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to DVD Studio Pro 4

DVD Studio Pro is software for authoring DVD-Video 
titles. It is both powerful and easy to use.

DVD Studio Pro lets you work with audio, video, graphics, and text materials that you 
have already created and edited and orchestrate them into a DVD that can be played 
on a DVD player or a suitably equipped computer.

If you have used such production tools as Final Cut Pro, Adobe Photoshop, Media 100, 
or Discreet cleaner, DVD Studio Pro will be easy for you to learn. You can use 
DVD Studio Pro for everything from constructing sophisticated training materials, 
corporate presentations, sales tools with web links, or high-quality event videos, to 
preparing a motion picture for release on DVD.

When you install DVD Studio Pro, you have access to the following tools (in addition to 
the DVD authoring software) to help you prepare your material, learn the program, and 
view your DVD:

• QuickTime MPEG Decoder, for viewing MPEG-2 streams with QuickTime 
• The Apple Compressor application, for encoding QuickTime video to MPEG-2 streams 

and uncompressed audio to Dolby Digital AC-3

What’s New With DVD Studio Pro 4 
There are a number of new features, enhancements, and changes in this version of 
DVD Studio Pro, the most significant of which are introduced below.

Support for Authoring DVDs With HD Video
In addition to authoring standard definition (SD) DVDs, DVD Studio Pro 4 adds support 
for authoring DVDs containing high definition (HD) video that conform to the new HD 
DVD standard. This makes it possible for you to author DVDs using a variety of HD 
video sources that can be burned to either red laser or blue laser drives and played by 
the latest Apple DVD Player. 
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See “About Standard and High Definition DVDs” on page 19 for additional information. 
See “Emulating Your Project” on page 570 for more information on DVD Player 
requirements.

Support for External Video and Audio Monitors
You can now connect external video and audio monitors that can be used when 
simulating your project. When you author a DVD, it can be important to see the video 
and hear the audio with devices that closely match those that the viewer is expected to 
use. Being able to do this while simulating your project allows you to verify the video 
and audio prior to building your project and burning a test DVD. In particular:
• You see the true color based on YUV values instead of a computer monitor’s RGB values.
• You see the actual pixel aspect ratios. To display SD resolution 4:3 or 16:9 video on a 

computer monitor requires the pixels to be scaled, which can create or hide issues in 
the video.

• By connecting a suitable AC-3 or DTS decoder, you can hear surround sound audio.

The video monitor uses your system’s second monitor connection (if available). For 
example, you could connect an NTSC or PAL monitor to the S-Video output of a 
PowerBook G4 computer. 

The audio monitor, which can include a suitable AC-3 or DTS decoder, can be 
connected to the computer’s optical digital audio output (also known as an S/PDIF 
output) or to the computer’s FireWire or USB port.

See “External Video and Audio Monitoring” on page 31 for details on the equipment 
and “Simulating With an External Video and Audio Monitor” on page 547 for 
information on using the Simulator.

Video Title Set (VTS) Editor Added
DVD Studio Pro 4 now includes a VTS Editor that allows you to view and control the 
VTS structure of your project. Using the VTS Editor, you are now able to manually assign 
elements to VTS blocks. This makes it possible for you to optimize the final DVD’s layout 
so that when it’s played there are minimal pauses due to the player having to move 
between elements in different parts of the disc.

Important:  The order of elements in the Outline tab no longer affects the file structure 
when building your project. 

Additionally, DVD Studio Pro 4 will now automatically create additional VTS blocks as 
needed to support menus with a variety of video and audio assets. For example, if you 
have a main menu that uses an AC-3 audio asset and a second menu that uses an AIFF 
audio asset, each menu is automatically placed in its own VTS. 

See “VTS Editor” on page 588 for more information.
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Improved General Purpose Register Memory (GPRM) Usage
When creating scripts, you may find that you could use an additional GPRM or two. 
DVD Studio Pro provides access to eight 16-bit GPRM registers, but you don’t always 
need the full 16-bits of a register.

DVD Studio Pro 4 allows you to increase the number of GPRM registers by partitioning 
one or more of them into smaller sizes. For example, you could choose to partition 
GPRM 1 into four 4-bit registers. This makes it possible to greatly increase the usable 
number of GRPMs available when creating your scripts. 

See “Configuring GPRM Partitions” on page 505 for more information.

Improved Motion Integration
DVD Studio Pro 4 can now support specialized markers added to your Motion projects. 
These markers can define the loop point when creating a motion menu and the 
transition switch point when creating Alpha Transitions. See the Motion User Manual, in 
the Motion Help menu, for more information.

AC-3 Encoding Added to Compressor
Compressor now includes the ability to encode Dolby Digital AC-3 audio files. You can 
encode uncompressed audio assets containing from 1 to 5.1 channels using the 
Compressor batch and preset capabilities. See the Compressor User Manual, in the 
Compressor Help menu, for more information.

Compressor Includes Distributed Encoding
DVD Studio Pro 4 includes an enhanced version of Compressor that supports 
distributed encoding. Distributed encoding allows you to spread the encoding 
workload among several computers, which can greatly speed up the process. See the 
Compressor User Manual, in the Compressor Help menu, for more information.

Support for Additional Digital Theatre Systems (DTS) Audio Formats
You can now use DTS ES audio that has up to 6.1 channels, as well as audio that uses a 
96 kHz sample rate and a 24-bit sample size.

Important:  All DTS audio imported into DVD Studio Pro must use the compacted file 
format, with a “.cpt” file extension.

See “DTS Audio” on page 79 for more information.

Dual-Layer Break Points Can Be Set in DVD-ROM Area
In those dual-layer projects that have more DVD-ROM content than DVD-Video 
content, you can now set the break point within the ROM content.

See “Setting the Break Point With Large DVD-ROM Contents” on page 578 for 
more information.
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Menu Loop Point Feature Improved
You are now able to use the menu loop point feature with any motion menu, even 
those with drop zones, text items, and buttons with video assets. Additionally, you can 
now use a script to jump to a menu’s loop point. When configuring the Jump 
command, an option has been added to the Script Inspector that allows you to jump 
directly to a menu’s loop point rather than the start point.

See “Jumping to a Menu’s Loop Point” on page 509 for an example and “Configuring 
Motion Menu Settings” on page 282 for information on setting the loop point.

Moving From iDVD to DVD Studio Pro
The Apple entry-level DVD authoring application is iDVD. It allows you to create simple 
DVD-Video titles with some of the most popular features found in Hollywood-style 
releases, without having to know any technical details about the process. The interface 
and feature set are configured to make the process nearly foolproof. 

Eventually, however, you will find yourself requiring features beyond those that iDVD 
offers. DVD Studio Pro gives you access to a wide range of professional features 
outlined in the DVD specification: 

• Support for multiple video, audio, and subtitle streams, making it easy to create discs 
that support multiple languages or add features such as a director’s commentary

• Additional menu functionality. For example, you can create and add up to 36 
buttons, control the navigation between them, and have more flexibility when 
assigning their functions.

• Alternate ways to play back movies. You can use the DVD Studio Pro story feature to 
control how a movie plays.

• Support for web interactivity. You can embed links to websites or other documents 
into your DVD title.

• Many advanced features supported by the DVD specification, such as dual-layer discs 
and copy protection

DVD Studio Pro offers several workflows and work styles for creating DVD projects, 
including templates and the drag-and-drop method used within iDVD. This makes 
DVD Studio Pro easy to learn while still providing the advanced features you need. 

Important:  See “Importing iDVD Projects and Themes” on page 629 for information on 
importing iDVD projects.
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About Standard and High Definition DVDs
Standard definition (SD) DVDs provided most viewers with their first digital video 
experience. The great video quality, interactive menus, and surround sound audio 
found on current DVDs set a high standard for viewer expectations. Meanwhile, the 
establishment of high definition (HD) video format standards and the increasing 
availability of HD broadcasts have led to more and more viewers having HD video 
monitors, and even higher expectations for DVDs.

These expectations, along with the development of improved compression 
technologies and a blue laser technology that greatly increases a disc’s storage 
capacity, have led to the ability of recording HD video onto a DVD. 

But I Thought DVDs Were Already High Definition?
In addition to traditional 4:3 aspect ratio video, traditional DVDs support widescreen 
16:9 video, which is often mistaken for being high definition. The 16:9 video used on 
current DVDs, however, is the same resolution as the 4:3 video, which is the same as 
the standard NTSC and PAL broadcast resolutions. The 16:9 video must be anamorphic, 
which makes it appear horizontally squashed when viewed on a 4:3 monitor.

This leads to a logical next question—what constitutes high definition video? While 
most HD video formats use a 16:9 aspect ratio, what generally defines whether they are 
HD or not is the resolution.

Video resolutions that result in more pixels per frame than are used in SD-based DVDs 
are considered high definition. There are two common HD vertical resolutions: 720 lines 
and 1080 lines (used for both NTSC and PAL). These compare to NTSC’s 480 lines and 
PAL’s 576 lines for SD video. 

As with SD-based DVDs, the scanning method used on HD-based DVDs can be 
interlaced, with a video frame containing one field with the odd lines and another field 
with the even lines, or progressive, where each frame is complete. Not all HD formats 
support progressive scanning, however. See “Supported Video Resolutions” on page 21 
for details on supported SD and HD video formats, including frame rates and 
scanning methods.



20 Preface    An Introduction to DVD Studio Pro 4

 

About DVD Studio Pro 4 and HD Resolution DVDs
In addition to supporting standard definition (SD) format video DVDs, DVD Studio Pro 4 
now supports creating high definition (HD) format video DVDs. 

With the exception of support for HD video resolutions and the number of buttons on 
menus and button over video subtitles, HD projects in DVD Studio Pro 4 have the same 
limits as SD projects. 

There are two aspects to creating DVDs with HD content:  what you can put into the 
DVD video zone and the DVD disc media. 

DVD Video Zone With HD Content
While the contents of the DVD video zone for an HD-based DVD (HVDVD_TS) are 
similar to those of an SD-based DVD video zone (VIDEO_TS), there are some important 
differences:
• HD-based DVDs support a broad range of video resolutions, including most of those 

used in SD-based DVDs. See “Supported Video Resolutions” on page 21 for a 
complete list of supported resolutions.

• In addition to supporting SD MPEG-2 video encodes, HD-based DVDs support HD 
MPEG-2 and H.264 video encodes. These are discussed in “HD Video Assets” on 
page 22.

Blue Laser Disc Media
Due to the improved video resolution possible with HD video, the encoded video files 
for HD resolution DVDs can be larger than those used with SD resolution DVDs. For that 
reason, a media format based on a blue laser was designed specifically for DVD projects 
containing HD video. See the following table for a comparison of SD and HD disc sizes.

In addition to blue laser based DVD media, an HD project’s DVD video zone can be 
written to DVD media based on the red lasers used by traditional DVDs. (The obvious 
limitation is that you will not be able to fit as much video data on the disc.)

Important:  SD-based DVD players are not able to play DVD projects containing HD 
content, whether they are on red or blue laser media. Additionally, only HD projects on 
special 3x DVD-ROM red laser media are officially supported in the HD DVD 
specification. You can burn HD projects to traditional red laser media on your system; 
however, the discs might not play in all HD DVD players.

Disc Red laser capacity Blue laser capacity

Single-sided, single-layer 4.7 GB 15 GB

Single-sided, dual-layer 8.54 GB 30 GB
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Supported Video Resolutions
All video resolutions supported by SD-based DVDs are also supported by HD-based 
DVDs. This means that an HD-based DVD can use an HD video resolution for the main 
feature, then use an SD video resolution for extras. The following list includes the SD 
and HD video resolutions supported by DVD Studio Pro 4.

Note:  MPEG-1 encoded video files are not supported in HD projects. 

NTSC
Frame rates with an “i” indicate the interlaced scanning method; those with a “p” 
indicate the progressive scanning method.

PAL
Frame rates with an “i” indicate the interlaced scanning method; those with a “p” 
indicate the progressive scanning method.

Resolution Frame rate Aspect ratio Notes

352 x 240 29.97i 4:3 Also known as SIF format

352 x 480 29.97i 4:3 Also known as 1/2 D1

704 x 480 29.97i 4:3, 16:9 Also known as Cropped D1; 16:9 is anamorphic

720 x 480 29.97i 4:3, 16:9 Also known as Full D1; 16:9 is anamorphic

720 x 480 59.94p 16:9 HD only, also known as 480p; is anamorphic

1280 x 720 59.94p 16:9 HD only, also known as 720p

1440 x 1080 29.97i 16:9 HD only; 16:9 is anamorphic

1920 x 1080 29.97i 16:9 HD only, also known as 1080i

Resolution Frame rate Aspect ratio Notes

352 x 288 25i 4:3 Also known as SIF format

352 x 576 25i 4:3 Also known as 1/2 D1

704 x 576 25i 4:3, 16:9 Also known as Cropped D1; 16:9 is anamorphic

720 x 576 25i 4:3, 16:9 Also known as Full D1; 16:9 is anamorphic

720 x 576 50p 16:9 HD only, also known as 576p; is anamorphic

1280 x 720 50p 16:9 HD only, also known as 720p

1440 x 1080 25i 16:9 HD only; 16:9 is anamorphic

1920 x 1080 25i 16:9 HD only, also known as 1080i
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Using 24P Video Formats
Both SD and HD projects can use assets encoded at 24 fps (actually 23.98 fps), as long 
as they are encoded specifically with NTSC or PAL flags set. 

Video at 24 fps has two main advantages:  It matches the film frame rate, and, in the 
case of NTSC, provides much smaller files due to having six fewer frames per second.

See “Importing 24 fps Assets” on page 49 for more information.

HD Video Assets
There are a variety of sources for HD video assets to use in your HD projects, with the 
most common being DVCPRO HD and HDV camcorders. 
• With DVCPRO HD, once you have finished editing the video, the result will need to 

be encoded to the HD MPEG-2 or H.264 video format.
• With HDV, which is already compliant MPEG-2 HD video, you can edit the video in 

Final Cut Pro 5 and import the result directly in your HD projects. 

DVD Studio Pro 4 supports HD video encoded using the HD MPEG-2 codec and the 
H.264 codec. Both of these formats are playable with the Apple DVD Player. You can 
use Compressor to encode video to either of these formats. When you import HD 
resolution QuickTime video, such as DVCPRO HD video, into DVD Studio Pro, it is HD 
MPEG-2 encoded using the embedded MPEG encoder.

Using HDV Assets
The HDV format uses MPEG-2 encoding to store HD video on a standard DV or Mini DV 
tape. There are two video resolutions supported by the HDV format:
• 1280 x 720 (720p) at 19 Mbps
• 1440 x 1080 (1080i) at 25 Mbps (which is anamorphic 16:9)

Imported HDV assets have the video and audio separated into elementary streams (the 
HDV format combines the video and audio into a single file), but are not otherwise 
processed or converted. 

Using H.264 Assets
You can use the H.264 for HD DVD presets included with Compressor to encode several 
supported HD and SD video resolutions for use in your HD projects. 

The H.264 encoder is twice as efficient as the standard MPEG-2 encoder. When 
compared to encoding with MPEG-2, this means that with the H.264 encoder:

• You can use a lower bit rate to get the same quality, resulting in smaller files.
• You can use the same bit rate and get better quality with the same file size.
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Using DVCPRO HD and Uncompressed HD Assets
Another source of HD assets for your HD projects is video encoded with the DVCPRO 
HD compression types or uncompressed video. DVCPRO HD video, like DVCPRO SD 
video, and uncompressed video cannot be used directly in your DVD Studio Pro 
projects. You can import them, however, and DVD Studio Pro will automatically encode 
them to compatible HD MPEG-2 assets using the embedded MPEG encoder. You can 
also encode them to HD MPEG-2 or H.264 using Compressor or QuickTime.

Brief Overview of the DVD Creation Process
You can create many different styles of DVDs with DVD Studio Pro, from corporate 
presentations to training materials to event videos to feature films. While the content 
and structure of each style may vary considerably, they all use the same basic DVD 
creation process. 

There are four phases to the DVD creation process:

• Creating your source material
• Encoding audio and video to compatible formats
• Authoring your DVD title
• Building the project and creating your disc

It’s important to understand the entire process, and how DVD Studio Pro is used in the 
process, before you begin your DVD projects.

Edit raw sources
• iMovie
• Final Cut Pro
• Final Cut Express

Author the DVD with 
DVD Studio Pro

DVD burner
(SuperDrive)

DLT
drive Replication

facility

Other sources
• Motion
• Keynote
• LiveType
• Soundtrack
• Compressor
• iTunes
• iPhoto

Encode
assets.

Create
menus,
tracks,

slideshows.

Build and
format

the 
project.

Duplication
facility
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Creating Source Material
The first part of the DVD creation process is to create or assemble your source material. 
This might mean shooting video, recording voice or music tracks, designing graphics to 
be included, and planning the general functionality of your project. If you are 
converting an existing video program into a DVD, you may only need to gather your 
original video and audio material and design graphics for the menus that will weave 
them together. 

You can use whatever tools you prefer for creating your video and audio material, as 
long as the resulting files are compatible with the MPEG or H.264 encoder that you 
plan to use. In most cases, your video and audio assets will be created and saved as 
QuickTime movie files or in standard sound file formats like AIFF, WAVE, or 
SoundDesigner II.

Your program material should be completely edited, including any special effects, 
audio fades, and scene transitions, before you encode it.

Menu graphics can be still image files, multilayer Photoshop files, or full-motion video. 
To create the menu graphics, you can use virtually any graphics program. 
DVD Studio Pro includes extra support for Adobe Photoshop (PSD) files, taking 
advantage of Photoshop’s “layers” feature to simplify the creation of backgrounds and 
overlays. Also included is support for the menu loop point you can set in Motion.

If you plan to include alternate-language subtitles in your DVD project, you will want to 
have your soundtrack transcribed and translated.

Quality In = Quality Out
The most important thing you can do when preparing your assets is to use the highest-
quality settings available. Any flaws in your material will be revealed on DVD much 
more quickly than in any other medium.

Once they are encoded into a DVD-compliant format, DVD Studio Pro does not 
improve or degrade the quality of your source material in any way; if you use high-
quality source materials, you’ll get high-quality results.
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Here are some guidelines to help you maintain high quality.

• Capture and edit your video material at the same resolution that you will use on the 
DVD (typically 720 x 480 at 29.97 frames per second [fps] for NTSC or 720 x 576 at 
25 fps for PAL for SD-based DVDs).

• When recording and editing audio, use a 48 kilohertz (kHz) sample rate and no 
compression. This assures the best quality whether you use the uncompressed audio 
on the DVD or decide to use the Compressor AC-3 encoder to compress it.

Important:  When creating DVDs, your audio must have either a 48 kHz or 96 kHz 
sample rate. You cannot use the 44.1 kHz sample rate found on standard audio CDs. 
In most cases, the DVD Studio Pro embedded AIFF encoder will convert your audio 
to the correct sample rate if necessary.

• When saving video material to the QuickTime format, either specify no compression 
(which requires a lot of disk space) or use a high-quality compression codec like DV 
or Motion JPEG.

Encoding Video and Audio
Once you have created your source materials, they must be encoded to comply with 
the DVD specification. DVD Studio Pro can use materials encoded using its embedded 
MPEG and AIFF encoders, as well as materials encoded using the Apple Compressor 
application and other methods.

What Is Needed for DVD? 
Before video or audio material can be used on a DVD, it must be prepared in one of the 
formats defined in the DVD specification. This usually means MPEG-2 format for video 
and Dolby AC-3 format for audio files (although you can also use standard PCM audio 
formats, such as AIFF files, DTS format files, and MPEG-1 Layer 2 formatted files).

SD projects also accept the older MPEG-1 video format, most commonly seen in web-
based applications. Because MPEG-1 is about one quarter the resolution of MPEG-2 
(352 x 240 as opposed to 720 x 480 for NTSC or 352 x 288 versus 720 x 576 for PAL) and 
utilizes much lower data rates, the quality is significantly lower. However, MPEG-1 is 
useful for very long programs if the picture quality is not of primary importance. Using 
MPEG-1 encoding, you can fit many hours of material on a single DVD.

Important:  You cannot use MPEG-1 formatted video assets in HD projects.

MPEG encoding performs extremely complex calculations on your source material to 
determine what can be safely “thrown away” with minimal impact on the visual quality. 
As a result, MPEG encoding can produce files that are less than ten percent the size of 
the source files, while still looking great.
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Using the DVD Studio Pro Tools
DVD Studio Pro includes embedded MPEG-2 and AIFF encoders. When you add a 
QuickTime asset directly to your DVD Studio Pro project, it is automatically encoded to 
be DVD-compliant. You can choose whether the asset is encoded in the background 
while you continue authoring or whether the encode waits until you build your project. 

Also included with DVD Studio Pro is Compressor, an encoding tool that provides 
additional MPEG encoding configurations and can process batches of video and audio 
clips in one step. 

For many projects you will probably want to use a Dolby-certified AC-3 encoder (such 
as the AC-3 encoder included with Compressor). An AC-3 encoder can be used to 
encode multichannel surround soundtracks for inclusion on a DVD, as well as for stereo 
or mono soundtracks. Using AC-3 encoded audio results in smaller files and a lower 
playback bit rate. Uncompressed audio formats (PCM or AIFF) have significantly larger 
file sizes and generally do not support specialized soundtrack formats, such as 
surround channels.

Using Pre-Encoded Sources
There are many other available tools that produce MPEG and H.264 streams, including 
software and hardware encoders. You can use any MPEG encoder you prefer, as long as 
it creates DVD-compliant elementary streams. This means that the audio and video 
information is contained in separate files (the streams). 

Important:  DVD Studio Pro cannot use MPEG multiplexed System, Program, or 
Transport streams for DVD projects. 

See “About MPEG Video” on page 54 for more information on DVD-compliant 
requirements.

Authoring With DVD Studio Pro
You use DVD Studio Pro to orchestrate your video, audio, and graphics material into an 
interactive DVD-Video title, complete with menus, buttons, subtitles, and alternate 
languages or soundtracks.

DVD Studio Pro gives you complete control over every aspect of your DVD, and lets you 
view its elements and simulate your DVD in real time as you create it.

You can easily create menus, add buttons, and specify the actions that occur when the 
buttons are activated. You can define powerful linking and scripting functionality with 
just a few clicks. And the Inspector gives you a complete picture of all the 
characteristics of any item in your project.
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Authoring in DVD Studio Pro consists of these basic steps:

Step 1:  Set the DVD and video standard
You can use DVD Studio Pro to author traditional SD-based DVDs or HD-based DVDs 
using either NTSC or PAL frame rates. It is important to set this before importing your 
assets since these settings control what happens when QuickTime assets are imported.

Step 2:  Import assets
Import your video, audio, graphics, and subtitle assets into DVD Studio Pro. If they are 
not already DVD-compliant, the embedded MPEG encoder automatically encodes them.

Step 3:  Create menus
Create one or more menus to define the structure and navigation of your DVD. The 
menus can rely completely on the supplied templates and styles or can use your 
own graphics.

Step 4:  Add buttons to the menus
Add one or more buttons to your menus. The display mode (4:3, 16:9 Letterbox, and so 
on) and DVD standard (SD DVD or HD DVD) determine the maximum number of 
buttons each menu can have. Each button can initiate a wide variety of actions, the 
most common being to open a different menu, play a track, or run a script. This 
hierarchy of menus and buttons gives you tremendous flexibility in constructing an 
“interactive” program in which the viewer has numerous options to choose from.

Step 5:  Create tracks and slideshows
Create one or more tracks, each consisting of one or more video streams, audio streams, 
subtitle streams, chapter markers, and stories. Create one or more slideshows, each 
consisting of still images and, optionally, audio. Tracks and slideshows can also be created 
by dragging assets to the Menu Editor and choosing options from the Drop Palette.

Step 6:  Link the project elements
Set up the various actions and links that will make your project work as it should when 
viewed. For example, you can set what happens when a DVD player first starts playing 
the disc, what happens when a track finishes playing, and what happens if the player 
sits idle at a menu for a specific amount of time.

Step 7:  Simulate your project
View your elements and test your project as you go using the real-time DVD Simulator 
built in to DVD Studio Pro. This process allows you to verify the links between the 
project elements.

Step 8:  Build and burn your project
Build the completed project and either send it to a replication facility or burn a DVD on 
your own system. 
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Creating a Disc
Creating a disc involves two steps:  building the DVD-formatted video zone (VIDEO_TS 
for SD-based DVDs and HVDVD_TS for HD-based DVDs) and formatting it for how you 
intend to deliver it. 

Building the Video Zone
When you build your SD-based DVD project, a set of files is created and stored on your 
hard disk in a folder named “VIDEO_TS” (video title set). The contents and structure of 
this folder is strictly defined by the DVD specification. HD projects store their files in a 
folder named “HVDVD_TS.” 

When you build your project within DVD Studio Pro, it combines all the material you’ve 
included (video, audio, and subtitles for the menus and tracks) into a single stream and 
writes it to this special folder. Using DVD Player, which is included with your operating 
system, you can open and play the contents of this folder, just as if it were on a DVD disc.

Formatting and Burning
Depending on the quantity of DVD discs you need, you can: 
• Burn one or more DVDs on your system (if properly equipped). This is a quick way to 

create a test disc. 

Note:  You cannot add high-end features such as copy protection.

• Send a burned disc to a duplicator who can burn additional copies for you. This allows 
you to create more discs than you would want to burn on your own system at a 
lower cost than using a replicator. Since the copies are based on a disc you burn on 
your system, the duplicated discs have the same restrictions as when you burn on 
your system.

• Prepare suitable files to send to a DVD replication facility. Use a replicator to make 
copies that are compatible with all DVD players, to create larger quantities of discs, 
and to include specialized features not supported by your system’s DVD burner.

If you are using a DVD replication facility, you can deliver your project to the facility in 
several ways:

• DLT:  Digital Linear Tape (DLT) is the preferred method for sending a DVD project to a 
DVD replication facility. DVD Studio Pro supports writing directly to a DLT drive. DLT 
is well suited to transporting DVD projects because of its reliability and very 
high capacity. 

• DVD-R:  Many DVD replicators accept DVD-R discs for replication. There are special 
requirements if you want to include high-end features such as dual-layer and copy 
protection. See “DVD Burners” on page 30 for more information on using DVD-R 
discs for replication, including information about the Cutting Master Format (CMF).
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What Makes a DVD Authoring System?
The DVD Studio Pro installation booklet lists the minimum hardware and software 
requirements necessary for using DVD Studio Pro to build DVD titles. However, you may 
find you need additional items beyond the minimum requirements to make up your 
DVD authoring system. Depending on the types of DVD titles you intend to create, your 
DVD authoring system can be an off-the-shelf Power Mac G4 with a SuperDrive, or a 
specialized system with additional drives and hardware.

Hard Disk Storage
No matter what sort of titles you intend to create, you will be working with very large files. 

You should have at least twice as much hard disk storage space as the size of your 
project. (For DVD-5, for example, which can hold about 4.4 GB, you need 4.4 GB for the 
MPEG-2 encoded asset files and another 4.4 GB to hold the built, or compiled, project. 
An HD project can require about 60 GB to hold the asset and built project. Original 
asset files, such as DV format video, require much more space than the MPEG-2 
encoded versions used in your DVD project.) For best build performance, dedicate two 
or three Ultra Wide A/V or FireWire hard disks to your project. (Make sure they contain 
only your media and no other programs that might fragment the disk and decrease 
performance.) If you have three disks, use one for video assets, one for audio assets, 
and the third for the finished files. If you have two disks, use one for source assets and 
one for final files.

SCSI Devices
Depending on your needs, you may need to add external devices—such as hard disks 
and DLT drives—that require SCSI support. 

To use SCSI devices, you must either have your Mac properly equipped when ordering 
it, or add a third-party SCSI PCI card to your existing desktop computer. Contact your 
Apple Authorized Reseller or see the Support area of the Apple website for a list of 
suggested SCSI cards and devices.
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DVD Burners
Being able to burn a DVD is useful for both proofing your titles on set-top DVD players 
and burning the finished project (when only a small number of discs are required). You 
can also burn a disc for a duplication or replication facility to use as a master when 
larger quantities are needed. 

You cannot burn discs that support Macrovision copy-protection or Content 
Scrambling System (CSS) encryption. These must be created at a replication facility. 

Note:  For best results, it is recommended that you supply the replication facility a DLT 
tape instead of a DVD-R. Be sure to confirm with the facility what formats it supports.

When choosing a DVD burner for your system, you have the option of using an Apple 
SuperDrive or other drives. Your choice depends in part on which media you want to 
use:  whether you intend to burn on red laser or blue laser media and, in the case of 
red laser burners, whether to use general or authoring media. 

Note:  You cannot burn SD projects to blue laser media.

General Versus Authoring Media 
The first drives created to write DVD-R discs used a special red laser and expensive 
media, now known as authoring media drives. The most common DVD-R drives, 
however, use a less expensive red laser and media. Such drives are known as general 
media drives. 

Red laser DVD-R drives can write to either general or authoring media—not both. The 
SuperDrive supplied with many Apple systems supports only general media. To use 
authoring media, you need to connect a special DVD-R drive. 

Important:  Be sure you write only to media supported by your drive. If the media is not 
labeled either general or authoring, it was likely manufactured before the existence of 
general drives, and can be assumed to be authoring-compatible.

The type of media you use only affects the writing of the disc. Both types of DVD-R 
drives and most DVD-ROM drives and set-top DVD players can read and play both 
general and authoring media.

For most projects, there is no significant difference between a DVD created using general 
or authoring drives and discs. However, if you intend to use a replicator and require high-
end features such as dual-layer discs, Macrovision copy-protection, region support, and 
CSS data encryption, you must use authoring media with an authoring drive.
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Even with authoring media, you cannot burn a DVD that supports any of these high-
end features on your own system. However, authoring media supports the Cutting 
Master Format (CMF), which can be used to add information required by the replicator 
to put these features on your discs. General media does not support CMF.

See “The Cutting Master Format” on page 585 for more information on the CMF 
standard.

DLT Drives
Digital Linear Tape (DLT) drives are the most reliable way to deliver DVD content to a 
replicator. They are also a good way to back up completed projects so that you can 
remove them from your hard disks and make room for your next project. 

DVD data written to DLT drives with DVD Studio Pro can use Data Description Protocol 
(DDP) version 2.0 or version 2.1. You can also write using CMF version 1.0.

External Video and Audio Monitoring
You can configure your system to support external video and audio monitors. This 
makes it possible to more closely simulate a viewer’s environment before you build the 
project and burn a test DVD.

When using external monitors, keep the following in mind:

• External video monitors are only used during simulation. 
• External audio monitors are active during simulation and while playing from the 

Assets tab or any of the editors (Track, Story, Slideshow, and Menu Editors).
• When using an external video monitor, the Simulator window on your computer 

is inactive.
• You cannot use the pointer to click buttons on the external video monitor. You must 

control the simulation by using the Simulator window’s controls. 
• Depending on your system and the video being simulated, frames may be skipped 

during playback in order to maintain synchronized playback with the audio.

The Simulator pane in DVD Studio Pro Preferences contains settings that control 
whether the external video and audio monitors are used. Additionally, the Simulator 
contains settings that allow you to change the display mode (4:3 Pan-Scan, 4:3 
Letterbox, or 16:9) and resolution (SD, HD 720, or HD 1080). See “Simulator Preferences” 
on page 122 and “Simulating With an External Video and Audio Monitor” on page 547 
for more information.
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Connecting an External Video Monitor
When simulating your project on your computer’s video monitor, you do not see video 
exactly as a viewer would when playing the video using a set-top DVD player 
connected to an NTSC or PAL monitor. There are two primary differences:
• Pixel aspect ratio:  Computer monitors always use square pixels, while SD video uses 

rectangular pixels. When viewed on the computer’s monitor, the Simulator scales 
the pixels to make them fit the 4:3 or 16:9 aspect ratio, which can affect the 
video appearance. 

• Color space:  Computer monitors generally use RGB color space for their displays 
while most monitors used to view DVDs use the YUV color space.

The advantage of connecting an external video monitor is that, depending on the 
monitor you connect, you are able to see the video as the viewer would see it.

The external video monitor uses the second monitor as configured in the Displays pane 
of System Preferences. You must set the resolution and refresh rate to match the 
external monitor. There are two common approaches to connecting an external 
video monitor:

• Connecting a video monitor to your computer’s S-Video output (if present)
• Connecting a second monitor to your system (if supported)

For example, you could connect an NTSC or PAL monitor to the S-Video output of a 
PowerBook G4 system.

Note:  When connected to an NTSC or PAL monitor, this video output provides only an 
approximation of what the video will look like when burned to a disc and played on a 
DVD player. Due to rendering, rescaling, and interlacing issues, you should not rely on 
this output as a true representation of the video quality, especially with SD projects.
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Connecting an External Audio Monitor
There are two primary issues with monitoring your project’s audio using the 
computer’s built-in audio system:
• The built-in system cannot play surround sound audio. The audio is first downmixed 

to stereo, then played.
• The built-in system cannot play DTS audio.

There are two common approaches to connecting an external audio monitor:

• Connecting a suitable AC-3 or DTS decoder to the computer’s optical digital audio 
output (also known as an S/PDIF output)

• Connecting a suitable AC-3 or DTS decoder to the computer’s FireWire or USB port

Audio and Video Assets
Audio and video assets can come from a wide variety of analog and digital sources. You 
must have an equally wide variety of ways to capture these sources on your authoring 
system. When bringing your assets into DVD Studio Pro, you should keep in mind the 
following issues.

Have the Assets Been Edited Yet?
DVD Studio Pro is not an editor. You can use it to link assets together on a timeline, as 
with an editor, and even trim an asset’s start and end, but you cannot add effects such as 
dissolves and text credits, or perform any audio mixing. Your assets need to be already 
edited using an application such as Final Cut Pro. If you are editing the assets on your 
authoring computer, you need to capture them in a format required by your editing 
software. Once edited, the assets can be imported into DVD Studio Pro (if they are in a 
QuickTime-supported format) or encoded into DVD-compliant MPEG and audio formats, 
using either the encoders supplied by DVD Studio Pro or third-party applications.

Capturing From an Audio or Video Player
Often your assets will be edited at a post-production facility and you will capture them 
directly from a video- or audiotape player. In this case, you must have a third-party 
capture card that supports the video and audio formats used. This video must be 
captured in a QuickTime format that the DVD Studio Pro embedded MPEG encoder can 
convert to DVD-compliant formats, or captured directly as DVD-compliant MPEG and 
audio sources.
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Resources for Learning About DVD Studio Pro
This manual provides background and conceptual information, as well as step-by-step 
instructions for tasks, and a glossary of terms. It is designed to provide the information 
you need to get up to speed quickly so that you can take full advantage of 
DVD Studio Pro.

In addition to this manual, DVD Studio Pro provides other sources of support. 

DVD Studio Pro Onscreen User Manual
The DVD Studio Pro onscreen User Manual allows you to access information directly 
onscreen while you’re working in DVD Studio Pro. To view this information, choose 
Help > DVD Studio Pro User Manual. DVD Studio Pro User Manual is a fully hyperlinked 
version of the User Manual, enhanced with many features that make locating 
information quick and easy.
• The homepage provides quick access to various features, including Late-Breaking 

News and the DVD Studio Pro website.
• A comprehensive bookmark list allows you to quickly choose what you want to see 

and takes you there as soon as you click the link.

In addition to these navigational tools, DVD Studio Pro User Manual gives you other 
means to locate information quickly:

• All cross-references in the text are linked. You can click any cross-reference and jump 
immediately to that location. Then, you can use the Preview Back button to return to 
where you were before you clicked the cross-reference.

• The table of contents and index are also linked. If you click an entry in either of these 
sections, you jump directly to that section of the user manual. 

• You can also use the Find dialog to search the text for specific words or a phrase.

Apple Websites
There are a variety of Apple websites that you can visit to find additional information.

DVD Studio Pro Website
For general information and updates, as well as the latest news on DVD Studio Pro, go to:
• http://www.apple.com/dvdstudiopro

http://www.apple.com/dvdstudiopro
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Apple Service and Support Website
For software updates and answers to the most frequently asked questions for all Apple 
products, including DVD Studio Pro, go to:
• http://www.apple.com/support/dvdstudiopro

You’ll also have access to product specifications, reference documentation, and Apple 
and third-party product technical articles.

Other Apple Websites
Start at the Apple homepage to find the latest and greatest information about 
Apple products:
• http://www.apple.com

This page lists complete specifications for DVD Studio Pro: 

• http://www.apple.com/dvdstudiopro/specs.html

QuickTime is industry-standard technology for handling video, sound, animation, 
graphics, text, music, and 360-degree virtual reality (VR) scenes. QuickTime provides a 
high level of performance, compatibility, and quality for delivering digital video. Go to 
the QuickTime website for information on the types of media supported, a tour of the 
QuickTime interface, specifications, and more:

• http://www.apple.com/quicktime

FireWire is one of the fastest peripheral standards ever developed, which makes it great 
for use with multimedia peripherals, such as video camcorders and the latest high-
speed hard disk drives. Visit this website for information about FireWire technology and 
available third-party FireWire products:

• http://www.apple.com/firewire

For information about seminars, events, and third-party tools used in web publishing, 
design and print, music and audio, desktop movies, digital imaging, and the media arts, 
go to:

• http://www.apple.com/pro

For resources, stories, and information about projects developed by users in education 
using Apple software, including DVD Studio Pro, go to:

• http://www.apple.com/education

Go to the Apple Store to buy software, hardware, and accessories direct from Apple 
and to find special promotions and deals that include third-party hardware and 
software products:

• http://www.apple.com/store

http://www.apple.com/support/dvdstudiopro
http://www.apple.com
http://www.apple.com/dvdstudiopro/specs.html
http://www.apple.com/quicktime
http://www.apple.com/firewire/
http://www.apple.com/pro
http://www.apple.com/education
http://www.apple.com/store
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1 Planning Your Project

Before you start authoring your DVD title, it is highly 
recommended that you set aside some time to plan 
your project. 

Spending time in the beginning to outline the various aspects of the project will lead 
to a smoother production with minimal surprises.

Investigating Existing DVDs
A very effective way to start planning your project is to spend some time viewing 
existing DVDs. This process provides you with examples of ways others approached 
various aspects of their DVD projects, such as using slideshows or providing language 
selections. It can also help you understand how frustrating the viewing experience can 
be when a disc has poorly conceived menus or confusing interactivity.

Not all DVD titles are Hollywood releases—be sure to spend time looking at a variety of 
titles, especially those that best match the goals of your project. 

Keep in mind that, while DVD Studio Pro provides the tools needed to create highly 
complex DVDs, most Hollywood-style titles have teams of specialists who work on each 
project. Before you set out to create a complicated DVD, be sure you understand all 
aspects of what is involved, and are prepared to deal with them. 
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Determining Your Target Audience and Playback Device
As with any media project, you must have a clear idea of who the viewers are and what 
their expectations will be. You may need to create a title that simply plays a movie as 
soon as the DVD is loaded, with no viewer interaction at all. Or, you may need to create 
a title with highly customizable languages or display types.

Another major consideration is whether your DVD will be played on a computer. When 
a DVD is played on a set-top DVD player, the arrow buttons on the remote control 
provide the primary navigation controls. However, when a DVD is played on a 
computer, viewers will typically use the pointer for navigation. This distinction affects 
menu designs, since you need to make it obvious where viewers should click to 
activate the buttons. 

Additionally, if you need the title to play on older computers, you may need to set the bit 
rate as low as possible, to increase the chances that the title will play without stuttering.

Deciding Which DVD Standard to Use
DVD Studio Pro 4 gives you the choice of authoring a traditional DVD using standard 
definition (SD) assets or a DVD using high definition (HD) assets. There are several 
factors to take into account when deciding which DVD format to use:
• While an HD-based DVD can provide an excellent HD video output, it can only be 

played on devices designed to specifically support it, such as the Apple DVD Player. 
SD-based DVDs can be played on all DVD players, including those that play HD-
based DVDs.

• An HD project can be written on either a red laser disc (as is used by SD projects) or 
on a blue laser disc. While SD-based DVD players can read red laser discs, they 
cannot play HD content from them. 

Important:  Only HD projects on special 3x DVD-ROM red laser media are officially 
supported in the HD DVD specification. You can burn HD projects to traditional red 
laser media on your system; however, the discs might not play in all HD DVD players.

• Blue laser discs can hold about three times the data that a red laser disc can hold (a 
single-layer red laser disc can hold 4.7 GB—a single-layer blue laser disc can hold 
15 GB). Since you can use SD video in your HD project, writing on a blue laser disc 
allows you to get much more content on the disc.

• You may need to author both SD-based and HD-based DVD versions of your project. 
The easiest way to do this is to first author the SD-based DVD version of the project. 
You can then set the DVD standard to HD DVD—DVD Studio Pro automatically 
converts the project—and you can then choose which QuickTime assets to encode 
to the HD format. Alternatively, you can swap SD assets with HD assets as needed. 
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Deciding Which Video Standard to Use
In addition to choosing the DVD standard you want to use, you must also choose the 
video standard to use. You can choose between NTSC and PAL. This choice affects the 
video resolutions and frame rates that are supported. 

Important:  You cannot use both NTSC and PAL assets in the same project.

Also, be careful not to confuse the video standard setting with the region code setting. 
The region code setting allows you to specify the regions that can play your DVD—
choosing a region that primarily contains PAL countries does not force you to use the 
PAL video standard, though in most cases you would want to. 

See “Video Standards of the World” on page 133 for information on which countries 
support each video standard. It is also useful to keep in mind that DVD players that can 
play both NTSC and PAL are becoming more common and are most common in PAL 
countries. However, in most cases, while the DVD player can output either video 
standard, it assumes the video monitor it is connected to can display either standard 
(which is less likely to be true).

Deciding What Content to Include
The audio, video, and still-image files used by DVD Studio Pro in authoring DVD 
projects are known as assets. Often you’ll have a good idea of what primary assets you 
want to include when you start your project, but you may think of additional items 
once it is too late to create them. For example, providing a second language may 
greatly increase the value of a corporate title, but may require you to create new 
menus to support it.

Additionally, including nontraditional items on a DVD, such as PDF files and web links, 
can add a great deal of value to titles that will be viewed on computers. 

You may also have the opposite problem—you may have too much content for a DVD 
title. Be sure you know which content is required and which is optional. Explore the 
feasibility of creating a dual-layer DVD or double-sided DVD. Some content may be 
suitable for encoding at lower bit rates or as MPEG-1 streams. Perhaps instead of using 
uncompressed AIFF audio, you can use Dolby Digital AC-3 to save space. See “Making 
Sure Your Content Will Fit” on page 40 for more information.
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Creating a Storyboard
Even simple DVD titles with only a few menus can benefit from the time you spend in the 
planning stages. Storyboarding includes planning the interaction between the menus, 
tracks, slideshows, and stories. It helps you visualize what the viewing experience will be, 
and ensures that there are minimal surprises during the authoring process.

You’ll find that storyboarding can give you the overarching view of your project 
needed to plan fairly complex interactivity. 

Designing the Menus and Buttons
DVD Studio Pro provides tools that make it easy to create menus without relying 
heavily on outside graphics applications. For simple titles whose main focus is to 
provide information, you may be able to rely on the basic button-and-text capability of 
DVD Studio Pro to create your menus.

For custom titles, you’ll need to create your own graphics. Creating graphics for use with 
video is a bit different from creating graphics for print. Be sure to see “Creating Graphics 
to Use in Menus” on page 82 for information on creating graphics for your title.

In either case, since menus and the buttons on them are the viewers’ primary way of 
interacting with your title, it is important to spend time making sure that they are 
straightforward, with logical button navigation and clear highlights that let viewers 
know where they are in the menu.

Making Sure Your Content Will Fit
Be sure to allow time in the planning process to determine whether all of your assets 
will fit on the type of DVD you are using. You don’t want to be surprised when you are 
finished authoring the title—that is a bad time to find out that the assets won’t fit.

What Do You Mean a 4.7 GB DVD Won’t Hold 4.7 Gigabytes?
With computers, memory and disk size are commonly expressed in terms such as 
kilobyte, megabyte, and gigabyte. Technically, a kilobyte should represent 1000 bytes, 
but due to the binary numbering system computers use, a kilobyte actually represents 
1024 bytes. Similarly, a megabyte represents 1,048,576 bytes (and not 1,000,000 bytes) 
and a gigabyte represents 1,073,741,824 bytes (and not 1,000,000,000 bytes).

Unfortunately, with DVD discs the terms megabyte and gigabyte do not use the same 
binary-based standard; they literally refer to the technically accurate 1,000,000 bytes for a 
megabyte and 1,000,000,000 bytes for a gigabyte. This means that a 4.7 GB DVD disc will 
actually hold only 4.37 binary-based gigabytes. While the difference is not large (relatively 
speaking), it must be accounted for if you intend to come close to filling the disc.
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Important:  When displaying estimated sizes, DVD Studio Pro uses the “1000 bytes 
equals a kilobyte” system. This means that the estimated sizes refer to the amount of 
space they will require on the DVD, and will be a bit larger than the file sizes shown in 
the Finder.

Disc Options
You have a variety of DVD discs to choose from. The one you choose depends on your 
content, your budget, and whether you intend to use a DVD replication facility. DVD 
sizes are typically referred to with names such as DVD-5 and DVD-9. While the number 
in the name is intended to provide general guidance as to the capacity of the disc, it 
should not be relied on too strictly. (Note that a DVD-4 disc has a higher capacity than 
a DVD-5 disc.) The following table lists the common sizes used.

Red Laser Discs

If you intend to burn your own discs using your system’s DVD burner, you can only use 
DVD-5 and DVD-9 discs. To use any of the other sizes, you must use a DVD replication 
facility and provide them with either DLT or Cutting Master Format (CMF) DVD-R masters.

DVD name Disc size Type Capacity

DVD-1 8 cm Single-sided, 
single-layer

1.46 GB 
(1.36 binary gigabytes)

DVD-2 8 cm Single-sided, 
dual-layer

2.66 GB 
(2.47 binary gigabytes)

DVD-3 8 cm Dual-sided, 
both sides single-layer

2.92 GB 
(2.72 binary gigabytes)

DVD-4 8 cm Dual-sided, 
both sides dual-layer

5.32 GB 
(4.95 binary gigabytes)

DVD-5 12 cm Single-sided, 
single-layer

4.7 GB 
(4.38 binary gigabytes)

DVD-9 12 cm Single-sided, 
dual-layer

8.54 GB 
(7.95 binary gigabytes)

DVD-10 12 cm Dual-sided, 
both sides single-layer

9.4 GB 
(8.75 binary gigabytes)

DVD-14 12 cm Dual-sided, 
one side dual-layer

13.24 GB 
(12.32 binary gigabytes)

DVD-18 12 cm Dual-sided, 
both sides dual-layer

17.08 GB 
(15.9 binary gigabytes)
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Blue Laser Discs 

Estimating Whether Your Content Will Fit
While you will often hear that a DVD-5 (or a 4.7 GB disc) can hold two hours of video 
content, this is really only a rough guideline. The actual amount of video a DVD-5 disc 
can hold depends on the bit rate the video is encoded at. Often overlooked is the size 
of audio files—if you plan to use uncompressed AIFF (PCM) audio, you must also take 
the additional space requirements into account when calculating whether all your 
content will fit.

If your project needs to fit on a DVD-5 disc that you can burn on your SuperDrive, you 
need to choose an appropriate bit rate. There is a simple formula you can use. See 
“Fitting Your Project on a DVD-5 Disc,” next.

If you are flexible as to the DVD disc type you can use, you can experiment with different 
bit rates and determine the disc space required by each. This process is more detailed 
and includes more variables, such as taking into account additional audio streams and 
DVD-ROM content. See Appendix C, “Calculating Disc Space Requirements,” on page 633 
for details on precisely determining your disc space requirements.

Fitting Your Project on a DVD-5 Disc
You can use this simple formula to estimate the bit rate you should use to fit your video 
on a DVD-5 disc:
• 560/x = bit rate

The “x” represents the length of the video (in minutes) and the resulting bit rate is in 
megabits per second (Mbps). This formula assumes you are using compressed audio, 
such as AC-3. If you are using uncompressed audio, you need to subtract 1.5 Mbps 
(assuming you are using 16-bit stereo at a 48 kHz sample rate) from the bit rate value. 

For example, if you have 120 minutes of video, you get a suggested bit rate of 
4.67 Mbps (560/120 = 4.67). If you are using uncompressed audio (such as the AIFF 
format the embedded AIFF encoder supplies), you need to reduce the bit rate to 
3.17 Mbps to ensure the video and audio will fit on the disc.

DVD name Disc size Type Capacity

HD DVD-4 8 cm Single-sided
single-layer

4.5 GB
(4.19 binary gigabytes)

HD DVD-9 8 cm Single-sided
dual-layer

9.0 GB
(8.38 binary gigabytes)

HD DVD-15 12 cm Single-sided
single-layer

15.0 GB
(13.97 binary gigabytes)

HD DVD-30 12 cm Single-sided
dual-layer

30.0 GB
(27.94 binary gigabytes)
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Beware of Setting Your Bit Rate Too High
You will find that with some DVD projects, the content easily fits on the disc, and you 
may be tempted to use the highest video bit rate available. While higher bit rates 
produce better quality, you must take into account other factors before deciding to use 
the maximum allowable value.

The maximum video bit rate allowed on SD-based DVDs is 9.8 Mbps, but rarely is that 
practical to use since DVD players support combined video, audio, and subtitle bit rates 
of up to 10.08 Mbps. For HD-based DVDs, the maximum video bit rate is 29.4 Mbps for 
HD assets and 15.0 Mbps for any SD assets used in an HD project, with an overall 
maximum bit rate of 30.24 Mbps.

In practice, you should be conservative when determining how high of a bit rate to 
allow for. Trying to squeeze out the highest possible bit rate for your project can lead to 
player compatibility and disc space issues. A general recommendation is to not exceed 
9.2 Mbps for the combined video and audio bit rates when authoring SD projects, or 29 
Mbps when authoring HD projects. 

Important:  If you are building your project and DVD Studio Pro detects that the bit rate 
of the multiplexed stream is too high, the build stops and an error message appears.

Using PCM or AC-3 Audio
A single PCM audio stream using typical settings (as produced with the embedded 
AIFF encoder) requires 1.536 Mbps, which leaves an absolute maximum bit rate for the 
video in an SD project of around 8.54 Mbps. If there are two PCM audio streams, 3.07 
Mbps must be allowed for the audio, leaving just 7.01 Mbps for the video. 

Note:  Even though you can only play one audio stream at a time, the bit rates of all 
audio streams must be added together when determining the overall bit rate for a track. 
Similarly, all subtitle streams must be added together and added to the overall bit rate.

Using AC-3 audio in place of the PCM audio leaves far more room for the video bit rate. 
Stereo AC-3 audio using typical settings requires only about 224 kbps—using two 
stereo AC-3 streams in place of the PCM audio leaves about 9.6 Mbps for the video.

See “Calculate the audio allowances” on page 636 for more information about 
allowances for other audio formats.

Subtitle Allowances
Subtitles generally use a very small bit rate—about 10 kbps per stream. Larger subtitles 
that change frequently or use graphics can have a significant impact though, and can 
affect the maximum bit rate you can use for the video.
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Multiple Video Angles
Using multiple video angles in a track also affects the maximum allowable video bit rate 
you can use. Due to the way the DVD specification requires video streams to be 
multiplexed together, the number of video streams determines the maximum video bit 
rate you can use in SD projects. The maximum combined bit rates (highest bit rate video 
stream + all audio streams + all subtitle streams) you can use for each multi- and mixed-
angle track in an SD project is from 8.0 Mbps with two streams to 7.0 Mbps with nine 
streams. See “Encoding Video for Multi-Angle Tracks” on page 68 for more information.

HD projects using multiple video angles in a track are limited to 24.0 Mbps for the 
maximum combined bit rates, regardless of the number of video angles.

Transitions
When you add a transition to a menu, still clip in a track, or to slides in a slideshow, you 
need to account for the additional video they create.
• In the case of menus, the transitions become short rendered video clips stored in the 

same video object (VOB) file as the menus. This means that, in addition to the overall 
amount of disc space menu transitions require, you must also consider their impact 
on the 1 GB menu VOB file size limit. See “Standard SD DVD Video Zone Files” on 
page 566 for more information. You must also take into account that a transition 
video clip is rendered for each menu button that has transitions enabled—a menu 
with 18 buttons can require 18 transition video clips.

• In the case of still clips in a track and slides in a slideshow, adding transitions 
increases the amount of disc space each requires even if the transition does not 
increase the length of the track or slideshow. This is because stills and slides use 
much less disc space than the motion video created by the transitions, even if the 
transition is from one slide to another. 

The amount of disc space required by each transition varies depending on their length 
and type. In general, for SD projects, which use a bit rate of 6 Mbps for transitions, you 
should allow 750 KB of disc space for every second of transition time in the project. For 
HD projects, which use a bit rate of 20 Mbps for transitions, you should allow 2.5 MB of 
disc space per second.
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Using the Video Bit Rate
The video bit rates you calculate can be used as the bit rate entry of your encoder, 
regardless of the encoding method you intend to use (one pass, one-pass variable bit 
rate [VBR], or two-pass VBR). 

When using one of the VBR encoding methods in the embedded MPEG encoder, the 
“Bit rate” setting affects the amount of disc space that the MPEG video file requires, 
while the “Max bit rate” setting sets the highest video bit rate that is allowed in the file 
(but does not affect the file size). See “MPEG Encoding Methods” on page 56 for 
more information.

General DVD Limitations
Following are some general limitations you may run into while authoring your DVD 
project with DVD Studio Pro. Most of these limitations are due to DVD-Video 
specification requirements.

Note:  With the exception of the number of buttons on a menu, the same limits apply 
to both SD and HD projects.

Project
• Maximum number of tracks, stories, and slideshows in a project:  99
• Minimum number of menus in a project:  0
• Minimum number of tracks or slideshows in a project:  1

Menus
• Maximum number of menus in a project:  10,000
• Menu aspect ratio support:  4:3 and 16:9 menus can be used in the same project. 
• Maximum number of buttons on an SD-based DVD 4:3 menu:  36
• Maximum number of buttons on an SD-based DVD 16:9 menu:  18, unless Pan Scan & 

Letterbox is selected, which then sets the maximum to 12
• Maximum number of buttons on an HD-based DVD 4:3 menu:  48
• Maximum number of buttons on an HD-based DVD 16:9 menu:  24, unless Pan Scan & 

Letterbox is selected, which then sets the maximum to 16
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Tracks
• Maximum number of video streams in a track:  9
• Minimum number of video streams in a track:  1
• Maximum number of audio streams in a track:  8
• Maximum number of subtitle streams in a track:  32
• Maximum number of cell markers in a track:  255
• Maximum number of chapter markers in a track:  99 (Each chapter marker is also a 

cell marker.)
• Maximum combined number of chapter markers and individual chapter end jump 

settings in a track: 106 (See “Setting Chapter Marker End Jumps” on page 530 for more 
information.)

• Maximum number of buttons on an SD-based DVD 4:3 track’s button highlight 
marker:  36

• Maximum number of buttons on an SD-based DVD 16:9 track’s button highlight marker:  18, 
unless Pan Scan & Letterbox is selected, which then sets the maximum to 12

• Maximum number of buttons on an HD-based DVD 4:3 track’s button highlight 
marker:  48

• Maximum number of buttons on an HD-based DVD 16:9 track’s button highlight marker:  24, 
unless Pan Scan & Letterbox is selected, which then sets the maximum to 16

Stories
• Maximum number of segments:  98 (must all be from the same track)

Slideshows
• Maximum number of slides in a slideshow:  99
• Minimum number of slides in a slideshow:  1

Scripts
• Maximum number of scripts in a project:  10,000
• Maximum number of command lines in a script:  124
• Minimum number of command lines in a script:  1
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2 Preparing Assets

Before you can begin building a DVD project, you must 
have correctly prepared source material:  edited video 
and audio, subtitles, and graphics or video for menus. 

After you have captured and edited your source material, you need to encode it to 
make it DVD-compliant. DVD Studio Pro includes embedded MPEG and AIFF encoders 
for encoding QuickTime video to MPEG-2 or H.264 streams and QuickTime audio to 
AIFF streams. 

The DVD Studio Pro integration of these encoders allows you to directly import 
QuickTime sources into a project—the encoders work with the sources while you 
continue authoring the project.

Included with DVD Studio Pro is Compressor, a full-featured video and audio 
compression application. Compressor can also be used to create DVD-compliant assets 
for use in DVD Studio Pro, including HD video and Dolby Digital AC-3 audio assets. It 
gives you more control over the encoding process, including the ability to encode 
several clips in one batch operation. It also integrates well with Final Cut Pro, providing 
exceptionally high-quality MPEG-2 streams.

This chapter describes how to prepare source material for use in DVD Studio Pro and 
how to use the embedded MPEG encoder. For more information on DVD-compliant 
material, see “About MPEG Video” on page 54.
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Preparing Video Sources
Several source types are commonly used to create DVD titles: 
• Movies:  These typically include both video and audio, and can be the primary 

component of the title or can be short clips used for menu backgrounds. Audio-only 
clips are often used along with still menus and slideshows.

• Stills:  These can be used either as part of a slideshow, or more commonly, as menu 
backgrounds. They can be simple, single-layer graphics files or multilayer Adobe 
Photoshop files, with layers for each element in a menu.

• Buttons:  DVD Studio Pro lets you use custom “iDVD-style” buttons in your menus. 
These button shapes are small, multilayer Photoshop files containing all of the 
elements that make up a DVD button—the primary graphic, the highlight, and the 
thumbnail image mask. 

The DVD-Video specification has strict requirements for several aspects of the sources 
used. For best results, you should create and capture your video and audio using the 
settings required for DVD.

See “DVD Source Settings Summary” on page 104 for a complete list of settings 
required for a source to be DVD-compliant.

NTSC or PAL?
A DVD-Video title must contain either all NTSC or all PAL sources. If you intend to create 
a title that can be played on either NTSC or PAL DVD players, you must create two titles 
and two versions of the sources (including all graphics and video, which will require 
significant effort), one for each standard. 

About the Terms “NTSC” and “PAL”
The terms “NTSC” and “PAL” are technically incorrect when used with respect to DVDs. 
These terms specify a variety of things with respect to an SD composite video signal. 
When you refer to a video asset as NTSC or PAL with respect to SD-based DVDs, you 
are defining the asset’s frame rate and resolution. With most HD assets, the terms 
NTSC and PAL refer only to the frame rate, since the resolution is far different than an 
SD video asset.

Dual-Standard DVD Players
Many DVD players in PAL countries can also play NTSC DVD-Video titles. It’s important 
to understand that these players do not convert NTSC video to PAL—they simply 
output the NTSC sources. You must connect an NTSC or dual-standard video monitor in 
order to view the output. Additionally, be aware that all DVD players have a region code 
that prevents them from playing DVD-Video titles not intended for the player’s region.
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Using 24 fps Video
Often the video content for a DVD project originates from film shot at 24 frames per 
second (actually 23.976 fps). The DVD specification allows you to include 24 fps MPEG-2 
assets as long as they are properly flagged so the DVD player can decode them by 
either using a 3:2 pulldown (for NTSC DVD players) or playing them 4% faster (for PAL 
DVD players). The video resolution also must match those allowed for the intended 
video standard. See “Choosing a Video Resolution” on page 57 for details on supported 
video resolutions.

This means that there are NTSC and PAL versions of 24 fps MPEG-2 assets, and you can 
only use NTSC 24 fps assets in NTSC projects and PAL 24 fps assets in PAL projects.

Encoding video that originates with a 24 fps rate as a 24 fps MPEG asset has two 
primary advantages: 

• Less time is spent on the encoding process. 
• Smaller files are produced.

These advantages are due to fewer frames being encoded, especially when compared 
to NTSC frame rates.

Importing 24 fps Assets
How DVD Studio Pro handles your 24 fps assets depends on whether or not they are 
already MPEG-2 encoded:
• If you import 24 fps MPEG-2 assets, they are handled correctly and remain 24 fps when 

you build the project.

Note:  24 fps assets show as their display rate setting when viewed in the Track Editor. 
This makes them appear as if they were at the NTSC or PAL frame rate. You can 
confirm they are actually 24 fps by selecting them in the Assets tab and verifying the 
frame rate in the Asset Inspector.

• If you import 24 fps QuickTime assets, they are encoded as either 29.97 fps or 25 fps 
MPEG-2 files, based on your project’s video standard, and are no longer 24 fps when 
you build the project.

To create a 24 fps MPEG-2 asset, you need to use Compressor (included with 
DVD Studio Pro) or a third-party encoder that supports encoding 24 fps MPEG-2 assets.

Using 24 fps Video in Tracks
You can use 24 fps video assets in tracks just like you would use regular 29.97 fps or 25 
fps video assets, as long as they match the project’s video standard (NTSC or PAL). You 
can also combine 24 fps assets with regular video assets within a track, as long as they 
use the same resolution.
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Using 24 fps Video in Menus
You can use 24 fps assets in menus as backgrounds or assets for buttons and drop 
zones. You can also combine 24 fps assets with regular video assets within a menu.

If the menu must be rendered because it contains shapes, drop zones, or text objects, it 
is rendered at the project’s frame rate, even if the menu’s background is 24 fps.

Choosing an Aspect Ratio
The aspect ratio is the ratio of the width of the visible area of the video frame to the 
height of the visible area. Standard NTSC and PAL monitors have a picture aspect ratio 
of 4:3 (or 1.33, which is the width divided by the height). Some High Definition 
Television (HDTV) formats have a picture aspect ratio of 16:9, or 1.78. 

The DVD specification supports both 4:3 and 16:9 sources, but it does not support HD 
video. Most HD video formats use a combination of features to create the high 
definition image, including a much larger frame size than DVD-Video supports. 

HD-based DVDs also support both 4:3 and 16:9 sources, as well SD and HD video formats.

Using 16:9 sources in your project raises a number of issues that you need to be aware 
of. Your main goal is to ensure that 16:9 assets play back correctly on 16:9 monitors and 
as expected on 4:3 monitors (and that 4:3 assets play correctly on both monitor types 
as well). Incorrect settings can lead to distorted video. For example, the video may 
appear horizontally compressed (objects look “skinny”) or expanded (objects look “fat”).

This illustration shows the viewing options for a 16:9 asset.

16:9 monitor

16:9 aspect ratio

16:9 anamorphic
(The dashed line shows
the circle’s original size.)

16:9 letterbox 16:9 pan-scan

16:9 video on 4:3 monitors
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This illustration shows the viewing options for a 4:3 asset.

Read the following sections to find out more about using 16:9 assets in your projects.

What Exactly Is a 16:9 Asset?
When you decide to use 16:9 assets in a DVD Studio Pro project, it is crucial that you 
understand exactly what attributes your 16:9 media should have.

16:9 and SD Projects
The DVD specification and DVD Studio Pro require 16:9 video to be anamorphic. An 
anamorphic 16:9 video frame has the same number of pixels as a 4:3 video frame. 
When displayed on a 16:9 monitor, the frame is horizontally stretched to fit the screen, 
and the content appears normal. When viewed on a 4:3 monitor, however, the video 
content appears horizontally compressed (see the illustrations in the previous section).

The most common error is to letterbox your 16:9 video assets before bringing them 
into DVD Studio Pro. Once a 16:9 asset has been letterboxed, it becomes a 4:3 asset 
with black bars along the top and bottom of the video image. If you flag letterboxed 
source video as 16:9 video when encoding it, you will have problems when you play it 
back later.

16:9 and HD Projects
HD projects can use a wide variety of video resolutions. Several of these are true 16:9 
(1280 x 720p and 1920 x 1080i) while several others use the same anamorphic method 
used in SD projects (720 x 480p, 720 x 576p, and 1440 x 1080i).

4:3 monitor

4:3 aspect ratio

4:3 stretched
(The dashed line shows
the circle’s original size.)

4:3 video on 16:9 monitors

4:3 pillar box
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Using Pan-Scan to Display 16:9 Video
The pan-scan method of displaying 16:9 video on a 4:3 monitor was developed as a 
compromise between letterbox, which displays all the video content but with black 
areas at the top and bottom, and the only other alternative:  filling the entire 4:3 
screen, but cropping some of the content. With pan-scan, you can choose which bits of 
the 16:9 content to crop, ensuring the action is not lost by displaying the center of the 
screen only. The pan-scan method can result in sudden jumps from one side of the 
screen to the other (for example, to follow a conversation’s dialogue), which may make 
your video look as if edits have been made.

To make pan-scan work, you must have a pan-scan vector, a frame-based value that 
controls which part of the content to use. Someone watching the video creates the 
vector, deciding which parts should be seen. This vector must be available when the 
video is MPEG-encoded. The MPEG encoder included with DVD Studio Pro does not 
support pan-scan vector information. However, if the information is already part of an 
MPEG-encoded video stream, created with an encoder that supports the vector 
information, DVD Studio Pro passes this information along.

Virtually all movies shown on TV have been through the pan-scan process; however, 
pan-scan vectors are rarely used for movies released on DVD. Instead, a version of the 
movie is made using the 4:3 pan-scanned source, and is not intended to be played as a 
16:9 video on 16:9 monitors. The other side of the disc often contains the true 16:9 
version, set to display as letterboxed video on 4:3 monitors.

Important:  Do not use pan-scan if your video does not actually support it. If you do, 
only the center part of the frame will appear.

MPEG Encoding and 16:9 Video
It’s important to correctly identify your source video as either 4:3 or 16:9 before 
encoding it. At this point, you are only identifying it—you are not defining how it 
should be handled when played back. When using the embedded MPEG encoder, you 
can select the video’s aspect ratio in the Encoding pane of DVD Studio Pro Preferences.

Using 16:9 Assets in Tracks
Each track within a DVD Studio Pro project has an aspect ratio setting. This setting lets 
the DVD player know how to display the video when playing the title back.

With a 16:9 track, you specify how it will play back on a 4:3 monitor:  Pan-Scan, 
Letterbox, or Pan Scan & Letterbox (allowing the viewer to choose). As mentioned 
previously, pan-scan is rarely used, and should never be selected unless the encoded 
video contains pan-scan vector information.
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Mixing 16:9 and 4:3 Assets in a Track
Keep in mind that a track’s aspect ratio setting applies to the entire track. If you mix 
16:9 assets with 4:3 assets in a track, you will have problems when playing it back. For 
example, if you set the aspect ratio to 16:9 Letterbox, the 4:3 video will also be 
letterboxed, and end up looking vertically compressed.

To be safe, do not mix 16:9 and 4:3 assets in the same track. Instead, create separate 
tracks for each. You can use the Connections tab in DVD Studio Pro to control the 
playback order of the tracks.

Some Players Cheat!
Unfortunately, not all players handle 16:9 video correctly. The aspect ratio setting for 
each track is stored in the track’s video title set file (vts_01_1.vob, for example). Most 
DVD players read the setting and process it correctly, but some DVD players ignore this 
setting and instead look at the aspect ratio setting of the video itself. For the most part, 
this works out, but it can result in inconsistencies when playing the title on different 
DVD players, particularly if you are not careful while encoding and authoring.

Buttons Over 16:9 Video Tracks
To place a button over a video track, you add a menu overlay to a subtitle stream in the 
track. These overlays are not processed in the same way as the video, so you must 
create a separate overlay for each display mode (16:9, 4:3 letterbox, and 4:3 pan-scan). 
You then need to create a script that selects the correct subtitle stream to display 
based on the DVD player’s settings.

See “What Happens With Different Aspect Ratios?” on page 442 for information on 
using subtitle streams to place buttons over a video track, and see Chapter 14, 
“Creating Scripts,” on page 467 for information on creating scripts.

Using 16:9 Assets in Menus
Typically you’ll want to use 16:9 menus with 16:9 tracks. Most of the same concerns 
with video apply to menus as well—specifically how the 16:9 menu is displayed on a 
4:3 monitor. 

With a 16:9 menu, you specify how it will play back on a 4:3 monitor:  Pan-Scan, 
Letterbox, or Pan Scan & Letterbox (allowing the viewer to choose). As mentioned 
previously, pan-scan is rarely used, and should never be selected unless the encoded 
video contains pan-scan vector information.

See “Understanding Pixel Differences in Graphics and Video” on page 84 for 
information on the image size settings you should use when creating 16:9 menus.
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Issues With Film Aspect Ratios
While 16:9 is a fairly wide aspect ratio, it is not wide enough to contain an entire frame 
from a typical Hollywood movie. Two film aspect ratios are widely used now:  Normal is 
1.85:1 and Panavision is 2.35:1 (for comparison, 16:9 is 1.78:1). For normal titles (those 
that use the 1.85:1 aspect ratio), a small amount of letterboxing or pan-scan cropping is 
required to transfer the title to DVD, but for Panavision titles significant letterboxing or 
pan-scan cropping is necessary. This processing must be done before the video is 
MPEG-encoded. The DVD specification supports only 4:3 and 16:9 aspect ratios.

You should not be surprised to see some letterboxing when playing a Panavision movie 
on a 16:9 monitor.

About MPEG Video
MPEG (Moving Picture Experts Group) is a family of video and audio compression 
formats that make high-quality titles possible on DVD. There are a broad range of 
MPEG types and settings; use care to select those that are DVD-compliant with the 
DVD standard (SD or HD) you are using. DVD Studio Pro imports MPEG assets created 
with a wide variety of third-party products. The following section provides a general 
overview of MPEG, as well as details that relate specifically to DVD Studio Pro and its 
embedded MPEG encoder.

Encoding Video Materials for DVD
The DVD specification requires video movies to be in a DVD-compliant MPEG format. 
There are a number of methods for converting video from its current format to MPEG. 

DVD Studio Pro includes an embedded MPEG encoder, which can quickly encode your 
QuickTime movies into DVD-compliant MPEG-2 files. See “Using the Embedded MPEG 
Encoder” on page 62 for more information.

For analog sources, you need a hardware video capture card to digitize your video. 
Depending on the card’s output format, you may then need a transcoder to convert 
it to MPEG.

2.35:1 (Panavision)

1.85:1 (Normal film)

1.78:1 (16:9)

1.33:1 (4:3)
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Elementary and Multiplexed MPEG Files
There are two common types of MPEG file structures:  elementary and multiplexed. 
Elementary files contain only one stream of data, either the video or the audio. 
Multiplexed MPEG files, also known as system, transport, or program files, have the video 
and audio combined into a single file. 

If you import MPEG files directly into DVD Studio Pro, they must be elementary MPEG files. 
You can use an MPEG utility to convert multiplexed MPEG files into elementary streams. 
The embedded MPEG encoder converts QuickTime files into elementary MPEG streams.

When creating an HD project, you can import HDV and H.264 streams, both of which 
are multiplexed QuickTime streams.

Choosing Between MPEG-1 and MPEG-2
The DVD specification allows for the use of either MPEG-1 or MPEG-2 encoded video. In 
general, MPEG-1 provides for smaller file sizes but reduced picture quality (by scaling a half-
screen image to full screen), while MPEG-2 provides for better quality with larger file sizes. 
• MPEG-1 is generally used for titles for which file size is critical, and that will be played 

back on a computer (not a set-top DVD player).
• MPEG-2 is usually used for DVD titles on DVD media. The embedded MPEG encoder 

encodes video into MPEG-2.

DVD Studio Pro works with both MPEG-1 and MPEG-2 video assets in your SD project 
tracks, as long as they are DVD-compliant. MPEG-1 video used as menu backgrounds is 
rendered to full D1 MPEG-2 when the project is built.

Important:  HD projects cannot use MPEG-1 video.

Choosing a Bit Rate for SD Projects
Bit rate directly determines file size, and thus how many minutes of material you can fit 
onto a DVD disc. SD-based DVD players support combined bit rates of up to 10.08 
megabits per second (Mbps), but this must include the audio and subtitles as well. The 
maximum video bit rate is 9.8 Mbps.

Note:  Some DVD players have trouble playing video that uses sustained high bit rates. 
On such players, you may see dropped frames during playback.

Typical maximum bit rates used for video are around 8 Mbps. The maximum 
MPEG-1 bit rate is 1.856 Mbps, while 1.15 Mbps is most typical.

The actual video content determines how low a bit rate you can use and still get acceptable 
quality. Video with little movement works well at lower bit rates, while higher bit rates are 
best at handling video with a lot of movement (a quick camera pan, for example).

For more information on choosing a bit rate that ensures all the content in your project 
will fit on a DVD, see “Making Sure Your Content Will Fit” on page 40.
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Choosing a Bit Rate for HD Projects
Choosing a bit rate for use in HD projects is similar to doing so for SD projects, but 
there are some differences.

The maximum overall bit rate for HD projects is 30.24 Mbps. While an HD project can use 
both SD and HD video assets, the maximum bit rate you can use is different for each:

• HD assets:  29.4 Mbps

Note:  HD assets include the 480p and 576p resolutions.

• SD assets:  15.0 Mbps

MPEG Encoding Methods
There are three common methods of encoding video:  CBR (constant bit rate, also known 
as one-pass), one-pass VBR (variable bit rate), and two-pass VBR. 
• CBR (one-pass) method:  You choose a bit rate and it is used for the entire video, 

regardless of its content. The advantage of this method is that you can reliably 
predict the final encoded file size. By adjusting the bit rate, you can ensure the video 
will fit on the DVD. The disadvantage is that the same bit rate gets applied to all of 
the video, regardless of the motion content. You must choose a high enough bit rate 
to provide acceptable results for the scenes with motion, even if they are only a small 
part of the movie.

• One-pass VBR method:  You choose a basic bit rate and a maximum bit rate. The 
encoder detects the amount of motion present in the video as it encodes, and 
adjusts the bit rate appropriately—scenes with motion use higher bit rates (up to the 
maximum setting you choose) and scenes with little motion use the lower, basic bit 
rate. The disadvantage of this method is that the quality will not be as good as with 
the two-pass VBR method. 

• Two-pass VBR method:  You choose a basic bit rate and a maximum bit rate, just as 
with the one-pass VBR method. The difference is that the encoder makes two passes 
through the video to encode it. The first pass examines the video to learn about its 
motion content. The second pass performs the encode, varying the bit rate to 
provide better results in scenes with motion (as compared to the one-pass VBR 
method). The disadvantage of this method is that it takes twice as long as the one-
pass VBR method.

Important:  With the VBR methods, the basic bit rate setting determines the encoded 
file size. The maximum bit rate setting does not affect the file size. Additionally, the VBR 
methods are most effective when the maximum bit rate is about double the basic bit 
rate, or at least 1 to 3 Mbps higher than the basic bit rate.

The embedded MPEG encoder allows you to select which of these methods you want 
to use.
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Choosing a Video Resolution
The resolution determines the number of pixels processed within a frame. The more 
pixels used, the sharper the details in the image. Note that regardless of the resolution 
you choose, most DVD players play back at full screen. The following is a list of 
common resolutions used with MPEG-1 and MPEG-2 video with DVD Studio Pro. 

Note:  Menus must use full D1 resolution MPEG-2 video. If you assign any other 
resolution or an MPEG-1 asset, the video will be transcoded to full D1 MPEG-2 when 
you build the project.

SD Projects
SD projects can use the following resolutions:

NTSC
Frame rates with an “i” indicate the interlaced scanning method; those with a “p” 
indicate the progressive scanning method. With the exception of 352 x 240, all 
resolutions are MPEG-2 only.

PAL
Frame rates with an “i” indicate the interlaced scanning method; those with a “p” 
indicate the progressive scanning method. With the exception of 352 x 288, all 
resolutions are MPEG-2 only. 

Resolution Frame rate Aspect ratio Notes

352 x 240 29.97i 4:3 Also known as SIF format; MPEG-1 or MPEG-2

352 x 480 29.97i 4:3 Also known as 1/2 D1

704 x 480 29.97i 4:3, 16:9 Also known as Cropped D1; 16:9 is anamorphic

720 x 480 29.97i 4:3, 16:9 Also known as Full D1; 16:9 is anamorphic

Resolution Frame rate Aspect ratio Notes

352 x 288 25i 4:3 Also known as SIF format; MPEG-1 or MPEG-2

352 x 576 25i 4:3 Also known as 1/2 D1

704 x 576 25i 4:3, 16:9 Also known as Cropped D1; 16:9 is anamorphic

720 x 576 25i 4:3, 16:9 Also known as Full D1; 16:9 is anamorphic
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HD Projects
HD projects can use the following resolutions:

Note:  MPEG-1 video is not supported.

NTSC
Frame rates with an “i” indicate the interlaced scanning method; those with a “p” 
indicate the progressive scanning method.

PAL
Frame rates with an “i” indicate the interlaced scanning method; those with a “p” 
indicate the progressive scanning method.

Picture Frame Rate
DVD Studio Pro NTSC projects support the NTSC frame rate (29.97 fps) and 23.976 fps 
assets that use NTSC video resolutions. PAL projects support the PAL frame rate (25 fps) 
and 23.976 fps assets that use PAL video resolutions. You can set a project’s video 
standard in the General tab in the Disc Inspector or in the Project pane of 
DVD Studio Pro Preferences.

Resolution Frame rate Aspect ratio Notes

352 x 240 29.97i 4:3 Also known as SIF format

352 x 480 29.97i 4:3 Also known as 1/2 D1

704 x 480 29.97i 4:3, 16:9 Also known as Cropped D1; 16:9 is anamorphic

720 x 480 29.97i 4:3, 16:9 Also known as Full D1; 16:9 is anamorphic

720 x 480 59.94p 16:9 HD only, also known as 480p; is anamorphic

1280 x 720 59.94p 16:9 HD only, also known as 720p

1440 x 1080 29.97i 16:9 HD only; 16:9 is anamorphic

1920 x 1080 29.97i 16:9 HD only, also known as 1080i

Resolution Frame rate Aspect ratio Notes

352 x 288 25i 4:3 Also known as SIF format

352 x 576 25i 4:3 Also known as 1/2 D1

704 x 576 25i 4:3, 16:9 Also known as Cropped D1; 16:9 is anamorphic

720 x 576 25i 4:3, 16:9 Also known as Full D1; 16:9 is anamorphic

720 x 576 50p 16:9 HD only, also known as 576p; is anamorphic

1280 x 720 50p 16:9 HD only, also known as 720p

1440 x 1080 25i 16:9 HD only; 16:9 is anamorphic

1920 x 1080 25i 16:9 HD only, also known as 1080i

Warning:  You cannot mix NTSC and PAL MPEG assets in a project.
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Working With GOP Settings
A major function of MPEG encoding is to identify redundancy not only within a frame, 
but also among a group of frames. A scene with no movement except a car driving by 
has a lot of redundancy over time. In this case, a single complete frame could provide the 
majority of the video; subsequent frames only need to provide for the areas that change. 
Each MPEG stream contains three types of frames that define the video. A Group of 
Pictures (GOP) setting defines the pattern of the three frame types used:  Intra (I) frames, 
Bi-directional (B) frames, and Predicted (P) frames. 
• I-frames, also known as reference or key frames, contain the complete image of the 

current frame, without reference to frames that precede or follow it. The I-frame is 
the only type of MPEG frame that can stand by itself, without requiring information 
from other frames in the GOP. Every GOP contains one I-frame, although it does not 
have to be the first frame of the GOP. I-frames are the least efficient MPEG frame 
type, requiring the most disc space. Markers on a DVD track can be placed only at 
I-frames.

• P-frames are encoded from a “predicted” picture based on the closest preceding I- or 
P-frame. P-frames are also known as reference frames, since neighboring B- and P-frames 
can reference them. P-frames typically require much less disc space than I-frames.

• B-frames are encoded based on an interpolation from I- and P-frames that come 
before and after them. B-frames are the most efficient MPEG frame type, requiring 
the least amount of disc space. While a GOP can begin with a B-frame, it cannot end 
with one.

The goal of encoding video to MPEG is to reduce the video file size as much as possible 
while maintaining good quality. The B- and P-frames are what make MPEG so good at 
compressing video into such small files. Since they only contain information about 
what has changed in the images, they use much less disc space than I-frames. 

There are three aspects to choosing a GOP setting:  the GOP pattern, the GOP length, 
and whether the GOP is “open” or “closed.”
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(IBBP, 15 Frames)
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GOP Pattern
The GOP pattern determines the ratio of P- to B-frames within a GOP. The most 
common patterns used for DVD are IBP and IBBP. All three frame types do not have to 
be used in a pattern; an IP pattern is also used in special circumstances. 

IBP and IBBP GOP patterns, in conjunction with longer GOP lengths, produce the most 
efficient encodes. Smaller GOP patterns with shorter GOP lengths work better with 
video that has quick movements. 

Some encoders can force I-frames to be added sporadically throughout a stream’s 
GOPs. These I-frames can be placed manually by someone watching for sudden video 
changes or automatically by an encoder detecting scene changes. You can place 
markers in Final Cut Pro to identify specific frames to have an I-frame, either for use as a 
chapter marker or to manually identify high motion areas. See “Adding Markers to Your 
Video” on page 70 for more information.

The embedded MPEG encoder uses a GOP pattern of IBBP.

GOP Length
Longer GOP lengths produce more efficient encodes by reducing the number of 
I-frames, but are less desirable during short-duration effects such as quick fades and 
quick camera pans. 

SD-Based DVDs
The maximum GOP length for SD projects is 18 frames for NTSC or 15 frames for PAL. 
The minimum GOP length depends on the GOP pattern. For example, an IP pattern can 
have a length as short as two frames.

The embedded MPEG encoder uses a GOP length of 15 frames for NTSC and 12 frames 
for PAL SD assets.

HD-Based DVDs
Since HD projects can use both interlaced and progressive video assets, they have 
different GOP length maximums.
• NTSC interlaced assets:  18 frames per GOP
• NTSC progressive assets:  36 frames per GOP
• PAL interlaced assets:  15 frames per GOP
• PAL progressive assets:  30 frames per GOP

Note:  24p assets have their GOP structure based on their display rate, not the encoded 
rate. A 24p asset encoded to play in an NTSC project has a display rate of 29.97 
interlaced frames (with an 18 frames per GOP maximum) or 59.94 progressive frames 
(with a 36 frames per GOP maximum).

The embedded MPEG encoder uses a GOP length of 15 frames for NTSC and 12 frames 
for PAL.
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Open or Closed GOPs
An open GOP allows the B-frames from one GOP to look at an I- or P-frame from an 
adjacent GOP. Open GOPs are more efficient, but cannot be used with multi-angle or 
mixed-angle titles. A closed GOP keeps all references within itself, standing alone with 
respect to other GOPs. DVD Studio Pro works with either type in single-angle titles, and 
requires closed GOPs with multi-angle and mixed-angle titles.

It is important to know that the same pattern can provide different results when used 
with an open or closed GOP. For example, the embedded MPEG encoder uses a closed 
GOP type, and it starts its IBBP pattern with an I-frame. Other encoders using an open 
GOP may start with a B-frame. In this case, starting with a B-frame is a little more 
efficient; if you start with an I-frame, an extra P-frame must be added to the end (a GOP 
cannot end with a B-frame).

General Quality Issues
The quality of the MPEG encoding determines the quality of the title. It is well worth 
putting some effort into getting the best possible MPEG encoding environment. For 
example, start with the best quality source material you can. An uncompressed digital 
source is the best, followed by a DV source, and then an analog Component source. Of 
the other analog formats, S-Video (Y/C) is much preferable to Composite. 

Noisy Video
Since a large portion of MPEG’s compression power depends on its ability to locate 
areas of the image that do not change between successive frames, “noisy” video can 
reduce the efficiency of MPEG encoding. While the actual video may be identical 
between two frames, if there are noise artifact differences between the two frames, 
they are detected as a change in video and require more bits to encode. A lot of noise 
causes poor encodes, because the encoding resources are tied up trying to faithfully 
reproduce the noise.

Transcoding Artifacts
Every time video is transcoded from one format to another—for example, from analog 
to digital, or DV to MPEG-2—artifacts are introduced into it. The visibility of these 
artifacts depends on the quality of the transcoding device and the content. While 
transcoding cannot be avoided, its effects can be minimized. Use the highest quality 
equipment and software you can, and choose products that work well together and 
support each other’s formats.



62 Chapter 2    Preparing Assets

 

Using the Embedded MPEG Encoder
When you install DVD Studio Pro, you also install an embedded MPEG encoder. 

The embedded MPEG encoder outputs an MPEG-2 video stream with a closed GOP 
pattern and a fixed GOP size (15 frames for NTSC and 12 frames for PAL). The exported 
MPEG video stream can be used for multi-angle tracks. The file type is “.m2v.”

If the file to be encoded has audio multiplexed together with the video, the audio is 
encoded as a PCM audio file and given the same name as the video file, but with an 
“.aiff” extension. See “Preparing Audio Sources” on page 77 for more information on 
audio formats.

Configuring the Embedded MPEG Encoder
DVD Studio Pro Preferences contain the settings that determine how DVD Studio Pro 
uses the embedded MPEG encoder.

To configure the embedded MPEG encoder:
1 Choose DVD Studio Pro > Preferences.

2 Click Encoding to open the Encoding pane.

3 Configure the settings in the Encoding pane. See the following sections for information 
about the options in this pane. 

4 Click Apply to enable the settings, then click OK to close the Preferences window.

Transcoding With the Embedded MPEG Encoder
If you import a QuickTime asset whose video standard is different from the project’s 
current setting, the embedded MPEG encoder automatically transcodes the asset to 
the project’s video standard while encoding it. For example, if you are working on a 
PAL project and accidentally import an NTSC QuickTime file, the NTSC file is encoded 
as a PAL asset and is imported into the project.

You should be aware, though, that the embedded MPEG encoder is not intended to 
transcode video from one video standard to the other, and the results you get are 
usually not suitable for use in a project. Compressor and a variety of third-party 
products can provide good transcoding results, as well as facilities that specialize in 
video standards conversion.
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Encoding Preferences

The Encoding pane of DVD Studio Pro Preferences contains two tabs:  MPEG-2 SD and 
MPEG-2 HD. Each tab has the same settings, with the exception of the higher bit rate 
settings allowed in the MPEG-2 HD tab.

The settings in the MPEG-2 SD tab are automatically applied to QuickTime video assets 
with an SD video resolution, and the MPEG-2 HD tab’s settings are applied to 
QuickTime video assets with an HD video resolution. (An exception are H.264 and HDV 
QuickTime assets, which are already properly encoded.) 

Settings in the MPEG-2 SD and MPEG-2 HD Tabs
• Aspect Ratio:  Select the aspect ratio of the video to be encoded. There are special 

issues to be aware of:
• For HD video assets, only the 16:9 aspect ratio is supported.
• For SD video assets, selecting 16:9 does not convert the video to the 16:9 aspect 

ratio. The file to be encoded must already be in a 16:9 anamorphic format. See 
“What Exactly Is a 16:9 Asset?” on page 51 for more information.

• Start:  Sets the starting timecode of the encoded MPEG stream. This is most often set 
to match the timecode of the original video, ensuring that any timecode-based lists 
you have, such as a chapter list, marker positioning file, or subtitle file, match the 
encoded video.

• Drop Frame:  Select this checkbox to use drop frame timecode for assets using the 
NTSC frame rate.



64 Chapter 2    Preparing Assets

 

• Field Order:  Choose the field order (Top or Bottom) that matches the video being 
encoded. This is also known as the field dominance setting in other products. Each 
interlaced NTSC and PAL video frame is comprised of two fields, each containing 
every other video line. The top field is also known as field two, the upper field, or the 
odd field. The bottom field is also known as field one, the lower field, or the even field.

If the field order is set incorrectly, any motion in the video will appear very jagged 
when played back. Most professional and DV sources are field one dominant, and 
should use the Bottom setting. If you are unsure of the field order of your source 
video, choose Auto to let the encoder attempt to determine the field order.

Note:  The Field Order setting does not apply to progressive scan video.

• Encode Mode:  You can choose from three encoding modes, each with its own 
advantages and disadvantages.
• One Pass:  With this option selected, the encoder uses a one-pass encoding 

method with a constant bit rate (CBR).
• One Pass VBR:  With this option selected, the encoder uses the one-pass variable bit 

rate (VBR) encoding method.
• Two Pass VBR:  With this option selected, the encoder uses the two-pass VBR 

encoding method (one pass to create a motion profile of the video, and a second 
pass to perform the encode).

See “MPEG Encoding Methods” on page 56 for more information on the 
encoding methods.

Note:  The embedded MPEG encoder One Pass mode actually varies the bit rate a 
small amount.

• Bit Rate:  Set the bit rate for the One Pass encoding method, and the basic bit rate for 
the One Pass VBR and Two Pass VBR encoding methods. When using one of the VBR 
encoding methods, you cannot set Bit Rate any higher than 85% of the Max Bit Rate 
setting. See “Choosing a Bit Rate for SD Projects” on page 55 for more information.

• Max Bit Rate:  Set the maximum bit rate that can be used during a One Pass VBR or 
Two Pass VBR encode. You cannot set the Max Bit Rate setting lower than the Bit Rate 
setting or 5 Mbps (whichever is higher). Since the VBR methods are most effective 
when the maximum bit rate is about double the basic bit rate, or at least 1 to 3 Mbps 
higher than the basic bit rate, the Max Bit Rate setting is forced to be higher than the 
Bit Rate setting.

Note:  The Max Bit Rate setting does not affect the size of the encoded file—it only 
sets the upper limit that can be used during the encode.
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• Motion Estimation:  Choose a Motion Estimation setting that provides a balance 
between quality and speed of encoding. This setting controls how much time is 
spent determining the motion between video frames.
• Good:  The fastest Motion Estimation setting. This mode does well even with 

significant amounts of motion between frames, if the motion has minimal 
interfield motion within frames. For example, footage that has been exposed to 
frame-rate conversion or other effects processes tends to have little interfield 
motion. In general, use Good with the One Pass encoding mode.

• Better:  A good general purpose Motion Estimation setting. The Better mode 
provides good results even with complex interlaced motion. Better works well for 
almost all types of interlaced video sources, even shaky footage from hand-held 
consumer camcorders. In general, use Better with One Pass VBR and Two Pass VBR.

• Best:  This is the highest quality Motion Estimation setting and should be used for 
the most demanding and complex motion for interlaced sources. It is slower than 
the Better mode. In general, use the Best mode to maximize quality when using 
One Pass VBR or Two Pass VBR.

• Reset to Factory Defaults:  Click this to restore the current tab’s settings to the 
default settings.

Settings Outside of the Tabs
• Method:  Select when you want the asset to be encoded.

• Background encoding:  The encoding begins as soon as you import the asset. The 
encoding takes place in the background, allowing you to continue working on 
your project. A progress bar appears in the Status column of the Assets tab. Once 
the encoding process finishes, the Status column displays Done. See “Default 
Columns in the Assets Tab” on page 188 for more information.

• Encode on build:  The encoding does not start until you complete your project and 
build the VIDEO_TS or HVDVD_TS files. 

Note:  An advantage of selecting “Background encoding” is that, once the assets are 
encoded, the encoded versions of them appear in the Simulator and the Viewer 
when playing a track. This makes it possible to see the video as it will appear on the 
DVD, and not the QuickTime version. See “Is That the QuickTime or MPEG Encoded 
Version?” on page 66 for more information.
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Using the Embedded MPEG Encoder 
Depending on the Method setting in Encoding Preferences, video assets can either 
begin encoding as soon as you add them to your project, or they can wait until you 
perform a build of the project. 

When you import a QuickTime video asset into DVD Studio Pro, the current Encoding 
Preferences settings are assigned to it. If you change the Encoding Preferences settings 
after you have imported a QuickTime video asset, those changes will be applied only to 
new assets you import—they are not applied to existing assets.

Is That the QuickTime or MPEG Encoded Version?
When you import QuickTime assets and assign them to elements in your project, it 
can be important to know whether you are seeing the original QuickTime version of 
the asset or the MPEG encoded version in the Viewer or Simulator. Seeing the MPEG 
encoded version has the advantage of allowing you to see the video as it will appear 
when the DVD is played. The disadvantage of seeing the MPEG encoded version is 
that the video must be encoded first. 

The Method setting in the Encoding pane of DVD Studio Pro Preferences controls 
whether the encoded versions of the assets can be available while you are authoring 
the project. With “Background encoding” selected, you will be able to see the 
encoded versions of the assets as soon as they are encoded. With “Encode on build” 
selected, you will not be able to see the encoded versions until you build the project.

There are some guidelines DVD Studio Pro uses to determine whether to show the 
original QuickTime version of the asset or the MPEG encoded version:

• When you view an asset from the Assets tab in the Viewer, you will see the 
QuickTime version, whether the encoded version is available or not.

• When you view an asset from the Track Editor, you will see the encoded version (if 
available). This is also true when viewing the track in the Simulator.

• When you view an asset in the Menu Editor, you will see the QuickTime version, 
whether the encoded version is available or not. This is also true when viewing the 
menu in the Simulator.
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Verifying and Changing Encoding Settings
If your project contains a mixture of 4:3 and 16:9 assets, or has some assets you want to 
encode differently than others, you must be sure to set the Encoding Preferences 
settings before you import the assets. You can verify and change the encoding settings 
on assets that have been imported.

To change the encoding settings after importing an asset, do one of the following:
m Select the asset and choose File > Encoder Settings.
m Control-click the asset in the Assets tab, then choose Encoder Settings from the 

shortcut menu.
m Select the asset in the Assets tab, then press Command-E.

The Encoder Settings dialog appears with the same settings found in the Encoding 
Preferences pane, with HD projects getting an added Resolution setting. When you 
have the “Background encoding” method selected and you make any changes in this 
dialog, one of two things happens:

• If you change the bit rate setting, the current file, whether a complete or partially 
complete file, is left as is and the encoder starts encoding a new file. This allows you 
to compare the quality of the two bit rates. If you decide to continue the encoding of 
the partially completed file, you can set the bit rate (and all other settings, if you 
have made changes) to the value it used, and the encoder will continue encoding it.

Note:  If the encoded files are being written to the project bundle, they are deleted 
regardless of whether or not you change the bit rate setting.

• If you do not change the bit rate setting, the original asset is deleted, whether a 
complete or partially complete file, and a new encoded file is created. For example, if 
you want to see the difference between one-pass VBR and two-pass VBR encoding 
and want to keep the files from both encoding sessions, you need to rename or 
move the completed one-pass VBR encoded file before re-encoding with the 
two-pass VBR setting.

If you have the “Encode on build” method selected, these changes will apply once you 
build your project.

Encoding Settings in HD Projects
Since an HD project can use assets with a wide variety of video resolutions, the 
Encoder Settings dialog contains a Resolution pop-up menu that shows the asset’s 
resolution. You are also able to change an asset’s video resolution by choosing a setting 
from the Resolution pop-up menu. 

Note:  SD resolution assets (720 x 480i and 720 x 576i) in HD projects can use a bit rate 
up to 15 Mbps. The Bit Rate setting in the Encoder Settings dialog will not go beyond 
15 Mbps when an SD resolution is chosen. 
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Important:  Encoding an asset at a resolution other than its native resolution may result 
in unacceptable artifacts appearing in the video. 

How the Encoded Files Are Named
When you import QuickTime video assets into DVD Studio Pro, the embedded MPEG 
encoder names the encoded files as follows:
• The first half is the complete original filename, including its extension.
• The second half has three parts—the video standard (NTSC or PAL), the encoding bit 

rate (shown as a four-digit number), and the “.m2v” extension.

For example, if you import an asset named “Main Program.mov,” use the NTSC standard 
and a bit rate of 5.5 Mbps, the MPEG-encoded filename will be “Main 
Program.mov_NTSC_5500.m2v.

Audio files created by the embedded AIFF encoder use the original filename with an 
added “.aiff” extension.

Encoding Video for Multi-Angle Tracks
DVD Studio Pro supports multi-angle and mixed-angle video. With multi-angle video, 
a track can contain up to eight alternate video streams that last the entire length of 
the main stream (for a total of nine video streams per track). With mixed-angle video, 
the alternate streams do not last the entire length of the main stream, so you can 
have alternate streams in only those locations where they are needed, saving disc 
space. In either case, the viewer can switch among angles using the Angle button on 
the remote control.

Since different MPEG encoders can produce slightly different GOP structures, you 
should use the same encoder for all streams.

Note:  Switching angles while playing a DVD affects only the video playback. The audio 
remains on the currently selected stream.

Other Considerations for Mixed-Angle Tracks
Mixed-angle tracks provide the possibility of interesting playback scenarios. The 
illustration below shows a track that has two sections with three alternate angles, with 
playback set to angle 3.

Angle
1
2
3
4

Mixed-angle track with stream 3 playing 
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There are some additional considerations when creating a mixed-angle track:

• Within a track, you can use markers to define multiple sections to use additional 
angles, but each section must have the same number of streams. For example, you 
cannot have one section early in the track with two alternate streams and a section 
later in the track with three alternate streams—both sections must have either two 
or three streams.

• Each alternate angle section can be a different length, but all streams within a 
section must be the same length. For example, you can have one mixed-angle 
section early in the track that is 10 seconds long and a second mixed-angle section 
that is 20 seconds long. All alternate streams in the first mixed-angle section must be 
10 seconds long; all alternate streams in the second mixed-angle section must be 20 
seconds long.

• You cannot use still images in the V2 through V9 streams. You can use still images in 
the V1 stream as long as they are outside of the mixed-angle areas (places where 
video is present in the V2 through V9 streams).

Requirements for MPEG Streams in Multi- and Mixed-Angle Video
The embedded MPEG encoder produces streams that meet the criteria for multi- and 
mixed-angle use:
• With multi-angle tracks, all streams must be the same length. With mixed-angle 

tracks, all alternate streams in each mixed-angle section must be the same length.
• All streams must have the same resolution and frame rate.
• The length and pattern of GOPs (Group of Pictures) must be the same for all streams 

(angles). If you are not using the embedded MPEG encoder, use an encoder that 
allows you to turn scene detection off. 

• All GOPs should be closed. You will not be able to cleanly switch between the 
streams if you use open GOPs. 

Using Final Cut Pro and Compressor
In addition to the chapter and compression markers you can manually add to a video 
clip in Final Cut Pro and Final Cut Express, compression markers are automatically 
added at each edit point. 

The manually added chapter and compression markers (also known as named markers) 
are processed by the embedded MPEG encoder and by Compressor. Be sure to add 
identically placed chapter and compression markers to each video clip you intend to 
use in a mixed- or multi-angle track.

The embedded MPEG encoder ignores the automatic compression markers, since they 
can alter the GOP structure and make the clip unusable for mixed- and multi-angle tracks. 
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You can either set Compressor to process the automatic compression markers or ignore 
them. The Extras pane of the Compressor MPEG-2 presets includes an “Include chapter 
markers only” checkbox. Select the checkbox to force Compressor to ignore the 
automatic compression markers if you are encoding clips for use in a mixed- or multi-
angle track. See “Using Compression Markers to Improve the MPEG Encode” on page 71 
for more information about compression markers.

Maximum Bit Rates for Multi- and Mixed-Angle Tracks
The maximum bit rate for a multi- or mixed-angle track is different from other tracks. Due 
to the way the DVD specification requires video streams to be multiplexed together, the 
number of video streams determines the maximum video bit rate you can use. Following 
is a list of maximum combined bit rates (highest bit rate video stream + all audio streams 
+ all subtitle streams) you can use for each multi- and mixed-angle track:

SD Projects
• 5 angles or fewer:  8 Mbps maximum for the track’s combined bit rate
• 6–8 angles:  7.5 Mbps maximum for the track’s combined bit rate
• 9 angles:  7 Mbps maximum for the track’s combined bit rate

HD Projects
• 2 to 9 angles:  24 Mbps maximum for the track’s combined bit rate

Important:  When calculating the combined bit rate for a track, you only need to add in 
the bit rate of one video stream, but it needs to be the stream with the highest bit rate.

Adding Markers to Your Video
You can add markers to your tracks in the DVD Studio Pro Track Editor. You can use 
these markers in a variety of ways—the most common usage is to provide a place in a 
track to which a button on a chapter index menu can connect. 

Apple video editing applications—Final Cut Pro, Final Cut Express, and iMovie—let you 
add markers while you edit the video. You can also add markers with Compressor. 
There are two types of markers that are important to DVD Studio Pro:

• Chapter markers:  DVD Studio Pro can import these markers and display them in the 
Track Editor.

• Compression markers:  The embedded MPEG encoder uses these markers to place 
custom I-frames in the MPEG-encoded file.

Since DVD Studio Pro can import chapter markers added within Final Cut Pro, 
Final Cut Express, iMovie, and Compressor, you can choose to create the markers in the 
editing, compressing, or DVD authoring process. When you import video with chapter 
markers into DVD Studio Pro, you see the marker position and marker name you set 
appear in the Track Editor. The markers can then be edited within DVD Studio Pro 
exactly as if you had manually created them there.
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Note:  The markers embedded in MPEG files encoded with the DVD Studio Pro 4 version 
of the embedded MPEG encoder are not compatible with 1.X versions of DVD Studio Pro.

Placing Chapter Markers Exactly Where You Want Them
Adding markers in Final Cut Pro, Final Cut Express, iMovie, or Compressor offers the 
potentially large advantage of allowing you to position them on the exact frame where 
you want them to appear. 

When adding markers to a track in DVD Studio Pro, you can only place them at GOP 
boundaries. This means that you will often not be able to place them exactly where 
you want them. When you place the markers with a video editor, the embedded MPEG 
encoder automatically forces an I-frame at that position, placing a GOP boundary 
exactly at every marker and providing perfect marker placement. Markers placed in 
Compressor before using it to encode the video are also perfectly placed.

Using Compression Markers to Improve the MPEG Encode
MPEG encoding is based on the placement of I-frames, P-frames, and B-frames within a 
GOP (see “Working With GOP Settings” on page 59). The I-frames encode a complete 
frame, while the P-frames and B-frames only encode the parts of the video that change 
between the I-frames. When there is a sudden change in the video content on a P-
frame or B-frame, such as a cut to a new scene, the output of the MPEG encoder can 
have significant artifacts until it reaches the next I-frame.

The embedded MPEG encoder uses compression markers to force an I-frame into the 
encode at a specific frame, modifying the surrounding GOP structure to keep the 
encode DVD-compliant.

Adding compression markers at places in the video where sudden transitions occur can 
produce better MPEG encodes when you use the embedded MPEG encoder. You can 
manually place compression markers in Final Cut Pro and Final Cut Express. As with 
chapter markers, an I-frame is forced at their position. The difference is that 
compression markers do not import into DVD Studio Pro as chapter markers, and do 
not count against the 99 chapter marker limit for a track.

Note:  Final Cut Pro automatically adds compression markers at each edit point. These 
are not processed when encoding the video with the embedded MPEG encoder. Only 
compression markers you manually add in Final Cut Pro are processed. See “Using 
Final Cut Pro and Compressor” on page 69 for information on these markers 
and Compressor.



72 Chapter 2    Preparing Assets

 

About the Markers You Add in an External Editor
There are several issues to be aware of when adding chapter and compression markers 
in an external video editor:
• DVD tracks can support a maximum of 99 chapter markers. Since compression 

markers are only used in the MPEG encoding process, they do not count as chapter 
markers and do not count against the 99-marker limit. Since you can add several 
video assets to a single track in DVD Studio Pro, you must keep in mind that the 
99-marker limit applies to the total markers of all assets on the track.

• You cannot place markers closer than one second to each other or within one 
second of the clip’s start or end in the editor. This gives the encoder the flexibility to 
modify the GOP structures in that area to accommodate the added I-frame.

• If you are going to use a video asset to create a mixed-angle or multi-angle track, all 
video streams must have identical MPEG structures. If you add chapter or 
compression markers to one stream, you must add them at the exact same place in 
the other streams.

Adding and Configuring Markers in Final Cut Pro 
and Final Cut Express
Using Final Cut Pro or Final Cut Express, you can add markers to a clip or to a sequence. 
If you intend to export the markers for use with DVD Studio Pro, it is important that 
you place the markers correctly.
• If you export a clip by selecting it in the Browser, the chapter and compression 

markers can be exported.
• If you export a sequence by selecting it in either the Browser or the Timeline, only 

markers in the sequence will be exported—markers in any clips in the sequence 
are ignored.

For details on adding markers to clips and sequences, see the Final Cut Pro User Manual. 
The following instructions assume you are familiar with Final Cut Pro and 
Final Cut Express.

Note:  The following instructions are for Final Cut Pro 4 through Final Cut Pro 5, and all 
versions of Final Cut Express. If you are using a different version of Final Cut Pro, you 
may have different choices.
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To configure a marker in Final Cut Pro:
1 Select the marker and open the Edit Marker dialog.

2 Enter a name for the marker. 

This is the name that appears in the Track Editor in DVD Studio Pro and can be used as 
button text.

3 Click either Add Chapter Marker or Add Compression Marker. 

Text is added to the Comment area. 

Only chapter markers appear in DVD Studio Pro. Since each chapter marker forces an 
I-frame at that location, it is unnecessary for you to add both marker types.
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To export a Final Cut Pro or Final Cut Express movie with markers:
1 Do one of the following:

• If exporting a clip with markers, select the clip in the Browser.
• If exporting a sequence with markers, select the sequence in either the Browser or 

the Timeline.

2 Choose File > Export > QuickTime Movie. 

The Save dialog appears.

3 Choose the type of markers to export from the Markers pop-up menu.

Choose DVD Studio Pro Markers to export both compression and chapter markers, or 
choose the type (compression or chapter) you want to export. 

4 Ensure all other settings are correct, then click Save. 
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Adding Markers in iMovie
You can add up to 36 chapter markers in an iMovie movie. These markers can be used 
by either iDVD or DVD Studio Pro.

Note:  The following is based on iMovie 4 and iMovie HD.

To add chapter markers in iMovie:
1 Edit your movie in iMovie.

2 Click the iDVD button.

3 Position the playhead, using either the scrubber or timeline, to the point at which you 
want to insert a chapter marker.

Note:  You cannot export markers placed within one second of the start or end of the 
movie or within one second of each other.

4 Click Add Chapter in the iDVD pane. 

A marker is added at the playhead and an entry is added to the iDVD pane. The entry 
shows the marker’s position, the marker’s name, and its timecode.

5 Enter a name for the marker in the iDVD pane. 

By default, the marker is named with the project’s name. Since these names are 
imported into DVD Studio Pro and used to identify the markers and name buttons, you 
should be sure to enter appropriate names for each marker.

6 Add any additional markers, up to 36 total. 

7 Save the project.

Saving an iMovie project creates a reference movie that contains the edits and markers. 
It is this reference movie, which has the same name as the project, that you need to 
import into DVD Studio Pro. How you do this depends on whether you are using 
iMovie 4 or iMovie HD.

• iMovie 4 places the movie in the project’s folder. You import the movie using the 
same methods as importing other assets.

• iMovie HD saves the project as a package. In this case, you import the iMovie HD 
project using the same methods as importing other assets, and the movie 
automatically appears in the Assets tab. 



76 Chapter 2    Preparing Assets

 

About H.264 Video
You can use the H.264 video format, also known as MPEG-4 part 10 and the Advanced 
Video Codec (AVC), in your HD projects. The H.264 encoder is twice as efficient as the 
standard MPEG-2 encoder. When compared to encoding with MPEG-2, this means that 
with the H.264 encoder:
• You can use a lower bit rate to get the same quality, resulting in smaller files.
• You can use the same bit rate and get better quality with the same file size.

While DVD Studio Pro does not include an embedded H.264 encoder, Compressor 
includes presets specifically for use in HD projects. You are able to modify these presets 
to suit your specific needs.

H.264 Bit Rates 
The process of choosing a bit rate for H.264 video is similar to choosing a bit rate for 
MPEG-2 video—the higher the bit rate the better the quality, but the more disc space 
that is required. In general, you are able to use lower bit rates than you would use with 
an MPEG-2 encoder. 

While the maximum bit rates you can use are identical to MPEG-2 video, the minimum 
bit rates are lower.

H.264 Frame Sync Setting
The H.264 encoder in Compressor contains a Frame Sync setting. This setting defines 
how often the encoder places a key frame, similar to an MPEG-2 I-frame, in the stream. 
The value is in seconds, with one half second increments. The range is from 0.5 seconds 
to 5.0 seconds.

The smaller the Frame Sync value is, the more key frames are placed in the stream, 
which results in better quality but with a larger file size. Higher values result in a smaller 
file but with reduced quality. 

The Frame Sync setting does not affect where you can place markers in the Track Editor. 
Due to the structure of the H.264 stream, you are able to place a marker about every 
half second. 

Video format MPEG-2 range H.264 range

Standard definition 2.0 Mbps to 15.0 Mbps 0.5 Mbps to 15 Mbps

High definition 2.0 Mbps to 29.4 Mbps 1.5 Mbps to 29.4 Mbps
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Preparing Audio Sources
The DVD specification restricts the types of audio formats that you can include on a 
DVD. There are also restrictions on mixing audio of different types within a track or set 
of menus. There are also required audio formats to make a DVD-compliant disc.

Audio Formats Not Supported by the DVD Specification
If you import an audio format that is not supported by the DVD specification, 
DVD Studio Pro automatically uses the embedded AIFF encoder to transcode the audio 
file into an uncompressed AIFF format file. For example, if you import an MP-3 file (a file 
format that is not supported by the DVD specification), DVD Studio Pro creates an AIFF 
file from the MP-3 file and that is what is used by your project. 

Note:  Since an AIFF file is not compressed, its file size will be substantially larger than 
the original MP-3 file. If disc space is an issue, you can use the AC-3 encoder in the 
Compressor application to transcode the AIFF file to the Dolby Digital AC-3 format. See 
“Dolby Digital AC-3 Audio” on page 78 for more information.

Audio Formats Supported by the DVD Specification 
and DVD Studio Pro
The following audio formats are supported by the DVD specification and can be 
imported into DVD Studio Pro without using the embedded AIFF encoder.
• MPEG-1 Layer 2 audio
• Dolby Digital (AC-3) audio (mono up to six channels)
• DTS multichannel audio (preview not supported)
• WAVE audio (Windows uncompressed PCM audio; the most common Windows audio 

format)
• PCM audio (“raw” pulse code modulation audio; similar to WAVE, but without 

“header” and other file information)
• AIFF audio (Audio Interchange File Format—uncompressed PCM audio; the most 

common Macintosh audio format)

Using AAC Audio Files From the iTunes Music Store
DVD Studio Pro is able to import and use AAC format audio files purchased from the 
iTunes Music Store as long as the computer you are using them on is authorized to 
use them. If you import iTunes Music Store files that the computer is not authorized 
to use, DVD Studio Pro plays silence when it encounters those files. Additionally, if 
you select and try to play an iTunes Music Store file that the computer is not 
authorized to play in the Audio tab in the Palette, DVD Studio Pro plays silence. As 
with MP-3 files, AAC files are converted to AIFF files.
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Note:  When importing DVD-compliant audio files, DVD Studio Pro imports only 
elementary files (not multiplexed). See “Elementary and Multiplexed MPEG Files” on 
page 55 for more information.

Uncompressed PCM Audio
Uncompressed audio is typically referred to as PCM, although the files usually have a 
“.wav” or “.aif” extension. The DVD specification supports uncompressed PCM audio at 
sample sizes of 16 bits and 24 bits, and sample rates of 48 kHz or 96 kHz. Audio in this 
format is completely compatible with DVD players worldwide, and is of higher fidelity 
than data-compressed audio. The disadvantage of PCM audio is the relatively large file 
sizes, compared to compressed audio formats. 

Compressed Audio Formats
The DVD medium uses data-compressed (as opposed to sonically compressed) audio 
for two purposes:
• To deliver discrete surround audio (5.1)
• To conserve bandwidth and disc space, allowing more room for video. This is 

especially applicable in long-form material such as feature films, and especially when 
the smaller DVD-5 medium is the target. 

Data-compressed audio for DVD comes in a few forms, described next. 

MPEG-1 Layer 2 Audio
For DVD products in PAL, MPEG-1 Layer 2 audio is compatible with all players. For NTSC 
markets (North America, Japan), most (but not all) DVD players support playback of 
MPEG-1 Layer 2 audio. If you create NTSC titles using MPEG audio, be aware that there 
may be problems in playback on some players.

If you want to ensure that your data-compressed audio is compatible with all players 
for NTSC, using the AC-3 format is recommended. See the next section for information 
on encoding and authoring with AC-3 format audio.

Dolby Digital AC-3 Audio
There are two good reasons to use AC-3 format audio in your DVD production:
• To take advantage of 5.1 surround audio (five main speakers and a subwoofer—six 

channels of audio total), which is supported by AC-3 but not by MPEG-1 Layer 2 or 
PCM audio. 

• To produce stereo data-compressed audio that is fully compatible with every DVD 
player in the NTSC markets of North America and Japan. You may run into some 
compatibility issues with older DVD players in PAL countries.

You can use the AC-3 encoder in Compressor to encode everything from stereo to 5.1 
surround audio. See “Previewing AC-3 and DTS Audio” on page 79 for information on 
listening to surround audio. 
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DTS Audio
DTS (Digital Theatre Systems) is an alternative format for surround audio. 
DVD Studio Pro can import and use DTS audio files. 

DVD Studio Pro supports DTS ES audio that can have up to 6.1 channels, as well as 
audio that uses a 96 kHz sample rate and a 24-bit sample size.

Important:  All DTS audio imported into DVD Studio Pro must use the compacted file 
format, with a “.cpt” file extension.

See “Previewing AC-3 and DTS Audio” on page 79 for information on listening to 
surround audio. 

Previewing AC-3 and DTS Audio
In most cases, the best way to verify AC-3 and DTS audio is to burn a disc that you can 
play on a DVD player with suitable audio support. If you play the audio on your 
computer using its built-in audio support, the following happens:
• When you play AC-3 audio from the Assets tab, one of the editors (Track, Story, 

Slideshow, or Menu Editor), or the Simulator, the audio is automatically converted to 
2-channel stereo for playback through your computer. 

• Since there is no DTS decoder on your computer, you cannot hear DTS audio when 
played from the Assets tab, one of the editors (Track, Story, Slideshow, or Menu 
Editor), or the Simulator.

You are able to add an external AC-3 or DTS decoder to your computer to listen to your 
surround sound audio from the Assets tab, one of the editors (Track, Story, Slideshow, 
or Menu Editor), or the Simulator.

To configure DVD Studio Pro to use an external audio monitor:
1 Choose DVD Studio Pro > Preferences.

2 Click the Simulator icon to show the Simulator preferences.

3 Choose your external audio monitor device from the Playback Output section’s Audio 
pop-up menu. 

Common choices include Built-in Audio, for normal system audio, and Built-in Audio (S/
PDIF), which uses your system’s optical digital audio output (if available) to output the 
audio to an external AC-3 or DTS decoder.

4 Click Apply.

See “External Video and Audio Monitoring” on page 31 for more information.

Another option is to build your project and use the Apple DVD Player. Similar to 
DVD Studio Pro, you can configure DVD Player to use an external audio monitor.
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To configure DVD Player for external audio decoder support:
1 Start DVD Player.

2 Choose DVD Player > Preferences.

3 Click the Disc Setup icon to show the Disc Setup pane.

4 Choose the external audio device to use from the Audio Output pop-up menu.

5 Click OK.

Using Multiple Audio Formats in Your Project
A project can contain audio in a variety of formats; however, there are some restrictions 
regarding mixing formats within an element or group of elements, such as menus. 

When you are required to have the same audio format within an element or group of 
elements, all settings must be the same:

• Audio type:  AIFF, WAVE, PCM, AC-3, or MPEG-1 Layer 2
• Number of channels:  This is especially true with the AC-3 audio format, since it 

commonly supports a variety of channel configurations.
• Sample size:  16 bits or 24 bits
• Sample rate:  48 kHz or 96 kHz
• Bit rate:  64 kbps to 4608 kbps, depending on the audio type

Tracks
Each audio stream within a track can be in a different format. Within an audio stream, 
however, the audio format must be the same for all clips.

Menus
All menus within a video title set (VTS) must use the same audio format. DVD Studio Pro 
automatically creates additional VTS blocks as needed to support menus with different 
audio formats. See “VTS Editor” on page 588 for additional information.

Slideshows
When adding individual audio clips to each slide or when using multiple audio clips for 
overall audio, all clips must use the same audio format.
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Required Audio Formats for SD Projects
To ensure that a DVD will play on all SD-based DVD players, there is a DVD specification 
requirement that at least one stream of audio for each element be in a specific format.
• For NTSC DVDs, at least one of the audio streams must be either PCM or AC-3.
• For PAL DVDs, at least one of the audio streams must be either PCM or MPEG 

compressed audio.

Note:  HD projects can use any supported audio format and do not require specific 
ones to be present.

DVD Studio Pro verifies your project during the build process to ensure it is 
DVD-compliant. The build log shows any issues that are found; however, the build will 
continue and you can write your project to disc.

Preparing Menu Sources
The types of menu sources you need for your DVD project depend on the types of 
menus you want to use:
• Will the backgrounds be still images or contain full-motion videos?
• Will you use the provided shapes for your buttons or create your own?
• Will you use the standard method of creating menus or the layered method? 

Before you can know how to prepare your menu sources, you need to understand how 
DVD Studio Pro uses them. Following is an overview of what makes up a menu and 
how menus are used.

What Is a Menu?
Most DVD-Videos have at least one menu. The menu allows the viewer to choose what to 
see. If there are no choices to be made, such as with a looping movie at a sales kiosk, the 
disc can be configured to immediately begin playing the movie, and no menu is required.

For DVDs that have a number of viewing options—such as multiple movies, chapter 
selections, and bonus items—menus that are clear and logical can greatly enhance the 
viewing experience. Menus that are cluttered, clumsy, and confusing may cause 
viewers to become frustrated and give up trying to watch the title.

A menu consists of a background and one or more buttons. The background can be a 
simple still image or a full-motion video (a motion menu). The background may or may not 
contain content that relates to the buttons; it may be a scenic mountain view or a 
multilayered graphic including images for each button. Some menus may also have audio.
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Creating a Menu
Creating a menu involves two basic steps:  selecting the background graphic or video, 
and setting up the buttons. Selecting the background graphic or video is fairly simple; 
the only challenge is when you use multilayer Photoshop files. Setting up the buttons 
involves identifying where they are located by drawing boxes over them, and then 
setting up their actions (what happens when they are activated) and the colors to 
display for their different states.

DVD Studio Pro gives you two ways to create menus:  the standard method, which uses 
overlays and allows you to use shapes, templates, and add text; and the layered method. 

• The standard method is usually preferred. It is the most flexible, allowing you to mix 
overlays with shapes, to use either stills or videos as the menu background, and to 
include audio. You can also use the templates and styles included with 
DVD Studio Pro for quick and consistent menu creation. For more information on 
overlays, see “Creating Overlays” on page 86. For a description of shapes, see 
“Creating Shapes” on page 93. For information on the templates and styles feature, 
see “Using Templates, Styles, and Shapes to Create Your Menus” on page 303. See 
“Creating Video for Motion Menus” on page 91 for information on motion menus and 
setting the loop point. 

• The layered method does not use overlays, but instead uses layers in a Photoshop 
(PSD) file to describe each button’s possible states. This method cannot be used with 
motion menus and cannot include audio.

Creating Graphics to Use in Menus
When creating graphics for menus, you need to be aware of several considerations. 
Some of these apply to all menu types, and some are specific to certain menu types, 
such as layered menus, menus with a still background, or menus using an overlay.

Using Your Graphics Program
DVD Studio Pro is designed to import a wide variety of graphics formats, allowing you 
to use almost any graphics program to create the menus and overlays.

Supported formats include:

• Adobe Photoshop PSD files
• PICT format files
• BMP format files
• JPEG format files
• QuickTime image files
• Targa (TGA) format files
• TIFF (TIF) format files
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Additional support is also included for files that conform to the Adobe Photoshop 
(PSD) format. DVD Studio Pro can recognize individual layers and allows you to assign 
them to separate functions in a menu. You can even use the same file for several 
menus by selecting the appropriate layers to use for each menu.

• Layers for standard overlay menus:  When creating graphics for standard overlay 
menus, you can select the layer (or layers, as is often the case) to use as the 
background and the overlay. In this way, a single file can be used in several menus, 
even sharing elements (such as a background image). To avoid confusion, assign 
clear names to each of the layers. 

• Layers for layered menus:  When creating graphics for use as layered menus, in 
addition to the layer (or layers) that make up the background, you must create at 
least two layers for each button, one showing the selected state and the other 
showing the activated state. To show the normal state of each button, you can either 
build it into the background layer or create a third layer.

Tips for Creating Menu Graphics
Most of the following tips apply to all graphics programs. Several apply specifically to 
Adobe Photoshop, although similar issues may exist in other graphics programs.
• Make horizontal lines a minimum of three pixels thick so they won’t flicker on TV 

screens. For the same reason, avoid using typefaces with narrow lines. Serif fonts 
tend to be more prone to flicker than sans serif fonts. 

• Be sure to use a filter that constricts the colors in the graphic to NTSC or PAL color 
space. In order to support broadcast bandwidths, NTSC and PAL video must use 
colors that are substantially limited compared to those your graphics program can 
create. Highly saturated colors create the biggest problems and produce the biggest 
disappointments when viewed on a video monitor.

• Photoshop’s effects layers, transfer modes, and layer styles do not work with 
DVD Studio Pro. Be sure to flatten any of these before using them in DVD Studio Pro. 

Flattening a Photoshop Layer
When creating graphics within Adobe Photoshop, you may want to add effects such as 
bevels, glows, and shadows to a layer, use the transfer modes, or configure layer styles. 
These Photoshop effects and modes are not supported by DVD Studio Pro. However, 
you can “flatten” them in Photoshop so that they appear in DVD Studio Pro. 

Note:  Flattening effects is not the same as using the Flatten Image command, which 
combines all contents of all layers of a Photoshop file (including effects) into a single layer.

It’s a good idea to use this procedure on a copy of the original file, just in case 
something goes wrong.
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To flatten a layer of a Photoshop file:
1 Add a new empty layer immediately below the layer with the effects you want to 

flatten.

2 Either merge or stamp the layer with the effects into the empty layer. Merging deletes 
the effects layer, and stamping leaves the effects layer in place (which can be a good 
idea if you need to make changes to the layer later on). 

• To merge the layer, select it and choose Layers > Merge Layers, or press Command-E. 
• To stamp the layer, select it and press Option-Command-E.

A bitmap image of the effects layer is placed in the new layer. 

Understanding Pixel Differences in Graphics and Video
The term square pixel actually refers to the horizontal and vertical distance from a pixel 
to its neighbors. With a square pixel, the distance is the same in both directions. This 
distance is a function of the sampling rates, both horizontal and vertical, and the 
aspect ratio the graphic will be displayed in. Given the right aspect ratio, virtually any 
combination of horizontal and vertical sampling rates could produce square pixels.

Computer graphics programs are optimized to work with square pixels:   When you 
draw a square, it has the same number of pixels in all four of its sides and looks like a 
square on the display.

Unfortunately, SD video is different.

Video Pixels
Standard definition video uses a 4:3 aspect ratio. No matter what the size of the display, 
the height is always 75 percent of the width. This is true for both NTSC, which has 525 
lines in each frame (480 of these active with DVDs), and PAL, which has 625 lines per 
frame (576 active). Both standards also have 720 pixels per line when converted to MPEG.

To fit the 4:3 aspect ratio perfectly using square pixels and 720 pixels per line, there 
would have to be 540 lines in each frame. So for NTSC, which has 480 lines, the lines 
must be spaced slightly apart to fill the same area, resulting in rectangular pixels. For 
PAL, with 576 lines, they must be squeezed together slightly to fit.

The Settings pop-up menu in the DVD Studio Pro Menu Editor has a square/rectangular 
pixel selection that allows you to choose whether to view menu graphics as 
rectangular pixels (forcing a 4:3 aspect ratio) or as square pixels while creating menus. 
The Viewer tab also has the same settings. The Simulator always shows rectangular 
pixels, simulating what the viewer will see. 

The real problem arises when you create your menu graphics.
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Square Pixels in Graphics
Graphics programs use square pixels. If you set the dimensions of a graphic to 
720 x 480 pixels (the NTSC frame size), you will notice that the drawing area of the 
graphic in the graphics program is not a 4:3 aspect ratio (it is a bit short). If you set a 
graphic to PAL dimensions (720 x 576 pixels), the drawing area you see in your graphics 
program is taller than 4:3.

Anything you put in the graphic will be distorted (either vertically stretched or 
compressed, depending on your video standard) when viewed on a video monitor. If 
you draw a square, it will look like a rectangle. In some cases, the distortion is not great 
enough to worry about, but in most cases you should build your graphics with the 
distortion in mind. 

To compensate for pixel differences between graphics and video, you need to build the 
graphics at one size, and then rescale them to the appropriate video dimensions, as 
shown in the following table.

DVD Studio Pro will automatically rescale graphics that use the starting dimensions 
above. (Graphics that already use the rescale dimensions are imported without any 
rescaling.) If you rescale the graphics in your graphics program, they will appear 
distorted in the graphics program, but will be correct when viewed in DVD Studio Pro 
as rectangular pixels.

Note:  See “Shape Aspect Ratios” on page 96 for information on how DVD Studio Pro 
works with graphics used in shapes, buttons, and drop zones.

Aspect ratio Starting dimension Rescale dimension

NTSC 4:3 720 x 534 pixels 720 x 480 pixels

NTSC 16:9 864 x 480 pixels 720 x 480 pixels

PAL 4:3 768 x 576 pixels 720 x 576 pixels

PAL 16:9 1024 x 576 pixels 720 x 576 pixels
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HD Video Pixels
There are a variety of video resolutions supported by HD projects: 

Note:  HD projects can also use SD assets, which should use the same starting and 
rescale dimensions as in SD projects.

Creating Overlays
As viewers use the arrow buttons on the DVD player’s remote control to cycle through 
the buttons on a menu, they need some sort of indication as to which button is currently 
selected. If they activate the button, they need an indication of that, too. An overlay’s 
primary function is to show the viewer which button is currently selected or activated.

Note:  If you intend to use shapes for your menu buttons, you do not need to 
create overlays.

Overlays are still images that contain the graphics used to show each button’s three states 
(normal, selected, and activated). One overlay file contains all of the buttons. Part of the 
menu creation process in DVD Studio Pro is to identify each button and set its function.

The overlay is almost always used in conjunction with the background image. For 
example, the normal button art may be in the background, while the overlay supplies 
only the selected and activated highlights, such as a halo or checkmark. 

About Simple and Advanced Overlays
DVD Studio Pro allows you to choose whether to work with simple overlays that use a 
single overlay color, or advanced overlays that use up to four colors. Simple overlays are 
easier to create and configure, but are not as flexible when creating complex menus. 
Advanced overlays give you the ability to use multiple colors for a button’s selected 
and activated states.

Resolution Square pixels Starting dimension Rescale dimension

480p (NTSC; 16:9) No (anamorphic) 864 x 480 pixels 720 x 480 pixels

576p (PAL; 16:9) No (anamorphic) 1024 x 576 pixels 720 x 576 pixels

720p (NTSC, PAL; 16:9) Yes 1280 x 720 pixels 1280 x 720 pixels

1080i (NTSC, PAL; 16:9) Yes (anamorphic) 1920 x 1080 pixels 1440 x 1080 pixels

1080i (NTSC, PAL; 16:9) Yes 1920 x 1080 pixels 1920 x 1080 pixels
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About the Overlay Colors
Overlays can contain up to four colors. A peculiar feature of overlays is that the colors 
used to create them are not the colors that are displayed when viewers see the menu. 
The overlay only identifies the areas on the screen where highlights are to be 
applied—not the color or transparency of the highlights. You define the actual colors 
viewers see when you create the menu. 

When you use the simple overlay method, everything in the overlay graphic must be 
one of two colors:  the white background that is set to be transparent, and the black 
highlight graphic to which you assign a color and transparency. If you add an element 
to the overlay that has a soft glow around it or has been anti-aliased, the areas of the 
element that are not white or black will appear with additional highlight colors 
(controlled by the advanced overlay color mapping settings). In this case, you should 
either correct the graphic or use the advanced overlay method which allows you to 
control all of the highlight colors.

The elements in an advanced overlay use up to four different colors. This gives you the 
ability to use multiple highlight colors for a button or create pseudo-soft edges, and to 
take advantage of anti-aliased edges. See “Creating Advanced Overlays” on page 88 for 
more information. 

About Overlay Files
Whether you create simple or advanced overlays, the overlay must be a single flattened 
layer, either as part of a Photoshop (PSD) format file or as a separate file. 

It is common to have a single PSD file supply both the menu’s background and overlay. 
The DVD Studio Pro Menu Editor allows you to select as many layers as you want to use 
as the background, but you can only select a single layer as the overlay.

Note:  Don’t confuse a PSD file with layers (used to supply the background and overlay) 
with the type of PSD file used when creating layered menus. Standard menus contain 
all buttons’ selected and activated states within a single layer of the file; layered menus 
contain a separate layer in the PSD file for each button’s state (normal, selected, and 
activated). These layers are not overlays that you assign colors to—they are full-color 
images of the button in one of the three states. See “Creating a Layered Menu” on 
page 91 for more information.
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Creating Simple Overlays
With simple overlays, you must use only white and black to create the graphics. 

To create a simple overlay:
1 Create a full-screen white background. See “Square Pixels in Graphics” on page 85 for 

information on the frame size to use. 

2 Choose black and add the highlight elements to the background. Be sure to disable 
anti-aliasing and avoid using soft edges. Depending on your graphics application, 
choose to use a 1-bit or bitmap mode.

3 Depending on the graphics application you use, you may need to flatten the overlay 
elements into a single layer.

Creating Advanced Overlays
To create advanced overlays, you first need to understand how they are used and the 
difference between the chroma and grayscale methods.

The Four Colors in an Advanced Overlay
When creating an advanced overlay, you create your highlights by using up to four 
specific colors. You can use a chroma method (using red, blue, black, and white as the 
four overlay colors) or a grayscale method (using black, dark gray, light gray, and white 
as the four overlay colors). You don’t have to use all four colors when creating an 
overlay, but you will most likely use at least two. 

White is commonly used as the overlay’s background color. When creating the menu, 
white’s transparency is usually set to 0. Any of the other three overlay colors can be 
used for any aspect of the overlay. 

Is White 0% or 100%?
Depending on your graphics background, you may assume white to be either 0% or 
100%, with black being the opposite (100% or 0%, respectively). Previous versions of 
DVD Studio Pro considered white to be 0%, while most video people would consider 
white to be 100%. For the purposes of creating the light gray and dark gray colors 
used by the grayscale method, you need to use the following values:
• If you consider white to be 0%, use 33% for light gray and 66% for dark gray.
• If you consider white to be 100%, use 66% for light gray and 33% for dark gray.
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For example, if you had a menu background with a group of buttons that were actually 
just text, such as “Play Movie” and “Select Chapter,” initially your overlay would start as 
all white. If you wanted the button text to change to green when each button was 
selected, you’d need to add the text to the overlay and make it an overlay color such as 
light gray (or dark gray or black—remember that you will set the green color as the 
“selected” highlight color when you create the menu in DVD Studio Pro). If you wanted 
the text to change to orange when each button was activated, you wouldn’t have to do 
anything more to the overlay—you would just set the “activated” highlight color to 
orange when you created the menu. 

If you also wanted a checkmark to appear next to each text button as it was selected, 
but you wanted the checkmarks to be yellow when they were selected, you’d need to 
add the checkmarks to the overlay graphic and set them to be a different overlay color 
than the text (in this case, dark gray) so that you could apply a different highlight color 
(in this case, yellow). 

In the same way, you could add the word “OK!” after each text button and show it only 
when the button was activated. Simply add the text to the overlay and set it to be 
black; in DVD Studio Pro, you can set black to be transparent for the normal and 
selected states, but visible with a green color in the activated state.

To create an advanced overlay:
1 Create a full-screen white background. See “Square Pixels in Graphics” on page 85 for 

information on the frame size to use. 

Note:  You don’t have to use white as the background color, as you do with simple 
overlays, but it is a good idea to use white, since the default color mapping settings 
assume it is the background.

2 Depending on whether you intend to use the chroma or grayscale method, add 
elements using the three leftover overlay colors (white having been used for 
the background). 

3 Depending on the graphics application you use, you may need to flatten the overlay 
elements into a single layer.

If you use colors other than the four that are specified by the method you chose 
(chroma or grayscale), they are mapped to their closest equivalent when you use the 
overlay. In many cases, this produces surprising (but not useful) results.

 Play Movie OK!

Light gray
checkmark

Dark gray
name

Black
“OK!”

White
background
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Pseudo-Soft Overlay Edges
Instead of using the advanced overlay’s four colors to create multiple color highlights, you 
can use them to create pseudo-soft edges and take advantage of anti-aliased graphics. 
This requires you to use the grayscale method, using either white elements on a black 
background or black elements on a white background. The soft or anti-aliased edges are 
mapped to the dark and light gray overlay colors. By mapping the same color to each 
overlay color, but at reduced opacities on the dark and light gray overlay colors that occur 
at the edges, you can effectively simulate soft or anti-aliased edges.

Keeping Each Button’s Elements Together
When creating your menu in DVD Studio Pro, you draw a single box around all of the 
elements for each button. The box identifies that button’s highlight area. In the above 
example, you would draw a box around each button that includes its checkmark, the 
main text, and the word “OK!” When you draw this box, no parts of any of the other 
buttons should be included, or they will also appear with this button. 

For example, instead of having an “OK!” after each line, you might want a single large 
“OK!” on the right side. There’s no way to draw a box that would include both the 
button name (“Play Movie,” for example) and the large “OK!” without including some of 
the other button text, making this arrangement unusable.

Note:  The Menu Editor has three color mapping sets that, in some cases, you can use 
to work around this problem. See “Understanding Color Mapping” on page 236 for 
more information.

You also need to make sure none of the boxes overlap, since this can cause navigation 
problems, especially when using a pointer to select the buttons while playing the disc 
on a computer.

Active area overlap

 Play Movie

 Scene Select

 Slideshow
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Creating a Layered Menu
Layered menus can provide greater flexibility in showing a button’s selected and 
activated states, compared to standard overlay menus. In addition to the background 
image (which may contain the buttons in their normal states), a layered menu has two 
separate layers for each button (or three, if the button’s normal states are not part of 
the background). For example, a menu with 12 buttons would need 24 layers just to 
show the selected and activated states of each button, plus 12 more if their normal 
state is not part of the background. (A Photoshop file can have up to 99 layers.)

There are several issues to be aware of when deciding whether to use layered menus:

• You cannot add an audio stream to them.
• You cannot include a full-motion video in them.
• When viewers make selections, they will notice a slower reaction time to button presses.

Using the Photoshop Layers
When you configure a PSD file for use as a layered menu, you select the layer or layers 
that provide the menu’s background. The background can include all of the buttons’ 
normal state, but it doesn’t have to. If the background includes the normal state, the 
selected and activated states must be configured to take into account that the normal 
state is always present. If you want the button to change significantly when switching 
to the selected and activated states, you may need to have the normal state on its own 
layer so that it can be hidden when the other states appear.

Using PSD Files to Create Layered Menus
There are some issues to be aware of when using PSD files to create layered menus:
• Each button’s active area is created the same way as it is when working with overlays. 

This means you need to be able to draw a single box around each button’s elements. 
See “Keeping Each Button’s Elements Together” on page 90 for more information.

• In addition to the layered buttons, you can use overlay-based buttons. The overlay 
can be another layer in the PSD file or a separate file.

Creating Video for Motion Menus
The video used for motion menus must follow the same DVD-compliance rules as 
video used in tracks. There are a few additional considerations you should be aware of:
• If you add any shapes, text items, or drop zones to a menu, the menu will be 

rendered when you build the project. See “About Menu Rendering” on page 230 for 
more information.
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• If you want to include button art beyond the capabilities of what an overlay can 
provide, you need to edit these over the video with an application such as Motion or 
Final Cut Pro. You can create the button art and associated overlay with your 
graphics program, and then superimpose the button art over the video with your 
video editor and use the overlay in DVD Studio Pro to set up the buttons. 

Note:  An alternative is to use shapes to provide buttons over motion video.

• You can set the video to loop once it reaches its end. There will be a short pause in 
the playback as the menu moves from the end back to the beginning. This can be 
minimized or eliminated by carefully selecting the video to use. For example, a car 
driving by a mostly static background can be looped cleanly. If you are creating an 
animation for use as the background, be sure to keep looping in mind.

• Don’t create excessively long video for motion menus. The videos can take up a lot of 
disc space, and if you use a lot of them, you can have problems building your title. 
See “Standard SD DVD Video Zone Files” on page 566 for menu size limitations.

• Menus in SD projects can only use full-frame MPEG-2 video as a background. If you 
use an MPEG-1, 1/2 D1 MPEG-2, or a cropped D1 MPEG-2 file as the background, it 
will be encoded to full D1 MPEG-2 when you build the project. Menus in HD projects 
can use either full D1 MPEG-2 video or any of the supported HD video resolutions as 
the background.

Defining the Menu Loop Point
When you configure a looping menu, you have the option of setting the loop point 
(the point playback jumps to once the end of the menu’s video is reached) to be 
different than the menu’s first frame of video. For example, the menu’s video may have 
an introduction that plays before the buttons become active—you would not want the 
introduction to play each time the menu loops. 

In addition to setting the loop point manually in the Menu Inspector, you can add a 
chapter marker, named “MenuLoopPoint,” to the background video while you are 
editing it in Motion or Final Cut Pro. DVD Studio Pro automatically sets the menu’s loop 
point to match this marker when you assign the video to the menu’s background using 
one of the dragging methods, such as dragging the video to the Menu Editor and 
choosing Set Background from the Drop Palette. See “Configuring Motion Menu 
Settings” on page 282 for more information.

In Final Cut Pro, you add the chapter marker exactly as you would add a chapter 
marker for use in a track. The only requirement is that it be named “MenuLoopPoint.” 
See “Adding Markers to Your Video” on page 70 for more information. In Motion, you 
need to select the Menu Loop Point option when you add the marker to the video. See 
the Motion documentation for more information.
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Creating Shapes
Shapes provide an easy way to create a standard menu using a simple background 
image (still or moving) without an overlay. These shapes can be either the ones 
supplied with DVD Studio Pro or shapes that you create. 

Shapes can be used for buttons and for drop zones. (Drop zones are graphic elements 
that get added to the menu background, and have no effect on the buttons.) You can 
position the shapes and change their size freely, and even have full-motion video play 
in them (motion buttons).

See “Adding Shapes to a Menu” on page 256 for information on using shapes with the 
Menu Editor. See “Importing a Shape” on page 320 for information on importing 
shapes into the Palette.

Creating a Shape
A shape is a Photoshop PSD file with up to four layers. DVD Studio Pro uses the layer 
order to determine which layer serves each function. 

• First (bottom) layer:  Contains the mask for the thumbnail image used when you assign 
an asset to a button or drop zone. This layer should have a grayscale image to control 
the thumbnail’s appearance. White areas are completely opaque (you see all of the 
thumbnail image), gray levels are partially transparent, and black levels are completely 
transparent (you see none of the thumbnail image). The mask can use an irregular 
shape—the asset is scaled to fill it completely. Any part of the asset that falls outside 
the mask then gets removed. If you don’t want a thumbnail image, you must still have 
this layer present, but you can draw a black square or any simple image.

When you activate drop shadows on a button or drop zone using a shape, 
DVD Studio Pro uses this layer, along with the second layer, to define the shape of 
the drop shadow.

Layers in a Photoshop 
PSD file
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• Second layer:  Contains the shape’s visible graphic. When used as a button, this is the 
layer that determines how the button looks in its normal state. DVD Studio Pro uses 
the RGB values for the shape. See “Setting the Shape’s Opacity” on page 95 if you 
want this layer to be partially transparent. Be sure to flatten any effects you apply to 
the layer. (See “Flattening a Photoshop Layer” on page 83 for details.) Since this layer 
has a higher priority than the first layer, it must provide a “window” to the thumbnail 
mask (if used). 

When you activate drop shadows on a button or drop zone using a shape, 
DVD Studio Pro uses this layer, along with the first layer, to define the shape of the 
drop shadow.

• Third layer:  Contains the highlight mask. This layer defines where the highlight colors 
appear when you use the shape as a button, and select or activate the button. You 
can use white or black, since it is this layer’s alpha channel that defines the highlight. 

This layer is ignored if you use the shape in a drop zone.

Important:  If you use this layer’s alpha channel to create pseudo-soft or anti-aliased 
edges, you can only use the shape in menus set to use the grayscale overlay method.

• Fourth layer:  Contains the shape’s icon, which appears in the Shapes tab in the 
Palette and shape selector in the Button and Drop Zone Inspectors. This is an 
optional layer—the second layer provides this function if this layer is not present. The 
disadvantage of using the second layer is that often the shape alone does not 
provide a good indication of what the button will look like once you assign an asset 
to it. DVD Studio Pro uses the RGB values for the icon.
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Note:  Do not include the fourth layer in the file unless you are adding a graphic to 
be used as the thumbnail. Adding an empty fourth layer results in a shape that you 
cannot use in DVD Studio Pro.

Setting the Shape’s Opacity
DVD Studio Pro does not use the opacity settings you can apply to the layers within 
Photoshop. As a result, you cannot use the second layer’s opacity setting to control the 
transparency of the shape’s visible graphic. As an alternative, you can use Photoshop’s 
merge capability to get the desired effect.

To set the shape’s opacity:
1 Create the shape in Photoshop as usual.

It’s a good idea to save the shape at this point so that you can go back to it if you later 
need to adjust the opacity or content.

2 Set the opacity for the second layer (the shape’s visible graphic).

3 Add a new layer to the graphic, and place it below the second layer. (It becomes the 
second layer, and the second layer becomes the third layer.)

4 Select the original second layer (which is now the third layer).

5 Press Command-E to merge the selected layer with the new empty layer.

The two layers merge into a new second layer, and the original second layer is deleted. 
When this shape is imported into DVD Studio Pro, this new second layer will use the 
opacity you set before the merge.

General Shape Information
When creating a shape in Photoshop, set the new image settings to the following:
• Width and Height:  Set to values that will hold the shape at the largest size it will ever 

be used at in DVD Studio Pro (quality tends to suffer much more when you make a 
shape larger than the original than it does when making the shape smaller). Be sure 
the shape’s graphics come as close to the edges of the canvas as possible—the 
canvas defines the button’s active area. A typical button size is 200 pixels wide by 
150 pixels high.

• Resolution:  Set to 72 pixels per inch. DVD Studio Pro bases the image size on the 
number of pixels there are—the resolution does not affect its size when used on a menu.

• Mode:  Set to RGB Color.
• Contents:  Set to Transparent.
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Keep these additional points in mind when creating your shapes:

• It does not matter which layers are visible when you save the shape’s file.
• You do not have to rasterize layers with text. You do have to flatten them if you apply 

an effect to them.
• Also be sure that the colors you use are within broadcast limits. You can create 

shapes that look great in the graphics program but look a lot different once you use 
them in a DVD project.

• You may want to design shapes with the specific intention of using them for drop 
zones. This allows you to have drop zones with irregular edges. You need to use the 
layers exactly as you do when creating a button’s shape, except that the highlight layer 
is not used with drop zones. Shapes created for buttons can also be used for drop 
zones. See “Adding Drop Zones to Your Menu” on page 273 for more information.

Shape Aspect Ratios
Shape graphics are automatically scaled to maintain their aspect ratio. If you create a 
square graphic and import it as a shape, it will be scaled so that it remains a square 
graphic in DVD Studio Pro (as long as you add it to a menu by dragging it to an 
empty area).

While the rescaling makes the graphic look correct in the Menu Editor, the shape’s 
dimensions look incorrect as shown in the Button Inspector or Drop Zone Inspector. For 
example, if you create a square shape that is 200 pixels wide by 200 pixels high, its size 
will appear as either 200 pixels wide by 180 high (if applied to an NTSC menu) or 187 
pixels wide by 200 pixels high (if applied to a PAL menu), when added to a menu as a 
button or drop zone.

Creating Graphics for Drop Zones and Buttons
Assets used in drop zones and buttons do not need to conform to video aspect ratios 
since drop zones and buttons can be resized independently in the horizontal and 
vertical directions. Additionally, drop zones and buttons support a graphic’s 
transparency. This means you can create a graphic with irregular edges, such as a logo, 
and when it is assigned as the asset for a drop zone or button, the transparency will 
control how the graphic appears.

Similar to graphics used for shapes, drop zone and button graphics are automatically 
scaled to maintain their aspect ratio. If you create a square graphic and import it as an 
asset for a drop zone or button, it will be scaled so that it remains a square graphic in 
DVD Studio Pro. See “Shape Aspect Ratios” on page 96 for more information.

Note:  To force the drop zone or button active area to match the graphic’s aspect ratio, 
press Shift while dragging one of its corners.
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Preparing Stills for Slideshows
When preparing still images for use in DVD Studio Pro slideshows, most of the same 
rules for preparing menu backgrounds apply. These same considerations apply if you 
intend to add slides to a track.

File Formats
DVD Studio Pro lets you use most common image formats in slideshows: 
• Photoshop PSD files using the 8-bit RGB mode

Slideshows do not support layer selection, as menus do. The layers visible when the 
file was last saved become the visible image of the graphic.

• PICT files
• BMP files
• JPEG files
• QuickTime image files
• Targa (TGA) format files
• TIFF (TIF) format files

Once a still is imported into DVD Studio Pro and you build the project it is assigned to, 
it is converted into an MPEG image and, if necessary, automatically scaled to fit the 
frame size defined by the slideshow’s resolution and display mode settings.

Aspect Ratio and Resolution
You can create 4:3 and 16:9 slideshows. In HD projects, you can also choose a resolution 
for the slideshow.

Note:  In HD projects, the 720 x 480p, 720 x 576p, 1280 x 720p, and 1920 x 1080i 
resolutions do not support the 4:3 aspect ratio.

When creating 16:9 slideshows, you are able to choose the display mode (pan and scan, 
letterbox, or pan and scan and letterbox) used when viewed on a 4:3 monitor.

For the best results, you should make sure your slides match the resolution of your 
slideshow. Slides that are smaller or larger than the slideshow’s resolution are 
automatically scaled to fit it. Slides whose aspect ratio does not match the slideshow’s 
aspect ratio have a background color added to fill in the gaps. The background color is 
part of DVD Studio Pro Preferences. See “Setting DVD Studio Pro Preferences” on 
page 112 for more information.



98 Chapter 2    Preparing Assets

 

Colors
The DVD specification requires all video, including stills and menu graphics, to conform 
to the NTSC or PAL video broadcast standard for allowable colors. In order to support 
broadcast bandwidths, NTSC and PAL video must use colors that are substantially 
restricted compared to those your graphics program can create. It’s important to work 
within the broadcast standard, because pictures and graphics that look fantastic when 
viewed in a graphics application can look very different when viewed on a DVD. Highly 
saturated colors create the biggest problems and produce the biggest 
disappointments when viewed on a video monitor.

Before importing your pictures and graphics, be sure to open them in a graphics 
application and use a filter to constrict the colors to NTSC or PAL color space. 

Audio
Slideshows can have either an individual audio clip assigned to one or more of the 
stills, or one or more audio clips for the overall slideshow.

Important:  If you assign an audio clip to the individual stills or use multiple audio clips 
as the overall slideshow audio, all audio clips in the slideshow must be in the same 
format (AC-3, AIFF, and so on), have the same bit rate, and have identical resolution. 

Preparing Alpha Transitions
Alpha Transitions make it possible for you to create customized transitions for use in 
your DVD Studio Pro menus, tracks, and slideshows. 

All DVD Studio Pro transitions have a start and end frame, based on where the 
transition is being used. The standard transitions are able to transform the start and 
end frame video, providing the ability to have a variety of effects, such as rotating or 
blurring, directly applied to the video. An Alpha Transition does not directly transform 
the start and end frame video—it simply transitions from the start to the end based on 
QuickTime movies you create. 
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Creating an Alpha Transition requires from one to three QuickTime movies, depending 
on the type of transition you want to create. Some features to consider include: 

• Do you want any kind of video other than the start and end frames to appear during 
the transition? For example, if you want a spinning DVD to fly across the screen during 
the transition, you must have an asset movie that provides the flying DVD image.

• Do you want to see the start and end frames on the screen at the same time during 
the transition? In the example with the spinning DVD, maybe you want to see the 
start frame around the outside edge of the DVD and the end frame in the DVD’s 
center. To see the start and end frames at the same time, you must have a 
background matte movie.

• Do you want a simple wipe transition that uses a custom shape? You can use a 
background matte movie to create a wipe transition with hard or soft edges in any 
shape you like.

There are several components to an Alpha Transition:

• The transition asset folder:  Contains the transition’s assets. Additionally, the name of 
this folder is the name of the transition. Each Alpha Transition requires a separate 
transition asset folder.

• The asset movie:  Required if you want any kind of video other than the start and end 
frames to appear during the transition. 

• The asset matte movie:  Required if your asset movie does not include an alpha channel.
• The background matte movie:  Required if you want to see the start and end frame 

video at the same time or if you want to create a wipe transition.

Important:  For best results, be sure to use progressive (non-interlaced) video in your 
movies at either 60 fps for NTSC or 50 fps for PAL. Also, make sure to create movies that 
match the aspect ratio (4:3 or 16:9) and, in the case of HD projects, the resolution of the 
elements you will use the transitions with. DVD Studio Pro will scale the movies to 
match the element if necessary; however, there will be a loss in quality.

The DVD image is from the 
asset movie, with an asset matte 
movie controlling where the 
background video appears.

Start frame (red in
this example)

End frame (blue in
this example)

The background matte
movie (not visible)

controls whether the
background shows the

start or end video.
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Transition Asset Folder
The transition asset folder contains the movies that make up the Alpha Transition. The 
name of this folder becomes the name of the transition. The names of the files within the 
folder must include the folder name, with additional text to distinguish the file’s purpose.

When you open DVD Studio Pro, it looks in two locations for transition asset folders:

• At the root of your disk, in this location:  [root]/Library/Application Support/
DVD Studio Pro/Transitions/

• In your home folder, in this location:  [user]/Library/Application Support/
DVD Studio Pro/Transitions/

Note:  If you add a transition folder while DVD Studio Pro is open, it is ignored until the 
next time you open DVD Studio Pro. 

Asset Movie
The asset movie is required if you want any kind of video other than the start and end 
frames to appear during the transition. For example, if you want a spinning DVD to fly 
across the screen during the transition, it is the asset movie that provides the flying 
DVD image.

The asset movie must have the same name as the transition asset folder and can have 
an extension. For example, if the transition asset folder’s name is Spinning DVD, the 
asset movie could be named Spinning DVD.mov.

There are two optional aspects to the asset movie:  an alpha channel and a switch point.

The asset movie provides 
transition video in addition to 
the start and end frames.

The asset movie can
contain an alpha channel

to control where the
background appears.
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Alpha Channels
In the above example with the spinning DVD flying by, you would most likely want to 
be able to see the start or end frame video through the DVD’s hole and around its 
edges. For this to happen, there must be an alpha channel for DVD Studio Pro to know 
which parts of the asset movie video should appear and which should be ignored. 

There are two ways to provide this alpha channel: embedded with the asset movie or 
as a separate asset matte movie (described in “Asset Matte Movie” on page 102). 

Important:  When the alpha channel is embedded with the asset movie, be sure the 
video output is premultiplied.

Switch Points
If your transition does not require the start and end frame video to be on the screen at 
the same time, you can add a switch point marker to the asset movie to control when 
the transition switches from showing the start frame to showing the end frame. If you 
do want to have both the start and end frame video on the screen at the same time, 
you must use a background matte movie (described in “Background Matte Movie” on 
page 102).

If the transition asset folder does not contain a background matte movie, 
DVD Studio Pro does the following to set the switch point:

• DVD Studio Pro first looks in the asset movie to see if there is a marker named 
TransitionSwitchPoint. If present, this marker is used as the switch point. 

• If not present, DVD Studio Pro looks to see if there are any markers in the asset 
movie. If present, the first marker is used as the switch point. 

• If no markers are present in the asset movie, the switch point is set to the asset 
movie’s halfway point.
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Asset Matte Movie
The asset matte movie is required only when an asset movie that does not include an 
alpha channel is used by the transition. Having a separate asset matte movie is 
particularly useful when the asset movie is normal video (as opposed to an animation).

The asset matte movie must have the same name as the transition asset folder, followed 
by “-matte” and can have an extension. For example, if the transition asset folder’s name 
is Spinning DVD, the asset matte movie could be named Spinning DVD-matte.mov.

The asset matte movie needs to be monochrome, with white identifying the asset 
movie video to use, and black identifying the places where the start or end frame video 
appears. You can also use levels in between white and black to set a transparency and 
add soft edges.

Background Matte Movie 
The background matte movie can be used in one of two different ways:
• It can be used in conjunction with the asset movie to control which areas of the screen 

should show the start frame video and which should show the end frame video.
• It can be used as the only movie in the transition assets folder to provide a wipe 

transition. As when used with the asset movie, the background matte movie controls 
which areas of the screen should show the start frame video and which should show 
the end frame video.

The white areas define 
where the asset movie 
video appears.

The black areas define
where the background

video (start or end frame,
depending on the switch

point or background
matte movie) appears.

The gray areas define 
where the asset movie 
video appears, but is 
transparent.
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The background matte movie must have the same name as the transition asset folder, 
followed by “-backgroundMatte” and can have an extension. For example, if the 
transition asset folder’s name is Spinning DVD, the background matte movie could be 
named Spinning DVD-backgroundMatte.mov. 

The background matte movie needs to be monochrome, with white identifying where 
the start frame video appears, and black identifying where the end frame video 
appears. As a general rule, the background matte movie should start with a full white 
screen and end with a full black screen. You can also use levels in between white and 
black to set a transparency and add soft edges. 

About Alpha Transition Durations
The asset movie (if present) or the background matte movie (if the asset movie is not 
present) determine the default duration of the Alpha Transition. When configuring the 
transition in DVD Studio Pro, you are able to set the duration from one half the default 
(but not less than one second) to twice the default duration.

About NTSC and PAL Alpha Transitions
Each Alpha Transition is either NTSC or PAL. DVD Studio Pro uses the frame rate of the 
transition assets to determine whether they are NTSC or PAL. Only those appropriate to 
the current project’s video standard are available in DVD Studio Pro.

Note:  Alpha Transitions using a frame rate of 24 fps can be used only in NTSC projects, 
though they may show undesirable artifacts when the frame rate is scaled to match 
the project.

The white areas define 
where the start frame 
background video 
appears.

The black areas define
where the end frame

background video
appears.
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DVD Source Settings Summary
Following is a summary of the required settings for MPEG and other sources that can 
be used with DVD Studio Pro.

Note:  All assets within a project must use the same video standard (all NTSC or all PAL). 
For the other settings, such as encoding format, resolution, and bit rates, you can mix 
assets with different settings.

DVD Video and Audio Settings for SD Projects
The following settings work with SD projects. With the exception of MPEG-1 video, 
these same settings can also be used in HD projects.

Video Settings
Following are the video settings supported by DVD Studio Pro.

MPEG Type
Both MPEG-1 and MPEG-2 are supported, at the video resolutions listed below.

MPEG Structure
Only elementary streams are supported.

MPEG Bit Rates
Multi-angle and mixed-angle tracks have stricter requirements. See “Encoding Video for 
Multi-Angle Tracks” on page 68 for details.

MPEG-1 Video
• Up to 1.856 Mbps (1.15 Mbps is typical.)

MPEG-2 Video
• Up to 9.8 Mbps (The typical maximum used is 8 Mbps.)

Video Resolution
There are a variety of resolutions supported by DVD Studio Pro. See “Choosing a Video 
Resolution” on page 57 for more information.

MPEG-1
• SIF (Standard Interface Format):  352 x 240 NTSC; 352 x 288 PAL

MPEG-2
• SIF:  352 x 240 NTSC; 352 x 288 PAL
• 1/2 D1:  352 x 480 NTSC; 352 x 576 PAL
• Cropped D1:  704 x 480 NTSC; 704 x 576 PAL (matches analog blanking)
• Full D1:  720 x 480 NTSC; 720 x 576 PAL
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Frame Rate
• NTSC with 525 lines (29.97 fps)
• PAL with 625 lines (25 fps)
• Versions of 23.976 fps video using either the NTSC or PAL video resolutions

Aspect Ratio
4:3 and anamorphic 16:9 are supported. (See “What Exactly Is a 16:9 Asset?” on page 51.)

Chroma Format
The DVD specification requires a 4:2:0 chroma format.

GOP Size (Maximum)
• 18 frames NTSC; 15 frames PAL

GOP Size (Typical)
• 15 frames NTSC; 12 frames PAL

Audio Settings
Following are the audio settings supported by DVD Studio Pro. See “Preparing Audio 
Sources” on page 77 for details on these settings.

Bit Rates
The audio bit rate depends on the format and quality level you need (higher bit rates 
provide better quality, but reduce the bit rate you can use with the video).

MPEG-1 Layer 2 Audio
• 64 to 384 kbps (192 kbps and 224 kbps are typical.)

Dolby Digital AC-3
• 64 to 448 kbps (192 kbps, 224 kbps, and 448 kbps [for 5.1] are typical.)

DTS ES 
• 754.5 kbps or 1509.75 kbps

Stereo PCM @ 16 Bits/48 kHz 
• 1536 kbps

Stereo PCM @ 24 Bits/96 kHz 
• 4608 kbps

Audio Sample Rate
• 16 bits or 24 bits
• 48 kHz or 96 kHz
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DVD Video and Audio Settings for HD Projects
The following settings work with HD projects. 

Video Settings
Following are the video settings supported by DVD Studio Pro.

MPEG Type
MPEG-2, HDV, and H.264 are supported, at the video resolutions listed below.

MPEG Structure
Only elementary streams are supported.

MPEG Bit Rates
Multi-angle and mixed-angle tracks have stricter requirements. See “Encoding Video for 
Multi-Angle Tracks” on page 68 for details.

SD MPEG-2 Video
• From 2.0 Mbps to 15.00 Mbps 

HD MPEG-2 Video
• From 2.0 Mbps to 29.40 Mbps (The typical maximum used is 27 Mbps.) 

Note:  HD assets include the 480p and 576p resolutions.

HDV Video
HDV video is MPEG-2 encoded. The bit rate depends on the video resolution:
• 1280 x 720p:  19 Mbps
• 1920 x 1080i:  25 Mbps

H.264 Bit Rates
Multi-angle and mixed-angle tracks have stricter requirements. See “Encoding Video for 
Multi-Angle Tracks” on page 68 for details.

SD H.264 Video
• From 0.5 Mbps to 15.00 Mbps 

HD H.264 Video
• From 1.5 Mbps to 29.40 Mbps (The typical maximum used is 27 Mbps.) 

Note:  HD assets include the 480p and 576p resolutions.
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Video Resolution
There are a variety of resolutions supported by DVD Studio Pro. See “Choosing a Video 
Resolution” on page 57 for more information.
• SIF:  352 x 240 NTSC; 352 x 288 PAL
• 1/2 D1:  352 x 480 NTSC; 352 x 576 PAL
• Cropped D1:  704 x 480 NTSC; 704 x 576 PAL (matches analog blanking, only the 

interlaced version is supported)
• Full D1:  720 x 480 NTSC; 720 x 576 PAL (both interlaced and progressive versions)
• 720p:  1280 x 720 (NTSC and PAL, progressive)
• Anamorphic 1080i:  1440 x 1080 (NTSC and PAL, interlaced, anamorphic 16:9)
• 1080i:  1920 x 1080 (NTSC and PAL, interlaced)

Frame Rate
• NTSC with 525 lines (29.97 fps)
• PAL with 625 lines (25 fps)
• Versions of 23.976 fps video using either the NTSC or PAL video resolutions

Aspect Ratio
4:3, anamorphic 16:9, and true 16:9 are supported. 

Chroma Format
The DVD specification requires a 4:2:0 chroma format.

GOP Size (Maximum)
• 18 interlaced frames or 36 progressive frames NTSC; 15 interlaced frames or 30 

progressive frames PAL

GOP Size (Typical)
• 15 frames NTSC; 12 frames PAL

Audio Settings
Following are the audio settings supported by DVD Studio Pro. See “Preparing Audio 
Sources” on page 77 for details on these settings.
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Bit Rates
The audio bit rate depends on the format and quality level you need (higher bit rates 
provide better quality, but reduce the bit rate you can use with the video).

MPEG-1 Layer 2 Audio
• 64 to 384 kbps (192 kbps and 224 kbps are typical.)

Dolby Digital AC-3
• 64 to 448 kbps (192 kbps, 224 kbps, and 448 kbps [for 5.1] are typical.)

DTS ES 
• 754.5 kbps or 1509.75 kbps

Stereo PCM @ 16 Bits/48 kHz 
• 1536 kbps

Stereo PCM @ 24 Bits/96 kHz 
• 4608 kbps

Audio Sample Rate
• 16 bits or 24 bits
• 48 kHz or 96 kHz
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3 Starting a Project

When you start a new DVD project, especially if it’s the 
first project you’ve created on a particular system, you 
need to set certain preferences and disc properties 
before you begin working with your assets. 

This chapter describes how to open DVD Studio Pro, set preferences and properties, 
and create a new project.

DVD Studio Pro includes a number of views and windows that you use while building your 
DVD. See Chapter 4, “The DVD Studio Pro Interface,” on page 137 for a complete 
description.

Opening DVD Studio Pro
The first time you open DVD Studio Pro, a dialog appears where you choose the user 
interface configuration, the video standard, the DVD standard, and the default 
language to use. When opened after this, DVD Studio Pro uses the configuration, video 
standard, and DVD standard in use when it was last closed.

Note:  The choices you make in this dialog are not permanent; all of these can be 
changed in either DVD Studio Pro Preferences or, in the case of the configurations, in 
the Window menu.
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To open DVD Studio Pro the first time:
1 Start up your computer.

2 Double-click the DVD Studio Pro icon (in the Applications folder) to open the application. 

The Choose Application Defaults dialog appears.

3 Select the configuration that best fits your needs.

• Basic:  Use this configuration if you intend to use the templates and styles provided 
by DVD Studio Pro, and intend to rely on dragging and dropping assets to create 
your projects. This configuration is intended for users familiar with iDVD and users 
new to creating DVDs.
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• Extended:  Use this configuration if you are familiar with the DVD creation process 
and require easy access to more of the features of DVD Studio Pro. The extended 
configuration displays three quadrants to provide access to additional tabs, and 
the Inspector. 

• Advanced:  Use this configuration to gain access to all of the capabilities of 
DVD Studio Pro. Use this configuration if you are authoring complex titles.
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Note:  Once DVD Studio Pro opens, you can choose from these three configurations 
and others suitable for specific monitors. In addition, you can create and save your own 
configurations. See “Configuring the Interface” on page 139 for more information on 
selecting, creating, and saving configurations.

4 Select the video standard, NTSC or PAL, that you will use for your projects. If you are 
unsure of which standard to use, see “Video Standards of the World” on page 133.

5 Select the default project resolution, SD DVD (Standard Definition DVD) or HD DVD 
(High Definition DVD), that you will use for your projects.

6 Select the default language for your projects. 

7 Select the “Show at startup” checkbox to have this dialog appear each time you open 
DVD Studio Pro.

8 Click OK to confirm your choices and continue opening DVD Studio Pro. 

An untitled project opens, using the selected configuration and defaults. 

See Chapter 4, “The DVD Studio Pro Interface,” on page 137 for information on working 
with the quadrants, tearing off tabs into their own windows, and configuring the toolbar.

Setting DVD Studio Pro Preferences
The DVD Studio Pro Preferences window contains settings that you can use to 
configure its default operations. These settings affect all projects you create, although 
most of them can be overridden for individual projects within the DVD Studio Pro 
editors and Inspectors. Taking some time now to select these settings can make 
creating your projects faster and easier.

To open DVD Studio Pro Preferences, do one of the following:
m Choose DVD Studio Pro > Preferences.
m Press Command-, (comma).
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The Preferences window opens, displaying the last selected pane. The Preferences 
window includes ten panes, each containing settings related to specific areas of 
DVD Studio Pro.

To use the Preferences window:
1 Click an icon along the top to open its pane. 

2 Click Apply to apply the current settings and leave the Preferences window open. 

3 Click OK to apply the current settings and close the Preferences window.

4 Click Cancel to close the Preferences window without applying the current settings.

Project Preferences
The Project pane in DVD Studio Pro Preferences contains settings used to define basic 
aspects of new projects.

Note:  These settings do not affect the currently open project.

• DVD Standard:  Choose to define whether new projects are SD DVD (Standard 
Definition DVD) or HD DVD (High Definition DVD).

• Video Standard:  Defines the video standard (NTSC or PAL) of new projects you create. 
• Default Language:  Choose to set the default menu language for new projects. 
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General Preferences
The General pane in DVD Studio Pro Preferences contains settings used in a variety of 
areas in DVD Studio Pro.

Slideshows and Tracks
• Default Slide Length:  Enter a value, in seconds, that is used as the duration of still 

images added to slideshows and to a track’s video stream.
• Background Color:  You can set the color used as a background by the Slideshow Editor. 

Normally, this color will not be seen because it will be covered by the slide. It will be 
seen if the still image is not the correct size to fit in the video frame. In that case, this 
background color fills the gaps that exist. This color is also used by the Track Editor if 
you add still images that are not the correct size to fit in the video frame.

Important:  This setting is not saved as part of the project. If you change this setting, it 
will affect all projects, including previously saved ones, that have this color visible.

SD DVD Menus, Tracks, and Slideshows
• Display Mode:  Choose the default aspect ratio to use when creating menus, tracks, 

and slideshows in SD projects. You can choose from 4:3, 16:9 Pan-Scan, 16:9 
Letterbox, and 16:9 Pan-Scan & Letterbox.

HD DVD Menus, Tracks, and Slideshows
• Resolution:  Choose the default video resolution to use when creating menus, tracks, 

and slideshows in HD projects. You can choose from 720 x 480i, 720 x 480p, 
1280 x 720p, 1440 x 1080i, and 1920 x 1080i.

• Display Mode:  Choose the default aspect ratio to use when creating menus, tracks, 
and slideshows in HD projects. You can choose from 4:3, 16:9 Pan-Scan, 16:9 
Letterbox, and 16:9 Pan-Scan & Letterbox.

Note:  The 4:3 setting is not available if you choose a Resolution setting that does not 
support it (720 x 480p, 720 x 576p, 1280 x 720p, and 1920 x 1080i).
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Thumbnail Size
• Palette:  Choose Small or Large as the thumbnail size used in the Palette.
• Slideshow:  Choose Small or Large as the thumbnail size used in the Slideshow Editor.

Subtitle
• Fade In:  Enter a value, in frames, that controls whether a subtitle, by default, appears 

instantly (0 frames) or fades on over a number of frames.
• Length:  Enter a value, in seconds, that controls the default length of new subtitles 

you create.
• Fade Out:  Enter a value, in frames, that controls whether a subtitle, by default, 

disappears instantly (0 frames) or fades off over a number of frames.

Menu Preferences
The Menu preferences allow you to set a variety of defaults used when creating menus. 

• Motion Duration:  Enter a default duration, in seconds, to use when you create a motion 
menu. See “Configuring Motion Menu Settings” on page 282 for more information.

• Auto Assign Button Navigation:  Choose whether the Auto Assign feature wraps the 
button navigation for left-to-right or right-to-left reading. See “Right-to-Left Reading 
Mode” on page 271 for more information. 

• Final Rendering:  Since menus can contain a variety of elements layered over the 
background, such as buttons, drop zones, and text, they must be rendered into a 
single layer, similar to flattening a multiple layer graphic file. With still menus, this 
takes little time, but with motion menus, where each frame must be rendered, this 
can be a time-consuming process. Additionally, all transitions you add to your project 
must be rendered. See “About Menu Rendering” on page 230 for more information.
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The Final Rendering settings allow you to choose how the menus and transitions 
are rendered:

• Hardware based:  This setting provides the fastest rendering. However, since the 
quality is dependent on your system’s video card, the quality might not be as good 
as when using the “Software based” setting, and may not be consistent between 
different systems.

• Software based:  This setting provides consistent, good-quality rendering on all 
systems. However, depending on your system, it may take substantially longer 
than the “Hardware based” setting.

• Drop Palette Delay:  Position the slider to control how long of a delay there is before 
the Drop Palette appears over the Menu Editor when you drag an asset to it.

• Video Background Color:  You can set the color used as a background by the Menu 
Editor when no asset has been assigned as the menu’s background. Normally, this 
color will not be seen because it will be covered by the menu background. It will be 
seen if the background image is not the correct size to fit in the video frame. In that 
case, this background color fills the gaps that exist.

Important:  This setting is not saved as part of the project. If you change this setting, it 
will affect all projects, including previously saved ones, that have this color visible.

Track Preferences
The Track preferences allow you to set a variety of defaults used when creating tracks.

• Marker Prefix (Root) Name:  Enter the name that all new markers use as their prefix. 
The Generate Marker Names setting, below, controls whether this root name is 
followed by a number of timecode value.

• Check for unique name:  Select this checkbox to ensure you will not have two markers 
with the same name within a track. 
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• Generate Marker Names:  You can choose how markers are named when you create them.

Note:  You can rename the markers in the Marker Inspector.

• Automatically:  Names new markers with the prefix followed by a number that 
increments each time you add a marker. (You set the prefix below.) An advantage 
of this option is that you can easily tell how many markers have been added 
(although the number does not take into account any markers that you may have 
deleted). A disadvantage is that, since you can add markers between existing ones, 
the numerical order of the markers is not necessarily the same as their order in the 
timeline—the numerical order is based on the order the markers are created, not 
on their position. 

• Timecode based:  Names new markers with the prefix followed by the timecode of 
the video asset. (You set the prefix below.) An advantage of this option is that the 
marker names are always in the order they appear in the timeline. A disadvantage 
is that you cannot easily tell how many markers you have in the track. 

• Auto update:  When you select “Timecode based,” the “Auto update” checkbox 
becomes available. Selecting this checkbox causes the timecode value assigned to 
a marker’s name to update if you move the marker.

• Snap To:  Controls what happens when you place a marker in the timeline. In 
DVD Studio Pro, markers can only be placed on I-frames, which occur once per 
Group of Pictures (GOP). A GOP is typically 12 to 15 frames long, which means that 
when you place a marker, you generally will not be able to place it on the exact 
frame you would like. This setting allows you to control how DVD Studio Pro chooses 
the frame to use.
• Previous GOP:  Places the marker on the GOP occurring before the selected location.
• Next GOP:  Places the marker on the GOP occurring after the selected location.
• Nearest GOP:  Places the marker on the GOP closest to the selected location, either 

before or after it.

See “Working With GOP Settings” on page 59 for more information on GOPs.

• Thumbnail Offset:  A thumbnail image of the video asset, representing its first frame, 
appears in the Video tab in the Palette, in the Video Asset Inspector that appears 
when you select a video asset in the Assets tab, and at the first frame of the video 
stream in the Track Editor. This setting allows you to determine whether the 
thumbnail used in those places is based on the video frame at the start of the video 
asset or on a frame up to five seconds later in the asset. Since video assets often start 
at black and fade up, this setting allows you to set the thumbnail to a frame that has 
video that better represents the asset.

• Default Language:  You can choose a language that is automatically assigned to all 
audio and subtitle streams in new tracks. Choose Not Specified to have no language 
assigned to the streams. 
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• Space bar toggles between play/pause:  This setting controls what happens when you 
press the Space bar while viewing a track. When you play a track, the timeline’s 
playhead follows along. With the checkbox next to “Space bar toggles between play/
pause” selected, the playhead in the track’s timeline remains at its current position 
when you press the Space bar. When the checkbox is not selected, the playhead 
jumps back to where you started playing from when you press the Space bar.

Note:  This setting does not affect the pause and stop controls in the Viewer tab—
only what happens when you use the Space bar while playing a track.

• Fix invalid markers on build:  While creating your tracks, it is possible to end up with 
markers that either are not positioned on GOP boundaries or fall outside of the V1 
stream. When this checkbox is not selected, a build operation will abort if any invalid 
markers are detected. With the checkbox selected, a build operation will 
automatically reposition any markers that are not placed on GOP boundaries and will 
remove any markers that are outside the V1 stream.

• Find matching audio when dragging:  Select this checkbox to have DVD Studio Pro 
automatically try to locate an audio file with the same name as the video file you 
have dragged to an element, such as a menu or the Assets tab, of your project. 
DVD Studio Pro only checks the folder the video file was dragged from. 
DVD Studio Pro does not try to find matching audio if you drag a mixture of video 
and audio files. You can press the Command key after you start dragging a video 
asset to temporarily override this setting.

Alignment Preferences
The Alignment preferences apply to the Menu and Subtitle Editors, allowing you to 
customize the rulers, guides, and snapping actions.
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Rulers
These settings allow you to customize the rulers that appear in the Menu Editor.
• Show and Hide:  Select one of these options to set whether the rulers are displayed. 

Note:  Alignment guides can only be dragged onto the Menu Editor if the rulers 
are visible.

• Units:  Choose the units for the rulers from the pop-up menu.
• Pixels:  The rulers show the number of pixels.
• Centimeters:  The rulers show the number of centimeters, based on 28.35 pixels 

per centimeter.
• Inches:  The rulers show the number of inches, based on 72 pixels per inch.
• Percentage:  The rulers show the percentage of the frame.

• Center ruler origin:  Select this checkbox to have the rulers start at the center of the 
frame. This places “0” at the center of the rulers, with the units counting up from 
there in both directions. When this checkbox is not selected, the ruler’s origin is the 
frame’s upper-left corner.

• Show ruler guide tooltips measurements:  Select this checkbox to have the pointer’s 
coordinates appear when dragging an alignment guide. The values are in pixels, 
based on a position of 0, 0 for the upper-left corner.

Guides
These settings apply to the guides that appear in the Menu and Subtitle Editors.
• Show and Hide:  Select whether menu guides are displayed. You create menu guides 

by dragging in from the ruler.

Note:  You cannot add menu guides in the Subtitle Editor.

• Guide color:  Set the color for the menu guides and the dynamic guides that appear 
when you move an item in the Menu or Subtitle Editor. Opens the Colors window.

• Show Dynamic Guides at object center:  Select this checkbox to have the dynamic 
guides that appear when you drag an item in the Menu and Subtitle Editors show 
lines referenced to the item’s center.

• Show Dynamic Guides at object edges:  Select this checkbox to have the dynamic 
guides that appear when you drag an item in the Menu and Subtitle Editors show 
lines referenced to the item’s edges.
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Text Preferences
The Text preferences contain the default settings that apply when adding text to a 
menu, a menu’s button, and to a subtitle.

All Text Types
• Show:  Choose the type of text to configure (subtitle, menu, or menu button). The 

type you choose determines the other settings available in this pane.
• Font:  Shows the current settings.
• Font Panel:  Click to open the Font panel to configure the font.

Subtitle Text Settings

Note:  You cannot set the subtitle text color as you can for the menu button and menu 
text items.

• Horizontal and Vertical:  Use to set the default positioning of text-based subtitles you 
create in DVD Studio Pro. See “Creating Subtitles With DVD Studio Pro” on page 445 
for more information.

• Offset:  Enter values to modify the horizontal and vertical settings. For example, you 
can enter a horizontal offset value to move the text slightly towards the center when 
you have selected left justified as the horizontal setting.

With the horizontal offset, negative values move the text to the left and positive 
values move it to the right. With the vertical offset, negative values move the text up 
and positive values move it down. 

Menu Button Defaults
See “Adding Text to a Button” on page 266 for more information.
• Color Panel:  Opens the Colors window for configuring the text color.
• Position:  Choose the default position for the button’s text (Bottom, Top, Right, Left, 

or Center).
• Include text in highlight:  Select this checkbox to have the text included as part of the 

button’s highlight area.



Chapter 3    Starting a Project 121

 

Menu Text Settings
See “Adding Text Objects to a Menu” on page 276 for more information.
• Color Panel:  Opens the Colors window for configuring the text color.

Colors Preferences
The Colors pane contains the color mapping settings for the Menu and Subtitle Editors.

• Show:  Choose whether to show the settings for the Menu Editor or Subtitle Editor. 
This affects all other settings in this pane. 

• Mapping Type:  Choose the type of overlay mapping, Chroma or Grayscale, you are 
using. This only applies if you are using advanced overlays. See “Using Advanced 
Overlay Color Mapping” on page 240 for more information.

• Selection State:  Choose which of the three selection states (Normal, Selected, or 
Activated) to configure.

• Set:  Choose which of the three color mapping sets to configure. These settings are 
only active when the Selection State is set to Selected or Activated. See “Color 
Mapping Sets” on page 238 for more information.

• Key, Color, and Opacity Settings:  Choose the color and opacity setting for each of 
the overlay’s four colors (shown in the Key column) for each selection state and set. 
See “Colors Tab in the Menu Inspector With Advanced Selected” on page 251 for 
more information.

Note:  Shapes and simple overlays use the black key color (the top one) for their highlights.

• Palette:  Shows the colors in the color mapping palette. You can change a color by 
clicking it and selecting a new color from the Colors window. See “Setting the Colors 
in the Color Palette” on page 237 for more information.
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Simulator Preferences
The Simulator preferences apply to the Simulator you can use to test your project. See 
“Testing Your Project With the Simulator” on page 545 for more information.

Default Language Settings
• Audio, Subtitle, and DVD Menu Default Language:  Choose the languages to use as the 

Simulator’s default for menus, audio, and subtitles. This simulates the language 
settings in a DVD player. If you want any of these elements to use the stream settings 
in the Disc Inspector in place of the language settings, choose Not Specified.

Features
• Enable DVD@CCESS Web Links:  Select so that the Simulator can process any 

DVD@CCESS links in the project. This is useful to verify that email and web links work 
correctly. See “Testing DVD@CCESS Links” on page 596 for more information.

Region Code
• Default Region:  Choose the region code to simulate. You can choose All or a 

specific region.

Playback Output
• Video:  Choose the destination for the Simulator video. The two choices are Simulator 

Window, which is the default setting, and Digital Cinema Desktop Preview, which 
actually selects your system’s second monitor, whether it is an S-Video monitor, an 
Apple Cinema Display, or any other appropriate display. See “Simulating With an 
External Video and Audio Monitor” on page 547 for more information.

• Audio:  Choose the destination for the Simulator, Assets tab, and any of the editors’ 
(Track, Story, Slideshow, and Menu Editors) audio. Common choices include Built-in 
Audio, for normal system audio, and Built-in Audio (S/PDIF), which uses your system’s 
optical digital audio output (if available) to output the audio to an external AC-3 or 
DTS decoder.
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• Resolution:  Choose the monitor resolution to simulate. The choices include SD, HD 
720, and HD 1080.

• Display Mode:  Choose the monitoring situation to simulate:
• 4:3 Pan-Scan:  Simulates a 4:3 aspect ratio monitor with a DVD player configured to 

use the pan-scan method when showing 16:9 content.
• 4:3 Letterbox:  Simulates a 4:3 aspect ratio monitor with a DVD player configured to 

use the letterbox method when showing 16:9 content.
• 16:9:  Simulates a 16:9 aspect ratio monitor.

Destinations Preferences
The Destinations preferences control the location of files created during a variety of 
processes within DVD Studio Pro.

• Show:  Choose the process whose path you want to configure. 
• Encoding:  Specifies the location for the video and audio files that are created by 

the embedded MPEG and AIFF encoders when you import QuickTime files into 
your project. See “Importing Assets That Are Not DVD-Compliant” on page 193 and 
“Using the Embedded MPEG Encoder” on page 62 for more information.

• Image Encoding:  Specifies the location for the MPEG files that are created when 
you use non-MPEG still images in your menus, slideshows, and within a track. See 
“Using Still Assets That Are Not DVD-Compliant” on page 186 for more information.

• MPEG Parsing:  Specifies the location for the parse files that are created when you 
import MPEG files. See “About the Parse Files” on page 186 for more information.

• Build/Format:  Contains settings that define the default location to which the 
AUDIO_TS and VIDEO_TS folders, created during the build process, are saved. See 
“Building Your Project” on page 560 for more information on building your project.

• Palette Elements:  Specifies the location for the stock (Apple supplied) and custom 
items that appear in the Palette. See “Palette Elements Settings” on page 124 for 
more information.
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• Location:  Choose the location to save files to:
• Same Folder as the Asset:  This is the default setting. It places the files into an MPEG 

or PAR subfolder (depending on the type of file being created) in the original file’s 
folder. For QuickTime assets, an MPEG folder is created, with a PAR subfolder. The 
encoded file is placed in the MPEG folder and, if necessary, the parse file is placed in 
the PAR folder. For assets that are already MPEG-encoded, a PAR folder is created 
and the parse file is placed there. If the original files are on a volume that can’t be 
written to, such as a CD-ROM disc or a disk you do not have Write privileges for, 
DVD Studio Pro automatically writes to the Specified Folder/Fallback Folder location.

• Project Bundle:  This setting saves the files to the project file. To see the contents of 
the project file (the file created when you saved your project), locate the file in the 
Finder, Control-click it, then choose Show Package Contents from the shortcut 
menu. If you have not saved your project yet, the files are saved at your Specified 
Folder/Fallback Folder location.

• Specified Folder/Fallback Folder:  This setting saves the files to a disk and folder you 
choose. You can either enter the path directly or click Choose to open a dialog to 
choose the folder to use. It is also used when DVD Studio Pro is unable to write to 
the Same Folder as the Asset or Project Bundle locations. The default path is in 
your home folder at /Library/Caches/DVD Studio Pro Files. If you specify a location 
that cannot be written to, this default path is used in its place.

Palette Elements Settings
Click Choose to open a dialog to choose the folder to use. Click Reset to revert to the 
factory default settings.
• Stock:  Choose the location for the stock (Apple-supplied) Palette elements.

Note:  The default location is within the DVD Studio Pro package contents. You 
cannot directly navigate to the location—you must Control-click the DVD Studio Pro 
icon and choose Show Package Contents from the shortcut menu. Use extreme 
caution when opening the package contents.

• Custom:  Choose the location for the custom (user-created) Palette elements. 
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Encoding Preferences
The Encoding pane contains the settings that control the embedded MPEG encoder, 
which is used when you import a QuickTime asset. See “Using the Embedded MPEG 
Encoder” on page 62 for more information on the embedded MPEG encoder and 
details on these settings.

Creating a New Project 
When you open DVD Studio Pro, a new project file is automatically created. You can 
also create a new project at any time. 

To create a new project:
1 Choose File > New. 

A dialog asks whether you want to save the currently open project. Once you select an 
answer, a new, empty project opens.

2 Choose File > Save and specify a name and location for your project file.

Saving your project early ensures that if any files need to be saved to your project 
during the authoring process, they have a place to be written to. 

Once you have created and saved your project, there are four areas you might want to 
configure before you begin.

• Setting the video standard:  DVD-Video titles are based on one of two video 
standards:  NTSC or PAL. You cannot create a DVD-Video title that supports both 
video standards. DVD Studio Pro includes a video standard setting that applies to 
projects created after the standard has been set. It’s a good idea to confirm this 
setting if this is the first DVD Studio Pro project you are creating, or if you author 
both NTSC and PAL titles on this system. See “Setting the Video Standard,” next, for 
more information.
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• Setting the DVD standard:  You can author either SD or HD projects with 
DVD Studio Pro. If you are authoring an SD project, you can change it to HD. If you 
are authoring an HD project, you cannot change it to an SD project just by changing 
the DVD standard. See “Changing a Project’s DVD Standard” on page 135 for 
more information.

• Naming the project:  Each project is given a name that can be seen by the viewer 
when the finished DVD is played on a computer or on some set-top DVD players. 
DVD Studio Pro automatically uses the project’s filename, created when you saved 
the project, as the project name. See “Naming the Project” on page 129 for 
information on how to change this.

• Setting the disc size:  By default, DVD Studio Pro is set to use a 4.7 GB disc. This setting 
affects not only the disc burning process, but also the toolbar’s disc meter. See 
“Setting the Disc Size” on page 129 for information on changing this setting if you 
intend to work with other disc sizes.

• Setting the First Play element:  Each project must have an element designated as “first 
play.” This is the element that appears when the viewer first starts playing the DVD. 
By default, it is Menu 1. You can set this to be any element in your project. See 
“Setting the Project’s First Play” on page 131 for more information.

Setting the Video Standard
The DVD-Video specification supports two video standards:  NTSC and PAL. This may 
appear to leave out those countries that use the SECAM or PAL-M video standards. 
However, since the MPEG video on DVDs is in a component format, your sources, once 
MPEG-encoded, only need to conform to the line and frame rates of either the NTSC or 
PAL standard. 
• Use the NTSC video standard if you are in a country that supports either the NTSC or 

PAL-M video standard. Both standards use a 29.97 fps frame rate with 525 lines per 
frame. As a general rule, if your country uses 60 Hz AC power, you should use the 
NTSC video standard.

• Use the PAL video standard if you are in a country that supports either the PAL or 
SECAM video standard. Both standards use a 25 fps frame rate with 625 lines per 
frame. As a general rule, if your country uses 50 Hz AC power, you should use the PAL 
video standard. 

See “Video Standards of the World” on page 133 for a list of countries and the video 
standards they support. 

Note:  You cannot mix NTSC and PAL assets on a DVD. See “NTSC or PAL?” on page 48 
for more information. Also see “Changing a Project’s Video Standard” on page 134 for 
information on converting a project from one video standard to the other.

Important:  If you have any doubts about whether your system is set to the correct 
standard, you should verify its setting (described next) and change it if necessary 
before you start adding assets to your project.
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To set the video standard for the current project in the Disc Inspector:
1 Choose View > Show Inspector if the Inspector is not visible.

2 Do one of the following:

• Select the project’s name (next to the disc icon) in the Outline tab. (Choose 
Window > Outline if the Outline tab is not visible.)

• Click an empty area in the Graphical tab.
The Disc Inspector appears. 

3 In the General tab, select either NTSC or PAL to set the project’s video standard.

Note:  You cannot change a project’s video standard once you have added motion assets 
to it. See “Changing a Project’s Video Standard” on page 134 for more information.

The other Disc Inspector settings can be made later. See Chapter 16, “Finishing a 
Project,” on page 543 for details on these settings.

To set the video standard for DVD Studio Pro in the Preferences window:
1 Do one of the following to open the Preferences window:

• Choose DVD Studio Pro > Preferences.
• Press Command-, (comma).

2 Click the Encoding icon along the top of the Preferences window to open the Encoding 
pane.

3 Choose either the NTSC or PAL video standard.

This setting only affects projects created after it is set.

Setting the DVD Standard
You can choose from two DVD standards when you start your project:  the original SD 
DVD standard based on standard definition video assets and the new HD DVD standard 
designed to use high definition video assets.

Most asset formats supported by SD-based DVDs are also supported by HD-based 
DVDs. The exception is MPEG-1 video, which is not supported in HD projects. See 
“About Standard and High Definition DVDs” on page 19 for more information.

There are two places to set the DVD standard—each is used for different circumstances.

Select the video standard 
before adding assets.
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Setting the DVD Standard in DVD Studio Pro Preferences
You can set the DVD standard for all new projects in the Project pane of 
DVD Studio Pro Preferences. This setting does not affect the current project.

To set the DVD standard for new projects:
1 Do one of the following to open the Preferences window:

• Choose DVD Studio Pro > Preferences.
• Press Command-, (comma).

2 Click the Project icon along the top of the Preferences window to open the Project pane.

3 Choose either SD DVD or HD DVD from the DVD Standard pop-up menu.

Setting the DVD Standard in the Disc Inspector
The General tab in the Disc Inspector contains a setting that shows the DVD standard 
for the currently open project. 
• If SD DVD is selected, you can change the project to HD DVD.
• If HD DVD is selected, the settings are deactivated and you cannot change the project 

to SD DVD.

Note:  If you create a new project and it has HD DVD selected when you actually intend 
to create an SD project, you must change the DVD Standard setting in the Project pane 
of DVD Studio Pro Preferences.

To change the DVD standard for the current project using the Disc Inspector:
1 Choose View > Show Inspector if the Inspector is not visible.

2 Do one of the following:

• Select the project’s name (next to the disc icon) in the Outline tab.
• Click an empty area in the Graphical tab.
The Disc Inspector appears. 

3 Select the General tab (if not already selected).

4 Note the DVD Standard setting.

• If SD DVD is selected, you can change the project to HD DVD. A warning appears 
saying that you will not be able to change the project back to the SD DVD standard.

• If HD DVD is selected, the settings are deactivated and you cannot change the project 
to SD DVD.

See “Changing a Project’s DVD Standard” on page 135 for more information.
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Naming the Project
By default, each DVD disc you create is automatically given the same name as the 
project’s file, entered when you saved it. The disc’s name can be seen by the viewer 
when the finished DVD is played on a computer or on some set-top DVD players.

In most cases, the name of the project’s file is suitable to use as the disc’s name. 
However, there are some cases in which you might want to set the disc’s name 
independently of the project’s filename. For example, you may have several versions of 
a project, such as Bicycles 1, Bicycles 2, and Bicycles 3, that you will choose from for the 
final project. In this case, if you choose the Bicycles 2 version of the project, you would 
not want the final disc to appear as Bicycles 2 when the viewer plays the title—you 
would want it to say simply Bicycles.

The name of the disc is restricted to uppercase letters, numbers, and the underscore 
character. There is a maximum of 32 characters. The project’s filename is automatically 
converted to work with these restrictions when it is used as the disc’s name. For 
example, a project filename of Bicycle 2 is converted to a disc name of BICYCLE2.

To name the disc in the Disc Inspector:
1 Do one of the following:

• Select the disc’s name (next to the disc icon) in the Outline tab.
• Click an empty area in the Graphical tab.
The Disc Inspector appears. 

Note:  Choose View > Show Inspector if the Inspector is not visible.

2 Enter the new name for the disc in the Name field at the top of the Disc Inspector, then 
press Return.

Setting the Disc Size
The DVD Studio Pro default is set to a 4.7 GB DVD-5. This setting affects both the actual 
disc burning process when you finish your project, and the disc meter icon in the toolbar.

In addition to showing the estimated project size numerically, the disc meter also 
shows how full the disc is getting graphically. The disc meter uses the project’s disc size 
setting to determine the disc’s capacity.

As long as you intend to burn DVD-5 discs, the disc meter is accurate. If you intend to 
burn a blue laser, dual-layer, or 8 cm disc, you need to set the disc size to the proper 
format so that the disc meter reflects the changed requirements of your project. 



130 Chapter 3    Starting a Project

 

To set a project’s disc size:
1 Do one of the following:

• Select the project’s name (next to the disc icon) in the Outline tab.
• Click an empty area in the Graphical tab.
The Disc Inspector appears. (Choose Window > Outline if the Outline tab is not visible. 
Choose View > Show Inspector if the Inspector is not visible.)

2 Click the Disc/Volume tab in the Disc Inspector. 

3 Choose Red Laser or Blue Laser as the Disc Media (HD projects only).

4 Choose Single or Dual as the Layer Options.

5 Choose 8 cm or the standard 12 cm as the Disc Size.

The maximum size for the project appears below the Disc Size setting.

The other Disc Inspector settings can be made later. See Chapter 16, “Finishing a 
Project,” on page 543 for details on these settings. See “Disc Options” on page 41 for 
more information on available DVD sizes. See topics relating to finishing a project for 
more information on these settings.

Choose the disc capacity 
required for this project.

Choose the disc size 
required for this project.

Choose the disc media
required for this project.

(HD projects only)

Based on the other
settings, shows the

disc capacity.
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Setting the Project’s First Play
An important consideration when starting a project is deciding which of its elements will 
be the first to appear when a viewer starts playing the DVD. Some examples might be:
• Using the default setting and opening Menu 1 when the DVD starts playing
• Setting First Play to a motion menu or track that plays before the main menu 

appears. This motion menu or track could be a short animated company logo or 
a disclaimer. 

• Creating a DVD for continuous kiosk playback. You may want to have a disc that plays 
a track over and over, with no menus or other viewer interaction. In that case, you 
would set the track to be the First Play element, and set the track’s End Jump setting 
to be that same track. 

• Running a script to determine if the DVD should be allowed to play on this player. 
A script could also be used to configure playback to match the DVD player’s 
languages or its display’s aspect ratio. The script would end by choosing the first 
element to play for the viewer. (The viewer would not actually know that a script is 
the First Play element.)

To set the project’s First Play to an element other than Menu 1, you must first create 
that element. For this reason, you do not have to (and often can’t) set the project’s First 
Play when you start creating your project, but it is a good idea to have a plan in mind. 

You can set the project’s First Play in the Disc Inspector, the Connections tab, the 
Outline tab, and the Graphical tab. See “Assigning the First Play Element” on page 178 
for information on using the Outline and Graphical tabs to set the First Play. See 
“Settings at the Top of the Disc Inspector” on page 552 for information on using the 
Disc Inspector to set the First Play. See “Disc Sources” on page 534 for information on 
using the Connections tab to set the First Play. 

Opening an Existing Project
There are several methods you can use to open an existing DVD Studio Pro 4 project. 
These methods can also be used to open iDVD 3 and iDVD 4 projects, as well as projects 
created with earlier versions of DVD Studio Pro. See “Importing Other Projects” on 
page 629 for more information on opening iDVD and earlier DVD Studio Pro projects.

To open an existing project, do one of the following:
m Choose File > Open.
m Press Command-O.
m Double-click the project file in a Finder window.

If a project is already open in DVD Studio Pro, a dialog appears, prompting you to save 
it if it has not already been saved.

Note:  DVD Studio Pro only allows you to have one project open at a time.
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To open a recently opened project:

 

m

 

Choose File > Open Recent > [name of project].

 

m

 

Choose File > Open Recent > Clear Menu to remove existing projects from the Open 
Recent submenu.

There are several issues to be aware of when opening an existing project:

 

•

 

If you open a DVD Studio Pro project that uses a font that is not on the computer 
you are opening it on (either because the font was deleted or the project was 
created on a different computer), any items using the missing font have a different 
font substituted with no warning.

There are three items in a DVD Studio Pro project that utilize fonts:  a menu’s text 
objects, a button’s text, and text-based subtitles. 

 

•

 

When you open a project that uses assets requiring parse files, DVD Studio Pro 
checks to see if the files are available. If not, it creates them as part of the project-
opening process; in these cases, the project takes longer to open. It is not 
uncommon for the parse files to be left behind when moving a project and its assets 
from one computer to another. Creating the parse files can take from a few seconds 
to several minutes, depending on the number and length of the assets used in the 
project. A progress bar indicates the completion status of the parse file. See “About 
the Parse Files” on page 186 for more information about parse files.

 

•

 

When you open a project that DVD Studio Pro is unable to locate assets for, a Missing 
Files window appears. You can use the window to manually locate the assets. If you 
choose to open the project with missing assets, those assets are displayed in red in 
the Assets tab, and any elements that use them are disabled. See “Missing or 
Renamed Assets” on page 182 for more information.

 

•

 

Multiple users can open the same project over a network. This can lead to problems 
if each user makes changes and resaves the project. When another user opens the 
same project you are currently working with, an alert appears that names the other 
user and computer that opened the project. 

 

Important:  

 

DVD Studio Pro does not prevent multiple users from writing to a project. 
You must use care to avoid this situation and immediately resolve any alerts that appear.
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Video Standards of the World
Since you may find yourself needing to know the video standard of a particular 
country, following is a list of the different continents and regions of the world, and the 
video standards they use.

Note:  This list is subject to change, and should be used as a guideline only.

Continents and regions Video standard

Africa All countries in the African continent use either the PAL or SECAM 
video standard.

Asia All countries in the Asian continent use either the PAL or SECAM 
video standard, with the exception of Burma, Japan, the 
Philippines, South Korea, Taiwan, and Vietnam, which use the NTSC 
video standard.

Caribbean All islands in the Caribbean region use the NTSC video standard, 
with the exception of Guadeloupe and Martinique, which use the 
SECAM video standard.

Central America All countries in Central America use the NTSC video standard.

Europe All countries in the European continent use either the PAL or 
SECAM video standard. 

Middle East All countries in the Middle East use either the PAL or SECAM video 
standard. 

North America All countries in North America use the NTSC video standard, with 
the exception of Greenland, which uses the PAL video standard.

Oceania All countries in the Oceania region, including Australia and New 
Zealand, use either the PAL or SECAM video standard, with the 
exception of American Samoa, Guam, the Marshall Islands, 
Micronesia, the Midway Islands, Palau, and Samoa, which use the 
NTSC video standard.

South America All countries in South America use the NTSC video standard, with 
the exception of Brazil, which uses the PAL-M video standard, and 
Argentina, Paraguay, Uruguay, and French Guyana, which use either 
the PAL or SECAM video standard.
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Changing a Project’s Video Standard
When you create a project, all assets used in it must be the same video standard (NTSC 
or PAL). If you want the project to be available in both video standards, you need to 
create two projects—one for each standard. You can minimize the amount of work 
involved in re-creating the project in the other video standard by keeping the following 
rules in mind:
• You cannot have any video assets assigned to the project when you try to change 

the project’s video standard. Before you can remove the assets from the project, they 
must not be in use by any of the project’s elements. 

• Any markers placed in the Track Editor remain behind when you remove the video 
asset. If you then change the project’s video standard and import a version of the 
video asset in the new video standard, the markers are applied to the new asset. The 
timecode values of the markers change to match the new video standard. 
Depending on the encoding used, the markers may no longer occur at GOP 
boundaries. Be sure to select the “Fix invalid markers on build” setting in the Track 
pane of DVD Studio Pro Preferences to ensure you will be able to build the project. 
See “Track Preferences” on page 116 for more information.

• Still assets do not need to be removed before you change a project’s video standard. 
DVD Studio Pro automatically rescales still assets (except overlays) to the new video 
standard; however, for the best quality, it is recommended that you remove the 
original assets and import versions that match the new video standard.

• All menu settings, including button connections, drop zones, and text objects, are 
retained when you change a project’s video standard. This reduces the amount of 
reconfiguration you have to go through when changing video standards, even if you 
have to change the menu’s background.

Note:  An exception is if any buttons or drop zones use motion assets—the assets 
must be removed from these elements before you change the video standard.

• Audio assets can be used with either video standard. 
• If you add a QuickTime asset whose video standard is different from the project’s 

current setting, the embedded MPEG encoder automatically transcodes the asset to 
the project’s video standard while encoding it. For example, if you are working on a 
PAL project and accidentally import an NTSC QuickTime file, the NTSC file is encoded 
as a PAL asset and is imported into the project.

• Templates and styles are specific to the video standard. If your project relies on 
custom templates and styles, you will need to create versions in both NTSC and PAL 
to be able to use them in both standards. 

Note:  Apple templates and styles are supplied in both the NTSC and PAL standards.

Note:  Shapes are not specific to the video standard.
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Changing a Project’s DVD Standard
DVD Studio Pro makes it easy to convert an SD project to an HD project. However, 
there is no comparable method to use to convert an HD project to an SD project. For 
that reason, if you are intending to build both an SD and HD version of the project, you 
should start by building the SD version first.

Note:  If you create a new project and it has HD DVD selected when you actually intend 
to create an SD project, you must change the DVD Standard setting in the Project pane 
of DVD Studio Pro Preferences.

To convert an SD project to an HD project:
1 Do one of the following:

• Select the project’s name (next to the disc icon) in the Outline tab.
• Click an empty area in the Graphical tab.
The Disc Inspector appears. (Choose Window > Outline if the Outline tab is not visible. 
Choose View > Show Inspector if the Inspector is not visible.)

2 Click the General tab in the Disc Inspector. 

3 Select the HD DVD setting for DVD Standard.

A warning appears stating that you will not be able to convert the project back to the 
SD DVD standard.

4 Save the project using a new project name. 

This ensures the original SD project will remain as it is and not be overwritten.

There are a few things to keep in mind when converting an SD project to an HD project:

• HD projects cannot have MPEG-1 video. 
• If your SD project contains QuickTime video assets that use an HD video resolution, 

you can have the embedded MPEG encoder create MPEG-2 HD versions of those 
assets by Control-clicking them, choosing Encoder Settings from the shortcut menu, 
and then choosing new encoder settings for the asset.
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4 The DVD Studio Pro Interface

The DVD Studio Pro user interface is designed to provide 
a flexible environment that can be configured easily to fit 
the needs and skill levels of all users. 

A wide variety of users use DVD Studio Pro, from those who are familiar with iDVD and 
want to access a few more DVD authoring features, to those who have extensive 
experience with professional DVD authoring applications. 

You can arrange the DVD Studio Pro interface to display as much information as you 
need. The main interface can be arranged to display from one to four quadrants. Each 
quadrant can contain one or more tabs. Each tab provides access to specific functions. 
For example, the Menu tab contains the Menu Editor which you use to create menus. 
Some tabs will be used by all users while others are only used for advanced features. 
See “Overview of the Quadrant Tabs” on page 147 for information on the tabs. 

Tabs in the lower-
right quadrant

Toolbar
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The interface also includes a customizable toolbar. You can choose which tools appear 
and which are hidden. See “Customizing the Toolbar” on page 160 for more 
information.

A floating Inspector displays properties for each project element, with its contents 
changing based on the currently selected element. For example, if you are working on 
a menu’s buttons, the Inspector displays all properties and settings that apply to 
buttons. When creating basic DVD Studio Pro projects, you might find it easier to keep 
the Inspector closed, only opening it when necessary.

See “Inspector” on page 154 for more information.

A floating Palette provides easy access to features that help you create menus and 
tracks. These features include:

• Templates and styles
• Shapes
• Media tabs

See “Palette” on page 155 for more information.

Inspector
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Configuring the Interface
To make it easy to change between different configurations of the DVD Studio Pro 
interface, DVD Studio Pro lets you save each configuration. For example, once you 
configure the quadrants so they are optimized for creating subtitles, you can save that 
configuration for easy recall later.

Each configuration includes:

• The current arrangement of the quadrants, including their sizes, the tabs assigned to 
them, and the tab that is currently visible

• Any tabs that have been torn off into separate windows. See “Tearing Off a Tab Into 
Its Own Window” on page 146 for more information.

• The tools in the toolbar
• The column configuration in the Assets tab
• The Inspector and Palette window arrangements, including whether they are visible, 

their size, and their position

DVD Studio Pro includes several standard configurations you can choose from. These 
configurations provide three levels of access to the features of DVD Studio Pro—basic, 
extended, and advanced. 

You can use these configurations as they are, perhaps adding a new tool to the toolbar or 
another tab to a quadrant, or as a starting point for creating your own configurations.

Palette
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To choose a DVD Studio Pro configuration:
m Choose Window > Configurations, then choose a configuration from the submenu.

The submenu lists the supplied configurations plus any that you have created. Each of 
the first three supplied configurations are automatically assigned keyboard shortcuts 
F1 through F3. You can assign keyboard shortcuts for any custom configurations in the 
Manage Configurations dialog.

Once you select a configuration, the DVD Studio Pro interface changes to the new settings. 
You can make your own changes to the interface and save it as a new, custom configuration.

To save a configuration:
1 Configure the interface as needed, including the quadrants and their tabs, the toolbar, 

the Inspector, and the Palette. See “Working With the Quadrants” on page 142, “Hiding 
and Showing the Inspector” on page 154, “Hiding and Showing the Palette” on 
page 155, and “Customizing the Toolbar” on page 160 for more information.

2 Choose Window > Save Configuration. 

The following dialog appears.

3 Enter a name for the configuration.

4 Click Save. 

The new configuration is added to the list of configurations available to your system.

Note:  To update a custom configuration, save the updated version using the original 
version’s name.

Each standard configuration 
has a keyboard shortcut 
assigned.
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To manage your configurations:
1 Choose Window > Manage Configurations.

A list of existing configurations appears. The Key column lists the “F” key assigned as 
each configuration’s keyboard shortcut. 

2 Do any of the following:

• Click the Add (+) button to add a new configuration.
• Delete a configuration by selecting it and then clicking the Delete (–) button. 
• Rename a configuration by double-clicking it and entering a new name.
• Assign a keyboard shortcut to a configuration by choosing an “F” key from its Key 

pop-up menu.

Important:  F9, F10, and F11 are used by default by the Mac OS X Exposé feature. You 
can reconfigure them in System Preferences. F14 and F15 are used by Mac OS X to 
control the monitor brightness.

• Apply a configuration by selecting it and then clicking the Apply button.

3 Click Done to close the dialog and save the changes.

DVD Studio Pro Quadrants and Tabs
The main DVD Studio Pro interface can contain from one to four quadrants. Each 
quadrant contains one or more tabs that contain controls for specific functions. You have 
great flexibility in customizing what is displayed in each quadrant and how it’s displayed.

If you choose the basic configuration, one quadrant appears. With the extended 
configuration, three quadrants appear. See “Adding Quadrants to the Basic and 
Extended Configurations” on page 144 for details on working with the basic and 
extended configurations.
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Working With the Quadrants
You can adjust each quadrant’s size by dragging its borders, or adjust the size of all four 
quadrants at once by dragging the point where they intersect. You can “close” a 
quadrant by dragging its inside edge to the DVD Studio Pro interface edge.

Resizing the Quadrants
You can resize the quadrants in pairs, either horizontally or vertically, or resize them all 
at once. When all four quadrants are displayed, making individual horizontal or vertical 
adjustments affects all four quadrants. For example, dragging the horizontal boundary 
up causes both lower quadrants to get bigger, while both upper quadrants get smaller.

The pointer changes its shape when it is at a quadrant boundary, indicating that you 
can drag it from there. 

You can also quickly make the current quadrant expand to full window.

To make the current quadrant full window, do one of the following:
m Choose Window > Expand [tab name]. The currently active tab’s name is shown, and its 

quadrant is the one that becomes full window.
m Press Shift-Space bar.
m Press Option-Command-` (left quote, on the same key as the tilde).

In all cases, you can use these same methods to restore the quadrant to its normal size. 

Note:  If you perform a function that requires a different tab to appear, the quadrant is 
automatically restored to its normal size. 

To resize the quadrants manually, do one of the following:
m To change only the heights of the upper and lower quadrants, drag the boundary 

between the upper and lower halves up or down.
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m To change only the widths of the left and right quadrants, drag the boundary between 
the left and right halves left or right.

m To change both the heights and widths of the four quadrants, drag the point where 
they intersect.

m To split either the vertical or horizontal boundary, so that you can resize two quadrants 
while leaving the other two as they are, Option-drag the boundary you want to move. 
This creates two intersection points, each of which can be dragged as needed. To 
reconnect the split boundaries, drag one of them so that it aligns with the other, then 
release it. They are now reconnected and will move as a single boundary.

When a horizontal or vertical boundary gets close to an edge of the user interface, the 
boundary snaps to that edge, instantly hiding the smaller quadrant. This makes it easy 
to quickly display only one or two of the quadrants. You can display the hidden 
quadrants by dragging the edge back toward the center of the window.
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Adding Quadrants to the Basic and Extended Configurations
There are two ways to add quadrants to the basic and extended configurations:  
Choose a different configuration or drag their edges in toward the center.

The basic configuration is actually just the upper-right quadrant with its left and 
bottom boundaries dragged to the edges of the interface. To add a quadrant to the left 
half of the interface, drag the left edge toward the center. To add a quadrant to the 
bottom half, drag the bottom edge toward the center.

The extended configuration has the lower-left quadrant hidden. To add it, drag the 
lower-left edge toward the center.

Working With the Tabs
The quadrants hold the tabs that contain the primary controls of the DVD Studio Pro 
interface. You can select a tab to make it active, move the tab to a different quadrant, 
or “tear off” the tab to make it available in its own window.

Viewing a Tab’s Contents
When you have multiple tabs in a quadrant, only one is active and can be seen. There 
are several methods you can use to make a tab active so that it appears in front of 
the others.

To view a tab’s contents, do one of the following:
m Click the tab you want to view.
m Choose Window > [name of tab].
m Use the tab’s keyboard shortcut. For a compete list of keyboard shortcuts, see 

“Keyboard Shortcuts” on page 613.

Note:  If a tab is hidden, choosing it from the Window menu or using the keyboard 
shortcut makes it appear as a separate window.

In many cases, selecting an element in the Outline or Graphical tab automatically 
activates related tabs (if they are assigned to a quadrant). For example, if you double-
click a menu in the Outline tab, the Menu tab becomes active. 

Rearranging Tabs Within a Quadrant
You can change the order in which tabs appear within a quadrant.

To change the order of tabs:
m Drag a tab to a new position.
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Moving a Tab to a Different Quadrant
You can move a tab from one quadrant to another. This allows you to group tabs that 
work best for you. For example, you may group the tabs so that you can reduce the 
number of quadrants that appear and see just the tabs you use most.

To move a tab to a different quadrant by dragging:
m Drag a tab to the new quadrant’s tab area.

As you drag the tab, an outline surrounds the tab area in the quadrant to which you’re 
moving the tab. You can drag the tab to a specific position among the quadrant’s 
current tabs.

To move a tab to a quadrant using a shortcut menu:
m Control-click an empty part of the tab area in the quadrant you want to add a tab to, 

then choose the tab to add from the shortcut menu. (Tabs with checkmarks are already 
part of the quadrant.)

The tab you choose is removed from its existing location and added to the end of the 
quadrant’s current tabs. (If the tab was torn off into a separate window, its window is 
closed as long as there are no other tabs in the window.)

Dragging the Graphical tab 
to the upper-right quadrant
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Tearing Off a Tab Into Its Own Window
You can “tear off” a tab so that it appears in its own window. This is useful if you have a 
large computer display or use multiple displays and are able to spread out. It is also 
useful if you have a small display and a limited workspace, since it allows you to have 
larger windows without resizing the quadrants.

To tear off a tab, do one of the following:
m Drag a tab to a position outside of the immediate tab area.
m Control-click the tab, then choose Tear Off Tab from the shortcut menu.
m Control-click in the area next to the tabs in its quadrant, then choose the tab’s name 

from the shortcut menu.

The tab’s window can be sized and positioned as needed. You can also drag additional 
tabs to the window.

Restoring a Torn-Off Tab to a Quadrant
You can add a tab back into a quadrant using several methods.

To restore a tab to its quadrant, do one of the following:
m Drag the tab’s name to a quadrant. The tab snaps back into place and its window closes 

(as long as there are no other tabs in the window).

Note:  This is different from dragging the window’s title bar, which just repositions 
the window.

m Control-click an empty area of a quadrant’s tab area, then choose the tab from the 
shortcut menu. You can also do this if the tab’s window has been closed. 

Dragging the Graphical
window’s tab to add it to

the upper-left quadrant
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What Happens If You Close a Torn-Off Tab’s Window?
If you close a tab’s window by clicking the close button in the upper-left corner of the 
window, the tab does not automatically get added back to a quadrant, and it is no 
longer displayed. 

You can either reopen the window or add the tab to one of the quadrants (as 
described in the previous section).

To reopen the tab in its own window, do one of the following:
m Choose Window > [the tab name].
m Press the tab’s keyboard shortcut.
m Double-click an element that requires the tab in the Outline or Graphical tab.

The tab opens in its window at the same position and size as when it was closed.

Overview of the Quadrant Tabs 
Following is an alphabetical list of the tabs that can be included in the quadrants. 

Assets Tab
The Assets tab is a central location for managing the assets used in your project. It 
displays extensive information about each asset in columns that you can configure to 
see just the information you want. Additionally, you can create folders and subfolders 
to help organize assets when you are working with large projects. See “Assets Tab” on 
page 187 for details on working with the Assets tab.
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Connections Tab
The Connections tab provides a comprehensive tool for linking elements—such as a 
menu button and a track marker—to each other. While there are a number of ways to 
make most connections, including directly in the Menu Editor, the Connections tab is 
the only way to access some advanced features. See Chapter 15, “Establishing 
Connections,” on page 525 for details on working with the Connections tab.

Graphical Tab
The Graphical tab provides a tile-based view of all elements in your project. You are 
able to arrange the tiles and display lines indicating how they connect to each other. 
This makes it possible to create a flowchart of your project, which can be printed and 
used for project planning and approvals. See “Using the Graphical Tab” on page 167 for 
more information.
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Log Tab
You can use the Log tab to see status information for a variety of functions:
• Build:  Displays messages generated while building your project’s files in preparation 

for writing them to a DVD disc.
• Encode:  Displays messages generated by the embedded MPEG and AIFF encoders.
• Simulate:  Displays messages generated while using the Simulator with your project.

Menu Tab
The Menu tab contains the Menu Editor. You use the tools in the Menu Editor to build 
your project’s menus. The editor contains a display to show the menu’s video contents, 
along with controls to configure the display. See “About the Menu Editor” on page 211 
for details on using the Menu Editor.
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Outline Tab
The Outline tab provides an organized list of all project elements. Each element is 
grouped by type, such as Menus or Tracks, in sections that function a bit like file folders. 
Next to each section name is a disclosure triangle—clicking the triangle allows you to 
hide or display the elements listed in that section. See “Using the Outline Tab” on 
page 165 for details on using the Outline tab.

The Outline tab also contains the VTS Editor. The VTS Editor (Video Title Set Editor) 
allows you to manually place project elements into specific VTS blocks. See “VTS Editor” 
on page 588 for more information.
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Script Tab
The Script tab contains the Script Editor. You use the Script Editor to add and manage 
commands in your scripts. The editor lists each command and its step number. See 
“The Scripting User Interface” on page 470 for details on using the Script Editor.

Slideshow Tab
The Slideshow tab contains the Slideshow Editor. You use the tools in the Slideshow 
Editor to create and edit slideshows. The editor contains thumbnails of each slide in 
display order, along with the slide’s duration. You can also add audio to your slideshow 
in the editor. See “Slideshow Editor Settings” on page 415 for details on using the 
Slideshow Editor.
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Story Tab
The Story tab contains the Story Editor, which you use when creating a story for a track. 
To create a story, you choose which sections of the track to play, as defined by chapter 
markers. See “Using the Story Editor” on page 391 for details on using the Story Editor.

Track Tab
The Track tab contains the Track Editor. The Track Editor displays all streams associated 
with a track (video, audio, and subtitle) in a linear, timecode-based manner. It provides 
tools for adding and editing markers. It allows you to trim and combine multiple assets 
on a single stream. See “Configuring the Track Editor” on page 364 for details on using 
the Track Editor.
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Viewer Tab
The Viewer tab lets you view your project’s elements. See “Viewing a Track” on 
page 400 for details on using the Viewer tab.

The Viewer tab is also used when editing subtitles. You use the tools along the bottom 
to build subtitles within DVD Studio Pro or to view subtitles imported from an external 
source. The display shows both the subtitle and the first frame of video that it appears 
over. See “Creating Subtitles With DVD Studio Pro” on page 445.
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Inspector
The Inspector is a floating window that displays the properties of the element you are 
currently working with. In some cases, it contains multiple tabs, with the properties 
grouped by type and function.

With the exception of the Palette, the Inspector always has the highest viewing priority 
of the DVD Studio Pro windows—it is never covered by any other DVD Studio Pro 
window. (If the Inspector and Palette are in the same area of the screen, the one last 
selected will cover the other.) Because it is always on top of the other interface 
elements, you may find it useful to keep the window closed until you need it.

Hiding and Showing the Inspector
You can hide and show the Inspector to suit your needs. 

To hide the Inspector, do one of the following:
m Choose View > Hide Inspector.
m Click the close button in the upper-left corner of the window.
m Click Inspector in the toolbar. 
m Press Option-Command-I.

To show the Inspector, do one of the following:
m Choose View > Show Inspector.
m Click Inspector in the toolbar. 
m Press Option-Command-I.
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Palette
The Palette provides easy access to the templates, styles, and shapes used to create 
menus. Additionally, the Palette includes three media tabs—Audio, Stills, and Video—
that can make it easier to locate the assets you want to import.

Hiding and Showing the Palette
With the exception of the Inspector, the Palette always has the highest viewing priority 
of the DVD Studio Pro windows—it is never covered by any other DVD Studio Pro 
window. (If the Palette and Inspector are in the same area of the screen, the one last 
selected will cover the other.) Because it is always on top of the other interface 
elements, you may find it useful to keep the window closed until you need it.

To hide the Palette, do one of the following:
m Choose View > Hide Palette.
m Click the close button in the upper-left corner of the window.
m Click Palette in the toolbar. 
m Press Option-Command-P.

To show the Palette, do one of the following:
m Choose View > Show Palette.
m Click Palette in the toolbar. 
m Press Option-Command-P.
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Templates and Styles Tabs
A template comprises up to five styles that define most aspects of a menu. You can 
create your own templates and styles or use those that DVD Studio Pro provides. You 
can apply all or just selected parts of a template or style to a menu or a selected part of 
a menu. This makes it easy to create a series of menus using an identical button layout 
and background.

See “Using Templates, Styles, and Shapes to Create Your Menus” on page 303 for details 
on using templates and styles to create your menus.

Shapes Tab
Shapes are graphics elements that you can add to your menu as either a button or a 
drop zone. You can drag them directly from the Shapes tab to your menu background 
or choose the shape to use in the Button Inspector’s Style tab or in the Drop Zone 
Inspector. You can use the shapes that DVD Studio Pro provides, or you can create and 
import your own.

Click to select the 
category of styles you 
want to view.
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See “Creating Shapes” on page 93 for details on creating shapes and “Adding Shapes to 
a Menu” on page 256 for details on using them in your menus.

Media Tabs
The Palette includes a set of three media tabs—labeled Audio, Stills, and Video—that 
display DVD Studio Pro–compatible assets located in folders that you specify. You can 
add these assets to your project by dragging them from the Palette to the Assets tab, 
Menu Editor, or anywhere else you can directly add assets. 

Select a folder from this 
list to view its contents.

Click this button to play 
the selected audio or 
video asset.

The assets in the selected 
folder

Use these to add and
delete folders.

Drag this separator bar
to control how many

folders appear.

Enter text to search for
in the selected folder.
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The media tabs, and the folders assigned to them, are available to all DVD Studio Pro 
projects. They provide an additional method to organize your assets, and are especially 
useful for accessing assets you use often. 

Important:  Assets that appear in the media tabs are not automatically part of a project 
in DVD Studio Pro. You must add them to a project by dragging them to it. You should 
think of the media tabs as being a specialized Finder window.

Adding Folders to the Folder List
The folder list appears at the top of the three media tabs. Before you can see your 
assets in any of the media tabs, you must add one or more folders to the folder list.

To add a folder to the folder list:
1 Click the tab of the asset type to add a folder to (Audio, Stills, or Video).

2 Add a folder by doing one of the following:

• Drag a folder from a Finder window to the folder list. 

Note:  If you click outside of DVD Studio Pro without dragging a folder to a media 
tab, the Palette disappears and you will need to reselect DVD Studio Pro to see the 
Palette again.

• Click the Add (+) button. A folder selection dialog appears. Select the folder or 
folders to add and click Add. 

• Control-click in the list where you want the added folder to go, then choose Add 
Folder from the shortcut menu. A folder selection dialog appears. Select the folder or 
folders to add and click Add.

The folder appears in the folder list. You can now select the folder to see a list of its assets. 

Note:  Only assets in the selected folder appear. Assets in subfolders (nested folders) 
are ignored.
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Managing the Folder List
There are several ways to make the folder list easier to use:
• You can change the folder list display order to have folders you use frequently 

appear at the top.
• You can remove folders that are no longer needed, such as those specific to a project 

that is completed.

To change the folder list display order:
1 Click the tab whose display order you want to change (Audio, Stills, or Video).

2 Drag the folder to be moved slightly to the right or left, then up or down to its new 
location. A black line appears to show where the folder will be placed when you release it.

Note:  Dragging straight up or down does not move the folder—it selects the folders 
the pointer moves over and shows their contents in the assets area.

To remove a folder from the folder list:
1 Click the tab to remove the folder from (Audio, Stills, or Video).

2 Select the folder or folders to remove in the folder list. 

3 Do one of the following to remove the folder:

• Click the Delete button. 
• Control-click the folder, then choose Remove Folder from the shortcut menu.
• Press the Delete key.

The folder is removed from the folder list. 

Note:  This does not delete the folder or its assets from your hard disk, and has no effect 
on assets that may have been added to your project from this folder.

Viewing and Using Assets
Once you have added folders containing compatible assets, you can show the assets 
and drag them to your project.

To show a folder’s assets:
m Select the folder that contains the assets you want to see. You can select multiple 

folders by dragging the pointer over a group of folders, holding down the Shift key and 
clicking the folders (if they are contiguous), or holding down the Command key and 
clicking the folders (if they are not together).

You can change the Palette’s size to control how many assets you can see. You can also 
drag its separator bar to control the sizes of the folder list and assets area. 

There are five columns in the Audio tab (Name, Artist, Length, Sample, and Type) that 
show additional information about each asset. Similar to the columns in the Assets tab, 
you can change the column order and size, and sort the list based on the column heading 
you click. See “Managing Columns in the Assets Tab” on page 190 for more information.
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To play a folder’s video or audio asset:
m Click the Play button in the bottom-right corner of the Audio or Video tab. Click it a 

second time to stop playback.

Audio assets play through your system’s audio setup. 

Video assets play in their thumbnail image. The General pane in DVD Studio Pro 
Preferences contains a setting that allows you to choose small or large thumbnail 
images, which may make viewing the video easier. Also, audio will play along with the 
video if it is a QuickTime file with video and audio together or an MPEG file with an 
audio file in the same folder with the same root name.

To use the assets in your project:
m Drag the asset to the Menu Editor, Assets tab, or to any other project element within 

DVD Studio Pro that allows you to drag assets in. 

You can select and drag multiple assets. You can also drag a folder from the folder list 
to the project element to create a slideshow.

Depending on the “Find matching audio when dragging” setting in the Track pane in 
DVD Studio Pro Preferences, when you drag an MPEG video asset to an element, 
DVD Studio Pro can automatically add the companion audio asset to the element as 
long as it is in the same folder and has the same root name as the video asset. Press 
the Command key after you start dragging to override the preferences’ setting for 
dragging a video file. When you drag a QuickTime asset that also has audio from the 
Video tab, it is treated like a video/audio pair.

Toolbar
The DVD Studio Pro interface includes a toolbar that can be customized to display 
exactly the tools you need. The toolbar provides one-click access to a variety of 
functions, such as creating menus and slideshows or simulating your title. 

Customizing the Toolbar
You can customize the toolbar in a variety of ways, including selecting the tools to 
include, rearranging them, and choosing whether both the tool’s icon and text appear.

Note:  Choosing a new user configuration from the Window menu also changes the 
toolbar contents. Be sure to save a new user configuration once you are finished 
customizing the toolbar.
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Hiding and Showing the Toolbar
You can choose to hide the toolbar completely.

To hide the toolbar:
m Choose View > Hide Toolbar.

To show a toolbar that has been hidden:
m Choose View > Show Toolbar.

Managing the Toolbar
DVD Studio Pro provides a simple drag-and-drop interface for managing the toolbar.

To manage the toolbar:
1 To display the toolbar palette, do one of the following:

• Choose View > Customize Toolbar.
• Control-click the toolbar, then choose Customize Toolbar from the shortcut menu.

2 To add tools to the toolbar, drag their icons from the toolbar palette to their new 
position in the toolbar.

3 To remove tools from the toolbar, drag them out of the toolbar, or Control-click the tool 
you want to remove and choose Remove Item from the shortcut menu.

4 To change the order of the tools in the toolbar, drag each tool to its new position.

5 To set the toolbar to a default configuration, drag the default set of tools to the toolbar.

6 To control whether each tool’s icon and text appear in the toolbar, choose Text Only, 
Icon Only, or Icon & Text from the Show pop-up menu in the toolbar palette, or 
Control-click the toolbar and choose Text Only, Icon Only, or Icon & Text from the 
shortcut menu. 

7 Click Done when you are finished configuring the toolbar.
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Toolbar Items
The following items (listed in alphabetical order) can appear in the toolbar.

Note:  With the exception of Space, Flexible Space, and Separator, you can have only 
one of each item in the toolbar.

• Add Language:  Adds a new menu language to the project. 
• Add Layered Menu:  Adds a new layered menu to the project. 
• Add Menu:  Adds a new standard menu to the project. 
• Add Slideshow:  Adds a new slideshow to the project. 
• Add Story:  Adds a story to the currently selected track (or the first one, if none is 

currently selected).
• Add Script:  Adds a new script to the project. 
• Add Track:  Adds a new track to the project. 
• Build:  Compiles your project and creates a video title set (VIDEO_TS folder) of 

your project. 
• Build/Format:  First builds the video title set, then writes it to a DVD drive, DLT drive, 

or as a disk image to a hard disk.
• Burn:  Builds the video title set and writes it to your DVD burner using the current 

Disc Inspector settings. 
• Configurations:  Opens the Configuration Manager dialog so that you can manage or 

apply an interface configuration.
• Customize Toolbar:  Opens the toolbar palette.
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• Disc Meter:  Displays the disc meter. A progress bar shows both the amount of disc 
space used and what is still available (based on the Disc Media you select in the Disc/
Volume tab in the Disc Inspector). The number underneath the progress bar shows 
the amount of space used.

• Flexible Space:  Inserts a space into the toolbar that automatically expands to fill any 
existing empty space. This ensures that there are tools at the left and right edges of 
the toolbar.

• Format:  Writes the video title set to a DVD drive, Digital Linear Tape (DLT) drive, or as 
a disk image to a hard disk.

• Import Asset:  Opens the Import Asset dialog, allowing you to select assets to import 
into the project.

• Inspector:  Displays the Inspector.
• Menu Editor:  Displays the Menu Editor.
• Palette:  Displays the Palette in its last configuration.
• Read DLT:  If a DLT drive is connected and a DLT tape inserted, reads the tape 

contents and writes them to the designated drive.
• Separator:  Inserts a vertical bar into the toolbar, allowing you to group tools.
• Show Colors:  Opens the Colors window.
• Show Fonts:  Opens the Font panel.
• Simulate:  Opens the project Simulator, allowing you to try out your project before 

actually building it.
• Slideshow Editor:  Displays the Slideshow Editor.
• Space:  Inserts a fixed space into the toolbar. This allows you to group tools by adding 

a fixed space between them.
• Story Editor:  Displays the Story Editor.
• Subtitle Editor:  Displays the Subtitle Editor.
• Track Editor:  Displays the Track Editor.
• Viewer:  Displays the Viewer tab. 
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Drop Palette
The Drop Palette appears in the Menu Editor when you drag an asset or project 
element to it. Once you stop moving the pointer, the Drop Palette appears, allowing 
you to choose how to use the asset within the menu. The contents of the Drop Palette 
vary, depending on the asset or element type, how many assets you drag, and whether 
you have dragged to an existing button.

See “Options in the Drop Palette for Standard Menus” on page 285 and “Options in the 
Drop Palette for Layered Menus” on page 337 for a complete listing of the options in 
the Drop Palette.

Using the Outline and Graphical Project Views
DVD Studio Pro includes two tabs you can use to view and work with your project:  the 
Outline tab and the Graphical tab. Each tab has its own advantages, and you will most 
likely find yourself using both as you create your project.

Comparing the Outline and Graphical Tabs
The Outline and Graphical tabs both:
• Show all project elements
• Allow you to select an element so that you can work on it
• Allow you to rename an element
• Allow you to add, delete, and duplicate elements
• Allow you to show the selected element in the Simulator
• Automatically create new elements when assets are dragged to the tabs, or modify 

existing elements if assets are dragged to an existing element in the tabs
• Allow you to drag elements to the Menu Editor to establish connections
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The Outline tab also has these capabilities:

• It includes the menu language elements that you use when configuring your menus 
to support multiple languages.

• It includes the VTS Editor that provides extensive control over how your project’s 
elements are burned to a DVD.

The Graphical tab also has these capabilities:

• You can choose whether to view all elements or just specific types.
• Elements that use the transitions feature are marked.
• The element assigned as First Play has a special icon.
• You can view connection lines that show which elements have targets set to 

other elements.
• You can arrange the tiles to provide a flowchart view of the project.
• You can print the Graphical tab.
• You can set a flag on specific elements, making it easy to distinguish them.

See “Using the Outline Tab” on page 165 and “Using the Graphical Tab” on page 167 
for detailed information on using each tab. See “Managing Elements Using the 
Outline and Graphical Tabs” on page 177 for information on using the tabs to manage 
your project’s elements. 

See “Dragging Assets to the Outline and Graphical Tabs” on page 196 for information 
on what happens when you drag assets directly to the Outline or Graphical tab.

Using the Outline Tab
The Outline tab provides a simple list view of your project’s elements. It contains two 
displays:  By Type and By VTS. You can click the Alternate View button to switch 
between the two displays or drag the partition to show both displays at the same time.

The elements in the By VTS and By Type displays are very similar and can be used to do 
many of the same things. For example, double-clicking an element in either display 
opens it in its editor and inspector. (Selecting an element in one display also selects 
that same element in the other.)
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The primary difference is in how they are organized.

• By VTS lists the elements based on the VTS they belong to. A VTS can have only one 
track (which can also have stories) or one slideshow, but it can have multiple menus 
and scripts. The primary use of the By VTS display is to control how your project’s 
elements are written to a DVD. See “VTS Editor” on page 588 for more information.

• By Type lists the elements based on their type (menus, tracks, slideshows, and scripts). See 
“Using the Outline Tab” on page 165 for more information on using the By Type display.

Note:  The Languages section in the By Type display does not represent actual 
elements—it represents languages that can be used for the menus. It does not appear 
in the By VTS display since it is not specific to a VTS.

Selecting Elements
The most common way to use the Outline tab is to select a project element so that you 
can configure it. Selecting an element changes the Inspector and the element’s editor 
to display settings for that particular element. Double-clicking an element brings the 
editor to the front of the DVD Studio Pro interface, the same as if you clicked its tab.

You can select several elements at once by holding down the Command key while 
clicking the elements, or select all elements by pressing Command-A. You can delete, 
duplicate, and save descriptions of a group of elements.

If you hold the pointer over an element in the Outline tab, a tooltip appears that shows 
additional information about the element, such as what type of menu it is, or how 
many streams it has.

Click each section’s
disclosure triangle to

view its contents.

Option-click the Tracks
disclosure triangle to also

show the stories.

Layered menus use a 
different icon than 
standard menus.

Alternate View button 
swaps view between 
By Type and By VTS.

Adds a new empty VTS
(active only in the

By VTS view).

Drag this partition to split 
the tab and show both 
By Type and By VTS.
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Moving Elements in the By Type Display
You can move an element from one position to another within the same section. 

Note:  The order of the elements in the By Type display does not affect how the 
elements are written to the DVD.

To change an element’s position in the Outline tab’s By Type display:
m Drag the element to its new position. As you drag, a line appears between elements to 

indicate where the dragged element will be moved when you release it.

Using the Graphical Tab
The Graphical tab uses a tile-based interface to show you a project’s elements.

Tile viewing and editing tools

Choose tile types to view.

Macro view shows
entire tile area.

Connections, tile size, 
and snap grid settings

Project element tile

Connection line
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Graphical Tab Introduction
The Graphical tab uses tiles to represent each element in your project. Similar to the 
Outline tab, you can use the Graphical tab to select elements to work with and can 
rename the elements. Each tile contains a thumbnail image that represents the 
element. You are able to position the tiles as needed, and can choose to view either 
large or small versions of the tiles. You can also choose to view connection lines 
between the elements.

Viewing Options
Depending on the size of your project, the Graphical tab can have a large number of 
tiles and not be able to fit in the tab’s window. You can either make the tab’s view 
larger so that more tiles can be seen, zoom out to fit the tiles to the window, or you 
can use scrollers to view a portion of the tile area. 

To make the tab’s view larger, do one of the following:
m With the Graphical tab selected, press Shift-Space bar.

The tab’s contents fill the DVD Studio Pro interface. Press Shift-Space bar again to 
restore the tab to normal size. If you double-click a tile, the tab’s view reverts to normal 
size so that you can see the editors.

Note:  If you hold down Shift-Space bar, the large view becomes temporary and will 
revert back to normal once you release the keys.

m Press Option-Command-` (left quote, on the same key as the tilde).
m Drag an edge of its quadrant. 

See “Resizing the Quadrants” on page 142 for more information.
m Tear the tab off into its own window.

See “Tearing Off a Tab Into Its Own Window” on page 146 for more information.

To fit the tiles to the current window size, do one of the following:
m Click the Graphical tab’s Zoom to Fit button.

m Press Shift-Z.

When there are more tiles than can be displayed in the Graphical tab, scrollers appear 
that allow you to control which part of the tile area shows. The scrollers also allow you 
to zoom in or out on the tile area.

Zoom to Fit button
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To use the Graphical tab scrollers, do one of the following:
m Drag them to control which part of the tile area you can see.
m Drag the ends of the horizontal scroller to zoom in or out on the tile area.

There are also several zoom and positioning keyboard shortcuts available.

To zoom using keyboard shortcuts, do one of the following:
m Press Z, then click the area of the Graphical tab that you want to zoom in on. Press 

Option-Z, then click to zoom out.
m Press Z, then drag the pointer across the area that you want to zoom in on.
m Press the Space bar. The pointer changes to a hand that you can use to control which 

part of the tile area is visible, similar to using the scrollers.
m Press Command-+ to zoom in and Command-– (hyphen) to zoom out on the Graphical 

tab, maintaining its center position.

Using the Macro View
The Graphical tab includes a macro view capability. The macro view is a small display 
showing a view of the entire tile area. It includes a visible-view rectangle that indicates 
the part of the tile area currently showing. You can drag the visible-view rectangle to 
choose the part of the tile area that shows, and you can change the rectangle’s size to 
zoom in or out.

Displaying the Macro View
The macro view floats over the top of the Graphical tab. There are several methods you 
can use to display or hide the macro view.

To display and hide the macro view, do one of the following:
m Click the Graphical tab’s macro view button.

m Press M.

Note:  You can temporarily display the macro view by holding down the M key.

Drag the scroller ends to zoom 
in or out on the tile area.

Shows and hides the macro view.
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m Position the pointer over the macro view (which causes the title bar to appear), then 
click the hide symbol in the macro view’s title bar to hide the macro view.

Note:  The title bar can appear on the top or bottom of the macro view, depending on 
where the pointer is.

Working With the Macro View
You are able to position the macro view anywhere within the tab, but you cannot move 
it outside the tab’s boundaries.

To move the macro view within the Graphical tab:
m Position the pointer over the macro view (which causes the title bar to appear), then 

drag the title bar to the new position. 

To change the size of the macro view display:
m Drag the resize corner of the title bar.

The visible-view rectangle can be moved and resized to control the tile area that shows.

To use the visible-view rectangle, do one of the following:
m Click within the rectangle to drag it to a new position.
m Click outside the rectangle to have the rectangle jump to a new position, with the 

point you clicked being as close as possible to the rectangle’s center.
m Drag a corner of the rectangle to change its size. Making the rectangle bigger zooms 

out on the tile area, showing more tiles. Making the rectangle smaller zooms in on the 
tile area, showing fewer tiles. 
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Selecting and Managing Tiles
You can use several tools to select and arrange tiles—many are the same as those used 
with buttons in the Menu Editor. There are also a variety of methods you can use to 
add, delete, and copy tiles.

Selecting Tiles
There are several reasons you might want to select one or more tiles:
• Selecting a tile makes it the current element, and opens it in its editor. 
• Selecting one or more tiles allows you to arrange them.
• Selecting one or more tiles allows you to delete or copy them.

To select one or more tiles, do one of the following:
m Click a tile to select it. Any other selected tiles are deselected.
m Press the Shift or Command key, then click a tile to select it. Any other selected tiles 

remain selected.
m Drag the pointer over a group of tiles. This creates a selection rectangle that selects all 

tiles it touches.
m Choose Edit > Select All to select all tiles. You can also choose Edit > Deselect All or 

click an empty part of the Graphical tab to deselect all tiles.
m Press Command-A to select all tiles. You can also press Shift-Command-A to deselect 

all tiles.

Moving Tiles by Dragging
You can move a tile or group of tiles once they are selected by simply dragging them. If 
connections are showing, they move with the tiles. You can also use the arrow keys to 
move selected tiles.

If you move a tile to an edge of the Graphical tab, the tile area scrolls to show its new 
position. If the edge of the tile area is reached, it is automatically expanded to 
accommodate the tile’s new position.

To make it easier to see a larger area while dragging a tile, you can press the Z key after 
you start dragging the tile to temporarily zoom out.

You can enable a snap grid to make it easier to organize the tile in straight lines 
and columns.

To enable the snap grid:
m Choose Snap to Grid from the Graphical tab’s Settings pop-up menu.

You may want to drag a tile to the Menu Editor. This is an easy way to link either a new 
or an existing button in the current menu to the element being dragged.
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To drag an element to the Menu Editor:
1 Click the element’s tile and hold down the mouse button for a moment without 

moving the tile.

A transparent tile appears.

2 Drag the transparent tile to the Menu Editor.

You can also drag multiple tiles to the Menu Editor by selecting them before holding 
down the mouse button on one of them.

Using Distribute Objects
The distribute objects feature allows you to select a group of tiles and evenly space 
them between each other using one of four methods:
• Horizontally:  Only active when more than one tile is selected. Tiles in between the tile 

furthermost to the left and furthermost to the right are positioned evenly horizontally.
• Vertically:  Only active when more than one tile is selected. Tiles in between the tile 

furthermost to the top and furthermost to the bottom are positioned evenly vertically.
• By Type:  With no tiles selected, all tiles are affected; with one or more tiles selected, 

only the selected tiles are affected. Arranges the tiles in evenly spaced rows and 
columns based on their types. The type order is:
• Menus
• Layered menus
• Tracks
• Stories
• Slideshows
• Scripts

• Autolayout:  Affects all tiles, regardless of which are selected. The tiles are arranged 
based on connections, types, and quantity.

To use the distribute objects feature:
1 Depending on the distribution method you intend to use, select the group of tiles to 

distribute. See “Selecting and Managing Tiles” on page 171 for details on how to do this.

2 Choose Arrange > Distribute Objects, then choose the distribution method to use 
(Horizontally, Vertically, By Type, or Autolayout).

Locking the Tile Positions
You can lock the tile positions and prevent accidentally rearranging them.

To lock the tile positions, do one of the following:
m Choose Arrange > Lock All Tiles.
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m Click the Graphical tab’s Lock button.

m Press L.

You can use the same button and keyboard shortcut to unlock the tiles. If you need to 
move a tile while they are locked, you can press the Option key, then drag it to the 
new location.

While the tile positions are locked, you are still able to change your view of the tiles by 
zooming or using the scrollers. You can also change the connections view. 

About the Tiles
There are six different tile types that can appear in the Graphical tab. Each type uses a 
different color to differentiate it:
• Menu:  light blue
• Layered menu:  dark blue
• Track:  green
• Story:  teal
• Slideshow:  purple
• Script:  brown

Each tile has a thumbnail image of the element. The aspect ratio of the thumbnail 
changes to indicate whether the element uses 4:3 or 16:9 assets. A tooltip showing 
information about the element appears when you position your pointer over it. 

The element designated as First Play has an icon added to it. Elements that are using 
the transitions feature also have icon indications.

Tile position lock button

First Play icon

Transitions icon

Element name
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Tile Sizes
You can choose large or small sizes to view the tiles.

To change the tile size:
m Choose Small Tiles or Large Tiles from the Graphical tab’s Settings pop-up menu. 

Flagging Tiles
You can flag a tile so that it stands out from the others. For example, you might want to 
flag tiles for elements that still require assets or use DVD@CCESS.

To flag one or more tiles, do one of the following:
m Control-click a tile and choose Flag from the shortcut menu. This also selects this tile 

and deselects any others that are selected.
m Shift-Control-click a tile and choose Flag from the shortcut menu. This also selects this 

tile and flags any others that are selected.
m Position the pointer over a tile and press F. It does not matter whether the tile is 

selected or not.
m Select a group of tiles to be flagged, then choose Edit > Flag Tiles. 
m Select a group of tiles and press F.
m Select a group of tiles to be flagged, Control-click an empty area in the tile display, then 

choose Flag from the shortcut menu.

You can use any of these methods to also turn off the flags on one or more tiles.

Viewing Specific Tile Types
You can choose specific tile types to view. For example, you may only want to see the 
slideshows.

Note:  If you choose to hide a tile type, all connections to that tile type are also hidden.

The Graphical tab’s tile type show/hide buttons control which tiles are visible and 
which are hidden.

Clicking a button hides its tile type and the button background becomes lighter. Clicking 
the button again shows its tile type and the button background becomes darker.

Menu tiles

Script tilesTrack tiles
Slideshow tilesStory tiles
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Viewing Connections
You can configure the Graphical tab to show lines indicating which elements are 
connected to each other. Arrows indicate which element is the target. 

The connection lines are useful when you want to view the project as a flowchart. They 
can also be helpful to ensure you have not inadvertently left out an intended connection.

Note:  You cannot make connections or change existing connections in the Graphical tab.

You can customize how many connections appear with the Graphical tab’s Settings 
pop-up menu.

• No Connections:  No connection lines appear.
• Relative Connections:  Only the connections relating to the currently selected tile or 

tiles appear. 
• All Connections:  All tiles show their connections.
• Basic, Standard, and Advanced Connections:  Control how much connection detail to 

show. These three levels match a similar setting in the Connections tab. See “Sources” 
on page 528 and “Source Details” on page 534 for more information.

To configure the Graphical tab’s connections view:
1 Open the Graphical tab’s Settings pop-up menu.

2 Choose to show no connections, relative connections for selected tiles only, or 
all connections.

3 Choose the level of connections to show (basic, standard, or advanced).
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Printing the Graphical Tab’s Tile Area
Printing the Graphical tab’s tile area can be a useful way to show others the basic 
construction of a project. The contents of the Graphical tab print as they currently 
appear with respect to tile size and placement and connection view status.

You can choose to print the whole tile area on a single sheet of paper or to print the 
tile area over multiple sheets of paper.

To print the Graphical tab’s tile area:
1 Do one of the following:

• Choose File > Print Graphical View.
• Press Command-P.

2 Choose DVD Studio Pro from the print configuration pop-up menu.

3 Select one of the following:

• Fit to Page:  Prints the entire tile area on one sheet.
• Multiple Pages:  Prints the tile area at full size, using as many sheets of paper as necessary.

4 Select the Page Numbers option to add page numbers to each sheet. This is especially 
useful when you select Multiple Pages.

5 Click Preview to see an example of how the printed document will look, or Print to 
print the tile area.
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Managing Elements Using the Outline and Graphical Tabs
You can use either the Outline or Graphical tab to manage your project’s elements.

Renaming Project Elements
In addition to entering an element’s name in its Inspector, you can rename an element 
in the Outline or Graphical tab.

To rename an element in the Outline tab:
1 Select the element whose name you want to change.

2 Click the element’s name.

3 Type the new name, then press Return. 

The element’s name is changed.

To rename an element in the Graphical tab:
1 Double-click the element’s name.

2 Type the new name, then press Return. 

The element’s name is changed.

Deleting Elements
You can delete elements to remove them from your project.

To delete an element or group of elements:
1 Select the element or group of elements to delete.

2 Do one of the following:

• Choose Edit > Delete.
• Control-click in an empty area of the Outline or Graphical tab, then choose Delete 

from the shortcut menu.
• Press the Delete key.

Important:  If you delete a track that has stories, the stories are also deleted. An alert 
appears to warn you of this.

Duplicating Elements
You can duplicate elements within the Outline and Graphical tabs. You can build a 
chapter index menu, for example, and quickly make duplicates of it that just need to 
have their connections changed to become functional.
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To duplicate an element:
1 Select the element to duplicate.

You can also select multiple elements.

2 Do one of the following:

• Choose Edit > Duplicate.
• If you have selected a single element, Control-click the element, then choose 

Duplicate from the shortcut menu. 
• If you have selected a group of elements, Control-click in an empty area of the tab, 

then choose Duplicate from the shortcut menu.
• Press Command-D.

The new element is named with its type (menu, track, and so on) followed by the next 
number. For example, if you duplicate a menu when there are already five menus, the new 
one becomes “Menu 6.” In the Outline tab, the new element appears last in the section.

Assigning the First Play Element
In addition to using the Disc Inspector or the Connections tab, you can assign your 
project’s First Play element directly in the Outline or Graphical tab. The First Play 
element is the one that plays when a DVD player begins playing the project.

To assign the First Play element in the Outline tab, do one of the following:
m Control-click the disc element, then choose the First Play element from the shortcut 

menu’s First Play submenu. This method allows you to select a specific button (menu), 
slide (slideshow), or chapter marker (track or story) within an element to play from.

m Control-click an element, then choose First Play from the shortcut menu. This method 
uses the element’s default button (menu), first slide (slideshow), or first marker (track or 
story) to play from.

To assign the First Play element in the Graphical tab, do one of the following:
m Control-click in an empty area of the Graphical tab, then choose the First Play element 

from the shortcut menu’s First Play submenu. This method allows you to select a 
specific button (menu), slide (slideshow), or chapter marker (track or story) within an 
element to play from.

m Control-click a tile, then choose First Play from the shortcut menu. This method uses 
the element’s default button (menu), first slide (slideshow), or first marker (track or 
story) to play from.

See “Setting the Project’s First Play” on page 131 for more information.
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Simulating Elements
The Simulator provides a way to verify your project before you build the title. Starting 
the Simulator by clicking Simulate in the toolbar simulates the project from its 
beginning, at the element designated as “First Play.” However, often you will want to 
start the Simulator at a specific project element, for example, to verify the navigation of 
a chapter index menu. 

You can use the Outline or Graphical tab to start the Simulator at a specific element so 
that you can quickly verify it is working as planned.

To start the Simulator at a specific element, do one of the following:
m Choose File > Simulate Element, where “Element” is the type of element currently selected.
m In the Outline or Graphical tab, Control-click the element at which you want to start the 

Simulator, then choose Simulate from the shortcut menu.
m Select the element to start the Simulator with, then press Option-Command-0 (zero).

Note:  Clicking Simulate in the toolbar always starts the Simulator with the element 
assigned as first play. If no first play element has been assigned, the Simulator starts by 
playing the first track.

Using Item Descriptions
An item description is an XML text file that lists all the properties of an element. You 
can save and load an item description, and view the description using TextEdit. You can 
also load an item description from one project into another. This can make it easy to 
create menus in multiple projects that all look the same or to copy a script 
between projects.

To save an item description:
1 Select the element for which you want to save a description.

You can select the element in the Outline or Graphical tab, or in any of the editors.

Note:  You cannot export an item description of a story. Item descriptions of tracks 
include their stories.

2 Choose File > Export > Item Description.

3 Enter a name for the file and select its destination in the dialog that appears, then 
click Export.

DVD Studio Pro creates the file and saves it in the location you specify.
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To load an item description:
1 Choose File > Import > Item Description.

2 Locate the description file to load and click Import in the dialog that appears.

Important:  Item descriptions from previous versions of DVD Studio Pro cannot be 
loaded into DVD Studio Pro 4. An alternative is to open a project in DVD Studio Pro 4 
that contains the element you originally made the item description from, then save a 
new item description from it.

Note:  With the exception of script item descriptions, you cannot import item 
descriptions created in one DVD standard (SD DVD or HD DVD) into the other DVD 
standard. Additionally, you cannot import item descriptions from one video standard 
(NTSC or PAL) into another video standard.

The description file loads and a new element appears in the Outline and Graphical tabs. 
The description file uses the same name it had when it was saved, unless that name is 
already in use. If the name already exists, a number is added to the end of its name, or 
if a number already exists, the number increments to form a unique name.

Note:  When you load an item description into a project, all of the assets used when the 
description was saved must still be available. An error message appears if any problems 
are encountered.



5

     181

5 Importing and Managing Assets

DVD Studio Pro provides tools and workflow options that 
give you the flexibility to decide how best to import and 
manage your assets.

As you work on your DVD project, it’s important to give some thought as to how best 
to organize and manage your assets. Even a simple project can use enough assets to 
make it worth investing the time to plan for them. Moderately ambitious projects can 
use hundreds of assets, creating a large potential for confusion as you try to keep track 
of them.

Additionally, if you intend to author both SD and HD versions of your project, keeping 
the assets organized is crucial to avoid confusing an SD version of a video asset with an 
HD version of it.

How DVD Studio Pro Manages Assets
There are several methods you can use to import an asset into a project, but in all cases 
the assets are treated the same.

Importing an asset into a DVD project does not actually copy or move the asset file 
from its current location. The Assets tab simply lists references to the actual asset files. 
The folder structure you create in the Assets tab does not affect the folder structure of 
the files on your hard disk; it only helps you manage the asset names while working on 
your project.
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Missing or Renamed Assets
Once you import an asset into a project, it’s important not to move or rename its 
source file. A Missing Files window appears if you open a project and DVD Studio Pro 
cannot locate an asset in its original location. You can manually locate the asset or 
cancel the dialog. 

To locate a missing asset when opening a project:
1 Select the asset in the Missing Files window. 

2 Do one of the following:

• Click Locate and use the file location dialog to find the asset.
• If the asset is a QuickTime file and its MPEG-2 or AIFF encoded version is available, you 

can click “Replace with encoded file.” In these cases, the QuickTime version of the asset 
is not required, and instead its encoded versions are used by the project. See “Should 
You Remove the Original QuickTime Files?” on page 184 for more information.

If you open the project without locating the assets, or the assets become missing while 
the project is open, the names of the missing assets are displayed in red and any 
elements in which the assets are used are disabled. 

To reconnect an asset to a project, do one of the following:
m Choose File > Asset > Re-Link.
m In the Assets tab, Control-click the asset’s name, then choose Relink from the 

shortcut menu. 

You can only relink assets whose names appear in red.
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Any elements that use missing assets are displayed in red in the Outline and Graphical tabs. 
The elements cannot be opened, either from the Outline tab, the Graphical tab, or in their 
editor. If you select an element with missing assets, a dialog appears with three choices:

• Relink:  Opens the Missing Files window so that you can locate the missing files. 
• Delete Clips/Slides/Assets:  The missing assets are removed from the element. 

• For tracks, any clips with missing assets are removed. 
• For menus, any item with a missing asset is set to “not set” as its asset (no items are 

removed—only their asset assignment is changed). 
• For slideshows, any missing slides are removed from the slideshow.

• Continue:  The element shows as being selected in the Outline and Graphical tabs, 
but it is not opened in its editor. This provides the opportunity to delete the element, 
which will remove it from the project.

Using Video and Audio Assets That Are Not DVD-Compliant 
When you import motion assets (video or audio) that are not DVD-compliant into a 
DVD Studio Pro project, the embedded MPEG encoder converts them to be DVD-
compliant (if they are in a supported format). In addition to the general MPEG 
encoding settings, the Encoding pane in DVD Studio Pro Preferences includes a setting 
that controls whether the encoding begins immediately as a background function, or 
waits until you build the final project into the VIDEO_TS folder. 

There is also a preferences setting in the Destinations pane to control where the encoded 
files are saved. See “Destinations Preferences” on page 123 for more information.

To set the encoding preferences:
1 Choose DVD Studio Pro > Preferences.

2 Click the Encoding icon to open the Encoding pane.

3 Set the encoding method by choosing one of the following: 

• Background encoding:  The encoding begins as soon as you import the asset. The 
encoding takes place in the background, allowing you to continue working on your 
project. A progress bar appears in the Status column of the Assets tab. Once the 
encoding process finishes, the Status column displays Done. See “Default Columns in 
the Assets Tab” on page 188 for more information.

• Encode on build:  The encoding does not start until you complete your project and 
build the VIDEO_TS or HVDVD_TS files. 

4 Configure the remaining encoding items as needed. See “Using the Embedded MPEG 
Encoder” on page 62 for more information.

5 Click Apply to enable the settings and OK to close the Preferences window.
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The current encoding settings are applied to assets as soon as they are imported, 
whether you choose to start encoding them right away or wait to encode them when 
you build your project. Changes you make to the Encoding Preferences only affect 
assets you import from then on. See “Verifying and Changing Encoding Settings” on 
page 185 for more information.

How the Encoded Files Are Named
When you import QuickTime video assets into DVD Studio Pro, the embedded MPEG 
encoder names the encoded files as follows:
• The first half is the complete original filename, including its extension.
• The second half has three parts—the video standard (NTSC or PAL), the encoding bit 

rate (shown as a four-digit number), and the “.m2v” extension.

For example, if you import an asset named “Main Program.mov,” use the NTSC standard 
and a bit rate of 5.5 Mbps, the MPEG-encoded filename will be “Main 
Program.mov_NTSC_5500.m2v.”

Audio files created by the embedded AIFF encoder use the original filename with an 
added “.aiff” extension.

See “Using the Embedded MPEG Encoder” on page 62 for more information on the 
embedded MPEG encoder.

Should You Remove the Original QuickTime Files?
When you import motion assets that are not DVD-compliant, the embedded MPEG and 
AIFF encoders create the files (video and audio) required by the DVD-Video specification. 
To free up hard disk space, you may decide to remove the original files.

Even after the encoders have created the new DVD-compliant files, DVD Studio Pro 
continues to keep track of the original files. The advantage of this is that you can 
re-encode the files if you decide later to use a different bit rate or encoding mode. For 
example, you might find that, after the initial encoding, the MPEG-2 video looks great, 
but is a larger file than you planned for. You can decide to re-encode using a lower bit 
rate and use the slower but higher quality two-pass VBR option.

Additionally, if you convert an SD project to an HD project, HD assets imported as 
QuickTime files can be encoded to HD MPEG 2.

If you decide to remove the original file, DVD Studio Pro notices it is missing and 
presents you with the Missing Files window. If you then click “Replace with encoded 
file,” the original file will no longer be associated with the project, and DVD Studio Pro 
will no longer try to find it. See “Missing or Renamed Assets” on page 182 for more 
information. You also will no longer be able to re-encode the asset. 
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Verifying and Changing Encoding Settings
If your project contains a mixture of 4:3 and 16:9 assets, or has some assets you want to 
encode differently than others, you must be sure to set the Encoding Preferences 
settings before you import the assets. You can verify and change the encoding settings 
on assets that have been imported.

You can also re-encode a QuickTime asset if you want to try different encoding settings.

To change the encoding settings after importing an asset:
1 Do one of the following:

• Select the asset and choose File > Encoder Settings.
• Control-click the video asset in the Assets tab, then choose Encoder Settings from 

the shortcut menu.
• Select the asset in the Assets tab, then press Command-E.

Note:  The Encoder Settings option in the Assets tab shortcut menu is only available if 
the original QuickTime video file is available.

A dialog appears that contains the same settings found in the Encoding Preferences pane.

2 Configure the encoder settings and click OK.

When you have the “Background encoding” method selected in Encoding Preferences 
and you make any changes in this dialog, one of two things happens:

• If you change the bit rate setting, the current file, whether a complete or partially 
complete file, is left as is and the encoder starts encoding a new file. This allows you 
to compare the quality of the two bit rates. If you decide to continue the encoding of 
the partially completed file, you can set the bit rate to the value it used, and the 
encoder will continue encoding it.

Note:  You must match not only the bit rate, but all other settings used in that file.

Note:  If the encoded files are being written to the project bundle, they are deleted 
whether or not you change the bit rate setting.

• If you do not change the bit rate setting, the original asset is deleted, whether a 
complete or partially completed file, and a new encoded file is created. For example, 
if you want to see the difference between one-pass VBR and two-pass VBR encoding 
and want to keep the files from both encoding sessions, you need to rename or 
move the completed one-pass VBR encoded file before re-encoding with the 
two-pass VBR setting.

If you have the “Encode on build” method selected, these changes will apply once you 
build your project.

Note:  Changing the encoding settings for an asset does not affect the encoding 
settings for other assets.
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This method of configuring encoding settings for specific assets allows you to 
customize how the embedded MPEG encoder gets used in your project, and makes it 
possible to have a mixture of assets with different encoding requirements (such as 
some that use the 4:3 aspect ratio and others that use the 16:9 aspect ratio).

Using Still Assets That Are Not DVD-Compliant
You can add still assets in any format supported by QuickTime to a slideshow or a track. 
DVD Studio Pro automatically converts them to the MPEG format once you start the 
build process. It creates an MPEG folder in the location specified in the Destinations 
pane of DVD Studio Pro Preferences. See “Destinations Preferences” on page 123 for 
details on setting up this preference.

Using DVD-Compliant Assets
When you import supported assets that are DVD-compliant, they are left in their 
original locations with no processing (other than the parse file being created, as 
described in the next section). 

About the Parse Files
To use an asset in a project, DVD Studio Pro needs to know some general information 
about it, such as its length, type, and integrity. Video assets encoded within 
DVD Studio Pro can include this information in the encoded files, or can create separate 
files for it. Assets encoded by Compressor outside of DVD Studio Pro can include this 
information if you select the “Add DVD Studio Pro meta-data” option in the Extras pane 
of the Encoder settings.

Assets encoded with other encoders, or with the “Add DVD Studio Pro meta-data” 
option disabled when using Compressor, must be parsed before DVD Studio Pro can 
use them. Parsing creates a small file, with the same name as the video asset and a 
“.par” extension that contains the required information. The parse file can take from 
several seconds to several minutes to create, depending on the size of the asset file.

See “Destinations Preferences” on page 123 for details on setting up the parse 
file preference.

About Segmented MPEG Files
The segmented MPEG files created by some third-party encoders do not import 
correctly into DVD Studio Pro. Some encoders segment their large encoded files into 
1 GB files. When imported into DVD Studio Pro, only the first 1 GB segment is imported. 
You need to append the files into a single file before importing the asset into 
DVD Studio Pro. There are several third-party applications that can be used to append a 
segmented MPEG file into a single file.
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Using Motion and LiveType Projects
DVD Studio Pro allows you to import Motion and LiveType projects directly into your 
DVD project. This has several benefits:
• You do not have to render the projects before importing them. DVD Studio Pro 

allows you to use them as if you had rendered them and exported a QuickTime 
movie from them. You import the projects using the same methods you would use 
to import other assets.

Note:  Playing projects requires significantly more system resources than playing a 
QuickTime movie. Depending on your system, projects may skip frames or show 
artifacts when playing as part of a menu or track.

• You can open the Motion or LiveType project from DVD Studio Pro. If you make 
changes to the project in Motion or LiveType, DVD Studio Pro automatically uses the 
updated project.

To open a Motion or LiveType project in that application, from within 
DVD Studio Pro, do one of the following: 

m Select the project in the Assets tab, then choose File > Asset > Open in Editor. 
m Control-click the project in the Assets tab, then choose Open in Editor from the 

shortcut menu. 
m Double-click the project in the Assets tab. 

Note:  The Motion or LiveType application must be available on your computer.

Assets Tab
The Assets tab displays a list of all assets imported into the project, whether they were 
directly imported to the Assets tab or dragged to the Menu or Track Editor from the 
Palette or a Finder window. 

Note:  Subtitle text files and shapes do not appear in the Assets tab.

Video icon

 Still image icon

Audio icon

Click a folder’s disclosure
triangle to show or

hide its contents.

Click to open the
Import Assets dialog.

Click to create a new folder.

Click to remove the 
selected asset.
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The Assets tab can contain up to 15 columns. For information on choosing which 
columns appear, see “Managing Columns in the Assets Tab” on page 190.

The Assets tab also has three buttons you can use to manage the assets.

• Import:  Opens the Import Assets dialog so you can choose assets to import. See 
“Using the Import Asset Feature” on page 193 for more information.

• New Folder:  Creates a new folder in the assets list. If you have an existing folder 
selected, the new folder becomes its subfolder. See “Creating Asset Folders” on 
page 191 for more information.

• Remove:  Removes the selected asset or assets, including folders, from the assets list. 
A message appears if you try to remove assets that are currently in use by the 
project. This does not affect the asset’s actual file—it just controls whether it appears 
in this list. See “Removing Selected Assets” on page 199 for more information.

Default Columns in the Assets Tab
The following columns appear by default in the Assets tab. You can remove these, 
change their order, and add additional columns as needed. See “Managing Columns in 
the Assets Tab” on page 190 for more information.
• Name:  Applies to all asset types. Displays the asset’s name and an icon that 

represents the asset type. By default the asset name is the same as the asset 
filename, but you can rename the asset to make it easier to identify within your 
project. See “Renaming Assets” on page 199 for more information.

The Name column also displays folders, with disclosure triangles, which you can use 
to organize your assets.

About QuickTime Files
QuickTime files often contain a video and audio stream. When you import a 
QuickTime file with both video and audio, it is displayed in the Assets tab as two files, 
each with the same name, one with the video icon and the other with the audio icon. 
The Type column lists them as QuickTime Video or QuickTime Audio. In most cases, 
these files are encoded with the embedded MPEG or AIFF encoder. You can re-
encode the video files by Control-clicking them, then choosing Encoder Settings from 
the shortcut menu. 

An exception is the HDV and H.264 QuickTime files you can import into HD projects. 
These QuickTime files do not require encoding with the embedded MPEG encoder, 
and cannot be re-encoded.
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• Status:  Applies to all asset types. Displays whether the asset is being encoded, 
parsed, or is ready to use. 
• Progress bar:  Appears while the asset is encoding or parsing.
• Yellow:  The asset has not been encoded (applies to assets to be encoded with the 

embedded MPEG or AIFF encoder). If the setting in the Encoding pane of 
DVD Studio Pro Preferences is set to “Encode on build,” the yellow dot shows for 
any assets that will be encoded once you build the project.

• Green:  The asset has been encoded (applies to assets encoded with the embedded 
MPEG or AIFF encoder only).

• Red:  The asset encountered an error while encoding or parsing.
• In Use:  Applies to all asset types. Shows a checkmark next to all assets currently in 

use within the project. 
• Type:  Applies to all asset types. Displays the type of asset (QuickTime video, AC-3 

audio, and so on).
• Length:  Applies to video and audio asset types. Displays the length (in 

hours:minutes:seconds:frames) of the asset.
• Size:  Applies to all asset types. Displays the file size of the asset. In the case of 

QuickTime assets, shows the size of the original QuickTime file. You can select the 
asset to see its encoded file size in the Asset Inspector.

• Rate:  Applies to video and audio asset types. For video assets, displays the original 
frame rate. For audio, displays the original sample rate (typically 48000 or 96000).

Additional Columns You Can Add
You can add the following additional columns to the Assets tab.
• Location:  Applies to all asset types. Displays the asset’s actual filename and location 

within your system.
• Timestamp:  Applies to video and audio asset types. Displays the timecode value of 

the first frame. 
• Channels:  Applies to audio assets. Displays the number of audio channels contained 

in the file.
• Dimensions:  Applies to video and still assets. Displays the size of the image in pixels 

(before rescaling, if applicable).
• Layers:  Applies to still assets. Displays the number of layers the still contains.
• Bit Depth:  Applies to still assets. Displays the number of bits the still contains.
• Aspect:  Applies to video and still assets. For video assets, displays the aspect ratio of 

the asset (4:3 or 16:9). For still assets, shows whether the asset is being rescaled to fit 
the video aspect ratio (Retain) or is displaying actual pixels (blank).

• Markers:  Applies to video assets. Displays the number of chapter markers the 
video contains.
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Managing Columns in the Assets Tab
DVD Studio Pro lets you customize the columns in the Assets tab, making it easy to 
display only the information you want.

To customize the columns in the Assets tab:
m To display a hidden column, Control-click the column name to the left of where you want 

the hidden one to appear, then choose the column’s name from the shortcut menu.

All columns that are currently displayed have checkmarks next to their names.
m To hide a column, Control-click in the column name area, then choose the column’s 

name from the shortcut menu. 

You can choose to display as few or as many of the columns as you like.
m To change the order of the columns, drag a column’s name to a new position. 

m To change a column’s width, position the pointer on its right edge. When the pointer 
changes to a double arrow, drag to the new size.

When you drag a column to a new position, 
the other columns shift to make room for 
the one you are moving.

The pointer changes to a double arrow 
when you change a column’s width.
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Managing the Contents of the Assets Tab
As you add assets to your project, you will want to keep them organized to reduce the 
potential for confusion. There are several tools you can use to organize and keep track 
of your assets:
• Folders:  Folders are the most powerful organizing tool for managing your assets. For 

added flexibility, you can create subfolders (folders within folders), import assets 
directly into a folder, and move assets between folders. You can also drag a folder to 
a new location.

• Sorting:  You can sort the assets based on any of the columns. 
• Asset information:  You can select any asset to see its properties in the Asset Inspector.

Creating Asset Folders
You can create folders in the Assets tab at any time—before or after you have imported 
your assets.

To create and name a folder:
1 Do one of the following:

• Choose Project > New Asset Folder.
• Control-click anywhere within the Assets tab, then choose Create New Folder from 

the shortcut menu.
• Click the New Folder button in the Assets tab.
• Press Shift-Command-N.

2 Select the folder, click the folder’s name, then type a new name. 

To create a new folder within an existing folder:
m Control-click the existing folder, then choose Create New Folder from the shortcut menu. 

Click the disclosure
triangle to open and

close folders.
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Sorting Assets
You can sort the assets in the Assets tab by any of the columns.

To sort the assets:
1 Click the name of the column by which you want to sort the assets.

The assets sort in the order of that column’s contents, and a triangle appears next to 
the column’s name to indicate it is controlling the sort and to show the sort’s direction 
(up or down).

2 Click the name of the column a second time to change the sort’s direction.

Scrolling Through the Assets List
Once you have added a number of assets to your project, DVD Studio Pro provides a 
variety of methods for scrolling through them.

To scroll through a list of assets, do one of the following:
m Drag the scroller located on the right edge of the Assets tab. Hold down the Option key 

to scroll slowly through the list (useful with long lists).
m Press the Up and Down Arrow keys to scroll through one asset at a time.
m Press Option–Up Arrow to jump to the first asset in the list.
m Press Option–Down Arrow to jump to the last asset in the list.
m Press the Page Up and Page Down keys or hold down the Option key while clicking the 

scroller’s arrows to scroll through the list one page at a time.

Importing Assets
DVD Studio Pro provides several methods for importing assets into a project. 
• Using the Import Asset feature:  You can click the Import Asset icon in the toolbar, click 

the Import button in the Assets tab, or use a shortcut menu in the Assets tab to 
import assets directly into the Assets tab.

• Dragging assets to the Assets tab:  You can drag assets from the media tabs in the 
Palette or a Finder window to the Assets tab.

• Dragging assets directly to project elements:  You can drag assets directly to the Menu 
Editor, Track Editor, and several other elements in your DVD Studio Pro project. These 
assets are also automatically added to the Assets tab.

The triangle indicates the column 
controlling the sort and the sort 
direction (up or down).
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See “Media Tabs” on page 157 for information on using the Audio, Stills, and Video tabs 
in the Palette.

Note:  To help organize your assets, it’s a good idea to create folders in the Assets tab 
before you import your assets, although you can create folders and move assets into 
them at any time.

Importing Assets That Are Not DVD-Compliant
When you import video and audio assets that are not DVD-compliant, DVD Studio Pro 
uses its embedded encoder to convert them. In DVD Studio Pro Preferences, you can 
specify whether the encoding happens immediately, in the background, or waits until 
you build your completed project. See “Using Video and Audio Assets That Are Not 
DVD-Compliant” on page 183 for more information.

Once the encoding starts, a progress bar appears in the Status column of the Assets tab. 

Using the Import Asset Feature
You can import assets directly from within the Assets tab by using the Import button or 
by using the Import Asset icon in the toolbar. You can import single assets, multiple 
assets, or entire folders of assets.

Note:  The “Find matching audio when dragging” setting in the Track pane of 
DVD Studio Pro Preferences does not apply when using the Import Asset dialog. Only 
the files you select are imported into the Assets tab.

To import assets from within the Assets tab:
1 Select the folder in the Assets tab that you want to import the assets into (if applicable).

2 Open the Import Asset dialog by doing one of the following:

• Choose File > Import > Asset.
• Control-click the folder or an empty area of the Assets tab, then choose Import from 

the shortcut menu.
• Click the Import button in the Assets tab.
• Click Import Asset in the toolbar.
• Double-click an empty area of the Assets tab.
• Press Shift-Command-I.

3 Locate the assets or folder to be imported, then click Open.

The assets are imported into the Assets tab. If you select a folder, the folder and all 
recognized asset files in it are added to the Assets tab. Any subfolders within the 
imported folder are also imported. A message appears if the folder contains assets that 
are not supported by DVD Studio Pro.

Note:  An asset cannot be imported more than once, and it can only appear once in the 
Assets tab. However, any asset in the Assets tab can be used multiple times in a project.
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Dragging Assets to the Assets Tab
You can drag one or more assets from the Palette or a Finder window to the Assets tab, 
and place them directly in folders if desired.

To import assets from the Palette or a Finder window:
1 In the Palette or a Finder window, select the assets to be imported.

2 Do one of the following:

• To import them at the root level of the Assets tab, drag the assets to an empty area 
of the tab.

• To import them into a folder in the Assets tab, drag the assets directly to the folder.

If you select a folder in the Finder window and drag it to the Assets tab, the folder and 
all recognized asset files in it are added to the Assets tab. Any subfolders within the 
imported folder are also imported. A message appears if the folder contains assets that 
are not supported by DVD Studio Pro.

The Track pane of DVD Studio Pro Preferences includes a “Find matching audio when 
dragging” setting. When this checkbox is selected and you drag a video asset or group 
of video assets, DVD Studio Pro automatically looks for audio assets with the same base 
name in the same folder, and imports them as well. This does not happen if you drag a 
mixture of asset types, such as video and still images. It also does not happen when 
using the Import Asset dialog. You can temporarily override the preferences setting by 
holding down the Command key after you start dragging video assets.

Dragging Assets Directly to a Project Element 
You can drag an asset from the Assets tab, the Palette, or a Finder window directly to 
the element that is going to use it. Assets dragged from the Palette or a Finder window 
are also added to the Assets tab.

As is the case when dragging video assets to the Assets tab, the “Find matching audio 
when dragging” setting in the Track pane of DVD Studio Pro Preferences controls 
whether audio assets automatically follow the video assets when they are dragged to 
an element.
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Dragging Assets to the Menu Editor
You can drag video, audio, and still images to the Menu Editor. You can drag multiple 
assets, but they must all be of the same type (video or still image). You can drag a 
folder that contains still images to create a slideshow. 
• If you drag the asset to the Menu Editor and drop it immediately, it uses the default 

action for that asset type. 
• If you drag the asset to the Menu Editor and pause, the context-sensitive Drop Palette 

appears so that you can choose the asset’s action. The choices available depend on 
the type of asset you are dragging and whether you are dragging it to an empty part 
of the Menu Editor, a button, or a drop zone. See “Options in the Drop Palette for 
Standard Menus” on page 285 and “Options in the Drop Palette for Layered Menus” 
on page 337 for a complete list of the actions available.

• If you drag video assets to the Menu Editor, DVD Studio Pro automatically looks for audio 
assets with the same base name in the same folder, and imports them as well. This 
does not happen if you drag a mixture of asset types, such as video and still images.

You can also drag templates and styles from the Palette. Any assets used by the 
template or style, such as a background video or an asset assigned to a drop zone, are 
also added to the list in the Assets tab, in a folder named Templates. See “Using 
Templates, Styles, and Shapes to Create Your Menus” on page 303 for more information 
on using templates and styles.

Dragging Assets to the Track Editor
You can drag video, audio, and still images to streams in the Track Editor. You can drag 
multiple assets, but you cannot drag a folder. See “Adding Video and Audio Assets” on 
page 372 for details on how the assets are placed in their streams.

You can also drag one or more still images, as well as a folder containing multiple still 
images, to a subtitle stream. Each still image creates a subtitle clip. See “Importing a 
Graphics File” on page 452 for more information.

Dragging Assets to the Slideshow Editor
You can drag one or more still images, as well as a folder, to the Slideshow Editor. The 
still images are automatically added to the slideshow. See Chapter 12, “Creating 
Slideshows,” on page 405 for more information on slideshows.
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Dragging Assets to the Outline and Graphical Tabs
You can drag video, audio, and still images to the Outline and Graphical tabs. How the 
assets are used depends on where you drag the assets. The only difference between 
dragging to the Outline or Graphical tab is that only the Outline tab has section titles 
for each element type. The following tables list the supported actions.

Note:  Most of the following actions work with the Outline tab’s By Type and By VTS 
displays. The exceptions are dragging assets to the Tracks and Slideshows sections, 
since the By VTS display does not have these sections. Additionally, with the By VTS 
display, all menus created by dragging assets to the Menu section of a VTS are 
automatically assigned to that VTS. See “Using the VTS Editor” on page 589 for more 
information on the By VTS display.

When you drag the following 
assets to an empty area 
or the disc’s name Action

One video asset Creates a track and adds the video to stream V1.

Multiple video assets Creates a track for each and adds the video to stream V1.

One audio asset Creates a track and adds the audio to stream A1.

Multiple audio assets Creates a track for each and adds the audio to stream A1.

One video/audio asset pair Creates a track and adds the video to stream V1 and the audio to 
stream A1.

One still image Creates a menu and sets the still image as its background.

Multiple still images Creates a slideshow and adds the still images to it.

One multiple-layer PSD file Creates a standard menu and sets the file as the background with 
all layers selected.

One folder Creates a slideshow and adds the still images to it.

When you drag the following 
assets to the Menus section 
title in the Outline tab Action

One video asset Creates a menu and sets the video as its background.

Multiple video assets Creates multiple menus and sets the video as their backgrounds.

One audio asset Creates a menu and assigns the audio to it.

One video/audio asset pair Creates a menu and sets the video as its background and assigns 
the audio to it.

One still image Creates a menu and sets the still image as its background.

Multiple still images Creates multiple menus and sets the still images as their 
backgrounds.

One multiple-layer PSD file Creates a standard menu and sets the file as the background with 
all layers selected.
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When you drag the 
following assets to 
a specific standard menu Action

One video asset Sets the video as the menu’s background.

One audio asset Assigns the audio to the menu.

Multiple audio assets Assigns the audio to the menu. 

One video/audio asset pair Sets the video as the menu’s background and assigns the audio to it.

One still image Sets the still image as the menu’s background.

One multiple-layer PSD file Sets the file as the menu’s background with all layers selected.

When you drag the 
following assets to 
a specific layered menu Action

One still image Sets the still image as the menu’s background.

One multiple-layer PSD file Sets the file as the menu’s background with all layers selected.

When you drag the following 
assets to the Tracks section 
title in the Outline tab Action

One video asset Creates a track and adds the video to stream V1. 

Multiple video assets Creates a track for each video asset and adds the video to stream 
V1 on each track.

One audio asset Creates a track and adds the audio to stream A1. 

One video/audio asset pair Creates a track and adds the video to stream V1 and the audio to 
stream A1.

One still image Creates a track and adds the still image to stream V1. 

Multiple still images Creates a track and adds the still images to stream V1. 

One multiple-layer PSD file Creates a track and adds the still image to stream V1, using only 
the layers set as visible in Photoshop.
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When you drag the following 
assets to a specific track Action

One video asset Adds the video to stream V1, at the end of any existing video. 

Multiple video assets Adds the videos to stream V1, at the end of any existing video.

One audio asset Adds the audio to stream A1, at the end of any existing audio.

Multiple audio assets Adds the audios to stream A1, at the end of any existing audio.

One video/audio asset pair Adds the video and audio to streams V1 and A1, at the end of any 
existing video and audio.

One still image Adds the still image to stream V1, at the end of any existing video.

Multiple still images Adds the still images to stream V1, at the end of any existing video.

One multiple-layer PSD file Adds the still image to stream V1, at the end of any existing video, 
using only the layers set as visible in Photoshop.

When you drag the following 
assets to the Slideshow 
section title in the Outline tab Action

One audio asset Creates a slideshow and assigns this as its overall audio.

One still image Creates a slideshow and adds the still image to it.

Multiple still images Creates a slideshow and adds the still images to it.

One multiple-layer PSD file Creates a slideshow and adds the still image to it, using only the 
layers set as visible in Photoshop.

One folder of images Creates a slideshow and adds the still images to it.

When you drag the following 
assets to a specific slideshow Action

One still image Adds the still image at the end of the slideshow.

Multiple still images Adds the still images at the end of the slideshow.

One multiple-layer PSD file Adds the still image at the end of the slideshow, using only the 
layers set as visible in Photoshop.

One folder of images Adds the still images at the end of the slideshow.
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Removing Selected Assets
If you no longer need assets in a project, you can remove them from the Assets tab. 

Important:  The Assets tab only contains links to the actual asset files. Removing an 
asset from the Assets tab does not actually delete the asset’s file from your hard disk.

To remove assets from the Assets tab:
1 Select one or more assets to remove.

2 Do one of the following:

• Choose Edit > Remove Asset.
• Control-click in the Assets tab, then choose Remove from the shortcut menu.
• Click the Remove button in the Assets tab.
• Press the Delete key.

You cannot remove assets that are currently in use by the project. If you try to do so, an 
error message appears listing the selected assets that are in use and which project 
element is using them.

You can click an asset in the list to see which elements use it, or use the Up Arrow and 
Down Arrow keys to scroll through the assets list.

Renaming Assets
You can rename assets as they appear in DVD Studio Pro. This does not affect the 
actual name of the asset’s file.

To rename an asset:
1 Select the asset in the Assets tab.

2 Change its name by doing one of the following:

• Click the asset’s name after the asset has been selected and type in a new name.
• Enter a new name in the Asset Inspector’s Name field.

See “Asset Inspector” on page 204 for more information on the Asset Inspector.

List of assets that 
cannot be removed

Locations that use the 
asset you select in the 
above assets list
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Refreshing Still and QuickTime Assets
It is possible, during the course of creating your project, that you will need to update 
a still or QuickTime asset. DVD Studio Pro includes both an automatic and a manual 
asset refresh capability to make it easier to use updated versions of your still and 
QuickTime assets.

Important:  An alert appears when updated assets have been detected, and the Encode 
view of the Log tab lists specific elements that use those assets. It is important to verify 
that each of these elements function correctly.

All still and QuickTime assets are automatically refreshed any time you bring 
DVD Studio Pro to the foreground on your computer. For example, if you are working in 
DVD Studio Pro and switch to a graphics program to update a still or QuickTime asset 
used in the current project, the asset refreshes as soon as you switch back to 
DVD Studio Pro.

Important:  If the Simulator is active when assets are refreshed, you must close it and 
restart it for the refreshed assets to appear correctly in it.

You can also manually refresh selected assets.

To manually refresh selected assets, do one of the following:
m Choose File > Asset > Refresh.
m Control-click the asset to be refreshed in the Assets tab, then choose Refresh from the 

shortcut menu.

Manually refreshing still and QuickTime assets is useful when you are updating them 
using a networked computer.

Note:  You cannot refresh MPEG motion assets.

Issues With Refreshing Still Assets
When used in slideshows and as clips in tracks, still assets that have been refreshed will 
have no impact outside of the change you made to the still asset itself.

When used in a menu, there may be issues for you to work with. For example, if the 
asset is used in a menu also using overlays, you may have to readjust the button active 
areas to match any changes you have made to the graphic. The same is true if you have 
made changes to the layers of a multiple-layer PSD file.
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Issues With Refreshing QuickTime Assets
Changes made to QuickTime assets, which can include video, audio, or both together, 
can have large impacts on any project elements that use them. 

Reencoding
Any QuickTime assets you make changes to that have already been MPEG encoded by 
the DVD Studio Pro embedded MPEG encoder will need to be reencoded. If you have 
enabled background encoding in the Encoding pane of DVD Studio Pro Preferences, 
this reencoding will start automatically.

Video Asset Length Changes
If you have changed the length of a video asset that is used in a track, there could be 
audio sync problems if there are other assets used in the same track. For example, 
making the asset shorter would cause all video assets in the timeline that are placed 
after it to shift earlier since the V1 stream cannot have any gaps in it. The 
corresponding audio does not shift though, since audio streams can have gaps.

Making the QuickTime video asset longer will not change the clip in any tracks that use it. 
You will have to manually change the clip’s duration in the tracks to use the added video.

When used as backgrounds in motion menus, you may need to adjust the menu’s 
duration to better fit with the asset’s new length. 

Video Asset Content Changes
If you have changed the content of a video asset, you may need to adjust marker positions 
to match the new content or, in the case of motion menus, adjust the loop point.

Audio Asset Length Changes
If you have changed the length of an audio asset that is used in a slideshow, there are 
several issues that may arise.
• If the audio is assigned to a specific slide, that slide’s length will change. 
• If the audio is assigned to the slideshow as overall audio and Fit to Audio has been 

selected, the slideshow’s duration will change.

In both cases, if you have shortened the audio asset it is possible that the slide and 
transition durations cannot be shortened enough to match the audio.

Making the QuickTime audio asset longer will not change the clip in any tracks that use it. 
You will have to manually change the clip’s duration in the tracks to use the added audio.
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Opening Assets in Their Editor
You can open a selected asset in a different application. This can make it easier for you 
to update the asset.

Note:  See “Using Motion and LiveType Projects” on page 187 for information on 
opening Motion and LiveType projects.

To open an asset in a different application, do one of the following:
m Choose File > Asset > Open In Editor or File > Asset > Open With.
m Control-click the asset to be opened in the Assets tab, then choose Open In Editor or 

Open With from the shortcut menu.

Open In Editor and Open With have the following differences:

• Open In Editor:  Choose this if you want to open the asset using its registered 
application (exactly as would happen if you double-clicked the asset in the Finder).

• Open With:  Choose this if you want to select the application to open the asset. This is 
useful when the registered application for that asset type is not the application you 
want to use.

With still assets, you can edit and save them using the selected application, and 
DVD Studio Pro automatically refreshes the assets.

With audio and video motion assets, you may find that you are unable to resave the assets 
once you have edited them. To ensure you can resave the audio or video motion assets, 
close the DVD Studio Pro project once you have opened the asset in its application.

Identifying an Asset
You can identify an asset’s actual filename and location, and even open a Finder 
window that displays it. This is especially useful if you have renamed the assets within 
DVD Studio Pro.

To identify an asset’s filename and location, do one of the following:
m Add the Location column to the Assets tab. This column lists the details of the asset’s file.
m Control-click the asset’s name, then choose Reveal In Finder from the shortcut menu. 

This opens a Finder window displaying the asset’s file.
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Previewing Assets
You can display an asset in the Viewer tab or listen to its audio.

To preview an asset:
1 Select the asset in the Assets tab.

2 Preview the asset by doing one of the following:

• Choose File > Asset > Preview.
• Control-click the asset, then choose Preview from the shortcut menu.
• Double-click the asset.
• Select the asset and press the Space bar.

You can use the controls in the Viewer tab to pause and stop playback.

QuickTime video assets preview in their native format, even if they have been encoded 
with the embedded MPEG encoder. To preview the MPEG-encoded version of the 
QuickTime asset, you must add the asset to a track and preview it from the Track Editor.

Still assets always preview using square pixels, and will scale to show actual pixels if 
possible; if not, they are scaled to fit the Viewer tab. Anamorphic still assets will preview 
as 4:3 assets. 

Preview controls
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Asset Inspector
When you select an asset in the Assets tab, the Asset Inspector appears. 

The Asset Inspector shows general information about the selected asset. The only 
information you can edit is the asset’s name as it appears in DVD Studio Pro.

Video assets include a thumbnail image and a scrubber so you can scrub through the 
video. Still assets also include a thumbnail image. 
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6 Introduction to Creating Menus

Menus are the backbone of your project. To ensure 
a positive experience for the viewer, it’s important to 
create menus that provide logical navigation and 
a consistent experience.

Menus provide the buttons that the person viewing a DVD uses to configure the disc’s 
playback and to choose the tracks and slideshows that supply the DVD’s content. DVD 
menus are made up of a background, which can be a still image or a full-motion movie, 
and buttons. For the most part, the elements that make up a menu are created outside 
of DVD Studio Pro. You use DVD Studio Pro to combine these elements into a complete 
menu and assign actions to the buttons. See “Preparing Menu Sources” on page 81 for 
details on creating the graphics used in your menus.

DVD Studio Pro includes templates and styles that can make it easier to create menus. 
You can use the supplied templates and styles to quickly create your menus, or you can 
create your own templates and styles. Using templates and styles lets you apply a 
standardized look to your menus for all of your projects—for example, to maintain a 
corporate image. See “Using Templates, Styles, and Shapes to Create Your Menus” on 
page 303 for more information.

About Menus
Before you create your menus, you need to understand the two different methods used 
to create menus in DVD Studio Pro, and be aware of special considerations for menus 
with a 16:9 aspect ratio. If you are authoring HD projects, you also need to be aware of 
special issues when creating HD menus.
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DVD Studio Pro Menu Creation Methods
In DVD Studio Pro, you can create menus using either a standard, or overlay method, or 
a layered method. You can use menus created with both methods in a project, so you 
can use the method best suited to each individual menu. 

The menu creation methods differ primarily in how each button’s states are displayed. 
Each button in a menu has three states:

• Normal:  How the button looks when not in the selected or activated state
• Selected:  How the button looks when you navigate to it using the DVD player’s 

arrow buttons
• Activated:  How the button looks after you navigate to it and press Enter. This state is 

typically displayed for just a short time before the menu clears and the next element 
appears, based on the action assigned to the button.

Standard Method
The standard method uses an overlay structure to display each button’s states. As 
described in detail in “Creating Overlays” on page 86, an overlay is a four-color image 
used to identify the highlight area of each button. Each of the four colors is mapped to the 
actual color and transparency values that will appear for each of the three button states.

The standard method provides the most flexibility when creating menus. 

• The background can be static, or it can be a full-motion video clip. 
• The background can contain the normal state of the buttons, or it can be plain, with 

the overlay supplying the normal button image.
• You can use DVD Studio Pro to type text over the menu. The text can be used to title 

the menu or just provide basic information.
• You can add text to buttons, or even create text-only buttons.
• You can use shapes on the menu as either buttons or drop zones. Shapes are self-

contained graphics that include the normal state image, a graphic that defines the 
highlight area, and that can even display a full-motion thumbnail image of an 
assigned asset. Some shapes, called patches, contain animated effects. Shapes can be 
fully positioned and resized. DVD Studio Pro includes many stock shapes and can 
import shapes you create. The stock shapes are particularly useful when creating 
menus with minimal reliance on graphics programs.

• You can create drop zones on the menu. A drop zone is an area of the menu you can 
assign an asset or shape to. You can reposition, resize, and rotate drop zones. Drop 
zones become a part of the menu’s background when you build the project. They 
allow you to add graphic elements to your menu that are not text- or button-related, 
making it possible to create complex menu backgrounds.

• You can use templates and styles.
• You can add audio to the menu.
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The drawback of the standard method is that using overlays limits your creativity when 
showing the different states of a button. While the normal state of a button can be a 
full 24-bit image, you can only use up to four colors (as defined by the DVD-Video 
specification) to modify the normal image to show the selected and activated states. 
Since one of these colors is typically used as a transparent background color, that 
leaves only three colors. This is sufficient to add an outline or highlight to show when 
the button is selected or activated, but it is not enough to allow you to radically alter 
the button.

See “Creating Menus Using the Standard Method” on page 229 for details on creating 
standard menus.

Layered Method
The layered method allows you to create independent 24-bit versions of each button 
for each of the three states (normal, selected, and activated). This gives you great 
flexibility in changing a button’s appearance when it is selected and activated.

The layered method requires an Adobe Photoshop (PSD) graphics file that contains a 
separate layer for each state of each button, in addition to the background graphic. 
This means a menu with 12 buttons requires 36 layers to show the normal, selected, 
and activated states of each button. You can combine overlays with buttons created 
using the layered method.

There are several drawbacks to using the layered method:

• You cannot have motion in the background; backgrounds must be still images.
• You cannot use the text or shape features.
• You cannot use templates and styles.
• You cannot add audio to the menu.
• Viewers may experience a slow reaction time while navigating around the buttons 

on DVD players.

Because layered menus use separate layers for each button state, DVD Studio Pro 
performs some behind-the-scenes processing, creating separate hidden menus for 
each possible state of the menu. In the above example with 12 buttons, 25 versions of 
the menu would need to be created (one with all buttons in their normal state, and 
one for each button in its selected and activated states). These menus are not visible as 
separate elements within your project, but are displayed when you use the arrow 
buttons on the DVD player’s remote control to navigate to a button and activate it.

Due to the number of menus that are created using the layered method, some DVD 
players may have a slight delay in displaying the menus as viewers navigate around the 
buttons, which may confuse impatient viewers. 

See “Creating Menus Using the Layered Method” on page 323 for details on creating 
layered menus. 
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Working With 16:9 Menus
When using 16:9 menus in your project, you need to be aware of several things.

How the Menu Will Be Displayed on a 4:3 Monitor
Be sure to choose the proper display mode in the Menu tab of the Menu Inspector. 
Also, a default Display Mode setting in DVD Studio Pro Preferences sets all new menus, 
tracks, and slideshows to the proper display mode. 

The options include 4:3, 16:9 Pan-Scan, 16:9 Letterbox, and 16:9 Pan-Scan & Letterbox. If 
you select Pan-Scan, be aware that areas at the left and right edges of the menu will 
not be visible. See “Choosing an Aspect Ratio” on page 50 for more information on this 
and other aspect ratio issues.

Fewer Buttons Can Be Used
When you set a menu’s display mode to 16:9 Pan-Scan or 16:9 Letterbox, you reduce 
the total number of buttons you can have on the menu. For SD projects, the total 
number of buttons drops from 36 to 18; for HD projects, the total drops from 48 to 24. 
This is because DVD Studio Pro must create two menu overlays, one for each aspect 
ratio, and automatically select the one to use based on the DVD player’s aspect ratio 
setting. When you set a menu’s display mode to 16:9 Pan-Scan & Letterbox, the total 
number of buttons you can have on a menu drops to 12 for SD projects, and 16 for HD 
projects, since three menu overlays must be created.

16:9 Graphics Must Be Anamorphic in SD Projects
All graphics for 16:9 menus in SD projects must be anamorphic (horizontally 
compressed to fit the 4:3 aspect ratio). See “What Exactly Is a 16:9 Asset?” on page 51 
for details on creating graphics for 16:9 menus.

Creating Menus for HD Projects
Creating menus for HD projects is not much different from creating menus for SD 
projects. The most common issue is understanding how the HD-based DVD menus 
handle background video assets with respect to their resolutions.

There is a Resolution setting in the General pane of DVD Studio Pro Preferences that 
defines the default resolution of all new menus (and tracks and slideshows) you create. 
However, the actual resolution of a menu is usually defined by the background video 
asset you assign to it.
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For example, if your default resolution as defined by the Preferences setting is 
1280 x 720p and you create a new menu, its resolution is 1280 x 720p. If you set the 
menu’s background video to a 1920 x 1080i asset, the menu’s resolution automatically 
changes to match it.

If you set a menu’s background asset to something that is non-standard, for example, a 
still that is 800 x 600, the menu’s resolution changes to the highest resolution that is 
smaller than the non-standard size (in this example, full D1, which is 720 x 480 for NTSC 
or 720 x 576 for PAL), and the image is scaled to fit. If you set a menu’s background to 
something that is smaller than full D1, it is scaled up to the full D1 size.

Note:  As with SD-based DVD menus, when a menu’s background asset does not match 
the 4:3 or 16:9 display mode, the empty areas are filled with the menu background 
color, as defined in the Menu pane of DVD Studio Pro Preferences.

You must also be aware that the limit on the number of buttons your menu can have is 
different than with SD-based DVD menus. Menus using the 4:3 aspect ratio can have up 
to 48 buttons. Menus using the 16:9 Pan-Scan or 16:9 Letterbox modes can have up to 
24 buttons. Menus using the 6:9 Pan-Scan & Letterbox modes can have up to 16 buttons.

Adding Intro and Transition Clips to Menus
You can make the DVD viewing experience more polished by adding short video clips 
that play at the beginning of a menu (intro clips) and when buttons are pressed 
(transition clips).

There are several approaches you can take to add these clips to your project. See 
“Adding Intro and Transition Clips to Menus” on page 345 for more information.

Adding “Easter Eggs” to Your Menus
It is becoming increasingly popular to add hidden items to DVD projects. For example, 
you may include a track or menu that you only want people to find if they know the 
right buttons to push.

Most often, invisible buttons on less-used menus are used to access these items. 
Depending on how elaborate you want to be, you can configure the button navigation 
so that the viewer can only get to the invisible button by pressing non-obvious arrow 
buttons on the remote control.
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For example, if you have a menu with a column of six buttons, you could set the button 
navigation so that the invisible button is reached only by pressing the left arrow button 
when on the fourth button in the column. (Most viewers would not think to press the 
left arrow button if the menu’s buttons are arranged in an obvious up/down fashion.) 
You can make it even harder to find by using multiple invisible buttons, with each 
requiring the correct arrow button presses to get to the next, with incorrect presses 
jumping back to the visible buttons. 

See “Advanced Tab in the Button Inspector” on page 262 for information on 
invisible buttons.

Important:  While using invisible buttons can make it difficult for viewers to accidentally 
find hidden features, you should not assume this is entirely secure. Determined viewers 
can use a variety of methods to find hidden content on a DVD disc.

About Invisible Buttons
You can set an overlay button to be invisible by selecting Invisible in the Advanced 
tab of the Button Inspector. In this case, making a button invisible means that the 
highlight colors do not appear when the button is selected and activated. This can be 
confusing when combined with visible buttons on a menu since it can lead to a 
condition where nothing appears to be selected.

Instead of using a true invisible button, you may want to use a button whose normal 
state is invisible, but which acts as a visible button when selected and activated. To 
do this, you only have to make sure the button has no normal state graphics on the 
menu’s background (making the button invisible when not selected), but does have 
supporting graphics, such as a star or happy face, in the overlay file that will show the 
selected and activated highlight colors. Note that if you do this, a viewer playing the 
DVD on a computer may be able to find the button just by waving the pointer over 
the menu.
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About the Menu Editor 
The Menu Editor is contained in the Menu tab. It displays the menu graphics in either a 
4:3 or 16:9 aspect ratio (depending on what is set in the Menu tab in the Menu 
Inspector). There are also several buttons and pop-up menus that let you select what 
appears in the editor and provide tools that help with the menu creation process.

The Menu Editor scales the menu to fit within its quadrant. As you make the quadrant 
larger, the menu also increases up to the point that it reaches full size, when it stops 
growing and the extra area around it is filled with gray. When working with the larger 
HD resolutions, however, you may find it difficult to increase the quadrant’s size 
enough to show the menu at full size. One option is to tear off the Menu tab into its 
own window, which you can then resize without affecting the rest of the 
DVD Studio Pro interface. See “Tearing Off a Tab Into Its Own Window” on page 146 for 
more information.

Menu Editor tools

Drag the Menu Editor
rulers to create guides.

Click this to hide and
show the Menu

Editor tools.

Choose a menu
to configure.

Open this pop-up
menu to choose a

menu language.

Open to configure 
additional Menu 
Editor settings.
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Using the Menu Rulers
The left and top sides of the Menu Editor can display rulers. When you click within the 
Menu Editor, marks on the ruler show the pointer’s position. The Alignment pane in 
DVD Studio Pro Preferences contains configuration settings for the ruler. These settings 
include whether the rulers are shown and the units they use (pixels, percentage, and so 
on). See “Alignment Preferences” on page 118 for details on setting the ruler’s 
preferences. 

To show or hide the menu rulers, do one of the following:
m Select the relevant setting in the Alignment pane of DVD Studio Pro Preferences.
m Press Command-R.

Menu Object Alignment Features
DVD Studio Pro includes several features you can use to help you align the objects 
(buttons, drop zones, and text objects) you add to your menus:  menu guides, dynamic 
guides, the Align Objects command, and the Distribute Objects command.

Using Menu Guides
You can create horizontal and vertical guides to assist you while creating your menu. 
The guides are useful when lining up buttons or text on a menu. You can create as 
many guides as you need, reposition them, and remove them. The guides include a 
snapping feature that makes it easy to position menu items.

The Alignment pane in DVD Studio Pro Preferences contains configuration settings for 
the guides. These settings include whether the guides are shown and their color. See 
“Alignment Preferences” on page 118 for details on setting the guide’s preferences.

To create a guide:
m Place the pointer over the top or left ruler, then drag into the Menu Editor.

Note:  The rulers must be visible before you can add guides to the Menu Editor.

To reposition a guide:
m Drag the guide where you want it.

To hide or show previously created guides, do one of the following:
m Click the Guides button on the Menu Editor.

m Press Command-; (semi-colon).

Shows and hides the 
menu guides.
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To temporarily disable snapping to the guides while moving an item:
m Press Command while dragging the item. This also disables the dynamic guides 

discussed in the next section.

To remove a guide:
m Drag the guide back to the ruler.

Note:  Like button outlines, guides are not included when you build your project, so it is 
not necessary for you to remove them when you are done.

Using Dynamic Guides
In addition to the menu guides, there are also dynamic guides that automatically 
appear as you drag menu objects. Dynamic guides make it easy to align menu objects 
with each other and with the menu’s center. As you move a menu object around, lines 
appear and the object snaps into position whenever one of its edges or its center is in 
alignment with another object’s edge or center or the menu’s center.

This tool is especially useful when you are creating duplicates of an existing button (by 
Option-dragging it) and want them all to line up with each other.

Only the guide preference’s color setting applies to dynamic guides—they do not 
disappear when you hide the menu guides. 

To temporarily hide the dynamic guides and disable their snapping action:
m Hold down the Command key while you drag the menu object.
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Using the Align Objects Feature
The align objects feature allows you to select a group of objects and apply an 
alignment mode to them. For example, you could select three buttons and set them so 
that their left edges align.

The usual way of dragging to select a group of items will not work—you will end up 
creating a new button.

To select multiple menu items, do one of the following:
m To individually select items, hold down the Shift key and click them. 
m To select a group of items by dragging, press the Command key while dragging over them.
m To select all items in the Menu Editor, press Command-A.
m To deselect all items, press Shift-Command-A.

Once you have the objects selected, you can align them.

To use the align objects feature:
1 Select the group of objects to align.

Note:  The last object you select is the reference object that the others align to.

2 Do one of the following:

• Choose Arrange > Align Objects, then choose the alignment to use (Top, Center, 
Bottom, Left, Middle, or Right).

• Control-click one of the selected objects, then choose the alignment to use (Top, 
Center, Bottom, Left, Middle, or Right) from Align Objects in the shortcut menu.

The objects move to the new alignment. If you get a surprising result, press 
Command-Z to undo the alignment and verify that you had the right buttons selected 
and that you selected the reference button last.

Using the Distribute Objects Feature
The distribute objects feature allows you to select a group of objects and evenly space 
them between each other.

To use the distribute objects feature:
1 Select the group of objects to distribute. See “Using the Align Objects Feature” on 

page 214 for details on how to do this.

Note:  The order that you select the objects does not matter. The objects are distributed 
between the two outermost objects. 

2 Do one of the following:

• Choose Arrange > Distribute Objects, then choose the distribution method to use 
(Horizontally or Vertically).

• Control-click one of the selected objects, then choose the distribution method to use 
(Horizontally or Vertically) from Distribute Objects in the shortcut menu.
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Using the Menu Editor Pop-Up Menus and Tools
The Menu Editor tools let you customize the editor to your needs. 

To show or hide the Menu Editor tools:
m Click the dots at the bottom of the Menu Editor.

Menu Editor Pop-Up Menus
The top of the Menu Editor contains several pop-up menus.
• View:  Choose the menu you want to open in the Menu Editor from this pop-up 

menu. This is an alternative to selecting the menu in the Outline or Graphical tab.

You can also choose a language to configure for this menu from the pop-up menu 
next to the View pop-up menu. See “Using Languages With Menus” on page 352 for 
more information.

• Settings:  Contains a variety of settings that control what you see in the Menu Editor.
• Auto Assign Buttons Now and Auto Assign Buttons Continuously:  You can choose to 

have DVD Studio Pro automatically assign button navigation settings to the 
current menu configuration or continuously. See “Configuring Button Navigation” 
on page 268 for more information.

• Display Background, Display Overlay, and Display Composite:  You can choose to 
show the background or overlay by itself or as a composite image. You can also 
press Q to step through these options.

• Title Safe Area and Action Safe Area:  These settings turn on a shaded area around 
the outside edge of the menu, indicating portions of the menu that may not be 
viewable on most consumer monitors. Placing buttons or text in these shaded 
areas can be risky and should be avoided. There are two safe areas:  title and 
action. The title safe area is more constricted, and should be observed for items 
that must be seen by the viewer. All text and buttons should be within this area. 
The action safe area is closer to the menu edges, and is considered a boundary for 
items that you would like the viewer to see, but are not required. You can also 
press Command-E to show or hide the title safe area, and Option-Command-E to 
show or hide the action safe area.
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• Square Pixels and Rectangle Pixels:  You can choose to switch between viewing the 
menu images with square pixels or scaled to the video aspect ratio (either 4:3 or 
16:9). See “Understanding Pixel Differences in Graphics and Video” on page 84 for 
more information. You can also press P to toggle the pixel display type.

• Show Single Field:  Optimizes playback when using field-based video sources. This is 
especially important with video that has fast motion, because it will reduce the 
motion artifacts. However, selecting Show Single Field with frame-based video 
sources results in reduced resolution (edges may appear jagged).

Menu Editor Tools
• Arrange controls:  These buttons allow you to change the priority of the selected item, 

letting you control which items have a higher priority by bringing them forward, or 
by sending lower-priority items to the back. See “Changing the Button Order” on 
page 264 for more information.

• Add Submenu, Add Slideshow, and Add Track buttons:  These buttons allow you to create a 
new element in your project and add a button to the current menu that connects to 
them. You can also press Option-Command-Y to create a submenu, Option-Command-K 
to create a slideshow, and Option-Command- T to create a new track.

The new button added to the menu uses the menu’s default button style. See 
“Setting Default Styles” on page 312 for more information.

Brings the item to the 
front, making it the 
highest priority.

Sends the item’s priority 
one step back.

Sends the item to the
back, making it the

lowest priority.

Moves the item’s 
priority one step up.

Creates an 
empty slideshow.

Creates an 
empty track.

Creates a submenu
that uses this

menu’s template.
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• Button state selections:  These buttons allow you to see the selected button in any of 
the three states (normal, selected, or activated). You can also press W to step through 
these options.

• Button Outlines button:  You can turn on button outlines, which show each button’s 
active area box and the button name. When your menu has buttons without an asset 
or shape assigned, turning off button outlines can make them disappear, which can 
be confusing if you later forget they are there and add them again.

• Guides button:  You can show or hide the menu guides created when you drag from the 
rulers into the Menu Editor. This does not affect the dynamic guides that appear when 
you drag items in the menu. See “Using Menu Guides” on page 212 for more 
information. See “Alignment Preferences” on page 118 for details on setting the menu 
guide preferences. You can also press Command-; (semi-colon) to show or hide these 
guides.

• Motion button:  Applies to standard menus only. Use this button to start or stop 
playback of video and audio assets assigned to the menu. This is useful for motion 
menus and still menus that include audio, providing a preview of how the motion 
elements appear. You can also press the Space bar or Command-J to turn the motion 
on and off.

Note:  The Motion button in DVD Studio Pro does not work the same way as the 
similar button in iDVD. In DVD Studio Pro, the Motion button does not have to be 
active to create a motion menu. It does not affect how the menu will appear when 
you finish the project and build the title.

Shows the 
selected state.

Shows the 
activated state.

Shows the
normal state.

Shows the 
menu guides.

Shows the
button outlines.
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Starting and Working With a Menu
By default, all projects have an empty standard menu for you to start with. You can also 
add additional menus as needed.

Creating a New Menu
The following describes how to add a new standard or layered menu to your project.

To add a standard menu, do one of the following:
m Choose Project > Add to Project > Menu.
m Control-click in the Outline or Graphical tab, then choose Add from the shortcut menu 

and Menu from the submenu.
m Click Add Menu in the toolbar.
m Press Command-Y.

To add a layered menu, do one of the following:
m Choose Project > Add to Project > Layered Menu.
m Control-click in the Outline or Graphical tab, then choose Add from the shortcut menu 

and Layered Menu from the submenu.
m Click Add Layered Menu in the toolbar.
m Press Shift-Command-Y.

A new menu is added to the project, with the name “Menu _,” where “_” is the number 
of that menu. You can rename menus, making it easier to locate specific ones.

You can also create a new standard submenu from an existing menu (standard or 
layered) by clicking the Add Submenu button in the Menu Editor. 

This creates a new menu based on the original menu, using its background, buttons, 
and other settings. This also adds a new button to the existing menu that is linked to 
the new submenu.

Creates an empty 
slideshow.

Creates an 
empty track.

Creates a submenu
that uses this

menu’s template.
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Opening a Menu
To work with a menu, you need to open the Menu Editor for that menu. You can do so 
from the Outline tab, the Graphical tab, or within the Menu Editor. 

To open a menu from the Outline tab:
1 Click the Outline tab.

2 Click the disclosure triangle next to Menus to display a list of current menus (if they are 
not already visible).

3 Select a menu by clicking its name. 

The menu appears in the Menu Editor, and the Inspector switches to show the menu’s 
settings. If the Menu Editor is not visible, you can double-click the menu’s name in the 
Outline tab to make it appear.

To open a menu from the Graphical tab:
1 Click the Graphical tab.

2 Select a menu by clicking its tile. 

The menu appears in the Menu Editor, and the Inspector switches to show the menu’s 
settings. If the Menu Editor is not visible, you can double-click the menu’s tile in the 
Graphical tab to make it appear.

To choose a menu in the Menu Editor:
m Choose the menu to open from the View pop-up menu, located along the top of the 

Menu Editor.

The menu appears in the Menu Editor, and the Inspector switches to show the 
menu’s settings.

Naming Menus
As you add menus to your project, you should rename them to make it easier to locate 
and group them.

To rename a menu, do one of the following:
m In the Outline tab, select the menu, click its name, then type the new name.
m In the Graphical tab, select the menu tile, double-click its name, then type the new name.
m Select the menu in the Outline tab, the Graphical tab, or the Menu Editor, then enter 

the new name in the Name field of the Menu Inspector.
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Adding Assets to a Menu
There are several ways to add assets to a menu:
• Drag an asset to the Menu Editor. See “Dragging Assets to the Menu Editor,” next, 

for details.
• Apply a template or style from the Palette. See “Applying a Template or Style” on 

page 309 for details.
• Select the assets in the Menu Inspector. See “Creating Menus Using the Standard 

Method” on page 229 or “Creating Menus Using the Layered Method” on page 323 
for details.

Dragging Assets to the Menu Editor
One way to add an asset to a menu is to drag the asset to the Menu Editor, and then 
use the Drop Palette to assign the asset a function. You can drag the asset from the 
Assets tab, the Palette, or from the Finder. You can also drag tracks, menus, and 
slideshows from the Outline or Graphical tab. When you drag an asset, the Drop Palette 
appears after a short delay to let you choose what function the asset will serve. For 
example, if you drag a still graphic, the menu may offer the options of using it as a 
background, an overlay, or a button. 

The top item in the Drop Palette is the default function. If you drag an asset or element 
to the Menu Editor and release it before the Drop Palette appears, the default function 
is applied.

Viewing the Drop Palette

To see the Drop Palette:
m Drag the asset to the Menu Editor. When it’s positioned exactly where you want it, hold 

the asset there while you keep the mouse button pressed. 

The Menu pane of DVD Studio Pro Preferences contains a setting that controls the 
length of the delay before the Drop Palette appears. See “Menu Preferences” on 
page 115 for more information. See “Options in the Drop Palette for Standard Menus” 
on page 285 and “Options in the Drop Palette for Layered Menus” on page 337 for 
information about the available options. 
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The options in the Drop Palette depend on the type of asset you are dragging, whether 
you drag it to a button or an empty area of the menu, and the type of menu (standard 
or layered). For example, if you drag a video asset to an existing button, the Drop 
Palette provides the options of linking the video to the button and creating a track for 
it. If you drag the same asset to an empty part of the menu, the Drop Palette contains 
options for either using the video as the background, or adding a button at that 
location and linking it to the video.

• If you drag an asset and you don’t see the options you expect in the Drop Palette, you 
may not have dragged it to the right place. Continue holding down the mouse 
button and drag the asset to the correct location.

• If you drag to the menu but do not wait for the Drop Palette to appear, a default action 
is applied.

• If you select an option that creates a new button on the menu, that button will use the 
default button style assigned to that menu. This style can determine whether or not 
the new button shows a thumbnail image of the asset. 

• If you are dragging multiple assets or elements and will be creating multiple buttons, the new 
buttons will be stacked together. To avoid problems with having overlapping buttons on 
a menu, be sure to drag them away from each other after they have been created.

See “Options in the Drop Palette for Standard Menus” on page 285 and “Options in the 
Drop Palette for Layered Menus” on page 337 for a complete list of Drop Palette 
options and details on what they do.
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About Dragging Video and Audio Assets Together
Several of the Drop Palette options only appear when you select and drag a video/
audio asset pair. A video/audio asset pair is created when you select a video asset, and 
then hold down the Command key and select a companion audio asset. (There are also 
other ways to select an asset pair, depending on where you are dragging from.)

Having Audio Automatically Follow the Video
If you drag a motion video asset by itself to the Menu Editor and choose an option 
from the Drop Palette that supports audio, DVD Studio Pro checks to see if there is an 
audio asset in the same folder with the same basic name as the video asset. If the 
option does support audio (such as creating a track or setting a menu’s background), 
and an audio file is not already assigned to the target element, DVD Studio Pro can 
automatically add the audio asset to the element, depending on the “Find matching 
audio when dragging” setting in the Track pane of DVD Studio Pro Preferences.

Note:  You can override the “Find matching audio when dragging” preferences setting 
by pressing the Command key after you start dragging the video asset.

If you drag a QuickTime movie, from a Finder window or the Video tab in the Palette, 
that contains both video and audio to the Menu Editor, it is treated as if it were a video/
audio pair, with both the video and audio being added to the element. 

Selecting Multiple Menu Items 
As you create your menus, there will be times when you need to select multiple menu 
items, such as buttons, drop zones, or text objects, so that they can all be moved, 
deleted, or have an attribute applied. The usual way of dragging to select a group of 
items will not work—you will end up creating a new button.

To select multiple menu items, do one of the following:
m To individually select items, hold down the Shift key and click them. 
m To select a group of items by dragging, press the Command key while dragging over 

them. Any currently selected items are deselected first. Press the Shift-Command keys 
while dragging to keep any currently selected items selected.

m To select all items in the Menu Editor, press Command-A.
m To deselect all items, press Shift-Command-A.
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Copying Menu Items
You are able to copy menu items, such as buttons, drop zones, and text objects, within 
an existing menu or from one menu to another. You can even copy multiple items at 
once. See “Selecting Multiple Menu Items,” above, for more information. 

The copied items retain all attributes of their original, including assigned assets and, in 
the case of buttons, their target settings. The new items have a higher priority than the 
original items. See “Changing the Button Order” on page 264 for information on how 
you can modify the item priorities.

There are several issues that can cause a copy operation to fail. 

• You are not allowed to copy items that are incompatible with their destination (such 
as copying a drop zone to a layered menu).

• You are not allowed to copy buttons to a menu that would cause it to exceed the 
maximum allowed number of buttons. Menus with a 4:3 aspect ratio can have a 
maximum of 36 buttons. Menus with a 16:9 aspect ratio can have a maximum of 
18 buttons.

Copying Items by Dragging
You can copy one or more items within a menu by selecting them and then dragging 
them to a new location.

To copy one or more items within a menu by dragging:
1 Select the items to be copied.

2 Press the Option key, then drag the items to their new position.

If multiple items are selected, they all move as a group, maintaining their relationships 
to each other.

Using Copy, Cut, and Paste 
You can use the copy and paste commands to copy items within a menu and 
between menus.

To copy one or more items using copy and paste:
1 Select the items to be copied.

2 Do one of the following:

• Choose Edit > Copy.
• Press Command-C.
This copies the selected items to the Clipboard. The selected items are not affected.

3 Select the menu where you want to paste the copied items.

4 Do one of the following:

• Choose Edit > Paste.
• Press Command-V.
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If there are no items selected in the menu before you paste the copied items, the 
copied items are placed in the same locations as the originals. If an item is selected in 
the menu before you paste the copied items, the copied items are positioned relative 
to the selected item with a small offset.

You can use the Paste command multiple times after using the Copy command. This 
makes it easy to add a button to multiple menus.

To move one or more menu items using cut and paste:
1 Select the items to be moved.

2 Do one of the following:

• Choose Edit > Cut.
• Press Command-X.
This copies the items to the Clipboard and removes the items from the current menu. 

3 Select the menu where you want to paste the cut items.

4 Do one of the following:

• Choose Edit > Paste.
• Press Command-V.

This is most useful when you are moving menu items from one menu to another. 

Moving and Resizing Menu Items
There are a number of methods you can use to move or resize your buttons, drop 
zones, and text objects in your menu.

To move and resize menu items:
m To move the item by dragging, click inside the dashed lines and drag it to the new position. 
m To move the item by dragging in one direction only (horizontal or vertical), press the 

Shift key, then drag the item.
m To move the item by dragging with snapping and the dynamic guides temporarily 

disabled, press Command, then drag the item.
m To move the item using the arrow keys, select the item and press the arrow keys to 

move it one pixel at a time. Press Shift and the arrow keys to move it 10 pixels at a time, 
or press Shift-Option and the arrow keys to move it 20 pixels at a time.

m To move a button or drop zone, you can use the Coordinates & Size area in the 
Advanced tab in the Button Inspector or in the Drop Zone Inspector to precisely set a 
button’s or drop zone’s size and position.

m To move an item’s edge, click the resize handle at the center of the edge and drag it to 
the new position. This changes the item’s size.
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m To move an item’s corner (which moves two edges at once), click the resize handle at 
the corner and drag it to the new position. This also changes the item’s size.

m To change a button’s or drop zone’s size while maintaining the button’s aspect ratio, 
Shift-drag an edge or corner. See “Working With Assets in Buttons and Drop Zones” on 
page 276 for more information.

m To change a button’s or drop zone’s size while keeping the button centered at its 
current location, click an edge or corner, start dragging, then press the Option key.

m To delete an item, select it (resize handles appear on its dashed line), then press the 
Delete key.

Verifying Your Menus
As you create your menus, you will want to verify several aspects of them:
• Button connections:  Do the buttons connect to the correct project elements?
• Button navigation:  As you navigate around the menu’s buttons using the arrow keys, 

does the button selection follow a logical path?
• Menu aspect ratios and languages:  Does the menu perform correctly with different 

displays and DVD player languages?

Verifying Button Connections
Each button’s Target setting (set in the Button Inspector) states its connection. 
Sometimes, however, the names of the various project elements can make it easy to 
choose a target that is not the one intended. For this reason, it’s important to verify the 
connections are correct. There are two ways you can do this:
• Double-clicking the button in the Menu Editor:  If you double-click a button that is 

connected to a different menu, the Menu Editor automatically switches to show that 
menu. If you double-click a button connected to a track, story, or slideshow, the 
appropriate editor opens to that element and the Viewer prepares to play it (all you 
need to do is click its play button).

• Simulating the menu:  You can simulate the menu by either Control-clicking in the 
Menu Editor, then choosing Simulate from the shortcut menu, or Control-clicking the 
menu in the Outline or Graphical tab, then choosing Simulate from the shortcut 
menu. This forces the Simulator to start at this menu instead of the First Play 
connection, as it does when started from the toolbar.

Verifying Button Navigation
To verify button navigation, you need to use the Simulator. Either Control-click in the 
Menu Editor, then choose Simulate from the shortcut menu, or Control-click the menu 
in the Outline or Graphical tab, then choose Simulate from the shortcut menu. You can 
now use the Simulator’s arrow keys to verify the navigation and highlight settings.
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Verifying Menu Aspect Ratios and Languages
When you create menus using the 16:9 aspect ratio or multiple languages, you can use 
the Simulator to verify the menu configurations. In DVD Studio Pro Preferences, you 
can configure the Simulator to mimic a 16:9, 4:3 letterbox, or 4:3 pan-scan display. You 
can also configure the default language settings of the Simulator.

Once you have configured the Simulator preferences, Control-click the menu’s name in 
the Outline or Graphical tab, then choose Simulate from the shortcut menu.

About Chapter Index Menus
When you drag a video asset, track, or slideshow to the Menu Editor, you are given the 
option of creating a chapter index menu. A chapter index menu is created automatically 
and has buttons linked to the asset’s and track’s markers or the slides in a slideshow. How 
the chapter index menu is created depends on the menu already in the Menu Editor:
• If the menu does not contain any buttons, text objects, or drop zones, that menu 

becomes the first chapter index menu (with additional chapter index menus added if 
more buttons are needed).

• If the menu contains one or more buttons (whether you drag to them or not), a new 
menu is created to become the first chapter index menu (with additional chapter 
index menus added if more buttons are needed).

When you create a chapter index menu, a Choose Template or Layout Style dialog 
appears. You use this dialog to choose a template or layout style to provide the 
template for what the menu will look like. 

The template or layout style you choose defines:

• How many buttons are on a menu
• Where the buttons are placed
• What shape the buttons use
• The navigation between the buttons
• Whether the marker names are used as button text
• Whether the marker’s video is used as a button asset
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Templates can also define the menu background, assign an audio asset to the menu, 
and add text objects, such as a title.

If there are more markers or slides than buttons on the template or layout style you 
choose, additional chapter index menus are created. 

Templates and layout styles can also include buttons that do not get markers assigned 
to them. These are special-purpose buttons that you can use to provide navigation 
between the chapter index menu and other menus in your project.

Once the chapter index menu (or menus) are created, you need to configure the 
navigation between each of them and the other menus in your project. For example, 
you would need to provide a way to access the main menu from each chapter index 
menu, as well as access to the chapter index menus from the main menu. 
DVD Studio Pro can automatically configure the navigation if you use the correct 
special-purpose buttons. See “Special-Purpose Buttons” on page 311 for information on 
how button attributes affect the creation of chapter index menus.

Additionally, you can modify any aspect of the chapter index menu that the template 
or layout style you chose defined. For example, you can move the buttons around, 
change their shapes, and add additional ones.

DVD Studio Pro includes several templates and layout styles you can choose from, and 
you can also create some of your own. See “Using Templates, Styles, and Shapes to 
Create Your Menus” on page 303 to learn more about templates and styles. 

About the First Marker Button in a Chapter Index Menu
DVD Studio Pro automatically adds the first marker to all tracks. It is named “Start” 
when the track is created by dragging a video asset to the Menu Editor. (When the 
asset is dragged to the Track Editor, the name is based on the marker naming settings 
in the Track pane of DVD Studio Pro Preferences.) When you create a chapter index 
menu, the first button linked to a marker is linked to the “Start” marker set by 
DVD Studio Pro.

Since this marker is at the start of the track, pressing this button plays the track from its 
beginning. If the marker names appear on your chapter index menu’s buttons, you may 
want to edit this button’s text to better describe its function.
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7 Creating Menus 
Using the Standard Method

Standard menus provide the most flexibility when 
creating menus. You can choose to use static or full-motion 
backgrounds, audio, text objects, and drop zones.

When creating a menu using the standard method, you have a wide variety of options:

• Choosing the background:  You need to assign an asset as the menu background. This 
can be a still graphic or a full-motion video image. It can contain art and text that 
represents the buttons, or it can be plain, relying on an overlay, shapes, drop zones, 
and the Menu Editor’s text capability to provide background and button art. 

• Choosing the overlay:  Although an overlay graphic is not required for a menu, you 
will typically use one to provide art for selected and activated button states, and in 
some cases, for the normal state as well. If you do not choose an overlay, 
DVD Studio Pro generates a full-screen white frame to be used in its place.

• Using shapes:  You can use shapes either in place of the overlay, or in conjunction 
with it. 

• Adding drop zones:  You can add graphic elements to your background by creating 
drop zones and assigning assets to them.

• Adding text:  You can type text onto the background. This text can be used to create 
button labels, add titles to the menu, or provide viewing instructions.

• Adding drop shadows:  You can configure the menu’s drop shadow settings and apply 
them to the menu’s shapes, drop zones, and text.

• Configuring motion settings:  In addition to the menu’s background, you can use 
motion video in the shapes and drop zones. You choose whether the video loops 
once it reaches the end.

• Adding audio:  You can assign one or more audio assets to the menu.

You can also simplify the standard method by using the templates and styles feature 
and choosing from the provided elements or adding your own. See “Using Templates, 
Styles, and Shapes to Create Your Menus” on page 303 for more information.
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About Menu Rendering
Depending on how you create your standard menus, they may have to be rendered 
into an MPEG-2 video asset when you build your project. The menu must be 
rendered if it uses any of the following:
• Assets assigned to a button
• Shapes
• Drop zones
• Text objects
• SIF (MPEG-1 or MPEG-2), 1/2 D1, or cropped D1 video

Standard menus that only use a background (whether still or video), an overlay, and 
one or more audio files do not get rendered.

Whether the menu gets rendered or not can be important for a couple of reasons:

• The time it takes. Rendering menus is a process that composites all of the menu 
elements, one frame at a time, and creates an MPEG-2 file out of these composited 
frames. Depending on your system and the length of your menus, this can take a 
significant amount of time to process. See “Menu Preferences” on page 115 for more 
information.

• Extra processing can affect video. If your menu background video must be rendered, 
the extra processing has the potential to change the video a small amount. 
Anytime you decode compressed video, process it (such as by compositing shapes 
or text over it), then recompress it, you can expect some subtle changes to the 
background video. In those cases where you have meticulously encoded your 
background video before assigning it to a menu, this extra processing could 
noticeably change the video.

When SD menus are rendered, they are encoded at 7 Mbps using the one-pass VBR 
method. HD menus are rendered at 21 Mbps using the one-pass VBR method.
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Setting a Menu’s Background and Overlay
The first step in creating a menu is to choose its background and, if you are using one, 
its overlay.

Choosing the Background
The menu background can be a still image or a video clip.

Still Images
You can use a wide variety of graphic formats as still backgrounds in DVD Studio Pro. 
See “Using Your Graphics Program” on page 82 for a list of supported formats.

For best quality, be sure your graphic:

• Matches the menu’s resolution and aspect ratio (4:3 or 16:9):  If you are creating 16:9 
menus in SD projects, or with the 720 x 480p, 720 x 576p, or 1440 x 1080i HD 
resolutions in HD projects, be sure the graphic is anamorphic. See “Creating Graphics 
to Use in Menus” on page 82 and “Choosing an Aspect Ratio” on page 50 for details.

• Conforms to the broadcast video color space:  Graphics that look stunning in your 
graphics program can look very different when viewed on DVD. Most graphics 
applications let you scale colors to NTSC or PAL color space.

DVD Studio Pro automatically scales the size of the background graphic to fit the frame 
size if necessary. This can result in the menu’s background color being visible along 
some edges.

Note:  The color of an empty menu’s background can be set in the Menu pane of 
DVD Studio Pro Preferences. By default this color is set to dark gray.

Video Clips
Assigning a video clip as a menu’s background creates a motion menu. The video can 
be an animation or live action. Often the video is actually a still background with 
several small moving images representing scenes you can jump to. See “Creating Video 
for Motion Menus” on page 91 for more information on creating the video.

Looping
You can choose what happens when a menu’s video clip reaches its end:
• It can simply stop, displaying a still image of the last frame.
• It can loop, jumping from the end back to a point in the video clip that you choose.

It is common for a menu’s video clip to have a relatively complicated introduction—
perhaps with the buttons flying in and a piece of dialogue providing the audio—and 
then resolve into a mostly still graphic, with lights flickering or objects moving in a 
repetitive way. This kind of design makes it easier to create a loop that jumps from the 
end back to the loop point as smoothly as possible.
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See “Configuring Motion Menu Settings” on page 282 for more information on setting 
looping options.

Assigning a Background to a Menu
There are several ways to assign a background to a menu. Use the method that you feel 
most comfortable with. In all cases, these methods also replace an existing background.

Assigning a Menu Background Using the Inspector
You can assign a menu background using the Inspector. With this method, you can 
only choose from assets already imported into DVD Studio Pro.

To assign a menu background using the Inspector:
1 Select the menu and make sure the Menu Inspector displays the menu properties.

2 Choose a background from the Background pop-up menu. 

The selected file appears as the menu background.

Assigning a Menu Background by Dragging
You can assign a background to a menu by dragging the asset from the Assets tab, the 
Palette, or a Finder window.

To assign a menu background by dragging it to the Menu Editor:
1 Select the menu in the Outline or Graphical tab or choose it from the Menu Editor’s 

View pop-up menu to display it in the Menu Editor.

2 Locate the background file you want to use in the Assets tab, Palette, or Finder window.

3 Drag the asset to an empty part of the Menu Editor and pause until the Drop 
Palette appears.

4 Choose Set Background from the Drop Palette.

The background appears in the Menu Editor.

To assign a menu background by dragging it to the Outline or Graphical tab:
1 Select the menu in the Outline or Graphical tab or choose it from the Menu Editor’s 

View pop-up menu to display it in the Menu Editor.

2 Locate the background file you want to use in the Assets tab, Palette, or Finder window.

3 Assign the background file to the menu by dragging it to the menu’s name in the 
Outline tab or the menu’s tile in the Graphical tab. A box appears around the name or 
tile to let you know the menu will receive the background file.

The background appears in the Menu Editor when you release the mouse button.
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Choosing a Menu’s Background From a Layered Photoshop File
You can choose a layer (or several) from an Adobe Photoshop format (PSD) file to use 
as the menu background. One PSD file can supply backgrounds and overlays for 
several menus.

To choose a menu background from a PSD file:
1 Either create a new menu or select an existing one.

2 Click the Menu tab in the Menu Inspector.

3 Assign the PSD as the menu’s background by either:

• Choosing it from the Background Asset pop-up menu in the Menu Inspector
• Dragging it to the Menu Editor and choosing Set Background from the Drop Palette
The PSD file’s layer names appear in the Background area of the General tab. 

4 Select the checkboxes next to the layers that make up the background.

Choosing the Overlay
The overlay is a graphic that defines what kind of highlight appears when the viewer 
selects each button using the DVD player’s remote control, and where each button’s 
highlights occur on the menu. The highlight can be an outline of the button, an 
underline, or even text.

Note:  If you intend to use shapes to create your menu buttons, you do not need to 
choose an overlay file. You can use an overlay file and shapes in the same menu.

There are two types of overlays you can use when creating your menus:

• Simple overlay graphics have a single highlight color. Simple overlays use white where 
they will be transparent, and black to define the highlight areas.

• Advanced overlay graphics can have up to four colors or shades of gray, depending on 
the mapping type you intend to use. Using advanced overlays, you have multiple 
highlight colors appear when selecting or activating buttons.

A single overlay graphic provides the highlights for all buttons. When creating your 
buttons, you must single out each button’s active area to ensure that when the viewer 
selects a button, only its part of the overlay graphic is highlighted.

Select these checkboxes
to make the layers part of

the background.
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The overlay typically provides the art only for each button’s selected and activated 
states. It can also provide the art for the normal state, but this state is most often 
incorporated into the background, allowing for very nice-looking, 24-bit resolution 
buttons. An advanced overlay’s four-color limit, and especially a simple overlay’s 
one-color limit, greatly restrict the visual quality of normal-state buttons.

The four colors used in an advanced overlay depend on the mapping type used for 
the overlay:

• Chroma:  The overlay must use the colors black, red, blue, and white, with white 
typically being the background color.

• Grayscale:  The overlay must use the colors black, dark gray, light gray, and white. 
White is usually used as the background color.

The Mapping Type setting in the Menu Inspector’s Colors tab indicates the type of 
overlay you are using.

If colors other than those specified are present in the overlay, they are mapped to their 
closest equivalents, which can produce surprising results. Use care to include only the 
specified colors when creating your overlays. See “Creating Overlays” on page 86 for 
details on creating overlay graphics, including the color values used by the chroma and 
grayscale mapping types.

It is important to understand that the actual colors used in the overlay, whether you 
use the chroma or grayscale method, are not what appear as the highlights in the 
menu. They only identify where the actual highlight colors should appear. 
DVD Studio Pro uses color mapping to set the highlight colors.

See “Understanding Color Mapping” on page 236 to learn more about color mapping.

Assigning an Overlay to a Menu
There are several ways to assign an overlay to a menu. Use the method that you feel 
most comfortable with. In all cases, these methods also replace an existing overlay.

Assigning a Menu Overlay Using the Inspector
You can assign a menu overlay using the Inspector. With this method, you can only 
choose from assets already imported into DVD Studio Pro.

To assign a menu overlay using the Inspector:
1 Select the menu and make sure the Menu Inspector displays the menu properties.

2 Click the General tab in the Menu Inspector (if it’s not already visible).

3 Choose an overlay from the Overlay File pop-up menu. 

The selected file is assigned as the menu overlay. Depending on other menu settings, 
you may not see any changes in the Menu Editor.
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Assigning a Menu Overlay by Dragging
You can assign an overlay to a menu by dragging it from the Assets tab, the Palette, or 
a Finder window.

To assign a menu overlay by dragging it to the Menu Editor:
1 Select the menu in the Outline or Graphical tab or choose it from the Menu Editor’s 

View pop-up menu to display it in the Menu Editor.

2 Locate the overlay file you want to use in the Assets tab, Palette, or Finder window.

3 Drag the asset to an empty part of the Menu Editor and pause until the Drop 
Palette appears.

4 Choose Set Overlay from the Drop Palette.

The selected file is assigned as the menu overlay. Depending on other menu settings, 
you may not see any changes in the Menu Editor.

Choosing a Menu Overlay From a Layered Photoshop File
You can choose a layer from an Adobe Photoshop format (PSD) file to use as the menu 
overlay. One PSD file can supply backgrounds and overlays for several menus.

To choose a menu overlay from a PSD file:
1 Either create a new menu or select an existing one.

2 Click the General tab in the Menu Inspector.

3 Assign the PSD asset as the menu’s overlay by either:

• Choosing it from the Overlay pop-up menu in the Menu Inspector
• Dragging it to the Menu Editor and choosing Set Overlay from the Drop Palette

4 Choose the layer to use as the overlay from the Overlay Layer pop-up menu.

Choose the overlay file.
Choose the overlay layer.
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Understanding Color Mapping
Color mapping is the process of assigning highlight colors with transparency values to 
the colors used in an overlay. The colors you assign can be different for each of the 
three button states (normal, selected, and activated). 

There are two types of overlays you can use:  a simple one that uses a single overlay 
color and an advanced one that uses up to four overlay colors. For many menus, a 
simple overlay will provide what you need with minimal complexity. You may find, 
however, that an advanced overlay provides greater flexibility when you are creating 
complicated menus.

Differences Between Simple and Advanced Overlays
The simple and advanced overlays differ primarily in how they use the overlay file. 
• For simple overlays, the color white in the overlay graphic is set to be transparent—

this cannot be changed. The only other color allowed is black. If you add a graphic 
element that has a soft glow or has been anti-aliased, the areas that are not black or 
white appear with additional highlight colors (controlled by the advanced overlay 
color mapping settings). You get to choose a highlight color and its transparency for 
each of the three button states (normal, selected, and advanced). See “Creating 
Simple Overlays” on page 88 for more information.

• For advanced overlays, you can use up to four colors when creating your overlay 
graphic. When setting up the color mapping, you assign a highlight color and 
transparency to each of the four overlay colors, for each of the three button states. 
This allows you to create much more varied looks to the menu. For example, you do 
not need to make all highlight colors for a button the same color. Using an advanced 
overlay can also allow you to take advantage of anti-aliased edges.

Both simple and advanced overlays use the same color mapping palette and color 
mapping sets. When you map a color in a simple overlay, you are also mapping the 
color to the black overlay color in the advanced overlay.

You can use simple overlay mapping for some buttons and advanced overlay mapping 
for other buttons on the same menu.
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Color Mapping Palette
The DVD specification allows a single 16-color palette to be assigned to each menu. 
This palette provides the colors used by the overlay to create the three button states. 
You can set each of the 16 colors and save the palette as the default palette for 
DVD Studio Pro. You can also create a different palette for each menu.

Note:  Avoid choosing highly saturated colors. All colors used in your project must 
conform to broadcast limits. If necessary, the colors are restricted during playback and 
you may find the colors you configured do not match those used in the title.

Setting the Colors in the Color Palette
You set each of the 16 colors in the palette independently.

To set a palette color:
1 Select the menu and make sure the Menu Inspector displays the menu properties.

2 Click the Colors tab in the Menu Inspector.

3 Click Edit Palette at the bottom of the Colors tab. 

The Color Palette window appears.

4 Select the color you want to change. 

The Colors window appears.

5 Select the color-choosing method you want to use, then choose the color. See 
“Methods for Choosing Colors” on page 238 for information on the different methods. 

6 As you choose your color, the color in the palette also changes.

To change another color in the palette, select it in the Color Palette and repeat the 
above process. Click the close button once you have set the colors in the Color Palette.

In the Colors tab in the Menu Inspector, clicking the Save as Default button makes this set 
of colors the DVD Studio Pro default palette, and it will be used in all menus and projects 
created from now on (until it is changed again). Clicking Restore to Default overrides any 
changes you have made to this palette and sets it to match the default palette.

Note:  Although they are identical in how they appear and work, the Color Palette used 
for subtitles is independent of the one used for menus.



238 Chapter 7    Creating Menus Using the Standard Method

 

Methods for Choosing Colors 
DVD Studio Pro uses the standard Mac OS X Colors window. The window provides a 
variety of methods for choosing your colors, including a magnifying glass for grabbing 
colors from anywhere on your system’s display. See Mac Help for information on using 
the Colors window.

Color Mapping Sets
While the DVD specification limits you to 4 colors in a menu overlay and 16 colors in a 
menu’s palette, you can use those colors in different ways on each button on a menu. 
DVD Studio Pro lets you choose from three color mapping sets for each button.

Each set uses the same Color Palette, but allows you to assign different colors and 
transparencies to each overlay color for the selected and activated states of the 
buttons. There are two reasons you might want to do this:

• To include buttons with different highlight colors on the same menu
• To get around problems with overlapping buttons

Using the Color Mapping Sets
Both the Menu and Button Inspectors have tabs with color mapping settings. The 
settings you make in the Colors tab in the Menu Inspector affect all buttons that you 
have created and will create for that menu. All buttons use color mapping set 1 when 
first created. 

Once a button has been created, its properties appear in the Button Inspector. You can 
select a different color mapping set (2 or 3) for this button in the Style tab. You can also 
change the color mapping settings (for example, picking a different color for the 
selected state of overlay color 2) in the Colors tab. However, this affects all buttons that 
use that setting, not just the current button. 

The illustration below shows a menu with six buttons. The menu uses the three color 
mapping sets to group buttons with similar functions.

Play Movie
Select Scene

Cast Bios
Trailers

OK!
OK!
OK!
OK!

Bonus OK!Credits OK!

Color map set 1

Color map set 1

Color map set 1

Color map set 1

Color map set 2 Color map set 3
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Using Simple Overlay Color Mapping
Simple overlays have one color setting for each button state (normal, selected, and 
activated). All white areas of the overlay graphic are automatically set to be 
transparent—all black areas become a highlight area. You can use palettes and color 
mapping sets with a simple overlay. 

Setting Up a Menu’s Color Mapping Using a Simple Overlay
The following steps show you how to set up color mapping for a menu when using a 
simple overlay. Once you start creating buttons (described in “Adding Buttons to Your 
Menu” on page 253), you will be able to select the color mapping sets for them. 

To set up color mapping for a menu using a simple overlay:
1 Select a menu that has a background and overlay assigned. 

The Menu Inspector appears.

2 Click the Colors tab in the Menu Inspector.

3 Select Simple next to Overlay Colors.

4 In the Menu Editor, choose Display Composite from the Settings pop-up menu to see 
the normal color settings take effect as you set them. (You will not see the selected and 
activated settings take effect until you start creating buttons.)

5 Set the color and opacity settings for the normal selection state.

• To choose the color, open the Color pop-up menu and choose a color from the 
16-color palette that appears.

• To set the opacity, either enter a new value in the fields to the right of the Opacity 
slider, or drag the sliders. The values range from 0 (completely transparent) to 15 
(completely opaque).

Select Simple or Advanced, 
depending on the overlay 
you are using.

Select the color mapping set 
to configure.

Set the highlight’s opacity.Choose a color for each
button state.
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Set the normal color settings based on whether the background includes the normal 
button graphics. 

• If the normal button graphics are included in the background, set the opacity for the 
Normal color to 0 (completely transparent). 

• If the normal graphics are not included in the background, set the opacity and select 
the color so that the buttons appear as intended.

6 Select Selected and Activated under Selection States and set the highlight color 
settings for the selected and activated states. 

You will not see any of these settings take effect until you start creating buttons. You 
can configure the settings for all three of the color mapping sets by selecting their 
buttons (1, 2, and 3).

Note:  If you set the Normal opacity to 15 and see other colors around the edges of 
items in the overlay graphic, the graphic has anti-aliased edges. To prevent the extra 
colors from appearing, you should either correct the overlay graphic or use the 
advanced overlay method.

Using Advanced Overlay Color Mapping
Using an advanced overlay, you can map highlight colors to up to four overlay colors. You 
choose one of two mapping types for the overlay graphic (chroma or grayscale), based 
on how you created the overlay graphic. See “Creating Overlays” on page 86 for details.

Since advanced overlays can have up to four colors, you’re more likely to use them to 
create the normal button states (in addition to the selected and activated states) than 
you would be with a simple overlay. The following sections describe strategies you can 
use for each button state.

Normal State
Normal settings determine what a button looks like when not selected or activated. 
They apply to the entire overlay graphic, not just the areas identified by the button 
active areas.
• If the normal state of the button is part of the background (the overlay does not provide 

button graphics), then you will generally set the opacity for each of the overlay colors to 0, 
making them invisible (and making the highlight colors mapped to them unimportant).

• If the normal state of the button is not part of the background (the overlay provides the 
button graphics), then you need to assign a color and opacity for each overlay color 
for the normal state. 
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Selected State
To avoid viewer confusion, it is important to clearly show that a button has been 
selected. The way you do this depends on whether the normal state of the button is 
part of the background. 
• If the normal state of the button is part of the background, then the overlay typically 

provides a highlight by adding something to the existing button, such as an outline 
or a small graphic (such as a checkmark, logo, or some text).

• If the normal state of the button is not part of the background, then you can change the 
colors and transparency of the overlay colors used for the normal state button. For 
example, you could have one of the overlay colors be transparent in the normal state, 
and appear as an additional graphic in the selected state.

Activated State
The activated state, like the selected state, must appear clearly to the user. However, 
the activated state generally appears for only a short time—the amount of time it takes 
the DVD to process the button’s action.

The following is an example of an advanced overlay, showing only one button and 
using the grayscale mode.

This overlay uses a white background, main text that is dark gray, a light gray 
checkmark, and a black “OK!”. 

Using color mapping, you can control how each of these elements appears in each of 
the three states.

In the above example, for the normal state only the main text (using the dark gray 
overlay color settings) is visible, with its color set to yellow. When the button is 
selected, a green checkmark (using the light gray overlay color settings) appears. When 
activated, the checkmark disappears, the text turns brown, and a yellow “OK!” (using 
the black overlay color settings) appears. 

 Play Movie OK!

Light gray
checkmark

Dark gray
name

Black
“OK!”

White
background

Overlay color Normal state Selected state Activated state

Black Transparent Transparent Yellow, opaque

Dark gray Yellow, opaque Yellow, opaque Brown, opaque

Light gray Transparent Green, opaque Transparent

White Transparent Transparent Transparent
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Setting Up a Menu’s Color Mapping Using an Advanced Overlay
The following steps show you how to set up color mapping for a menu when using 
an advanced overlay. Once you start creating buttons (described in “Adding Overlay-
Based Buttons” on page 253), you will be able to select the color mapping sets for 
them separately. 

To set up color mapping for a menu using an advanced overlay:
1 Select a menu that has a background and overlay assigned. 

The Menu Inspector appears.

2 Click the Colors tab in the Menu Inspector.

3 Select Advanced next to Overlay Colors.

4 Set the Mapping Type to either Chroma or Grayscale, depending on how the overlay 
was created.

5 Select Normal under the Selection State.

6 In the Menu Editor, choose Display Composite from the Settings pop-up menu to see 
the normal color settings take effect as you set them. (You will not see the selected and 
activated settings take effect until you start creating buttons.) 

7 Set the color and opacity settings for the normal selection state.

• To choose the color, open the Color pop-up menu and choose a color from the 16-
color palette that appears.

• To set the opacity, either enter a new value in the fields to the right of the Opacity 
sliders, or drag the slider next to the value. The values range from 0 (completely 
transparent) to 15 (completely opaque).

Set the normal color settings based on whether the background includes the normal 
button graphics. 

• If normal button graphics are included in the background, set the opacity for each 
overlay color to 0 (completely transparent). 

• If normal graphics are not included in the background, set the opacity and select the 
color for each overlay color so that the buttons appear as desired.

8 Select Selected and Activated under Selection State and set the highlight color settings 
for the selected and activated states. 

You will not see any of these settings take effect until you start creating buttons. You 
can configure the settings for all three of the color mapping sets by selecting their 
buttons (1, 2, and 3).
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Using an Advanced Overlay to Support Anti-Aliasing
Instead of using the advanced overlay’s four colors to create multiple color highlights, you 
can use them to create pseudo-soft edges and take advantage of anti-aliased graphics. 
This requires you to use the grayscale method, using either white elements on a black 
background or black elements on a white background. The soft or anti-aliased edges are 
mapped to the dark and light gray overlay colors. By mapping the same color to each 
overlay color, but at reduced opacities on the dark and light gray overlay colors that occur 
at the edges, you can effectively simulate soft or anti-aliased edges.

To configure an advanced overlay for anti-aliased edges:
1 Select a menu that has a background and overlay with anti-aliased edges assigned. 

The Menu Inspector appears.

2 Click the Colors tab in the Menu Inspector.

3 Select Advanced next to Overlay Colors.

4 Set the Mapping Type to Grayscale.

5 Select Normal under the Selection State.

6 In the Menu Editor, choose Display Composite from the Settings pop-up menu to see 
the normal color settings take effect as you set them. (You will not see the selected and 
activated settings take effect until you start creating buttons.) 

7 If the overlay should appear in the normal selection state, set the color and opacity 
settings as follows:

• Choose the same color from the Color pop-up menus for each of the overlay colors.
• Set the opacity for the primary overlay color (usually black) to 15.
• Set the opacity for the next overlay color (dark gray) to 10.
• Set the opacity for the next overlay color (light gray) to 5.
If the overlay should not appear in the normal selection state, set the opacity settings 
to 0 for each overlay color.

8 Select Selected and Activated under Selection State and set the highlight color settings 
for the selected and activated states. Set the color and opacity settings using the same 
method used in step 7. You will not see these settings take effect until you create 
buttons on the menu.
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Configuring the Menu Inspector for Standard Menus
The tabs within the Menu Inspector provide a variety of menu configuration settings. 
These settings control everything from background and overlay configuration, to 
transition and timeout settings.

Setting Menu Properties
The Menu Inspector has five tabs:  General, Menu, Transition, Colors, and Advanced. 

The Colors tab changes depending on whether you are using simple or advanced 
overlay color mapping.

Settings at the Top of the Menu Inspector for Standard Menus

There are three settings at the top of the Menu Inspector:

• Name:  Enter the name for this menu. 
• Est. Size:  Displays the estimated amount of disc space the menu requires based on 

the type and duration of the assigned assets.
• Background:  Choose the menu’s background. See “Choosing the Background” on 

page 231 for more information.
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General Tab in the Menu Inspector for Standard Menus
The General tab in the Menu Inspector is divided into four sections:  The upper section 
contains basic menu settings, the next section contains settings for motion menus and 
menu timeout actions, the next section contains the overlay selection settings, and the 
bottom section contains the audio file settings.

Motion Menu Settings
The motion menu settings apply whenever you assign a video asset as the menu’s 
background or add audio to the menu. See “Configuring Motion Menu Settings” on 
page 282 for more details on these settings.
• Start:  Defines the starting frame for the motion background. Use either the slider or 

timecode field to set this value.
• Loop Point:  Defines the frame that is jumped back to when the motion background 

is looped. By default this frame is set to be the same as the Start timecode. This is 
also the point where button highlights appear and the viewer can begin navigating 
the buttons. (Since button highlights are still images, you may want to delay their 
appearance until the buttons stop moving if you are flying them onto the screen.) 
Use either the slider or timecode field to set this value. This value can also be set by a 
chapter marker in the background video.

• End:  Defines the last frame for the motion background. The At End setting becomes 
active once this frame is reached. Use either the slider or timecode field to set this 
value.

• Duration:  Adjusts automatically to match the time between the Start and End 
settings. Adjusting Duration only affects the End setting.

Motion menu settings

Audio settings

Menu timeout and jump actions

Overlay selections
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• Single Field:  Optimizes playback when using field-based video sources. This is 
especially important with video that has fast motion, and will reduce any motion 
artifacts. Selecting Single Field with frame-based video sources results in reduced 
resolution (edges may appear jagged).

• At End:  Sets the motion menu action when the End time is reached during playback. 
Choose one of these settings:
• Still:  Freezes the video’s last frame once the video asset finishes playing. If there is 

an audio file assigned, it will also play once and then stop. 
• Loop:  Activates the Start, Loop, and End controls if there is a video asset assigned 

as the background. See “Configuring Motion Menu Settings” on page 282 for 
information on using these controls.

• Timeout:  Activates the Sec and Action settings. This allows you to configure the 
menu so that if the viewer does not select a button for a specified amount of time, 
the title automatically jumps to the element specified with the Action setting.

Menu Timeout and Jump Action
You can set whether a menu appears indefinitely or has a timeout duration. If you set a 
timeout duration, the title jumps to the element selected in the Action pop-up menu 
after the specified amount of time. If the menu has a video asset assigned as the 
background, the timeout’s countdown does not start until the video finishes playing. 
You’d generally use a timeout setting with titles played at a sales kiosk, where you want 
to have something playing onscreen as much as possible.
• Sec:  Enter the amount of time, in seconds, that the menu appears if no button is selected. 
• Action:  Choose the element to jump to once the timeout value is reached. If the 

menu has a default transition, the transition plays before the element is jumped to.

Overlay Selections
• Overlay File:  Choose the file with the menu’s overlay. See “Choosing the Overlay” on 

page 233 for more information.
• Overlay Layer:  Becomes active whenever you assign a PSD file with layers as the 

menu’s subpicture overlay. You choose the overlay layer from the pop-up menu.

Audio Settings
See “Adding Audio to a Menu” on page 279 for more information on using the settings 
in this area.
• Filename area:  Lists the audio files assigned to the menu. You can add audio files to 

the menu by dragging them here. You can rearrange their order by dragging the 
filenames to a new position. 

• Add (+):  Opens the file selection dialog, allowing you to add one or more audio files 
to the menu.

• Delete (–):  Removes the selected audio file from the menu.
• Total Audio Duration:  Shows the combined duration of all audio files assigned to 

the menu.
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Menu Tab in the Menu Inspector for Standard Menus
Most settings in the Menu tab in the Menu Inspector are optional. Exceptions are the 
Resolution and Display Mode settings, which must be set correctly for each menu, and 
the Background Layers area that is used when a Photoshop layered file (PSD) is 
assigned as the background.

Miscellaneous Menu Settings
• Default Button:  Choose the button to be selected when the menu appears during 

playback of the title. This setting can be overridden by any element that jumps to 
this menu, based on its jump setting and the Highlight Condition setting.

• Return Button:  Choose the project element to jump to if you press the Return button 
on the DVD player’s remote control. 

• Highlight Condition:  Provides an alternative method to the Default Button setting for 
determining which button to highlight. When Highlight Condition is set to Default, the 
Default Button setting supplies the button highlight setting. When Highlight Condition 
is set to one of its stream settings (audio, subtitle, camera angle), the number of the 
stream last played determines the button to highlight. This setting can be overridden 
by any element that jumps to this menu, based on its jump setting.

• Language:  Choose the language in which this menu should be displayed. See “Using 
Languages With Menus” on page 352 for more information.

Miscellaneous menu 
settings

PSD background layer 
selections

Drop shadow settings 
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• Resolution:  Choose the menu’s resolution. 
• For SD projects, the resolution is either 720 x 480i (NTSC) or 720 x 576i (PAL).
• For HD projects, you can choose from any of the supported resolutions. 

DVD Studio Pro Preferences includes a setting for the default resolution. The 
resolution automatically changes to match the menu’s background video 
resolution if it matches one of the supported resolutions. Choosing a resolution 
different than that used by the menu’s background video results in the menu 
being scaled and rendered to this setting when you build the project.

• Display Mode:  Set the aspect ratio for this menu (4:3 or 16:9), and with 16:9, choose 
how it displays on a 4:3 monitor. The aspect ratio of the background and overlay 
must match this setting. See “Working With 16:9 Menus” on page 208 for more 
information.

• Number Pad:  Defines which buttons are directly accessible by a DVD player’s numeric 
keypad. Choose All, None, or a button number from the pop-up menu. When you 
choose a button number, that button and all buttons less than that number are 
accessible via the numeric keypad—buttons greater than this value are blocked from 
direct access.

• Btn Offset:  You can use this setting to offset button numbers so they make sense to a 
viewer who wants to select a button by entering its number. For example, you may 
have a set of scene selection menus with numbered scenes. One of the menus may 
have scenes 23 to 34, with the button for scene 23 being the first button on the 
menu. If you enter an offset value of 22 for this menu, when the viewer enters 23 on 
the remote control, 22 is subtracted from it, with the result being 1—the button’s 
actual number.

Background Layers Selections
• Background Layers:  This table becomes active whenever you assign a PSD file with 

layers as the menu’s background. A list of all layers in the file appears, with 
checkboxes so that you can select which ones to use for the background. 

See “Choosing a Menu’s Background From a Layered Photoshop File” on page 233 for 
details on these settings.

Drop Shadow Settings
• Menu Shadow:  This area configures the drop shadow settings for this menu. See 

“Configuring the Menu’s Drop Shadow” on page 280 for more information.
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Transition Tab in the Menu Inspector for Standard Menus
The Transition tab is used to configure a button transition for this menu. See “Transition 
Tab in the Menu and Button Inspectors” on page 350 for details on this tab.

Colors Tab in the Menu Inspector With Simple Selected

Select Simple or 
Advanced, depending on 
the overlay you are using.

Select the color mapping 
set to configure.

Set the highlight’s 
opacity.

Choose a color for each
button state.
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The following settings are available in the Colors tab in the Menu Inspector when you 
select the simple overlay color mode.

• Overlay Colors:  Select Simple or Advanced, depending on the kind of overlay you 
are using.

• Set:  Select the color mapping set (1, 2, or 3) to configure. You cannot assign sets to 
buttons from the Menu Inspector; you must select a button or group of buttons and 
select their set in the Button Inspector. All new buttons use set 1.

Note:  These sets apply only to the selected and activated states of the buttons. The 
normal state color mapping setting applies to the entire overlay graphic unless a 
button’s active area is selected or activated. See “Using the Color Mapping Sets” on 
page 238 for more information.

• Color:  Choose the color for each of the three button states from the current 
Color Palette.

Note:  This also sets the highlight colors for the black overlay color if an advanced 
overlay is also used on this menu.

• Opacity:  Set the opacity for each of the highlight colors. You can use the slider or 
enter a value from 0 (completely transparent) to 15 (completely opaque).

Note:  This also sets the opacity for the black overlay color if an advanced overlay is 
also used on the menu.

• Save As Default:  Saves this color mapping configuration as the default to be used on 
all new menus you create.

Simple and advanced overlays use the same default mapping configuration.

• Restore Defaults:  Replaces the existing settings with those of the default color 
mapping configuration.

• Edit Palette:  Displays the Color Palette window, which you can use to change colors 
within the palette.
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Colors Tab in the Menu Inspector With Advanced Selected

The following settings are available in the Colors tab in the Menu Inspector when you 
select the advanced overlay color mode.

• Overlay Colors:  Select Simple or Advanced, depending on the overlay you are using.
• Mapping Type:  Select the colors used to create the overlay graphic. Chroma uses 

black, red, blue, and white. Grayscale uses black, dark gray, light gray, and white.
• Selection State:  Select the button state you want to configure. This setting also 

determines which state’s colors and transparencies to display.
• Set:  Select the color mapping set (1, 2, or 3) to configure. You cannot assign sets to 

buttons from the Menu Inspector—you must select a button or group of buttons 
and select their set in the Button Inspector. All new buttons use set 1.

Note:  These sets apply only to the selected and activated states. The normal state 
color mapping setting applies to the entire overlay graphic unless a button’s active 
area is selected or activated.

• Key:  Shows the overlay file’s colors as selected with the Mapping Type.
• Color:  Choose the color for each of the four overlay colors from this pop-up menu, 

which displays the current Color Palette. You must do this for all three button states.
• Opacity:  Set the opacity for each of the highlight colors. You can use the slider or 

enter a value from 0 (completely transparent) to 15 (completely opaque).
• Save As Default:  Saves this color mapping configuration as the default to be used on 

all new menus you create.

Both simple and advanced overlays use the same default mapping configuration.

• Restore Defaults:  Replaces the existing settings with those of the default color 
mapping configuration.

• Edit Palette:  Displays the Color Palette window, which you can use to change colors 
within the palette. 

Select Simple or Advanced, 
depending on the overlay 
you are using.

Select the color mapping 
set to configure.

Set the highlight’s opacity.

Shows the overlay
graphic’s colors.

Select the mapping type
used for the overlay

graphic.

Choose the colors to
map to each overlay

graphic color.

Select the button state.
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Advanced Tab in the Menu Inspector for Standard Menus
The Advanced tab in the Menu Inspector for standard menus contains settings that are 
used only in specialized projects.

Disabled User Operations Settings
• Disabled User Operations:  Select the functions that you want to be disabled while this 

menu plays. See “User Operations” on page 598 for more information.

Playback Options Settings
• Pre-Script:  Choose a script to run before the menu appears. This script can decide 

whether to show the menu or configure the DVD player before showing it. 
See “Pre-Scripts” on page 467 for information on pre-scripts. 

• DVD@CCESS:  Selecting this checkbox allows you to add DVD@CCESS links, which 
provide additional functionality to your title when played on a computer. See 
“DVD@CCESS” on page 594 for more information.

• Display Condition:  Selecting this checkbox enables the Display Condition settings which 
control whether or not this menu should be displayed, and to define what should be 
displayed if not this menu. See “Display Condition” on page 603 for more information.

Disabled User Operations 
settings

Playback Options settings
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Adding Buttons to Your Menu
Once you have set your background and overlay, you are ready to start adding buttons 
to your menu.

You can add buttons either by creating active areas in the overlay or by dragging 
shapes to the Menu Editor. You can then set each button’s properties, such as what the 
button jumps to when activated and how to navigate from it when using the DVD 
player’s remote control. 

The number of buttons a menu can have depends on the DVD standard and its 
display mode.

For SD Projects
• Menus using a 4:3 display mode can have up to 36 buttons. 
• Menus using a 16:9 Pan-Scan or 16:9 Letterbox display mode can have up to 18 

buttons. 
• Menus using a 16:9 Pan-Scan & Letterbox display mode can have up to 12 buttons.

For HD Projects
• Menus using a 4:3 display mode can have up to 48 buttons. 
• Menus using a 16:9 Pan-Scan or 16:9 Letterbox display mode can have up to 24 buttons.
• Menus using a 16:9 Pan-Scan & Letterbox display mode can have up to 16 buttons.

Adding Overlay-Based Buttons
To add an overlay-based button, you must identify each button’s “active area.” The 
active area is where selected and activated state highlights will occur, whether the title 
is played on a set-top DVD player or on a computer. Additionally, when the title is 
played on a computer, the active areas also determine the area in which a mouse-click 
will activate the button. 

To create the active area, you use the pointer to drag over the area containing the 
button’s elements. See the next section for details.

Creating and Modifying Button Active Areas
While you can create a button’s active area without a background or overlay assigned, 
most of the time you will need to assign them first so you know where to place the 
button active areas. See “Creating Menus Using the Standard Method” on page 229 
and “Creating Menus Using the Layered Method” on page 323 for details on assigning 
these files.
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To create and modify a button’s active area:
1 Click the menu background where you want one of the button’s corners to be, then 

drag to the opposite corner. You see a rectangle with dashed lines. 

2 To move the button by dragging, click inside the dashed lines and drag it to the 
new position. 

3 To move the button by dragging in one direction only (horizontal or vertical), press the 
Shift key, then drag the button.

4 To move the button by dragging with snapping and the dynamic guides temporarily 
disabled, press Command, then drag the button.

5 To move the button using the arrow keys, select the button and press the arrow keys to 
move it one pixel at a time. Press Shift and the arrow keys to move it 10 pixels at a time, 
or press Shift-Option and the arrow keys to move it 20 pixels at a time.

6 To move an edge, click the resize handle at the center of the edge and drag it to the 
new position. This changes the button’s size.

7 To move a corner (which moves two edges at once), click the resize handle at the 
corner and drag it to the new position. This also changes the button’s size.

8 To change a button’s size while maintaining the button’s aspect ratio, Shift-drag an 
edge or corner. See “Working With Assets in Buttons and Drop Zones” on page 276 for 
more information.

9 To change a button’s size while keeping it centered at its current location, click an edge 
or corner, start dragging, then press the Option key.

10 To delete a button, select it (resize handles appear on its dashed line), then press the 
Delete key.

You can also use the Coordinates & Size area in the Advanced tab in the Button 
Inspector to precisely set a button’s size and position. 
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Viewing the Selected and Activated States
You can view the highlights for all three button states when you have a button selected. 
This makes it easy to see how the color mapping settings interact with the overlay. 

To view and set highlights for a button:
1 In the Menu Editor, choose Display Composite from the Settings pop-up menu. 

The Menu Editor displays both the background and the overlay based on the color 
mapping settings.

2 Use the Menu Editor’s button state buttons to select the state (normal, selected, or 
activated) to display.

3 With the button state set to either selected or activated, select Highlight Set 1, 2, or 3 in 
the Style tab in the Button Inspector to select the color mapping configuration to apply 
to the current button.

Note:  The Set 1, 2, and 3 buttons in the Button Inspector’s Colors tab are for 
configuring the sets. They do not apply the sets to the current button.

Shows the selected state.

Shows the 
activated state.

Shows the
normal state.

Why Don’t I See the Highlight Colors Without an Overlay?
In earlier versions of DVD Studio Pro, you could see the selected and activated 
highlights in the active area rectangle even without an overlay. This made it easy to 
create a menu by just creating underlines (which were short and wide active areas) 
that showed the selected and activated highlights.

The shapes feature of DVD Studio Pro 4 includes a SimpleButton shape that you can 
use to create these same types of highlights. By applying the SimpleButton shape to 
the first button active area you add to a menu, and then setting that button to be the 
menu’s default, all subsequent buttons will automatically have the SimpleButton 
shape and will show the selected and activated highlights.

See the following section for information on applying shapes, and “Setting Default 
Styles” on page 312 for information on defining a menu’s default button style.
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Adding Shapes to a Menu
There are two ways to add a shape to a menu:
• Drag it from the Shapes tab in the Palette.
• Create a button active area, then select the shape from the Button Inspector.

When you drag a shape from the Palette, it appears at its actual size, as created in the 
graphics program. When you add a shape by assigning it to an active area, it is scaled 
to fit the area, which can make it appear squashed or stretched. 

Dragging a Shape From the Palette
The Palette offers three groups of shapes, and shows you thumbnails of all the shapes 
you have to choose from. 

To drag a shape from the Palette:
1 Select the Shapes tab in the Palette.

2 Select the group of shapes to display:

• Click Apple to display the shapes included with DVD Studio Pro.

Note:  Not all shapes supplied with DVD Studio Pro support highlights. Some are 
intended to be used only with drop zones, and do not include the highlight layer 
used by buttons.

• Click Custom to display the shapes that have been imported for use by all projects.
• Click Project to display shapes imported for use by this project only.

3 Scroll through the available shapes, then select the one you want to use.

Select the group of 
shapes to display.

A soft gray border
appears around the

selected shape.
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4 To add the shape to any empty part of the menu, drag it to the Menu Editor. If you 
hover over the area for a second, the Drop Palette appears, where you can choose to 
create a button or drop zone. See “Adding Drop Zones to Your Menu” on page 273 for 
additional information about drop zones.

5 To apply the shape to an existing button, select the button in the Menu Editor, then do 
one of the following:

• Click Apply in the Palette.
• Drag the shape to the button.

When dragged to an empty part of the menu, the shape becomes a button and appears 
at its actual size. You can move it and change its size by either dragging it or entering 
coordinate and size values in the Advanced tab in the Button Property Inspector.

When applying or dragging the shape to an existing button, the shape’s size changes 
to match the existing button’s size.

Assigning a Shape in the Button Inspector
In the Button Inspector, you can select from the same shapes displayed in the Palette.

To assign a shape in the Button Inspector:
1 In the Menu Editor, select the button you want to apply the shape to.

2 Click the Style tab in the Button Inspector.

3 Choose a shape group from the Shape pop-up menu, then choose the shape to use.

A thumbnail of the shape appears in the Button Inspector and the shape is applied to 
the button.

The shape’s size changes to fit the button’s active area. You can move the button and 
change its size by either dragging it or entering coordinate and size values in the 
Advanced tab in the Button Inspector. See “Managing Shapes” on page 317 for 
information on the different types of shapes available and details on how to import 
your own shapes.
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Copying a Button
You can make a copy of a button to use on the same menu.

To make a copy of a button:
1 Select the button to be copied in the Menu Editor.

2 Hold down the Option key, then drag the button’s copy to its new location.

The copy is automatically given the same name as the original, with a number added 
to distinguish it. The copy has all the same properties as the original, including its 
Target and navigation settings.

Setting a Button’s Connection
The main purpose of a button is to provide a way for the viewer to jump to a new 
disc location. For this to work, you must assign an element from your project as the 
button’s connection. 

There are several ways to set a button’s connection:

• Using the Target setting in the Button Inspector
• Using the shortcut menu that appears when you Control-click a button
• Using the Connections tab. See Chapter 15, “Establishing Connections,” on page 525 

for more information.

In some cases, when using the dragging methods to add assets to a menu and 
selecting options from the Drop Palette, the connection is automatically set. See 
“Dragging Assets to the Menu Editor” on page 220 for more information.

You can see a button’s current connection by placing the pointer over it and reading 
the tooltip that appears.

To set a button’s connection in the Button Inspector:
1 Select the button whose connection you want to set.

2 Choose the element to connect to from the Target pop-up menu in the top section of 
the Button Inspector.
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To set a button’s connection using the shortcut menu:
1 Control-click the button whose connection you want to set.

2 Choose Target, then choose the element to connect to from the shortcut menu.

A checkmark appears next to the currently selected target.

Those elements that can have a pre-script assigned to them (menus, tracks, stories, and 
slideshows) are listed in square brackets. Setting a button’s target to the element in 
brackets allows the pre-script, if one is assigned to the element, to run before the 
element appears. If you set the target to anything else in the list, the pre-script is not 
run. See “Pre-Scripts” on page 467 for more information.

Setting Button Properties
When you select or create a button, the Button Inspector appears. 

Note:  There is a different Button Inspector for buttons on layered menus. See “Setting 
Layered Menu Button Properties” on page 333 for more information.

There are four tabs in the Button Inspector:  Style, Advanced, Colors, and Transition. 

About Resume
If you jump to a menu while watching a track, for example, by pressing the remote 
control’s Menu button, the DVD player remembers what track you were playing and 
how far you were into it. 

A mostly unknown feature of DVD players is that you can press the Menu button 
while in a menu to resume playing the track at the same place you jumped from.

Creating a button on the menu and setting its Target to Resume provides the viewer 
with a more obvious way to resume playing the track.
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Settings at the Top of the Button Inspector

There are three settings at the top of the Button Inspector.

• Name:  By default, buttons you manually add are named “Button _,” where “_” is the 
button number on that menu. To reduce confusion when viewing a list of the menu’s 
buttons, it is helpful to rename the buttons based on their functions.

Note:  Buttons created as a result of a Drop Palette action that creates other project 
elements are named after the new project elements. In the case of actions that 
create a new track, the button and the track are named after the video asset.

• Button #:  Next to the button’s name is its number. This number is based on the order 
in which the buttons are added to the menu. See “About Button Numbers” on 
page 264 for information on changing this number and why it can be important.

• Target:  You can use this pop-up menu to define a button’s action when activated. 
(You can also use the Connections tab or Control-click the button.) Often you must 
set the connection later since what you want to jump to has not yet been added to 
the project. The pop-up menu contains all possible elements you can jump to.

Style Tab in the Button Inspector

• Asset:  Use this pop-up menu to assign an asset to the thumbnail of the shape (if 
present) or, when there is no shape, to the button’s active area. You can choose any 
existing applicable assets.
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• Start Frame:  When the asset assigned to this button is a video clip, this area displays 
the video. Use the slider or timecode entry to choose the start point for motion 
playback (if motion is enabled) or to choose the frame to use in the button’s 
thumbnail if motion is not enabled.

• Motion:  Select this checkbox to enable motion in the button when the button’s asset 
is a video clip. See “Configuring Motion Menu Settings” on page 282 for looping 
details with motion buttons.

• Shape:  Use this pop-up menu to choose a shape to assign to the selected button. A 
thumbnail image of the selected shape appears next to the pop-up menu. The pop-up 
menu lists the existing shapes by their names, grouped as Apple Shapes (supplied with 
DVD Studio Pro), Custom Shapes (added shapes available to all projects), Project 
Shapes (added shapes available to this project only), and Patch Shapes. Use the 
Palette’s Shapes tab to manage the shapes and as another way to select a shape.

• Shadow:  Select this checkbox to apply the menu’s drop shadow setting to this shape.
• Selected Highlight:  Choose the button’s selected state highlight color from the 

16-color palette.

Note:  This does not affect the button’s normal or activated states. Use the settings in 
the Colors tab for those highlights.

• Highlight Set:  Choose the color mapping set (1, 2, or 3) to use for this button.
• Opacity:  Use this slider or enter a numeric value to set the selected highlight’s 

transparency from 0 (completely transparent) to 15 (completely opaque).

Note:  The Selected Highlight and Opacity settings affect the black color mapping 
settings for the selected color mapping highlight set. These settings affect all buttons 
on this menu, including overlay buttons, that use the same color mapping set.

• Text:  You can type text directly on the button in the Menu Editor or type it in this 
text area, then press Return to apply it to the button. To start a new line, press 
Option-Return. See “Adding Text to a Button” on page 266 for more information.

• Shadow:  Select this checkbox to apply the menu’s drop shadow setting to this 
button text.

• Text Position:  Choose where you want to place the text when adding text to a 
button. Choices include Bottom, Top, Right, Left, and Center. Use the Center setting 
when creating a text-only button.

• Text Offset X and Y:  Allows you to adjust the position of the text. For the horizontal (X) 
offset, positive numbers move the text to the right and negative numbers move it to 
the left. For the vertical (Y) offset, positive numbers move the text down and 
negative numbers move the text up.

• Include Text in Highlight:  Select this checkbox to make the button text highlight 
when the button is selected or activated.
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Advanced Tab in the Button Inspector

• Navigation:  The pop-up menus in this area let you set the actions that take place 
when the viewer uses the arrow buttons on the DVD player’s remote control to 
navigate around the title. Since this is the typical way the title will be viewed, it is 
important to spend some time configuring the navigation in a logical, predictable 
way. See “Configuring Button Navigation” on page 268 for information.

• Angle/Audio/Subtitle Streams:  Use these three pop-up menus to connect a button to 
specific audio, subtitle, and angle streams to play back. For the subtitle stream, you 
can also choose whether subtitles should appear.

• Auto Action:  If you enable Auto Action for a button, it will activate automatically as 
soon as it is navigated to, without the viewer needing to press Enter. This is useful in 
menus, such as scene selection menus, in which you use Next and Previous buttons; 
you can assume that if viewers navigate to the Next or Previous button, they want to 
activate it.

Note:  With overlay-based buttons, if you select this option, only the activated color 
mapping appears when the button is navigated to, skipping the selected color mapping.

• Invisible:  Applies to overlay-based buttons. Allows you to have a button that does 
not display highlights in the normal, selected, or activated state. This is useful when 
you want to have a menu with text and no visible buttons. The text could tell the 
viewer to press the Enter button to go to the next menu or start playback (or 
whatever the button is set to jump to).

• Coordinates & Size:  This area lets you set the location of each edge of the button’s 
active area, plus the area’s height and width. The upper-left corner of the menu is at 
pixel 0, line 0. You can enter values for each edge, allowing you to precisely position 
and size the button’s active area. (You can also drag the active area and each of its 
edges with the pointer.)
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Colors Tab in the Button Inspector
The Colors tab works exactly as does the Colors tab in the Menu Inspector. See “Colors 
Tab in the Menu Inspector With Simple Selected” on page 249 and “Colors Tab in the 
Menu Inspector With Advanced Selected” on page 251 for information on this tab.

Transition Tab in the Button Inspector
The Transition tab is used to configure a button transition for this button. See 
“Transition Tab in the Menu and Button Inspectors” on page 350 for details on this tab.
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About Button Numbers
Each time you add a button to a menu, in addition to its name (which you can change), 
it is assigned a number (which you cannot directly change) based on the order in 
which you added it to the menu. 

The first button you manually add to a menu is named and numbered “Button 1,” the 
second is “Button 2,” and so on. How a button fits in the order is important for 
three reasons:

• Button number 1 is the default button selected when the menu plays if no other 
button has been set as the menu’s default button.

• It determines the priority of the buttons if they overlap. Higher numbered buttons 
have a higher priority, and can cover up lower numbered buttons.

• It affects the creation of chapter index menus (see “General-Purpose Buttons” on 
page 311).

While you cannot change this number in the Button Inspector, you can change it using 
the shortcut menu that appears when you Control-click a button. 

Changing the Button Order
When you Control-click a button, a shortcut menu appears that allows you to rearrange 
the button order (and also set other button properties).

The button’s number

The button’s name
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There are also four buttons along the bottom of the Menu Editor (the Arrange controls) 
that allow you to rearrange the button order.

• Send To Back:  Makes the selected button button 1, the lowest priority button. The 
existing button 1 now becomes button 2, and so on. The button names don’t 
change, however. You can also press Shift-Command-B to send it to the back.

• Send Backward:  Swaps the selected button’s number with the button below it, 
making it a lower priority than the button below it. If this is button 12, then it 
becomes button 11, and button 11 becomes button 12. You can also press 
Command-[ to send it backward.

• Send Forward:  Swaps the selected button’s number with the button above it, making 
it a higher priority than the button above it. If this is button 12, then it becomes 
button 13, and button 13 becomes button 12. You can also press Command-] to send 
it forward.

• Bring to Front:  Makes the selected button the highest priority button on the menu. 
All buttons that were above it move down one number. You can also press Shift-
Command-F to bring it to the front.

The priority is generally not important unless you overlap your buttons or you intend 
to use this layout as a style for creating chapter index menus. (Overlapping is 
discouraged; see “About Overlapping Buttons” on page 272 for more information.)

Note:  Drop zones, text objects, and buttons are included in the same priority list; a 
drop zone can have a higher priority, and thus cover up, a button.

Brings the item to the 
front, making it the 
highest priority.

Sends the item’s priority 
one step back.

Sends the item to the
back, making it the

lowest priority.

Moves the item’s 
priority one step up.
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Adding Text to a Button
You can add text to any button on a standard menu. You can even create text-only 
buttons by creating a button active area and then adding the text to it.

The default text font and color are set in the Text pane in DVD Studio Pro Preferences.

To add text to a button:
1 Make sure the Style tab in the Button Inspector is displayed.

2 To add the text, do one of the following:

• Select the button in the Menu Editor, then press Return. An insertion point appears 
at the bottom of the button. Type your text here. Press Return to add an additional 
line, or press Enter to exit the text entry mode.

• Select the button in the Menu Editor, then type the text in the Text entry area of the 
Button Inspector. To add an additional line, press Return or Enter.

• Select the button in the Menu Editor, then click just below its active area. An 
insertion point appears. Type your text. Press Return to add an additional line, or 
press Enter to exit the text entry mode.

Note:  The default settings in the Button Inspector’s Text Formatting section at the bottom 
of the Style tab place the text at the bottom of the button. You can change these settings 
before typing the text, in which case the text appears at the new position.

3 Select the Shadow checkbox (next to the text entry area) to apply the menu’s drop 
shadow settings to the text.

4 Choose the text’s position (Bottom, Top, Left, Right, or Center) from the Position pop-up 
menu. You can use the X Offset and Y Offset entries to fine-tune the position.

5 Select Include Text in Highlight if you want the text to highlight along with the button 
when selected or activated.

You can edit the text by clicking within it or by dragging the pointer over the portion 
of the text to be replaced, then typing the new text.

The button’s active area extends to include the text if you choose to include the text in 
the highlight. Use care to ensure that the active area does not inadvertently overlap 
other buttons on the menu.
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Setting the Button Text’s Font and Color
A button’s text can use a mix of colors and fonts.

To change the text font and color:
1 Select the text you want to change. 

2 Do one of the following to open the Font panel:

• Choose Format > Font > Show Fonts.
• Click Fonts in the toolbar.
• Press Command-T.

3 Choose the font and size to use.

4 Do one of the following to open the Colors window:

• Choose Format > Font > Show Colors.
• Click Colors in the toolbar.
• Press Shift-Command-C.

5 Choose the color to use.

You can also add bold, italic, and underline attributes to the text.

Note:  The bold and italic attributes are available only if the current font supports them.

To apply bold, italic, and underline attributes:
1 Select the text you want to change. 

2 Do one of the following to add the bold attribute:

• Choose Format > Font > Bold.
• Press Command-B.

3 Do one of the following to add the italic attribute:

• Choose Format > Font > Italic.
• Press Command-I.

4 Do one of the following to add the underline attribute:

• Choose Format > Font > Underline.
• Press Command-U.

By selecting different parts of the button’s text, you can mix different fonts, colors, and 
attributes on the same button.

Creating Text-Only Buttons
You can create text-only buttons that only have the text as their graphic. This is useful if 
you want a simple button that says something like “Play Movie.” By centering the text 
in the button and configuring the button so that the selected and activated highlights 
apply to the text, you can create a button that works well in a DVD title.
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To create a text-only button:
1 Create a button active area by dragging in the Menu Editor.

2 Add text to the button, either in the Button Inspector or by typing directly in the 
Menu Editor. 

3 Set the text’s font and color. 

4 In the Style tab in the Button Inspector, choose Center for the Position, and select 
Include Text in Highlight.

5 Adjust the size of the button’s active area so that it fits the text.

You can now set the button’s selected and activated highlights as you would any 
simple overlay graphic.

Note:  If you open a DVD Studio Pro project that uses a font that is not on the computer 
you are opening it on (either because the font was deleted or the project was created 
on a different computer), any items using the missing font have a different font 
substituted with no warning.

Configuring Button Navigation
Since most viewers will use the arrow buttons on a DVD player’s remote control to navigate 
through the buttons on a menu, it’s important that the navigation is easy and logical. 

DVD Studio Pro includes three methods for setting button navigation:

• Dragging:  In the Menu Editor, you can Option-Command-drag the resize handle on 
each button’s edge to the button it should navigate to.

• Manually:  You can manually set each button’s navigation using the Navigation 
section in the Button Inspector’s Advanced tab.

• Auto Assign:  You can use the Auto Assign feature in the Menu Editor. This sets the 
navigation for all buttons on the menu at the same time.

• Continuous Auto Assign:  You can use the Continuous Auto Assign feature in the Menu 
Editor. This sets the navigation for all buttons each time you add a new button or 
reposition an existing button. This feature is activated when you first open 
DVD Studio Pro. See “Setting Button Navigation With Continuous Auto Assign” on 
page 271 for more information.

In general, if you are manually setting button navigation or modifying automatic button 
navigation, you should wait until all buttons have been added to the menu, ensuring that 
all possibilities are taken into account. It is also helpful to name each button before 
setting the navigation so that you can easily distinguish them from each other.
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Setting Button Navigation Manually by Dragging 
in the Menu Editor
You can set button navigation in the Menu Editor by dragging a button’s edge to the 
button that it should navigate to. Each edge of a button corresponds to an arrow 
button on a remote control. For example, dragging the right edge of a button 
determines what will happen when you press the Right Arrow button.

To set button navigation by dragging button edges:
1 Select the button whose navigation you want to set. 

The active area rectangle appears around it.

2 Hold down the Option and Command keys and click the resize handle on the edge you 
want to set. For example, click the right edge to set the right-arrow jump for the button.

3 Drag from the resize handle to the button you want to link to. A line appears to 
indicate which edge you started at.

4 As you drag, the line’s color changes from white to green once you reach a button’s 
active area. When the line is green, release the mouse button to make the connection.

Once the connection is made, the line disappears. 

The biggest drawback to setting navigation this way is that, unless you verify the 
connections carefully, you can easily miss setting all four edges of all buttons, resulting 
in some peculiar navigation.

Setting Button Navigation Manually With the Button Inspector
You can manually set each button’s navigation using the Button Inspector. You can also 
change a button’s navigation that has been set with the Auto Assign feature.

To manually set button navigation:
1 Select a button. 

2 Click the Advanced tab in the Button Inspector.

3 In the Navigation area, open the pop-up menu for each direction (left, right, up, and 
down) and choose the button that should be jumped to for each. Leave the setting at 
“not set” if you do not want an action to occur when a viewer presses a particular 
arrow button.

Each button’s settings are completely independent. The settings you make for one 
button have no effect on the other buttons in the menu.
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Setting Button Navigation With the Auto Assign Feature
The Auto Assign feature makes it easy to configure the button navigation for a menu. 
You can also use it as a starting point for configuring your navigation, and then freely 
adjust the settings it creates.

To use Auto Assign to set button navigation:
1 Set up your menu as you want it, with its buttons in their final locations.

2 Do one of the following:

• Choose Auto Assign Buttons Now in the Menu Editor’s Settings pop-up menu.
• Press Shift-Command-D.

It’s important to understand that Auto Assign works with the buttons as they currently 
exist on the menu. If you move, delete, or add buttons to the menu, you need to use 
Auto Assign again to update the navigation. 

Note:  Using Auto Assign overrides any existing navigation settings. If you intend to 
manually modify the settings Auto Assign creates, be sure you have all buttons in place 
before using it. This reduces the risk of having to use Auto Assign again, and undoing 
any modifications you may have made.

How Auto Assign Works
Auto Assign strives to configure the navigation in a logical manner. For example, 
pressing a Right Arrow button on the remote control selects the button to the right (if 
there is one). If a menu has a peculiar button layout, however, Auto Assign can produce 
surprising results. 

Auto Assign uses the following rules when configuring the navigation:

• It assigns every button a navigation setting. This is an advantage, since you may 
accidentally skip a button when manually assigning navigation, resulting in 
orphaned buttons.

• The navigation loops through all buttons. When you reach the edge of a menu and 
press the same arrow button on the remote again, you jump to the menu buttons in 
the next row at the opposite edge. This means that if you keep pressing any of the 
arrows, you will eventually get to all menu buttons.

1 2 3

4 5 6

7 8 9
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Setting Button Navigation With Continuous Auto Assign
The Menu Editor includes a Continuous Auto Assign feature that updates the 
navigation of all buttons on the menu each time you add a new button or move an 
existing one. You are unable to manually assign button navigation while the 
Continuous Auto Assign feature is active.

To enable Continuous Auto Assign:
m Choose Auto Assign Buttons Continuously in the Menu Editor’s Settings pop-up menu.

The Continuous Auto Assign feature remains enabled until you choose it again to 
disable it.

Unlike using the Auto Assign feature, you can enable the Continuous Auto Assign 
feature before the buttons are in their final positions—you can even enable it before 
you have added any buttons to the menu. 

Right-to-Left Reading Mode
Auto Assign and Continuous Auto Assign have a Right-to-Left Reading option, 
designed for use with titles whose viewers are used to reading right-to-left (such as 
Farsi and Hebrew). To use the Right-to-Left option, choose the appropriate setting in 
the Menus pane in DVD Studio Pro Preferences.

The illustration above shows the path for a menu intended for viewers familiar with 
right-to-left reading. Note that the difference is in what happens when you reach a 
menu edge; when you are not on an edge, the arrow buttons work the same in both 
reading modes.

3 2 1

6 5 4

9 8 7



272 Chapter 7    Creating Menus Using the Standard Method

 

About Overlapping Buttons
In general, it’s a good idea to avoid overlapping buttons. Some DVD players may 
behave erratically when they try to process menus with overlapping buttons. This 
problem is worse if you are playing the title on a computer and using a pointer to 
select a button.

Sometimes, however, while the button graphics do not actually overlap, their active 
areas do.

In this case, if viewers watch the title on a computer, they may get unexpected results if 
they click in an overlap area. 

Another problem occurs when using overlay-based buttons. Since the active areas 
control the overlay area that is highlighted when you select or activate a button, you 
may end up with portions of neighboring buttons highlighting at inappropriate times. 
It is possible to get around this problem by using different color mapping sets on 
neighboring buttons. See “Color Mapping Sets” on page 238 for more information.

Adding Drop Zones, Text Objects, and Audio to a Menu
In addition to buttons, standard menus allow you to add several other features to 
your menus. 
• Drop zones make it easy to add graphics, still or full motion, to the menu’s 

background. 
• Text objects provide a way to add text to the background, making it easy to add 

titles and other information that is useful for the viewer. 
• Adding audio to your menu can make it more interesting or provide instructions on 

using the menu.

Active area overlap

 Play Movie

 Scene Select

 Slideshow
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Adding Drop Zones to Your Menu
Drop zones are similar to buttons; you can assign an asset to them, move them around, 
and change their size. Unlike buttons, however, they do not have jump targets and 
they are not counted as buttons in the menu’s button count. 

Drop zones allow you to add graphics to a menu that you would otherwise have had to 
add to the background using an external video editing application.

To create a drop zone by dragging an asset:
1 Drag a still image, video clip, or shape to an empty part of the Menu Editor. You can 

drag this from the Assets tab, the Palette, or a Finder window.

2 Choose Create Drop Zone from the Drop Palette. 

A 120-pixel high by 180-pixel wide rectangle appears, with the still image, video clip, or 
shape filling it. You can position and resize the drop zone the same as you would a 
button’s active area. See “Working With Assets in Buttons and Drop Zones” on page 276 
for more information.

To create a drop zone by drawing a rectangle:
m Hold down the Option key while dragging to create a rectangle in the Menu Editor, 

similar to the way you create a button’s active area.

You can use the Drop Zone Inspector or drag to assign a shape and asset to the 
drop zone.

To convert a button to a drop zone, do one of the following:
m Choose Project > Convert Button to Drop Zone.
m Control-click the button, then choose Convert Button to Drop Zone from the 

shortcut menu.

The name of the drop zone is DropZone _, with _ being the next available number. 

To convert a drop zone to a button, do one of the following:
m Choose Project > Convert Drop Zone to Button.
m Control-click the button, then choose Convert Drop Zone to Button from the 

shortcut menu.

The name of the button is Button _, with _ being the next available number. 

Once you have created a drop zone, you can drag an asset to the drop zone, or select 
an asset in the Drop Zone Inspector. See “Working With Assets in Buttons and Drop 
Zones” on page 276 for more information.
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Setting Drop Zone Properties
The Drop Zone Inspector appears once you create a drop zone. It contains basic 
settings for configuring the drop zone.

• Name:  Enter a name for the drop zone.
• Asset:  Use this pop-up menu to assign an asset to the drop zone. You can choose any 

applicable assets.
• Start Frame:  When the asset assigned to the drop zone is a video clip, this area 

displays the video. Use the slider or the timecode entry to choose the start point for 
motion playback (if motion is enabled) or to choose the frame to use in the drop 
zone if motion is not enabled.

• Motion:  Select this checkbox to enable motion in the drop zone when the drop 
zone’s asset is a video clip. See “Configuring Motion Menu Settings” on page 282 for 
details on looping video within drop zones.

• Shape:  Use this pop-up menu to select a shape to assign to the selected drop zone. A 
thumbnail image of the selected shape appears next to the pop-up menu. The pop-up 
menu lists the existing shapes by their names, grouped as Apple Shapes (supplied with 
DVD Studio Pro), Custom Shapes (added shapes available to all projects), Project 
Shapes (added shapes available to this project only), and Patch Shapes. Use the 
Palette’s Shapes tab to manage the shapes and as another way to select a shape. 

• Shadow:  Select this checkbox to apply the menu’s drop shadow setting to this 
drop zone.

• Coordinates & Size:  This area lets you set the location of each edge of the drop zone, plus 
the drop zone’s height and width. The upper-left corner of the menu is at pixel 0, line 0. 
You can enter values for each edge, allowing you to precisely position and size the drop 
zone. (You can also drag the drop zone and each of its edges with the pointer.)

• Rotation:  Rotate the knob or enter a value to rotate the drop zone. The values can go 
from 0.0 to 359.9, with a value of 0.0 as normal. 
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About Using Drop Zones
Any drop zones you add to your menu will become part of the menu’s background 
when the project is built.

Overlapping Drop Zones
While you should avoid overlapping buttons, you can feel free to overlap drop zones, 
since they are not involved in navigation. Because drop zones can be overlapped, you 
should use care when adding them to the menu—those added later have a higher 
priority and will cover up those added earlier.

To change a drop zone’s priority:
m Control-click it, then choose an option from the shortcut menu. See “Changing the 

Button Order” on page 264 for more information.

Note:  Drop zones, text objects, and buttons are included in the same priority list; a 
drop zone can have a higher priority, and thus cover up a button.

Shapes in Drop Zones
While shapes are primarily intended to be applied to buttons, they can be useful when 
applied to drop zones, too.

Without a shape, a drop zone usually has a rectangular outline, since that is the shape 
of the still images and video clips you can add to the drop zones. Shapes, however, can 
have an irregular outline, and when applied to a drop zone, the irregular outline is 
maintained. This makes it possible to have heart- or star-shaped drop zones—or any 
shape you want to create and import. Using a shape in a drop zone, you could add 
your corporate logo to your menus without having to composite it externally.

Shapes with patches can also be used with drop zones. See “Adding Shapes to a Menu” 
on page 256 for more information.

Note:  A drop zone can also have an irregular edge if the asset assigned to it has an 
alpha channel. See “Creating Graphics for Drop Zones and Buttons” on page 96 for 
more information.
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Working With Assets in Buttons and Drop Zones
A button’s or drop zone’s active area aspect ratio may not match the aspect ratio of the 
asset assigned to it. In these situations, part of the asset ends up being cropped off. You 
have two options for working with the asset:
• You can leave the active area’s aspect ratio as it is, and move the asset to control 

which part of it is cropped off.
• You can force the active area’s aspect ratio to match the asset’s aspect ratio.

Positioning Images in a Button or Drop Zone
If you want to keep the button’s or drop zone’s active area at its current aspect ratio, 
you can position the asset within the active area, choosing which parts of the asset are 
cropped off.

To position an asset in an active area:
m Shift-Option-click the asset within the active area, then drag it. 

The active area remains where it is, and the asset moves within it (similar to moving a 
picture behind a window).

Matching the Active Area Aspect Ratio to the Asset
If you want the asset to appear without being cropped, you need to adjust the active 
area’s aspect ratio to match the asset’s aspect ratio.

To match the active area’s aspect ratio to the asset’s aspect ratio:
m Shift-drag a corner of the active area.

The active area snaps to match the asset’s aspect ratio, ensuring none of it is being 
cropped off. As long as you hold down the Shift key while changing the active area’s 
size, this aspect ratio is maintained.

Adding Text Objects to a Menu
You can type text directly onto a menu’s background, creating a text object. When you 
build the project, this text object merges with the background—it cannot be selected 
by the viewer or have jump actions assigned to it. 

A text object can contain characters with different colors, fonts, and sizes. The Text 
pane in DVD Studio Pro Preferences contains settings that define the text font and 
color used when you create new text objects. You can change the text font and color 
after you have typed it.

Text objects can also be rotated and have the menu’s drop shadow applied.
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To add a text object to a menu:
1 Double-click the menu where you want to add a text object. You will be able to move 

the object later, so the actual position is not critical.

2 Start typing the text. As you type, the text appears on the menu, with a handle on each 
end. To create a new line, press the Return key, or press Enter to exit the text entry 
mode. The Text Object Inspector appears.

Note:  You can also type the text in the Text entry area in the Text Object Inspector, and 
use either Return or Enter to create a new line. 

3 Click the Shadow checkbox to add the menu’s drop shadow to the text.

4 To change the text’s justification, do one of the following:

• Click the appropriate button in the Text Object Inspector.
• Press Shift-Command-[ to left align the text.
• Press Shift-Command-] to right align the text.
• Press Shift-Command-\ to center the text.

5 Rotate the Rotation knob or enter a value to rotate the text object.

You can reposition the text object by dragging the text to a new position. (If you are in 
the text edit mode with the blinking insertion point showing in the Menu Editor, you 
need to click an empty area of the Menu Editor to exit the text edit mode before you 
can drag the text object to a new position.) 

To change the text object’s font and color:
1 Select the text you want to change. 

2 Do one of the following to open the Font panel:

• Choose Format > Font > Show Fonts.
• Click Fonts in the toolbar.
• Press Command-T.

3 Choose the font and size to use.

Note:  If you open a DVD Studio Pro project that uses a font that is not on the computer 
you are opening it on (either because the font was deleted or the project was created 
on a different computer), any items using the missing font have a different font 
substituted with no warning.
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4 Do one of the following to open the Colors window:

• Choose Format > Font > Show Colors.
• Click Colors in the toolbar.
• Press Shift-Command-C.

5 Choose the color to use.

You can also add bold, italic, and underline attributes to the text.

Note:  The bold and italic attributes are available only if the current font supports them.

To apply bold, italic, and underline attributes:
1 Select the text you want to change. 

2 Do one of the following to add the bold attribute:

• Choose Format > Font > Bold.
• Press Command-B.

3 Do one of the following to add the italic attribute:

• Choose Format > Font > Italic.
• Press Command-I.

4 Do one of the following to add the underline attribute:

• Choose Format > Font > Underline.
• Press Command-U.

By selecting different parts of the text, you can mix different fonts, colors, and 
attributes in the same text object.

Setting Text Object Properties
The Text Object Inspector appears once you type text on a menu or select an existing 
text object. It contains basic settings for configuring the text.



Chapter 7    Creating Menus Using the Standard Method 279

 

• Text:  This area contains the text displayed in the text object. You can also enter or 
edit the text here. To add additional lines, press Return. 

• Shadow:  Select this checkbox to apply the menu’s drop shadow setting to this text 
object.

• Position:  Select the justification to apply to the text object (left, center, or right).
• Rotation:  Rotate the knob or enter a value to rotate the text object. The values can 

go from 0.0 to 359.9, with a value of 0.0 as normal.

About Text Objects
Any text objects you add to your menu will become part of the menu’s background 
when the project is built.

Overlapping Text Objects
While you should avoid overlapping buttons, you can feel free to overlap text objects, 
since they are not involved in navigation. Because text objects can be overlapped, use 
care when adding them to the menu—those added later have a higher priority and will 
cover up those added earlier.

To change a text object’s priority:
m Control-click it, then choose an option from the shortcut menu. See “Changing the 

Button Order” on page 264 for more information.

Note:  Text objects, drop zones, and buttons are included in the same priority list; a text 
object can have a higher priority, and thus cover up, a button or drop zone.

Adding Audio to a Menu
All menus created with the standard method, including menus with still backgrounds, 
can have one or more associated audio files. Adding audio to a menu can be an easy 
way to make it more engaging. The audio can come from files created specifically for 
this purpose, portions of the soundtrack, or from an audio library. The Apple audio 
applications Soundtrack and GarageBand are both great for creating high quality 
background audio.

If you assign a video asset to the menu’s background by dragging it to the Menu Editor, 
DVD Studio Pro can automatically assign its companion audio file (with the same base 
name and in the same folder) to the menu. The “Find matching audio when dragging” 
setting in the Track pane of DVD Studio Pro Preferences controls whether or not the 
audio is assigned. See “Track Preferences” on page 116 for more information.

You can also manually assign an audio file to a menu.
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To assign an audio file to a menu, do one of the following:
m Drag an audio file to the Menu Editor, then choose Set Audio or Add to Existing Audio 

from the Drop Palette.
m Click the General tab in the Menu Inspector, then do one of the following:

• Drag an audio file to the Audio Filename area. 
• Click the Add (+) button and select the audio file from the file selection dialog.

In addition to adding audio files to your menu, you can use the General tab in the 
Menu Inspector to set the order of the audio files and to remove them from the menu.

To manage the audio files assigned to a menu:
m To set the order of the audio files, drag them in the file list.
m To remove audio files, select them and click the Delete (–) button.

To hear the audio:
m Click the Motion button in the Menu Editor. If there is a still image as the menu’s 

background, you can use the motion settings in the Menu Inspector’s General tab to 
set the start and end points of the audio.

See “Configuring Motion Menu Settings” on page 282 for information on how the audio 
interacts with any video clips assigned to the menu, including when looping is enabled.

Configuring Drop Shadow and Motion Settings
Once you have added most of the items to your menu, you can configure its drop 
shadow settings and determine how the menu will work with any motion assets 
assigned to it.

Configuring the Menu’s Drop Shadow
Each standard menu can have a drop shadow that can be shared by button text, 
shapes, drop zones, and text objects. You configure the drop shadow in the Advanced 
tab in the Menu Inspector and then enable it in the Inspector for each button text, 
shape, drop zone, and text object you want it applied to. 



Chapter 7    Creating Menus Using the Standard Method 281

 

Enabling Drop Shadows
Enabling the drop shadows on a menu is a two-step process:  Enable drop shadows for 
each menu item you want to apply them to, and then configure the menu’s drop 
shadow settings. This allows you to see the effect of the menu settings on all of the 
items at once.

To enable the drop shadow:
1 Select a menu item that supports drop shadows (button text, button shapes, drop zone 

shapes, or text objects). 

2 In that item’s Inspector, click the Shadow checkbox to enable it.

3 Click an empty part of the menu in the Menu Editor so the Menu Inspector appears.

4 Click the Menu Inspector’s Menu tab. The drop shadow settings appear along the 
bottom part of the tab.

5 Configure the drop shadow settings. (Keep in mind that the drop shadows only appear 
on items that have been enabled.) See “Setting the Drop Shadow Properties” on 
page 281 for more information.

Setting the Drop Shadow Properties
Once you have enabled drop shadows on one or more menu items, you can start 
adjusting the drop shadow settings.

Note:  You will not see the drop shadow if any of the settings are at 0.0.

• Angle:  A rotary control that sets the direction of the drop shadow. The control’s 
indicator points in the drop shadow’s direction. Rotate the indicator to the desired 
direction. You can also enter an angle value. A value of 0 places the shadow directly 
above the item; 90 places it to the right.

• Alpha:  Sets the drop shadow’s transparency. A value of 0.0 makes the drop shadow 
completely transparent while a value of 1.0 makes it completely opaque.

• Diffusion:  Sets the drop shadow’s softness. Smaller numbers provide harder edges 
while larger numbers (up to a maximum of 15.0) provide softer edges.

• Distance:  Sets the distance of the drop shadow from the item. Smaller numbers 
position the drop shadow closer while larger numbers (up to a maximum of 15.0) 
position it farther away.

• Colored rectangle:  Sets the color of the drop shadow. Click it to open the Colors 
window where you can choose the color to use.
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Configuring Motion Menu Settings
There are several parts of a standard menu that can include an asset with motion or a 
time setting:
• The menu’s background
• The menu’s audio
• Buttons
• Drop zones

A motion menu can have anywhere from one to all four of these motion items. The 
items it contains determine how they will interact.

About Motion Menu Playback
The Menu Editor contains a motion menu start/stop button. 

Clicking the button starts motion menu playback. Clicking it a second time stops 
playback. You can also press Command-J to turn the playback on and off.

Note:  Unlike a similar button in iDVD, this button does not determine whether or not 
this menu is a motion menu. It only controls whether the motion menu plays while you 
are working on it. Once you add motion assets to a menu, it is a motion menu.

Note:  Depending on your system and the number of motion items in the menu, 
motion menu playback may not be perfectly smooth in the Menu Editor. Once you 
build your project, playback will be perfect.

About the Motion Settings
The Menu Inspector’s General tab contains a section for configuring a menu’s start, end, 
loop, and duration times.

You can drag the slider located under the thumbnail images of the background, click 
the arrow controls, or enter a timecode value for each of the entries. The way the Start, 
Loop Point, End, and Duration settings function depends on the type of assets assigned 
to the menu.
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Start Setting
You can use the Start setting to set the video’s starting frame. By default, the start is set 
to the background video’s first frame. If there is audio assigned to the menu, its start 
time is also moved by the same number of frames as the video. 

Note:  If there are other motion assets assigned to buttons or drop zones, they are not 
affected by the change in start time.

When the menu’s background is a still image, the Start setting only affects the 
menu’s audio.

Loop Point
You can use the Loop Point setting to set a frame different from the starting frame to 
use when you choose Loop as the At End setting. By default, the Loop setting is the 
same as the Start setting. When you adjust the Loop setting, you are choosing the 
frame that is jumped to once the end frame is reached. This allows you to have a 
looping background with a beginning section—for example, a fade up from black or a 
transition from another menu—that only plays the first time through. If there is audio 
assigned to the menu, it automatically follows the video as it loops.

This setting also defines when the button highlights appear—the viewer cannot 
navigate the menu’s buttons until the loop point is reached. Additionally, the Loop 
Point setting controls the video used for the menu’s tile in the Graphical tab.

If you are creating your menu background video in an application such as Motion or 
Final Cut Pro, you can set a chapter marker named “MenuLoopPoint” to define the loop 
point. When you assign a menu’s background by dragging the video to the Menu 
Editor and choosing Set Background from the Drop Palette, or dragging the video to 
the Outline or Graphical tab, DVD Studio Pro checks to see if a chapter marker named 
“MenuLoopPoint” is present. If it is, the Loop Point setting is set to its time. If it is not 
present, the Loop Point setting is set to match the Start setting.

Note:  When you assign the menu’s background using the Menu Inspector’s 
Background pop-up menu, you must manually set the Loop Point setting, even if the 
video contains a “MenuLoopPoint” chapter marker.

See “Defining the Menu Loop Point” on page 92 for more information on setting the 
chapter markers.
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End Setting
You can use the End setting to set the menu’s ending frame. By default, this is set to 
the value entered in the Menu pane in DVD Studio Pro Preferences if the menu has any 
motion assets. You can adjust it to be shorter or longer. This is most useful when you 
do not want to use the entire video background asset—when used along with the 
Start setting, you can choose the specific part of the video to use.
• When using the slider, its maximum setting matches the length of the menu’s 

background video. If the background is a still image, the slider maximum setting 
matches the longest of the other menu assets (audio or assets assigned to buttons 
and drop zones).

• When using the numeric timecode entry, you are able to choose any length. 

When the end is reached during playback, either all assets stop and display their last 
frame as a still image (At End set to Still), or the playback jumps to the Loop, if 
available, or Start setting. 

If any assets assigned to the menu reach their end before the menu reaches the End 
setting, they are looped back to their start to keep playing. 

Duration Setting
You can use the Duration setting to set the menu’s duration. It is equal to the End setting 
minus the Start setting. If you enter a value, the End setting automatically updates. 

About Jumping Directly to a Menu’s Loop Point
When you configure a motion menu with a loop point, you may find that, in some 
cases, you would prefer to jump directly to the loop point rather than to the start 
point. This is especially true if the menu has a long period between the start and loop 
points. 

You can write a simple script that will allow you to jump to the loop point. When you 
select Jump as the command in the Script Inspector and choose a menu to jump to, a 
Start At Loop Point option becomes available. When selected, this option sets the 
jump to skip the start point and jump directly to the loop point. See “Start At Loop 
Point Checkbox” on page 485 for more information, and “Jumping to a Menu’s Loop 
Point” on page 509 for an example script.
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Options in the Drop Palette for Standard Menus
Following are descriptions of the various Drop Palette options that can appear when 
you drag an asset or element to the Menu Editor. See “Viewing the Drop Palette” on 
page 220 for information on using the Drop Palette options.

The following descriptions are grouped by the type of item you are dragging (asset, 
project element such as a track or slideshow, and a template, style, or shape from the 
Palette). Details for standard menus are listed first, followed by the details for the 
layered menus. 

For those Drop Palette options that appear when you drag a motion video asset, a 
matching audio asset is also added (if applicable), as long as:

• The “Find matching audio when dragging” setting in the Track pane of 
DVD Studio Pro Preferences is selected.

• An audio file with the same base name as the video file is located in the same folder 
as the video asset.

The following details assume the “Find matching audio when dragging” preference is 
selected and a suitable audio file is found.

Drop Palette for Standard Menus—Dragging Assets
The following sections list the choices in the Drop Palette that appear when you drag 
assets to an empty area, button, or drop zone on a standard menu.

Dragging a Motion Video Asset to an Empty Area
The following options appear in the Drop Palette:

Set Background
The default action. 
• Uses the video as this menu’s background.
• Assigns matching audio as the menu’s audio.

Create Button and Track
• Creates a button at this menu location.
• Assigns this video to the button’s thumbnail.
• Creates a new track with this video.
• Assigns matching audio as the track’s audio.
• Names the track the same as the video asset.
• Adds a link from the new button to the first marker of the new track. 
• Sets the new track’s End Jump setting to this menu.
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Create Button 
• Creates a button at this menu location.
• Assigns this video to the button’s thumbnail, creating a motion button. 

This option does not create a track or link the button to anything.

Create Drop Zone
• Creates a drop zone at this menu location.
• Assigns this video to the drop zone.

Create Button and Chapter Index 
Use this option with video that has had chapter markers added with Compressor, 
Final Cut Express, Final Cut Pro, or iMovie.

Note:  If the menu contains no buttons, drop zones, or text objects, then this option 
changes to Create Chapter Index. Instead of creating a separate menu as the first chapter 
index menu, this menu is used. Additional chapter index menus are created if necessary.

• Creates a track and adds the chapter markers to it.
• Assigns matching audio as the track’s audio.
• Names the track the same as the video asset.
• Sets the new track’s End Jump setting to this menu.
• Creates a button on this menu to link to the first of the new chapter index menus.
• Creates one or more new chapter index menus, depending on the number of 

markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the new track to buttons in the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 

Dragging a Motion Video Asset to a Button
The following options appear in the Drop Palette:

Set Asset
The default action. 
• Sets this video to be the button’s thumbnail image. 

This option does not create a track or link the button to anything.

Set Asset and Create Track
• Assigns this video to the button’s thumbnail.
• Creates a new track with this video.
• Assigns matching audio as the track’s audio.
• Names the track the same as the video asset.
• Adds a link from the button to the first marker of the new track.
• Sets the new track’s End Jump setting to this menu.
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Create Track
• Creates a new track with this video.
• Assigns matching audio as the track’s audio.
• Names the track the same as the video asset.
• Adds a link from the button to the first marker of the new track. 

The button’s thumbnail image does not change.

Set Asset and Create Chapter Index
Use this option with video that has had chapter markers added with Compressor, 
Final Cut Express, Final Cut Pro, or iMovie.
• Creates a track and adds the chapter markers to it.
• Assigns matching audio as the track’s audio.
• Names the track the same as the video asset.
• Sets the new track’s End Jump setting to this menu.
• Links the button to the first of the new chapter index menus.
• Sets this video to be the button’s thumbnail image. 
• Creates one or more new chapter index menus, depending on the number of 

markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the new track to buttons in the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 

Create Chapter Index
Use this option with video that has had chapter markers added with Compressor, 
Final Cut Express, Final Cut Pro, or iMovie.
• Creates a track and adds the chapter markers to it.
• Assigns matching audio as the track’s audio.
• Names the track the same as the video asset.
• Sets the new track’s End Jump setting to this menu.
• Links the button to the first of the new chapter index menus.
• Creates one or more new chapter index menus, depending on the number of 

markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the new track to buttons in the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 
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Dragging a Motion Video Asset to a Drop Zone
The following options appear in the Drop Palette:

Set Asset
The default action.
• Sets this video to be the drop zone’s asset. 

Create Button and Track
• Creates a button on top of the drop zone.
• Assigns this video to the button’s thumbnail.
• Creates a new track with this video.
• Assigns matching audio as the track’s audio.
• Names the track the same as the video asset.
• Adds a link from the new button to the first marker of the new track. 
• Sets the new track’s End Jump setting to this menu.

The drop zone is unaffected.

Dragging Multiple Motion Video Assets to an Empty Area
The following options appear in the Drop Palette:

Create Buttons and Tracks 
The default action. For each video asset: 
• Creates a button. 
• Assigns each video as its button’s asset. 
• Creates new tracks.
• Assigns matching audio as each track’s audio.
• Names each track the same as their video asset.
• Sets each new track’s End Jump setting to this menu.
• Adds links from the new buttons to the first marker of the new tracks.

Create Buttons
• Creates a button for each video asset.
• Assigns each video as its button’s asset.

This option does not create any tracks or link the buttons to anything. 

Dragging One or More Audio Assets to an Empty Area
The following options appear in the Drop Palette:

Set Audio
The default action. 
• Assigns this audio as the menu’s audio.

Add to Existing Audio
• Adds this audio to the existing audio assets assigned to this menu.
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Dragging a Video/Audio Pair to an Empty Area
The following options appear in the Drop Palette:

Set Background and Audio
The default action.
• Sets this video to be the menu’s background.
• Sets this audio to be the menu’s audio.

Create Button and Track
• Creates a button at this menu location.
• Assigns this video to the button’s thumbnail.
• Creates a new track with this video and audio.
• Names the track the same as the video asset.
• Adds a link from the new button to the first marker of the new track.
• Sets the new track’s End Jump setting to this menu.

Create Button and Chapter Index
Use this option with video that has had chapter markers added with Compressor, 
Final Cut Express, Final Cut Pro, or iMovie.

Note:  If the menu contains no buttons, drop zones, or text objects, then this option 
changes to Create Chapter Index. Instead of creating a separate menu as the first chapter 
index menu, this menu is used. Additional chapter index menus are created if necessary.

• Creates a track and adds the chapter markers and audio to it.
• Names the track the same as the video asset.
• Sets the new track’s End Jump setting to this menu.
• Creates a button on this menu to link to the first of the new chapter index menus.
• Creates one or more new chapter index menus, depending on the number of 

markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the new track to buttons in the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 

Dragging a Video/Audio Pair to a Button
The following options appear in the Drop Palette:

Set Asset and Create Track
The default action. 
• Sets this video to be the button’s thumbnail image.
• Creates a new track with this video and audio.
• Names the track the same as the video asset.
• Adds a link from the button to the first marker of the new track.
• Sets the new track’s End Jump setting to this menu.
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Create Track
• Creates a new track with this video.
• Names the track the same as the video asset.
• Adds a link from the button to the first marker of the new track. 

The button’s thumbnail does not change.

Set Asset and Create Chapter Index
Use this option with video that has had chapter markers added with Compressor, 
Final Cut Express, Final Cut Pro, or iMovie.
• Creates a track and adds the chapter markers and audio to it.
• Names the track the same as the video asset.
• Sets the new track’s End Jump setting to this menu.
• Links the button to the first of the new chapter index menus.
• Sets this video to be the button’s thumbnail image.
• Creates one or more new chapter index menus, depending on the number of 

markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the new track to buttons in the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail.

Create Chapter Index
Use this option with video that has had chapter markers added with Compressor, 
Final Cut Express, Final Cut Pro, or iMovie.
• Creates a track and adds the chapter markers and audio to it.
• Names the track the same as the video asset.
• Sets the new track’s End Jump setting to this menu.
• Links the button to the first of the new chapter index menus.
• Creates one or more new chapter index menus, depending on the number of 

markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the new track to buttons in the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 
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Dragging a Still Picture to an Empty Area
The following options appear in the Drop Palette:

Set Background
The default action. 
• Uses the picture as this menu’s background.

Set Overlay
• Uses the picture as this menu’s overlay.

Create Button
• Creates a button at this menu location and assigns this picture to its thumbnail. 

This option does not create a new menu or link the button to anything.

Create Drop Zone
• Creates a drop zone at this menu location and assigns this picture to it.

Create Submenu
• Creates a button at this menu location.
• Assigns this picture to the button’s thumbnail.
• Creates a new menu with this picture as the background.
• Adds a link from the new button to the new menu.

Dragging a Still Picture to a Button
The following options appear in the Drop Palette:

Set Asset
The default action. 
• Sets this picture to be the button’s thumbnail image. 

This option does not create a menu or link the button to anything.

Set Asset and Create Submenu
• Sets this picture to be the button’s thumbnail image.
• Creates a new menu with this picture as the background.
• Adds a link from the button to the new menu.

Create Submenu
• Creates a new menu with this picture as the background.
• Adds a link from the new button to the new menu. 

The button’s thumbnail does not change.
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Dragging a Still Picture to a Drop Zone
The following options appear in the Drop Palette:

Set Asset
The default action. 
• Sets this picture to be the drop zone’s asset. 

Create Button
• Creates a button on top of the drop zone and assigns this picture to its thumbnail. 

This option does not create a new menu or link the button to anything. The drop zone 
is unaffected.

Dragging Multiple Still Pictures (or a Folder) to an Empty Area
The following options appear in the Drop Palette:

Create Button and Slideshow
The default action. This is the only action available if you drag a folder to an empty area 
(uses only the still pictures of the folder’s first level).
• Creates a button with the first picture assigned as its thumbnail image.
• Creates a new slideshow.
• Adds a link from the new button to the new slideshow.
• Sets the slideshow’s End Jump setting to this menu.

Create Buttons 
• Creates a button for each picture, and assigns each picture as its thumbnail. 

This option does not create any menus or link the buttons to anything. 

Create Submenus 
• Creates a button for each picture. 
• Assigns each picture as its button’s asset. 
• Creates new menus with each picture as their backgrounds.
• Adds a link from the new buttons to the new menus. 
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Dragging Multiple Still Pictures (or a Folder) to a Button
The following options appear in the Drop Palette:

Set Asset and Create Slideshow
The default action. 
• Sets the button’s thumbnail to the first picture.
• Creates a new slideshow.
• Adds a link from the button to the new slideshow.
• Sets the slideshow’s End Jump setting to this menu.

Create Slideshow
• Creates a new slideshow.
• Adds a link from the button to the new slideshow. 
• Sets the slideshow’s End Jump setting to this menu.

The button’s thumbnail image does not change.

Dragging a Multiple-Layer Still Picture to an Empty Area
The following options appear in the Drop Palette:

Set Background—All Layers Visible
The default action. 
• Uses the picture as this menu’s background, with all layers visible.

Once set, you can disable layers in the Menu Inspector.

Set Background—No Layers Visible
• Uses the picture as this menu’s background, with no layers visible.

Once set, you can enable layers in the Menu Inspector.

Set Overlay
• Uses the picture as this menu’s overlay, with no layers assigned to the overlay.

Once set, you can select the layer to use as the overlay in the Menu Inspector.

Create Button
• Creates a button at this menu location and assigns this picture to its thumbnail, 

using the layers left visible by the graphics application. 

This option does not create a new menu or link the button to anything. You cannot 
select the layers to show—because they are composited together.
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Create Standard Submenu
• Creates a button at this menu location.
• Assigns this picture to the button’s thumbnail, using the layers left visible by the 

graphics application.
• Creates a new standard menu with this picture as the background, with all layers visible.
• Adds a link from the new button to the new menu.

Once set, you can disable layers for the new menu in the Menu Inspector.

Create Layered Submenu
• Creates a button at this menu location.
• Assigns this picture to the button’s thumbnail, using the layers left visible by the 

graphics application.
• Creates a new layered menu with this picture as the background, with all layers visible.
• Adds a link from the new button to the new menu.

Once set, you can disable layers for the new menu in the Menu Inspector.

Drop Palette for Standard Menus—
Dragging Project Elements
The following sections list the choices in the Drop Palette that appear when you drag 
project elements from the Outline or Graphical tab to an empty area or a button on a 
standard menu.

Dragging an Existing Track to an Empty Area
The following options appear in the Drop Palette:

Create Button
The default action. 
• Creates a button at this menu location.
• Assigns the video from the first video clip of stream 1 to the new button’s thumbnail.
• Adds a link from the new button to the first marker of the track.
• Sets the track’s End Jump setting to this menu (if it has not already been set).



Chapter 7    Creating Menus Using the Standard Method 295

 

Create Button and Chapter Index

Note:  If the menu contains no buttons, drop zones, or text objects, then this option 
changes to Create Chapter Index. Instead of creating a separate menu as the first chapter 
index menu, this menu is used. Additional chapter index menus are created if necessary.

• Creates a button on this menu to link to the first of the new chapter index menus.
• Creates one or more new chapter index menus, depending on the number of 

markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the track to buttons on the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 
• Sets the track’s End Jump setting to this menu (if it has not already been set).

Dragging an Existing Track to a Button
The following options appear in the Drop Palette:

Set Asset
The default action. 
• Sets the video from the first video clip of stream 1 to be the button’s thumbnail image.
• Adds a link from the button to the first marker of the track.
• Sets the track’s End Jump setting to this menu (if it has not already been set).

Connect to Track
• Adds a link from the button to the first marker of the track. 
• Sets the track’s End Jump setting to this menu (if it has not already been set).

The button’s thumbnail does not change.

Set Asset and Create Chapter Index
• Links the button to the first of the new chapter index menus.
• Sets this track to be the button’s thumbnail image.
• Creates one or more new chapter index menus, depending on the number of 

markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the track to buttons on the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 
• Sets the track’s End Jump setting to this menu (if it has not already been set).
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Create Chapter Index 
• Links the button to the first of the new chapter index menus.
• Creates one or more new chapter index menus, depending on the number of 

markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the track to buttons on the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 
• Sets the track’s End Jump setting to this menu (if it has not already been set).

Dragging Multiple Existing Tracks to an Empty Area
The following options appear in the Drop Palette:

Create Buttons
The default action. 
• For each track, creates a button.
• Assigns each track as its button’s asset. 
• Adds a link from the new buttons to the first marker of the tracks. 
• Sets each track’s End Jump setting to this menu (if it has not already been set).

Dragging an Existing Story to an Empty Area
The following option appears in the Drop Palette:

Create Button
The default action. 
• Creates a button at this menu location.
• Assigns the video from the story’s first video clip to the new button’s thumbnail.
• Adds a link from the new button to the story’s first video clip.
• Sets the story’s End Jump setting to this menu (if it has not already been set).

Dragging an Existing Story to a Button
The following options appear in the Drop Palette:

Set Asset
The default action. 
• Sets the video from the story’s first video clip to be the button’s thumbnail image.
• Adds a link from the button to the story’s first video clip.
• Sets the story’s End Jump setting to this menu (if it has not already been set).

Connect to Story
• Adds a link from the button to the story’s first video clip. 
• Sets the story’s End Jump setting to this menu (if it has not already been set).

The button’s thumbnail does not change.
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Dragging Multiple Existing Stories to an Empty Area
The following option appears in the Drop Palette:

Create Buttons
The default action. 
• For each story, creates a button.
• Assigns each story as its button’s asset.
• Adds a link from the new buttons to each story’s first video clip. 
• Sets each story’s End Jump setting to this menu (if it has not already been set).

Dragging a Slideshow to an Empty Area
The following options appear in the Drop Palette:

Create Button
The default action.
• Creates a button at this menu location.
• Assigns the first slide to its thumbnail.
• Adds a link from the new button to the slideshow.
• Sets the slideshow’s End Jump setting to this menu (if it has not already been set).

Create Button and Chapter Index

Note:  If the menu contains no buttons, drop zones, or text objects, then this option 
changes to Create Chapter Index. Instead of creating a separate menu as the first chapter 
index menu, this menu is used. Additional chapter index menus are created if necessary.

• Creates a button on this menu to link to the first of the new chapter index menus.
• Creates one or more new chapter index menus, depending on the number of slides 

and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each slide from the slideshow to buttons in the chapter index menus.
• Assigns the picture from each slide to its button’s thumbnail. 
• Sets the slideshow’s End Jump setting to this menu (if it has not already been set).

Dragging a Slideshow to a Button
The following options appear in the Drop Palette:

Set Asset
The default action. 
• Sets the first slide’s image to be the button’s thumbnail.
• Adds a link from the button to the slideshow.
• Sets the slideshow’s End Jump setting to this menu (if it has not already been set).
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Connect to Slideshow 
• Adds a link from the button to the slideshow. 
• Sets the slideshow’s End Jump setting to this menu (if it has not already been set).

The button’s thumbnail does not change.

Create Chapter Index 
• Links the button to the first of the new chapter index menus.
• Creates one or more new chapter index menus, depending on the number of slides 

and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each slide from the slideshow to buttons in the chapter index menus.
• Assigns the picture from each slide to its button’s thumbnail. 
• Sets the slideshow’s End Jump setting to this menu (if it has not already been set).

Dragging Multiple Slideshows to an Empty Area
The following option appears in the Drop Palette:

Create Buttons
The default action.
• Creates a button for each slideshow.
• Assigns each slideshow as its button’s asset.
• Adds a link from the new buttons to the slideshows. 
• Sets each slideshow’s End Jump setting to this menu (if they have not already been set).

Dragging a Menu to an Empty Area
The following option appears in the Drop Palette:

Create Button 
The default action.
• Creates a button at this menu location.
• Assigns the menu’s background as the button’s thumbnail.
• Adds a link from the new button to the menu.

Dragging a Menu to a Button
The following options appear in the Drop Palette:

Set Asset
The default action. 
• Sets the menu’s background to be the button’s thumbnail.
• Adds a link from the button to the menu.

Connect to Menu 
• Adds a link from the button to the menu. 

The button’s thumbnail does not change.
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Dragging a Script to an Empty Area
The following option appears in the Drop Palette:

Create Button
The default action.
• Creates a button at this menu location.
• Adds a link from the new button to the script.

Dragging a Script to a Button
The following option appears in the Drop Palette:

Connect to Script
The default action.
• Adds a link from the button to the script.

Drop Palette for Standard Menus—Dragging Templates 
and Styles
The following sections list the choices in the Drop Palette that appear when you drag 
templates and styles from the Palette to an empty area or a button on a standard menu.

Dragging a Shape to an Empty Area
The following options appear in the Drop Palette:

Create Button
The default action.
• Creates a button at this menu location.
• Assigns this shape to the button.

Create Drop Zone
• Creates a drop zone at this menu location.
• Assigns this shape to the drop zone.

Dragging a Shape to a Button or Drop Zone
The following options appear in the Drop Palette:

Set Shape
The default action.
• Assigns this shape to the button or drop zone.

Create Button
Only available when dragging to a drop zone.
• Creates a button on top of the drop zone.
• Assigns this shape to the button.

The drop zone is unaffected.
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Dragging a Template to an Empty Area
The following options appear in the Drop Palette:

Apply to Menu
The default action.
• Template buttons are only applied to existing buttons (no new buttons are created). 

Note:  An exception is if the menu has no buttons, in which case all buttons from the 
template will be added. 

Apply to Menu—Add All Buttons
• Template buttons are all applied, replacing existing buttons and adding new ones 

(if necessary).

Create Submenu
• Creates a button at this menu location.
• Assigns this template’s background to the button’s thumbnail.
• Creates a new standard menu with this template.
• Adds a link from the new button to the new menu.

Dragging a Template to a Button
The following option appears in the Drop Palette:

Create Submenu and Apply Template
The default action.
• Creates a new standard menu with this template.
• Adds a link from the button to the new menu.

Dragging a Button Style to an Empty Area
The following options appear in the Drop Palette:

Create Button
The default action.
• Creates a button at this menu location.
• Assigns this style to the button.

Create Button—Set Default Button Style
• Creates a button at this menu location.
• Assigns this style to the button.
• Assigns this style as the default button style for this menu.

Set Default Button Style
• Assigns this style as the default button style for this menu.

No button is created.
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Dragging a Button Style to a Button
The following option appears in the Drop Palette:

Apply to Button
The default action.
• Applies this button style to the button.

Dragging a Text Style to an Empty Area
The following options appear in the Drop Palette:

Create Text Object
The default action.
• Creates a text object at this menu location.
• Assigns this style to the text object.

Create Text Object—Set Default Text Style
• Creates a text object at this menu location.
• Assigns this style to the text object.
• Assigns this style as the default text style for this menu.

Set Default Text Style
• Assigns this style as the default text style for this menu.

No text object is created.

Dragging a Text Style to a Text Object
The following option appears in the Drop Palette:

Apply to Text Object
The default action.
• Assigns this style to the text object.

Dragging a Drop Zone Style to an Empty Area
The following option appears in the Drop Palette:

Create Drop Zone
The default action.
• Creates a drop zone at this menu location.
• Assigns this style to the drop zone.
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Dragging a Drop Zone Style to a Drop Zone
The following option appears in the Drop Palette:

Apply to Drop Zone
The default action.
• Assigns this style to the drop zone.

Dragging a Layout Style to the Menu Editor
The following options appear in the Drop Palette:

Apply to Menu
The default action.
• Layout style buttons are only applied to existing buttons (no new buttons are created).

Note:  An exception is if the menu has no buttons, in which case all buttons from the 
layout style will be added. 

Apply to Menu—Add All Buttons
• Layout style buttons are all applied, replacing existing buttons and adding new ones 

(if necessary).
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8 Using Templates, Styles, 
and Shapes to Create Your Menus

DVD Studio Pro includes templates and styles that can 
make it easier to create menus. You can use the supplied 
templates and styles to quickly produce your menus, or 
you can make your own templates and styles.

DVD Studio Pro includes templates and styles that are designed to make the menu 
creation process quicker and easier. By applying a template or style to all menus in a 
project, you can create a cohesive, consistent look for your project.

• You can use the supplied templates and styles to create your menus. Use a template 
to supply everything needed for a menu, or choose certain styles to use in 
combination with menus you create.

• You can create your own templates and styles. This makes it easy to create a 
consistent look to apply to all of your menus that meets your specific needs. 

DVD Studio Pro also includes a shapes feature that allows you to add buttons to your 
menu that include the art and highlight areas. The shapes can also be used to create drop 
zones with irregular edges. See “Managing Shapes” on page 317 for more information.

What Are Templates and Styles?
Templates and styles both contain properties, such as background assets, button 
highlights, and text colors, that you use to create a menu. While templates cover all 
aspects of a menu, styles are targeted to specific areas. Applying a template to a menu 
can result in a mostly finished menu—you may only need to link the buttons. With 
styles, you generally work with an existing menu, and then use the styles to change 
specific areas such as a button’s shape or a text object’s font. 

In addition to the supplied templates and styles, you can create your own. You can 
import and use these templates and styles in many different projects.

Each template and style can be self-contained, including the actual assets used in the 
template or style, such as backgrounds, audio files, and shapes. Or, they can reference 
assets located in a folder on your hard disk.
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Note:  Templates and styles are in either PAL or NTSC format. You cannot use a template 
or style created using NTSC assets in a PAL project. The Palette only shows templates 
and styles that are compatible with the current project’s video standard. Additionally, 
templates using HD-specific resolutions (such as 1280 x 720p) or HD-specific video 
formats (HDV or H.264) cannot be imported into SD projects. 

Templates and Styles in the Palette
Templates and styles are contained in the Palette’s first two tabs.

See “Managing Shapes” on page 317 for information on the Shapes tab, and “Media 
Tabs” on page 157 for information on the Audio, Stills, and Video tabs.

You can choose either small or large as the size for the thumbnails that appear in the 
Palette in the General pane of DVD Studio Pro Preferences. See “General Preferences” 
on page 114 for more information on the preferences.

Template Intro Movies
The DVD Studio Pro installation disc includes several video assets that are intended to 
be used as menu intro files for specific supplied templates. These assets can be used 
to provide a smooth transition when a menu is selected that uses the associated 
template. See the “About Template Intro Movies” file, located in the Template Intro 
Movies folder on the installation disc for more information. Also see “Using Menu 
Intro Clips” on page 345.

Click to select the 
group of templates 
or styles to display.
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Template and Style Groups
To see the available templates and styles, you click the buttons at the top of the tabs. 
There are three choices for templates and four for styles:
• Apple:  The templates and styles provided by DVD Studio Pro. These are available to 

all projects.
• Custom:  The templates and styles you create and do not designate as “Project.” These 

are available to all projects.
• Project:  The templates and styles you create for use only in a specific project. These 

will not appear when working on other projects.

Note:  You must have saved your project before you can create a template or style 
belonging to the project group.

• Current:  For styles only, these are the styles that have been linked to the template 
assigned to the current menu. See “Linking Styles to Templates” on page 306 for 
more information.

Style Types
In addition to the style group you select, when you click the Styles tab in the Palette, 
you also need to select the type of style.

There are four style types you can choose from:

• Buttons:  Contains almost all settings (except navigation and jump settings) from the 
Button Inspector.

• Text:  Contains the font, size, color, rotation, and default text.
• Drop Zones:  Contains details about drop zones. 
• Layouts:  Contains locations, sizes, shapes, and other attributes of one or more 

buttons on a menu.

Click to select the 
style type to display.
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Linking Styles to Templates
You can link, or associate, styles to templates. That way, if you apply a template to a 
menu and then want to use a different button style on one of the buttons, you can 
choose to see only those button styles that have been linked to that template. This 
makes it easier to create menus based on families of templates and styles, helping you 
maintain a consistent look while creating a project.

Once you have applied a template to a menu, you can see which styles are linked to 
that template by selecting the Current view in the Styles tab in the Palette. When you 
select a style type (buttons, text, layouts, or drop zones), only the styles linked to that 
menu appear.

Note:  You can only link the styles you create to templates. The supplied Apple styles 
are already linked to the Apple templates.

To link a style to a template:
1 Control-click a style, then choose Link to Templates from the shortcut menu. 

A selection dialog that lists all templates appears.

2 Select the checkbox next to all templates that you want to link this style to.

Since menus keep track of the last template applied to them, you can open a menu at 
any time and, by selecting the Current view in the Styles tab, see those styles linked to 
the menu’s template.

Note:  If no template is applied to the menu, or no styles have been linked to the 
template, no styles appear when the Current view is selected.

About Template and Style Properties
Properties define the look and content of templates and styles. For example, properties 
define what kind of menu background a template has, how many buttons a layout 
style has, and where the buttons are located on the menu. Not all templates and styles 
need to use all of the properties available to them. For example, you can create a set of 
templates that have no menu background—when they are applied to an existing 
menu, the menu’s current background is maintained while other template properties, 
such as groups of buttons and text objects, are added to the menu.
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A template contains the properties of each of the four styles plus some additional 
properties. The following property list is grouped by style, with an additional group of 
properties applying only to templates. 

Button Style Properties
Button styles and all buttons in a template contain the following properties. Templates 
also contain the following properties as the default button style, used when a Drop 
Palette action requires new buttons to be created on the menu. See “Setting Default 
Styles” on page 312 for information on setting a default button style.
• Size:  The width and height of the button’s active area 
• Asset:  The asset file assigned to the button and the timecode setting below the 

thumbnail. When a button style is applied to an existing button, this asset only 
appears if the existing button does not already have an asset assigned.

• Motion:  Whether or not motion has been enabled for the asset
• Shape:  The shape file assigned to the button 
• Shadow:  Whether or not the menu’s drop shadow has been enabled for the shape 
• Color Set:  Which of the three highlight sets the button uses
• Auto Action:  Whether or not Auto Action has been enabled for the button 
• Invisible:  Whether or not the button has been set to be invisible
• Default Text:  The actual text that the button uses. When a button style is applied to an 

existing button, this text only appears if the existing button does not already have text.
• Font:  The font’s name and size used for the button text
• Text Color:  The text’s color
• Text Position:  The text’s position on the button (top, left, right, center, or bottom)
• Text Offset:  The offset values for the text’s position
• Text Shadow:  Whether or not the menu’s drop shadow has been enabled for the text
• Text in Highlight:  Whether or not the text is included in the button’s highlight

Text Style Properties
Text styles and all text objects in a template contain the following properties. 
Templates also contain the following properties as the default text style, used when 
you double-click the menu background to create a text object. See “Setting Default 
Styles” on page 312 for information on setting a default text style.
• Default Text:  The actual text that the text object uses. This text does not appear when 

a text style is applied to an existing text object.
• Font:  The font’s name and size used for the text object
• Text Color:  The text’s color 
• Rotation:  The rotation setting used for the text object
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Drop Zone Style Properties
Drop zone styles contain the following properties. Templates contain the following 
properties for each of their drop zones.
• Size:  The width and height of the drop zone’s active area
• Asset:  The asset file assigned to the drop zone and the timecode setting below the 

thumbnail. When a drop zone style is applied to an existing drop zone, this asset only 
appears if the existing drop zone does not already have an asset assigned.

• Shape:  The shape file assigned to the drop zone
• Shadow:  Whether or not the menu’s drop shadow has been enabled for the drop zone 
• Rotation:  The rotation setting used for the drop zone
• Motion:  Whether or not motion has been enabled for the asset

Layout Style Properties
Layout styles and templates contain the following properties.
• Position/Size:  The position and size of all buttons in the layout 
• Button Assets:  The assets assigned to the buttons. This asset does not appear when a 

layout style is applied to a menu with buttons already containing assets. This asset 
only appears if the existing buttons do not already have an asset assigned.

• Button Shapes:  The shapes assigned to the buttons 
• Button Text:  The text assigned to the buttons. This text does not appear when a 

layout style is applied to a menu with buttons already containing text. This text only 
appears if the existing buttons do not already have text assigned.

• Default Button:  The button number of the button assigned as the default button. This 
is the button selected when the menu appears, unless the connection to the menu 
specified a different button. 

• Guides:  The guide configuration, including the number of guides and their positions

Other Template Properties
In addition to the button, text, drop zone, and layout style properties, templates 
contain the following properties:
• Default Button Style:  The default button style is used when a Drop Palette action 

requires new buttons to be created on the menu. See “Setting Default Styles” on 
page 312 for information on setting a default button style.

• Default Text Style:  The default text style is used when you double-click the menu 
background to create a text object. See “Setting Default Styles” on page 312 for 
information on setting a default text style.

• Background Asset:  The name of the asset assigned to the menu as the background
• Overlay:  The name of the asset assigned to the menu as the subpicture overlay
• Audio Asset:  The name of the audio asset assigned to the menu
• Drop Zones:  All drop zones added to the menu. Each drop zone includes its own settings. 
• Text Objects:  All text objects added to the menu. Each text object includes its own settings. 
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• Color:  The color mapping settings for the menu. These include the color and opacity 
assigned to each button state for each of the three color sets, as well as the Color 
Palette’s 16 colors. 

• Mapping Type:  Whether the menu uses the chroma or grayscale mapping type
• Motion:  The timecode values for the start, loop point, end, and duration settings, as 

well as the action for the menu’s end 
• Shadow:  The drop shadow settings that the buttons, text objects, and drop zones 

can use
• Display Mode:  Whether the menu uses a 4:3,16:9 Pan-Scan, 16:9 Letterbox, or 16:9 

Pan-Scan & Letterbox display mode 
• Resolution:  The video resolution of the video background
• Transitions:  All transitions assigned to the menu and its buttons

Applying a Template or Style
When you select a template or style in the Palette, it does not affect the menu until you 
click the Apply button. Before you click Apply, it is important to make sure that the 
Menu Editor is displaying the correct menu, and in the case of some of the styles, that 
the correct items in that menu are selected.

Note:  The Menu Editor always has a menu assigned to it, and it is that menu that 
templates and styles are applied to. Templates and styles can be applied to a menu 
even if you are working on a different element, such as a track. The Menu Editor does 
not even have to be visible. 

You do not need to select anything in the menu before applying templates or layout 
styles. These items can be applied to an existing menu or a new empty one. 

Important:  Applying a template to a menu changes the menu’s resolution and display 
mode to match the template (if they are different). Applying layout styles (or any of the 
other styles) does not change the menu’s resolution or display mode. In the case of 
layout styles, the layout is scaled to match the menu’s current resolution.

For the button, text, and drop zone styles, you can either select one or more items in an 
existing menu before applying the style, or you can drag the style to an item. Styles are 
applied only to selected items in an existing menu, so you can actually use multiple 
versions of these styles on a single menu. For example, if you want the buttons on a menu 
to use different shapes, you can set up several different styles to provide those shapes.

Note:  Applying a template or style to a menu is a one-time action—the menu does not 
become locked to the template or style. You can make changes to the menu just as if 
you had manually configured it. 
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Using the Palette’s Apply Button
The Palette includes an Apply button that you can use to apply the selected template 
or style to a menu. When applying button, text, or drop zone styles using the Apply 
button, the style is applied to all selected items at once. When dragging, you can only 
apply the style to one item.

To apply a template or style using the Apply button:
1 Make sure the Menu Editor is displaying the correct menu. 

2 In the case of the button, text, and drop zone styles, select the item on the menu to 
apply the style to.

3 Select the template or style to apply to the menu.

4 Click Apply.

The Apply button is unavailable if more than one template or style is selected. You can 
also apply a template or style by double-clicking it.

Dragging Templates and Styles to a Menu
In addition to the Palette’s Apply button, you can apply templates and styles by 
dragging them to the menu. The Menu Editor’s Drop Palette appears when you drag 
templates and styles to it. The Drop Palette provides options not available when using 
the Apply button. For example, you can drag a button style to an empty area of the 
Menu Editor and create a new button with it. With the Apply button, you need to select 
an existing button before the style can be applied.

The area to which you drag the template or style determines the options available to 
you. For example, if you drag a template to an empty part of the menu, you have the 
options of applying it to the menu, applying it to the menu and adding all buttons, and 
creating a submenu. If you drag a template to an existing button, your only option is to 
create a submenu and apply this template to it. See “Drop Palette for Standard 
Menus—Dragging Templates and Styles” on page 299 for a complete list of options.

To apply a template or style by dragging:
1 Make sure the Menu Editor is displaying the correct menu.

2 Select the template or style to apply to the menu and drag it to the Menu Editor. Be 
sure to drag it to an empty area or to an existing item, depending on how you want to 
apply the template or style.

If you select more than one item before dragging, only the item you actually drag gets 
applied to the menu—the others are ignored.
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Applying Templates or Layout Styles to a Menu With Buttons
When you apply a template or layout style to a menu that already has buttons, you are 
given the option of adding only enough buttons to replace the existing ones, or of 
adding all template or layout style buttons. If the menu has more buttons than the 
template or layout style, all buttons are added with the extra ones on the menu 
remaining unchanged.

When replacing existing buttons, DVD Studio Pro first looks at their names to see if 
they match the names of any buttons in the template or layout. If an existing button 
and a new button have the same name, the link and asset of the original button are 
copied to the new button. By carefully naming your buttons, you can apply one 
template after another to a menu and still maintain the original button settings. 

To be able to switch templates easily while using the templates and layout styles 
supplied with DVD Studio Pro, you need to name the buttons on your menus 
according to the button-naming convention used by DVD Studio Pro.

Button Naming in DVD Studio Pro Templates and Layout Styles
In the Apple templates and layout styles provided with DVD Studio Pro, button names 
fall into two categories:  general-purpose buttons and special-purpose buttons.

General-Purpose Buttons
General-purpose buttons use the DVD Studio Pro default naming structure for buttons, 
starting with “Button 1.”

Additionally, the Apple templates and layout styles can have assets and text assigned 
to each of the general-purpose buttons. When you create a chapter index menu, 
DVD Studio Pro checks each button to see if it has an asset assigned—if it does, the 
asset is changed to match the marker’s video. Similarly, if the button has text assigned, 
it is replaced with each marker’s name. 

Special-Purpose Buttons
Any buttons not intended to link to chapter markers have underscores before and after 
their names—this causes DVD Studio Pro to ignore them when assigning chapter 
markers to buttons. The Apple templates and layout styles include three of 
these:  _NEXT_ (to link to the next chapter index menu), _PREV_ (to link to the previous 
chapter index menu), and _UP_ to link to the original menu (if applicable). These three 
buttons automatically link to the appropriate menus when used to create a chapter 
index menu. 

See “About Chapter Index Menus” on page 226 for more information on chapter index 
menus. 
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Setting Default Styles
You can set a default button and text style for each menu. Additionally, you can choose 
a default text style for the entire project in DVD Studio Pro Preferences. 

DVD Studio Pro uses the default button style any time you drag an asset to the Menu 
Editor and choose an option from the Drop Palette that creates buttons. The default 
button style applies only to menus to which you’ve assigned it.

The default text style is used whenever you add a text object to any menu in a project. 
You can also set a default text style for each menu. The text style includes the font, its 
size, and its color. It can also include default text.

You can set the default button and text styles by dragging the style to the Menu Editor 
or using shortcut menus.

To set a button or text style as the menu default by dragging:
1 Select a button or text style in the Palette and drag it to the Menu Editor.

2 When the Drop Palette appears, choose Set Default Button (or Text) Style.

To set a button or text object as the menu default in the Palette:
m In the Palette, Control-click the button or text object you want to use as the default, 

then choose Set as Default from the shortcut menu.

To set a button or text object as the menu default in the Menu Editor:
m In the Menu Editor, Control-click the button or text object you want to use as the 

default, then choose Set as Default from the shortcut menu.

Additionally, you can set the default button and text styles for a menu when you apply 
a template.

See “Setting DVD Studio Pro Preferences” on page 112 for information on setting a 
default text style in DVD Studio Pro Preferences.
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Creating a Template or Style
While creating a template or style is not difficult, it is worth spending some planning 
time so that you can make the templates and styles as useful as possible.

To create a template or style:
1 Configure a standard menu to match what you want the template or style to be. If 

you’re creating a template or a layout style, use care to name the buttons and create 
them in the correct order. See “About Button Numbers” on page 264 and “General-
Purpose Buttons” on page 311 for details.

2 If you’re creating a button, text, or drop zone style, select the specific item on the menu 
whose settings you want to include in the style. For templates and layout styles, you do 
not need to select anything on the menu.

3 Do one of the following:

• Choose Project > Create in Menu > Template or Project > Create in Menu > Style.
• Click Create in the Palette. 

The Create Template or Create Style window opens.

4 Enter a name for the template or style.

5 Select the Project checkbox if you want the template or style to be available only to 
this project. Leaving this unselected makes this template or style available to all 
projects on this system.

6 Select the Self-Contained checkbox to copy the assets used by this template or style 
into its file. This makes it easier to copy the file to another system where it can be 
imported by another project.

7 Click Save.

The template or style is now saved and appears in the Palette. 

Select Self-Contained to copy the assets 
in this template or style to its file. Leave 
unselected to have the template or style 
reference the assets.

The thumbnail of the
template or style

Enter the name of the 
template or style.

Select Project to have this 
template or style available 
to only this project.
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About Self-Contained Templates and Styles
A template or style can use a surprising number of assets. Motion backgrounds and 
assets assigned to the button thumbnails can be very large files. In many cases, 
templates and styles you create that use motion assets will be specific to a particular 
project. In these cases, there is no reason to save them as self-contained. 

If you are creating a template or style and want to be sure it will always have the assets 
it requires, you can save it as self-contained. In this case, the assets are added to the 
template or style’s file. This makes it possible to copy the file to a different system and 
still have a working version of it. The drawback is that the file may be very large.

Locations of Template and Style Files 
Template and style files are placed in different locations based on whether or not they 
are project-exclusive. When you import template and style files, they are also copied to 
these locations.

Custom Template and Style Files
When you save a template that is not specific to a project, it is placed at the root of 
your disk, in this location:  /Library/Application Support/DVD Studio Pro/Templates. All 
template files have a “.dsptemplate” extension. 

Style files are placed at the same location, in a Styles folder:  /Library/Application 
Support/DVD Studio Pro/Styles. All style files have a “.dspstyle” extension, regardless of 
the type of style they are. To avoid confusion, be sure to indicate the style type when 
naming your style.

Project Template and Style Files
When you save a project template or style, it is added to the project bundle file (the file 
created when you save your project). Project templates and styles cannot be shared 
with other projects or systems. If you want to share them, you can add a menu to your 
project, apply the template or style to it, and then create a new template or style from 
the menu, setting it so that it is not specific to the project. This creates a new template 
or style file in the folders mentioned above.

Apple Template and Style Files
The Apple template and style files provided with DVD Studio Pro are in its application 
bundle file (the file used to open DVD Studio Pro). Since these are the same for all 
DVD Studio Pro systems, there is no reason to copy these to another system.

Naming Buttons in Your Templates and Styles
If you create a template or layout style, you should follow a consistent button-naming 
convention. This will allow you to apply different templates or styles, one after the 
other, without having to reconfigure your buttons. For information on the button-
naming conventions used in DVD Studio Pro templates and layout styles, see “Button 
Naming in DVD Studio Pro Templates and Layout Styles” on page 311.
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Importing Templates and Styles
You can import templates and styles from other systems. When you import a template 
or style, it is copied to the same locations used when you create a custom or project 
template or style. See “Locations of Template and Style Files” on page 314 for 
more information.

To import a template or style using the File menu:
1 Choose either File > Import > Style or File > Import > Template.

2 Use the import dialog to navigate to the templates or styles you want to import. You 
can select a single file or multiple files.

3 Select the Project checkbox if you want the template or style to be available to this 
project only. Deselecting Project makes this template or style available to all projects 
on this system.

4 Click Import to import the files.

To import a template or style using the Palette:
1 Click the Templates or Styles tab in the Palette. 

Note:  When importing a style, it is not necessary to select the proper style type 
(button, layout, and so on). All style types can be imported.

2 Control-click in the Palette’s thumbnail area, then choose Import from the shortcut menu. 

3 Use the import dialog to navigate to the templates or styles you want to import. You 
can select a single file or multiple files.

4 Select the Project checkbox if you want the template or style to be available to this 
project only. Deselecting Project makes this template or style available to all projects 
on this system.

5 Click Import to import the files.

The imported templates and styles appear in the Palette and are ready for use.

Will Imported Templates and Styles Work?
There are several factors that determine how well an imported template or style will 
work on your system.
• Templates and styles only work with the video standard (NTSC or PAL) of the system 

on which they were created. You cannot import templates and styles from one 
standard into the other.

• Self-contained templates and styles work on all systems using the same video 
standard, regardless of what assets they contain or how they are arranged. 

• Referencing templates and styles requires the assets to be in the same location on the 
new system as they were on the original system. Any assets that cannot be found when 
a template or style is applied are skipped, leaving those areas of the menu empty.
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Deleting Templates and Styles
You can delete templates and styles once you no longer need them. 

To delete a template or style:
1 Select the template or style to delete. You can select multiple items to delete.

2 Do one of the following:

• Click Delete at the bottom of the Palette.
• Control-click the item to be deleted, then choose Delete Selected Template or Delete 

Selected Style from the shortcut menu.

3 A dialog appears, warning that deleting this item may affect this and other projects. 
Click OK.

Note:  You cannot delete a template or style that contains assets currently in use on a menu. 

The template or style is deleted. 

Deleting Really Deletes
When you delete a template or style, the file is actually deleted from the disk. You 
cannot undo a deletion. This can be a serious issue if the template or style is self-
contained, since the assets used in the template or style are also deleted. Any projects 
that used the deleted template or style will no longer be able to access those assets, 
and you will need to relink their assets.

Deleting Apple Templates and Styles
You cannot delete the Apple templates supplied with DVD Studio Pro; however, you 
can delete the Apple styles. If you later decide you want to use the deleted styles, you 
must reinstall DVD Studio Pro to get them back.
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Managing Shapes
The Palette contains a Shapes tab. You can use this tab to view thumbnails of the 
shapes, drag the shapes to the Menu Editor to use them as buttons or drop zones, and 
import shapes that you have created.

You can choose either small or large as the size for the thumbnails in the Palette in the 
General pane in DVD Studio Pro Preferences. See “General Preferences” on page 114 for 
more information on the preferences. 

Two Types of Shapes
There are two types of shapes that are available:  normal and patches. You can create 
your own normal shapes; however, patches only come with DVD Studio Pro, and you 
cannot create your own.

What’s a Patch?
Patches are shapes that are able to modify the assigned asset. For example, a shape 
may add a tint or a blur filter to the assigned asset. Some patches have a motion 
element although most are static. Patches can be positioned and sized just like normal 
shapes, and have still or video assets assigned to them. 

Unlike normal shapes, you are not able to create custom patches.

Patches appear in the Apple group of the Shapes tab along with the normal shapes. 
You can tell which shapes are patches by choosing Patch Shapes in the Button 
Inspector’s Style tab.
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Applying a Shape
You can apply a shape to an existing button or drop zone (or group of buttons or drop 
zones) on a menu, or you can create a new button when you apply the shape. The 
method you use to apply the shape (use the Apply button or drag the shapes) 
determines what you are able to do.

Shapes are sorted into three groups:

• Apple:  The shapes provided by DVD Studio Pro. These are available to all projects.

Note:  Not all shapes supplied with DVD Studio Pro support highlights. Some are 
intended to be used only with drop zones, and do not include the highlight layer 
used by buttons.

• Custom:  The shapes you import and designate as available to all projects created on 
this system

• Project:  The shapes you import for use only in this project. These will not appear 
when working on other projects.

The Shapes tab in the Palette includes buttons so that you can choose which of these 
groups of shapes to view.

To apply a shape using the Apply button:
1 In the Palette, select the shape’s group (Apple, Custom, or Project), then select the 

shape you want to apply. 

2 In the Menu Editor, do one of the following:

• To apply the shape to an existing button or drop zone, select the button or drop zone.
• To apply the shape to a group of buttons or drop zones, select the buttons or drop 

zones by holding down the Shift key while clicking them.

3 Click Apply. 

The shape is applied to the selected items.

Note:  The Apply button is disabled if you select more than one shape in the Palette. 
You cannot create a new button or drop zone using the Apply button.
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To apply a shape by dragging:
1 In the Palette, select the shape’s group (Apple, Custom, or Project) so that the shape’s 

thumbnail appears.

2 Drag the shape from the Palette to the Menu Editor, then do one of the following:

• To apply the shape to an existing button or drop zone, drag the shape to it.
• To create a new button or drop zone, drag the shape to an empty area of the menu 

and when the Drop Palette appears, choose either Create Button or Create Drop Zone.

Note:  You cannot apply the shape to multiple existing buttons or drop zones by dragging.

To assign a shape in the Button Inspector:
1 In the Menu Editor, select the button to which you want to apply the shape.

2 Click the Style tab in the Button Inspector.

3 Choose a shape group from the Shape pop-up menu, then choose the shape to use 
from the submenu.

A thumbnail of the shape appears in the Button Inspector and the shape is applied to 
the button.

When you create a new button by dragging a shape to the Menu Editor, the shape is 
added to the menu at its actual size. This can be important if you intend your shapes to 
be a specific size when used on a menu. (When shapes are applied to an existing 
button, they are squeezed to fit it, which can distort it significantly.)
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Importing a Shape
You can import shapes that you create. See “Creating Shapes” on page 93 for 
information on creating shapes. 

When you import shapes, you choose whether they are specific to a project or shared. 

To import a shape:
1 Click Import in the Shape tab in the Palette.

2 In the selection dialog that appears, locate and select the shape (or shapes) to import.

3 Select the Project checkbox if you want the shapes to be used only with this project. 
Deselect the checkbox to make them available to all projects on this system.

4 Click Import.

The imported shapes now appear in their group (Project or Custom).

For custom shapes, the shape file is copied to the [root]/Library/Application Support/
DVD Studio Pro/Shapes folder. For project shapes, the shape is copied to the project 
bundle. (Apple shapes are contained in the DVD Studio Pro application bundle.)

Select if you want the 
imported shapes to be used 
only with this project.
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Updating a Shape
When you create a custom shape, you will often find, once you’ve applied it to a button 
or drop zone on a menu, that you need to make an adjustment to it. For example, you 
might need to make the highlight area larger.

To reimport a shape:
1 Click Import in the Shape tab in the Palette.

2 In the selection dialog that appears, locate and select the shape (or shapes) to reimport.

3 Select the Project checkbox if the shapes are used only with this project. Deselect the 
checkbox if they are available to all projects on this system.

4 Click Import.

A dialog appears, stating that the shape already exists.

5 Click Replace to import the new versions of the shapes, replacing the existing ones. 

To see the new versions of the shapes, either in places they are already in use or in new 
places you want to use them, you must save your project, close it, and then open it 
again. Any older versions of the shapes are updated to the new versions.

Deleting a Shape
You can delete one or more shapes.

To delete a shape:
1 In the Palette, select the shape’s group (Apple, Custom, or Project) that contains the 

shape or shapes to be deleted.

Note:  If you delete an Apple shape, you must reinstall DVD Studio Pro to get the shape 
back.

2 Select the shape or shapes to delete. Use the Shift key to select multiple shapes.

3 Click the Shape tab’s Delete button.

The shape’s file is deleted from its location (as determined by its group). 

Note:  You cannot delete a shape that is currently in use on a menu. 
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9 Creating Menus 
Using the Layered Method

The layered method allows you to create independent 
versions of each button for each of the three states. This 
gives you great flexibility in changing a button’s 
appearance when it is selected and activated.

When you create menus using the layered method, you specify independent 24-bit 
layers in an Adobe Photoshop file (PSD) for each state (normal, selected, and activated) 
of each button (as opposed to using an overlay or shapes, as you do with the standard 
method). See “Layered Method” on page 207 for a discussion of the advantages and 
disadvantages of this method.

Note:  Menus created with the layered method can also use overlays. See “Choosing the 
Overlay” on page 233 for details on using overlays.

See “Starting and Working With a Menu” on page 218 for information on creating a 
layered menu, naming it, and adding assets to it.

Note:  You cannot change an existing menu from one kind of menu (standard or 
layered) to the other.

Setting a Menu’s Background and Overlay
The first step in creating a menu is to choose its background and, if you are using one, 
its overlay.

Choosing the Background
Layered menus must use the same PSD file for both the menu’s background and the 
layered buttons. Because of this requirement, only PSD files with multiple layers can be 
used as backgrounds for layered menus.
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For best quality, be sure your graphic:

• Matches the menu’s resolution and aspect ratio (4:3 or 16:9):  If you are creating 16:9 
menus in SD projects, or with the 720 x 480p, 720 x 576p, or 1440 x 1080i HD 
resolutions in HD projects, be sure the graphic is anamorphic. See “Creating Graphics 
to Use in Menus” on page 82 and “Choosing an Aspect Ratio” on page 50 for details.

• Conforms to the broadcast video color space:  Graphics that look stunning in your 
graphics program can look very different when viewed on DVD. Most graphics 
applications let you scale colors to NTSC or PAL color space.

DVD Studio Pro automatically scales the size of the background graphic to fit the frame 
size if necessary, which can result in the menu’s background color appearing along 
some edges.

Assigning a Background to a Menu
There are several ways to assign a background to a menu. Use the method that you feel 
most comfortable with. In all cases, these methods also replace an existing background.

Assigning a Menu Background Using the Inspector
You can assign a menu background using the Inspector. With this method, you can 
only choose from assets already imported into DVD Studio Pro.

To assign a menu background using the Inspector:
1 Select the menu and make sure the Menu Inspector displays the menu properties.

2 Click the General tab in the Inspector (if it’s not already visible).

3 Choose a background from the Background pop-up menu. 

The selected file appears as the menu background, with all layers hidden. You can 
choose which layers to show in the Menu Inspector.

Assigning a Menu Background by Dragging
You can assign a background to a menu by dragging the asset from the Assets tab, the 
Palette, or a Finder window.

To assign a menu background by dragging it to the Menu Editor:
1 Select the menu in the Outline tab, the Graphical tab, or choose it from the Menu 

Editor’s View pop-up menu to display it in the Menu Editor.

2 Locate the background file you want to use in the Assets tab, Palette, or Finder window.

3 Drag the asset to an empty part of the Menu Editor and pause until the Drop 
Palette appears.
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4 Choose one of the following:

• Set Background—All Layers Visible if you want all layers in the file to show.
• Set Background—No Layers Visible if you want all layers in the file to be hidden.

The background appears in the Menu Editor. You can choose which layers to show in 
the Menu Inspector.

To assign a menu background by dragging it to the Outline or Graphical tab:
1 Click the Outline or Graphical tab and select the menu you want to assign the 

background to.

2 Locate the background file you want to use in the Assets tab, Palette, or Finder window.

3 Assign the background file to the menu by dragging the file to the menu’s name or tile. 
A box appears around the name or tile to let you know the menu will receive the 
background file.

The background appears in the Menu Editor, with all layers hidden, when you select 
the menu. You can then choose which layers to show in the Menu Inspector.

Choosing a Menu’s Background From a Layered Photoshop File
You can choose a layer (or several) from an Adobe Photoshop format (PSD) file to use 
as the menu background. One PSD file can supply backgrounds and overlays for 
several menus.

To choose a menu background from a PSD file:
1 Either create a new menu or select an existing one.

2 Click the General tab in the Menu Inspector.

3 Assign the PSD as the menu’s background by either:

• Choosing it from the Background Asset pop-up menu in the Menu Inspector
• Dragging it to the Menu Editor and choosing Set Background from the Drop Palette
The PSD file’s layer names appear in the Background area of the General tab. 

4 Select the checkboxes next to the layers that make up the background.

Choose the background 
from this pop-up menu.

Select these checkboxes
to make the layers part of

the background.
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Choosing the Overlay
You can use overlays with layered menus as well as with standard menus. Every aspect 
of using them, from selecting the file and configuring its color mapping, is identical to 
how you use overlays in a standard menu. See “Choosing the Overlay” on page 233 for 
information on adding an overlay to your layered menu. See “Understanding Color 
Mapping” on page 236 for information on configuring color mapping for simple and 
advanced overlays. 

Configuring the Menu Inspector for Layered Menus
The tabs within the Menu Inspector provide a variety of menu configuration settings. 
These settings control everything from background and overlay configuration, to 
transition and timeout settings.

Setting Layered Menu Properties
The Menu Inspector for layered menus has five tabs:  General, Menu, Transition, Colors, 
and Advanced. 

The User Operations tab is the same as those in other DVD Studio Pro Inspectors, and is 
discussed in “User Operations” on page 598.

Settings at the Top of the Menu Inspector for Layered Menus
The top of the Menu Inspector for layered menus contains two settings.

• Name:  Enter the name for this menu.
• Est. Size:  Displays the estimated amount of disc space the menu requires based on 

the assigned assets.
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General Tab in the Menu Inspector for Layered Menus
The General tab in the Menu Inspector for layered menus is divided into three 
sections:  The upper section contains the menu timeout settings, the middle section 
contains the background configuration settings, and the lower section contains the 
overlay configuration settings.

Menu Timeout Settings
• At End:  Choose whether the menu displays indefinitely (Still) or performs a jump 

action if there is no activity for a period of time (Timeout).
• Sec:  Active only when At End is set to Timeout. Enter the number of seconds the 

menu appears before jumping to the Action setting.
• Action:  Choose the element to jump to once the timeout ends.

Background Settings
• Background:  Choose the layered PSD file to use as the menu’s background.
• Show:  Select the checkboxes next to each layer that you want to appear as part of 

the background.

Overlay Settings
• Overlay:  Choose the file to use as the menu’s overlay file. Set this only if you want to 

use both overlay-based buttons and layered buttons on this menu. 
• Show:  Select the checkbox next to the layer you want to use as the overlay for the 

menu. Unlike backgrounds where you can select multiple layers, you can only select 
a single layer for use as an overlay.

Menu timeout settings

Background settings

Overlay settings
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Menu Tab in the Menu Inspector for Layered Menus
Most settings in the Menu tab in the Menu Inspector for layered menus are optional. 
An exception is the Aspect Ratio setting, which must be set correctly for each menu.

• Default Button:  Choose the button to be selected when the menu appears during 
playback of the title. This setting can be overridden by any element that jumps to 
this menu, based on its jump setting, and the Highlight Condition setting.

• Return Button:  Choose the project element to jump to if you press the Return button 
on the DVD player’s remote control. 

• Highlight Condition:  Provides an alternative method to the Default Button setting for 
determining which button to highlight. When Highlight Condition is set to Default, the 
Default Button setting supplies the button highlight setting. When Highlight Condition 
is set to one of its stream settings (audio, subtitle, camera angle), the number of the 
stream last played determines the button to highlight. This setting can be overridden 
by any element that jumps to this menu, based on its jump setting.

• Language:  Choose the language in which this menu should be displayed. See “Using 
Languages With Menus” on page 352 for more information. 

• Resolution:  Choose the menu’s resolution. 
• For SD projects, the resolution is either 720 x 480i (NTSC) or 720 x 576i (PAL).
• For HD projects, you can choose from any of the supported resolutions. 

DVD Studio Pro Preferences includes a setting for the default resolution. The 
resolution automatically changes to match the menu’s background video 
resolution if it matches one of the supported resolutions. Choosing a resolution 
different than that used by the menu’s background video results in the menu 
being scaled and rendered to this setting when you build the project.
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• Display Mode:  Set the aspect ratio for this menu (4:3 or 16:9). With 16:9, you also 
choose how it will display on a 4:3 monitor. The aspect ratio of the background and 
overlay must match this setting. See “Working With 16:9 Menus” on page 208 for 
more information.

• Number Pad:  Defines which buttons are directly accessible by a DVD player’s numeric 
keypad. Choose All, None, or a button number from the pop-up menu. When you 
choose a button number, that button and all buttons less than that number are 
accessible via the numeric keypad—buttons greater than this value are blocked from 
direct access.

• Btn Offset:  You can use this setting to offset button numbers so they make sense to a 
viewer who wants to select a button by entering its number. For example, you may 
have a set of scene selection menus with numbered scenes. One of the menus may 
have scenes 23 to 34, with the button for scene 23 being the first button on the 
menu. If you enter an offset value of 22 for this menu, when the viewer enters 23 on 
the remote control, 22 is subtracted from it, with the result being 1—the button’s 
actual number.

• Pre-Script:  Choose a script to run before the menu appears. This script can determine 
whether to show the menu or configure the DVD player before showing it. See 
Chapter 14, “Creating Scripts,” on page 467 for information on scripts.

Transition Tab in the Menu Inspector for Layered Menus
The Transition tab is used to configure a button transition for this menu. See “Transition 
Tab in the Menu and Button Inspectors” on page 350 for details on this tab.
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Colors Tab in the Menu Inspector for Layered Menus
The Colors tab is identical to the Menu Inspector for standard menus. See “Colors Tab in 
the Menu Inspector With Simple Selected” on page 249 and “Colors Tab in the Menu 
Inspector With Advanced Selected” on page 251 for information on the Colors tab.

Advanced Tab in the Menu Inspector for Layered Menus
The Advanced tab in the Menu Inspector for layered menus contains settings that are 
used only in specialized projects.
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Disabled User Operations Settings
• Disabled User Operations:  Select the functions that you want to be disabled while this 

menu plays. See “User Operations” on page 598 for more information.

Playback Options Settings
• Pre-Script:  Choose a script to run before the menu appears. This script can decide 

whether to show the menu or configure the DVD player before showing it. 
See “Pre-Scripts” on page 467 for information on pre-scripts. 

• DVD@CCESS:  Selecting this checkbox allows you to add DVD@CCESS links, which 
provide additional functionality to your title when played on a computer. See 
“DVD@CCESS” on page 594 for more information.

• Display Condition:  Selecting this enables the Display Condition settings which control 
whether this menu should be displayed or not, and to define what should be displayed 
if not this menu. See “Display Condition” on page 603 for more information.

Adding Buttons to Your Layered Menu
There are two button types you can add to a layered menu:  layered buttons and 
overlay buttons. In both cases, the first step is to create a button active area. See 
“Creating Menus Using the Standard Method” on page 229.

Once you create the active areas, you can configure the buttons. For overlay buttons, 
see “Using Simple Overlay Color Mapping” on page 239 and “Using Advanced Overlay 
Color Mapping” on page 240 for details. For layered buttons, see “Configuring a 
Layered Button” on page 332.

Mixing Overlay Buttons With Layered Buttons
So that you can combine overlay and layered buttons on the same menu, the color 
mapping settings are active at all times—even when you aren’t adding an overlay to the 
menu. If you see an unexpected color appear in the active areas in any of the button 
states (normal, selected, or activated), you need to configure the color mapping settings.

If no overlay file is assigned to a layered menu, a plain white image is used in place of 
the overlay file. If the color mapping settings apply a color to white, that color will 
appear in the active areas. 

When working with a layered menu without an assigned overlay file, you must either:

• Select Simple as the Overlay Colors setting. This automatically sets white to be 
fully transparent.

• Select Advanced as the Overlay Colors setting, then set the opacity for white to 0 for 
each selection state. 
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Configuring a Layered Button
Configuring a layered button is a matter of selecting layers in the menu’s PSD file to 
display in the three button states (normal, selected, and activated).

To configure a layered button:
1 Click in the button’s active area. 

The Button Inspector appears.

2 Set the button’s connection by choosing an element from the target pop-up menu in 
the top section of the Button Inspector.

3 Click the Layers tab. 

A list of all layers in the PSD file appears.

4 Select the checkbox in the Normal column next to the layer to display when this 
button is not selected or activated. You can select more than one layer. 

If the normal state for the button is already part of the background, you do not need to 
select layers in the Normal column.

5 Select the checkbox in the Selected column next to the layer to display when this 
button is selected. You can select more than one layer. 

The normal button
state column

The selected button
state column

The activated button
state column
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6 Select the checkbox in the Activated column next to the layer to display when this 
button is activated. You can select more than one layer. 

7 To verify the layer settings, use the Menu Editor’s button state icons to select the state 
(normal, selected, or activated) to display. 

You need to repeat this process for each layered button in your menu.

Setting Layered Menu Button Properties
The Button Inspector for layered menus has four tabs:  Button, Layers, Colors, and 
Transition. 

Settings at the Top of the Button Inspector for Layered Menus
The top of the Button Inspector for layered menus has three settings.

• Name:  By default, buttons manually added to a menu are named “Button _,” where 
“_” is the button number on that menu. To reduce confusion when viewing a list of 
the menu’s buttons, it is helpful to rename the buttons based on their functions.

Next to the button’s name is its number. This number is based on the order in which 
the buttons are added to the menu. See “About Button Numbers” on page 264 for 
information on changing this number and why it can be important.

• Target:  You can use this pop-up menu to define a button’s action when activated. (You 
can also use the Connections tab or Control-click the button.) Often you must set the 
connection later since what you want to jump to has not yet been added to the 
project. The pop-up menu contains all possible project elements you can jump to.

Shows the 
selected state.

Shows the 
activated state.

Shows the
normal state.
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Button Tab in the Button Inspector for Layered Menus
The Button tab in the Button Inspector for layered menus contains settings that allow 
you to customize the selected button.

• Navigation:  This area lets you set the actions that take place when the viewer uses 
the arrow buttons on the DVD player’s remote control to navigate around the title. 
Since this is the typical way the title will be viewed, it is important to spend some 
time configuring the navigation in a logical, predictable way. See “Configuring 
Button Navigation” on page 268 for information.

• Angle/Audio/Subtitle Streams:  Use these three pop-up menus to connect a button to 
specific audio, subtitle, and angle streams to play back. For the subtitle stream, you 
can also choose whether subtitles should appear.

• Auto Action:  If you enable Auto Action for a button, it will activate automatically as 
soon as it is navigated to, without the viewer needing to press Enter. This is useful in 
menus, such as scene selection menus, in which you use Next and Previous buttons; 
you can assume that if viewers navigate to the Next or Previous button, they want to 
activate it.

Note:  With overlay-based buttons, if you select this option, only the activated color 
mapping appears when the button is navigated to, skipping the selected color mapping.
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• Invisible:  Applies to overlay-based buttons. Allows you to have a button that does 
not display highlights in the normal, selected, or activated state. This is useful when 
you want to have a menu with text and no visible buttons. The text could tell the 
viewer to press the Enter button to go to the next menu or start playback (or 
whatever the button is set to jump to). 

• Highlight:  Applies to overlay-based buttons. Allows you to choose the color mapping 
set to assign to this button. 

• Coordinates & Size:  This area lets you set the location of each edge of the button’s 
active area, plus the area’s height and width. The upper-left corner of the menu is at 
pixel 0, line 0. You can enter values for each edge, allowing you to precisely position 
and size the button’s active area. (You can also drag the active area and each of its 
edges with the pointer.)

Layers Tab in the Button Inspector for Layered Menus
The Layers tab in the Button Inspector for layered menus lists the layers in the PSD file 
assigned as the menu’s background. There are three columns of checkboxes—normal 
(on the left), selected (in the center), and activated (on the right)—next to each layer. 
For the current button, you select at least one layer to appear when the button is 
selected, and a second layer to appear when the button is activated. You do not need 
to select a layer for the button’s normal state if it is part of the menu’s background.
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Colors Tab in the Button Inspector for Layered Menus
The Colors tab is identical to the one used in the Button and Menu Inspectors for 
standard menus. See “Colors Tab in the Menu Inspector With Simple Selected” on 
page 249 and “Colors Tab in the Menu Inspector With Advanced Selected” on page 251 
for details on using this tab.

Transition Tab in the Button Inspector for Layered Menus
The Transition tab is used to configure a button transition for this button. See 
“Transition Tab in the Menu and Button Inspectors” on page 350 for details on this tab.
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Options in the Drop Palette for Layered Menus
Following are descriptions of the various Drop Palette options that can appear when 
you drag an asset or element to the Menu Editor. See “Viewing the Drop Palette” on 
page 220 for information on using the Drop Palette options.

The following descriptions are grouped by the type of item you are dragging (asset, 
project element such as a track or slideshow, and a template, style, or shape from the 
Palette). Details for standard menus are listed first, followed by the details for the 
layered menus. 

For those Drop Palette options that appear when you drag a motion video asset, a 
matching audio asset is also added (if applicable), as long as:

• The “Find matching audio when dragging” setting in the Track pane of 
DVD Studio Pro Preferences is selected.

• An audio file with the same base name as the video file is located in the same folder 
as the video asset.

The following details assume the “Find matching audio when dragging” preference is 
selected and a suitable audio file is found.

Drop Palette for Layered Menus—Dragging Assets
The following section lists the choices in the Drop Palette that appear when you drag 
assets to an empty area or button in a layered menu.

Dragging a Motion Video Asset to an Empty Area
The following options appear in the Drop Palette:

Create Button and Track
The default action. 
• Creates a button at this menu location.
• Creates a new track with this video.
• Assigns matching audio as the track’s audio.
• Names the track the same as the video asset.
• Adds a link from the new button to the first marker of the new track.
• Sets the new track’s End Jump setting to this menu.

Create Button and Chapter Index
Use this option with video that has had chapter markers added with Compressor, 
Final Cut Express, Final Cut Pro, or iMovie.
• Creates a track and adds the chapter markers to it.
• Assigns matching audio as the track’s audio.
• Names the track the same as the video asset.
• Sets the new track’s End Jump setting to this menu.
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• Creates a button on this menu to link to the first of the new chapter index menus.
• Creates one or more new chapter index menus (using the standard method), 

depending on the number of markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the new track to buttons on the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 

Dragging a Motion Video Asset to a Button
The following options appear in the Drop Palette:

Create Track
The default action. 
• Creates a new track with this video.
• Assigns matching audio as the track’s audio.
• Names the track the same as the video asset.
• Adds a link from the button to the first marker of the new track.
• Sets the new track’s End Jump setting to this menu.

Create Chapter Index
Use this option with video that has had chapter markers added with Compressor, 
Final Cut Express, Final Cut Pro, or iMovie.
• Creates a track and adds the chapter markers to it.
• Assigns matching audio as the track’s audio.
• Names the track the same as the video asset.
• Sets the new track’s End Jump setting to this menu.
• Links the button to the first of the new chapter index menus.
• Creates one or more new chapter index menus (using the standard method), 

depending on the number of markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the new track to buttons on the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 

Dragging a Video/Audio Pair to an Empty Area
The following options appear in the Drop Palette:

Create Button and Track
The default action. 
• Creates a button at this menu location.
• Creates a new track with this video and audio.
• Names the track the same as the video asset.
• Adds a link from the new button to the first marker of the new track.
• Sets the new track’s End Jump setting to this menu.
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Create Button and Chapter Index
Use this option with video that has had chapter markers added with Compressor, 
Final Cut Express, Final Cut Pro, or iMovie.
• Creates a track and adds the chapter markers to it.
• Names the track the same as the video asset.
• Sets the new track’s End Jump setting to this menu.
• Creates a button on this menu to link to the first of the new chapter index menus.
• Creates one or more new chapter index menus (using the standard method), 

depending on the number of markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the new track to buttons on the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 

Dragging a Video/Audio Pair to a Button
The following options appear in the Drop Palette:

Create Track
The default action. 
• Creates a new track with this video and audio.
• Names the track the same as the video asset.
• Adds a link from the button to the first marker of the new track.
• Sets the new track’s End Jump setting to this menu.

Create Chapter Index
Use this option with video that has had chapter markers added with Compressor, 
Final Cut Express, Final Cut Pro, or iMovie.
• Creates a track and adds the chapter markers to it.
• Names the track the same as the video asset.
• Sets the new track’s End Jump setting to this menu.
• Links the button to the first of the new chapter index menus.
• Creates one or more new chapter index menus (using the standard method), 

depending on the number of markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the new track to buttons on the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 
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Dragging a Single-Layer Still Picture to an Empty Area
The following options appear in the Drop Palette:

Set Overlay
The default action. 
• Uses the picture as this menu’s overlay.

Create Standard Submenu
• Creates a button at this menu location.
• Creates a new standard menu with this picture as the background.
• Adds a link from the new button to the new menu.

Dragging a Single-Layer Still Picture to a Button
The following option appears in the Drop Palette:

Create Standard Submenu
The default action. 
• Creates a new standard menu with this picture as the background.
• Adds a link from the button to the new menu.

Dragging a Multiple-Layer Still Picture to an Empty Area
The following options appear in the Drop Palette:

Set Background—All Layers Visible
The default action. 
• Uses the picture as this menu’s background, with all layers visible.

Once set, you can disable layers in the Menu Inspector.

Set Background—No Layers Visible
• Uses the picture as this menu’s background, with no layers visible.

Once set, you can enable layers in the Menu Inspector.

Set Overlay
• Uses the picture as this menu’s overlay, with no layers assigned to the overlay.

Once set, you can select the layer to use as the overlay in the Menu Inspector.

Create Standard Submenu
• Creates a button at this menu location.
• Creates a new standard menu with this picture as the background, with no layers visible.
• Adds a link from the new button to the new menu.

Once set, you can enable layers for the new menu in the Menu Inspector.
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Create Layered Submenu
• Creates a button at this menu location.
• Creates a new layered menu with this picture as the background, with no layers visible.
• Adds a link from the new button to the new menu.

Once set, you can enable layers for the new menu in the Menu Inspector.

Dragging a Multiple-Layer Still Picture to a Button
The following options appear in the Drop Palette:

Create Standard Submenu
The default action. 
• Creates a new standard menu with this picture as the background, with no layers visible.
• Adds a link from the button to the new menu.

Once set, you can enable layers for the new menu in the Menu Inspector.

Create Layered Submenu
• Creates a new layered menu with this picture as the background, with no layers visible.
• Adds a link from the button to the new menu.

Once set, you can enable layers for the new menu in the Menu Inspector.

Dragging Multiple Still Pictures (or a Folder) to an Empty Area
The following option appears in the Drop Palette:

Create Button and Slideshow
The default action. 
• Creates a button at this menu location.
• Creates a new slideshow.
• Adds a link from the new button to the new slideshow.
• Sets the slideshow’s End Jump setting to this menu.

Dragging Multiple Still Pictures (or a Folder) to a Button
The following option appears in the Drop Palette:

Create Slideshow
The default action. 
• Creates a new slideshow.
• Adds a link from the button to the new slideshow.
• Sets the slideshow’s End Jump setting to this menu.
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Drop Palette for Layered Menus—Dragging Project Elements
The following section lists the choices in the Drop Palette that appear when you drag 
project elements from the Outline or Graphical tab to an empty area or a button in a 
layered menu.

Dragging an Existing Track to an Empty Area
The following options appear in the Drop Palette:

Create Button
The default action. 
• Creates a button at this menu location.
• Adds a link from the new button to the first marker of the track.
• Sets the track’s End Jump setting to this menu (if it has not already been set).

Create Button and Chapter Index
• Creates a button on this menu to link to the first of the new chapter index menus.
• Creates one or more new chapter index menus (using the standard method), 

depending on the number of markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the track to buttons in the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 
• Sets the track’s End Jump setting to this menu (if it has not already been set).

Dragging an Existing Track to a Button
The following options appear in the Drop Palette:

Connect to Track
The default action. 
• Adds a link from the button to the first marker of the track.
• Sets the track’s End Jump setting to this menu (if it has not already been set).

Create Chapter Index
• Links the button to the first of the new chapter index menus.
• Creates one or more new chapter index menus (using the standard method), 

depending on the number of markers and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each chapter marker from the track to buttons in the chapter index menus.
• Assigns the video from each marker to its button’s thumbnail. 
• Sets the track’s End Jump setting to this menu (if it has not already been set).
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Dragging a Story to an Empty Area
The following option appears in the Drop Palette:

Create Button
The default action. 
• Creates a button at this menu location.
• Adds a link from the new button to the story.

Dragging a Story to a Button
The following option appears in the Drop Palette:

Connect to Story
The default action. 
• Adds a link from the button to the story. 

Dragging a Slideshow to an Empty Area
The following options appear in the Drop Palette:

Create Button
The default action. 
• Creates a button at this menu location.
• Adds a link from the new button to the slideshow.
• Sets the slideshow’s End Jump setting to this menu (if it has not already been set).

Create Button and Chapter Index
• Creates a button on this menu to link to the first of the new chapter index menus.
• Creates one or more new chapter index menus (using the standard method), 

depending on the number of slides and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each slide from the slideshow to buttons in the chapter index menus.
• Assigns the picture from each slide to its button’s thumbnail. 
• Sets the slideshow’s End Jump setting to this menu (if it has not already been set).
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Dragging a Slideshow to a Button
The following options appear in the Drop Palette:

Connect to Slideshow
• Adds a link from the button to the slideshow. 
• Sets the slideshow’s End Jump setting to this menu (if it has not already been set).

Create Chapter Index
• Links the button to the first of the new chapter index menus.
• Creates one or more new chapter index menus (using the standard method), 

depending on the number of slides and the button layout used.
• Opens the Choose Template or Layout Style dialog so you can choose the template 

or layout style to use for the chapter index menus.
• Links each slide from the slideshow to buttons in the chapter index menus.
• Assigns the picture from each slide to its button’s thumbnail. 
• Sets the slideshow’s End Jump setting to this menu (if it has not already been set).

Dragging a Menu to an Empty Area
The following option appears in the Drop Palette:

Create Button
The default action. 
• Creates a button at this menu location.
• Adds a link from the new button to the menu.

Dragging a Menu to a Button
The following option appears in the Drop Palette:

Connect to Menu
The default action. 
• Adds a link from the button to the menu. 

Dragging a Script to an Empty Area
The following option appears in the Drop Palette:

Create Button
The default action. 
• Creates a button at this menu location.
• Adds a link from the new button to the script.

Dragging a Script to a Button
The following option appears in the Drop Palette:

Connect to Script
The default action. 
• Adds a link from the button to the script. 
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10 Using Advanced Menu Features

Adding menu transitions and creating menus for multiple 
languages are advanced features that can add value to 
your DVD project.

Menu transitions are short video clips that play at the beginning of a menu (intro clips) 
and when buttons are pressed (transition clips). There are several approaches you can 
take to add these clips to your project. See “Adding Intro and Transition Clips to Menus” 
on page 345 for more information.

You can configure a menu to support up to 16 different languages. By assigning 
different backgrounds, overlays, audio, and text to each menu’s language, you can 
create a DVD that supports a wider audience. See “Using Languages With Menus” on 
page 352 for more information.

Adding Intro and Transition Clips to Menus
You can make the DVD viewing experience more polished by adding short video clips 
that play at the beginning of a menu (intro clips) and when buttons are pressed 
(transition clips).

Using Menu Intro Clips
Menu intro clips are most effective when they build up to the menu’s background 
video. For example, if the menu’s background is a shot of a building with buttons in its 
windows, you could have an intro clip that fades up from black to the shot of the 
building, and then has the button elements fly in from off the screen and take their 
place in the windows.
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There are three approaches you can take to create a menu intro effect:

• Combine the intro clip with the menu’s background video. This method guarantees a 
seamless transition between the intro clip and the original menu’s background. The 
Menu Editor includes a Loop Point setting that you can use to control where the 
menu jumps to when its playback is looped. This allows you to configure the intro 
clip to play only the first time a menu’s background plays. The loop point also 
controls when the button highlights appear. Since button highlights cannot move, 
you would not want them visible during the intro while the button elements are 
moving. See “About the Motion Settings” on page 282 for more information.

A disadvantage of this mode is that, unless you use a simple script, the menu’s intro 
must play each time the menu is accessed since you cannot jump directly to the 
menu’s loop point. (See “Jumping to a Menu’s Loop Point” on page 509 for an 
example of the script.)

• Configure the intro clip as its own menu. To do this, you need to create a menu and 
assign the intro clip as its background. You also need to set the menu’s At End setting 
to Timeout, enter 0 as the Sec, and set the Action to be the menu this intro clip is for.

Whenever you want to jump to the original menu, you can jump to this intro menu 
instead—the intro menu will automatically jump to the original menu once its intro 
clip plays.

The advantage of this method is that, since you are jumping from one menu to 
another menu, the disruption during that jump time should be minimal. (By default, 
all menus are stored in the same general area on a DVD disc, making it easier for the 
DVD player to jump between them. Additionally, you can use the VTS Editor to 
ensure the two menus are next to each other.) Another advantage is that you can 
choose whether to jump to the intro menu or to jump directly to the original menu, 
avoiding forcing the viewer to watch the intro menu multiple times.

• Configure the intro clip as its own track. To do this, you need to create a track and add 
the intro clip to its V1 video stream. The only configuration you need to do is to set 
the track’s End Jump setting to the original menu.

Whenever you want to jump to the original menu, you can jump to this intro track 
instead—the intro track will automatically jump to the original menu once its intro 
clip plays.
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Button Transition Clips
Button transition clips provide the opposite effect of the menu intro clip—they provide 
a transition from the menu background’s buttons to the element (a track or another 
menu) that the menu’s button is connected to. Using the same example used for the 
intro clips (a shot of a building with buttons placed in its windows), the transition clip 
could have the button elements fly off the screen and then fade the shot of the 
building to black.

You can use the menu transition feature to automatically create the transition clips or 
you can manually create button transition clips.

Using the Menu Transition Feature
The menu transition feature makes it easy to automatically create transition clips for all 
buttons on a menu. You define a transition in the Menu Inspector that is then applied to 
all buttons and the timeout action (if set). By default, each button is set to use the menu’s 
transition settings; however, you can modify or disable the settings for each button. 

Transition settings include:

• Transition (crossfade, wipe, and so on)
• Specific parameters based on the transition type (duration, direction, and so on)
• Alternative start and end video

The menu transition feature can be used with standard and layered menus.
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Important:  Be aware of the aspect ratio and resolution of the button’s target when 
configuring transitions. All transitions from a menu are based on the menu’s aspect 
ratio and resolution. Depending on the type of monitor a viewer is using, if the button’s 
target uses a different aspect ratio or transition, there may be a noticeable glitch when 
the monitor switches from the menu’s settings to the button target’s settings.

About the Transition Types
DVD Studio Pro includes a variety of Standard and Alpha Transitions you can use with 
your menus. These same transitions are available in slideshows and tracks with still images. 
Menus also allow you to specify a video clip to use in place of the Standard Transitions.

Alpha Transitions
DVD Studio Pro includes several Alpha Transitions. These transitions use short video 
clips to produce a transition from the current picture to the new picture. These 
transitions, indicated with an “ ” character in front of their name, have no settings 
other than a duration. 

Additionally, you can even create and import your own Alpha Transitions. See 
“Preparing Alpha Transitions” on page 98 for details on the process. 

Disables default 
transitions for this menu.

Standard Transitions

Video Transition

Alpha Transitions
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Standard Transitions
When you choose a Standard Transition from the Transition pop-up menu in the 
Transition tab in the Menu or Button Inspector, DVD Studio Pro creates a short video 
clip to be used as the transition. 

The transition clips use a start and end video frame, with the transition controlling how 
the video changes from one to the other. 

• The start frame is the menu with all buttons in the normal state. If the menu has a 
video asset as its background, the loop point frame (or first frame, if the loop point is 
not set) of the video is used as the start frame. The start frame also includes the 
menu’s drop zones and text objects.

• The end frame is the first frame of the target the button is jumping to. If the button 
jumps to a script, the end frame is black. If you change the button‘s target, the end 
frame automatically updates. 

You are able to assign specific assets or colors as the start and end video frames in the 
Menu and Button Inspectors. See “Transition Tab in the Menu and Button Inspectors” 
on page 350 for more information.

The transition clips that are created with the menu transition feature are rendered as 
part of the build process. They are placed in the same video title set (VTS) file as the 
menus. When authoring a project that will fill the DVD disc, you must take into account 
that a transition video clip is rendered for each menu button that has transitions 
enabled—a menu with 18 buttons can require 18 transition video clips. This can have a 
significant impact on the amount of disc space the menus require. See “Transitions” on 
page 44 for more information.

Video Transitions
When you choose Video Transition from the Transition pop-up menu in the Transition 
tab in the Menu or Button Inspector, you can assign a short video clip to be used as the 
transition clip. 

Adding Button Transitions to a Menu
You can set a default transition for the menu. This transition is applied to all buttons.

To set a transition for a menu:
1 Select the menu in the Outline tab, the Graphical tab, or from the Menu Editor’s View 

pop-up menu.

2 Click the Transition tab in the Menu Inspector.

3 Choose either a Standard Transition or the Video Transition from the Transition 
pop-up menu.

You can choose “not set” to disable default transitions for this menu. (You can still 
configure individual buttons to use transitions.)

4 Configure the transition using its specific parameters.
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Once you have configured the menu’s transition, you can modify or disable it at 
each button.

To modify a button’s transition:
1 Select the button to be modified.

2 Click the Transition tab in the Button Inspector.

The Transition setting shows “Same as Menu” by default.

3 Choose the transition to use from the Transition pop-up menu.

You can choose “not set” to disable transitions for that button.

4 Configure the transition using its specific parameters.

Transition Tab in the Menu and Button Inspectors
The Transition tabs in the Menu and Button Inspectors are identical—the only 
difference is that the Transition pop-up menu in the Button Inspector has a “Same as 
Menu” choice that the Menu Inspector does not have.

• Start thumbnail:  Shows the video frame that a still transition will start from.
• Transition thumbnail:  Provides a preview of a still transition when you click the 

Preview button, or a preview of a video transition when you click the Play button. 
• End thumbnail:  Shows the video frame that a still transition will end with. This 

thumbnail is empty in the Menu Inspector unless you have used the End pop-up 
menu to specify an ending frame.
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• Transition:  Choose the transition to use. In the Menu Inspector, this sets the default 
transition for this menu, which you can override at each button.
• not set:  Disables transitions for this menu or button. 
• Standard Transition:  Creates a transition clip based on the standard transitions 

supplied with DVD Studio Pro. 
• Video Transition:  Uses a video clip you assign to create a transition. See “Video 

Transitions” on page 349 for more information.
• Same as Menu:  Only available in the Button Inspector. Sets the current button to 

use the transition settings in the Menu Inspector.
• Preview:  Click this to preview the current transition in the Transition thumbnail area.
• Parameters area:  Contains the parameters, including the duration, for the current 

transition. Each transition has its own set of parameters. 
• Start:  Choose the start frame for the transition to use. 

• With Default, the start frame is the menu’s background. 
• With Solid Color, you are able to choose a color to use as the start frame.
• With Stills and Videos, you are able to choose a specific asset to use as the start 

frame. In the case of videos, an Offset setting appears that allows you to choose 
the video frame to use. 

• End:  Choose the end frame for the transition to use. 
• With Default, the end frame is the menu’s background. 
• With Solid Color, you are able to choose a color to use as the end frame.
• With Stills and Videos, you are able to choose a specific asset to use as the end 

frame. In the case of videos, an Offset setting appears that allows you to choose 
the video frame to use. 

Transition Parameters
Each transition has its own parameters. In many cases, the settings are self-explanatory; 
however, in some cases, the settings are not obvious. See Appendix D, “Transition 
Parameters,” on page 639 for details on the parameters for each transition.
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Manually Creating Button Transition Clips
Transition clips are inserted between the button and the button’s connection. While a 
menu’s intro clip plays when you jump to the menu, button transitions play when you 
activate a specific button. If you have eight buttons on a menu and want the transition 
clip to play when each button is activated, you have to create a separate transition clip 
for each button, since the end of the transition clip needs to jump to the button’s 
actual connection.

There are two approaches you can take to create the button transition effect:

• Configure the transition clip as its own menu. To do this, you need to create a menu 
and assign the transition clip as its background. You also need to set the menu’s At 
End setting to Timeout, enter 0 as the Sec, and set the Action to be the element that 
the button originally connected to. Then you need to change the original menu’s 
button connection to this transition menu.

The advantage of this method is that, since you are jumping from one menu to 
another menu, the disruption during that jump time should be minimal. (All menus 
are stored in the same general area on a DVD disc, making it easier for the DVD 
player to jump between them.)

• Configure the transition clip as its own track. To do this, you need to create a track and 
add the transition clip to its V1 video stream. The only configuration you need to do is 
to set the track’s End Jump setting to the element that the button originally connected 
to, and to change the original menu’s button connection to this transition track. 

Using Languages With Menus
You can configure a menu to support up to 16 different languages. When the DVD first 
starts playing, it checks the menu language setting of the DVD player and 
automatically displays the corresponding menu (if a menu for that language is 
available) or the menu for the first language available (if there is no language match).

The Outline tab lists the languages you have added to the project in the Languages 
section. The languages you see there are used to determine only which menus to 
display and have no effect on the stream settings within the tracks. By default, one 
language, based on the Default Language setting in the Project pane of 
DVD Studio Pro Preferences, appears in the Outline tab.
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You do not actually create different menus for each language—you simply assign 
separate background, overlay, and audio (if applicable) files to each language. You can 
also change the text in any text objects and buttons. These three files and the text 
changes are the only differences between the languages. Button active areas, links, and 
all other menu settings are exactly the same for each language. 

Note:  Since the start frames of transitions are based on the menu’s background video, 
separate transition clips are rendered for each language which uses a different 
background video.

Creating and Configuring Menu Languages
There are two approaches you can take to configure menus for multiple languages:
• Create the primary language’s menu first, and then create the alternate languages in the 

Outline tab. When you create the menu languages after you have created the primary 
menu, all of the primary menu attributes are applied to all language versions of the 
menu, including those that can be different between the languages. This makes it 
easier to configure the menus for the other languages, especially if you are not 
changing much between the different languages.

• Create the languages first, and then create the menus. When you create the languages 
first, the menus all start out empty. Anything you apply to one of the menus that is not 
language-specific gets applied to all versions of the menu. If you apply an item that is 
language-specific—for example, you create a text object—a text object is created on 
all versions of the menu, but only the menu you created it on will have the text and 
text attributes (font or color). This can require more effort since you will have to set not 
only the text, but its attributes for each version of the menu. (If you had created the 
primary menu first, all of the other versions would have the text object with its font 
and color—all you would need to do would be type the new text.)

Most often you will find yourself using a mixture of these methods. For example, you 
might create the languages and menus, and then find you need to add an additional 
language. The menu configurations for the new language will match the primary 
menu settings.
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Adding Menu Languages
You can use the Outline tab’s shortcut menu to create menu languages.

To create menu languages, do one of the following:
m Choose Project > Add to Project > Language.
m Control-click in the Outline tab, then choose Add from the shortcut menu and 

Language from the submenu.
m Press Command-/ (slash).

The new language appears in the Outline tab under the Languages heading. By default it is 
named “English _,” with “_” being the number of the language. The General pane in 
DVD Studio Pro Preferences contains a project default language setting that you can use to 
define the default language. See “General Preferences” on page 114 for more information.

Important:  For every language you add, DVD Studio Pro creates a new menu for each 
menu in your project. This is true whether or not you assign different backgrounds to 
each language. For projects with a lot of motion menus, these additional menus can 
take up a significant amount of space on the DVD.

Configuring Menu Languages in the Outline Tab
You can use the Outline tab to configure the menu languages.

To configure menu languages using the Outline tab:
1 Click the triangle next to Languages to display the available languages. There should be 

at least one entry.

2 Select the language entry to open the Language Inspector.

3 Choose a language from the Language Code pop-up menu. This is the language that 
this language element should map to on the DVD player when the title plays. 

4 If desired, enter a new name in the Language Name area. This is the name that you will 
see when configuring your menus. By default, it changes to match the name of the 
language selected in the Language Code pop-up menu. This name is not seen by the 
viewer; it is strictly for your use while configuring menus.

5 To remove a language, select it in the Outline tab and press the Delete key.
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Setting Up Menus for the Languages
Once you have created and configured your languages, you can configure their menus. 
To do this, you need to have created and imported all assets (backgrounds, overlays, 
and audio streams) that will be used for the different languages.

To configure a menu for a language:
1 Select a menu. It does not have to be fully configured yet. Keep in mind that all 

settings (with the exception of the background, overlay, audio file, and text) are shared 
among all languages. 

2 Do one of the following to choose a language to configure:

• Choose the language from the Language pop-up menu in the Menu tab in the 
Menu Inspector. 

• Choose the language from the Menu Editor’s language pop-up menu, next to the 
View pop-up menu.

3 Select the background file, overlay file, and audio file to use for this language. You can 
use the same file for multiple languages.

Note:  These files must be compatible (the same format, resolution, and, in the case of 
audio, the same bit rate, sample size, and sample rate) between all language versions of 
the menu. 

4 If desired, change the text in any text objects and buttons to what you want to appear 
for that language. You can also change the font and color for each language.

5 Select any additional languages and set their asset files and text as you like.

When you choose a language that you have already configured with alternate assets, 
the menu’s assets and text change to match those settings. 
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11 Creating and Editing Tracks

The main content of a DVD project is contained in tracks, 
which hold pieces of video, audio, and subtitles that play 
as a unit. 

A DVD can have a combination of up to 99 tracks, stories, and slideshows. Each track 
can contain up to:

• 9 video streams, used as angles or alternate video 
• 8 audio streams for different soundtracks
• 32 subtitle streams for alternate text, alternate languages, or buttons over video
• 99 chapter markers used primarily to define points in the track that can be jumped to
• 255 cell markers used for a variety of purposes, such as button highlights and 

DVD@CCESS (this includes chapter markers, which are also cell markers)
• 98 stories (assuming there are no other tracks or slideshows), each defining an 

alternate track playback by treating each chapter marker as a clip that can be moved 
or skipped as needed 

Working With a Track’s Assets
You can add multiple video or audio assets to each stream in a track. You can even trim 
each asset’s start and end points to choose the parts of it you want to use. While this 
allows for a lot of flexibility when creating your tracks, it is not a substitute for using a 
video editing application, such as Final Cut Pro, to edit the clips into an asset to add to 
your project.

You need to use a video editing application to add effects such as dissolves, wipes, and 
keys to the video. With this kind of editor, you can precisely choose each clip’s start and 
end points—the trimming capability of DVD Studio Pro is restricted to Group of 
Pictures (GOP) boundaries only, making it much harder to trim a clip exactly where you 
would like. Also, DVD Studio Pro can’t mix multiple audio assets together as you can 
with an editor.
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How Many Tracks Should You Have?
Depending on your intended result, your project may have one long track, or you may 
choose to divide your material into multiple tracks that can be played separately or 
linked together.

For example, if you are working on a long project that you expect the viewer to watch 
from beginning to end, using one long track is the best option. This eliminates any 
pauses that the viewer may encounter while the DVD player jumps from one track to 
another. Even if your project contains several independent segments that the viewer 
would not watch one after the other, you can still use a single track and set actions on 
the markers to break the track into the smaller segments. Or, you can create separate 
tracks for each segment—whichever method is easiest for you to manage.

In some cases, such as a track with a mixture of still images and motion clips, you may 
need to use multiple tracks to work around the 99 chapter marker–per–track limit.

If you think you may need to replace some segments in your project later on—for 
example, to customize for various countries or to update outdated sections—you may 
find it easier to replace these segments if they are separate tracks.

About Subtitle Streams
Subtitles can be created in the Track Editor, or they can be imported from other 
applications. They can be used to overlay dialogue text over the video stream, or to 
overlay simple graphics. Subtitles can also be used to place buttons over the video; the 
viewer can select these buttons just as they would on a menu. 

See “Creating Subtitles” on page 431 for information on working with subtitles.

DVD Studio Pro Tools for Working With Tracks
DVD Studio Pro provides two primary tools for configuring your tracks:  the Track 
Inspector and the Track Editor. 
• The Track Inspector contains general track settings, such as its aspect ratio, what happens 

when the track finishes, the remote control settings, and DVD@CCESS settings.
• The Track Editor is where you add and manage your video and audio assets, as well as 

your subtitles. You can also add markers for use as chapter points and other functions.

There is also a Marker Inspector you use when working with markers and a Clip 
Inspector you use when working with individual clips within a track.

Note:  An asset used within a track is considered a clip. This distinguishes what is used 
in the track (which may be just a part of the asset) from the original asset.

Together, these powerful tools allow you to make the tracks into exactly what you need.
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Getting Started With Tracks
There are several methods you can use to create a track. Once it has been created, you 
can open it in the Track Editor, using the controls there and in the Track Inspector to 
configure it. 

Creating Tracks
By default, a new project contains one menu and one track. Depending on your 
project, you will probably want to add additional tracks. There are several ways to add a 
track to your project.

To create a track, do one of the following: 
m Drag a video asset or a video/audio asset pair to the Menu Editor and choose an option 

that creates a new track from the Drop Palette. You can drag the assets from the Assets 
tab, the Palette, or a Finder window. See “Options in the Drop Palette for Standard 
Menus” on page 285 and “Options in the Drop Palette for Layered Menus” on page 337 
for details on the options in the Menu Editor’s Drop Palette.

In all cases, a track is created with the video placed in the V1 stream and the audio 
(if used) placed in the A1 stream. The track has the same name as the video asset.

m Drag a video asset or a video/audio asset pair to an empty area of the Outline or 
Graphical tab. You can also drag the assets to the disc name or the Tracks heading. 

In all cases, a track is created with the video placed in the V1 stream and the audio 
(if used) placed in the A1 stream. The track has the same name as the video asset.

m Dragging a video or video/audio asset pair to an existing track in the Outline or 
Graphical tab appends the assets to the track’s existing assets.

m Convert a slideshow to a track. The still images and audio are added to the track’s V1 and 
A1 streams. See “Converting a Slideshow to a Track” on page 424 for slideshow details.

m Click Add Track in the toolbar. Each track created this way is empty.
m Press Control-Command-T. This also creates an empty track.

Opening Tracks
To configure a track, you need to open it in the Track Editor. You can select the track 
you want to work with in the Outline tab, the Graphical tab, or the Track Editor. 

To open a track in the Track Editor:
m Double-click the track you want to configure in the Outline or Graphical tab. 
m Choose the track from the Track Editor’s Track pop-up menu. The track appears in the 

Track Editor and the Track Inspector changes to display its properties. 
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Setting Track Properties
The Track Inspector contains a top section and four tabs:  General, Other, User 
Operations, and Transition.

Settings at the Top of the Track Inspector

There are three settings at the top of the Track Inspector.

• Name:  Enter the name for the track. If a track is created because a video asset was 
dragged to the Menu Editor, the Outline tab, or the Graphical tab, it is automatically 
named the same as the video asset. In other cases, the track is named “Track _” 
where “_” is the next available number.

• Est. Size:  Shows the approximate amount of disc space the track will require. This 
takes into account all of the assets assigned to the video, audio, and subtitle streams.

• End Jump:  Choose the element to jump to once the track finishes playing. If you 
don’t make this selection, the DVD player will be unable to continue playing the title 
when it reaches this point. If the track was created by dragging an asset to the Menu 
Editor, the End Jump is automatically set to jump back to that menu.

General Tab in the Track Inspector
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• Resolution:  Choose the track’s resolution. 
• For SD projects, the resolution is either 720 x 480i (NTSC) or 720 x 576i (PAL).
• For HD projects, you can choose from any of the supported resolutions, as long as 

no video assets have been assigned to the track. You cannot change the resolution 
once a video asset has been assigned to the track. (You can change the resolution 
if the track only contains still assets.) The resolution automatically changes to 
match the track’s V1 stream video resolution if it matches one of the supported 
resolutions. DVD Studio Pro Preferences includes a setting for the default 
resolution (which also applies to menus and slideshows).

• Display Mode:  Set the aspect ratio for this track (4:3 or 16:9), and with 16:9, choose how it 
displays on a 4:3 monitor. The aspect ratio of the video assets must match this setting.

• Pre-Script:  The script you choose in this pop-up menu will run as soon as the track is 
selected. The script determines whether to play the track or configure the DVD player 
before playing it. See Chapter 14, “Creating Scripts,” on page 467 for information 
on scripts.

• Wait:  You can set how long the DVD player shows the last frame of the track’s video 
before exercising the End Jump setting. 
• None:  Immediately jumps to the End Jump setting.
• Seconds:  Shows the track’s last frame for the number of seconds you enter.
• Infinite:  Shows the track’s last frame indefinitely. 

• Remote Control:  Use these pop-up menus to set what happens when the viewer uses 
the remote control buttons on the remote control. See “Remote Control Settings” on 
page 608 for more information.

• Display Condition:  Select this checkbox to set display conditions to control whether 
this track should appear or not, and to define what should appear if not this track. 
See “Display Condition” on page 603 for more information. Select the “Apply to 
Stories” checkbox to also have these display conditions apply to stories based on 
this track.
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Other Tab in the Track Inspector
The Timestamps settings in the Other tab in the Track Inspector applies to both SD and 
HD projects. The other settings in the tab apply only to SD projects. 

• Timestamps:  Shows the start timecode of the first video asset in the V1 stream. You 
can also enter a track offset that is used in place of the first video asset’s timecode 
when you choose Asset-Based Timecode in the Track Editor. See “Timecode in the 
Timeline” on page 367 for more information.

• Reset:  Click to change the track offset back to 00:00:00:00, allowing the first asset 
start time to be used for the timeline (if you are using asset-based timecode in the 
Track Editor).

• Closed Caption:  SD projects only. Use these settings to assign a closed caption file to 
this track. See “Line 21 Settings for Closed Captions” on page 611 for more 
information.

• Macrovision:  SD projects only. This setting allows you to override the disc’s 
Macrovision copy-protection settings for this track. If you have not enabled the 
Macrovision settings for the disc in the Disc Inspector, setting this to one of the three 
types automatically enables Macrovision for the disc. See “About the Macrovision 
Settings” on page 560 for more information.
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User Operations Tab in the Track Inspector
The User Operations tab is the same as those in other DVD Studio Pro Inspectors, and is 
discussed in “User Operations” on page 598.

Transition Tab in the Track Inspector
The Transition tab is the same used in the Clip Inspector when a still clip is selected. See 
“Transition Tab in the Track and Clip Inspectors” on page 399 for details on the 
Transition tab.
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About the Track Editor
The streams are the heart of the Track Editor. In these parallel areas, you define the 
video, audio, and subtitle assets to be used in your tracks, and their relationship to one 
another.

Within the Track Editor, timescales provide different ways to obtain timing information 
about the tracks. See “Understanding Time Information in the Track Editor” on 
page 366 for more details.

Configuring the Track Editor
You can configure the Track Editor to suit your needs. You can set the size of the 
streams, how many of each stream type appear, and the timeline zoom amount.

Viewing the Streams
A track can contain up to 49 streams total, but viewing this many streams at once 
requires some effort. It’s unlikely that you’ll need to view more than ten streams at 
once; depending on the types of projects you create, you may use only two or three 
streams. There are three ways to control how many streams appear.
• You can change the size of the Track Editor’s quadrant. You can even drag the Track 

tab into its own window. See “Working With the Quadrants” on page 142 for 
more information.

• You can use the Track Editor’s separator bars to control how many of each stream 
type appear. For example, if you do not plan to add subtitles, you can hide the 
subtitle stream area by dragging the separator bar above the subtitle area to the 
bottom of the window.

• You can select a different stream height. This changes the height of the streams as 
they appear in the Track Editor. This can be useful if you want to see larger or smaller 
thumbnails of the video at the markers.

Drag the separator bars 
to set how many video, 
audio, and subtitle 
streams appear.

Choose the track to view
in the Track Editor.

Use these controls to
configure the streams.

Select the height of
the streams.

Set the timeline 
zoom amount.

Displays the track’s 
time and marker 
information.

Scroll through the timeline 
to view different parts.
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Using the Stream Configuration Buttons
The Track tab includes a set of controls that you can use to quickly change which 
streams appear. The size of the Track tab determines how many streams appear.

To choose which streams appear, do one of the following:
m Click the video icon to show only video streams.
m Click the audio icon to show only the V1 stream and the audio streams.
m Click the subtitle icon to show only the V1 stream and the subtitle streams.

If you select more than one of these views at the same time, the separator bars move to 
show as many of the selected streams as possible. Once you choose one of these views, 
you can drag the separator bars to customize the stream types that are displayed.

Setting the Timeline Zoom
The Track tab contains a zoom control you can use to expand or contract the timeline. 
When working with large projects, you often need to be able to expand the timeline in 
order to set a marker or insert a subtitle. Using the zoom control in conjunction with 
the scroller at the bottom of the timeline allows you to configure the timeline so that it 
provides enough detail to work with. 

Click to show the
video streams in the

Track Editor.

Click to show the V1 and
audio streams in the

Track Editor.

Click to show the V1 and 
subtitle streams in the 
Track Editor.

Drag the ends of the 
scroller to zoom in or out.

Drag the timeline scroller to 
select the part to view.

Drag to the right to zoom out 
or to the left to zoom in.
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To use the zoom control, do one of the following:
m Drag it to the right to zoom out, showing more of the timeline. If the playhead is not 

visible, the timeline scroller automatically jumps to a position that does show it.
m Drag it to the left to zoom in, showing less of the timeline but more detail in the part 

that shows. If the playhead is not visible, the timeline scroller automatically jumps to a 
position that does show it.

Hold down the Shift key while dragging the zoom control to prevent the scroller from 
automatically changing its position to show the playhead.

You can also set the timeline zoom using keyboard shortcuts.

To zoom using keyboard shortcuts, do one of the following:
m Press Command-- (hyphen) to zoom out on the timeline. If the playhead is not visible, 

the timeline scroller automatically jumps to a position that does show it.
m Press Shift-Command-- (hyphen) to zoom out without moving the scroller to show 

the playhead.
m Press Command-= to zoom in on the timeline. If the playhead is not visible, the 

timeline scroller automatically jumps to a position that does show it.
m Press Shift-Command-= to zoom in without moving the scroller to show the playhead.
m Press Shift-Z to zoom the timeline out to its maximum.
m Press Shift-Option-Z to fit the currently selected clip into the Track tab.

Understanding Time Information in the Track Editor
There are a variety of time-related elements that appear in the Track Editor. Some only 
display time information while others allow you to change the information. The time 
values help you identify the position of markers, clips, the playhead, and the pointer 
within the video, audio, and subtitle streams.

Displays the pointer
position within the

stream or marker area.

Shows the playhead’s
position, and can be

used to move it.

Drag the playhead along the
timeline to view a different part

of a stream in the Viewer tab.

The timeline’s 
timecode

Sets the start and end time of
the selected clip with respect

to the timeline.
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Timecode in the Timeline
The timeline’s timecode is continuous throughout the track. You can choose from two 
sources for the timecode:  zero-based and asset-based. 
• Zero-based timecode starts the timeline at 00:00:00:00. You cannot change the zero-

based timecode, and the assets assigned to the V1 stream do not affect it.
• Asset-based timecode can be based either on the timecode of the first clip on the V1 

stream, or on a value you enter in the Track Inspector.

To choose the timeline’s timecode source, do one of the following:
m Choose View > Timescale > Zero-Based Timecode or View > Timescale > Asset-Based 

Timecode.
m Control-click in the timeline, then choose either Zero-Based Timecode or Asset-Based 

Timecode from the shortcut menu.

The pointer position, playhead, and start and end timecode values change to match 
the timecode source you choose. 

If you choose the asset-based timecode source, you can also choose whether to use 
the clip’s timecode or a value you enter.

To configure the asset-based timecode source:
1 Choose Asset-Based Timecode as the timecode source for the Track Editor’s timeline. 

2 Click the Other tab in the Track Inspector. If the Inspector is not showing the track 
properties, select the track’s name in the Outline tab, its tile in the Graphical tab, or 
click an empty area in any of the Track Editor streams. 

3 Do one of the following:

• To use the timecode from the first clip in the V1 stream, click the Reset button. This 
sets the Track Offset value to 00:00:00:00, which forces the timeline to use the clip’s 
timecode.

• To set the timecode to start at a specific value, enter a new timecode value in the 
Track Offset entry. The timeline’s first frame is set to this number.

Control-click in the 
timeline to choose the 
timecode source.
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Being able to force the timeline’s timecode to start at a specific value can be useful 
whenever you are importing a marker list or subtitle file that is based on timecode 
different from the zero-based or asset-based values.

Note:  For NTSC projects, the type of timecode in the first asset—drop frame or non-
drop frame—determines the type of timecode for the timeline.

Clip Start and End Timecode
Timecode start and end values appear when you select a clip (video, audio, or subtitle) 
in one of the streams. These values indicate the position of the clip with respect to the 
timeline’s selected timecode source. Depending on the stream, you can enter new start 
values to reposition the clip or new end values to trim the clip’s size. 

See “Editing Video and Audio Clips” on page 376 for more information.

Playhead
The playhead provides a visual indication of what part of the track is currently playing 
in the Viewer tab. When you play the track, the playhead moves along the track’s 
timeline. It also provides a way to scroll across the timeline and see the video in the 
Viewer tab.

The playhead is in the timeline’s timecode area. With new tracks, the playhead is 
located at the track’s start.

The currently selected clip is 
darker than the others.

Shows the clip’s timeline timecode for 
its last frame. You can trim the clip by 
entering a new End timecode.

Shows the clip’s timeline timecode for 
its first frame. You can move the clip 
(on streams other than video) by 
entering a new Start timecode.

The playhead at 
the track start
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A playhead icon appears in the timeline scroller area to let you know where it is relative 
to the part of the timeline being shown, which is useful if you cannot see the playhead in 
the Track Editor. For example, if the playhead icon appears to the left of the scroller, that 
means the playhead is at a point in time before the clips currently visible in the timeline.

Positioning the Playhead by Dragging
You can drag the playhead along the timeline to see the video (and subtitle, if 
applicable). This is useful when placing markers since it allows you to see the actual 
video frame.

As you drag the playhead along the timeline, the timecode of its current position 
appears in the playhead timecode entry. A line extends across all of the streams, 
indicating the playhead position. 

You can also click anywhere in the timeline to move the playhead to that position and 
have the video at that position appear in the Viewer tab. Playback starts at this point if 
you click the Play button in the Viewer tab. 

The playhead appears in 
the timeline’s scroller.

The playhead’s current 
timecode appears here when 
you drag the playhead.
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Positioning the Playhead by Using Keyboard Shortcuts
There are a number of keyboard shortcuts that you can use to position the playhead.
• Left and Right Arrow keys:  Move the playhead one frame at a time. 
• Shift–Left and Shift–Right Arrow keys:  Move the playhead one second at a time.
• Option–Left and Option–Right Arrow keys:  Move the playhead one GOP at a time.
• Control–Left and Control–Right Arrow keys:  Move the playhead to the next marker.
• Command–Left and Command–Right Arrow keys:  Move the playhead to the start or 

end of the selected clip.
• Up and Down Arrow keys:  Move the playhead to the next clip edge (includes all clips 

in all streams) or marker.
• Home and End keys:  Move the playhead to the start or end of the timeline.

See Appendix A, “Keyboard Shortcuts,” on page 613 for a complete list of 
keyboard shortcuts.

Positioning the Playhead by Entering a Timecode Value
You can also set the playhead’s position by entering a timecode value in the playhead 
position entry. The playhead jumps to its new position.

See “About the Viewer Tab” on page 401 for more information on using the Viewer tab.

Working With the Track Editor’s Streams
The Track Editor’s streams contain the video, audio, and subtitle assets. You can add one 
or more assets to each stream. Each stream has several properties you can set, such as 
its language and whether or not it is enabled.

See Chapter 13, “Creating Subtitles,” on page 431 for information on working with the 
subtitle streams.

Supported Asset Types
In addition to assets that are already DVD-compliant, you can add assets supported by 
the DVD Studio Pro embedded encoder. These assets are encoded once they are added 
to your project.

Enter a timecode to 
move the playhead to.
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See “Encoding Video Materials for DVD” on page 54 for information on supported 
video assets, “Preparing Audio Sources” on page 77 for information on supported audio 
assets, and “Using the Embedded MPEG Encoder” on page 62 for information on the 
assets the embedded encoder supports.

Video Assets for SD-Based DVD Video Streams
All video assets on an SD-based DVD stream must use the same aspect ratio (4:3 or 
16:9), the same video standard (PAL or NTSC), and the same MPEG type (SIF MPEG-1 or 
full D1 MPEG-2, for example). 

Note:  All QuickTime video assets you import into an SD project are encoded as full D1 
MPEG-2 assets, and can be mixed with still images in a video stream.

Video Assets for HD-Based DVD Video Streams
All assets on an HD-based DVD stream must use the same aspect ratio (4:3 or 16:9), the 
same resolution, the same video standard (PAL or NTSC), and the same MPEG type 
(MPEG-2/HDV or H.264).

All non-HDV and non-H.264 QuickTime video assets you import into an HD projects are 
encoded as MPEG-2. 

Note:  Since HDV is actually HD MPEG-2, you can combine HDV assets with other HD 
MPEG-2 assets, including those encoded from the embedded MPEG encoder, as long as 
they are the same resolution.

Still Assets for Video Streams
You can add still images to a video stream to either manually create a slideshow or 
create a stream with mixed motion and still video. Stills can be added to all SD and HD 
tracks except those using SIF, 1/2 D1, cropped D1 MPEG-2, or H.264 format assets.

Still asset clips in a stream must each be at least 15 frames long for NTSC projects, or 
12 frames long for PAL projects.

Note:  To have still assets with shorter durations, you can edit them into a video asset 
using an external video editor.

About Segmented MPEG Files
The segmented MPEG files created by some third-party encoders do not import 
correctly into DVD Studio Pro. Some encoders segment their large encoded files into 
1 GB files. When imported into DVD Studio Pro, only the first 1 GB segment is 
imported. You need to append the files into a single file before importing the asset 
into DVD Studio Pro. There are several third-party applications that can be used to 
append a segmented MPEG file into a single file.
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Still clips can have a transition added to their end. The transition controls what 
happens at the end of the still clip—for example, you can configure it to dissolve or 
wipe to the next clip, whether the next clip is a video or still clip. See “Using Still Clip 
Transitions” on page 398 for more information.

Assets for Audio Streams
All audio assets within a stream must be the same type (AC-3, AIFF, MPEG-1 layer 2, and 
so on) with the same number of bits (16, 20, or 24), the same sample rate (48 kHz or 
96 kHz), the same bit rate (when using compressed audio), and the same channel 
configuration; for example, stereo or 5.1 surround. (The streams within a track do not 
have to match each other—only the assets within a stream must match. For example, 
the A1 stream can use AC-3 audio and the A2 stream can use AIFF audio.) 

Adding Video and Audio Assets
If you created your track by dragging either a video asset or a video/audio asset pair to 
the Menu Editor, the Outline tab, or the Graphical tab, it already contains video and audio 
clips. If you created your track using the Add Track icon in the toolbar, it will be empty.

In either case, you can add additional assets to the streams, and even trim each clip’s 
start and end points.

To add an asset to a stream:
m Drag the video or audio asset from the Assets tab, the Palette, or a Finder window to 

the stream where you want to place it.

With the V1 stream, DVD Studio Pro automatically ensures there is always a clip at its 
beginning (if one has been assigned), and there are no gaps between the clips. With 
the other video streams, the clips can only be positioned at markers. Audio and subtitle 
clips can be positioned anywhere on the stream and there can be gaps between them.

Adding Audio Assets Automatically
When you enable the “Find matching audio when dragging” setting in the Track pane 
in DVD Studio Pro Preferences, audio assets are automatically added to a track when 
video is added.

Using AAC Audio Files From the iTunes Music Store
DVD Studio Pro is able to import and use AAC format audio files purchased from the 
iTunes Music Store as long as the computer you are using them on is authorized to 
use them. If you import iTunes Music Store files that the computer is not authorized 
to use, DVD Studio Pro plays silence when it encounters those files. Additionally, if 
you select and try to play an iTunes Music Store file that the computer is not 
authorized to play in the Audio tab in the Palette, DVD Studio Pro plays silence.
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When you add a video asset to the V1 stream, DVD Studio Pro checks to see if there is 
an audio asset with the same base name in the same folder. If there is, it is 
automatically added to the A1 audio stream.

The start of the audio clip will be the same as the video clip. If any audio already exists in 
the A1 stream where the new audio clip needs to go, it is trimmed or moved as necessary.

Note:  Hold down the Command key after you start dragging to temporarily override 
the “Find matching audio when dragging” preferences setting.

Adding AC-3 Audio Assets
AC-3 audio assets are the only DVD Studio Pro–supported audio asset type that 
actually have embedded timecode. This can help when you want to maintain sync 
between the video and audio.

To add an AC-3 asset using its timecode:
m Hold down the Option key, then drag the AC-3 audio file from the Assets tab to an 

audio stream in the Track Editor.

Note:  Since the file must be parsed to determine its embedded timecode, an AC-3 file’s 
timecode is only available when you drag it from the Assets tab, and not from the 
Palette or a Finder window. Drag the AC-3 file to the Assets tab first and then from 
there to the Track Editor.

When you add an AC-3 asset to an audio stream while holding down the Option key, 
DVD Studio Pro checks to see if its timecode is coincident with the V1 stream’s 
timecode. In other words, it checks to see if the AC-3 asset has timecode that falls 
within the timecode range of the video asset.

• If it is coincident, it is placed in the stream so that it is in sync with the video. 
• If it is not coincident, the AC-3 stream is placed at the beginning of the stream.

Note:  If the V1 stream has more than one video clip, the AC-3 timecode is ignored. It is 
also ignored if the audio stream you drag it to already has an audio clip.

Using Multiple Copies of a Clip
You can use a clip multiple times in the same stream or you can drag the clip to 
other streams.

To copy a clip within a stream:
m Option-click the clip and drag it to an empty location in the stream.

You can treat the clip’s copy the same as any other clip in the stream.
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To copy a clip to a different stream, do one of the following:
m Option-drag the clip to the stream that you want to copy it to. You can position it 

as needed.
m Shift-Option-drag the clip to the stream that you want to copy it to. The clip is 

constrained to use the same start time as the original.

The original clip is not affected, and remains in its location. 

Copies of the original clip take up as much disc space as the original clip. If the size of 
your project is an issue, you may want to simply reuse the original clip by setting 
markers and creating scripts to access the clip from another project element. 

Viewing a Clip’s Properties
When you select a clip in one of the Track Editor’s video or audio streams, the Clip 
Inspector appears. 

To accommodate the additional settings used to configure transitions, the Clip 
Inspector used for still clips contains two tabs:  General and Transition. The General tab 
contains the same information and settings as with video clips. See “Using Still Clip 
Transitions” on page 398 for information on the Transition tab.

Note:  Selecting a clip in a subtitle stream opens the Subtitle Inspector. See Chapter 13, 
“Creating Subtitles,” on page 431 for information on subtitles.
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The Clip Inspector shows information about both the clip and the stream.

• Name:  Enter a name for the clip. This name applies to the clip in this track’s timeline 
only—it does not affect the asset’s name in the Assets tab.

• Asset:  Shows the clip’s actual filename.
• Est. Size:  Shows how much disc space this clip requires.

Clip Information and Settings
• Start:  Shows the clip’s start time in the stream.
• Clip Start Trim:  Choose the part of the asset that the clip should use. Enter an amount 

of time by which to trim the clip’s beginning. This affects the clip’s overall length. 
When you enter a new Clip Start Time, the clip repositions itself on the timeline so 
that it begins at the same time, with the clip’s end moving to its new position.

• Duration:  Shows the clip’s length. You can enter a new length to trim the end of the clip.

Note:  When you import a QuickTime asset that contains both video and audio, you 
may find that their durations, as shown in the Clip Inspector, do not match exactly. 
This is often due to the DVD-Video specification’s frame rate for the supported audio 
formats not dividing evenly into the video frame rate. This does not affect the lip 
sync between the audio and video streams or their playback, and is purely cosmetic.

• Asset Start Timestamp:  Displays the timecode of the asset’s first frame.
• Bits/Second (Avg.):  Shows the clip’s bit rate information.

Stream Information
• Stream Number:  Shows the stream’s number.
• Stream Duration:  Shows the stream’s length.
• Language:  For audio clips only; shows the stream’s language setting. You can choose 

a different language from the pop-up menu. The new language is applied to the 
entire stream. See “Assigning Languages” on page 379 for more information.

Browse Clip
For video clips only. You can drag the slider under the thumbnail image to scrub 
through the clip’s video.

Removing a Clip From a Stream
There are several ways you can remove clips from a stream.

To remove a clip from a stream:
m Click the clip to select it, then press the Delete key.
m Control-click the clip, then choose Delete Media Clip from the shortcut menu.

These methods remove the clip from the stream, but the asset remains in the Assets 
tab. The actual asset’s file is not affected.
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Editing Video and Audio Clips
You can trim the start and end of a clip, which is useful when you need to remove a 
portion of an asset for artistic reasons (such as a bumped camera). It is important to 
understand that video clips in DVD Studio Pro are trimmed based on GOP 
boundaries—you cannot choose a specific frame to trim to. The typical GOP (Group of 
Pictures) size for NTSC video is 15 frames—for PAL video it is 12 frames. This means you 
may have to choose between trimming a little too much or not quite enough. If you 
need to trim a clip precisely, you should use a video editor to make the trim, and then 
bring the asset back into DVD Studio Pro.

You can trim audio clips by frames, making it possible to trim off a popping noise.

Trimming can also be a way to use a small part of a longer asset. Only the part of the 
asset that is in the stream is included in the final disc size.

About the V1 Stream
The first video stream, V1, has requirements different from the other streams. 
DVD Studio Pro automatically ensures these conditions are met.
• The first clip must be at the beginning of the timeline. There cannot be a gap 

between the timeline’s first frame and the first frame of the V1 clip. All other streams, 
including the other video streams, can have their first clip start anywhere in the 
timeline.

• You cannot have gaps between clips in the V1 stream. All other streams can have 
gaps between their clips.

• When building the project, the track ends at the last frame of video in the V1 stream. 
Any streams that have clips extending beyond the V1 clips are automatically 
truncated by the build process. 

Trimming and Positioning Clips
There are several methods you can use to trim and position a stream’s clips within the 
Track Editor. 

To trim a stream’s clip by dragging:
1 Position the pointer over the end of the clip you want to trim. The pointer changes to a 

bracket with an arrow pointing in the direction you can trim.

2 Drag the clip’s edge to its new position.

Note:  You cannot trim a clip beyond the edges of the asset.
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To help guide you when trimming your clip, drag the playhead to the point you want 
to edit to. A vertical line appears across all streams, which you can use as a guide to 
trim an edge to. Be sure to use the timeline zoom feature to provide a close-up view of 
the area you’re editing.

Use care not to lose your video and audio synchronization when trimming. Instead of 
dragging, you can enter values in the Start and End boxes at the top of the Track Editor 
and the Duration and Clip Start Offset entries in the Clip Inspector to trim a clip more 
precisely so that you can repeat exactly the trim on other clips.

To use the start and end values to position and trim a clip:
1 Select the clip you want to trim. Its start and end values appear in the Track Editor’s 

Start and End boxes.

2 Enter a new Start time. The beginning of the clip moves to that time. 

This moves the entire clip, but does not actually trim it. 

3 Enter a new End time. The end of the clip is trimmed to that time.

To use the Clip Inspector to trim a clip:
1 Select the clip you want to trim. 

The clip appears in the Clip Inspector.

2 Enter a new Clip Start Offset to trim the clip’s start. 

The clip’s start position on the timeline is not changed—only its end position is moved 
to match its new duration.

3 Enter a new Duration value to trim the clip’s end.

Clip Conflicts
There are a number of rules to keep in mind when you trim and position a clip.

Video Clips
Dragging clips to the V1 stream is different from dragging audio clips. In part this is due 
to the requirement that there can be no gaps in the V1 stream, and there must be a 
clip at its beginning. 

The following situations cause video clips already in the V1 stream to move. This can 
cause problems if the video clips have associated audio or markers, since they do not 
move with the video.



378 Chapter 11    Creating and Editing Tracks

 

• If you drag a video clip to the start of a V1 stream that already has a clip assigned, the 
new clip becomes the first clip and the original one (and any that follow it) shuffle 
down the timeline.

• If you drag a video clip to the point where two existing video clips meet in a V1 stream, 
the new clip is inserted between them.

• If you drag a video clip to the stream, and the “Find matching audio when dragging” 
preference setting is enabled, the audio in the A1 stream is trimmed or moved to 
accommodate the new video clip, even if that clip does not have matching audio. 
This maintains sync between the track’s existing video and audio clips. 

Audio Clips
Since audio clips can be placed anywhere in their audio streams, the results are 
different from those you get when working with video clips.
• If you drag an audio clip to any open area within an audio stream, the clip is placed 

there. If the open area is not long enough to hold the whole clip, the clip’s end is 
trimmed so that it will fit. Unlike video clips, audio clips do not move unless you 
move them intentionally.

Setting Stream Properties
Each stream has a few settings you can use while configuring it.

Choosing Streams
Each stream has a button at the far-left side of the Track tab that you can click to 
enable that stream when you play the track in the Viewer tab. You can choose one 
video, and optionally, one audio and one subtitle stream.

Click to lock the stream, 
preventing inadvertent 
changes to it.

Choose a language to 
assign to each audio and 
subtitle stream.

Click to choose one
video, audio, and subtitle

stream to play in the
Viewer tab.
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Assigning Languages
Each audio and subtitle stream in a track can have a language assigned to it. When the 
track plays, it can select a stream based on the DVD player’s language setting. If no 
suitable stream is found, the player plays the first stream.

Note:  The Languages area of the Outline tab and the Add Language icon in the toolbar 
are used when creating multiple-language menus, and are not used by the Track Editor. 
See “Setting Up Menus for the Languages” on page 355 for more information.

Locking a Stream
You can protect a stream from accidental changes by clicking its lock icon. When it is 
open (unlocked), you can make changes to the stream; when the lock is closed, you 
can’t. You can still select it for previewing and assign a language to it, but you cannot 
make any changes to its clips. 

To lock all streams, do one of the following:
m Choose Project > Timeline > Lock All Streams.
m Press Shift-F4. 

Exporting an MPEG Clip
You can export the contents of the V1 stream as an MPEG file. This can be useful in 
several situations:
• If you have a long video asset and want to make a separate asset of a small part of it, 

you can add the asset to the stream, trim it to the size you want, and export it as a 
new asset. You can use this asset as you would any other asset. For example, you 
could use it as a menu background.

• You can edit multiple assets into the stream, and then export them as a single MPEG file.

Note:  You cannot export the stream as an MPEG file if the stream contains still 
images or uses H.264 format clips.

To export an MPEG file from the V1 stream:
1 Configure the stream as needed.

2 Do one of the following:

• Choose File > Export > MPEG File.
• Control-click the stream, then choose Export MPEG File from the shortcut menu.

3 Enter a name and select a destination for the file in the Save Stream dialog that 
appears, then click Save.

When exporting a large asset, be sure you have sufficient disk space to hold the file.
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Working With Markers
You can add up to 255 markers to a track, although a maximum of 99 can be set as 
chapter markers. Each marker has its own properties that define its purpose. Markers 
can be used to:
• Identify chapter points that the viewer can skip to when viewing the title
• Define when buttons appear over the video stream
• Identify the dual-layer break point when creating dual-layer projects
• Identify points in the stream that can be accessed by buttons and scripts
• Identify points where mixed-angle tracks can start
• Configure a DVD@CCESS operation to launch once the viewer reaches the marker 

point while playing the title
• Set a jump to another element in the project once the marker reaches its end. This is 

most often used by scripts that are set to play a portion of the stream and then 
return to another place in the project. 

There are three ways to place markers on your track:

• You can manually place the markers along the track’s timeline.
• If you are editing your video using Final Cut Pro 3.0.2 or later, Final Cut Express, or 

iMovie 3.0 or later, you can place the markers as part of the editing process. These 
markers are automatically imported into DVD Studio Pro when you import the video 
asset. See “Adding and Configuring Markers in Final Cut Pro and Final Cut Express” on 
page 72 and “Adding Markers in iMovie” on page 75 for more information.

• You can import a text file that contains a list of markers.

With all three methods, you can always edit the markers’ position and attributes as needed.

About Marker Placement
Markers can only be placed on Group of Pictures (GOP) boundaries. Because of this 
restriction, you cannot precisely position a marker on the exact frame you want to—
you often need to set the marker either a little early or a little late. The length of the 
GOP depends on the MPEG encoder’s settings (NTSC systems commonly use a GOP size 
of 15 frames and PAL systems commonly use a GOP size of 12 frames). This means that, 
unless you embed markers with a video editor, you may need to set a marker as much 
as 6 or 7 frames from where you’d like.

If you import markers from a timecode list, the markers are moved to a GOP boundary 
when they are imported. The Track pane in DVD Studio Pro Preferences lets you choose 
how the markers are placed. See “Track Preferences” on page 116 for more information.

If you import a video asset edited with a version of Final Cut Pro, Final Cut Express, or 
iMovie that supports chapter markers, the embedded MPEG encoder automatically 
adds GOP boundaries at the marker frames, so the markers end up positioned exactly 
where intended.
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If you convert a slideshow to a track, each still clip has a marker placed at its beginning. 
The markers are named the same as the still asset used for its clip. These markers retain 
any pause and DVD@CCESS settings that may have been set in the Slideshow editor. If 
any slides use transitions, the transitions appear as a shaded area in the timeline with a 
cell marker at their beginning. 

You can configure the transition by selecting the clip and making changes in the Clip 
Inspector’s Transition tab. If a still with a transition also has a pause, the marker for the 
next clip is placed at the beginning of the transition instead of at the next clip’s start. 
See “Using Still Clip Transitions” on page 398 and “Converting a Slideshow to a Track” 
on page 424 for more information.

See “Working With GOP Settings” on page 59 for more information about GOP 
structures, and “Adding Markers to Your Video” on page 70 for information on using 
Final Cut Pro, Final Cut Express, and iMovie to add markers to a clip.

Creating and Editing Markers
Each track always contains a chapter marker at its beginning. You can add up to 98 
additional chapter markers to a track.

Markers appear along the top of the timeline display. A vertical line extends across all 
streams at the position of each marker.

To add a marker to a track, do one of the following:
m Click in the area above the timeline display. A marker is added at the point where 

you clicked.
m Position the playhead at the point where you want to add the marker, then press M.

By default, the marker is set to be a chapter marker, and is purple. See “About the 
Marker Types” on page 386 for more information about the marker types. 

Transition indication
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Depending on the currently selected stream size, a thumbnail image of the frame located 
at the marker point appears in the video stream. You can modify the thumbnail image in 
the Marker Inspector. See “Setting Marker Properties” on page 387 for more information.

The default marker’s name is “Chapter _,” with “_” being the next number available. The 
number is based on the order in which you create the markers, not on their location on 
the track. This means Chapter 4 may occur before Chapter 2. To avoid confusion, you 
should rename your markers in the Marker Inspector. See “Setting Marker Properties” 
on page 387 for more information. The Track pane in DVD Studio Pro Preferences 
contains a setting you can use to control the names assigned to markers as they are 
created. See “Track Preferences” on page 116 for more information.

When you have multiple clips in the V1 stream, you can also have markers placed at a 
stream’s clip end (except for the last clip).

To add a marker to a clip’s end:
m Control-click the clip in the V1 stream to base the marker on, then choose Add Marker 

to Clip End from the shortcut menu to add a cell marker, or Add Chapter to Clip End to 
add a chapter marker.

You cannot add a marker to the end of the last clip in the V1 stream. See “About the 
Marker Types” on page 386 for information on the difference between a cell marker 
and a chapter marker.

To set the playhead to a marker’s position:
m Control-click the marker, then choose Set Playhead Here from the shortcut menu.

This makes it easier to see the video at the marker’s position. You can also hold down 
the Control key and use the Left and Right Arrow keys to jump from marker to marker.

To move a marker, do one of the following:
m Drag the marker to its new position. The timecode of the marker’s position appears 

next to the pointer timecode display as you move it.
m Enter a new time in one of the timecode boxes (zero-based or asset-based) in the 

Marker Inspector. See “Setting Marker Properties” on page 387 for more information.
m Drag the slider underneath the video thumbnail in the Marker Inspector.

When you move a marker, the thumbnail image in the video stream changes to match 
the marker’s new location.
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To delete a marker, do one of the following:
m Control-click the marker, then choose Delete Marker from the shortcut menu.
m Select the marker, then press the Delete key.

To delete all markers, do one of the following:
m Choose Edit > Delete All Markers.
m Control-click in an empty part of the Track Editor’s marker area, then choose Delete All 

Markers from the shortcut menu.

Adding Markers to a Track Without a Video Clip Assigned
You can add markers to a track even if you have not assigned a video clip to the track. 
You can also add markers beyond the end of the video clip, in anticipation of adding a 
video clip later. In these cases, since the GOP structure is unknown, you can place the 
markers at any frame. Once the video is added, however, the markers will need to be 
adjusted since most will not be at legal GOP boundaries.

DVD Studio Pro automatically readjusts the marker positions based on the Snap To 
setting in the Track pane in DVD Studio Pro Preferences.

What Happens to the Markers If You Move the Video?
When you place markers in the Track Editor with a video clip already present, the 
markers are automatically placed at GOP boundaries. If you move a marker, it will jump 
from one GOP boundary to the next, and will therefore always be in a legal position.

If you move the video clip—for example, by trimming its start or dragging it to 
another position when multiple clips are in the V1 stream—the markers do not 
reposition to follow the video. There is also a good chance that at least some of the 
markers will no longer be at GOP boundaries. For this reason, you should be sure the 
video is in its final location before adding markers to it.

When you build your project, DVD Studio Pro verifies that all markers are on GOP 
boundaries, and that none are placed after the end of the V1 stream’s video. A setting 
in the Track pane in DVD Studio Pro Preferences determines whether the build will 
abort if invalid markers are found, or if it will reposition markers to a GOP boundary 
and remove excess markers from the end of the track and continue with the build. 
See “Track Preferences” on page 116 for more information.
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Importing Markers From an Editor
When you edit your video asset in iMovie, Final Cut Pro, or Final Cut Express, you can add 
chapter markers that DVD Studio Pro uses to create markers on the track. If you have 
named the markers, DVD Studio Pro uses those names when it creates the markers.

How you add the video asset to your project determines what happens with the markers:

• If you add the asset by dragging it to the Menu Editor, you can choose any of the Drop 
Palette options that create a track. In addition to creating a track with the markers in 
place, some options create chapter index menus. The chapter index menu buttons 
are automatically linked to the track’s markers.

• If you add the asset by dragging it to a track, you can import the markers from the 
Track Editor. 

Note:  The first marker in a track is always at the beginning of the timeline, and is 
named “Start” when a track is created by dragging the video asset to the Menu Editor. 
It is not affected by imported markers. You can rename the marker as needed. 

To use the Menu Editor to import an asset with chapter markers:
1 Drag the video asset with markers to the Menu Editor. You can drag it to an existing 

button or to an empty area. 

2 When the Drop Palette appears, choose an option that creates a track. 

3 If you choose an option that creates a chapter index menu, select the template or 
layout style to use for the chapter index menu in the dialog that appears.

DVD Studio Pro creates the chapter index menu and a new track. The chapter index 
menu contains a button for each marker. Depending on the number of markers and 
the template or layout style you select, there may be multiple chapter index menus, 
and each marker button may have the name and a thumbnail image of the video 
frame located at its marker. Each of these marker buttons is linked to the new track, 
which displays the markers along with their names.

To import chapter markers directly into a track:
1 Drag the video asset with markers to the V1 stream of the Track Editor.

If there are currently no markers in the track (other than the one at the start of the 
timeline), the clip’s markers are automatically imported. If there are markers in the track 
other than the one at the timeline’s start, you must manually import them.

2 Control-click the clip, then choose Import Embedded Markers from the shortcut menu.

While this does not create chapter index menus, you can create them later by dragging 
this track from the Outline or Graphical tab to the Menu Editor. The advantage of this 
method is that you can add or edit the track’s markers before creating the chapter 
index menus.
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Importing Markers From a Text List
You can create a list of timecode points that DVD Studio Pro can import to create 
markers. The timecode values need to match the timecode of the track’s video clip. The 
list of timecode values must be a plain text file; you can create it with TextEdit (as long 
as you save the file as plain text). If you create the list with a more advanced word-
processing application, be sure to save the file as a plain ASCII text file with no 
formatting. The file must follow these rules:
• Each marker must be on a new line that starts with a timecode value in the 

“00:00:00:00” format. These values identify the marker positions.
• After the timecode value, you can include a name for the marker. You can use a 

comma, space, or tab character to separate the timecode value from the marker name.
• Any lines that do not begin with a timecode value are ignored. This makes it easy for 

you to add comments to the list.
• The timecode values do not have to be listed in chronological order.

To import a marker list from a text file, do one of the following:
m Choose File > Import > Marker List.
m Control-click in the Track Editor’s marker area in the track you want to apply the marker 

list to, then choose Import Marker List from the shortcut menu.

Once the import is complete, a message appears stating how many markers were 
imported. The markers are placed on the timeline at GOP boundaries. The Track pane in 
DVD Studio Pro Preferences contains a setting that controls how the GOP is chosen. 
See “Track Preferences” on page 116 for more information.
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About the Marker Types
There are four types of markers you can have in the track. One marker can be one or 
more of these types. The color of a marker in the Track Editor indicates its type—if you 
configure a marker to be more than one type, the marker symbol splits to display the 
relevant colors.

The types of markers and their colors are:

• Chapter:  purple
• Button highlight:  orange
• Dual-layer break:  black dot in the marker’s middle
• Cell:  green

You define the type of marker in the Marker Inspector. Additionally, you can set a 
marker to be a button highlight type by Control-clicking it and choosing Button 
Highlight Marker from the shortcut menu. 

Note:  Only chapter markers can be connected to from menu buttons and scripts. 

Each marker has a duration that is determined by the distance between it and the next 
marker. This duration is especially important when using button highlight markers, since 
it determines how long the highlights display over the video, and when creating stories, 
since it determines the length of each story’s segment. See “Creating Buttons Over 
Video” on page 460 and “Working With Stories” on page 390 for more information.

Chapter Markers
By default, all markers you create start out as chapter markers. Viewers can jump to 
these markers by pressing the Previous and Next buttons on their DVD player’s remote 
control. Only chapter markers can be connected to from other project elements such 
as menu buttons and scripts, and a track’s story can only use track sections defined by 
chapter markers. While a track can have up to 255 markers, it is limited to a maximum 
of 99 chapter markers.

Note:  The Previous and Next buttons can act differently on different DVD players. See 
“Getting Consistent Previous and Next Button Behavior” on page 602 for more 
information.

Chapter markers have an end jump setting. By default, this is set to Not Set, which 
actually means that playback will automatically jump to the next video frame. In almost 
all cases you will leave the End Jump set to Not Set; however, you may have non-standard 
situations where you need to set the End Jump to a specific element. In these cases, you 
are limited to a maximum of 106 chapter markers and individual end jump chapter 
settings. See “Setting Chapter Marker End Jumps” on page 530 for more information.
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Note:  

 

The DVD specification does not allow subtitles to extend across chapter markers. 
For that reason, subtitles that cross chapter markers are automatically split into 
multiple subtitle clips at each marker when you build your project.

 

Button Highlight Markers

 

You use button highlight markers when you want to have buttons display over the 
video on the track. These buttons are actually configured as part of a subtitle clip. The 
buttons appear once you reach the marker and disappear when you reach the next 
marker (unless it has also been configured as a button highlight marker). Often referred 
to as “buttons over video,” this feature allows you to provide choices to viewers while 
they watch the track part of the title. See “Creating Buttons Over Video” on page 460 
for more information on using buttons over video.

 

Important:  

 

There must be at least 1.5 seconds between a button highlight marker and 
the next marker.

 

Dual-Layer Break Markers

 

When you create a dual-layer title, you can set a marker to be used as the 

 

dual-layer 
break point,

 

 the point where the title splits between the first and second layer. Since the 
break point is often noticeable when playing the disc on a DVD player (the video 
temporarily freezes), you want to try to choose a place in the track where the freezing 
is not as noticeable. See “Choosing a Dual-Layer Break Point” on page 578 for details on 
choosing a dual-layer break point.

 

Cell Markers

 

All markers define a cell in the track. A cell marker is a marker that has no specific 
assignment. They are often added to a track to start a DVD@CCESS action or to provide 
a break point for a button highlight marker.

 

Setting Marker Properties

 

When you select a marker, the Marker Inspector appears. It has two tabs:  General and 
User Operations.

See “User Operations” on page 598 for details on the settings in this tab. Also see 
“Getting Consistent Previous and Next Button Behavior” on page 602 for information 
specific to user operations and markers.
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Settings at the Top of the Marker Inspector

• Name:  Enter the name for the marker. See “Track Preferences” on page 116 for 
information on how DVD Studio Pro can automatically assign names to markers. A 
number is automatically appended to the name you enter if a marker with that name 
already exists on that track.

• End Jump:  Choose the project element to jump to when the marker finishes playing 
(occurs just before the next marker is reached). This is typically left at “not set.” In 
most cases, if you leave it at “not set,” each marker is automatically connected to the 
next marker. This setting can be used by specialized projects and scripts that 
dynamically control which parts of the track plays. See “Setting Chapter Marker End 
Jumps” on page 530 for more information.

General Tab in the Marker Inspector

• Thumbnail:  The thumbnail is the video frame where the marker is located. You can 
drag the slider beneath the thumbnail image to move the marker to a new position.

• Save Still:  Click to save the thumbnail image as a video resolution TIFF file. You can 
import this file for use as a menu background or shape asset. This is useful as a way 
to create a still image from a frame of a video asset.

Marker thumbnail
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• Zero-Based:  Shows the marker’s timecode based on the timeline’s zero-based mode 
(based on the timeline’s first frame being 00:00:00:00). You can reposition the marker 
by entering a new value or using the arrows. The new position must correspond to a 
GOP boundary—the arrows jump one GOP at a time.

• Asset-Based:  Shows the marker’s timecode based on the timeline’s asset-based mode 
(based on the timecode of the timeline’s first clip or a value entered in the Track 
Inspector’s Other tab).

• Type:  Select the function to assign to the marker. You can select one or all functions. 
See “About the Marker Types” on page 386 for information.

• Wait:  Use this control to set how long the DVD player displays the last frame of the 
marker’s video before exercising the End Jump setting.
• None:  Immediately jumps to the End Jump setting.
• Seconds:  Shows the marker’s last frame for the number of seconds you enter.
• Infinite:  Shows the marker’s last frame indefinitely. 

• Pause after each VOBU:  Select if you want playback to pause until the viewer presses 
the Play button, when it plays to the next VOBU (Video Object Unit) and pauses again. 
This is a way to pause the track’s playback and wait for the viewer to start it again.

The length of a VOBU varies depending on whether it is a still image or full-motion 
video. When you place a still image in the video stream, it lasts for one VOBU 
regardless of its duration. With video, a VOBU can be from 0.4 to 1 second long. For 
this reason, “Pause after each VOBU” is generally only used on markers at still 
boundaries. You should avoid using it on markers with video since it will cause the 
playback to stop about once a second.

• DVD@CCESS:  Select to make the name and URL settings available for this marker, 
which allows you to add functionality to your title when played on a computer. See 
“DVD@CCESS” on page 594 for more information.

• Remote Control:  Choose the place in the project to jump to if the viewer presses the 
remote control’s Menu button. See “Remote Control Settings” on page 608 for more 
information on remote control settings.

• Macrovision:  SD projects only. Choose the Macrovision setting to apply to this 
marker’s video. See “About the Macrovision Settings” on page 560 for more 
information on Macrovision copy-protection.
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Working With Stories
A story is simply a way to rearrange the playback of the track cells defined by the 
chapter markers. You may want to create a version of a track that skips some 
objectionable content, or you may want to use a short piece of the track as a preview. 
A story does not increase the amount of disc space the track requires since it is simply 
playing the track’s markers in a different order.

A story has access to the entire track, but it does not have to include it all. You can 
choose which chapter markers to include and in what order—you can even play a 
marker’s video more than once. 

Additionally, you can exclude and subtitle audio streams from a story. By default, a story 
has access to the same audio and subtitle streams that the track has access to, which can 
be a problem if your intention is to present a less objectionable version of the track by 
providing alternative audio and subtitle streams. By excluding selected audio streams, 
you can force the DVD player to play the alternate audio and subtitle streams.

Creating a Story for a Track
Since stories are associated with the current track, you need to make sure you select 
the correct track before creating the story.

To create a story for a track:
1 In the Outline or Graphical tab, select the track for which you want to create a story.

2 To create the story, do one of the following:

• Choose Project > Add to Project > Story.
• Control-click in the Outline or Graphical tab, then choose Add from the shortcut 

menu and Story from the submenu.
• Control-click the track, then choose Add from the shortcut menu and Story from 

the submenu.
• Click Create Story in the toolbar.
• Press Shift-Command-T.

3 Double-click the new story. 

The Story Editor appears.
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Using the Story Editor
The Story Editor is where you create your story. 

The Story Editor contains two halves:

• The left half is the source list, which contains a list of all markers in the track. You 
cannot directly make changes to the source list. 

• The right half is the entry list, where you create your story by dragging markers from 
the left half (the source list).

As you drag markers from the source list to the entry list, you add story entries. Each 
entry shows the source marker’s name and the running time of the story, based on the 
duration of that marker and all markers ahead of it. A number is added to the end of 
the source marker’s name if the marker appears more than once in the entry list.

To delete a marker from the entry list:
m Select the entry, then press the Delete key.

The entry is removed from the entry list.

To change an entry in the entry list:
m Control-click the entry, choose Change Chapter from the shortcut menu, then choose 

the marker you want to replace the entry with from the submenu.

You can also change a story entry’s source marker in the entry’s Story Inspector.

To change the order of the entry list:
m Drag an entry to a new position. 

The order of the entries in the entry list controls how the story plays. This makes it easy 
to rearrange the order if you inadvertently mix up a couple of markers.

Choose a story
from the current

track to edit.

The entry list. Drag 
markers to this list to 
create your story.

The source list. Drag markers 
from this side to the other side 
to create your story.
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Setting Story Properties 
The Story Inspector has two tabs:  General and User Operations.

See “User Operations” on page 598 for details on the settings in this tab.

Settings at the Top of the Story Inspector

• Name:  Enter the name for the story. 
• End Jump:  Choose the project element to jump to when the story finishes playing. This 

is typically left at Same as Track, but can be set to any other element in the project.

General Tab in the Story Inspector
The Story Inspector appears when you select a story in the Outline or Graphical tab. If 
you select an entry or marker in the Story Editor, the Inspector changes to display 
details about that item. Select the story in the Outline or Graphical tab to switch back 
to the Story Inspector.

• Stream Options:  Deselect the checkboxes to disable any audio and subtitle streams 
you do not want to be available when this story plays. This is useful when you don’t 
want the story to have access to streams that might contain objectionable content.

• Remote Control:  Choose what happens when the viewer uses the Menu button of the 
remote control. See “Remote Control Settings” on page 608 for more information.
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• Pre-Script:  The script you choose in this pop-up menu will run as soon as the story is 
selected. The script determines whether to play the story or configure the DVD player 
before playing it. See Chapter 14, “Creating Scripts,” on page 467 for information 
on scripts.

• Wait:  Use this control to set how long the DVD player displays the last frame of the 
story’s video before exercising the End Jump setting. 
• None:  Immediately jumps to the End Jump setting.
• Seconds:  Shows the story’s last frame for the number of seconds you enter.
• Infinite:  Shows the story’s last frame indefinitely. 

• Display Condition:  Select this checkbox to set display condition settings to control 
whether this story should play or not, and to define what should play if not this story. 
See “Display Condition” on page 603 for more information.

Setting Story Entry Properties
If you select a marker in the Story Editor’s source list, the Marker Inspector appears, 
displaying the settings for that marker. See “Setting Marker Properties” on page 387 for 
an explanation of this window. 

If you select an entry in the entry list, the Story Marker Inspector appears.

• Name:  Enter the name for the story entry. This does not affect the marker’s name.
• End Jump:  Choose the project element to jump to when the entry finishes playing 

(occurs just before the next entry is reached). This is typically left at “not set.” In most 
cases, if you leave it at “not set,” each story entry is automatically connected to the 
next entry. This setting can be used by specialized scripts that dynamically control 
which parts of the track play. 
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• Zero-Based:  Shows the story entry’s timecode based on the timeline’s zero-based 
mode (based on the timeline’s first frame being 00:00:00:00). 

• Asset-Based:  Shows the marker’s timecode based on the timeline’s asset-based mode 
(based on the timecode of the timeline’s first asset).

• Track Marker:  Choose a marker from the source list to assign to this entry.
• Remote Control:  Choose the place in the project to jump to if the viewer uses the 

Menu button of the remote control. See “Remote Control Settings” on page 608 for 
more information.

Simulating a Story
Simulating a story allows you to verify that it plays as expected. 

To simulate a story, do one of the following:
m Select the story, then choose File > Simulate Story.
m Control-click the story’s name in the Outline tab or its tile in the Graphical tab, then 

choose Simulate Story from the shortcut menu.
m Select the story, then press Command-Option-0 (zero).

These methods force the Simulator to start at this specific story instead of the First Play 
connection, as it does when you open it using the icon in the toolbar. You can also start 
the Simulator from a specific story entry.

To simulate a story entry, do one of the following:
m Select the story entry in the Story Editor, then choose File > Simulate Story Entry.
m Control-click the story entry, then choose Simulate Story entry from the shortcut menu.
m Select the story entry, then press Command-Option-0 (zero).

Once the story starts playing, you can use the Simulator’s controls to choose the 
streams to view (angle, audio, and subtitle).

See “Simulating Your Project” on page 546 for information on using the Simulator.
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Adding Alternate Video Streams
One feature unique to the DVD medium is the viewer’s ability to switch between 
parallel video streams with continuous audio. Only one video stream at a time can 
serve as the active stream, but there can be as many as eight alternate streams, for a 
total of nine “camera angles.” These can be different camera views, or angles, of the 
same subject, or they can be any other video sources. 

For example, a concert video could use different camera angles for the alternate video 
streams, with cameras focusing on each musician. Stream V1, the main video stream, 
could be an edited version of all angles while streams V2 to V9 could be unedited 
versions of each musician. This would allow the viewer to choose whether to see the 
whole concert or focus on a specific aspect of it.

In another example, the V1 stream could contain the normal view of a business 
presentation, including the presenter, and the presentation’s slides could be displayed 
up close on the V2 stream. 

Multi-Angle and Mixed-Angle Tracks
DVD Studio Pro allows you to create either multi-angle or mixed-angle tracks. With a 
multi-angle track, the alternate video streams are the same length as the main stream. 
A mixed-angle track uses partial alternate video streams.

Authoring with multi-angle video is an exciting capability of the DVD medium, though 
there are some disadvantages, the main one being that multi-angle video streams 
consume a great deal of disc space. A DVD capable of holding 120 minutes of video has 
its play time reduced to 60 minutes if there are two video angles (120 divided by 2), 
and to 13.3 minutes if there are 9 video angles.

A space-efficient method of taking advantage of the alternate video streams is to build 
DVD projects that have a single video stream for most of their playing time, but that 
provide alternate streams in certain sections. This is known as using mixed angles.

Angle
1
2
3
4

Mixed-angle track with stream 3 playing 
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About Alternate Stream Video Assets 
If you want to switch between video streams while the DVD is playing, the DVD 
specification sets some restrictions on the alternate streams. They must be in the same 
MPEG format and have the exact same GOP structure as the main stream. It is strongly 
recommended that you use the same encoder for all streams to ensure they match exactly.

For multi-angle tracks, all streams, including the main one, must be the exact same length.

For mixed-angle tracks, you use markers to define one or more sections of the main stream 
that contain the alternate streams. There are three basic rules for the alternative sections:

• Within a track, you can use markers to define multiple sections to use additional 
angles, but each section must have the same number of streams. For example, you 
cannot have one section early in the track with two alternate streams and a section 
later in the track with three alternate streams—both sections must have either two 
or three streams.

• Each alternate angle section can be different lengths, but all streams within a section 
must be the same length. For example, you can have one mixed-angle section early in 
the track that is 10 seconds long and a second mixed-angle section that is 20 seconds 
long. All alternate streams in the first mixed-angle section must be 10 seconds long; all 
alternate streams in the second mixed-angle section must be 20 seconds long.

• You cannot use still images in the V2 through V9 streams. You can use still images in 
the V1 stream as long as they are outside of the mixed-angle areas (places where 
video is present in the V2 through V9 streams). 

See “Encoding Video for Multi-Angle Tracks” on page 68 for more information on 
stream requirements.

Creating a Multi-Angle Track
To create a multi-angle track, you need to use two or more suitable video assets that 
are the exact same length and have the same GOP structure.

To create a multi-angle track:
1 Configure the Track Editor so that you can see as many video streams as you intend to 

use. See “Viewing the Streams” on page 364 for details.

2 Add the main video asset to the track’s video stream 1 (V1). 

3 Add the second video asset to the track’s second video stream (V2).

4 Continue adding video assets to the next available streams until they are all in place.

You can name each clip in each stream using the Clip Inspector.
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Creating a Mixed-Angle Track
With a mixed-angle track, the main video stream runs the full length of the track with 
the alternate streams using only a small part of that time. Each of the track’s alternate 
video streams is aligned to a marker, and all corresponding alternate video assets start 
at the same point. 

Each alternate stream must use assets with the same length, and their GOP structures 
must match the main video stream.

To create a mixed-angle track:
1 Configure the Track Editor so that you can see as many video streams as you intend to 

use. See “Viewing the Streams” on page 364 for details.

2 Configure the V1 stream as needed. If you are adding multiple clips or still images, 
place them all and make any necessary adjustments before adding anything to streams 
V2 through V9.

3 Create a marker where you want the first mixed-angle portion to begin.

4 Add the second video asset to the track’s second video stream (V2) at the marker. 

The asset snaps to the marker. Use the timeline zoom control to verify the asset is 
positioned properly.

5 Continue placing video assets to the next available streams until they are all in place 
and lined up with the marker.

6 Add a marker at the end of the angle clips by Control-clicking the clip in the V2 stream 
and choosing Add Marker to Clip End from the shortcut menu.

7 If you are adding an additional mixed-angle section to the track, add another marker 
and repeat steps 3 through 6.

You can name each clip in each stream using the Clip Inspector.

Important:  To avoid errors when building your project, do not edit the V1 stream (add, 
trim, or remove assets) once you have added assets to the V2 through V9 streams. 
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Using Still Clip Transitions
When you add a still asset as a clip to a track, you are able to configure a transition for 
it. The transition can be an effect, such as a dissolve or wipe, that provides a smooth 
transition from the still clip to the next clip.

Each still clip in a track has its own transition settings, accessible in the Transition tab in 
the Clip Inspector. You can also set a default transition for the track in the Transition tab 
in the Track Inspector.

The transition is considered part of the still clip, and, in most cases, does not affect its 
duration. Using long transitions may lead to the still being visible for only a short time, 
or may require the clip’s duration to be increased. If any clips use transitions, the 
transitions appear as a shaded area in the timeline. 

Each transition has a start and end frame. The start frame is the still you are 
transitioning from and the end frame is the still you are transitioning to. If you are 
transitioning to a video clip, the end frame is the first frame of the video clip.

Note:  You cannot configure a transition from a video clip to a still clip.

Adding Transitions to Still Clips
You can add a transition to any still clip in a track.

Setting a Track’s Default Transition
You can set a default transition for a track. All still clips with their type set to “Same as 
Track” use the transition.

To set a track’s default transition:
1 Click in an empty stream in the Track Editor to show the Track Inspector.

2 Click the Transition tab.

3 Choose the transition to use from the Transition pop-up menu.

Choose “not set” if you do not want still clips to use a default transition. (You can still 
configure individual clips to use transitions.)

4 Configure the transition using its specific parameters.

Transition indication
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Setting an Individual Still Clip’s Transition
You can set each still clip’s transition settings.

To set a still clip’s transition:
1 Click the still clip in the timeline to which you want to add the transition.

2 Click the Transition tab in the Clip Inspector.

3 Choose the transition to use from the Transition pop-up menu, or choose “Same as 
Track” to use the track’s default transition settings.

Choose “not set” if you do not want this still clip to use a transition.

4 Configure the transition using its specific parameters.

Transition Tab in the Track and Clip Inspectors
The Transition tabs in the Track and Clip Inspectors are identical—the only difference is 
that the Type pop-up menu in the Clip Inspector has a “Same as Track” choice that the 
Track Inspector does not have.

• Start thumbnail:  Shows the video frame that a still transition will start from.
• Transition thumbnail:  Provides a preview of a still transition when you click the 

Preview button. 
• End thumbnail:  Shows the video frame that a still transition will end with. This 

thumbnail is empty in the Track Inspector.
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• Transition:  Choose the type of transition to use. In the Track Inspector, this sets the 
default transition for this track, which you can override at each still clip.
• not set:  Disables default transitions for this track or still clip.

Note:  Even with “not set” chosen for the track, you can set transitions at each still clip.

• Still Transition:  Creates a transition clip based on the chosen transition and its 
related settings.

• Same as Track:  Only available in the Clip Inspector. Sets the current still clip to use 
the transition settings in the Track Inspector.

• Preview:  Click this to preview the current transition in the Transition thumbnail area.
• Parameters:  Contains the parameters for the current transition. Each transition has its 

own set of parameters. 

Transition Parameters
Each transition has its own parameters. In many cases, the settings are self-explanatory; 
however, in some cases, the settings are not obvious. See Appendix D, “Transition 
Parameters,” on page 639 for details on the parameters for each transition.

Viewing a Track
The track preview feature allows you to select a video, audio, and subtitle stream to view. 
You control which streams play using the buttons at the far-left side of the stream.

To preview a track, do one of the following:
m Control-click in the video stream, then choose Play from the shortcut menu. 
m Press the Space bar.
m Move the playhead.

The Viewer tab moves to the front (if not already there) and shows the selected video 
stream and subtitle. You can also hear the audio of the selected audio stream through 
your system’s speakers or through an external audio decoder and monitor.

You can also see the video if you drag the playhead along the timeline in the Track 
Editor. If you click in the timeline, the playhead jumps to that position and its video 
appears in the Viewer tab.
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About the Viewer Tab
You use the Viewer tab to preview tracks. It is also used as the Subtitle Editor when you 
create subtitles in DVD Studio Pro.

When previewing a track, you can use four buttons to control the preview:

• Play/Pause
• Stop
• Step Forward
• Step Reverse

Note:  The Subtitle Editor tools in the Viewer tab are unavailable unless you select a subtitle 
to edit. See “Creating Subtitles With DVD Studio Pro” on page 445 for more information.

Pausing or Stopping Playback?
The difference between pausing and stopping playback is what happens to the playhead:
• When you pause playback by clicking the Play/Pause button, the playhead remains at its 

current position.
• When you stop playback by clicking the Stop button, the playhead jumps to the 

position it was at when playback started.

You can also use your keyboard’s Space bar to pause or stop the track. The “Space bar 
toggles between play/pause” setting in the Track pane of DVD Studio Pro Preferences 
controls whether the Space bar pauses or stops the track:

• With the checkbox selected, the Space bar pauses playback, leaving the playhead at its 
current position.

• With the checkbox not selected, the Space bar stops playback, returning the playhead 
to its original position.

Holding down the Space bar while playing the clip allows you to stop playing the clip 
automatically by releasing the Space bar. The playhead then follows the above 
preferences setting.
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Modifying the Step Buttons

 

The Step Forward and Step Reverse buttons move the playhead one frame at a time. 
You can use modifier keys to enhance their capabilities.

 

•

 

Holding down the Shift key 

 

while clicking the step buttons moves the playhead one 
second at a time.

 

•

 

Holding down the Option key 

 

while clicking the step buttons moves the playhead one 
Group of Pictures (GOP) at a time.

 

•

 

Holding down the Control key 

 

while clicking the step buttons moves the playhead one 
marker at a time.

You can also click a step button and continue to hold down the mouse button to 
repeatedly step the playhead.

 

Previewing Angles

 

If you are previewing a mixed-angle track and select a video stream other than V1, the 
preview still plays the V1 stream whenever the selected video stream is not present.

To see the multi-angle or mixed-angle stream actually function, you need to use the 
DVD Studio Pro Simulator. 

Click this control to show or 
hide the viewer controls.

The Play, Stop, and
Step buttons
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Simulating a Track
Simulating a track allows you to verify all streams and any special interactivity you may 
have built into it.

To simulate a track, do one of the following:
m Select the track, then choose File > Simulate Track.
m Control-click the track’s name in the Outline tab or its tile in the Graphical tab, then 

choose Simulate Track from the shortcut menu.
m Control-click one of the streams in the Track Editor, then choose Simulate from Track 

from the shortcut menu. 
m Select the track, then press Command-Option-0 (zero).

These methods force the Simulator to start at this specific track instead of the First Play 
connection, as it does when you open it using the icon in the toolbar.

Once the track starts playing, you can use the Simulator’s controls to choose the 
streams to view (angle, audio, and subtitle).

See “Simulating Your Project” on page 546 for information on using the Simulator.
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12 Creating Slideshows

Slideshows can be combined with video tracks on a DVD 
to provide extra information about the subject, such as 
historical information, newspaper and magazine articles, 
and cast biographies. 

In much the same way you assemble video assets in the Track Editor, you can assemble 
still images in slideshows, with fixed or user-controlled duration, and with or without 
audio. With the DVD Studio Pro slideshow feature, you can also create presentations 
with high-quality audio, and even put photo albums and scrapbooks on DVDs.

Slideshows can be used for training, human resources information, education, 
corporate communications, health care, weddings, and special events. Features, 
documentaries, and promotional materials on DVD can include slideshows for 
supplementary materials.

You can also convert a slideshow to a track, allowing you to add additional audio 
streams and subtitles to it. 

A slideshow can contain up to 99 still images. Each still can have its own display 
duration, or the viewer can control when to go to the next still. You can add audio to 
each slide and let each audio file’s duration determine the slide’s display duration. 
Alternatively, you can assign one or more audio files to the overall slideshow, with each 
slide’s duration scaled so the whole slideshow fits the duration of the audio files. You 
can also assign transitions to each slide, adding effects such as dissolves and wipes as 
you play the slideshow.

But I Want My Slideshow To Do More
Even with all that DVD Studio Pro allows you to do with a slideshow, you may find 
yourself wanting it to do more. For example, if you want a panning or zooming action 
on each slide, or more than the 99–still image limit, you will need to use an editing 
application, such as iMovie, Final Cut Pro, or Final Cut Express to edit the stills together 
into a QuickTime movie.
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You can import the movie into a DVD Studio Pro track. You can even add markers and force 
manual pauses so that the viewer can still control the pace of the slideshow playback.

Another way to get around the 99–still image limit is to manually create a slideshow in 
the Track Editor.

File Formats for Slideshows
Slideshows can use a wide variety of still and audio formats. The following sections 
provide details on these formats.

Still Images in SD Projects
DVD Studio Pro lets you use most common image formats in slideshows. You can also 
use a mix of formats within a slideshow. See “File Formats” on page 97 for a list of 
supported formats.

Once a still is imported into DVD Studio Pro, it is scaled, if necessary, to fit the 
slideshow’s resolution. If any of the still images do not fit the 4:3 or 16:9 aspect ratio 
you’ve chosen for the slideshow, a background color fills the gaps. You can set the 
background color in the General pane in DVD Studio Pro Preferences. See “General 
Preferences” on page 114 for more information.

Important:  Use care not to mix 4:3 and 16:9 stills in a slideshow.

For more information about still image sources, see “Preparing Stills for Slideshows” on 
page 97.

Still Images in HD Projects
Creating slideshows for HD projects is not much different from creating slideshows for 
SD projects. The most common issue is understanding how the HD slideshows handle 
stills with respect to their resolutions.

A Resolution setting in the General pane of DVD Studio Pro Preferences defines the 
default resolution of all new slideshows (and tracks and menus) you create. However, 
the actual resolution of a slideshow is usually defined by the first still you assign to it.

For example, if your default resolution as defined by the Preferences setting is 
1280 x 720p and you create a new slideshow, its resolution is 1280 x 720p. If the first still 
you add has a 1920 x 1080 resolution, the slideshow’s resolution automatically changes 
to match it.

If the first still’s resolution is something that is non-standard, for example, a still that is 
800 x 600, the slideshow’s resolution changes to the highest resolution that is smaller 
than the non-standard size (in this example, full D1, which is 720 x 480 for NTSC or 
720 x 576 for PAL), and the image is scaled to fit. If you set a menu’s background to 
something that is smaller than full D1, it is scaled up to the full D1 size.
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After you have added one or more stills, you can choose a resolution in the General tab 
of the Slideshow Inspector to force the stills to be scaled to a specific resolution. 

Note:  As with SD slideshows, when a still does not match the 4:3 or 16:9 display mode, 
the empty areas are filled with the slideshow background color, as defined in the 
General pane of DVD Studio Pro Preferences.

Audio Files
Slideshows can have one or more audio files for the overall slideshow, or a separate file 
for each still. While you can import files in a wide variety of audio formats for use with 
slideshows, all audio files within a slideshow must have the same format, resolution, 
and bit rate. See “Preparing Audio Sources” on page 77 for more information about 
audio files.

Creating Slideshows
You add and manipulate still images in the same manner as you do video assets. You 
can drag images directly to the Slideshow Editor from the Finder, or you can drag them 
to the Assets tab, and then to the Slideshow Editor. You can also create slideshows by 
dragging groups of stills to the Menu Editor.

Adding a Slideshow to Your Project
When you open DVD Studio Pro, no default slideshow is created. You have to add a 
slideshow to include one in your project. 

To add a slideshow to your project:
1 Do one of the following:

• Choose Project > Add to Project > Slideshow.
• Control-click in the Outline or Graphical tab, then choose Add from the shortcut 

menu and Slideshow from the submenu.
• Click Add Slideshow in the toolbar. 
• Press Command-K.
• Click the Slideshow tab and drag one or more stills to the Slideshow Editor.

2 A slideshow element appears in the Outline and Graphical tabs. To open the slideshow 
in the Slideshow Editor, double-click it.

3 Enter a name for the slideshow in the Slideshow Inspector.

Use the Slideshow Inspector to set the jumps and remote control settings for the slideshow.
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Creating a Slideshow Using the Menu Editor
An easy way to create a slideshow and a button that links to it is to drag a group of stills 
to the Menu Editor and choose Create Button and Slideshow from the Drop Palette.

To create a slideshow in the Menu Editor:
1 Do one of the following to select the menu to which you want to add the button that 

links to the new slideshow:

• Choose the menu from the Menu Editor’s View pop-up menu.
• Select the menu in the Outline or Graphical tab.

2 In either the Assets tab, the Palette, or a Finder window, select two or more still images 
to be used in the slideshow. You can also select a folder that contains the still images.

3 Drag the still images to the Menu Editor, positioning them at the location where you 
want the new button to be created. You can also drag them to an existing button if you 
want to link that button to the slideshow.

4 When you hold the pointer still, the Drop Palette appears. Choose an option that 
creates a slideshow.

A slideshow is created and linked to a button on the menu.

You can modify the slideshow just like any other slideshow, adding additional stills and 
audio as desired. Use the Slideshow Inspector to set the slideshow’s name, jumps, and 
remote control settings.
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Working With Slides in a Slideshow
Once you’ve created a slideshow, you can start adding still images to it. You can add 
still images one at a time or as a group, and rearrange their order. Before you begin 
adding slides, you should set their default duration.

Setting the Default Slide Duration
The General pane in DVD Studio Pro Preferences contains a default duration setting 
that determines each slide’s length when first imported. It’s a good idea to set the 
default slide duration before adding slides to the slideshow. While this setting applies 
to all slides when first imported, you can change the duration of individual slides later.

See “General Preferences” on page 114 for more information on this setting.

You shouldn’t spend too much time fine-tuning each slide’s duration until you have 
added and arranged all slides, and have added any audio.

Adding Slides to a Slideshow
Slides can be added to a slideshow one at a time or as a group.

Note:  Do not mix slides with 4:3 and 16:9 aspect ratios in a slideshow. Slideshows only 
directly support the 4:3 aspect ratio. 

To add slides to a slideshow:
1 Select one or a group of slides in the Assets tab, the Palette, or a Finder window.

2 Drag the file or files to the Slideshow Editor. If there are existing slides in the editor, a 
line appears where you position the pointer. The Slideshow Editor inserts the new 
slides underneath the line. By moving the pointer before releasing the mouse button, 
you can control where the slides are inserted. 

If you add a group of slides, the slides are added in alphabetical order. You can easily 
rearrange the slide order later.
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Selecting Slides in a Slideshow
As you add slides to a slideshow, you will need to be able to scroll through the list and 
select the slide you want to work on.

To scroll through the slideshow list, do one of the following:
m Drag the scroller along the right edge of the Slideshow Editor.
m Press the Up and Down Arrow keys to move through the list one slide at a time.
m Press the Option key, then the Up or Down Arrow key to jump to the first or last slide in 

the list.
m Press the Page Up and Page Down keys to move through the list one page at a time.

In the last three cases, a slide is selected and it appears in the Viewer tab.

There are times when you will want to select a group of slides. For example, you might 
need to delete them, change their duration, or move them to a different point in the 
list. There are several ways to select groups of slides.

To select a group of slides, do one of the following:
m To select a group of nonadjacent slides, hold down the Command key while you select 

the slides. 
m To select a group of adjacent slides, hold down the Shift key while selecting the first 

and last slide in the group.
m Hold down the Shift key while pressing the Up or Down Arrow key to select each slide 

you scroll through. 
m Press Command-A to select all slides. You can also press Shift-Command-A to deselect 

all slides.

Rearranging Slides in a Slideshow
Use the Slideshow Editor to rearrange slides in a slideshow.

To rearrange slides in a slideshow:
1 Select the slide or slides to be moved. You can move a group of nonadjacent slides 

together, but they will end up adjacent once they are moved.
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2 Drag the slide (or slides) to a new position. When you hold a slide over another slide in 
the list, a line appears where you position the pointer. The repositioned slide will be 
inserted underneath this line when you release the mouse button.

Removing Slides From a Slideshow
You can remove slides from your slideshow, either one at a time or as a group.

To remove slides from a slideshow:
1 Select the slide or slides you want to remove in the Slideshow Editor. 

2 Do one of the following:

• Choose Edit > Delete.
• Press the Delete key.

Note:  Dragging a slide out of the list does not remove it from the slideshow.

Adding Audio to Your Slideshow
You can assign one audio file to each slide or add one or more audio files to the overall 
slideshow. The method you choose depends on the type of slideshow you are creating. 
• If each slide requires descriptive audio, having a separate file for each makes it easy to 

ensure that the audio always matches the appropriate slide. 
• If your slideshow consists of stills with an audio file providing background music, it is much 

easier to assign one or more audio files, or an “overall audio file,” to the entire slideshow.

Assigning an Audio File to Each Slide
You can assign an audio file to each individual slide in a slideshow. You can use the same 
audio file multiple times, or only add audio to a few slides and leave the others silent.

Important:  You cannot add audio files directly to slides as long as there is an overall 
audio file assigned to the slideshow. See “Assigning Overall Audio Files to the Slideshow” 
on page 413 for information on removing overall audio files from a slideshow.
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To assign audio to a slide using the Slideshow Editor:
1 Select the audio file in the Assets tab, the Palette, or a Finder window. 

Note:  You can only add one audio file at a time when assigning them to slides.

2 Drag the file to a slide in the Slideshow Editor. When you pause the pointer, a black box 
surrounds the slide the audio will be assigned to. 

3 Release the mouse button when the correct slide is selected. 

The slide’s duration changes to match the length of the audio file. You cannot change 
the slide’s duration to a different value. 

4 Press the Space bar to play the slide with its audio. Press the Space bar a second time 
to stop playback.

To assign audio to a slide using the Slide Inspector:
1 Select the slide to which you want to add audio.

2 In the Slide Inspector, choose the audio asset to assign to the slide using the Audio File 
pop-up menu.

The Audio File pop-up menu in the Slide Inspector only allows you to choose from files 
already imported into your project.

To change the audio file assigned to a slide, do one of the following:
m Drag a new file to the slide in the Slideshow Editor. 
m Choose a new file with the Audio File pop-up menu in the Slide Inspector.

To delete an audio file assigned to a slide, do one of the following:
m Select the audio file in the Audio column in the Slideshow Editor, then press the Delete 

key. Make sure you only select the audio portion of the slide.
m Choose “not set” from the Audio File pop-up menu in the Slide Inspector.

Note:  All audio files used within a slideshow must be the same type and use the same 
resolution and bit rate.
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Assigning Overall Audio Files to the Slideshow
You can assign one or more audio files to a slideshow as overall audio files. This allows 
you to have audio files that are not specific to a single slide. When you assign overall 
audio to the slideshow, you can choose whether the slide or audio durations determine 
the slideshow’s duration.

To assign overall audio files to a slideshow:
1 Select the audio file or files in the Assets tab, the Palette, or a Finder window.

2 Do one of the following:

• Drag the file or files to the audio well in the Slideshow Editor. 

The audio well shows how many overall audio files are assigned to the slideshow.

• Drag the file or files to the Audio section in the Slideshow Inspector’s General tab.

3 Do one of the following to choose one of the two Slideshow Duration options:

• Choose Fit To Audio, Fit To Slides, or Fit To Slides and Loop Audio from the Slideshow 
Editor’s Settings pop-up menu. 

Drag one or more audio 
files to this location.

Choose a Slideshow 
Duration setting.
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• Select either Fit To Slides or Fit To Audio in the Slideshow Inspector’s General tab. If 
you select Fit To Slides, you can also select the Loop Audio checkbox.

Use Fit To Audio to calculate a slide duration value that is applied to all slides, based on 
the length of the audio file. The duration ensures the slides and the audio finish at the 
same time and that all slides appear for the same amount of time. 

There are several things to be aware of when using Fit To Audio:

• Each slide’s duration automatically updates if you add or remove slides or overall 
audio files in the slideshow.

• Using a short audio file with Fit To Audio can cause the audio to finish before the 
slides, since the slides cannot be set to durations shorter than their minimum 
duration (15 frames for NTSC or 12 frames for PAL projects). The minimum duration 
for the slides increases when one or more of them uses transitions.

• All slide duration controls are disabled when Fit To Audio is selected.
Use Fit To Slides to leave each slide’s duration as is. When the slideshow is played, most 
likely the audio will not finish at the same time that the slides finish appearing. 

• If the slides finish first, the audio is clipped off. (The Loop Audio setting has no effect.)
• If the audio finishes first, the slides continue playing in silence. With Loop Audio 

selected, the audio loops back to its beginning and continues playing if it reaches its 
end before the slides.

4 Select the first slide and press the Space bar to play the slideshow with its audio. 

Important:  Adding an overall audio file automatically removes any audio files assigned 
to individual slides. As long as there is an overall audio file assigned to the slideshow, 
you cannot add audio files directly to slides.

To change the assigned audio files using the Slideshow Inspector:
m Select one or more existing files and press Delete to remove them from the slideshow.
m Drag an existing audio file to a new location in the list to change its order.
m Drag one or more new audio files to the list to add them to the slideshow.

You can also drag additional audio files to the audio well in the Slideshow Editor to add 
them to the end of the list. 
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Working With Slideshows
You use the Slideshow Editor and Slideshow Inspector to change the settings for 
your slideshow.

Setting the Slideshow Editor’s Thumbnail Size
The General pane in DVD Studio Pro Preferences contains a thumbnail image size 
setting that allows you to control the number of slides displayed in the Slideshow 
Editor. See “General Preferences” on page 114 for more information on this setting. 

Slideshow Editor Settings
The Slideshow Editor has two areas:
• The controls along its top:  These buttons and pop-up menus provide easy access to a 

variety of slideshow features. See “Slideshow Editor Controls” on page 416 for details 
on these. 

• The slide list:  This lists the slideshow’s slides in the order they appear. See “Slide List” 
on page 417 for more information.

Slideshow Editor controls

Lists the slides in the
order they appear.

The triangle indicates this 
slide has a transition, and can 
be clicked to show the 
Transition Inspector.
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Slideshow Editor Controls
The top of the Slideshow Editor contains several controls that you can use while 
making changes to your slideshow.

• View pop-up menu:  Use this to select the slideshow to open in the Slideshow Editor.
• Transition pop-up menu:  Use this to choose the default transition for the slideshow. 

See “Using Slideshow Transitions” on page 421 for more information.
• Overall Audio well:  Drag audio files here to add them to the overall audio file list. The 

graphic in the well changes to show that one or more audio files are currently 
assigned as the overall slideshow audio. When you position the pointer over the well, 
a tooltip appears that lists some overall audio file information. You can Control-click 
the well to remove all assigned overall audio files.

• Convert to Track button:  Click this button to convert the slideshow to a track. See 
“Converting a Slideshow to a Track” on page 424 for details.

• Duration:  Enter a new value or choose a value from its pop-up menu. This duration 
affects all currently selected slides. This setting is disabled if overall audio is being 
used, and the Fit To Audio mode is selected. See “Manually Changing a Slide’s 
Duration” on page 418 for more information.

• Settings pop-up menu:  Contains a variety of settings you can use with your slideshow:
• Fit To Audio, Fit To Slides, and Fit To Slides and Loop Audio:  Control how the slideshow 

uses the audio when it is configured to use overall audio. These settings are 
disabled when audio is assigned to individual slides. See “Assigning Overall Audio 
Files to the Slideshow” on page 413 for more information.

• Manual Advance:  Use to set all selected slides to pause or, if they are already set to 
pause, to turn pause off. See “Setting Up a Slideshow to Let the Viewer 
Advance the Slides” on page 419 for more information.

Choose the
slideshow to edit.

Converts the slideshow to a 
track, allowing you to add 
additional features to it.

Choose the default
transition for the

slideshow.

Sets the duration 
for the selected 
slides.

Shows that an overall audio file has
been assigned. You can drag audio

files here to add them.

Contains overall 
audio duration and 
manual advance 
settings.
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Slide List
The Slideshow Editor displays eight columns of information for each slide. You can edit 
two of these columns:  Duration and Pause.

• No.:  Displays each slide’s number, indicating its order in the slideshow. You cannot 
edit this number directly, but if you drag one or a group of slides to a new position, 
the number is changed to reflect the slide’s new position in the slideshow.

• Image:  Displays a thumbnail image of each slide. All slides with a transition assigned 
have a triangle in their lower-right corner. Press Command-= for large thumbnails 
and Command--(dash) for small thumbnails.

• File:  Displays the name of each slide’s asset file.
• Audio:  Displays the name of the audio file assigned to the slide (if applicable).
• Time:  Displays the slideshow’s elapsed time at the beginning of each slide. This time 

value does not include the duration of the slide it is listed with. All slideshows start at 
00:00:00:00. While you cannot directly edit this value, changing the duration of any 
slides positioned earlier in the list will change this time value.

• Duration:  Displays the slide duration. This value is either the default duration 
selected in the Preferences window, the length of the audio file assigned to the slide, 
or, when using an overall audio file with the “Fit to audio” option selected in the 
Slideshow Duration pop-up menu, a value calculated so that all slides play for an 
equal amount of time and match the overall audio file length. You can edit this 
duration except on slides that have an audio asset assigned to them or in slideshows 
with an overall audio file that have “Fit to audio” selected. See “Manually Changing a 
Slide’s Duration” on page 418 for details.

• Pause:  Select the checkbox if you want a pause to occur at the end of the slide. The 
viewer then manually advances to the next slide using the Next button or Play 
button on the DVD player’s remote control.

Note:  If the slide contains a transition, the pause occurs before the transition. When the 
viewer advances to the next slide, the transition plays and then the next slide appears.

You can drag the list headings to rearrange their order. You can also drag the edges of 
the Audio columns to control its width. 
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Manually Changing a Slide’s Duration
You can manually change each slide’s duration except on slides that have an audio 
asset assigned to them or in slideshows with an overall audio file that have “Fit to 
audio” selected.

To change a selected slide’s duration to a fixed value using the Slideshow Editor:
1 Select one or more slides to change their durations.

2 Do one of the following:

• Choose a set value (1, 3, 5, 10, or 15 seconds) from the Duration pop-up menu.
• Enter a value (in seconds) in the Duration field and press Return.

 

The duration of all selected slides is changed to the new value.

To manually enter a slide’s duration in the slide list in the Slideshow Editor:
1 Select the slide whose duration you want to change. 

2 Double-click the current duration setting.

The duration highlights.

3 Type the new value and press Return.

Once you press Return, the new duration is set and the Time values for all affected 
slides adjust to reflect this change. The Duration value of the next slide is automatically 
selected. If you do not want to change its duration, select a different slide.

When entering a value, you don’t need to enter a colon to define the number pairs—
the values automatically divide into pairs starting from the frames. 

If you enter a value that is greater than the maximum value for that field, the 
appropriate time is added to the next field. For example, if you enter 79 seconds, the 
seconds field displays “19” and one minute is added to the minutes field.

Note:  The minimum slide duration for NTSC projects is 15 frames; for PAL, it is 12 frames. 
The minimum is longer on slides using transitions.

Either enter a duration or choose 
one from the pop-up menu to apply 
to the selected slides.
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To manually enter a slide’s duration in the Slide Inspector:
1 Select the slide whose duration you want to change. 

2 Do one of the following:

• Enter a new duration directly. Use the same methods as when entering a new 
duration in the slide list area of the Slideshow Editor.

• Choose a duration from the Duration pop-up menu.

Setting Up a Slideshow to Let the Viewer 
Advance the Slides
You can set up your slideshow so that each slide appears for a specified length of time 
or until the viewer decides to advance to the next slide. For example, you might want 
to coordinate your slideshow for a speaker to step through each slide. This allows the 
viewer (in this case the speaker) to choose when to advance to the next slide by 
pressing the Next or Play button on the DVD player’s remote control.

To set up a viewer-advanced slideshow, do one of the following:
m Select the checkbox in the Pause column next to each slide that you want the viewer 

to be able to advance manually.
m Select a group of slides and choose Manual Advance from the Slideshow Editor’s 

Settings pop-up menu. This turns on the Pause option on all selected slides.
m Select a slide and select the Manual Advance checkbox in the Slide Inspector.

Select the Pause checkbox on slides you
want to be advanced manually.
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The pause occurs at the end of the slide’s duration. If you have added an audio asset to the 
slide, the audio plays and then the pause occurs. The viewer can press the Next button or 
the Play button on the DVD player’s remote control to continue to the next slide.

Note:  If the slide contains a transition, the pause occurs before the transition. When the 
viewer advances to the next slide using the Play button, the transition plays and then 
the next slide appears. If the viewer advances using the Next button, the transition 
does not play, and the next slide immediately appears.

Setting a Pause on the Last Slide
The viewer may have problems when playing your slideshow on some DVD players if 
you set the last slide to have a pause. Some DVD players will not react to presses of the 
Next button once the viewer reaches the last slide, which leaves the viewer with no 
way to activate the slideshow’s End Jump setting.

There are two methods you can use to avoid this problem and provide consistent 
playback on all DVD players:

• Set the slideshow’s Next Jump connection in the Connections tab.
• Duplicate the last slide in the slideshow and set the new last slide not to pause.

Setting the Slideshow’s Next Jump Connection
Each element in your project has a Next Jump connection that is normally left not set. 
The only place you can set a connection for Next Jump is in the Connections tab.

To set the slideshow’s Next Jump connection:
1 Select the slideshow in the Outline tab.

2 Click the Connections tab.

3 Choose Advanced from the Connection tab’s View pop-up menu. Make sure the 
pop-up menu next to the View pop-up menu is set to All.

4 Locate the End Jump and Next Jump items in the list of sources.

5 Set the Next Jump target to be the same as the slideshow’s End Jump setting by 
dragging the End Jump target setting to the Next Jump target.

See “Next Jump and Prev Jump” on page 529 for more information.
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Duplicating the Last Slide
Duplicating the last slide in a slideshow allows you to create a “false ending” for the 
slideshow, and avoid the pause issue.

To duplicate and configure the last slide in a slideshow:
1 In the Slideshow Editor, determine the asset name of the last slide and drag that slide’s 

asset from the Assets tab to the next slide location.

2 Select the new last slide in the Slideshow Editor and set its duration to 15 frames by 
double-clicking its duration value, entering 15, then pressing Return.

Note:  For PAL projects, you can use a 12 frame duration. 

3 Make sure the last slide’s Pause checkbox is not selected.

When you play this version of the slideshow and press the Next button on the last slide 
with a pause, it jumps to the new last slide and then to the End Jump setting.

Using Slideshow Transitions
Slideshow transitions allow you to control whether the slideshow directly jumps from 
slide to slide or uses a transition effect, such as a wipe or crossfade, to move from slide 
to slide. You are able to set a transition effect that applies to all slides in the slideshow 
or you can individually configure each slide’s transition effect.

About Transitions
Each slide has its own transition settings, accessible in the Transition tab in the Slide 
Inspector. The default transition settings for the slideshow are in the Transition tab in 
the Slideshow Inspector. 

The transition is considered part of the slide, and, in most cases, does not affect its 
duration. Using long transitions may lead to the slide being visible for only a short time, or 
may require the slide’s duration to be increased. When you select a transition for a slide, 
group of slides, or the slideshow, a warning appears if any slides must be lengthened.

Start and End Frames
Each transition has a start and end frame. The start frame is the slide you are 
transitioning from, and the end is the slide you are transitioning to. 

If the last slide in a slideshow has a transition assigned, its transition’s end frame is 
based on the slideshow’s End Jump setting. If the End Jump is set to a script, the 
transition is to black.
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Setting a Slideshow’s Default Transition
Setting the transition for a slideshow affects all slides with their type set to “Same 
as Slideshow.”

To set a slideshow’s default transition using the Slideshow Editor:
m Choose the transition from the Slideshow Editor’s Transition pop-up menu.

The transition uses its default settings. You can change the settings in the Transition tab 
in the Slideshow Inspector.

To set a slideshow’s default transition using the Slideshow Inspector:
1 Double-click an empty place in the Slideshow Editor’s control area to show the 

Slideshow Inspector.

2 Click the Transition tab.

3 Choose the transition to use from the Transition pop-up menu.

Choose “not set” if you do not want slides to use a default transition. (You can still 
configure individual slides to use transitions.)

4 Configure the transition using its specific parameters.

Choose the default
transition for the

slideshow.

The triangle indicates this 
slide has a transition.
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Setting an Individual Slide’s Transition
You can use either the Slide Inspector or the Slideshow Editor to set the transition for 
a slide.

To set a slide’s transition in the Slide Inspector:
1 Select the slide for which you want to set a transition.

2 Click the Transition tab in the Slide Inspector and set the transition parameters.

In addition to selecting one of the transitions to use, you can choose “not set” to 
disable transitions for that slide, or “Same as Slideshow” to have the slide use the 
slideshow’s default transition.

To select a transition for a group of slides:
1 Select the group of slides for which you want to select a transition.

2 Control-click one of the slides, then choose Transition from the shortcut menu and the 
transition from the submenu.

Setting the Transition Parameters
The Transition tabs in the Slideshow and Slide Inspectors are identical—the only 
difference is that the Type pop-up menu in the Slide Inspector has a “Same as 
Slideshow” choice that the Slideshow Inspector does not have.

• Start thumbnail:  Shows the video frame that a still transition will start from.
• Transition thumbnail:  Provides a preview of a still transition when you click the 

Preview button. 
• End thumbnail:  Shows the video frame that a still transition will end with. This 

thumbnail is empty in the Slideshow Inspector.
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• Transition:  Choose the type of transition to use. In the Slideshow Inspector, this sets 
the default transition for this slideshow, which you can override at each slide.
• not set:  Disables transitions for this slideshow or slide. 

Note:  Even with “not set” chosen for the slideshow, you can set transitions at each slide.

• Still Transition:  Creates a transition clip based on the chosen transition and its 
related settings. 

• Same as Slideshow:  Only available in the Slide Inspector. Sets the current slide to 
use the transition settings in the Slideshow Inspector.

• Preview:  Click this to preview the current transition in the Transition thumbnail area.
• Parameters:  Contains the parameters for the current transition. Each transition has its 

own set of parameters. 

Transition Parameters
Each transition has its own parameters. In many cases, the settings are self-explanatory; 
however, in some cases the settings are not obvious. See Appendix D, “Transition 
Parameters,” on page 639 for details on the parameters for each transition.

Converting a Slideshow to a Track
You may want to add several features to your slideshow that the Slideshow Editor does 
not support. These include:
• Subtitles
• Alternate language streams
• The ability to combine moving video with the slides

To get access to these features, you can convert your slideshow to a track. Once 
converted to a track, what was previously a slideshow is now a track, and must be 
edited in the Track Editor.

Note:  Once you convert a slideshow to a track, you cannot convert it back. You can use 
the Undo feature or create a duplicate of the slideshow before you convert it to a track. 
If you do create a duplicate of the slideshow, be sure to delete the duplicate before you 
build your project.

To convert a slideshow to a track:
1 In the Outline tab, Control-click the slideshow’s name, then choose Duplicate from the 

shortcut menu. 

An identical copy of the slideshow is created in case you need it later. You should 
delete this copy when you are sure that it is no longer needed.

2 Choose the original slideshow in the Slideshow Editor.



Chapter 12    Creating Slideshows 425

 

3 Do one of the following:

• Choose Project > Slideshow > Convert to Track.
• Click Convert To Track in the Slideshow Editor. 

The slideshow is deleted and a new track is created using the slideshow’s name.

The new track has a marker at each slide, each named with the slide’s filename. Each 
slide retains its duration and pause setting. If audio files were assigned, they are also 
present in the track.

Note:  If a slide has a transition, a cell marker is placed at the beginning of the 
transition. If the slide has pause selected, this marker is set to pause.

Setting Slideshow Properties
Selecting a slideshow in the Outline tab displays the Slideshow Inspector. The Slideshow 
Inspector contains a top section and three tabs: General, Advanced, and Transition. 

Settings at the Top of the Slideshow Inspector

• Name:  Enter the name of the slideshow. This is the name that appears in the Outline 
tab (where you can also change it). 

• Est. Size:  Displays the amount of disc space the slideshow requires.
• End Jump:  Choose a setting from this pop-up menu to determine what happens 

once the slideshow finishes playing.

Click Convert To Track to 
create a track from the 
selected slideshow.
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General Tab in the Slideshow Inspector
The settings in the General tab in the Slideshow Inspector are used to set the 
slideshow’s resolution and display mode. These settings are also used to configure a 
slideshow for overall audio, and are disabled when you are using no audio or are 
assigning audio to individual slides. 

• Resolution:  Choose the slideshow’s resolution. 
• For SD DVD projects, the resolution is either 720 x 480i (NTSC) or 720 x 576i (PAL).
• For HD DVD projects, you can choose from any of the supported resolutions. The 

resolution automatically changes to match the first slide’s resolution if it matches 
one of the supported resolutions, or to the closest smaller resolution if there is not 
a direct match. DVD Studio Pro Preferences includes a setting for the default 
resolution (which also applies to menus and tracks). See “Still Images in HD 
Projects” on page 406 for more information.

• Display Mode:  Set the aspect ratio for this slideshow (4:3 or 16:9) and, with 16:9, 
choose how it displays on a 4:3 monitor. The aspect ratio of the slide assets should 
match this setting. 
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Parameters
• Slideshow Duration:  Controls how the slideshow uses the audio when it is configured to 

use overall audio. These settings are disabled when you assign audio to individual slides. 
See “Assigning Overall Audio Files to the Slideshow” on page 413 for more information.
• Fit To Slides:  Slide durations are not changed, which means the audio can end before 

or after the last slide. Selecting Fit To Slides enables the Loop Audio checkbox.
• Loop Audio:  Select this to have the slide durations control when the slideshow 

ends. If the audio is too long, it is clipped so that it ends with the last slide. If the 
audio is too short, it loops back to the first audio asset and continues playing until 
the last slide finishes.

• Fit To Audio:  Slide durations are changed to a value that ensures the slides and 
audio end at the same time.

• Total Running Time:  Shows the duration of the slideshow.

Audio
The audio section lists the overall audio files assigned to the slideshow. You can drag a 
file within the list to change its order.
• Add (+):  Opens a file selection dialog so you can add an audio file to the list.
• Delete (–):  Removes the selected audio files from the list.
• Total Audio Duration:  Shows the combined duration of the audio files.

Advanced Tab in the Slideshow Inspector

• Pre-Script:  If applicable, you can choose a script from this pop-up menu. 
See “Pre-Scripts” on page 467 for information on using pre-scripts.

• Remote Control:  Use these pop-up menus to customize the viewer’s interaction with 
the title from this slideshow. See “Remote Control Settings” on page 608 for details. 
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Transition Tab in the Slideshow Inspector
See “Setting the Transition Parameters” on page 423 for details on the Transition tab.

Setting Slide Properties
If you select a slide in the Slideshow Editor, the Slide Inspector appears. It allows you to set 
attributes for each slide. It contains a top section and two tabs:  General and Transition.

See “Setting the Transition Parameters” on page 423 for details on the Transition tab.

Note:  Any settings you make in the Slide Inspector become marker properties if you 
convert the slideshow to a track.

Settings at the Top of the Slide Inspector

• Name:  Displays the name of the slide as it appears in the Assets tab, where its name 
can be changed. 

• Asset:  Displays the name of the slide’s actual asset.
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General Tab in the Slide Inspector

• Slide Duration:  Displays the duration of the selected slide. You can enter a new 
duration or choose a duration from the pop-up menu.

• Manual Advance:  Determines whether the slideshow pauses (checkbox selected) or 
continues playing to the next slide (checkbox not selected).

• Audio File:  Displays the name of the audio asset assigned to this slide. You can use 
this pop-up menu to choose from the audio assets already imported into this project. 

Important:  All audio files within a slideshow must have the same format, resolution, 
and bit rate. 

• DVD@CCESS:  Select this checkbox for titles played on a computer if you need to 
open an application such as a web browser to view special content when the slide 
starts playing. See “DVD@CCESS” on page 594 for information on DVD@CCESS.

Previewing a Slideshow
Before you build the slideshow, it’s a good idea to preview it.

To preview a slideshow:
1 Select the slideshow in the Outline tab.

2 In the Slideshow Editor, select the slide to start playing from.

3 Do one of the following:

• Press the Space bar.
• In the Slideshow tab, Control-click a slide, then choose Play from the shortcut menu.

The Viewer tab appears and the slideshow starts playing from the selected slide. If the 
slideshow has audio assigned, it also plays. A drawback is that pauses are ignored. You 
can use the Simulator to play the slideshow and test any pauses you have set.
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Simulating a Slideshow
Simulating a slideshow allows you to fully test a slideshow, including its pauses and 
DVD@CCESS settings.

To simulate a slideshow, do one of the following:
m Select the slideshow, then choose File > Simulate Slideshow.
m Control-click the slideshow in the Outline tab, then choose Simulate from the 

shortcut menu. 
m In the Slideshow tab, Control-click a slide, then choose Simulate from the shortcut menu.
m Select the slideshow, then press Command-Option-0 (zero).

These options force the Simulator to start at this slideshow instead of the First Play 
connection, as it does when started by clicking Simulator in the toolbar.

Once the slideshow starts playing, you can use the Simulator’s controls to test the pauses.

See “Simulating Your Project” on page 546 for information on using the Simulator.
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13 Creating Subtitles

Although the most common use for subtitles is to display 
a text version of the dialogue, subtitles created in 
DVD Studio Pro can be used for many other purposes. 

Each track can include up to 32 subtitle streams. Having multiple streams makes it possible 
to offer text in several languages, allowing the viewer to select the appropriate one.

Increasingly, subtitles are being used for other purposes, such as to create buttons over 
video (also known as interactive markers or interactive subtitles), which allow the viewer 
to make choices while watching the movie. You can also use subtitles to supply simple 
graphics to augment the video, such as arrows and lines.

You can create text subtitles directly in DVD Studio Pro, one at a time. You set their 
position, font, size, style, and color, and can have them fade in and out. You control their 
start and stop time either by entering timecode values or dragging in the timeline.

You can also import subtitle files containing all of the subtitles for a track. 
DVD Studio Pro supports files that conform to any of these formats:

• STL:  The Spruce Technologies subtitle format
• SON:  The Sonic Solutions bitmap-based format
• TXT:  A plain text file 
• SCR:  The Daiken-Comtec Laboratories Scenarist bitmap-based format

Note:  See “Importing Older DVD Studio Pro Subtitles” on page 432 for information on 
importing SPU format subtitles (subtitles created with earlier versions of DVD Studio Pro). 

Files in these formats should all contain multiple subtitle text or graphics images tied to 
timecode values, ensuring they are placed properly within the timeline.

You can also import graphics files and use them as subtitles or overlay them on the 
video. For example, you could have a graphic that traces a route on a map that appears 
in the video stream. By importing several graphics, you could effectively animate the 
graphic (by making the line move in the map, for example).
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Subtitles can also be used to superimpose buttons over the track’s video. The viewer 
selects these buttons just as they would buttons on a menu. Creating buttons over 
video is similar to creating buttons using the standard menu creation method; that is, 
both involve overlays, drawing rectangles to identify each button’s active area, and 
color mapping.

There are no limits to how many subtitles you can add to a subtitle stream. However, 
there are limits to how many subtitles you can have that provide buttons over video. 
See “How Do Buttons Over Video Work?” on page 460 for more information.

There is also no limit to the length of subtitles—you can make subtitles as short as one 
frame or as long as the track. 

Short subtitles can be useful if you want to create an animation effect, with simple 
graphics that move. See “Using Graphics Files to Create an Animation” on page 453 for 
more information.

Subtitles can be configured so that the viewer controls whether they appear, or they 
can be forced to appear.

Importing Older DVD Studio Pro Subtitles
Because of the way they are created, you cannot directly import subtitle files created 
with the Subtitle Editor in earlier versions of DVD Studio Pro. These subtitle files have 
an “.SPU” extension.

However, you can import older DVD Studio Pro projects that contain subtitles into 
DVD Studio Pro 4. Each subtitle entry is converted to a TIFF file and placed on the 
timeline at the correct location. Since the subtitles are TIFF files, you cannot edit their 
text within DVD Studio Pro 4.

Subtitles and Overlays
All subtitle types use the same advanced overlay method used in the standard menu 
creation method. This means that any graphics and subtitle files must be made of up to 
four predefined colors, on which you map the actual colors that appear when the title 
plays. See “Creating Overlays” on page 86 for information on overlay graphics.
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About Subtitles and Closed Captions
While this chapter describes working with subtitles, it is important to understand how 
they compare to closed captions, which are also supported by DVD Studio Pro when 
creating NTSC SD projects. This is especially important if you are creating DVD titles 
that must comply with accessibility requirements.

There are two methods available to you to provide visual text to the viewers of your 
NTSC SD-based DVD title:  adding subtitles and importing closed caption files. In both 
cases, text can be made to appear on the screen along with the video. However, the 
capabilities of each method are different. 

Note:  DVD Studio Pro does not support closed captions in HD projects or PAL SD projects.

Subtitle Capabilities
Subtitles generally provide dialogue text only—there is no text description of sounds 
that may also be part of a scene (although those could be added if you wish). Subtitles 
are generally intended to provide the dialogue in a second language, and assume you 
can hear the disc’s audio. 

When creating subtitles, you can define their position, size, font, and color. Subtitles do 
not actually have to be text—they can be a graphic used to display a logo or point out 
an item in the video.

All DVD players, including those used by computers, include the ability to show 
subtitles. Subtitles work the same in both NTSC and PAL projects.

Closed Caption Capabilities
Closed captions provide not only dialogue text, but also descriptions of other sounds 
that are part of a scene (such as a phone ringing or a dog barking). They are intended 
to enhance the viewing experience for deaf and hearing-impaired viewers. 

To view closed captions, you must have a suitable decoder—either built in to the 
television or as a standalone device. When creating closed captions, you choose the 
text’s position and, in some cases, its color—the font is controlled by the decoder. 

Since a lot of computers do not have closed caption decoders, playing DVD titles on them 
means you generally cannot count on being able to show any included closed captions.

Due to their reliance on information contained in line 21 of the video signal, closed 
captions, as supported by the DVD specification, apply to NTSC programs only.

See “Adding Closed Captions to a DVD” on page 611 for details on importing a closed 
caption file.
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Subtitle Stream Basics
There are several aspects of working with subtitle streams that apply whether you 
create them in DVD Studio Pro or import them.

Working With Subtitles in DVD Studio Pro
Working with subtitles in DVD Studio Pro involves using the Track Editor, the Subtitle 
Inspector, and the Viewer tab.

All subtitles, whether created with text entered in DVD Studio Pro, as individual 
imported graphics files, or as a subtitle file containing multiple subtitles, are based on 
subtitle clips in one of the 32 subtitle streams. In general, you work with the subtitle 
clips the same way you work with audio clips in the Track Editor. You can drag the clips 
to change their position and drag their edges to change their length.

The Subtitle Inspector provides the settings you use to configure each of the subtitle 
clips. Even the subtitle clips you import as part of a subtitle file can have their settings 
modified in the Subtitle Inspector.

The Viewer tab serves the Subtitle Editor function. When you double-click a subtitle clip 
in the Track Editor, its playhead jumps to the subtitle clip’s start, with the subtitle 
appearing over the track’s video. You can enter and position subtitle text directly in the 
Viewer tab. It also contains the tools you use when you create subtitles configured for 
buttons over video.

How Subtitles Switch Streams
When the viewer switches from one subtitle stream to the other, two things must 
happen before the second stream’s subtitles appear:
• The subtitle clip currently showing must reach its end. No subtitle actions, including 

switching streams and turning subtitles off, can occur until the DVD player finishes 
showing the current subtitle clip.

• A clip on the second stream must start. If a subtitle clip on the second stream starts 
before the subtitle clip on the first stream ends, it will not appear, and instead, the 
next clip on the second stream will be the first from that stream to appear.

For most standard subtitles, this happens relatively quickly and the viewer quickly starts 
seeing subtitles from the selected stream. At most they might miss one subtitle clip.
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These rules become important if you create a long subtitle clip that is the same length 
as the track because you will never be able to select it or switch from it. Having a single 
long subtitle clip is useful if you want to place a logo in a corner of the image. For this 
to work, its subtitle stream must be selected before the long clip starts, and once 
selected, you cannot switch it off or switch to a different subtitle stream.

Note:  Subtitles that cross chapter markers are automatically split into multiple subtitle 
clips at each marker when you build your project.

Subtitle Preferences
DVD Studio Pro contains a set of preferences that control many aspects of how 
subtitles appear on a stream, whether manually created or imported (unless specifically 
overridden). It is recommended that you take some time and configure these 
preferences before you start working in the subtitle streams.

The preferences cover the following areas:

• Fade and length:  The General pane in DVD Studio Pro Preferences contains the 
default settings for the fade in and out settings as well as the subtitle length. The 
fade settings apply to all subtitles except those configured to provide buttons over 
video. The length setting applies only to new subtitles you create in DVD Studio Pro.

• Font and position:  The Text pane in DVD Studio Pro Preferences contains the default 
settings for the font used with text subtitles and the position settings for both text 
and graphic-based subtitles. Depending on the type of subtitle file you are 
importing, these settings may be overridden during the file import.

• Color mapping:  The Colors pane in DVD Studio Pro Preferences contains default 
settings for the color mapping used when importing subtitle files and creating 
subtitles in DVD Studio Pro. Depending on the type of subtitle file you are importing, 
these settings may be overridden during the file import.

See “Setting DVD Studio Pro Preferences” on page 112 for more information.
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Applying Subtitle Settings to the Stream
No matter how carefully you configure your preferences and how much time you 
spend deciding how the subtitles should look, there will often come a time when you 
need to make a change to all subtitle clips in a stream (and there could be hundreds of 
clips in a stream). For example, you may need to use a different color for the text or to 
change the font. 

The Subtitle Inspector includes an Apply to Stream function that you can use to 
selectively apply changes you make in one subtitle clip to all subtitle clips in that 
stream.

There are three areas in which you can independently apply changes you make to the 
entire stream:

• Fade In and Out:  You can make changes to a clip’s fade settings in the General tab in 
the Subtitle Inspector and apply the changes to all subtitle clips in the stream.

• Text formatting:  You can make changes to a clip’s font and position settings in the 
General tab in the Subtitle Inspector and apply the changes to all subtitle clips in 
the stream.

• Color mapping:  You can make changes to a clip’s color and opacity settings in the 
Colors tab in the Subtitle Inspector and apply the changes to all subtitle clips in 
the stream.

Subtitle Inspector
The Subtitle Inspector contains settings applicable to all subtitle clips. It shows the settings 
of the currently selected subtitle clip. The Subtitle Inspector contains three tabs:  General, 
Button, and Colors. There is also the Text entry area at the top of the Inspector. 

Text Entry Area in the Subtitle Inspector

You can use the Text area to enter subtitle text for the current subtitle clip. The Text 
area also displays any text you enter directly in the Subtitle Editor. If you have imported 
the subtitle as a graphic, the Text area does not show any text contained in the graphic.

Click within the Text area to enter text. You can even combine text with an imported 
graphic. Press Return to insert a line break.
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General Tab in the Subtitle Inspector

Clip Info
• Start:  The timecode where this clip appears. You can change a clip’s start time by 

entering a new value here or by dragging the clip’s leading edge in the Track Editor. 
Changing the start time also affects the clip’s end time, but not its duration. 

• Duration:  The length of the clip. If you enter a new duration here, the clip’s end time 
changes to fit it. You can also change a clip’s duration by dragging its edges in the 
Track Editor.

• Stop Time:  The timecode where the clip stops appearing. You can change a clip’s stop 
time by entering a new value here or by dragging the clip’s trailing edge in the Track 
Editor. Changing the stop time also affects the clip’s duration. 

• Fade In:  You can enter a value (in frames) that controls how long the clip takes to 
dissolve on. The fade in starts at the clip’s start time. 

Note:  The Fade settings are unavailable when working with a subtitle clip configured 
to provide buttons over video. 

• Out:  You can enter a value (in frames) that controls how long the clip takes to 
dissolve off. The fade out finishes at the clip’s stop time.

Note:  Since there are only 16 opacity levels, setting fades longer than 20 frames 
produces noticeable “stepping” as the subtitle dissolves in and out.

• Force display:  Select this checkbox to force specific subtitle clips to appear, even if 
the viewer has disabled subtitles. Subtitle clips set to force their display will only 
appear if their subtitle stream is currently selected. 

• Apply to Stream:  Click to apply the fade in and out settings to all subtitle clips in 
this stream.
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Formatting
• Horizontal:  Sets the horizontal justification of the text. Click the appropriate icon for 

left, center, or right alignment.
• Horizontal Offset:  Trims the horizontal position of the text, in pixel steps, from the 

selected justification setting. Positive values move the text to the right and negative 
values move it to the left. A value of 0 positions the text at its justification setting.

• Vertical:  Sets the vertical justification of the text. Click the appropriate icon for top, 
center, or bottom alignment.

• Vertical Offset:  Trims the vertical position of the text, in pixel steps, from the selected 
justification setting. Positive values move the text down and negative values move it 
up. A value of 0 positions the text at its justification setting.

• Apply to Stream:  Click to apply the formatting settings to all subtitle clips in this stream.

Graphic
• File:  Shows the name of the graphics file assigned to this subtitle clip. You can enter 

the path and name for a graphics file or click the Choose button to open a file 
selection dialog.

• Offset X and Y:  Use to trim the graphic’s position. 
• Offset X trims the horizontal position. Positive values move the graphic to the right 

and negative values move it to the left. A value of 0 positions the graphic at its 
default position.

• Offset Y trims the vertical position. Positive values move the graphic down and 
negative values move it up. A value of 0 positions the graphic at its default position.

Stream
• Language:  Choose the stream’s language. This setting applies to all subtitles in the 

stream. You can also choose the stream’s language in the stream configuration area 
of the Track Editor.

• Import Subtitles:  Click this button to import a subtitle file. This file affects the entire 
subtitle stream. See “Importing a Subtitle File” on page 454 for more information.

Note:  Importing a subtitle file deletes any existing subtitle clips from the stream.
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Button Tab in the Subtitle Inspector

The Button tab in the Subtitle Inspector is empty unless the subtitle is configured to 
provide buttons over video. See “Creating Buttons Over Video” on page 460 for more 
information. 

You use the Button tab to configure the buttons to add to the subtitle. 

• Name:  By default, buttons are named “Button _,” where “_” is the button number in 
that menu. To reduce confusion when viewing a list of the menu’s buttons, it is 
helpful to rename the buttons based on their functions. 

• Default:  Choose the button to be selected when the subtitle appears during 
playback of the title. This setting can be overridden by any element that jumps to 
this subtitle’s marker, based on its jump setting.

• Target:  You can use this pop-up menu to define a button’s action when activated. 
(You can also use the Connections tab or Control-click the button.) Often you must 
set the connection later since what you want to jump to has not been added to the 
project yet. The pop-up menu contains all possible elements you can jump to.

• Highlight:  Select the color mapping set (1, 2, or 3) to use for this button.
• Angle/Audio/Subtitle Streams:  Use these three pop-up menus to have a button select 

specific angle, audio, and subtitle streams to play back. For the subtitle stream, you 
can also choose whether subtitles should appear. These settings are only active if the 
target is set to “not set.” You can set the target to run a script if you want a button to 
jump to a specific stream in a different track.
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• Remote:  This area lets you set the actions that take place when the viewer uses the 
arrow buttons on the DVD player’s remote control to navigate through the title. Since 
this is the typical way the title will be viewed, it is important to spend some time 
configuring the navigation in a logical, predictable way. See “Configuring Button 
Navigation” on page 268 for information.

• Number Pad:  Defines which buttons are directly accessible by a DVD player’s numeric 
keypad. Choose All, None, or a button number from the pop-up menu. When you 
choose a button number, that button and all buttons less than that number are 
accessible via the numeric keypad—buttons greater than this value are blocked from 
direct access.

• Button Offset:  You can use this to offset button numbers so they make sense to a 
viewer who wants to select a button by entering its number. For example, you may 
have a set of scene selection menus with numbered scenes. One of the menus may 
have scenes 23 to 34, with the button for scene 23 being the first button on the 
menu. If you enter an offset value of 22 for this menu, when the viewer enters 23 on 
the remote control, 22 is subtracted from it, with the result being 1—the button’s 
actual number.

• Coordinates & Size:  This area lets you set the location of each edge of the button’s 
active area, plus the area’s height and width. The upper-left corner of the menu is at 
pixel 0, line 0. You can enter values for each edge, allowing you to precisely position 
and size the button’s active area. (You can also drag the area and each of its edges 
with the pointer.)

• Auto Action:  If you select Auto Action for a button, the button activates automatically 
as soon as it is navigated to, without the viewer needing to press Enter. This is useful 
in menus, such as scene selection menus, in which you use Next and Previous 
buttons; you can assume that if viewers navigate to the Next or Previous button, they 
want to activate it.

Note:  With overlay-based buttons, if you select this option, only the activated color 
mapping appears when the button is navigated to, skipping the selected color mapping.

• Invisible:  Applies to overlay-based buttons. Allows you to have a button that does 
not display highlights in the normal, selected, or activated state. This is useful when 
you want to have a menu with text and no visible buttons. The text could tell the 
viewer to press the Enter button to go to the next menu or start playback (or 
whatever the button is set to jump to). 
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Colors Tab in the Subtitle Inspector

The Colors tab in the Subtitle Inspector is very similar to the Colors tab in the 
Menu Inspector.

• Mapping Type:  Select the colors used to create the overlay graphic. Chroma uses 
black, red, blue, and white. Grayscale uses black, dark gray, light gray, and white. This 
setting only applies to imported graphics files. 

• Selection State:  Unless you have configured this subtitle clip to provide buttons over 
video, only the Normal setting is available. When configured for buttons over video, 
you can select the button state you want to configure, and that state’s colors and 
transparencies are displayed.

• Set:  Active only when you have configured this subtitle clip to provide buttons over 
video. Select the color mapping set (1, 2, or 3) to configure. All new buttons use set 1. 
See “Color Mapping Sets” on page 238 for more information.

Note:  These sets apply only to the selected and activated button states. The normal 
state color mapping setting applies to the entire overlay graphic unless a button’s 
active area is selected or activated.

• Key:  Displays the overlay file’s colors as selected with the Mapping Type. The names 
to the left of the key colors (Text, Outline 1, Outline 2, and Background) show which 
settings apply to subtitle text entered in DVD Studio Pro.

• Color:  Select the color for each of the four overlay colors from the current Color 
Palette. If this subtitle is configured to provide buttons over video, you must do this 
for all three button states.

• Opacity:  Set the transparency for each of the highlight colors. You can use the slider 
or enter a value from 0 (completely transparent) to 15 (completely opaque).

• Apply to Stream:  Click to apply the color and opacity settings to all subtitle clips in 
this stream.
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• Save As Default:  Click to save this color mapping configuration as the default to be 
used on all new subtitles you create.

Note:  This is not the same palette used by the Menu Editor.

• Restore Default:  Click to replace the existing settings with those of the default 
subtitle color mapping configuration.

• Edit Palette:  Click to display the Color Palette dialog, which you can use to change colors 
within the palette. See “Color Mapping Palette” on page 237 for more information. 

What Happens With Different Aspect Ratios?
There are special considerations when you add subtitles to a track with its display set to 
one of the 16:9 options, especially if you have subtitles configured to provide buttons 
over video. 

Normal Text Subtitles and 16:9
The text on the subtitles you create in DVD Studio Pro on 16:9 tracks will appear 
horizontally stretched when viewed on a 16:9 monitor. You can counteract this effect by 
choosing a narrow font. When a 16:9 track’s subtitle plays on a 4:3 monitor using either 
the letterbox or pan-scan method, the text will appear at its natural, nonstretched 
width. Additionally, the text is complete, even when you use the pan-scan mode.

Normal Overlay Graphic Subtitles and 16:9
Overlay graphics that you use for subtitles on 16:9 tracks must be anamorphic 
(horizontally compressed) to display properly when viewed on a 16:9 monitor. If you 
use nonanamorphic graphics for the subtitles, they will appear horizontally stretched 
when viewed on a 16:9 monitor.

When a 16:9 track with a graphic subtitle plays on a 4:3 monitor, the entire graphic 
appears, whether you use the letterbox or pan-scan mode. If you used an anamorphic 
graphic for the subtitle, it will appear horizontally squeezed when viewed on a 4:3 monitor.

Buttons Over Video Using Text Buttons and 16:9
If you create subtitle buttons by typing text and using the text as the buttons on a 16:9 
track, the highlights will work as expected when played on a 16:9 monitor.

How the track plays on a 4:3 monitor depends on whether you are using the letterbox 
or pan-scan mode.

• If you play the 16:9 track on a 4:3 letterbox monitor, the highlights will not match the 
text, since the highlight areas have been scaled along with the video. 

• If you play the 16:9 track on a 4:3 pan-scan monitor, the highlights will match the text.

Based on this behavior, it is recommended that text buttons not be used when creating 
buttons over video on a 16:9 track that is set to play in the letterbox mode on a 4:3 monitor.
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Buttons Over Video Using Overlay Graphic Buttons and 16:9
If you create subtitle buttons by importing an overlay graphic and configuring it for a 
16:9 track, the highlights will work as expected when played on a 16:9 monitor. 

The highlights will not match the overlay graphic when played on a 4:3 monitor, either 
letterbox or pan-scan.

• If you play the 16:9 track on a 4:3 letterbox monitor, the highlights will be expecting the 
overlay graphic to be compressed vertically about its center by 25 percent (matching 
what happens to the track’s video).

• If you play the 16:9 track on a 4:3 pan-scan monitor, the highlights will be expecting 
the overlay graphic to have had 12.5 percent of its width removed from both the left 
and right edges (resulting in a total of 25 percent of the width being removed, 
matching what happens to the track’s video).

In both cases, you can create overlay graphics that compensate for these issues, but 
not one that will work for both 16:9 and 4:3 playback.

One solution is to create two sets of graphics—one for 16:9 monitors and the other for 
4:3 monitors, either letterbox or pan-scan. If you place the graphics on separate subtitle 
streams at the same timecode, you can use a script to determine how the DVD player is 
configured and enable the appropriate stream.

See “Creating Buttons Over Video” on page 460 for more information about using 
buttons over video.

Viewing Subtitles
To see how your subtitles look over moving video, including the fade in and fade out 
settings, you must preview or simulate the track. 
• Previewing subtitles plays the selected subtitle stream over the video track in the 

Viewer tab. You are able to switch subtitle streams during playback. However, they 
switch immediately—not as they would switch with a DVD player. You cannot try out 
any buttons over video you may have added.

• Simulating subtitles plays the track in the Simulator. You are able to properly 
switch subtitle streams during playback and can verify any buttons over video 
you have configured.
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Previewing Subtitles
Before you can preview a subtitle, you need to enable its stream; you can then start 
playing the track.

To preview a subtitle:
1 Select the video, audio, and subtitle streams you want to preview, using the button at 

the far left of each stream.

See “Working With the Track Editor’s Streams” on page 370 for more information on 
stream settings.

2 Play the track by clicking the Play button in the Viewer tab. 

The track plays from the playhead’s current position. Since the playhead automatically 
jumps to each subtitle clip as you edit them, you will need to move it back to the 
track’s beginning if you want to begin playing from there. Alternatively, you can move 
the playhead to any position on the timeline to start playback at that point. 

See “Playhead” on page 368 for information on using the playhead. See “Viewing a 
Track” on page 400 for more information on playing tracks.

Simulating Subtitles
DVD Studio Pro provides two ways to start the Simulator:  at the First Play connection 
using Simulator in the toolbar, and at the current track using a shortcut menu in the 
Outline and Graphical tabs.

Since you may have not yet configured your project so that you can easily navigate to 
this track from the First Play setting, it is often more convenient to start the Simulator 
playing at the current track.

Click to select one video,
audio, and subtitle
stream to preview.
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To start the Simulator at a specific track, do one of the following:
m Select the track, then choose File > Simulate Track.
m Control-click the track in the Outline or Graphical tab, then choose Simulate Track from 

the shortcut menu.
m Control-click a stream in the Track Editor, then choose Simulate from Track from the 

shortcut menu.
m Select the track, then press Command-Option-0 (zero).

Creating Subtitles With DVD Studio Pro
Before you create a subtitle, you must have first created and selected the track where 
the subtitle will go. Since the contents of the track’s video and audio streams typically 
determine the subtitle placement, you should not start adding subtitles until these 
streams are set. 

Creating and Positioning a New Subtitle in a Stream
To create a subtitle clip, you must decide which stream to add it to and where to place 
it on that stream.

Creating a Subtitle Clip
There are several methods you can use to create a new subtitle clip.

Note:  Remember that you have to create the subtitle in a subtitle stream (one of the 
streams labeled S1 to S32), and not in the V1 stream.

To create a new subtitle clip, do one of the following:
m Double-click in the subtitle stream at the approximate time position where the subtitle 

clip should appear.
m Position the track’s playhead where the subtitle clip should appear, then choose 

Project > Timeline > Add Subtitle at Playhead.
m Position the track’s playhead where the subtitle clip should appear, then Control-click in 

the subtitle stream and choose Add Subtitle at Playhead from the shortcut menu.
m Position the track’s playhead where the subtitle clip should appear, then press Shift-~.
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m Control-click in the subtitle stream at the approximate time position where the subtitle 
clip should appear, then choose Add Subtitle from the shortcut menu.

All methods create an empty subtitle, with the duration and colors set in the General 
and Colors panes in DVD Studio Pro Preferences. Click the Viewer tab to see the video 
frame that corresponds to the start of the subtitle.

Positioning and Trimming a Subtitle Within a Stream
You can use your mouse or the settings in the General tab in the Subtitle Inspector to 
adjust the position and duration of the subtitle. 

To position and trim a subtitle:
1 Change the subtitle’s position on the timeline by doing one of the following:

• Drag it to a new position.
• Enter a new start time in the General tab in the Subtitle Inspector.

2 Change the subtitle’s duration by doing one of the following:

• Drag one of its edges to a new position. You may need to change the timeline’s 
zoom level to make it easier to see any changes you make, especially if the subtitle 
clip appears very small. The pointer changes to indicate when you are over an edge 
and can start dragging it.

• Enter a new duration in the General tab in the Subtitle Inspector.
• Enter a new stop time in the General tab in the Subtitle Inspector.

Note:  Subtitles cannot cross chapter markers. When you build your project, any subtitle 
clips that reach a chapter marker are clipped at that point.

Double-click in 
a subtitle stream 
to create a new 
subtitle.

Control-click in a subtitle stream 
to open this shortcut menu.



Chapter 13    Creating Subtitles 447

 

Selecting Subtitle Clips
Once you have multiple subtitle clips in a stream, you can use a variety of methods to 
select one.

To select a subtitle clip in a subtitle stream, do one of the following:
m Choose Project > Subtitle > Next or Project > Subtitle > Previous.
m Click a subtitle clip in the subtitle stream.
m Click the left and right arrows in the Viewer tab.
m Press the Up and Down Arrow keys to move the playhead through the timeline, 

stopping at each clip edge and marker.

Entering, Formatting, and Positioning Text
The Viewer tab contains the Subtitle Editor, which provides several ways to enter, 
format, and position the subtitle text. 

Entering Subtitle Text
If you have experience using graphics applications, most aspects of entering subtitle 
text will be familiar to you. You can type directly in the Viewer tab or in the Text area in 
the Subtitle Inspector.

To enter subtitle text:
1 Do one of the following:

• If the blinking insertion point is showing in the Subtitle Editor, you can start typing 
the text. The insertion point automatically appears at the default position in the 
Subtitle Editor.

• Click in the Text area in the Subtitle Inspector.

2 Type the text. Press Return to start a new line. 

Note:  When typing text in the Subtitle Editor, press Enter to exit the text entry mode.

You cannot create more than one text entry per subtitle. For example, you cannot enter 
a sentence, position it in the upper-left corner, and enter a second sentence and 
position it in the lower-right corner. If you need this functionality, create a graphics file 
that contains the text as required, and import it into a subtitle. See “Importing Graphics 
Files for Subtitles” on page 452 for more information.

See “Setting the Subtitle Font” on page 449 if the font is not the right size or style. See 
“Setting the Subtitle Color” on page 450 if you see the insertion point move, but no 
text appears in the Viewer tab, or you want the text to be a different color.

You can edit the text by clicking to place the insertion point or selecting existing text 
and typing new text. You can also drag the text in the Subtitle Editor to a new position.
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Copying Text Between Subtitles
You can copy text from one subtitle or other text source to a subtitle. Depending on 
where you paste the text, you can even maintain the font and size of the copied text:
• Paste at the insertion point in the Viewer tab to use the font and size information in 

addition to the text. The text’s color and justification are not copied.
• Paste in the Subtitle Inspector’s text entry area to use only the text. The text uses the 

subtitle’s font and size settings. 

To copy text to a subtitle:
1 Select the text to be copied.

This text can be from almost any text source, including other subtitles or TextEdit files.

2 Do one of the following:

• Choose Edit > Copy.
• Press Command-C.
This copies the text to the Clipboard. The selected text is not affected.

3 Select the subtitle to copy the text to, then do one of the following:

• To add it as new text, click the insertion point.
• To replace existing text, highlight the text to be replaced. 
• To add it to existing text, place the insertion point where the copied text should go.
Use the Viewer tab to retain the font and size settings of the copied text, or use the 
Subtitle Inspector’s text entry area to use the subtitle’s font and size settings.

4 To paste the text, do one of the following:

• Choose Edit > Paste.
• Press Command-V.

Entering Subtitles in Multiple Languages
One of the great things about subtitles is that you can have a completely different 
stream for each language. In the Viewer tab, you can type the subtitles on that stream 
in any language that your system is configured to handle. 

When you build the project, the text subtitles are converted to bitmap images. The 
system on which you build the project (if it is different from the one used to enter the 
subtitles) must have the proper fonts installed to create the bitmaps. However, once 
the project is built, the fonts are not required to view the title using DVD players.

You can copy each subtitle clip to a new stream, preserving any attributes, such as 
fading, fonts, and duration, you have already set.
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To copy a subtitle clip from one stream to another stream, do one of the following:
m Option-drag the existing subtitle clip to the new stream. You can place the clip freely 

within the stream.
m Shift-Option-drag the existing subtitle clip to the new stream. The subtitle clip is forced 

to the same timeline position as the original.

Formatting Subtitle Text
You can format your subtitle text in a variety of ways. You get to choose:
• The font family and specific typeface attributes (bold, oblique, and so on)
• The font size
• The colors, including transparency and outlines

You can also mix multiple fonts and sizes within the subtitle, although they must all use 
the same colors.

Note:  You cannot set the color of subtitle text as you do a text object in the Menu 
Editor. You must choose colors from the Color Palette. See “Setting the Subtitle Color” 
on page 450 for more information.

Setting the Subtitle Font
You can set the font attributes either before or after you type subtitle text.

To set the font attributes:
1 To open the Font panel, do one of the following:

• Choose Format > Font > Show Fonts.
• Click Show Fonts in the toolbar.
• Press Command-T.
The Mac OS X Font panel opens.

2 If you’re making changes to existing text, select the text in the Subtitle Editor by 
dragging across it.

3 In the Font panel, select the font family and the typeface style to use. The list of 
available fonts and styles is based on fonts currently installed on your system. 

4 Either select a size in the Size column (use the slider to scroll through the list) or select 
the existing size and enter the new value, then press the Return key.
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Note:  If you open a DVD Studio Pro project that uses a font that is not on the computer 
you are opening it on (either because the font was deleted or the project was created 
on a different computer), any items using the missing font have a different font 
substituted with no warning.

To help make the font list manageable, you can assign fonts to collections, creating 
groupings of similar fonts. This makes it easy to get to a specific font type, such as 
script or serif. For more information, see Mac OS X Help.

Setting the Subtitle Color
You can set the colors that subtitles are displayed in. As you type text into a subtitle, 
you are actually creating an overlay graphic, exactly the same as an overlay graphic you 
might create with a graphics application. As with an advanced overlay, a subtitle 
contains four colors that you map to the actual colors that are displayed in the finished 
title. Each color also has a transparency setting. For subtitles, however, the function of 
each of the four colors is fixed:  color 1 is the text, color 2 is the first text outline, color 3 
is the second text outline, and color 4 is the text background.

You usually set the opacity of color 4 (the text background) to 0—other opacity 
settings apply color 4 over the entire picture (except where the text is). Color 2 (text 
outline 1) and color 3 (text outline 2) let you apply a text border to help improve the 
contrast with the video underneath the subtitle. For example, you could set the text to 
be white and the outlines to be black, making it easy to read the text over light or dark 
video content.

You choose the colors that appear for each of the four overlays/text functions from a 
16-color palette, exactly as you do with the standard menu creation method. You can 
define the colors in the palette either in the Colors pane in DVD Studio Pro Preferences 
or by clicking Edit Palette in the Colors tab in the Subtitle Inspector. 

Note:  The subtitle Color Palette is independent of the menu Color Palette. Changes you 
make in one do not affect the other.

To set the text colors:
1 For each of the four overlays/text functions, choose a new color from the Color pop-up 

menu. See “Color Mapping Palette” on page 237 for details on setting the color palette.

2 Adjust the opacity (0 is completely transparent; 15 is completely opaque) for each color 
you set.

Note:  The Mapping Type setting only applies to imported graphics, and does not affect 
subtitle text.
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Positioning Subtitle Text Over the Video
Once you have typed your text and set its font attributes, you can set its final position. 
There are several tools you can use to set the text’s position:
• You can set the default position for subtitles in the Text pane in DVD Studio Pro 

Preferences. Any new subtitles you type will be placed according to your settings. 
• You can drag the text to a new position.
• You can use the buttons in the General tab in the Subtitle Inspector to automatically 

position the text horizontally and vertically. You can also fine-tune the placement by 
entering an offset for each direction, which moves the text the distance you specify 
from the position selected with the Horizontal and Vertical buttons.

The Text pane in DVD Studio Pro Preferences and the General tab in the Subtitle 
Inspector use similar settings for positioning the text. In both cases, you use horizontal 
and vertical alignment settings to get it close, and then use the offset settings to 
position it exactly. 

To position subtitle text without dragging:
1 Select the horizontal alignment (left, center, or right).

2 Enter an offset value, in pixels, to adjust the position selected with the alignment setting. 
Positive numbers move the text to the right. Negative numbers move the text to the left. 
A value of 0 positions the text at its default position for the selected alignment.

3 Select the vertical alignment (top, center, or bottom).

4 Enter an offset value, in pixels, to adjust the position selected with the alignment 
setting. Positive numbers move the text down. Negative numbers move the text up. A 
value of 0 positions the text at its default position for the selected alignment.

Note:  It’s easy to enter an offset value that makes the text disappear completely. If you 
cannot see the text, enter 0 for the horizontal and vertical offsets.
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Importing Graphics Files for Subtitles
You can use graphics files, configured as overlays, to create individual subtitles. These 
graphics can be drawings or text created using a graphics application. See “Creating 
Overlays” on page 86 for information on creating overlay graphics. You must also use 
the correct frame size when creating your graphics. See “Understanding Pixel 
Differences in Graphics and Video” on page 84 for information on square pixels and a 
list of frame sizes to use when creating the graphics.

You can also use graphics in conjunction with typed text. Since the same color 
mapping settings are used for both the text and graphics, you need to create the 
graphics with the mapping setting for the four overlay colors in mind.

Importing a Graphics File
There are two approaches you can take to import a graphics file into a subtitle stream:  
• Add a subtitle to a stream and import the graphic through the Subtitle Inspector.
• Drag a suitable graphics file directly to a subtitle stream.

In both cases, the graphic uses the normal color settings in the Colors tab in the 
Subtitle Inspector.

To import a subtitle graphic using the Subtitle Inspector:
1 Create a subtitle or select a previously created text subtitle. See “Creating a Subtitle 

Clip” on page 445.

2 Click Choose in the General tab in the Subtitle Inspector. 

3 In the dialog that appears, select the graphics file to use, then click Open.

The graphic appears in the Viewer tab, using the current settings in the Colors tab.

To import a subtitle graphic by dragging:
1 Locate the graphics file in the Assets tab, the Palette, or a Finder window.

2 Drag the graphics file to the subtitle stream at the approximate position where it 
should start.

A new subtitle is created with the duration and color mapping set in the Colors pane in 
DVD Studio Pro Preferences.
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Using Graphics Files to Create an Animation
While subtitles are most often used to present text, the ability to import graphics files 
into subtitle streams makes it possible to use them for other purposes. For example, 
the video stream might show a mountain while the subtitle shows the route taken to 
climb it with a line that gradually grows from the start of the trail to the mountain top.

While you cannot import any kind of a motion asset into a subtitle stream, you can 
manually create an animation by adding a number of very short (one- or two-frame) 
subtitles, each with a different graphic that shows the line at a different stage. 

Typical text subtitles have little impact on the playback bit rate—on average they run 
at around 10 kbps. When you use subtitles to create an animation, the impact on the 
playback bit rate becomes substantial, and may force you to lower the bit rate of the 
video stream. The DVD specification limits a subtitle stream’s bit rate to 3.36 Mbps 
(about the same as some MPEG-2 video).

The easiest way to create a subtitle animation is to create an STL subtitle file and 
import it. You can specify the exact duration and position of each graphic, as well as 
configure the color mapping settings. See “Creating an STL Format Subtitle File” on 
page 456 for more information.

Creating and Importing Subtitle Files
Often you may want to create your subtitles outside of DVD Studio Pro. There can be 
several reasons for this:
• To use a facility that specializes in creating subtitles and closed captions. This can be 

especially important if you are including subtitles in multiple languages.
• To free up your DVD Studio Pro system. Typing in a lot of subtitles takes a significant 

amount of time, especially if you are using multiple languages. This is often a task 
that can be started well before you start authoring the project. 

• To be able to spell-check the text. Creating the subtitle text with a text-editing 
program gives you the ability to take advantage of its spell-checking capabilities. 

There are two approaches used to create subtitle files for import into 
DVD Studio Pro:  Use a single file with the text embedded in it or use a group of 
graphics files, one for each subtitle, with a master file that controls which files appear at 
which time. 

In both cases, the subtitle files can be opened with a text-editing program such as 
TextEdit. This makes it easy to verify the file’s settings and make any necessary 
modifications. Be sure to save the file in a plain text format if you do make any changes.
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Using a Single Subtitle File
When you use the single file subtitle method, you specify a timecode for each subtitle’s 
start and end, as well as the actual subtitle text. You can also embed commands that 
affect how the text appears on the screen, such as the font, position, color mapping 
settings, and fade in and fade out settings.

There are two disadvantages of the single file subtitle method:

• It requires your authoring system to have the correct fonts installed. This can be an 
important issue when working with foreign languages that require special characters.

• The subtitle can only include text characters. However, you can manually import 
graphics files to use in addition to the imported subtitle file.

Using a Group of Graphics Files
When you use a group of graphics files for the subtitles, each file provides the graphic 
for one subtitle. A master file provides a list of timecode values for the start and end of 
each subtitle, along with the name of the graphics file to use for each subtitle.

An advantage of this subtitle method is that the graphics files do not need to actually 
contain text. This method is useful if you want to include graphics elements along with 
the text, such as a logo. This also means that the DVD Studio Pro system is not required 
to have the same fonts you used to create the subtitle graphics.

A disadvantage of this method is that you have to manage a folder with a lot of large 
graphics files, as compared to the single file method with its single small file.

The graphics files follow the same guidelines as overlay files. See “Creating Overlays” on 
page 86 for more information.

Importing a Subtitle File
Before you import a subtitle file, you will usually have the video asset it relates to in 
place in the V1 stream. It is also a good idea to have the subtitle preferences configured 
before importing a subtitle file. Unless the subtitle file specifically overrides them, these 
preference settings will apply to all subtitles that are imported. 

To import a subtitle file, do one of the following:
m Control-click in the subtitle stream to import the subtitles into, then choose Import 

Subtitle File from the shortcut menu.
m Select an existing subtitle clip in the stream, then click Import Subtitles in the 

Subtitle Inspector.
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In both cases, a file selection dialog appears for you to choose the file to import. After 
you choose the file, a dialog appears stating how many subtitles were imported, and 
the subtitle stream shows clips for each subtitle.

If the Subtitle Import Does Not Work
There are several common reasons why you might have problems when importing a 
subtitle file.

Wrong Timecode
The most common problem is that the timecode in the subtitle file does not 
correspond to the asset timecode of the video stream. In some cases, this is due to the 
original tape’s timecode not being entered prior to the video being MPEG-encoded. 

To see the timeline’s asset timecode, Control-click in the timeline and choose Asset-
Based Timecode from the shortcut menu. When importing STL format subtitle files, set 
the $TapeOffset command to True to force the subtitle import to use the timeline’s 
asset timecode to place the subtitle clips. See “Timeline Command” on page 459 for 
more information.

Font Not Available
If you are using the single subtitle file method and specify a font to use, no subtitle 
clips will appear if the font is not found on the system.

Note:  The font must be installed as a Mac OS X font—Mac OS 9 fonts are not used.

Unable to Find the Graphics Files
In most cases, the master subtitle file and the graphics files it uses must be in the same 
folder. In some cases, however, the master file may be configured to use a separate 
folder for the graphics files. In this case, the path supplied by the master file must 
match the actual location where the graphics files are.

How Subtitles Are Positioned
When you import subtitles, they are positioned in the subtitle stream based on the 
start and end timecode values in the subtitle file and the video stream’s asset timecode. 
This means that the timecode values in the subtitle file must be relative to the asset 
timecode of the video stream’s clip, not to the timeline’s zero-based timecode. An 
exception is when you use an STL format subtitle file, which can choose to use the 
timeline’s zero-based timecode. See “Timeline Command” on page 459 for information 
on positioning subtitles when using an STL format file. See “Understanding Time 
Information in the Track Editor” on page 366 for more information on asset-based 
versus zero-based timecode. 
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Editing Imported Subtitles
Once you have imported a subtitle file, you can work with the individual subtitle clips 
as if you had manually created them. You can reposition them and change their color 
mapping and any other subtitle attribute. If you imported the subtitles as text from a 
single subtitle file, you can edit the text. If you imported a group of graphics files as 
your subtitles, you cannot edit the actual text.

You can also modify all of the subtitles in a stream by using the Apply to Stream controls. 
See “Applying Subtitle Settings to the Stream” on page 436 for more information.

Creating an STL Format Subtitle File
An easy and flexible way to create subtitle files is to use the STL format developed by 
Spruce Technologies. The STL format allows you to configure most subtitle settings, and 
change the settings on a subtitle by subtitle basis. It supports both the single file 
method and the graphics file method, and even allows you to use both methods in the 
same file.

STL format files can be saved as either plain text files or as RTF files (as created with 
TextEdit). You must use RTF files if your text contains Unicode characters.

Basic STL Format
There are three parts to an STL format subtitle file:  commands, comments, and entries. 
• Commands are preceded by the dollar sign ($). It is these commands that allow you 

to configure the various aspects of the subtitles, such as their font and position. See 
“STL Commands” on page 457 for more information. 

• Comments are preceded by a double slash (//). These allow you to add text 
comments throughout the subtitle file without affecting its import.

• Entries include the start and end timecode values and the text or graphics file for that 
subtitle clip. 

Following is an example of a simple STL subtitle file.

$FontName = Arial

$FontSize = 65

//The following subtitles are for scene one.

00:00:12:04 , 00:00:14:12 , Lemurs are the bullies of the wild.

00:00:16:14 , 00:00:19:08 , Here we see them bring down a moose.

Commands, which are always preceded by a dollar sign, use the equal sign (=) to 
separate the command name from its value. The entries use commas to separate their 
fields. In both cases, you can add tab characters to align the fields and make the file 
easier to read.
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Note:  If you add spaces between the comma and the text entry, they are considered 
part of the text and appear in the subtitle. You can use the tab character to provide 
space between the comma and the text entry without affecting the text.

You can add a command multiple times within a file to change a setting for specific 
subtitles.

$FontName = Arial

$FontSize = 65

00:00:12:04 , 00:00:14:12 , Lemurs are the bullies of the wild.

$FontSize = 50

00:00:16:14 , 00:00:19:08 , Here we see them bring down a moose.

In this case, both subtitles will use the same font, with the first one at a size of 65 and 
the second one at 50.

STL Commands
Following is a list of the commands supported by the STL format.

Note:  These commands override the settings in DVD Studio Pro Preferences, which 
provide the default settings for all settings that have not been overridden. 

Font Commands
• $FontName:  Sets the name of the font the subtitles use. Use the family name as it 

appears in the Font panel, which can be opened by clicking Show Fonts in the 
toolbar or choosing Format > Fonts > Show Fonts.

• $FontSize:  Sets the size of the font.
• $Bold:  Selects the bold version of the font (if available). Enter True to select the bold 

version and False to disable it.
• $Italic:  Selects the italic version of the font (if available). Enter True to select the italic 

version and False to disable it.
• $Underlined:  Adds an underline to the subtitle text. Enter True to turn on the 

underline and False to turn it off.

Color Commands
The color commands choose the colors from the default subtitle Color Palette to apply 
to the subtitle. The values range from 0 to 15. You can assign the colors to the default 
Color Palette in DVD Studio Pro Preferences. 
• $ColorIndex1:  Chooses the text color. 
• $ColorIndex2:  Chooses the text’s outline 1 color. 
• $ColorIndex3:  Chooses the text’s outline 2 color. 
• $ColorIndex4:  Chooses the background color.
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Contrast Commands
The contrast commands set the opacity of the colors assigned to the subtitle. The 
values range from 0 (transparent) to 15 (opaque).
• $TextContrast:  Sets the opacity of the text color. 
• $Outline1Contrast:  Sets the opacity of the text’s outline 1 color. 
• $Outline2Contrast:  Sets the opacity of the text’s outline 2 color. 
• $BackgroundContrast:  Sets the opacity of the background color. This is usually set to 

0, unless you are using a graphic that does not use white as the background color.

Position Commands
These commands control the subtitle’s position.
• $HorzAlign:  Sets the subtitle’s horizontal alignment. You can enter left, center, or right.
• $VertAlign:  Sets the subtitle’s vertical alignment. You can enter top, center, or bottom.
• $XOffset:  Allows you to modify the subtitle’s horizontal position from where the 

horizontal alignment placed it. The values you enter are in pixels, with positive values 
moving the subtitle to the right and negative values moving it to the left. 

• $YOffset:  Allows you to modify the subtitle’s vertical position from where the vertical 
alignment placed it. The values you enter are in pixels, with positive values moving 
the subtitle up and negative values moving it down. 

Display Commands
These commands control how a subtitle displays.
• $ForceDisplay:  Forces the subtitle to display regardless of whether subtitles are 

turned on by the DVD player. You can enter True (subtitles are forced to display) or 
False (subtitle display is controlled by the DVD player).

• $FadeIn:  Sets the fade time used to gradually dissolve the subtitles on. Enter a value 
in frames.

• $FadeOut:  Sets the fade time used to gradually dissolve the subtitles off. Enter a 
value in frames.

Graphics File Command
Use this command if this subtitle file uses graphics files in addition to, or in place of, 
text entries.
• $SetFilePathToken:  Sets a token that you use on any subtitle entries that contain a 

graphics filename instead of subtitle text. The entry must be such that it never 
appears in normal text or filenames. The normal convention is to surround the text 
with dual angle brackets, making it easier to locate within an STL file. For example, 
you could use <<Graphic>>. See “Referencing Graphics Files in STL Subtitle Files” on 
page 460 for details.
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Timeline Command
By default, the timecode values in an STL file are in reference to the video stream’s zero-
based time, which starts at 00:00:00:00. You can use this command to reference the 
file’s timecode values to the video stream’s asset-based timecode.
• $TapeOffset:  Controls how the timecode values in the STL file are referenced to the 

video stream. You can enter False (the default setting) to reference them to the 
stream’s zero-based timecode (which begins at 00:00:00:00), or True to reference 
them to the asset-based timecode.

Note:  When referenced to the asset-based timecode, the Track Inspector’s Track Offset 
setting is ignored—only the actual asset’s timecode is used.

Controls Embedded in the Subtitle Text
You can embed several controls in the text part of the entries. These controls can force 
a line break and turn on and off the bold and italic font versions.

Line Breaks
Subtitle text does not automatically wrap at the edges of the screen. To make it fit you 
must either reduce the font size or break it into multiple lines by inserting line breaks. 
To insert a line break, add the vertical pipe character (|) to the text.
00:00:12:04 , 00:00:14:12 , Lemurs are the bullies | of the wild.

In the above example, the text will appear as two lines.

Bold, Italic, and Underlined Characters
You can embed controls that change the state of the bold and italic attributes within 
the text part of an entry. 

To change the state of the bold setting, insert an up arrow followed by the letter “B” (^B).

00:00:12:04 , 00:00:14:12 , Lemurs are ^Bbullies^B.

In the above example, the bold status changes for the word “bullies” only. If the bold 
attribute had not already been activated, “bullies” would change to bold. If the bold 
attribute had already been activated, “bullies” would not be bold.

To change the state of the italic setting, insert an up arrow followed by the letter “I” 
(^I). You can also use bold and italic together.

00:00:12:04 , 00:00:14:12 , Lemurs are ^B^Ibullies^B^I.

In the above example, the word “bullies” has both the bold and italic attributes change.

To add an underline to portions of the text, insert an up arrow followed by the letter 
“U” (^U). You can use the underline along with the bold and italic settings.
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Referencing Graphics Files in STL Subtitle Files
An STL subtitle file can contain a mix of text subtitle entries and references to graphics 
files. You must use the $SetFilePathToken command in the file before any lines that 
reference a graphics file.
$SetFilePathToken = <<Graphic>> 

00:00:12:04 , 00:00:14:12 , <<Graphic>>RabidLemur.tif

00:00:16:14 , 00:00:19:08 , <<Graphic>>MooseLemur.tif

Important:  Do not add spaces between the token (<<Graphic>> in this example) and 
the filename.

The STL subtitle file and the graphics it references must be in the same folder. And, just 
like the other assets that you import into your project, the graphics files must not be 
moved, renamed, or deleted until after you build your project. 

Creating Buttons Over Video
Having buttons appear while a track plays can be a very useful navigational tool, 
providing the viewer with options that can significantly add to the DVD title’s value. For 
example, you can use buttons over video to allow the viewer to jump from the current 
track to a track containing related information, such as an interview of an actor, a news 
clip, or an explanation of how an effect was done.

How Do Buttons Over Video Work?
DVD Studio Pro uses subtitles at specially configured markers to provide the buttons 
over video feature. You configure the buttons exactly as if you were configuring a 
standard menu using advanced overlays:  You create each button’s active area, assign 
its connection, set the button navigation (if you use more than one button), and set up 
the color mapping for the highlights.

Each subtitle containing buttons over video is tied to a marker. You must create a marker 
at the point where the subtitle should appear, and another where it should disappear. 
You can mix standard subtitles in the same stream as button over video subtitles.

You can only view one subtitle stream at a time. Since the buttons over video feature 
uses a subtitle stream, you effectively disable the normal usage of subtitles on the title 
while the buttons over video stream is selected. (Although a subtitle clip can have both 
buttons and subtitle text, often the buttons need to appear longer than normal 
dialogue text.) In most cases, you would configure the title so that the viewer decides 
whether to enable buttons over video by selecting a button on a menu. When selected, 
the subtitle stream that contains the buttons is usually configured to be forced to 
display so that the viewer does not inadvertently turn it off.
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Adding Button Highlight Markers
To create a button over video subtitle, you add a marker at the point where the subtitle 
should appear, select its button highlight setting, and add a second marker where the 
subtitle should end. Once you do this, if you create a subtitle between these markers, 
its start snaps to the marker with the button highlight setting selected and its end 
snaps to the second marker, regardless of its type. 

Any marker can be configured as a button highlight marker. See “Working With 
Markers” on page 380 for information on adding markers to a track.

To configure a marker as a button highlight marker, do one of the following:
m Control-click the marker, then choose Button Highlight Marker from the shortcut menu.
m Select the marker in the Track Editor. In the Marker Inspector, select the Button 

Highlight type in the General tab.

You can also select any of the other types available. Depending on the other types you 
select, at least a part of the marker will change to red. See “Working With Markers” on 
page 380 for more information.

The second marker, which ends the button over video subtitle, can be of any type. 

How a Button Highlight Marker Affects 
the Subtitle Stream
If a subtitle already exists between the two markers that specify the start and end of a 
button over video subtitle, its duration changes to match the time between the two 
markers. This is true of all subtitle streams. If you have traditional subtitles on one or 
more of the other subtitle streams, adding button highlight markers will also affect 
them. For this reason, you must use care when deciding when and how long to have 
the buttons over video subtitle appear, so as not to affect existing subtitles.

You can have several subtitle streams in the same track configured for buttons over video. 
For example, you may be using text for the buttons, and want to have different streams for 
each language. It’s important to keep in mind that all button active areas, connections, 
navigation settings, and color mapping settings are applied to all subtitle streams. The only 
element that can be different between the streams is the text or overlay you use.
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Adding a Button Over Video Subtitle Clip
Once you have configured the button highlight marker and the ending marker, you can 
add the button over video subtitle. 

To add a button over video subtitle clip:
m Double-click in the subtitle stream between the button highlight marker and the 

ending marker.

A new subtitle clip appears, with its duration matching the time between the two 
markers. See the next section for information on configuring the subtitle clip to provide 
buttons over video.

Configuring a Button Over Video Subtitle Clip
To configure a button over video subtitle clip, you first add the text or import the 
graphic to use for the button or buttons, and then configure the buttons much as you 
would when creating a menu.

Using an Overlay Graphic
The first step to creating a button over video subtitle using an overlay graphic is to 
import the overlay graphic into the subtitle.

To import an overlay graphic for a button over video:
1 Select the subtitle clip that you previously created to configure for buttons over video.

2 Click Choose in the General tab in the Subtitle Inspector. 

3 In the dialog that appears, select the graphics file to use, then click Choose.

The graphic appears in the Viewer tab, using the current settings in the Colors tab.

Using Text Buttons
The first step to creating a button over video subtitle using subtitle text is to enter the 
text in the subtitle. You need to set its font and position before proceeding with 
creating buttons from it. See “Entering, Formatting, and Positioning Text” on page 447 
for more information.
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Creating the Buttons
Once you have imported the overlay graphic or entered the button text, you can 
create the buttons. To create the buttons, you create active area rectangles by 
dragging over each button’s area. See “Adding Overlay-Based Buttons” on page 253 
for details on this process. 

The number of buttons you can have depends on the track’s aspect ratio setting, set 
with the Display Mode pop-up menu in the General tab in the Track Inspector.

For SD projects: 

• 4:3:  You can have up to 36 buttons.
• 16:9 Pan Scan:  You can have up to 18 buttons.
• 16:9 Letterbox:  You can have up to 18 buttons.
• 16:9 Pan Scan & Letterbox:  You can have up to 12 buttons. 

For HD projects: 

• 4:3:  You can have up to 48 buttons.
• 16:9 Pan Scan:  You can have up to 24 buttons.
• 16:9 Letterbox:  You can have up to 24 buttons.
• 16:9 Pan Scan & Letterbox:  You can have up to 16 buttons. 

See “Choosing an Aspect Ratio” on page 50 for more information on these modes. Also 
see “What Happens With Different Aspect Ratios?” on page 442 for issues that occur 
when creating buttons over video on a 16:9 track.

Configuring the Buttons
Once you have created the buttons, you need to configure them. There are three areas 
to configure:
• Button navigation:  Sets how a viewer jumps from one button to the next using the 

remote control’s arrow buttons. 
• Button targets:  Sets the connection for each button (what is jumped to when the 

button is activated). 
• Color mapping:  Sets the colors that appear for the normal, selected, and activated 

button states.

Button Navigation
Configuring button navigation with buttons over video is exactly the same as configuring 
the navigation in menus. By default, the navigation is assigned continuously, with 
DVD Studio Pro automatically setting the arrow button actions for each button. You can 
disable this function and set the navigation manually if you prefer.

See “Configuring Button Navigation” on page 268 for details on the methods you can 
use.
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Button Targets
Configuring the targets for each button with buttons over video is almost exactly the 
same as configuring the button targets in menus. You have the option of setting them 
in the Connections tab (the buttons appear as marker items), in the Subtitle Inspector, 
or by using a shortcut menu in the Subtitle Editor.

The difference is that a button within a track cannot select a specific stream in a 
different track. For this reason, the stream settings for buttons in subtitles are inactive if 
the target is set to anything other than “not set.”

If you need a button within a track to select a specific stream in another track, you can 
set the target to run a script that‘s configured to jump to the desired stream.

See “Setting a Button’s Connection” on page 258 for details on each method. 

Color Mapping
Configuring the color mapping for the buttons with buttons over video is similar to 
configuring the color mapping for an advanced overlay with a menu. 

The biggest difference is that you don’t have the option of using a simple overlay. You 
can accomplish a similar effect by setting the color and opacity settings for the three 
nonwhite overlay colors to the same values, and setting the white overlay opacity to 0, 
making it completely transparent.

Another difference is that the overlay colors have pre-assigned functions if you are 
typing subtitle text. See “Setting the Subtitle Color” on page 450 for more information.

See “Using Advanced Overlay Color Mapping” on page 240 and “Colors Tab in the 
Menu Inspector With Advanced Selected” on page 251 for more information.

Copying Buttons
You are able to copy buttons within a subtitle clip or to a different subtitle clip. The 
buttons retain all of their settings, including their target setting.

You are not allowed to copy buttons to a subtitle clip if it causes that clip to exceed the 
maximum number of buttons allowed. See “Creating the Buttons” on page 463 for 
details on the maximum number of buttons allowed.
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Copying Buttons by Dragging
You can copy one or more buttons within a subtitle clip by selecting them, then 
dragging them to a new location.

To copy one or more buttons within a subtitle clip by dragging:
1 Select the buttons to be copied.

2 Press the Option key, then drag the buttons to their new position.

If multiple buttons are selected, they all move as a group, maintaining their 
relationships to each other.

Using Copy, Cut, and Paste 
You can use the Copy and Paste commands to copy buttons within a subtitle clip and 
between subtitle clips. You can even copy buttons from a menu to a subtitle clip. 
However, any shapes, button styles, button text, and button assets that the menu’s 
button might have are not copied to the subtitle. 

Important:  If you copy a button to a subtitle clip that is not configured for buttons 
over video, DVD Studio Pro automatically converts the subtitle clip to support buttons 
by adding a button highlight marker (named “Button Marker _,” where “_” is the button 
marker number on that track) to the timeline at the clip’s beginning, and a cell marker 
(named “Marker _,” where “_” is the cell marker number on that track) at its end.

To copy one or more buttons using copy and paste:
1 Select the buttons to be copied.

2 Do one of the following:

• Choose Edit > Copy.
• Press Command-C.
This copies the selected buttons to the Clipboard. The selected buttons are not affected.

3 Select the subtitle clip to which you want the copied buttons to be pasted.

4 If the insertion point is active in the Viewer tab, click an empty area to deactivate it.

5 Do one of the following:

• Choose Edit > Paste.
• Press Command-V.

If there are no buttons selected in the subtitle clip before you paste the copied 
buttons, the copied buttons are placed in the same locations as the originals. If a 
button is selected in the subtitle clip before you paste the copied items, the copied 
buttons are positioned relative to the selected button with a small offset.

You can use the Paste command multiple times after using the Copy command. This 
makes it easy to add a button to multiple subtitle clips.
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To move one or more buttons using cut and paste:
1 Select the buttons to be moved.

2 Do one of the following:

• Choose Edit > Cut.
• Press Command-X.
This copies the buttons to the Clipboard and removes the buttons from the current 
subtitle clip. 

3 Select the subtitle clip to which you want the cut buttons to be pasted.

4 If the insertion point is active in the Viewer tab, click an empty area to deactivate it.

5 Do one of the following:

• Choose Edit > Paste.
• Press Command-V.

This is most useful when you are moving buttons from one subtitle clip to another. 
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14 Creating Scripts

You can add sophisticated interactivity and control 
to a project with only a few simple scripts.

The DVD-Video specification includes a simple yet powerful scripting language. This 
scripting language provides for extensive interactivity between the viewer and the 
DVD player. DVD Studio Pro gives you full access to these scripting capabilities. 

Scripts in DVD Studio Pro are created as separate elements within a project, so they can 
be assigned easily to any element that supports a script. Scripts can be assigned to 
buttons or attached to the start or end of any track, story, menu, or marker.

With scripts you can:

• Have the title automatically customize itself to best match the DVD player’s configuration 
in areas such as language selection, audio formats, and parental management

• Add specialized features, such as a random play after a menu times out
• Add subtle features, such as having a menu highlight the next button when 

returning to the menu after activating a previous button
• And much more

Pre-Scripts
Tracks, stories, slideshows, and menus have pre-script settings. A pre-script is a normal 
script that is run before the element plays or displays. It can be used to do things such as 
decide whether to play the element or to configure the DVD player before it is played. For 
example, you may have a pre-script assigned to a track that checks the DVD player’s 
parental management setting to decide whether this track or a different one should play.
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Pre-scripts only run if you jump to the root of the element (its name shown in square 
brackets, or, in the Connections tab, the element’s name) they are assigned to. 

For example, when you assign a connection to a menu, you can choose to jump to a 
specific button or to the menu root with no button specified (using the [Menu] 
selection). A pre-script assigned to a menu will only run if the element that jumped to 
it had [Menu] selected. If the jump selected a specific button on the menu, the pre-
script is skipped.

Similarly, a pre-script on a track or story will not run if you jump directly to a marker. 
With slideshows, the pre-script will not run if you jump directly to a slide.

In all cases, if you want the pre-script to run, you must jump to the root of the element, 
indicated by the square brackets.

If an element is also configured with a display condition, the pre-script runs first, and 
then the display condition.

Note:  Unlike pre-scripts, display conditions run when any part of an element is 
connected to.

Choose [Track] to have a 
pre-script assigned to this track 
run when it is jumped to.

Connect to the element’s name
to have the pre-script run.
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Scripting Overview
Scripts you add to your project contain commands that allow you to access the 
functionality available in all DVD players. Each script can contain up to 124 commands. 

Every DVD player contains a micro-controller that can execute a set of commands 
defined by the DVD-Video specification. 

The commands defined in the DVD-Video specification are at the level of 
microprocessor machine code, with very simple commands used to initiate desired 
functions. You may find that some of the concepts and terms are a challenge. 
Therefore, when learning scripting, proceed with initial deliberateness and caution—it 
is very easy to author titles with scripts that just don’t work. You should also use the 
Simulator and test builds of your project using the Apple DVD Player to verify that your 
title plays back exactly as intended.

About DVD Player Registers
Each DVD player has two types of memory registers:  General Purpose Register 
Memories (GPRMs, also known as variables) and System Parameter Register Memories 
(SPRMs). Scripts interact with these registers to determine DVD player settings (such as 
language and parental control) and to control various aspects of disc playback. 

Scripts use GPRMs as temporary storage, or “scratch pads,” while executing their 
commands. DVD Studio Pro provides access to eight 16-bit GPRM registers, designated 
GPRM 0 through GPRM 7 (though they can be renamed). DVD Studio Pro includes the 
ability to partition seven of these registers into multiple smaller registers. For example, 
you can partition GPRM3 into four 4-bit registers. Each register is independent of the 
others, and all are cleared whenever a disc is inserted into the DVD player. The registers 
can be used as storage locations or as countdown timers.

In contrast, SPRMs have rigidly defined functions. There are 24 of them, designated 
SPRM 0 through SPRM 23. See “SPRMs’ Values and Their Meaning” on page 491 for a 
detailed listing of their functions. 

Scripts spend a lot of time copying values from an SPRM to a GPRM, extracting 
information from the values (for example, determining the language setting), and then 
acting on that information (selecting the proper audio stream to play). Extracting the 
information can be challenging, requiring a bit of skill and programming knowledge.
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About Scripting Commands
You can choose from ten scripting commands when building your script. Each scripting 
command has its own set of controls that fit the command’s function. Each script can 
contain up to 124 commands, or operations. Depending on how you configure the 
scripting command, it might use up to 16 of the 124 commands. The top of the Script 
Inspector shows the number of commands used and available. A dialog appears to 
warn you if you create a script with too many commands, and the Script Inspector 
shows the commands used and available values in red, with a negative number for the 
Commands Remaining value.

Each scripting command creates a command line that appears in the Script Editor. You 
are provided with a variety of tools to rearrange the order of the command lines in the 
script, which is important since the command lines are executed in order (though it is 
possible for a command line to jump to any other command line in the script). 

The Scripting User Interface
Scripts appear in the Outline and Graphical tabs. Double-clicking an existing script or 
clicking the Script tab displays the Script Editor and the Script Inspectors. You use the 
Script tab to add and remove commands, as well as modify their order. You use the 
Script Inspectors to configure the commands, choosing the actual command to use 
and setting its parameters.
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Script Tab
You click the Script tab to access the Script Editor. The Script Editor lists the command 
lines within the script. You use its Add button to add command lines to the script. The 
other buttons provide methods for managing the order of the command lines. Since 
scripts generally execute the command lines in order, starting at command line 1, it is 
important to have them in the correct order.

Once you have multiple commands in the list, you can move between them by either 
selecting the one you want to go to or using the keyboard’s Up and Down Arrow keys 
to step from one to the other. You can also press the Command key along with the Up 
and Down Arrow keys to jump to the first or last command line, or the Page Up and 
Page Down keys to move through the list one page at a time.

Command Line Add and Delete Buttons
There are three buttons you can use to add or remove command lines from the 
Script Editor. 

Select to view the
values as

hexadecimal.

Choose the script to work
with in the editor.

Command line 
reorder tools

Command line add
and delete controls

Drag this bar to 
adjust column sizes.

Inserts a command line
below the selected line.

Adds a command line 
to the end of the list.

Deletes the selected 
command line.
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• Add (+):  Clicking the Add button, or pressing Command-=, adds a command line to 
the script. This command line is always placed at the end of the list, regardless of 
which command is currently selected. By default, each added command line is set to 
Nop (no operation) which works as a placeholder for the actual command you will 
select in the Inspector.

• Delete (–):  Clicking the Delete button removes the currently selected command line 
from the list. You can also use the keyboard’s Delete key.

• Insert:  Clicking the Insert button, or pressing Shift-Command-=, adds a new 
command line to the list, positioned after the currently selected command line. All 
command lines below the current one ripple down one location. As with the Add 
button, the new command is a Nop.

Command Line Reorder Tools
You can use the reorder tools to change the order of the command lines in the Script 
Editor. You can also drag a line to a new position.

Note:  You are just rearranging the order of the command lines—you are not deleting 
or replacing any command lines.

• Move Up:  Clicking the Move Up button moves the currently selected command line 
up one location. The command line already at that location moves down one 
location to make room (the two command lines basically switch positions).

• Move Down:  Clicking the Move Down button moves the currently selected command 
line down one location. The command line already at that location moves up one 
location (the two command lines basically switch positions).

• Move To Top:  Clicking the Move To Top button moves the currently selected 
command line to the top of the list, making it the first command line executed. All 
command lines that were above it in the list ripple down (the command line that 
was at the top is moved to the number 2 position, the number 2 command line 
moves to number 3, and so on).

• Move To Bottom:  Clicking the Move To Bottom button moves the currently selected 
command line to the bottom of the list, making it the last command line executed. 
All command lines that were below it in the list ripple up.

Moves the command
line up one line.

Moves the command 
line down one line.

Moves the command line 
to the top of the list.

Moves the command line 
to the bottom of the list.
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Copying Command Lines
When creating a script with multiple similar command lines, you may find it easier to 
create the first version of the command line, copy that command line multiple times, 
then modify the copies as needed. You can also copy a command line from one script 
to another.

To copy command lines in the Script Editor:
1 Select the command line to be copied.

You can select more than one command line.

2 Do one of the following:

• Choose Edit > Copy.
• Press Command-C.
This copies the command lines to the Clipboard. The selected command lines are 
not affected.

3 Select the command line in this script or a different script after which you want to 
paste the copied command lines.

If you have no command lines selected, the copied command lines are placed after the 
last existing command line.

4 Do one of the following:

• Choose Edit > Paste.
• Press Command-V.

To move one or more command lines using cut and paste:
1 Select a command line or a group of command lines to be moved.

2 Do one of the following:

• Choose Edit > Cut.
• Press Command-X.
This copies the command lines to the Clipboard and removes the command lines from 
the current list. 

3 Select the command line in the script after which you want the cut command lines to 
be pasted.

4 Do one of the following:

• Choose Edit > Paste.
• Press Command-V.

This is most useful when you are moving command lines from one script to another. 
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Script Inspectors
The Script Inspector has two displays:  a general Script Inspector that appears when no 
command lines in the script are selected, and a Script Command Inspector that appears 
when you select a command line. 

Script Inspector
To display the script’s Script Inspector, you need to either click in an empty area below 
the command lines in the Script Editor or click the script’s name in the Outline or 
Graphical tab.

The Script Inspector displays values showing the number of commands used and how 
many are still available out of the possible total of 124. (Configuring a scripting 
command may use up to 16 of the 124 commands.) These values will turn red if your 
script uses more than 124 commands, with a negative number in the Commands 
Remaining value indicating how many excess commands there are.

It is also where you name your script and then configure the partitions and names of 
the GPRM registers.

Note:  You can also configure the partitions and names of the GPRM registers in the 
Advanced tab in the Disc Inspector.

See “Configuring GPRM Partitions” on page 505 for more information.

Enter a name for 
the script.

Configure the 
GPRM partitions.

Use these to import 
and export GPRM 
configurations.
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Script Command Inspector
To display the Script Command Inspector, you need to select a command line in the 
Script Editor. 

The Script Command Inspector has four sections:

• The command selection section, where you select which of the ten commands to use
• The command setup section, where you configure the command’s parameters. The 

actual contents of this section vary, based on the command selected.
• The compare section, where you can add a compare function to the command
• The comment section, where you can add a comment to the command. Comments 

are useful for both yourself and others later on when trying to remember why certain 
commands were added. 

See “Script Command Details” on page 480 for details on setting up the commands.

Configure a compare 
function (optional).

Configure the 
command.

Enter a comment 
(optional).

Choose a command.
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Creating Scripts
While it is easy to create scripts, it’s a good idea to first spend some time planning 
exactly what you intend the script to do. Sometimes a single script can be designed to 
fit multiple situations, or it may be easier to create multiple similar scripts, with each 
configured for a specific case.

Creating a Script
Scripts can vary greatly. Simple scripts may contain only one or two commands, while 
complex scripts can contain many commands and dependencies on other scripts. No 
matter how complex the script, you create all scripts using the same basic methods. 

To create a script:
1 Do one of the following:

• Choose Project > Add to Project > Script.
• Control-click in the Outline or Graphical tab, then choose Add from the shortcut 

menu and Script from the submenu.
• Click Add Script in the toolbar.
• Press Command-’ (single quote).
A new script is added to the Outline and Graphical tabs.

2 To name the script, do one of the following:

• Enter the name in the Name field in the Script Inspector.
• Select the script in the Outline or Graphical tab, click its name, type the new name, 

then press Return.

3 Double-click the new script in the Outline or Graphical tab or click the Script tab to 
open the Script Editor. 

4 In the Script Editor, select the default Nop command line. 

The Script Command Inspector appears, displaying the command configuration display.

5 Configure the command line as desired, and add new command lines as needed. 

See “Script Command Details” on page 480 for details on the commands you can add 
to a script. See “About Connections” on page 525 for information on connecting scripts 
to your project’s elements. 
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Duplicating and Saving Scripts
Most scripts contain command lines that are specific to a particular function in a 
particular project. However, since it is often easier to modify an existing script rather 
than start from scratch, DVD Studio Pro includes several tools that allow you to create 
copies of a script for use in this and other projects.

Duplicating Scripts
When creating several similar scripts, use the Outline or Graphical tab’s duplication 
function to make a copy of a script.

To duplicate a script within a project, do one of the following:
m Select the script in the Outline or Graphical tab, then choose Edit > Duplicate.
m In the Outline or Graphical tab, Control-click the script, then choose Duplicate from the 

shortcut menu.

A copy of the script is created with the same name as the original, with a number 
added to the end of the name.

Saving Scripts
You can save a script as an item description file, making it easy to import a script into 
other projects.

To save a script as an item description file, do one of the following:
m Control-click the script in the Outline or Graphical tab, then choose Save Script from 

the shortcut menu.
m Select the script in the Outline or Graphical tab, then choose File > Export > 

Item Description.

Loading Scripts
You can load saved scripts into a DVD Studio Pro project.

To load a script file, do one of the following:
m Control-click in the Outline or Graphical tab, then choose Load Script.
m Choose File > Import > Item Description to import a script item description (with an 

“.dspScript” extension).

The script appears in the Outline tab under the Scripts heading and as a new tile in the 
Graphical tab, and can now be edited as needed.
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Testing Scripts
Once you have created a script, you will want to test it. Depending on the script’s 
function, you can test it with the Simulator, with the Apple DVD Player as part of an 
emulator test, or in set-top DVD players after you burn a disc. 

Testing a Script in the Simulator
The DVD Studio Pro Simulator has a Registers display that shows useful information 
when testing a script. The display appears when you click the Simulator’s Info button. 

You can display either the SPRM or GPRM values, or both at the same time. You can also 
choose whether the values appear as decimal numbers or hexadecimal numbers. 
Seeing the SPRM and GPRM values can be useful when you want to ensure the right 
values are being set in the registers.

Additionally, you are able to enter values into the registers to preset a specific condition 
you want to test. To enter a value, double-click its existing value and enter the new one. 
Also, you can name the GPRMs within the Simulator. To name a GPRM, double-click the 
existing name in the Description column and enter a new one.

The Simulator has several preferences settings that allow you to verify script commands 
that rely on general DVD player settings, such as language preferences, aspect ratio, 
and region code. See “Simulator Preferences” on page 122 for more information on 
Simulator preferences.

See “Testing Your Project With the Simulator” on page 545 for more information on 
using the Simulator.

Select to show the 
GPRM values.

Select to show the values 
as hexadecimals.

Select to show the
SPRM values
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Testing a Script With DVD Player
The Apple DVD Player provides an additional way to test your scripts. Testing a project 
with DVD Player is referred to as emulating the project. It requires you to build the 
project, which creates the VIDEO_TS folder that DVD Player uses. See “Emulating Your 
Project” on page 570 for more information.

Testing a Script on Set-Top DVD Players
The best test to give your scripts is to play the title in a set-top DVD player. This method 
provides the most real-world experience, giving the scripts the most true tests.

To test scripts in a set-top player, you need to build and format your project, burning it 
onto a DVD. See “Formatting Your Project” on page 581 for more information on 
burning a DVD.

General Scripting Information
There are a number of good practices to keep in mind when creating your scripts:
• Plan your GPRM partitioning. Partitioning one or more of the eight 16-bit GPRM 

registers can add a lot of flexibility to your script writing by making many GPRM 
registers available to be used. However, keep in mind that some scripting 
configurations and display conditions require full 16-bit GPRM registers. Also, when 
you import a script item description, any GPRMs used by the script must be 
partitioned exactly the same as they were when the script was originally created. To 
ensure compatibility, it is a good idea to consistently partition your GPRMs the same 
way for each project. See “GPRM Specifics” on page 504 for information on saving 
and loading GPRM configurations. 

• Don’t forget about display conditions. Menus, tracks, and stories can all have display 
conditions applied to them. Display conditions work a lot like a simple pre-script—
they determine whether the element should play, and if not, provide a jump to an 
alternative element. One advantage of a display condition is that it is part of the 
track, and is placed in the same video title set (VTS) file as the track—by default, all 
scripts are placed in VTS 1 (though you can move them to the track’s VTS with the 
VTS Editor). In some cases, there could be a slight delay as the DVD player jumps 
from one VTS to the other to run a script. An additional advantage is that a display 
condition executes whether you jump to an element’s root or to a part of it (such as 
a button or marker). See “Pre-Scripts” on page 467 and “Display Condition” on 
page 603 for more information.



480 Chapter 14    Creating Scripts

 

• There are many ways to do the same thing. When creating your script, you will often 
find that there are alternate ways to accomplish the same task. The simplest 
approach is often the best, but other considerations, such as a lack of available 
GPRMs, may force you to be creative in your script writing. Sometimes it is better to 
create several small scripts rather than one large one that covers all situations. 

• Make sure the script has a way to end. It is important for the script to have an exit 
point that terminates its running and returns to playing the disc. For example, if you 
run a script that only uses the set command to configure some registers, the DVD 
player will just sit and wait for the script to finish, which it never will. 

You create the exit point by using one of three commands:  jump, resume, and exit 
pre-script. You can use a jump command in any script; however, you can use the 
resume and exit pre-script commands only in specific script types. See “Script 
Command Details,” next, for more information on these commands.

Script Command Details
Scripts can affect a disc’s playback in one of two ways:
• Playback can jump to a new location (track or menu).
• A different stream (audio, video, subtitle) can be selected.

Most scripts use several commands to perform these functions. Often, one script may 
use values placed in a GPRM by a different script that ran earlier.

Each of the ten commands has unique settings and uses. Some provide memory read 
and write functions, some control jumping to elements within the title, and others 
control how the script executes. These commands can be accessed at the top of the 
Script Command Inspector.

In addition to the command configurations, each can also use a compare operation 
that provides a conditional execution function.
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Compare Function
You can use the compare function to determine whether or not a command executes 
(also known as a conditional instruction execution). For example, you might set a jump 
command to go to a track, but use the compare function to make sure the DVD player 
supports its aspect ratio. If the compare function is not satisfied, the command is 
skipped and the script moves down to the next command.

A compare function compares a specified element, which you select, with a value in a 
specified GPRM. You choose how to compare the two elements from a list of 
operations (equal to, greater than, and so on). 

To configure a compare:
1 In the Script Command Inspector, select the Compare Command checkbox to activate 

the compare settings. 

2 Choose the GPRM location to compare to the selected element from the “Execute if” 
pop-up menu.

3 Choose the compare operation type from the “is” pop-up menu. 

4 Choose the type of elements to compare from the “to” pop-up menu.

5 Choose the actual element to compare to the GPRM from the “with value” pop-up menu. 

Choose the 
element type.

Choose the GPRM register.

Choose the 
actual element.

Choose the
compare operation.

Enables the
compare function.
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Element Types to Compare
You can choose from five different elements to be compared to the selected GPRM.

• GPRM:  Allows you to select any of the available GPRMs to compare. 
• SPRM:  Allows you to select any of the 24 SPRMs to compare. See “SPRMs’ Values and 

Their Meaning” on page 491 for a list of SPRMs.
• Immediate:  Allows you to enter a decimal value, whose range depends on the size of 

the selected GPRM register, to compare. 
• Jump Target:  Allows you to select from all available project elements (menus, tracks, 

stories, slideshows, and scripts) to compare.
• Special:  Allows you to choose from Current Item, Last Item, and Last Track to compare.

• Current Item is this script, unless this is a pre-script. If this is a pre-script, the Current 
Item is the project element (menu, track, slideshow, or story) the script is assigned to.

• Last Item is the project element that started this script running. 
• Last Track is the last track that was played, even if this script was started by a 

button on a menu.

Note:  Jump Target and Special require the selected GPRM to be a 16-bit GPRM 
register. If you choose a partitioned GPRM with the “Execute if” pop-up menu before 
choosing the element type, Jump Target and Special will not be available. If you 
choose Jump Target or Special as the element type before choosing the “Execute if” 
GPRM, partitioned GPRMs will not be available.

GPRMs To Be Compared To
You can select one of the GPRMs to be compared to the selected element. For the 
values in a GPRM to be meaningful, you must first load something into it with a 
previous command in this script or from a different script run earlier. This is often done 
using the set command, but there are several other ways to load a value into a GPRM.
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Compare Operations
There are seven compare operations that you can use to compare the selected element 
to the selected GPRM.

• = (equal):  Executes the command if the two values are the same.
• != (not equal):  Executes the command if the two values are not the same.
•  > = (greater or equal):  Executes the command if the selected GPRM is larger or the 

same as the selected element.
•  > (greater):  Executes the command if the selected GPRM is larger than the 

selected element.
• <= (smaller or equal):  Executes the command if the selected GPRM is smaller or the 

same as the selected element.
• < (smaller):  Executes the command if the selected GPRM is smaller than the 

selected element.
• & (and):  Performs a bit-wise “and” operation between the two values and executes 

the command if the bits set to 1 in the selected GPRM are also set to 1 in the 
selected element. See “Using Bit-Wise Operations” on page 503 for information on 
bit-wise operations.

Note:  You need to have a basic understanding of working with binary numbers to be 
able to use these operations.

Nop Command
The Nop (no operation) command provides a placeholder function. Anytime you add or 
insert a new step into a script, it is set to Nop. If a script encounters a Nop command 
while running, it immediately skips to the next command. If the Nop command is the 
last command, the script stops running and the title stops playing.

Note:  When a script is run as a pre-script, it reacts differently to having a Nop as the 
last command line. With a pre-script, if the last command is a Nop, it is treated as if it 
were an exit pre-script command, and the element the pre-script is assigned to displays 
as normal.
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Jump Command
Jump commands are usually the last step executed in a script, since they result in 
another element (menu, track, or script) starting to play. 

Note:  Being the last step executed is not the same as being the last step in the script. A 
script might have multiple jump commands in it, with other commands determining 
which jump to execute.

To configure a jump command:
1 In the Script Command Inspector, choose Jump from the Command pop-up menu.

2 Choose the project element to jump to from the Jump To pop-up menu.

GPRM-Based Checkbox
A jump normally goes to a specific part of an element; for example, to button 3 on 
menu 2. Jumps also have the ability to use a value from a GPRM to determine which 
button or marker they should go to. This is useful if, instead of jumping to a set 
location, you want to jump to a place that is flexible, based on a value that a previous 
script writes to a GPRM.

To jump to a GPRM-based location:
1 In the Script Command Inspector, select the GPRM Based checkbox to enable the 

GPRM selection pop-up menu.

2 Choose the element to jump to from the Jump To pop-up menu. Specific buttons and 
markers will be unavailable—you can only choose the basic elements (a menu, track, 
story, and so on).

3 Choose the GPRM to use from the GPRM pop-up menu. 

When jumping to menu buttons, you can load the GPRM with the actual button 
number (1 through 36). 

When jumping to markers, you must enter the marker number (1 through 99). Any 
values you enter above 99 result in the first marker being selected.
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Start At Loop Point Checkbox
You can add a loop point to your motion menu that defines when the highlights 
appear and where the menu jumps back to when it reaches the end. A jump to a 
motion menu normally goes to its start point and begins playing from there. There are 
times, however, when you might want the jump to go to the loop point instead, 
ensuring the highlights appear immediately and avoiding forcing the viewer to sit 
through the first part of the menu.

Selecting the Start At Loop Point checkbox configures the jump to play the menu from 
the loop point. See “About the Motion Settings” on page 282 for more information. See 
“Jumping to a Menu’s Loop Point” on page 509 for an example script using this feature.

Set GPRM Command
The set GPRM command is used to determine a value that is then placed in a GPRM 
location. There are four elements to set:
• The operation type:  There are 11 operations you can choose from, ranging from a 

simple move to a “bit-wise exclusive or.” See “Operation Types” on page 486 for 
details on using these operations.

• The source type:  You choose from five possible source element types that can be 
used as the source. See “Source Element Types” on page 487 for details on the 
element types.

• The source value:  Once you choose the source element type, you can then choose 
the actual element. For example, if you choose an SPRM element type, you use this 
setting to choose the specific SPRM to use as the source.

• The GPRM target:  You choose a GPRM location where the value gets written. 
Depending on the operation you choose, this GPRM location may also be the second 
value in a math operation. For example, if you choose a subtraction operation, the 
source value is subtracted from the current target value and the result is written to 
the target location.

Choose the operation.

Choose the source 
element type.

Choose the GPRM target.

Choose the actual 
source element.



486 Chapter 14    Creating Scripts

 

To configure a set command:
1 In the Script Command Inspector, choose the operation from the Operation pop-up 

menu.

2 Choose the source element type from the Source Type pop-up menu. 

3 Choose the actual source element from the Source Value pop-up menu. The list of 
elements is determined by the source element type selection set in step 2.

4 Choose the GPRM target from the Target pop-up menu.

Operation Types
There are 11 operations you can choose from to control how the source and target values 
are handled. There are limitations you need to keep in mind when using these operations:
• Registers have no overflow or underflow flags.
• If the script tries to store a value smaller than 0 or larger than 65535, no error 

message is given; instead, the value “wraps around.” For example, if you subtract 7 
from 3, you would normally get –4. But if you do this in a script, 65532 will be stored. 
If you add 6 to 65534 in a script, 4 is stored instead of 65540.

The operation types are:

• mov:  Moves the source value to the target location, overwriting the existing value in 
the target.

• swp:  Swaps the source value with the target value. The source value is written to the 
target location, and the target value is written to the source location. This is the only 
operation that writes to the source location.

• add:  Adds the source and target values together and writes the result in the 
target location.

• sub:  Subtracts the source value from the target value and writes the result in the 
target location.

• mul:  Multiplies the source value by the target value and writes the result in the 
target location.

• div:  Divides the target value by the source value and writes the result in the 
target location.

• mod:  Divides the target value by the source value and writes the remainder 
(modulo) in the target location.
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• ran:  Generates a random value between 1 and the source value and writes the result 
in the target location.

• and:  Performs a “bit-wise and” operation between the 16 individual bits of the source 
and the target values, and writes the result in the target location. The bits that are set 
(value of 1) in both values are left set. Bits that are not set in one or the other value 
are reset (value 0).

• or:  Performs a “bit-wise or” operation between the 16 individual bits of the source 
and the target values, and writes the result in the target location. The bits that are set 
(value of 1) in either value are left set. Bits that are not set in both of the values are 
reset (value 0).

• xor:  Performs a “bit-wise exclusive or” operation between the 16 individual bits of the 
source and the target values, and writes the result in the target location. The bits that 
are set (value of 1) in one or the other value (but not both) are left set. Bits that are or 
are not set in both of the values are reset (value 0).

Source Element Types
You choose from five different elements to be used as the source type.

• GPRM:  Allows you to select any of the available GPRMs as the source. 
• SPRM:  Allows you to select any of the 24 SPRMs as the source. See “SPRMs’ Values 

and Their Meaning” on page 491 for a list of SPRMs.
• Immediate:  Allows you to enter a decimal value, whose range depends on the size of 

the selected GPRM register, as the source. 
• Jump Target:  Allows you to select from all available project elements (menus, tracks, 

stories, slideshows, and scripts) as the source.
• Special:  Allows you to choose from Current Item, Last Item, and Last Track as the source.

• Current Item is this script, unless this is a pre-script. If this is a pre-script, the Current 
Item is the project element (menu, track, slideshow, or story) the script is assigned to.

• Last Item is the project element that started this script running. 
• Last Track is the last track that was played, even if this script was started by a 

button on a menu.

Note:  Jump Target and Special require the target to be a 16-bit GPRM register.



488 Chapter 14    Creating Scripts

 

Goto Command
The goto command provides a way to jump to a specific line in a script. This is usually 
used in conjunction with a compare function, with the result determining whether the 
goto command executes, or whether the script moves on to the next line.

Goto is useful when you build multiple jump commands into your script, since it allows 
you to choose which jump command to execute by forcing the script to its line.

The only entry (other than the compare settings) is the Line Number value, which is a 
number from 1 to 124.

Set System Stream Command
The set system stream command provides an easy way to set the audio, subtitle, and 
video angle streams. You can choose to enable one, two, or all of the three streams. In 
the case of the subtitle stream, you also choose whether or not it appears.

You choose between two modes to set the stream values:

• Immediate Value:  Select the streams directly using their pop-up menus. (Pop-up menu 
values that say “not set” indicate that no assets are currently assigned to that stream.) 

• GPRM Based:  Select a GPRM register in each stream’s pop-up menu.

Note:  You can only select 16-bit GPRM registers.
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To configure the set system stream command:
1 In the Script Command Inspector, choose either the Immediate Value or GPRM Based 

modes for stream selection by clicking the appropriate button.

2 Select the streams you want to control by clicking their checkboxes.

3 For each stream you select, use the pop-up menu to choose the stream (Immediate 
mode) or GPRM register (GPRM mode).

4 If you select the subtitle stream, select the View checkbox to force the subtitle to appear.

Resume Command
The resume command works like the Resume button on a DVD player’s remote 
control—when executed as a step in a script, the disc starts playing from where it last 
left off. 

Note:  When the resume command is executed from a pre-script, the result may not 
match your expectations. Instead of playing the last menu or track that the viewer saw, 
the track or menu that had the pre-script assigned to it plays instead (which, even 
though the viewer had not seen it, was the last element “viewed”).

GPRM Mode Command
Each 16-bit GPRM register can be set to function as a memory location or as an 
incrementing counter. By default, all GPRM registers, including those partitioned to 
smaller registers than 16-bits, are set to be memory registers. 

• Counter mode:  The value loaded into the register increments once per second. This 
mode can be a useful way to determine how far into the track the viewer has played.

• Register mode:  A value written to a register remains there until a new value is written 
or the disc is ejected.

To configure the GPRM mode command:
1 In the Script Command Inspector, click either the Counter or Register Mode button to 

set the selected GPRM’s mode.

2 Choose the GPRM register to configure with the Set To pop-up menu.

Only 16-bit GPRM registers appear in the pop-up menu. 
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Exit Command
The exit command provides a way to stop the title from playing back. If, while a script is 
running, an exit command is encountered, the script stops running and you are 
prevented from playing the title. For example, you may want to do this in response to 
the player’s region setting.

Exit Pre-Script Command
A pre-script executes as soon as an element is selected. Depending on the purpose of 
the pre-script, you will often want to have that element display as normal once the pre-
script is finished running. The exit pre-script command provides a way to end a pre-
script and display the element as normal.

Note:  When a script is run as a pre-script, it reacts differently to having a Nop as the 
last command line. With a regular script, if the last command line is a Nop and the 
script encounters it while running, the script stops and the title will no longer play. 
With a pre-script, if the last command is a Nop, it is treated as if it were an exit pre-
script command, and the element the pre-script is assigned to displays as normal.

Jump Indirect Command
With the normal jump command, you must specify an element (menu, track, story, 
slideshow, or script) to jump to, even when using the GPRM Based Button setting.

The jump indirect command provides a way to jump to an element that is entirely 
determined by a value stored in a GPRM. For example, you could have a script that uses 
the set command write the current menu’s value to a GPRM, and then later on have a 
second script use the jump indirect command to jump to that same menu by reading 
that GPRM.

Note:  You can only select from the 16-bit GPRM registers.
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System Parameter Register Memories
Each DVD player operates internally via a group of system parameter registers (System 
Parameter Register Memories, or SPRMs). The status of player operation (which DVD 
track is playing, what language is being used, and so on) can be read by script 
commands that access the SPRM status registers.

The following list describes the system parameters that can be read by a script:

• SPRM 0:  Menu language description code; DVD player setup by user
• SPRM 1:  Current audio stream number; set by user or program
• SPRM 2:  Current subtitle stream number; set by user or program
• SPRM 3:  Current angle number; set by user or program
• SPRM 4:  Current playing title number (Title); set by DVD player
• SPRM 5:  Current Video Title Set (VTS) number; set by DVD player
• SPRM 6:  Current title PGC number; set by DVD player
• SPRM 7:  Current part of title number (chapter); set by DVD player
• SPRM 8:  Current highlighted button number; set by viewer in DVD player
• SPRM 9:  Navigation timer; set by program, then times out
• SPRM 10:  Timer target; DVD track to play when SPRM 9 times out
• SPRM 11:  Player audio mixing mode for Karaoke; set by program or DVD player setup
• SPRM 12:  Country code for parental management
• SPRM 13:  Parental management level in effect
• SPRM 14:  Player video configuration (Aspect Ratio, Letterbox Mode)
• SPRM 15:  Player audio configuration (DTS, AC-3, MPEG, PCM, SDDS)
• SPRM 16:  Initial language code for audio, DVD player setup by user
• SPRM 17:  Initial language code extension for audio
• SPRM 18:  Initial language code for subtitle, DVD player setup by user
• SPRM 19:  Initial language code extension for subtitle
• SPRM 20:  Player region code
• SPRM 21:  Reserved
• SPRM 22:  Reserved
• SPRM 23:  Reserved

These SPRMs provide all of the status information and control capability for the scripts.

SPRMs’ Values and Their Meaning
In order to use the SPRMs, you need to know what the range of values is for these 
registers and what that information means. The following sections list the most 
common bits used when authoring DVDs. All SPRMs are 16-bit values, although only 
certain bits are described. See “Using Bit-Wise Operations” on page 503 for information 
on using the “bit-wise and” operation to isolate specific bits of the 16-bit value, allowing 
you to use only those bits that are necessary.



492 Chapter 14    Creating Scripts

 

SPRM 0:  Menu Language Description Code
Each DVD player has three types of language settings:  Menu (SPRM 0), Audio (SPRM 
16), and Subtitle (SPRM 18). These values are based on a two-letter code for each 
language spoken. The code is derived from the lowercase ASCII value of each letter.

For example, the letters “en” represent English. The lowercase “e” is converted to an 
ASCII value of 101 decimal or 65 in hexadecimal. The lowercase “n” is converted to an 
ASCII value of 110 decimal or 6E in hexadecimal. When concatenated together in 
hexadecimal, the value is 656E. The decimal value of 656E is 25966.

See “Language Code Table” on page 519 for a complete listing of all of these language 
values.

It is useful to know the setting of this SPRM when dealing with multiple-language 
projects. By reading the value of SPRM 0, you can determine the language the viewer 
wants to see the menus displayed in. For instance, if you have a project that has menus in 
more than one language, you can display menus in the language the viewer has selected.

SPRM 1:  Current Audio Stream Number
The DVD specification allows for up to eight different audio streams. This SPRM lists the 
current stream being played or the last one selected by the viewer.

The value range for this SPRM is 0 through 7, where 0 is the first stream and 7 is the 
last stream.

This information is useful when tracking which audio stream was last selected or 
played. It is very useful when determining which button to highlight when jumping to 
a menu where audio streams are selected. This is especially important if the viewer is 
allowed to change the audio stream while viewing the movie.

Stream number SPRM 1 value

1 0

2 1

3 2

4 3

5 4

6 5

7 6

8 7
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SPRM 2:  Current Subtitle Stream Number
The DVD specification allows for up to 32 different subtitle streams. This SPRM contains 
two sets of values. 

The first value shows which of the 32 streams is selected. These values range from 0 
through 31 with 0 being the first stream and 31 being the last stream. The second value 
of this SPRM is a display flag that tells you if the subtitle is turned on or off. The flag has 
a value of 64 for on and 0 for off.

To obtain the value of the stream that is selected and displayed, add 64 to the value of 
the stream. For example:  Stream 1 has a value of 0. If you add that value to the value of 
the display flag “on” (64), you get a total of 64. Stream 2 has a value of 1; if you add the 
value of the display flag on (64) to it, you get a total of 65.

The following table lists the possible settings for SPRM 2:

Stream number
SPRM 2 value with the stream 
selected and display off

SPRM 2 value with the stream 
selected and display on

1 0 64

2 1 65

3 2 66

4 3 67

5 4 68

6 5 69

7 6 70

8 7 71

9 8 72

10 9 73

11 10 74

12 11 75

13 12 76

14 13 77

15 14 78

16 15 79

17 16 80

18 17 81

19 18 82

20 19 83

21 20 84

22 21 85

23 22 86
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Similar to SPRM 1, this information is useful to determine the last subtitle stream 
selected by the viewer. If you have a menu for subtitle selection, you can use this 
information to highlight the corresponding button for the correct subtitle.

SPRM 3:  Current Angle Number
Similar to SPRM 1, the DVD specification allows for up to nine multi-angle MPEG 
video streams. This SPRM lists the current stream being played or the last one 
selected by the viewer.

The value range for this SPRM is 1 through 9, where 1 is the first stream and 9 is the last 
stream (the value does not start at 0 as with SPRMs 1 and 2). If there is only one angle, 
the default value is 1. 

Knowing which multi-angle stream was last selected or played is very useful when 
determining which button to highlight when jumping to a menu where multi-angle 
streams are selected. This is especially important if the viewer is allowed to change the 
multi-angle stream while viewing the movie. 

24 23 87

25 24 88

26 25 89

27 26 90

28 27 91

29 28 92

30 29 93

31 30 94

32 31 95

Stream number
SPRM 2 value with the stream 
selected and display off

SPRM 2 value with the stream 
selected and display on
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SPRM 4:  Current Playing Title Number 
Each track, story, and slideshow element in your project is a title. You can have up to 99 
titles in your project. All of these are assigned numbers based on their order in the 
Outline tab’s By VTS display. SPRM 4 shows the number for the currently playing element.

If your project does not have stories, the VTS number shown in the Outline tab’s By VTS 
display will match the SPRM 4 value. Since stories are not placed in their own VTS, 
including them in your project affects the SPRM 4 values. For example, you could have 
a project with two tracks, with Track 1 in VTS 1 including 2 stories (Story 1 and Story 2) 
and Track 2 in VTS 2. The SPRM 4 values for this project are:

• Track 1 = 1
• Story 1 = 2
• Story 2 = 3 
• Track 2 = 4

SPRM 5:  Current Title Number in Video Title Set (VTS)
In projects created with DVD Studio Pro, the title number within the current Video Title 
Set (VTS) number is 1 for all elements, except stories. Each story within a track is 
assigned to a higher title number, starting with 2 (the track itself is number 1). 

SPRM 6:  Current Title PGC Number
In projects created with DVD Studio Pro, the Program Group Chains (PGC) number is 
1 for all elements, except stories. Each story within a track is assigned a number, 
starting with 2 (the track itself is number 1). This value matches the SPRM 5 value 
except in the case where a track, story, or slideshow has not yet been played. In that 
case, it is set to 0.

SPRM 7:  Current Part of Title Number
The Part of Title is the current chapter number of the track being played. 

This SPRM is useful if you need to know the last or current chapter played for that track. 
There may be reasons to jump to the beginning of the last chapter played from any 
menu, not just resume to the last place in the video. An example of this would be a 
training film that requires the viewer to resume watching the chapter from the 
beginning if they do not watch the chapter in its entirety. 
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SPRM 8:  Current Highlighted Button Number
This SPRM is the last button number of the current or last menu displayed. You can use 
this SPRM to track the last button position that the viewer selected. The value is 
calculated by multiplying the button number by 1024 (this SPRM uses bits 10 through 
15 to count the buttons).

The table below lists the button number and its value:

Button number SPRM 8 value

1 1024

2 2048

3 3072

4 4096

5 5120

6 6144

7 7168

8 8192

9 9216

10 10240

11 11264

12 12288

13 13312

14 14336

15 15360

16 16384

17 17408

18 18432

19 19456

20 20480

21 21504

22 22528

23 23552

24 24576

25 25600

26 26624

27 27648

28 28672

29 29696

30 30720
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SPRM 9:  Navigation Timer
This is the timer used to count down pauses and still frames. DVD Studio Pro 
automatically loads this timer for timeouts and pauses. There is no real use for it in scripts. 

SPRM 10:  Timer Target
This SPRM is used in conjunction with SPRM 9. It is loaded with the PGC that is 
activated when the Navigation Timer (SPRM 9) expires. 

It is loaded and set by DVD Studio Pro, and there is no real use for it in scripts.

SPRM 11:  Player Audio Mixing Mode for Karaoke
Karaoke-capable DVD players can blend several audio streams together. 

Note:  Refer to SPRM 15 to identify whether or not a DVD player is karaoke-capable. 

The primary stream is usually a music-only track in stereo (L and R). It is usually stream 
number 1 or 2. To those streams you can mix a melody stream (M) or vocal streams 
(V1 and V2). The melody stream and the vocal streams are usually stream numbers 3, 4, 
and 5. The values of SPRM 11 are listed in the table below:

31 31744

32 32768

33 33792

34 34816

35 35840

36 36864

Button number SPRM 8 value

Bit description Bit Bit value

Reserved 0 1

Reserved 1 2

Stream 3 added to stream 1 2 4

Stream 4 added to stream 1 3 8

Stream 5 added to stream 1 4 16

Reserved 5 32

Reserved 6 64

Reserved 7 128

Reserved 8 256

Reserved 9 512

Stream 3 added to stream 2 10 1024

Stream 4 added to stream 2 11 2048

Stream 5 added to stream 2 12 4096
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The value can be any combination of the above values (excluding reserved) with 0 
indicating that no streams are added. A value of 3072 indicates that streams 3 and 4 are 
added to stream 2 (1024 + 2048).

SPRM 12:  Country Code for Parental Management
This SPRM lists the intended country code for the disc’s parental management feature. 
For the United States this is 840. 

SPRM 13:  Parental Management Level
SPRM 13 lists the parental management level that the DVD player is currently set for. 
This is set by the viewer and is used to prevent children from watching movies with 
mature content. 

SPRM 13 can be useful in several ways. In some cases there may be more than one 
version of a single movie on a single DVD disc. Larger discs such as DVD-9s can contain 
both the R- and PG-rated versions of the same movie. By reading the value of SPRM 13, 
you could determine which version of the movie to play. 

Another use for SPRM 13 is to check the DVD player’s current parental setting. If the 
disc is rated higher than the DVD player is currently set for, you could have a script that 
jumps to a menu explaining that the disc cannot be played unless the player’s parental 
setting is changed. 

Below is a list of the numeric values of SPRM 13.

Reserved 13 8192

Reserved 14 16384

Reserved 15 32768

Bit description Bit Bit value

MPAA rating SPRM 13 value

G 1

— 2

PG 3

PG-13 4

— 5

R 6

NC-17 7

— 8
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SPRM 14:  Player Video Configuration
Every DVD player has several modes of video display. These are divided into the display 
mode and the aspect ratio. By reading SPRM 14 you can tell what modes the player is 
currently in. Bits 8 and 9 of SPRM 14 are used to determine the current display mode 
(whether the video needs processing for display on a 4:3 monitor) and bits 10 and 11 
are used to determine the aspect ratio of the monitor (4:3 or 16:9). The first eight bits in 
SPRM 14 are not used.

The following table shows the combinations for the display mode bits.

The following table shows the combinations for the aspect ratio bits.

SPRM 15:  Player Audio Configuration
Each DVD player can have several types of audio capabilities. Most players can handle 
Dolby Digital (AC-3), Linear PCM, and MPEG Audio. There are other audio options such 
as DTS and SDDS, as well as karaoke capabilities. 

By reading the values of SPRM 15, you can see which audio options the player has. This 
could be useful if you have two types of audio streams and want to play the proper 
one for that player. For example, if the player is capable of Dolby Digital (AC-3) audio, 
you might want to play that stream instead of a stereo PCM stream.

Display mode Bit 8 Bit 9 Total

Normal (no processing) 0 0 0

Pan-scan 256 0 256

Letterbox 0 512 512

Reserved 256 512 768

Aspect ratio Bit 10 Bit 11 Total

4:3 0 0 0

Not specified 1024 0 1024

Reserved 0 2048 2048

16:9 1024 2048 3072
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Here is a table of the values for SPRM 15:

Bit 4 (MPEG karaoke capability first bit) is off when the player is not MPEG karaoke–
capable, and on when it is. Bit 5 (MPEG karaoke capability second bit) is always off.

Bit 12 (MPEG capability first bit) is off when the player is not MPEG capable, and on 
when it is. Bit 13 (MPEG capability second bit) is always off.

There is no bit for regular PCM capability since all players must support it.

SPRM 16:  Initial Language Code for Audio
This SPRM is the initial audio language that the viewer has set the DVD player to. It can 
be assumed to be the primary spoken language that the viewer wants to hear. 

As with SPRM 0, these values are derived from a two-letter code for each language 
spoken. The code is derived from the lowercase ASCII value of each letter. See “Language 
Code Table” on page 519 for a complete table of all of these language values. 

Player audio configuration Bit Bit value

Reserved 0 1

Reserved 1 2

SDDS karaoke capability (option) 2 4

DTS karaoke capability (option) 3 8

MPEG karaoke capability first bit 4 16

MPEG karaoke capability second bit 5 32

AC-3 karaoke capability 6 64

PCM karaoke capability 7 128

Reserved 8 256

Reserved 9 512

SDDS capability (option) 10 1024

DTS capability (option) 11 2048

MPEG capability first bit 12 4096

MPEG capability second bit 13 8192

AC-3 capability 14 16384

Reserved 15 32768
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It is useful to know the setting of this SPRM when dealing with multiple-language 
projects. By reading the value of SPRM 16, you can determine the spoken language that 
the viewer wants to hear. If you have a project that has audio streams in more than one 
language, you can play the appropriate spoken language that the viewer has selected. 
If the viewer must choose a language from an audio menu, this SPRM value can be 
used to select the appropriate button highlight.

SPRM 17:  Initial Language Code Extension for Audio
SPRM 17 is rarely used but has several values. It can be used to flag an audio stream as 
audio for the visually impaired or for director’s commentary. 

SPRM 18:  Initial Language Code for Subtitle
SPRM 18 is the value of the initial subtitle language setting of the DVD player. It is a 
preference set by the viewer.

Many feature films that are put onto DVD are subtitled in several languages. By reading this 
SPRM, you can preselect the appropriate subtitle stream to the viewer’s preferred language. 
In the case of a subtitle menu, you can preselect the appropriate button highlight.

As with SPRM 0, these values are derived from a two-letter code for each language 
spoken. The code is derived from the lowercase ASCII value of each letter. See “Language 
Code Table” on page 519 for a complete table of all of these language values.

SPRM 19:  Initial Language Code Extension for Subpicture
Similar to SPRM 17, SPRM 19 is an extension code for more in-depth information about 
the subtitle stream. It covers such areas as subpicture size or whether the subtitle 
stream is for children.

Contents SPRM 17 value

Not specified 0

Normal captions 1

Audio for visually impaired 2

Director’s comments 1 3

Director’s comments 2 4

Contents SPRM 19 value

Not specified 0

Captions with normal size 
characters

1

Captions with larger size 
characters

2

Captions for children 3

Reserved 4
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SPRM 20:  Player Region Code
In order to have some control over which parts of the world can play a disc, a regional 
coding system was developed. With this system, all standalone DVD players are 
manufactured to support a single region, and DVD players used by computers have a 
setting that configures the player’s region (with a limited number of changes allowed). 

This SPRM returns the value of the DVD player’s region code. 

The globe is divided into eight sections: 

• Region 1:  Canada, United States, Puerto Rico, Bermuda, the Virgin Islands, and 
some islands 

• Region 2:  Japan, Western Europe (including Poland, Romania, Bulgaria, and the 
Balkans), South Africa, Turkey, and the Middle East (including Iran and Egypt)

• Region 3:  Southeast Asia (including Indonesia, South Korea, Hong Kong, and Macao)
• Region 4:  Australia, New Zealand, South America, most of Central America, Papua 

New Guinea, and most of the South Pacific
• Region 5:  Most of Africa, Russia (and former Russian states), Mongolia, Afghanistan, 

Pakistan, India, Bangladesh, Nepal, Bhutan, and North Korea
• Region 6:  China and Tibet
• Region 7:  (Reserved)
• Region 8:  Airlines, cruise ships, and other types of transportation 

Closed captions with normal 
size characters

5

Closed captions with larger size 
characters

6

Closed captions for children 7

Reserved 8

Forced captions 9

Reserved 10

Reserved 11

Reserved 12

Director’s commentary with 
normal size characters

13

Director’s commentary with 
larger size characters

14

Director’s commentary for 
children

15

Contents SPRM 19 value
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Here is a table of regions and values for SPRM 20:

Using Bit-Wise Operations
More often than not, when working with the SPRM values, you will only be interested 
in certain bits of each 16-bit value. The “bit-wise” operations (and, or, and exclusive or), 
make it possible to mask the bits that are not needed, allowing you to determine the 
states of the specific bits you need.

Note:  You need to have a basic understanding of working with binary numbers to be 
able to use these operations.

Example:  Using a “Bit-Wise And” Operation
Suppose you need to find out whether the DVD player is configured for a 4:3 or 16:9 
aspect ratio monitor. To determine this, you only need to look at bits 10 and 11 of SPRM 
14. You can use the “bit-wise and” operation to mask all bits except 10 and 11, making it 
possible to easily determine the aspect ratio status without having to be concerned 
with the other bits.

Referring to the above table, the x’s in the SPRM 14 value represent bits that are not 
needed. Bits 10 and 11 use “0/1” to indicate bits that you want to retain—these may be 
set to either 0 or 1. When performing an AND operation, placing 0 in the bits you want 
to mask results in their being cancelled out, regardless of their state. Placing 1 in the 
bits you want to retain passes them to the result as is—a 0 is still a 0 and a 1 is still a 1. 
In this case, an AND value of 3072 produces the proper masking.

Region SPRM 20 value

1 1

2 2

3 4

4 8

5 16

6 32

7 64

8 128

15

x

0

0

14

x

0

0

13

x

0

0

12

x

0

0

11

0/1

1

0/1

10

0/1

1

0/1

9

x

0

0

8

x

0

0

7

x

0

0

6

x

0

0

5

x

0

0

4

x

0

0

3

x
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The value of the result produces four possible answers:  0, 1024, 2048, and 3072. In the 
case of SPRM 14, 0 indicates the DVD player is set to 4:3, and 3072 indicates it is set to 
16:9 (the values of 1024 and 2048 are either not specified or reserved).

General Purpose Register Memories
The General Purpose Register Memories (GPRMs) provide memory storage that can be 
used when building scripts. Unlike System Parameter Register Memories (SPRMs), GPRMs 
are not used directly by the DVD player—they are only used by scripts. Values, such as an 
SPRM or a value you specify, can be written to a GPRM, have a math operation applied to 
it, and can then be used by a script command to control the DVD player.

GPRM Specifics
DVD Studio Pro provides access to eight 16-bit GPRMs. Each register is completely 
independent of the others. All of the registers are set to 0 when a disc is inserted into 
the DVD player.

When creating scripts, you may find that you could use an additional GPRM or two. 
Since you will often not need the full 16-bits of a GPRM register, you are able to 
increase the number of GPRM registers by partitioning one or more of them into 
smaller sizes. For example, you could choose to partition GPRM 1 into four 4-bit 
registers. This makes it possible to greatly increase the usable number of GPRMs 
available when creating your scripts.

Important:  Several script command configurations and display conditions require the 
use of full 16-bit GPRM registers. For that reason, you are only allowed to partition 
seven of the eight 16-bit GPRM registers.

About SPRMs and Partitioned GPRMs
SPRMs fall into one of three categories:
• Those that use the first bits of their register, such as SPRM 1
• Those that use part of the register, but not the first bits, such as SPRM 14 which 

uses bits 8 through 11
• Those that use the entire register, with each bit representing the status of a 

function, such as SPRM 15

If you partition a GPRM into four 4-bit registers, then move the same SPRM value into 
each register, each of the 4-bit registers would get the same first four bits of the SPRM. 

As an example, while SPRM 14 only uses four bits of its register, since they are not the 
first four bits, they cannot be moved into a partitioned GPRM register. For this reason, 
it is recommended that you always keep several 16-bit GPRMs available.
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Configuring GPRM Partitions
You are able to individually configure the partitions of each 16-bit GPRM register. Once 
configured, you are then able to name them and save the configuration, which can 
then be loaded into a different project.

Important:  Once you partition a GPRM register and use it in a script, you cannot change 
the GPRM’s partition settings. You also cannot import a script’s item description unless 
the GPRMs it uses are partitioned the same as when the item description was saved.

To configure a GPRM’s partition:
1 Do one of the following:

• Select a script in the Outline or Graphical tab. The Script Inspector appears.
• Select the disc in the Outline tab, then click the Advanced tab in the Disc Inspector.
• Click an empty area in the Graphical tab, then click the Advanced tab in the 

Disc Inspector.

2 Click the pop-up menu for the GPRM you want to partition, then choose the partition 
configuration to use from the pop-up menu.
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You can choose from the following:

Note:  Any GPRMs that are currently used by a script have their pop-up menus 
deactivated and cannot have their partition configuration changed.

Once you choose the partition configuration to use for that GPRM, it displays the 
new registers.

Naming the GPRM Partitions
To help manage the process of creating a script, you are able to name each of the 
GPRM partitions. (Even a 16-bit GPRM is considered to have one partition.) This makes it 
easier to keep track of which GPRMs are being used for what purpose. Since the GPRMs 
are shared by all scripts, once you name one, that name appears in all places it is used 
in all scripts. You can name GPRMs in either the Script or Disc Inspector.

Note:  All partition names must be unique.

Partition configuration Result Range of each register

1 Partition One 16-bit register 0-65535

2 Partitions Two 8-bit registers 0-255

4 Partitions Four 4-bit registers 0-15

8 Partitions Eight 2-bit registers 0-3

16 Partitions Sixteen 1-bit registers 0-1

The registers of a 
partitioned GPRM

Click the disclosure
triangle to show or hide

the GPRM’s registers.
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To name a GPRM:
1 Do one of the following:

• Select a script in the Outline or Graphical tab. The Script Inspector appears.
• Select the disc in the Outline tab, then click the Advanced tab in the Disc Inspector.
• Click an empty area in the Graphical tab, then click the Advanced tab in the 

Disc Inspector.

2 Click a GPRM’s disclosure triangle to show its partitions.

3 Double-click the partition name and type the new name in the text entry box for the 
GPRM you want to rename.

Note:  You can also change a GPRM partition’s name in the Simulator’s Registers display.

Importing and Exporting GPRM Configurations
If you find yourself needing to copy scripts from one project to another (using item 
descriptions), you will find that it is much easier if you can be sure that each project 
uses the same GPRM configuration. One way to do this is to export the GPRM 
configuration from the project with scripts you want to copy from, and then import 
that GPRM configuration into the project you want to copy the script into. 

Important:  You can only copy a script from one project to another project if the GPRMs 
used by the script are partitioned the same way in both projects.

When you export a GPRM configuration, a file is created that contains the partition 
information for each of the GPRMs plus their names.

When you import a GPRM configuration, the GPRMs are changed to match those in the 
file, including the names. Some things to keep in mind:

• Any GPRMs that are already in use by a script will not be reconfigured, and a warning 
will appear. All other GPRMs will be reconfigured.

• The names of all GPRM registers are changed to match those in the file you are 
importing. Any GPRMs that are already in use are not affected.
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To export a GPRM configuration:
1 Configure the GPRM register partitions, including changing their names if needed.

2 Do one of the following:

• Click the Script Inspector’s Export button.
• Click the Export button in the Advanced tab of the Disc Inspector.
The Export dialog opens.

3 Enter a name for the file, select its destination, and click Export.

A file is created using the name you entered plus a “.dspPartition” extension.

To import a GPRM configuration:
1 Do one of the following:

• Click the Script Inspector’s Import button. 
• Click the Import button in the Advanced tab of the Disc Inspector.
The Import dialog opens.

2 Select the file to import and click Import.

Note:  To avoid configuration conflicts, you should import the GPRM configuration 
before creating any scripts.

Setting a GPRM’s Mode
Each 16-bit GPRM register can be set to function as a memory register or as a 
decrementing counter. 

Note:  By default, all GPRM registers, including those less than 16-bits, are set to be 
memory registers. 

• As a memory register, a value written to it remains there until a new value is written 
or the disc is ejected.

• As a counter, once you load a value into the register, the value counts up once per 
second. You can pause the count by changing the mode back to register.

You set a GPRM’s mode using the GPRM Mode command as part of a script. Once you 
have set a GPRM’s mode, it stays that way until it is changed or the disc is ejected.
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Scripting Examples
By their nature, scripts tend to be very project-specific. While the function of a 
particular script might apply to a wide variety of projects, the specific tracks, streams, 
and menus it works with vary.

The following examples provide you with step-by-step instructions that can help you 
understand the process of creating a script, from the initial concept to the final 
product. These scripts show just one way to accomplish their tasks—alternate ways to 
accomplish the same results often exist.

Note:  These examples use menu and track names that are fictitious. You can create these 
elements and add suitable assets to them, or adapt these examples to your existing 
assets. You can even create these as empty elements, with no assets assigned. It is the 
names of the elements that get used in these script examples, not the actual assets. 
Additionally, these examples assume you have not partitioned the GPRMs.

Jumping to a Menu’s Loop Point
For this script, the project has a motion menu that has a loop point set, and you want 
to be able to have other elements jump directly to the loop point, bypassing the first 
part of the menu’s video.

For this script, you’ll call the menu Main Menu.

To create a Jump to Loop Point script:
1 Do one of the following:

• Choose Project > Add to Project > Script.
• Click Add Script in the toolbar.
• Press Command-’ (single quote).

2 Double-click the new script in the Outline or Graphical tab. 

The Script Editor opens and the Script Inspector appears.

3 In the Inspector, name the script Jump to Loop Point.

4 In the Script Editor, select the first command line (Nop). 

The Script Command Inspector appears.

5 In the Script Command Inspector, choose Jump as the command.

6 Choose Menus > Main Menu > [Menu] from the Jump To pop-up menu.

7 Select the Start At Loop Point checkbox.

You can use this script anyplace where you might normally jump to the Main Menu. For 
example, you could set a track’s End Jump to run this script—when the track finishes 
playing, it jumps to the Main Menu’s loop point.
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Randomly Playing Tracks
For this script, the project has four tracks, and you want a script to randomly choose 
one to play once a menu times out (has been inactive for a set amount of time).

For this script, you’ll call the tracks “Ocean,” “Beach,” “Trail,” and “Shopping.”

To create a Random Play script:
1 Do one of the following:

• Choose Project > Add to Project > Script.
• Click Add Script in the toolbar.
• Press Command-’ (single quote).

2 Double-click the new script in the Outline or Graphical tab. 

The Script Editor opens and the Script Inspector appears.

3 In the Inspector, name the script Random Play.

4 In the Script Editor, select the first command line (Nop). 

The Script Command Inspector appears.

5 In the Script Command Inspector, choose Set GPRM as the command.

6 To configure the set GPRM command:

• Choose “ran” as the Operation.
• Choose Immediate as the Source Type.
• Enter 4 as the Source Value.
• Choose GPRM 0 as the Target.
The above settings will generate a random number between 1 and 4 and place the 
value in GPRM 0. It is this value that will be looked at by the next commands in this 
script to determine which track to play.

7 In the Script Editor, click the Add button. 

The next command line is added to the script.

8 In the Script Command Inspector, choose Jump as the command.

9 To configure the jump command, choose Tracks and Stories > Ocean > Marker 1 from 
the Jump To pop-up menu. This plays the first of the four tracks, depending on the 
result of the compare function added next. 

Note:  Remember that the Ocean track is fictitious. Unless you created a track called 
Ocean, you won’t see it in this pop-up menu.
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10 Add a compare function to the jump command to test to see if this track has been 
selected with the random generator.

• Select the Compare Command checkbox.
• Choose GPRM 0 as the “Execute if” element to be compared to.
• Choose equal (=) as the “is” compare operation type.
• Choose Immediate as the “to” element type to compare.
• Enter 1 as the “with value.” 
If GPRM 0 has a 1 in it (generated by the random number generator command), this 
jump command occurs. If not, the script moves to the next command.

11 Add three additional jump command lines—one for each of the other three fictitious 
tracks. The only differences are the Jump To settings which need to match each track 
(Tracks and Stories > Beach > Marker 1; Tracks and Stories > Trail > Marker 1; and Tracks 
and Stories > Shopping > Marker 1) and the immediate values in the compare 
function’s “with value” field (use 2 for the Beach track, 3 for the Trail track, and 4 for the 
Shopping track).

12 You need to configure the menu’s timeout setting by selecting the menu in the Outline 
or Graphical tab, then clicking the General tab in the Menu Inspector. Choose Timeout 
from the At End pop-up menu and enter a value (in seconds) for the timeout. Choose 
this script (Random Play) from the Action pop-up menu.

Each time the menu sits idle for the specified amount of time, the script starts, 
generates a random number, and then plays one of the four tracks. Once the track 
ends, it jumps to the element specified by its End Jump setting. 
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Playing All Tracks
For this script, the project has four tracks, each with a button on the main menu to 
start it playing. You want to add a Play All button that will play all four tracks in order, 
returning to the main menu once they have finished. In this case, you will create five 
scripts—one that starts the Play All progress and one for each track that determines 
whether a Play All function is active. 

The Play All script places a value in a GPRM that will indicate to the other scripts that a 
Play All function is in process. It then jumps to the first track and starts it playing.

The other scripts are linked to each track’s End Jump settings. These scripts test to see if 
the Play All function is active. If it is, the script jumps to the next track. If not, the script 
jumps back to the main menu. 

For this script, you’ll call the tracks “Ocean,” “Beach,” “Trail,” and “Shopping.”

The Play All Script
This is the script you will link to the main menu’s Play All button.

To create the Play All script:
1 Do one of the following:

• Choose Project > Add to Project > Script.
• Click Add Script in the toolbar.
• Press Command-’ (single quote).

2 Double-click the new script in the Outline or Graphical tab. 

The Script Editor opens and the Script Inspector appears.

3 In the Script Inspector, name the script Play All.

4 In the Script Editor, select the first command line (Nop). 

The Script Command Inspector appears.

5 In the Script Command Inspector, choose Set GPRM as the command.

6 To configure the set GPRM command:

• Choose “mov” as the Operation. 
• Choose Immediate as the Source Type.
• Enter 1 as the Source Value.
• Choose GPRM 0 as the Target.
The above settings place the value 1 in GPRM 0. It is this value that will be looked at by 
the other scripts to determine whether a Play All function is in progress.
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7 In the Script Editor, click the Add button. 

A second command line is added to the script.

8 In the Script Command Inspector, choose Jump as the command.

9 To configure the jump command, choose Tracks and Stories > Ocean > Marker 1 from 
the Jump To pop-up menu. This plays the first of the four tracks.

Note:  Remember that the Ocean track is fictitious. Unless you created a track called 
Ocean, you won’t see it in this pop-up menu.

Link this script to the main menu’s Play All button. See “Setting a Button’s Connection” 
on page 258 for more information.

The Track End Scripts
The scripts you will link to the End Jump settings of the first three tracks are nearly 
identical—the only difference is the track name they jump to if a Play All function is in 
progress. The script used by the last track is a bit different, since it resets the GPRM that 
indicates a Play All function is in progress and always jumps to the main menu. 

Track End Scripts for the First Three Tracks
Follow these steps to create the script for the first track (Ocean). The notes indicate any 
changes you would enter for the other tracks (Beach and Trail). Remember these track 
names are fictitious, and you won’t actually see them in the pop-up menu unless you 
create them.
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To create the script for the first three tracks:
1 Create a script and select it.

2 Enter Ocean End as the script’s name.

Note:  Enter Beach End and Trail End as the names when creating the scripts for 
the other two tracks.

3 In the Script Editor, select the first command line (Nop). 

4 In the Script Command Inspector, choose Jump as the command.

5 To configure the jump command, choose Tracks and Stories > Beach > Marker 1 from 
the Jump To pop-up menu.

Note:  Choose Tracks and Stories > Trail > Marker 1 and Tracks and Stories > Shopping > 
Marker 1 when creating the scripts for the other two tracks.

6 Add a compare function to the jump command to test to see if a Play All function is 
in process.

• Select the Compare Command checkbox.
• Choose GPRM 0 as the “Execute if” element to be compared to.
• Choose equal (=) as the “is” compare operation type.
• Choose Immediate as the “to” element type to compare.
• Enter 1 as the “with value.” 
If GPRM 0 has a 1 in it (indicating the Play All function is in progress), this jump 
command occurs. If not, the script moves to the next command line.

7 In the Script Editor, click the Add button. 

The next command line (Nop) is added to the script. 

8 In the Script Command Inspector, choose Jump as the command.

9 To configure the jump command, choose Menus > Main Menu > Button 1 from the 
Jump To pop-up menu.

Like the track names, Button 1 is fictitious, used to illustrate the example.
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This jump only occurs if the compare function was not satisfied in the previous command.

Once you have created all three scripts, link each to the appropriate track’s End Jump 
setting (at the top of the Track Inspector for each track).

This script jumps to
the Beach track once the

Ocean track
finishes playing.

This script jumps to
the Trail track once

the Beach track
finishes playing.

This script jumps
to the Shopping track

once the Trail track
finishes playing.
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Track End Script for the Last Track
Follow these steps to create the script for the last track (Shopping). The main menu always 
appears when this track finishes playing—the difference is that the GPRM value needs to 
be set back to 0 so that a Play All process does not inadvertently get started later. 

To create the Track End script for the last track:
1 Create a script and select it.

2 Enter Shopping End as the script’s name.

3 In the Script Editor, select the first command line (Nop). 

4 In the Script Command Inspector, choose Set GPRM as the command.

5 To configure the set GPRM command:

• Choose “mov” as the Operation. 
• Choose Immediate as the Source Type.
• Enter 0 as the Source Value.
• Choose GPRM 0 as the Target.
The above settings place the value 0 in GPRM 0, ending the Play All process and 
ensuring that if you play any of the tracks individually, they will jump back to the main 
menu when finished playing. 

6 In the Script Editor, click the Add button. 

The next command line (Nop) is added to the script. 

7 In the Script Command Inspector, choose Jump as the command.

8 To configure the jump command, choose Menus > Main Menu > Button 1 from the 
Jump To pop-up menu.

This script always sets GPRM 0 to 0 and jumps back to the main menu. Link this script 
to the Shopping track’s End Jump setting, located at the top of its Track Inspector.
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Checking a DVD Player’s Parental Management Setting
For this script, the project has a track with two audio streams. One stream contains 
language suitable for mature viewers while the other has been edited, replacing the 
offensive words with those better suited to younger viewers. Before playing the track, 
the script needs to check the DVD player’s parental management setting, and then play 
the appropriate audio stream.

The track is named Main Program; stream A1 contains the original audio, and stream 
A2 contains the edited audio.

Creating the Script
This script will be used as a pre-script for the Main Program track, and will verify the 
DVD player’s parental management setting each time the track plays.

To create the script:
1 Do one of the following:

• Choose Project > Add to Project > Script.
• Click Add Script in the toolbar.
• Press Command-’ (single quote).

2 Double-click the new script in the Outline or Graphical tab. 

The Script Editor opens and the Script Inspector appears.

3 In the Script Inspector, name the script Parental Check.

4 In the Script Editor, select the first command line (Nop). 

5 In the Script Command Inspector, choose Set GPRM as the command.

6 To configure the set GPRM command:

• Choose “mov” as the Operation. 
• Choose SPRM as the Source Type.
• Choose SPRM 13 as the Source Value. 
• Choose GPRM 0 as the Target.
The above settings copy the SPRM 13 value to GPRM 0.

7 In the Script Editor, click the Add button. 

The second command line is added to the script.

8 In the Script Command Inspector, choose Set GPRM as the command.
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9 To configure the set GPRM command:

• Choose “and” as the Operation. 
• Choose Immediate as the Source Type.
• Enter a value of 15 as the Source Value. 
• Choose GPRM 0 as the Target.
The above settings configure an operation that ensures that only the first four bits of 
the SPRM 13 value are in GPRM 0 (the value 15 sets the first four bits to 1 and the 
remaining 12 bits to 0). See “Using Bit-Wise Operations” on page 503 for more 
information on the “and” operation.

10 In the Script Editor, click the Add button again. 

The next command line is added to the script.

11 In the Script Command Inspector, choose Set System Stream as the command.

12 To configure the set system stream command:

• Click the Immediate Value button.
• Select the Audio checkbox.
• Choose 2 from the audio stream pop-up menu.
Make sure the other stream checkboxes are not selected. This command sets stream 2 
(the edited audio) as the stream to play for this track.

13 In the Script Editor, click the Add button again. 

The next command line is added to the script.

14 In the Script Command Inspector, choose Set System Stream as the command.

15 To configure the set system stream command:

• Click the Immediate Value button.
• Select the Audio checkbox.
• Choose 1 from the audio stream pop-up menu.
Make sure the other stream checkboxes are not selected. This command will play the 
original stream. 

16 To make sure this command only sets stream 1 (the original stream) as the playback 
stream if the player is set to play R or higher-rated tracks, set up a compare function:

• Select the Compare Command checkbox.
• Choose GPRM 0 as the “Execute if” element to be compared to.
• Choose “greater or equal” (> =) as the “is” compare operation type.
• Choose Immediate as the “to” element type to compare.
• Enter 6 as the “with value” element to compare.
The above settings check to see if the value in GPRM 0 (originally from SPRM 13) is 
equal to or greater than the value 6 (the equivalent of an R rating). If the compare is 
satisfied, audio stream 1 is set to be played. If not, the script leaves the audio stream 
setting at 2 (as set with the third command) and goes to the next command.
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17 In the Script Editor, click the Add button again. 

The next command line is added to the script.

18 In the Script Command Inspector, choose Exit Pre-Script as the command. 

This command stops the script and starts playing the track.

All you need to do now is to assign this script to that track as its pre-script by selecting 
it in the Pre-Script pop-up menu of the Track Inspector for that track. Whenever that 
track is played, it will first verify the parental management setting and then choose the 
appropriate audio stream. 

Language Code Table
This table lists all possible languages and their numeric equivalents. It is sorted 
alphabetically by the language name.

Language Code HEX Decimal

(Afan) Oromo om 6F6D 28525

Abkhazian ab 6162 24930

Afar aa 6161 24929

Afrikaans af 6166 24934

Albanian sq 7371 29553

Amharic am 616D 24941

Arabic ar 6172 24946

Armenian hy 6879 26745

Assamese as 6173 24947

Aymara ay 6179 24953

Azerbaijani az 617A 24954

Bashkir ba 6261 25185

Basque eu 6575 25973

Bengali; Bangla bn 626E 25198
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Bhutani dz 647A 25722

Bihari bh 6268 25192

Bislama bi 6269 25193

Breton br 6272 25202

Bulgarian bg 6267 25191

Burmese my 6D79 28025

Byelorussian be 6265 25189

Cambodian km 6B6D 27501

Catalan ca 6361 25441

Chinese zh 7A68 31336

Corsican co 636F 25455

Croatian hr 6872 26738

Czech cs 6373 25459

Danish da 6461 25697

Dutch nl 6E6C 28268

English en 656E 25966

Esperanto eo 656F 25967

Estonian et 6574 25972

Faeroese fo 666F 26223

Fiji fj 666A 26218

Finnish fi 6669 26217

French fr 6672 26226

Frisian fy 6679 26233

Galician gl 676C 26476

Georgian ka 6B61 27489

German de 6465 25701

Greek el 656C 25964

Greenlandic kl 6B6C 27500

Guarani gn 676E 26478

Gujarati gu 6775 26485

Hausa ha 6861 26721

Hebrew iw 6977 26999

Hindi hi 6869 26729

Hungarian hu 6875 26741

Icelandic is 6973 26995

Indonesian in 696E 26990

Language Code HEX Decimal
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Interlingua ia 6961 26977

Interlingue ie 6965 26981

Inupiak ik 696B 26987

Irish ga 6761 26465

Italian it 6974 26996

Japanese ja 6A61 27233

Javanese jw 6A77 27255

Kannada kn 6B6E 27502

Kashmiri ks 6B73 27507

Kazakh kk 6B6B 27499

Kinyarwanda rw 7277 29303

Kirghiz ky 6B79 27513

Kirundi rn 726E 29294

Korean ko 6B6F 27503

Kurdish ku 6B75 27509

Laothian lo 6C6F 27759

Latin la 6C61 27745

Latvian, Lettish lv 6C76 27766

Lingala ln 6C6E 27758

Lithuanian lt 6C74 27764

Macedonian mk 6D6B 28011

Malagasy mg 6D67 28007

Malay ms 6D73 28019

Malayalam ml 6D6C 28012

Maltese mt 6D74 28020

Maori mi 6D69 28009

Marathi mr 6D72 28018

Moldavian mo 6D6F 28015

Mongolian mn 6D6E 28014

Nauru na 6E61 28257

Nepali ne 6E65 28261

Norwegian no 6E6F 28271

Occitan oc 6F63 28515

Oriya or 6F72 28530

Pashto, Pushto ps 7073 28787

Persian fa 6661 26209

Language Code HEX Decimal
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Polish pl 706C 28780

Portuguese pt 7074 28788

Punjabi pa 7061 28769

Quechua qu 7175 29045

Rhaeto-Romance rm 726D 29293

Romanian ro 726F 29295

Russian ru 7275 29301

Samoan sm 736D 29549

Sangro sg 7367 29543

Sanskrit sa 7361 29537

Scots Gaelic gd 6764 26468

Serbian sr 7372 29554

Serbo-Croatian sh 7368 29544

Sesotho st 7374 29556

Setswana tn 746E 29806

Shona sn 736E 29550

Sindhi sd 7364 29540

Singhalese si 7369 29545

Siswati ss 7373 29555

Slovak sk 736B 29547

Slovenian sl 736C 29548

Somali so 736F 29551

Spanish es 6573 25971

Sundanese su 7375 29557

Swahili sw 7377 29559

Swedish sv 7376 29558

Tagalog tl 746C 29804

Tajik tg 7467 29799

Tamil ta 7461 29793

Tatar tt 7474 29812

Tegulu te 7465 29797

Thai th 7468 29800

Tibetan bo 626F 25199

Tigrinya ti 7469 29801

Tonga to 746F 29807

Tsonga ts 7473 29811

Language Code HEX Decimal
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Turkish tr 7472 29810

Turkmen tk 746B 29803

Twi tw 7477 29815

Ukrainian uk 756B 30059

Urdu ur 7572 30066

Uzbek uz 757A 30074

Vietnamese vi 7669 30313

Volapuk vo 766F 30319

Welsh cy 6379 25465

Wolof wo 776F 30575

Xhosa xh 7868 30824

Yiddish ji 6A69 27241

Yoruba yo 796F 31087

Zulu zu 7A75 31349

Language Code HEX Decimal
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15 Establishing Connections

Your DVD title is a collection of elements you want your 
audience to view. The way you set the connections 
between these elements determines the way the viewer 
experiences your DVD title.

You can use the Connections tab to determine how the viewer moves from one 
element to another. You make links so the viewer jumps from a starting point, or 
source, to a destination, or target. 

About Connections
There are a number of places within DVD Studio Pro where you can establish 
connections between a project’s elements. Some are in Inspectors and some are in 
shortcut menus. Some connections are automatically set when you import an asset 
directly to a menu or track. The Connections tab provides a way to view and set all 
connections for a selected element, such as a menu or track, at the same time. You can 
also use the Connections tab to verify that you have not inadvertently left an item 
without a connection.
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Connections Tab
Connections are listed in two sections in the Connections tab. The sources (the 
elements’ starting points) and their current connections are on the left and the targets 
(the destinations) are on the right. 

You can also display the two halves of the Connections tab with the sources on the top 
and the targets on the bottom by either clicking the buttons in the upper-right corner 
or pressing the Control key and clicking the separator bar.

This project’s targets that 
can be connected to the 
selected source 

Choose the Connections
tab layout to use.

The sources and current 
connections for the selected 
element in the Outline or 
Graphical tab (in this case, 
the disc)

Drag this separator bar to set
the size of the two halves of

the Connections tab.
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The pop-up menus along the top of the Connections tab allow you to choose the 
detail level of the sources and whether to view only sources that do or do not have a 
connection assigned. 

Connection Items
There are three items involved in making a connection:
• The project element that is the subject of the connection. This can be a menu, track, 

slideshow, or the disc in general. The contents of the Connections tab change to 
match those that apply to the currently selected element.

• The source to be connected from. Every menu, track, slideshow, and disc has sources 
that you can link from. The more complicated the element, the more sources it will 
have (a menu with 12 buttons will have more source connections than a menu with 
4 buttons).

• The target to be connected to. Targets include all possible connections for all 
elements within your project. Most targets are available to each source. While a 
source can only connect to one target, a target can be used by multiple sources.

Project Elements
The project element you select in the Outline or Graphical tab determines the list of 
sources displayed in the Connections tab. Selecting the disc displays all sources from all 
elements, plus a few sources that do not appear in any of the other elements.

Choose a connection
status to show.

Choose the source detail 
level to show.

The element the 
sources belong to 
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Sources
Sources fall into five categories:  the disc, menus, tracks, stories, and slideshows. The 
number of choices you see in the list of sources depends on the selected element and 
whether you have chosen Basic, Standard, or Advanced from the View pop-up menu 
above the source list.

• Basic:  The most fundamental jumps you can make are in the basic list of sources. 
These include the startup action for the disc and the jumps made when the viewer 
presses the Title and Menu buttons on the remote control when the disc is inserted 
in the player. The basic link for menus is where to jump when buttons are activated. 
The basic links for tracks and slideshows are where to jump when playback is 
finished and where to jump when the Menu button is selected while the track or 
slideshow is playing.

• Standard:  The most commonly used jumps are found in the standard list of sources. 
In addition to those in the basic list, pre-scripts (scripts designed to run when the 
element is chosen) are listed for menus, tracks, and slideshows. If a DVD menu has 
been on the screen for a period of time specified in the General tab in the Menu 
Inspector, the subsequent action is determined by the Menu Timeout Target link. 
Each marker in a track and each slide in a slideshow displays its own end jump and 
menu button links.

• Advanced:  The advanced list of sources contains all of the possible sources available 
for the selected element. In addition to the basic and standard sources, the Return 
button on the DVD player’s remote control is also listed. 

Disc

Menus

Tracks

Slideshows

Stories

Drag this divider to adjust 
the Source and Target 
column widths.

The current connections 
between the sources 
and targets
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Additionally, for tracks and slideshows you can set connections for the following 
buttons found on some remote control devices:  Audio, Subtitle, Angle, and Chapter 
menu buttons. These links can make it convenient for viewers to access DVD menus 
that allow them to select audio and subtitle options, an angle, or a chapter. However, 
be sure to design your title with other ways to reach these DVD menus, since very few 
remote controls offer these buttons.

Important:  It is important not to confuse these buttons with the Audio, Subtitle, and 
Angle selection buttons commonly found on remote controls—these buttons do not 
access a menu, and instead directly change the selected stream.

See “Source Details” on page 534 for a complete list of sources as well as methods 
(other than the Connections tab) that you can use to link them.

Next Jump and Prev Jump
Tracks and slideshows have two settings, Next and Previous Jump, that can only be set 
in the Connections tab with the advanced sources displayed. These settings define 
what happens when the viewer presses the Next and Previous buttons on the DVD 
player’s remote control. 

While a track or slideshow is playing, the Next and Previous buttons allow the viewer to 
skip forward or backward between markers or stills. A setting in the Connections tab 
defines what happens if the viewer presses the Next or Previous button when there is 
no next or previous marker or slide. By default, with nothing assigned to these settings, 
nothing happens. This is the normal action used for most projects.

If you establish a connection to either of these buttons, there are two issues that you 
must be aware of:

• You will no longer be able to set the Menu button action for each marker—you will 
only be able to set it for the first marker.

• The DVD player will no longer display a play time for the track or slideshow.

See “Setting a Pause on the Last Slide” on page 420 for information on using the Next 
Jump setting in a slideshow.

Targets
The list of targets includes all menus and their buttons, all tracks and their stories and 
markers, all slideshow stills, and all scripts. There are four additional commands that 
can appear at the top of the list, depending on the selected source:  Resume, Stop, 
Same as Disc, and Same as Track. 

See “Target Details” on page 541 for a complete list of targets.
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Default Connections
There are two types of connections that DVD Studio Pro makes automatically:  linking 
each marker in a track to the next marker, and assigning the same menu button action 
to all of a track’s markers. These connections are not shown in the Connections tab, and 
can be overridden by assigning different targets while in the Standard or Advanced 
source view.

Chapter-to-Chapter Connections
DVD Studio Pro automatically links the end jump from one marker to the beginning of 
the next marker. This allows a track to play seamlessly through the markers. The end 
jump for the last marker is not linked to any targets—you must set this yourself using 
the End Jump setting.

Setting Chapter Marker End Jumps
In addition to the limit of 99 chapter markers per track, DVD Studio Pro has a 
combined limit of 106 chapter markers and individual chapter end jump settings per 
track. This is normally not an issue except in special cases where you decide to set an 
end jump for each chapter marker. 

If your track has 54 chapter markers, each configured with an end jump, the result is a 
combined 108 markers and jump settings. This will cause an error message to appear 
when you build the project. Since setting end jumps on chapter markers prevents the 
track from playing seamlessly from start to end, you can instead divide the track into 
two tracks, each containing a portion of the markers and thus avoid the 106 limit.

Why Would You Do This?
For example, you might use chapter markers with end jumps set to “edit” a track into 
multiple small clips. If you configure a menu button to jump to a specific chapter 
marker, the track starts playing from that point. Once the next marker is reached, the 
end jump directs the DVD player back to the menu, resulting in only a small portion 
of the track playing. 

The advantage of this is that you can easily configure a track to play as short clips and 
not worry about running into the 99 tracks, stories, and slideshows per project limit. The 
disadvantage of this is that you cannot play the track from start to end—as soon as the 
first marker that has its end jump set is reached, the player jumps to that setting. 

Using Stories
You can accomplish a similar result by creating a story that plays only from one 
chapter marker to the next. The disadvantage of doing this is that if you have a lot of 
these that you want to configure, you will quickly run into the 99 tracks, stories, and 
slideshows per project limit.
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Menu Button Connections
Once you establish a connection to the Menu button of the DVD player’s remote 
control, it is automatically applied to all markers in the track. 

Making Connections
Making connections involves displaying the correct sources and then linking them to 
the targets. While the Connections tab provides a complete list of all possible 
connections between your project’s elements, many of these connections can also be 
configured using other methods. 

Connections can be made in a number of Inspectors, including those for menus, 
buttons, tracks, slideshows, and the disc. For example, in the Button Inspector, you can 
set the target for a button. Additionally, you can set connections to buttons in the 
Menu and Subtitle Editors.

See “Source Details” on page 534 for a complete list of all sources and their alternative 
linking methods. See “Target Details” on page 541 for a complete list of all targets.

Changing the Displayed Sources
There are three groups of sources you can see in the source list:  basic, standard, and 
advanced. The most fundamental jumps for the selected element are shown in Basic 
source view. The most commonly used jumps are shown in the Standard source list. 
The Advanced list shows all possible jumps for the selected element. 

To change the sources displayed:
1 Select the element you want to work with in the Outline or Graphical tab. For a global 

view of all the sources, select the disc in the Outline tab, or click an empty area in the 
Graphical tab.

2 Choose Basic, Standard, or Advanced from the View pop-up menu located just above 
the source list.

Choose which sources
are shown.
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You can also display all sources, only sources with connections, or only sources without 
connections, using the second View pop-up menu.

Establishing Connections in the Connections Tab
There are several methods you can use to establish connections in the Connections 
tab:  dragging targets to the sources, using shortcut menus, and using keyboard shortcuts.

To establish a connection in the Connections tab:
1 Determine the source to which you want to assign a target.

2 Do one of the following:

• Locate the item you want to link to in the Targets column on the right, and drag it to 
the source on the left. A black box surrounds the selected source, making it clear that 
you are linking to the correct one.

If you drag a target that is not supported by the source, the black box does not appear.

Use each source’s connection 
status to choose which 
sources to display.
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• Hold down the Control key and click in the Target column next to the source for 
which you want to create a link. Choose a target from the shortcut menu. 

• Click to select a source and a target, then click the Connect button at the top of the 
Connections tab.

You can change an existing connection using these same methods. 

To establish connections using keyboard shortcuts:
1 Press the Up and Down Arrow keys to scroll through the currently active list (sources or 

targets) until you select the element you want to connect.

2 Press the Control key while using the up and down arrows to scroll through the other 
list until you highlight the entry you want to connect.

3 Press Return to make the connection.

If you select a source that already has a connection, pressing Return disconnects it. You 
can also press the Option key while using the Up and Down Arrow keys to jump to the 
top or bottom of the list.

If you want to connect to an element in the Targets list, you need to already have its 
disclosure triangle set to show the element’s contents.

To delete a connection:
1 Press the Up and Down Arrow keys to scroll through the currently active list (sources or 

targets) until you select the element you want to connect.

2 Press the Delete key.
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Connection Details
Many of the sources and targets are intuitive in their usage. However, some are not 
often used or can cause unexpected issues with your title.

Note:  The actual sources and targets you see depend on the elements in your project. 
The names used in the following descriptions are assigned by default when the 
elements are created.

Source Details
The sources displayed depend on which group of sources you choose—basic, standard, 
or advanced. The last two groups contain the sources from the previous level or levels, 
plus additional ones.

The primary method of setting connections for all sources is to use the Connections 
tab. Alternative methods are given in the far-right column below.

Basic
The following sources are available when viewing the basic source group. All these 
sources should be linked before you build the title.

Disc Sources 

Source Usage Alternative methods

First Play Use to specify what is displayed 
when the disc first starts playing 
after being inserted into the 
DVD player (automatically set to 
Menu 1).

First Play in the Disc Inspector 
Control-click disc in Outline tab.
Control-click empty area in 
Graphical tab.

Title Use to specify the action when 
the viewer presses the Title 
button on the DVD player’s 
remote control.

Disc Inspector General tab

Menu Use to specify the action when 
the viewer presses the Menu 
button on the DVD player’s 
remote control. This setting can 
be overridden by similar settings 
in tracks, markers, stories, and 
slideshows.

Disc Inspector General tab
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Menu Sources 

Track Sources 

Story Sources 

Source Usage Alternative methods

Button1:Jump when activated Use to specify the action when 
the button is activated. 

Button Inspector 
Control-click button in the Menu 
Editor.
Drag element directly to button.

Source Usage Alternative methods

End Jump Use to specify the action when 
the track reaches its end during 
playback. 

End Jump in the Track Inspector 
(automatically set in some cases)

Menu Use to specify the action when 
the viewer presses the Menu 
button on the DVD player’s 
remote control. This setting 
overrides the disc setting. By 
default, this is set to Same as Disc.

Track Inspector General tab

Marker 1:Button 1:Jump when 
activated

Use to specify the action when 
the button (part of a subtitle 
stream) is activated. 

Subtitle Inspector Button tab
Control-click button in the 
Subtitle Editor.

Source Usage Alternative methods

End Jump Use to specify the action when 
the story reaches its end during 
playback. By default, this is set 
to Same as Track.

End Jump in the Story Inspector 
(automatically set to Same as 
Track)

Menu Use to specify the action when 
the viewer presses the Menu 
button on the DVD player’s 
remote control. This setting 
overrides the disc and track 
settings. By default, this is set to 
Same as Track.

Story Inspector General tab 
(automatically set to Same as 
Track)
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Slideshow Sources 

Standard
The following sources are available when viewing the standard source group. These 
sources are in addition to those available at the basic level.

Menu Sources 

Track Sources 

Source Usage Alternative methods

End Jump Use to specify the action when 
the slideshow reaches its end 
during playback. 

End Jump in the Slideshow 
Inspector (automatically set in 
some cases)

Menu Use to specify the action when 
the viewer presses the Menu 
button on the DVD player’s 
remote control. This setting 
overrides the disc setting. By 
default, this is set to Same as Disc.

Slideshow Inspector General tab 

Source Usage Alternative methods

Pre-Script Use to assign a script to be run 
prior to displaying this menu. 

Menu Inspector Menu tab

Menu Timeout Target Use to specify the action when 
the menu’s inactivity timeout 
setting expires. 

Menu Inspector General tab

Source Usage Alternative methods

Pre-Script Use to assign a script to be run 
prior to playing this track.

Track Inspector General tab

Marker 1:Menu Use to specify the action when 
the viewer presses the Menu 
button on the DVD player’s 
remote control. This setting 
overrides the disc and track 
settings. 

Marker Inspector General tab

Marker 1:End Jump Use to specify the action when 
the marker’s part of the track 
finishes playing (the frame 
before reaching the next 
marker). 

End Jump in the Marker 
Inspector 
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Story Sources 

Advanced
The following sources are available when viewing the advanced source group. These 
sources are in addition to those available with the basic and standard levels.

Disc Sources 

Source Usage Alternative methods

Pre-Script Target Use to assign a script to be run 
prior to playing this story. 

Story Inspector General tab

Marker 1 Entry:End Jump Use to specify the action when 
this entry marker’s part of the 
track finishes playing (the frame 
before reaching the next 
marker). 

Story Marker Inspector 

Marker 1 Entry:Menu Use to specify the action when 
the viewer presses the Menu 
button on the DVD player’s 
remote control. This setting 
overrides the disc and track 
settings.

Story Marker Inspector 

Source Usage Alternative methods

Angle Use to specify the action when 
the viewer presses the Angle 
menu button on the DVD 
player’s remote control. This 
setting can be overridden by 
similar settings in tracks and 
slideshows.

Disc Inspector Advanced tab

Chapter Use to specify the action when 
the viewer presses the button 
on the DVD player’s remote 
control. This setting can be 
overridden by similar settings in 
tracks and slideshows.

Disc Inspector Advanced tab

Audio Use to specify the action when 
the viewer presses the Audio 
menu button on the DVD 
player’s remote control. This 
setting can be overridden by 
similar settings in tracks and 
slideshows.

Disc Inspector Advanced tab
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Menu Sources 

Track Sources 

Subtitle Use to specify the action when 
the viewer presses the Subtitle 
menu button on the DVD 
player’s remote control. This 
setting can be overridden by 
similar settings in tracks and 
slideshows.

Disc Inspector Advanced tab

Return Use to specify the action when 
the viewer presses the Return 
button on the DVD player’s 
remote control. This setting can 
be overridden by a similar 
setting in menus.

Disc Inspector General tab

Source Usage Alternative methods

Source Usage Alternative methods

Return Use to specify the action when 
the viewer presses the Return 
button on the DVD player’s 
remote control. This setting 
overrides the disc setting. 

Menu Inspector Menu tab

Source Usage Alternative methods

Angle Use to specify the action when 
the viewer presses the Angle 
menu button on the DVD 
player’s remote control. This 
setting overrides the disc 
setting. By default, this is set to 
Same as Disc.

Track Inspector General tab 
(automatically set to Same 
as Disc)

Chapter Use to specify the action when 
the viewer presses the Chapter 
menu button on the DVD 
player’s remote control. This 
setting overrides the disc 
setting. By default, this is set to 
Same as Disc.

Track Inspector General tab 
(automatically set to Same 
as Disc)

Audio Use to specify the action when 
the viewer presses the Audio 
menu button on the DVD 
player’s remote control. This 
setting overrides the disc 
setting. By default, this is set to 
Same as Disc.

Track Inspector General tab 
(automatically set to Same 
as Disc)
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Subtitle Use to specify the action when 
the viewer presses the Subtitle 
menu button on the DVD 
player’s remote control. This 
setting overrides the disc 
setting. By default, this is set to 
Same as Disc.

Track Inspector General tab 
(automatically set to Same 
as Disc)

Chapter Use to specify the action when 
the viewer presses the Chapter 
menu button on the DVD 
player’s remote control. This 
setting overrides the disc 
setting. By default, this is set to 
Same as Disc.

Track Inspector General tab 
(automatically set to Same 
as Disc)

Next Jump Use to specify the action when 
the viewer presses the Next 
button on the DVD player’s 
remote control after the last 
marker. See “Next Jump and 
Prev Jump” on page 529 for 
more information.

None

Prev Jump Use to specify the action when 
the viewer presses the Previous 
button on the DVD player’s 
remote control before the first 
marker. See “Next Jump and 
Prev Jump” on page 529 for 
more information.

None

Source Usage Alternative methods



540 Chapter 15    Establishing Connections

 

Slideshow Sources 

Source Usage Alternative methods

Angle Use to specify the action when 
the viewer presses the Angle 
menu button on the DVD 
player’s remote control. This 
setting overrides the disc 
setting. By default, this is set to 
Same as Disc.

Slideshow Inspector 
(automatically set to Same 
as Disc)

Audio Use to specify the action when 
the viewer presses the Audio 
menu button on the DVD 
player’s remote control. This 
setting overrides the disc 
setting. By default, this is set to 
Same as Disc.

Slideshow Inspector 
(automatically set to Same 
as Disc)

Subtitle Use to specify the action when 
the viewer presses the Subtitle 
menu button on the DVD 
player’s remote control. This 
setting overrides the disc 
setting. By default, this is set to 
Same as Disc.

Slideshow Inspector 
(automatically set to Same 
as Disc)

Chapter Use to specify the action when 
the viewer presses the Chapter 
menu button on the DVD 
player’s remote control. This 
setting overrides the disc 
setting. By default, this is set to 
Same as Disc.

Slideshow Inspector 
(automatically set to Same 
as Disc)

Next Jump Use to specify the action when 
the viewer presses the Next 
button on the DVD player’s 
remote control during the last 
slide. See “Next Jump and Prev 
Jump” on page 529 for more 
information.

None

Prev Jump Use to specify the action when 
the viewer presses the Previous 
button on the DVD player’s 
remote control during the first 
slide. See “Next Jump and Prev 
Jump” on page 529 for more 
information.

None
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Target Details
The list of targets is the same for all sources. Some targets only work with specific source 
types; DVD Studio Pro only allows you to assign appropriate targets to the sources.
• Menus:  Use to select the menu to link to a source. Select the menu to have the menu 

appear with the default buttons highlighted and to have the pre-script (if assigned) execute, 
or select a specific button to have the menu appear with that button highlighted.

• Tracks and Stories:  Use to select the track or story to link to a source. Select the track 
or story to have it play from the beginning and to have the pre-script (if assigned) 
execute, or select a specific marker or story entry to link to a specific place in the 
track or story.

• Slideshows:  Use to select a slideshow to link to a source. Select the slideshow to have 
it play from the beginning and to have the pre-script (if assigned) execute, or select a 
slide to link to.

• Scripts:  Use to select a script to link to a source.

Note:  The following only appear when a suitable source is selected.

• Resume:  Can only be assigned to menu buttons. Use it to take viewers from a menu 
back to a specific point in a track. For example, you can set up a track’s marker to 
jump to a menu that provides information or a graphic that pertains to the track just 
jumped from. The menu can have a single button set to Resume that, when 
activated, takes viewers back to the track at the point they left off.

• Stop:  Can only be assigned to the End Jump settings of markers and slides. Use it to 
force the DVD player to stop playing once the marker or slide is reached.

• Same as Disc:  Can only be assigned to sources that define actions for remote control 
buttons (such as Menu or Audio). Use it to set a remote control button to act the 
same as the disc’s setting.

• Same as Track:  Can only be assigned to story sources that define actions for remote control 
buttons. Use it to set a remote control button to act the same as the track’s setting.
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16 Finishing a Project

Once you have created your project’s tracks, stories, 
slideshows, and menus, and set the connections 
between them, you are ready to take the final steps 
to create the DVD. 

These steps include:

• Testing your project with the Simulator. Using the Simulator allows you to verify most 
of your connections and button navigation before building the title.

• Setting prebuild disc properties. This is the time to set any last-minute disc properties, 
especially those that must be set before you build the title.

• Building your project. This process creates a VIDEO_TS (video zone for SD projects) or 
HVDVD_TS (for HD projects) folder and compiles your project’s elements into a DVD-
compliant file structure.

• Emulating your project. You can use the Apple DVD Player to play the VIDEO_TS or 
HVDVD_TS folder’s contents.

• Setting preformat properties. You can set various details, such as copy protection, 
region coding, and various disc media attributes.

• Formatting your project. In this step, the VIDEO_TS and/or HVDVD_TS folder and any 
other added DVD-ROM content are formatted and written to the selected output type.

Simulate Emulate

DVD disc

DLT

Hard disk

VIDEO_TS 
or

HVDVD_TS
folder

Author
• Add assets
• Create elements
• Create connections

Format
• Set replication
   properties
• Create output

Build
• Set disc properties
• Compile project to 
   a VIDEO_TS folder or 
   HVDVD_TS folder
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Should You Burn, Build, Format, or Build and Format? 
When your project is finished, you have the option of directly burning a DVD or 
stepping through the process of building and formatting the project. The option you 
use depends on your situation.

Burning a Project
Burning is a simple one-click step that creates a DVD from your project. You simply click 
Burn in the toolbar or press Option-Command-B to start the process. Your system’s DVD 
burning drive is checked to see if suitable recordable media is present—if not, a dialog 
appears, prompting you to insert a blank disc. And that’s it. The process starts and there 
are no more decisions to make. This is a good choice if you do not require special 
settings, such as selecting the drive to write to.

Burning a project creates a VIDEO_TS or HVDVD_TS folder just as with the build 
process. It is written to the location specified in the Destinations pane in 
DVD Studio Pro Preferences. This makes it possible to burn additional discs (using 
Format) without needing to recreate the VIDEO_TS or HVDVD_TS folder.

If your system has multiple drives that can burn DVDs, the burn process uses the first 
general type drive it finds. If none are found, it then looks for an authoring drive. You 
cannot use the burn process to write to a DLT or disk image.

If you want to make several DVDs of your project, you can use Burn to create the first 
disc, and then save time by using Format to create the additional DVDs. This avoids 
having DVD Studio Pro recreate the VIDEO_TS or HVDVD_TS folder for each disc.

Building a Project
The build process only creates the VIDEO_TS or HVDVD_TS folder; it does not burn a 
disc. You click Build in the toolbar or press Option-Command-C to start the process. 

With the build process, you are able to choose the location where the VIDEO_TS or 
HVDVD_TS folder is created. Using Build by itself is useful when you want to create the 
VIDEO_TS or HVDVD_TS folder so that you can emulate the project using DVD Player, 
or if you want to manually copy the VIDEO_TS or HVDVD_TS folder to a disc.

See “Building Your Project” on page 560 for more information.

Formatting a Project
The format process requires you to have a VIDEO_TS and/or HVDVD_TS folder already 
created. You click Format in the toolbar or press Command-F to start the process. Using 
Format is especially useful when you want to make multiple discs from the same 
VIDEO_TS or HVDVD_TS folder.
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You would usually use the format process after you had emulated the VIDEO_TS or 
HVDVD_TS folder and were ready to burn a disc or DLT. You can also combine the 
format process and the build process (described next); however, an advantage to using 
the format process separate from the build process is that you can choose the 
VIDEO_TS or HVDVD_TS folder to format. This can be useful if you are working on a 
new project and get a request for a DVD of an earlier project whose VIDEO_TS or 
HVDVD_TS folder is still available.

See “Setting Disc Format Properties” on page 572 for more information.

Building and Formatting a Project
When combined, the build and format processes act similarly to the burn process. 
The difference is that you are presented with the same configuration options you get 
when you use the build and format processes separately, which allows you to 
customize the process. You click Build/Format in the toolbar or press Option-
Command-F to start the process.

After you configure the build and format options, you are then not required to do 
anything more until the DVD or DLT has been created. An exception is dual-layer discs, 
since the break point cannot be verified until the VIDEO_TS or HVDVD_TS folder has 
been created.

See “About the Build/Format Command” on page 564 for more information.

Testing Your Project With the Simulator
There are three methods you can use to test your project:  using the DVD Studio Pro 
preview and simulation features, and playing the title on a DVD player (emulating 
your project).
• Previewing your project’s elements:  The DVD Studio Pro preview feature provides a 

way to view single elements, such as a track. Preview does not allow you to check 
how one element works with others in the project. For example, you cannot use it to 
verify a connection from a menu to a track. See “Viewing a Track” on page 400 and 
“Previewing a Slideshow” on page 429 for more information.

• Simulating your project:  The DVD Studio Pro simulation feature is a relatively 
comprehensive way to test most aspects of a project, with the primary focus on 
verifying connections. The Simulator works a lot like a DVD player that plays the 
project before it’s built into a video title set. It allows you to test most connections, 
including First Play, and provides the functions of a DVD player remote control. It also 
provides a complete display of the contents of the System Parameter Register 
Memories (SPRMs) and General Purpose Register Memories (GPRMs), making it 
possible to verify many scripts.
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You can also configure your system to simulate the project using an external video 
and audio monitor. This makes it possible to see the project as most viewers will, 
with actual pixel aspect ratios, colors, and if applicable, interlacing.

• Emulating your project:  Emulating your project by playing it on a real DVD player is 
the most sure test of it. To emulate your project with the Apple DVD Player, you must 
build the VIDEO_TS or HVDVD_TS folder. To emulate your project using a standalone 
DVD player, you must also format it and burn a disc that you can then play on any 
DVD player. It’s important to test your project under varying conditions, especially if 
your project relies heavily on scripts. See “Emulating Your Project” on page 570 for 
more information.

Simulating Your Project
The DVD Studio Pro Simulator is a useful tool for verifying your project while you are 
still creating it. There are a few things to be aware of before simulating your project:
• The Simulator behaves much as a standalone DVD player. This means you should 

have the links set to allow you to navigate around the project. In particular, be sure 
to set your First Play action to a suitable menu or track. If you do not yet have the 
assets that will be the actual First Play element, you can temporarily link to an interim 
menu instead. This ensures that an element is displayed if you start the Simulator by 
clicking Simulate in the toolbar.

There are also a variety of ways you can force the Simulator to start at a specific 
element. For example, you can Control-click the element in the Outline or Graphical 
tab, then choose Simulate from the shortcut menu. This allows you to test parts of 
the project without having all of the elements in place.

• DVD Studio Pro Preferences contains a number of settings in the Simulator pane that 
allow you to configure the Simulator much like you would a DVD player. For example, 
you can set the Simulator’s region code, aspect ratios, language preferences, and 
playback output options to test for different situations. See “Simulator Preferences” 
on page 122 for more information.

• Since the project has not been built yet, the Simulator must use assets as and where 
they are. This may lead to issues with playback, such as stuttering or pauses. The 
severity of these issues depends on the assets and the computer you are authoring on. 

• The Log tab contains a simulation log that provides information on a simulation 
while it is in progress. This information can be useful when you are trying to work out 
issues with your project.

• The Simulator processes Pause After VOBU settings on markers set at slides in a track. 
The Simulator does not process Pause After VOBU settings on markers set on full-
motion video clips (which it is not recommended to do in any case). The track plays 
as if the settings were not active. See “General Tab in the Marker Inspector” on 
page 388 for more information on VOBUs.
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Simulating With an External Video and Audio Monitor
When you author a DVD, it can be important to see the video and hear the audio with 
devices that closely match those that the viewer is expected to use. Being able to do 
this while simulating your project allows you to verify the video and audio prior to 
burning a test DVD. In particular:
• You see the true color based on the DVD specification’s YUV values instead of a 

computer monitor’s RGB values.
• You see the actual pixel aspect ratios. To display 4:3 or 16:9 video on a computer 

monitor requires the pixels to be scaled, which can create or hide issues in the video.

See “External Video and Audio Monitoring” on page 31 for information on connecting 
external monitors. See “Simulator Preferences” on page 122 for information on 
Simulator settings.

When using an external video monitor, keep the following in mind:

• The external video monitor is only used during simulation.
• When using an external video monitor, the Simulator window on your computer is 

inactive.
• You cannot use the pointer to click buttons on the external monitor. You must 

control the simulation by using the Simulator window’s controls. 
• Depending on your system and the video being simulated, frames may be skipped 

during playback to maintain synchronized playback with the audio.

Starting and Stopping the Simulator
You can start the Simulator at any time while creating your project. You should have 
sufficient connections set so that navigation is possible between the elements you 
want to test. The most important item to have set is the First Play action. If you select 
the disc in the Outline tab or click an empty area in the Graphical tab, you can set the 
First Play action in the Connections tab or in the Disc Inspector. You can also set the 
First Play action directly in the Outline and Graphical tabs. See “Assigning the First Play 
Element” on page 178 for more information.

To start and stop the Simulator from the First Play element, do one of the following:
m Click Simulate in the toolbar. 
m Control-click the Graphical tab’s background, then choose Simulate Disc from the 

shortcut menu.
m Click the disc item in the Outline tab, then do one of the following:

• Choose File > Simulate Disc.
• Press Option-Command-0 (zero).

The Simulator opens and displays the First Play element. An alert appears if none has 
been assigned, and the Simulator starts at the first video stream of the first track.
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Stop the simulation by clicking the close button in the upper-left corner of the window 
or pressing Command-W.

You can also start the Simulator from a specific element or part of an element, 
including tracks, stories and story entries, slideshows and specific slides, or menus and 
specific buttons. This is useful when you only want to verify a specific element without 
going through the normal project navigation to get to it.

To start the Simulator from a specific element, do one of the following:
m Choose File > Simulate. (If no element is selected, the Simulator starts from the First 

Play element.)
m Control-click the element in the Outline or Graphical tab, then choose Simulate from 

the shortcut menu.
m Control-click in the element’s editor, then choose Simulate from the shortcut menu.
m Press Option-Command-0 (zero). (If no element is selected, the Simulator starts from 

the First Play element.)

The Simulator opens and displays the element.

Note:  If the element you start the Simulator at has a pre-script assigned to it, the pre-
script is not executed.

Simulator Window
The Simulator window appears in front of all other DVD Studio Pro windows.

The area to the left of the video display contains the playback controls you can use to 
navigate within your project. Most are similar to controls you would find on a DVD 
player’s remote control. You can click the Info button to open a drawer that shows 
information about the currently displayed element and the settings within the SPRMs 
and GPRMs.

Click the Info button
to open the

information drawer.

The timecode of the
current element

Choose the type of
display to simulate.
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You are also able to choose the resolution (SD, HD 720, or HD1080) and the display 
mode (4:3 Pan-Scan, 4:3 Letterbox, or 16:9) to simulate when not using an external 
video monitor. 

Note:  You can set the default state of these in the Simulator pane of 
DVD Studio Pro Preferences.

Playback Controls
The playback controls are similar to those found on DVD player remote controls. 

• Menu:  Jumps to the element assigned to the Menu button. The assignment can be 
different for each track, story, marker, and slideshow.

• Title:  Jumps to the element assigned to the Title button.
• Play/Pause:  Alternately pauses, then plays the track or motion menu.
• Stop:  Stops playback of the project. The jacket picture appears if you have assigned 

one to your project. See “About Jacket Pictures” on page 562 for more information. 
Click First Play to restart playback.

• Track Skip Reverse and Track Skip Forward:  To the left and right of the Play/Pause 
button and Stop button, these buttons skip to the beginning or end of a track, 
allowing you to test pre-scripts, display conditions, and End Jump settings.

• Navigation controls:  Allow you to navigate through the menus as you would with the 
arrow buttons on a remote control. (You can also use the pointer and click the menu 
buttons directly.) Press the center button to activate the currently selected button.

• Chapter Skip Reverse and Chapter Skip Forward:  Skip to the previous or next chapter 
marker or still while playing a track or slideshow.

Play/Pause

Chapter Skip 
Forward

Menu

Navigation 
controls

Track Skip 
Forward

Track Skip
Reverse

Chapter Skip
Reverse

Stop

Title
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Menu Controls
The menu controls let you test the project’s remote assignments.

• Chapter Menu, Angle Menu, Audio Menu, and Subtitle Menu:  Jump to the element 
assigned to the Chapter, Angle, Audio, and Subtitle menu buttons (not to be 
confused with the Angle, Audio, and Subtitle stream select buttons). The assignment 
can be different for each track and slideshow.

• First Play:  Restarts playback of the project by executing the First Play action.
• Return:  Jumps to the element assigned to the Return button. The assignment can be 

different for each menu.

Stream Selections
The stream selection pop-up menus operate like the Angle, Audio, and Subtitle buttons 
found on most remote controls. 

• Angle Select, Audio Select, and Subtitle Select:  When playing a track with multiple 
streams, you can select the streams to play. Each pop-up menu shows the stream 
number currently playing. To change streams, open the pop-up menus and choose a 
new stream.

• View checkbox:  Controls whether the selected subtitle stream displays. Select the 
checkbox to show subtitles and deselect it to hide them.

Angle MenuSubtitle Menu

Chapter Menu Return

Audio Menu

First Play

Click the Info button to open 
the information drawer.

Subtitle Select 

Subtitle Enable 

Angle Select

Audio Select
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Information Drawer
You can click the Info button or press Shift-I to open the information drawer. The 
drawer can open on any side of the Simulator, depending on the Simulator’s position. 
(You can press Option-Shift-I to have it open on a different edge.) The information 
drawer changes to match the current element type (menu, track, story, and so on). The 
Item Properties section shows information specific to that element; you cannot enter 
information into it. The Registers section shows the status of either the SPRMs or 
GPRMs. You can choose which to see by selecting the relevant checkbox. You can also 
choose to see the values in hexadecimal. You can double-click a value to enter a new 
value into it if you want to verify how your project operates under specific DVD player 
conditions. You can also enter a new name for any of the GPRMs.

Simulation Log
The Log tab contains a Simulate view that provides details of a simulation while it is 
running. These details include any changes in the SPRMs and GPRMs, any navigation 
actions, and any jumps that are made.

To show the simulation log:
1 Click the Log tab.

2 Choose Simulate from the View pop-up menu.

3 Simulate the project.

Note:  The Log tab automatically appears once you start the Simulator.
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Setting Disc Properties
The Disc Inspector contains settings that affect your DVD title. Some settings, such as 
the disc’s name, its First Play action, and the video standard, can be set early in the 
project creation process. You do not have to make other settings until you are ready to 
burn a DVD, write to a Digital Linear Tape (DLT) drive, or write to a hard disk. 

The top of the Disc Inspector and its General and Advanced tabs contain settings that 
affect the title’s playback. All of these settings (except the disc name and DVD-ROM 
settings) must be set before you build your project. You must also set the Macrovision 
setting in the Region/Copyright tab. 

The remaining settings affect the format process. You can set them at any time, even 
after you start the format process.

To open the Disc Inspector:
m Select the disc’s name in the Outline tab or click an empty area in the Graphical tab.

Settings at the Top of the Disc Inspector

There are three settings at the top of the Disc Inspector.

• Name:  This is the name that appears when the DVD is played on a computer. It’s also 
the name that appears in the Outline tab. The default name is Untitled Disc. You can 
enter a name with a maximum of 32 characters. While you can enter any characters 
you wish, the only permissible characters for the formatted disk image are the 26 
uppercase English characters, numerals 0 through 9, and the underscore (“_”). 
DVD Studio Pro automatically converts lowercase letters to uppercase and removes 
unsupported characters when you use the format feature. 

The disc name does not need to be set before building the project. You can set it 
during the formatting process.

• Est. Size:  This displays the amount of disc space that DVD Studio Pro estimates will be 
required for the build, including any DVD-ROM files you may be adding. This size uses 
the same convention as used by DVD media—one MB is equal to 1,000,000 bytes. 
See “Making Sure Your Content Will Fit” on page 40 for information on how much 
data a 4.7 GB disc can actually hold.
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• First Play:  This specifies what appears when the disc is first inserted into a DVD 
player. First Play can also be set in the Connections, Outline, and Graphical tabs. It is 
important to set First Play prior to building the project to ensure that all DVD players 
will play the disc correctly. You can choose from all menus, tracks, stories, slideshows, 
and scripts within your project.

See “Setting the Project’s First Play” on page 131 for information on setting the First 
Play for different types of projects. See “Assigning the First Play Element” on page 178 
for information on setting the First Play using the Outline or Graphical tab.

General Tab in the Disc Inspector
All of the settings in the General tab except the DVD-ROM settings must be set before 
building a project. 

• DVD Standard:  Shows the DVD standard for this project. When set to SD DVD, you 
can convert the project to HD-based DVD by clicking the HD DVD button. When set 
to HD DVD, however, you cannot change the project back to SD DVD. See “Setting 
the DVD Standard” on page 127 for more information.

• Video Standard:  Select the type of video used in this project, NTSC or PAL. This must 
be set before you import any video assets. See “Setting the Video Standard” on 
page 126 for more information.
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Streams
• Audio:  You can choose an audio stream that will serve as the initial active stream, 

overriding the DVD player’s setting. The default setting is “not set,” which lets the 
DVD player control the stream setting.

Note:  The word Empty in parentheses after a stream number indicates that that 
stream is currently empty.

• Angle:  You can choose a video stream that will serve as the initial active stream, 
overriding the DVD player’s setting. The default setting is “not set,” which lets the 
DVD player control the stream setting.

• Subtitle:  You can choose a subtitle stream that will serve as the initial active stream, 
overriding the DVD player’s setting. You can also force the subtitle stream to appear 
by selecting its View checkbox. The default setting is “not set,” which lets the DVD 
player control the stream setting.

Remote Control
• You can set the Title, Menu, and Return remote control settings, which correspond to 

a DVD player’s remote control buttons. See “Remote Control Settings” on page 608 
for details on setting these buttons.

DVD-ROM
See “About DVD-ROM Discs” on page 572 for details on using these settings and 
creating DVD-ROM discs.
• Content:  Specifies whether this is a DVD-Video or DVD-ROM title. Selecting Content 

enables the DVD-ROM content settings (Location and Joliet Extension Support). 
• Location:  This setting is active only when you select Content. The Location setting 

lets you choose the folder to include as the DVD-ROM contents for the disc. All files 
and folders at this location are added to the root of the DVD. 

For example, if you want several PDF files to be in a folder named PDFExtras at the 
root of the DVD, you would have to create the PDFExtras folder, place the PDF files in 
it, then place that folder in the folder you specify as the Location (DVDROMContent 
in the example below).
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• Size:  Shows the size of the files the folder chosen as the Location contains. This size 
uses the same convention as used by DVD media—one MB is equal to 1,000,000 
bytes. The size is also shown in actual bytes. 

• Joliet Extension Support:  This setting is active only when you select Content. Selecting 
Joliet Extension Support affects the filenames allowed in the DVD-ROM content 
when using red laser media. See “Joliet Volume” on page 574 for more information. 

Disc/Volume Tab in the Disc Inspector
These settings do not need to be set until you format your project. However, choosing 
the disc media, size, and layer options will ensure the toolbar’s disc meter is correct.

Disc Information
• Disc Media:  Available for HD projects only. Choose the type of media your project will 

be distributed on. Red Laser refers to the media used with SD projects, although HD 
projects can also use it. Blue Laser refers to media used with HD projects. 

Note:  SD projects can only use red laser media.

Important:  This setting affects the scale of the toolbar’s disc meter and the type of 
disc (red laser or blue laser) the replicator will create if you are using DDP or CMF 
when formatting your project. It does not affect what happens when burning a 
general media disc on your system. 
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• Layer Options:  Choose either single- or dual-layer for the media. 
• Track Direction:  Use this control to select either PTP (Parallel Track Path, in which the 

second disc layer plays from the inner track to the outer track as the first layer does) 
or OTP (Opposite Track Path, in which the second layer plays from the outer track to 
the inner track, the opposite of the first layer). The advantage of the OTP method is 
that it minimizes the amount of time the DVD player spends seeking the next track 
when switching layers. See “About Dual-Layer Discs” on page 576 for more 
information and tips on creating dual-layer discs. 

• Break Point:  Use this pop-up menu to choose the dual-layer break point. The Break 
Point setting controls where the division is between the first and second layer of the 
disc. You can select any marker on any track, although depending on how full the 
disc is, there may only be a limited number of usable options. When left as Auto, 
DVD Studio Pro automatically chooses the break point. See “About Dual-Layer Discs” 
on page 576 for more information on creating dual-layer discs.

• Seamless:  Select Seamless to configure the dual-layer break point as seamless. 

Important:  An alert appears when you select Seamless. Do not select Seamless 
unless your project specifically requires it. See “Choosing Seamless or Non-Seamless 
Layer Changes” on page 577 for more information.

• Number of sides:  Choose whether this is a one- or two-sided disc. 

Note:  A two-sided disc requires two separate projects—one for each side.

• Disc Side:  Choose Side A or Side B for this project. This is for the replication facility.
• Disc Size:  Choose either the standard 12 cm or the smaller 8 cm disc size. 
• Maximum Size:  Based on the above settings, shows the maximum amount of disc 

space available.
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Region/Copyright Tab in the Disc Inspector
The only setting in the Region/Copyright tab that you must set before building a 
project is the Macrovision setting.

• Playable Region Codes:  Select the checkbox next to the regions in which you want to 
be able to play the disc (all are enabled by default). All DVD players (standalone and 
computer) must be assigned a region code. This code divides the world into six 
regions, with an additional region for discs played on airplanes. These region codes 
allow you to have some control over where a disc can be played.

Note:  So that you can easily emulate on any DVD player the VIDEO_TS or HVDVD_TS 
folder created by the build process, the folder defaults to having all regions enabled 
(except “7-Reserved”). Region code settings are applied during the formatting process.

Important:  If you change the region code settings and burn a DVD using general 
media, some DVD players that should be prevented from playing it will play the disc. 
This issue does not occur with replicated discs originating from either general or 
authoring media.

• Copyright Management:  Select the checkbox to enable either digital-based or 
analog-based (Macrovision) copyright protection of the disc. Selecting this checkbox 
enables the Copy Generation setting.

Note:  This setting affects the number of bytes in each sector of the disc. With 
copyright management disabled, each sector has 2048 bytes. With copyright 
management enabled, each sector has 2054 bytes.

Warning:  You must have at least one playable region selected.
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• Copyright Generation:  This pop-up menu specifies whether copies are allowed.
• Copying Permitted:  The disc is not protected against copying. The Format for CSS 

checkbox and Macrovision pop-up menu are disabled. The only difference 
between this setting and leaving the Copyright Management checkbox unselected 
is the number of bytes in the sectors.

• One Copy Permitted:  Allows users to make a copy of the disc, but no additional 
copies from that copied disc (the Copy Generation status of the copied disc 
switches to No Copy Permitted). You can make as many copies as you want from 
the original disc; you just can’t make more copies from the copies of the original. 
The Format for CSS checkbox and Macrovision pop-up menu are disabled.

• No Copy Permitted:  Enables the Format for CSS checkbox and Macrovision pop-up 
menu so that you can choose the type of copy protection to use.

• Format for CSS:  Available in SD DVD projects only. Only available when Copy 
Generation is set to No Copy Permitted. The Content Scrambling System (CSS) 
provides digital-based copyright protection. Selecting Format for CSS alerts the 
replication facility to apply CSS encryption to the disc (if it is licensed and authorized 
to do so).

• Macrovision:  Available in SD DVD projects only. This must be set before you create the 
VIDEO_TS folder in the build process. Macrovision provides analog-based copyright 
protection. See “About the Macrovision Settings” on page 560 for more information.

Advanced Tab in the Disc Inspector
All of the settings in the Disc Inspector’s Advanced tab must be set before you build a 
project. These settings apply to specialized features used on advanced projects. 
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• Embed Text Data:  This checkbox is automatically selected if you use the DVD@CCESS 
feature within your project. You can also select it if you want to add the names you 
assigned to the tracks, slideshows, and menus to the DVD disc. This text can be 
displayed on DVD players designed to support the Text Display extensions of the 
DVD-Video specification (version 1.1). 

• Language:  If the Embed Text Data checkbox is selected, you can identify the 
language in which the text names will appear. Choose Not Specified to have the text 
appear regardless of the DVD player’s language setting.

• Additional Remote Controls:  You can set the Angle, Chapter, Audio, and Subtitle menu 
remote control settings, which correspond to a DVD player’s remote control buttons. 
These links can make it convenient for viewers to access DVD menus that allow them 
to select audio and subtitle options, an angle, or a chapter. However, be sure to 
design your title with other ways to reach these DVD menus, since very few remote 
controls offer these buttons.

Important:  Do not confuse these buttons with the Audio, Subtitle, and Angle 
selection buttons commonly found on remote controls—these buttons do not 
access a menu, and instead directly change the settings.

See “Remote Control Settings” on page 608 for details on setting these buttons.

• GPRM Variable Names:  You can configure the partitions and enter names for the 
eight GPRMs used when creating scripts. Once you create a script, you can also enter 
these names in the Script Inspector or the Simulator. See “General Purpose Register 
Memories” on page 504 for information on using GPRMs in your scripts.

• Jacket Picture:  You can choose a graphic to use as the jacket picture for this DVD. See 
“About Jacket Pictures” on page 562 for more information.



560 Chapter 16    Finishing a Project

 

Building Your Project
Building a project compiles all of the elements into files that conform to the DVD-Video 
specification (SD projects). Before you build your project, you must make sure you have 
set your prebuild disc properties.

Prebuild Disc Properties
The prebuild disc properties include the following items from the Disc Inspector. See 
“Setting Disc Properties” on page 552 for details on these properties. You must set 
these properties before you can build your project.
• First Play:  Located at the top of the Disc Inspector.
• Video Standard:  Located in the General tab.
• Streams:  Located in the General tab.
• Remote Control:  Located in the General tab.
• Macrovision:  (SD projects only) Located in the Region/Copyright tab.
• Embed Text Data:  Located in the Advanced tab.
• Additional Remote Controls:  Located in the Advanced tab.
• GPRM Variable Names:  Located in the Advanced tab.
• Jacket Picture Asset:  Located in the Advanced tab.

About the Macrovision Settings
If your SD project is to be coded for Macrovision Analog Protection System (APS) copy 
protection, you must choose the Macrovision type before you build the project.

Important:  The Macrovision APS is not available for HD projects.

The Macrovision APS is an analog copy protection system that alters the video signal in 
such a way as to discourage viewers from making copies of your DVD-Video disc onto a 
videocassette recorder. 

Macrovision Licensing
Use of analog copy protection for DVD applications is subject to the proprietary 
intellectual property rights of Macrovision Corporation, of Sunnyvale, California, USA, 
and users must complete a usage agreement with Macrovision Corporation before 
the analog protection system activation bits are set to “on.” For further information, 
see the Macrovision website:  http://www.macrovision.com.

http://www.macrovision.com
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To enable Macrovision APS:
1 Open the Disc Inspector by selecting the disc in the Outline tab or clicking an empty 

area in the Graphical tab.

2 Click the Region/Copyright tab.

3 Select the Copyright Management checkbox. 

4 Choose No Copy Permitted from the Copy Generation pop-up menu.

5 Choose the type of Macrovision protection to use (Type 1, Type 2, or Type 3) from the 
Macrovision pop-up menu.

Note:  The Format for CSS checkbox has no bearing on the Macrovision setting.

The Macrovision coding is applied to the entire disc. Once you have chosen No Copy 
Permitted from the Copy Generation pop-up menu, you can also apply or change 
Macrovision coding on specific tracks and markers using the Other tab in each track’s 
Inspector and the General tab in each marker’s Inspector.

Note:  If you configure Macrovision on a track or marker before you configure it for the 
disc in the Disc Inspector, the settings in the Disc Inspector automatically update to 
match the track or marker settings.

Macrovision Types
There are three Macrovision types supported by the DVD-Video specification:
• Type 1:  Uses the Automatic Gain Control (AGC) process. The AGC process places 

pulses in the vertical interval of the video stream that televisions do not detect. 
When a copy is attempted, these pulses confuse a VCR’s AGC circuitry, causing copies 
to exhibit characteristics such as dim and noisy pictures, loss of color, loss of video, 
and picture tearing. 

• Type 2:  Uses both the AGC process and a two-line colorstripe. The colorstripe process, 
which is only effective with NTSC video streams, consists of changes to colorburst 
information that are transparent on original viewing, but that produce horizontal 
lines across the picture when playing an unauthorized copy. The 2-line version of 
colorstripe has bands of altered chrominance 2 horizontal lines long.

• Type 3:  Uses both the AGC process and a four-line colorstripe. The 4-line version of 
the colorstripe process has bands of altered chrominance 4 horizontal lines long. This 
is also only effective with NTSC video streams.
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About Jacket Pictures
Jacket pictures are an optional part of the DVD-Video specification, and are intended to 
allow a DVD player to display a graphic representing a DVD. Jacket pictures are most 
commonly displayed on multi-disc players. 

Based on the DVD specification, Jacket Picture graphics should be supplied in three 
different resolutions (small, medium, and large) for display on different platforms and 
display devices. DVD Studio Pro automatically generates the required graphics and the 
folder that holds them, JACKET_P, when you build your project. 

To add a jacket picture to your project:
1 Import the graphic to use for the jacket picture into the Assets tab.

2 Choose the jacket picture graphic from the Asset pop-up menu in the Disc Inspector’s 
Advanced tab.

The jacket picture will appear in the Simulator when you stop playback. 

Building the Project
Once you have set the prebuild disc properties, you can build your project. Depending 
on the size of your project and the speed of your computer and disk drives, this process 
can take several hours to finish.

To build your project:
1 Do one of the following:

• Click Build in the toolbar. 

Note:  To format the project immediately after building it, click Build/Format. See 
“About the Build/Format Command” on page 564 for more information.

• Press Option-Command-C.

2 Select the drive and folder to build to in the dialog that appears, then click Open.

The build process begins and a progress bar appears that shows the element names 
currently being compiled. If the selected folder already has a folder of the same type it 
is generating (VIDEO_TS or HVDVD_TS), see “Incremental Builds” on page 563 for 
details on the dialog that appears.
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Note:  You cannot build an SD project in a folder that already contains an HVDVD_TS 
folder, and you cannot build an HD project in a folder that already contains a 
VIDEO_TS folder.

The Log tab also appears, automatically switching to display the build results. The tab 
shows details on the build’s progress, as well as messages about any errors that occur.

Incremental Builds
While creating your project, you may find it useful to perform builds several times 
before you are actually finished with it. These incremental builds can be useful to verify 
that certain aspects of the project are functioning properly, such as a set of scripts or a 
menu’s button navigation.

To help with this process, DVD Studio Pro includes the ability to reuse unchanged 
elements from a previous build. This can greatly speed up the build process when you 
perform incremental builds.

Once you select a folder to build into, DVD Studio Pro checks to see whether a folder of 
the same type it needs to create (VIDEO_TS or HVDVD_TS) is already present. If the 
folder already contains a folder of the same type, with a .layout file that has the same 
name as the project, a dialog appears for you to specify what should happen.

• Cancel:  Closes this dialog and the build process without saving anything. 
• Delete:  Deletes the current contents of the VIDEO_TS or HVDVD_TS folder and begins 

saving the new build information.
• Reuse:  Attempts to reuse as much of the current VIDEO_TS or HVDVD_TS folder 

contents as possible. 
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If you decide to reuse the VIDEO_TS or HVDVD_TS folder, DVD Studio Pro looks at its 
contents and, for each VTS block, checks to see if anything has changed from the last 
build. If the VTS block has not changed, the message “VOB up to date. Muxing skipped” 
appears in the Log tab and the build moves on to the next VTS block. See “Non-Standard 
SD DVD Video Zone Files” on page 567 for more information about .layout files.

General Build Information
Depending on your system and the size of your project, the build process might take 
several hours. Following is some information on speeding up the process.

Using Multiple Hard Disks 
One way to speed up the build process is to have the project’s assets on a disk 
completely different from the one you are building to (not just a second partition of the 
same disk). Using different disks for your assets and your build allows each disk to focus 
on either reading or writing data, rather than jumping from one function to the other.

About the Build/Format Command
Since the build and format processes take a lot of time, it is common to want to start 
them and let the processes run unattended. How well this will work depends on the 
type of project you are creating.

Starting the Build/Format Process
When you choose the Build/Format command, a dialog appears in which you can set 
your build location and the format properties.
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Once you have set the source and destination settings, including the preformat 
settings in the Disc/Volume and Region/Copyright tabs, click the Build & Format button 
to start the process. If you have chosen a DVD or DLT drive as the output device, you 
are prompted to insert a blank disc or tape. See “Configuring the Output Type” on 
page 583 for information on setting the destination, and “Preformat Disc Properties” on 
page 572 for more information on these settings.

Using Build/Format With Dual-Layer Projects
Dual-layer projects are more difficult to run unattended. 
• During the format part of the process, you will have to load a second blank disc or 

tape once the first layer is written.
• There may be problems with the break point. If you chose the Automatic mode for 

setting the break point, it is possible that a suitable marker may not exist. 
Additionally, if you chose a specific marker to use as the break point, it may not be 
suitable. DVD Studio Pro is unable to confirm either of these issues until the build 
part of the process finishes. If there is a problem, an error dialog appears and the 
format process is not started. Once you correct the problem by adding or selecting a 
different marker, you will have to start the build/format process over again.

See “About Dual-Layer Discs” on page 576 for more information on setting a break point.

The Build Files for SD Projects
Once the build for your SD project starts, DVD Studio Pro creates two folders at the 
location you specified:  an AUDIO_TS folder and a VIDEO_TS folder. Additionally, a third 
folder, JACKET_P, is created if you have assigned a jacket picture graphic.

The AUDIO_TS folder is used by systems authoring DVD-Audio titles. To meet the DVD 
specification requirements, DVD Studio Pro creates the folder and leaves it empty. The 
empty folder is included in the format process.

The JACKET_P folder contains three resolutions of the graphic assigned as the jacket 
picture. See “About Jacket Pictures” on page 562 for more information.
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The VIDEO_TS folder contains all of the DVD-Video files for your project, and is placed 
in the video zone. The naming and structure contents of the VIDEO_TS folder are 
tightly regulated. All SD DVD titles use the same filenames and structure their contents 
in the same way.

Standard SD DVD Video Zone Files
The following groups of files are present in the video zone of all SD DVD-Video titles.

Video Manager Group
The video manager files contain much of the navigation information for the title.
• VIDEO_TS.IFO:  Contains the major information for the disc, such as its capacity and 

video zone structure.
• VIDEO_TS.BUP:  This is a backup of the .IFO file that can be used by the DVD player if 

the .IFO file cannot be read.
• VIDEO_TS.VOB:  This is the video objects file for the video manager.

Track Content Group
A set of at least four files is created for each track and slideshow in the project. “VTS_01” 
in the following filename examples refers to the first VTS block. Files for the second VTS 
block would start with “VTS_02.” You can have up to 99 tracks, stories, and slideshows 
in a project.

Note:  While stories do not get placed in their own VTS block, they still count against 
the 99 VTS limit.

Video manager files

Track 1 content group

Non-standard file
used for formatting

Non-standard file
used for formatting
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Video object files (VOB) contain the actual video, audio, and subtitle content for the 
menus and tracks. The maximum size of each VOB file is 1 GB. Within each track 
content group there are at least two VOB files—one that is dedicated to menu content 
and another (up to eight more) with the track’s contents.

• VTS_01_0.IFO:  Contains the major information for the first track, such as the number 
and types of streams and menus. 

• VTS_01_0.BUP:  This is the backup for the .IFO file.
• VTS_01_0.VOB:  Contains the video and audio content for the menus. The properties 

of the audio and video used in the menus within a VOB must be the same. If your 
project has menus using different properties, they are placed in other VTS blocks 
(VTS_02_0.VOB, for example). See “VTS Editor” on page 588 for more information on 
menus and VTS blocks.

• VTS_01_1.VOB:  Contains the video and audio content for the track. If the content is 
greater than 1 GB, a second file (VTS_01_2.VOB) is created for that additional content. 
Up to 7 additional files can be created if required to hold the track’s contents.

Non-Standard SD DVD Video Zone Files
As part of the build process, DVD Studio Pro creates two additional files in the 
VIDEO_TS folder. The format process does not include these files in its final output. 
• A .layout file:  This file uses the disc name and a “.layout” extension. The file contains 

project information used by the format process, including the marker information 
used when creating dual-layer discs. 

• A VOB_DATA.LAY file:  This file is used for incremental builds when you choose to 
reuse files in the VIDEO_TS folder left from a previous build for a new build.

Note:  The .layout filename must match the disc name for an incremental build to 
work. See “Incremental Builds” on page 563 for more information.

If you intend to manually copy the VIDEO_TS folder to a disc (bypassing the 
DVD Studio Pro format process), you should be sure not to copy the above files to the 
disc. Most DVD players ignore them if they are present in the VIDEO_TS folder on the 
final disc, but some are unable to play the disc.

Additionally, if you have not saved your project before you build it, a folder is added to 
the VIDEO_TS folder named Render Data. This folder contains rendered versions of any 
motion menus in your project, and is normally in your project’s bundle file. See “Menu 
Preferences” on page 115 for more information on rendered menu files.
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The Build Files for HD Projects
Once the build for your HD project starts, DVD Studio Pro creates an HVDVD_TS folder 
at the location you specified. A second folder, JACKET_P, is created if you have assigned 
a jacket picture graphic.

The JACKET_P folder contains three resolutions of the graphic assigned as the jacket 
picture. See “About Jacket Pictures” on page 562 for more information.

The HVDVD_TS folder contains all of the DVD-Video files for your project, and is placed 
in the video zone. The naming and structure contents of the HVDVD_TS folder are 
tightly regulated. All HD DVD titles use the same filenames and structure their contents 
in the same way.

Standard HD DVD Video Zone Files
The following groups of files are present in all HD DVD-Video titles.

Video Manager Group
The video manager files contain much of the navigation information for the title.
• HV000I01.IFO:  Contains the major information for the disc, such as its capacity and 

video zone structure.
• HV000I01.BUP:  This is a backup of the .IFO file that can be used by the DVD player if 

the .IFO file cannot be read.
• HV000M02.EVO:  This is the enhanced video objects file for the video manager.

Note:  The file HV000M01.EVO is not used by DVD Studio Pro.

Track Content Group
A set of at least four files is created for each track and slideshow in the project. 
“HV001I,” “HV001M,” and “HV001T” in the following filename examples refer to the first 
VTS block. Files for the second VTS block would start with “HV002I,” “HV002M,” and 
“HV002T.” You can have up to 99 tracks, stories, and slideshows in a project. 

Non-standard file
used for formatting

Non-standard file
used for formatting

Standard files for an HD 
project with two tracks

Optional jacket picture files
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Note:  

 

While stories do not get placed in their own VTS block, they still count against 
the 99 VTS limit.

Enhanced video object (EVO) files contain the actual video, audio, and subtitle content 
for the menus and tracks. Within each track content group there are at least two EVO 
files—one that is dedicated to menu content and another (up to 99 more) with the 
track’s contents.

 

•

 

HV001I01.IFO:  

 

Contains the major information for the first track, such as the number 
and types of streams and menus. 

 

•

 

HV001I01.BUP:  

 

This is the backup for the .IFO file.

 

•

 

HV001M01.EVO:  

 

Contains the video and audio content for the menus. The properties 
of the audio and video used in the menus within an EVO must be the same. If your 
project has menus using different properties, they are placed in other VTS blocks 
(HV002M01.EVO, for example). See “VTS Editor” on page 588 for more information on 
menus and VTS blocks.

 

•

 

HV001T01.EVO:  

 

Contains the video and audio content for the track. If the content is 
greater than 1 GB, a second file is created for that additional content. Up to 99 
additional files can be created if required to hold the track’s contents. The last two 
digits of the filename increment as additional files are created. For example, the first 1 
GB would be in HV001T01.EVO, the second 1 GB would be in HV001T02.EVO, and so on.

 

Non-Standard HD DVD Video Zone Files

 

As part of the build process, DVD Studio Pro creates two additional files in the 
HVDVD_TS folder. The format process does not include these files in its final output.

 

•

 

A .layout file:  

 

This file uses the disc name and a “.layout” extension. The file contains 
project information used by the format process, including the marker information 
used when creating dual-layer discs.

 

•

 

A VOB_DATA.LAY file:  

 

This file is used for incremental builds when you choose to 
reuse files in the HVDVD_TS folder left from a previous build for a new build.

 

Note:  

 

The .layout filename must match the disc name for an incremental build to 
work. See “Incremental Builds” on page 563 for more information.

If you intend to manually copy the HVDVD_TS folder to a disc (bypassing the 
DVD Studio Pro format process), you should be sure not to copy the above files to the 
disc. Most DVD players ignore them if they are present in the HVDVD_TS folder on the 
final disc, but some are unable to play the disc.

Additionally, if you have not saved your project before you build it, a folder is added to 
the HVDVD_TS folder named Render Data. This folder contains rendered versions of any 
motion menus in your project, and is normally in your project’s bundle file. See “Menu 
Preferences” on page 115 for more information on rendered menu files.
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Emulating Your Project
Once you have successfully built your project and have a VIDEO_TS or HVDVD_TS 
folder, you can test it using the Apple DVD Player. This process allows you to verify your 
project using the actual compiled files. 

An advantage of using the Apple DVD Player is that it can play directly from a 
VIDEO_TS or HVDVD_TS folder. It also allows you to select which VIDEO_TS or 
HVDVD_TS folder to play, if there are multiple folders on your system. 

Important:  You must use DVD Player v4.6.6 or later with Mac OS X v10.4 Tiger to play 
the HVDVD_TS folder. 

In addition to testing with DVD Player, it is also recommended that you try your project 
on other DVD players. Some computer DVD players will play from the VIDEO_TS or 
HVDVD_TS folder, but may require the folder to be at the root level of your disk. To test 
on a standalone DVD player, you must go through the format process and create a DVD 
disc. This is the most comprehensive test you can perform on your project, and is 
highly recommended.

Emulating Using DVD Player
The Apple DVD Player works well as an emulation tool. It is provided with Mac OS X on 
computers with a DVD drive. It can play from a disc or from a specified VIDEO_TS or 
HVDVD_TS folder. It also processes any DVD@CCESS links you have added to your project.

Note:  To avoid conflicts, be sure to quit DVD Studio Pro before opening DVD Player. Once 
you have finished with DVD Player, be sure to quit it before opening DVD Studio Pro.

To emulate your project with DVD Player:
1 Quit DVD Studio Pro.

2 Open DVD Player by double-clicking its icon in the Applications folder. 

3 To select a VIDEO_TS or HVDVD_TS folder, do one of the following:

• Choose either File > Open DVD Video Folder or File > Open VIDEO_TS Folder 
(depending on your version of DVD Player).

• Press Command-O.

4 Use the navigation dialog to locate the VIDEO_TS or HVDVD_TS folder, then click 
Choose. 

5 To play the VIDEO_TS or HVDVD_TS folder, do one of the following:

• Click the Play button.
• Press the Space bar.

The title starts playing, based on its First Play action.
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Emulating DVD@CCESS Links
DVD Player can process your DVD@CCESS links. You must first enable its 
DVD@CCESS capability.

To emulate DVD@CCESS links with DVD Player:
1 Choose DVD Player > Preferences.

2 Click the Disc tab.

3 Select the Enable DVD@CCESS Web Links checkbox.

4 Click OK.

There are two types of DVD@CCESS links:  those that use network access (such as 
connecting to a URL or sending an email) and those that open a file. When emulating a 
VIDEO_TS or HVDVD_TS folder, you can’t process links that open a file, since the path you 
entered when setting the link most likely does not match the file’s current path (especially 
if the file is intended to be included on the DVD disc). To verify DVD@CCESS links that 
open a file, you must actually burn a DVD disc and emulate directly from the disc.

See “DVD@CCESS” on page 594 for details on using the DVD@CCESS feature.

Emulating Dual-Layer Projects
The build process for dual-layer projects is the same as for single-layer projects—it creates 
a single large VIDEO_TS or HVDVD_TS folder and compiles the files. You can emulate the 
project using DVD Player, but you will not be able to emulate the action at the dual-layer 
break point, since it has not yet been set. (That happens in the format process.)

Note:  You can burn your dual-layer project to a double-layer disc to test the break 
point action.
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Setting Disc Format Properties
Before formatting and writing your DVD disc, DLT, or hard disk files, you must configure 
your disc’s format properties. Most of these settings can be made at any time in the 
authoring process. Additionally, you are given the opportunity to set these after you 
start the format process.

Preformat Disc Properties
The preformat disc properties include the following items from the Disc Inspector. See 
“Setting Disc Properties” on page 552 for details on these settings. These same settings 
are in the format configuration window that appears when you start the format 
process. In all cases, the items appear in the same tab in both the Disc Inspector and 
the format configuration window. Any differences are listed below.
• Disc Name:  Located at the top of the Disc Inspector and in the General tab in the 

format configuration window.
• DVD-ROM:  Located in the General tabs. The size of the DVD-ROM content appears in 

the format configuration window.
• Disc Information:  Located in the Disc/Volume tab.
• Volume Information:  Located in the Disc/Volume tab of the format configuration 

window. Shows the volume creation date.
• Playable Region Codes:  Located in the Region/Copyright tab. 
• Copyright Management:  Located in the Region/Copyright tab. The Macrovision 

settings are disabled in the format configuration window since these must have 
been set prior to building the project.

• Destination:  Located only in the format configuration window’s General tab. See 
“Configuring the Output Type” on page 583 for more information.

About DVD-ROM Discs
You can create either DVD-Video or DVD-ROM discs with DVD Studio Pro. 
• DVD-Video discs contain the VIDEO_TS or HVDVD_TS and AUDIO_TS folders only. 
• DVD-ROM discs contain the VIDEO_TS or HVDVD_TS and AUDIO_TS folders, as well 

as other files you specify. 
• ROM-only DVD discs do not contain the VIDEO_TS, HVDVD_TS, or AUDIO_TS folders—

they contain only other files you specify.
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DVD-ROM discs, also known as hybrid discs, play on standalone DVD players the same 
way DVD-Video discs do. When played on a computer, however, the additional files on 
the disc can be accessed, either directly or as part of a DVD@CCESS link. See 
“DVD@CCESS” on page 594 for more information on DVD@CCESS.

Note:  The type of DVD project you are creating, SD or HD, determines the type of 
volumes that are created. SD projects create a UDF 1.02 volume and HD projects create 
a UDF 2.50 volume, regardless of the disc type actually being burned. UDF 2.50 
volumes will not play in current SD DVD players and are not supported by older 
computers, including those running Mac OS X v10.3 Panther or earlier. 

Filenaming Issues With Red Laser Media
A DVD-Video disc can contain several folders:  VIDEO_TS, HVDVD_TS, AUDIO_TS, and 
JACKET_P. The filenaming structure within these folders is very strict and tightly 
defined, and conforms to the “8.3” specification. That is, only eight characters maximum 
are allowed, followed by a three-character extension. The only allowed characters are 
uppercase letters, numbers, and the underscore. 

The names of files on a red laser disc are kept track of in two volumes—a UDF 1.02 
(Universal Disc Format version 1.02) volume and an ISO 9660 volume, which together 
are known as the UDF Bridge Format. The advantage of having the two volumes is that 
it makes the DVD disc usable on a wider variety of playback devices. A potential 
disadvantage is that each volume has its own filenaming rules. In the case of a 
DVD-Video disc, since the only files present are those within the VIDEO_TS and 
AUDIO_TS folders, the names in both volumes are identical.

A DVD-ROM disc also contains the VIDEO_TS and AUDIO_TS folders, and each must 
follow the same strict filenaming rules that apply to a DVD-Video disc. The difference is 
that the disc also contains folders and files outside of these normal DVD-Video folders. 
In addition, a third volume, the Joliet volume, may be created. 

As soon as you choose the DVD-ROM Content checkbox, the Joliet Extension Support 
checkbox becomes active. Use this to control the filenaming conventions applied to 
those nontraditional files.

The following sections describe the filenaming conventions that apply to the different 
types of volumes on a DVD.
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UDF 1.02 Volume
All SD DVDs using red laser media have a UDF 1.02 volume. The UDF volume always 
supports long (up to 255 characters) Unicode filenames. Unicode is a double-byte 
system allowing far more characters than the standard ASCII (single-byte) system. This 
is very useful when you want to use Japanese characters, for example. It also supports 
folders with extensions. Note that some operating systems prohibit the use of certain 
characters ( \ / ? : “ < > | ) in filenames. Standalone DVD players use the UDF volume to 
begin playing a disc, but only to locate the first files. They never go beyond the 
VIDEO_TS and AUDIO_TS directories. Macintosh computers using Mac OS 9 and 
Mac OS X use the UDF volume.

ISO 9660 Volume
All DVDs also have an ISO 9660 volume. This volume only supports filenames with 
single-byte ASCII characters. The ISO 9660 volume must conform to the “26.3” 
specification, similar to the “8.3” specification mentioned earlier (26 characters 
maximum followed by a 3-character extension; the only allowed characters are 
uppercase letters, numbers, and the underscore). In addition, folders cannot have 
extensions in their names. Filenames are automatically truncated and invalid characters 
replaced with an underscore. Filenames using double-byte characters exclusively are 
renamed as FILE_1, FILE_2, and so on.

Joliet Volume 
Once you have selected the DVD-ROM Content checkbox, the Joliet Extension Support 
checkbox becomes active. 

Important:  The Joliet Extension Support checkbox is only applicable when writing to 
red laser media. It has no effect when writing to blue laser media.

Selecting the Joliet Extension Support checkbox forces the creation of the Joliet 
volume. This volume supports long Unicode filenames, just like the UDF volume, but 
has a limit of 110 characters. Folders with extensions are also supported. Filenames 
longer than 110 characters are automatically truncated. When not selected, the Joliet 
volume is not created.

Note:  In rare cases, enabling the Joliet Extension Support checkbox and adding a 
number of files with extended character set names to the disc may create playback 
problems on some older DVD players. Select it only if you need to include such files 
and can test the disc on your intended players.
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Filenaming Issues With Blue Laser Media
Blue laser media contains only one volume—a UDF 2.5 volume. For the purposes of 
filenaming, a UDF 2.5 volume has the same rules as the UDF 1.02 volume found on red 
laser DVDs. See “UDF 1.02 Volume” on page 574 for more information.

Important:  Older computer operating systems, including Mac OS X v10.3 “Panther” and 
earlier, and DVD players do not support UDF 2.5 volumes whether on red or blue laser discs. 

Creating ROM-Only DVD Discs
You can use DVD Studio Pro to create DVD discs that contain only ROM data. The 
advantage of using DVD Studio Pro to do this (as opposed to using the Finder) is that, 
depending on whether you are using red laser or blue laser media, the volumes that 
are created are compatible with the DVD specification.

To create a ROM-only DVD disc:
1 Do one of the following:

• Select the project’s name (next to the disc icon) in the Outline tab.
• Click an empty area in the Graphical tab.
The Disc Inspector appears. 

2 Click the General tab in the Disc Inspector. 

3 Select the SD DVD setting for DVD Standard to write to red laser media, or the HD DVD 
setting to write to blue laser media.

4 Do one of the following:

• Choose File > Advanced Burn > Format.
• Click Format in the toolbar.
• Press Command-F.
The format configuration window appears.

By default, DVD Studio Pro assumes you want to format the project that was built last. 
The settings in the format configuration window are set to match the last build. 

5 Verify the settings in the Disc/Volume and Region/Copyright tabs are correct.

This includes making sure the correct media type (red or blue laser) is selected as well 
as the layer options (single or dual). 

6 In the General tab’s Source section, do one of the following:

• Use the Current Source pop-up menu (labeled “Choose”) to navigate to a folder 
without a VIDEO_TS or HVDVD_TS folder.

• Highlight and delete the text displayed in the Location text entry area.
An alert appears warning you that no DVD content could be found in that location.
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7 Configure the DVD-ROM Data section.

8 Configure the Destination section in the General tab in the format configuration 
window. This is where you select and configure the output type. See “Configuring the 
Output Type” on page 583 for more information.

9 Click Burn to start formatting the project if you are writing to DVD or DLT, or Format if 
you are writing to a hard disk.

About Dual-Layer Discs
Dual-layer discs present several challenges: 
• You can only fully test the break point if your system can burn to double-layer media. 

When you burn a dual-layer project to a double-layer disc using DVD Studio Pro, the 
break point, where the DVD player switches from one layer to the other, is placed as 
it would be with a replicated disc. See “Emulating Dual-Layer Projects” on page 571 
for more information.

Note:  DVD Studio Pro also allows you to burn a dual-layer project to a single-layer 
disc. In this case, all of the first layer and as much of the second layer as possible is 
written to the disc, with the marker that is used as the break point set to be 
non-seamless (unless you have chosen the seamless layer change setting). 

• The second layer’s direction must be selected. You need to decide whether to use the 
Parallel Track Path (PTP) or Opposite Track Path (OTP) direction. See “Setting the Dual-
Layer Direction” on page 577 for more information.

• A break point must be chosen. The point where the first layer ends and the second 
begins can be chosen automatically by DVD Studio Pro, or you can select the track 
marker that serves as the break point. See “Choosing a Dual-Layer Break Point” on 
page 578 for more information.

Dual-layer discs allow you to place nearly twice as much content on a single disc side, 
but there is a downside to this method:  At some point, the DVD player must switch 
from reading the first layer to reading the second layer. Switching between layers 
requires the player’s laser to refocus and then locate the sector at which to start 
playing. During this time, the video image freezes, which may confuse viewers or make 
them think the disc is defective.

There are two things you can do to minimize the effect of this switch time:  Use the 
OTP direction to minimize how long it takes, and choose a break point where a freeze 
is not as noticeable. Alternatively, you can choose to use a seamless layer change.
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Choosing Seamless or Non-Seamless Layer Changes
DVD Studio Pro includes a setting that allows you to choose between a seamless layer 
change or a non-seamless layer change. 

With the seamless layer change, the switch between the first and second layer is less 
detectable. With the non-seamless layer change, there is a short pause when the DVD 
player switches between the layers.

While the seamless layer change would appear to be the best choice, some DVD 
players do not support the seamless feature, and may stop playing the disc once the 
switch point is reached. For that reason, it is strongly suggested that you use the default 
non-seamless layer change setting.

To change the layer change setting:
1 Click the Disc/Volume tab in the Disc Inspector.

2 Do one of the following:

• Leave the Seamless checkbox deselected to use the normal layer change setting.
• Select the Seamless checkbox to force a non-standard seamless layer change setting.

Setting the Dual-Layer Direction
The disc’s first layer always starts on the inside edge, near the disc’s spindle hole. The 
disc plays from this point toward the outer edge.

It is the second layer’s direction that you have to choose. With the Parallel Track Path 
(PTP) setting, the second layer is configured exactly like the first layer—it begins on the 
inside and plays toward the outside. With the Opposite Track Path (OTP) setting, the 
second layer begins on the outside edge and plays toward the inside. 

Note:  Double-layer discs require you to use the OTP setting.

With the PTP setting, the DVD player will need more time when switching between 
layers since the laser must be repositioned from one end of the disc to the other. Using 
the OTP setting minimizes the time needed to reposition the laser, since the end of the 
first layer is near the beginning of the second layer. 

Important:  When using the OTP setting, the first layer must be larger than the 
second layer.
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Choosing a Dual-Layer Break Point
There are several factors that need to be taken into account when you choose where to 
place the dual-layer break point:
• Break points must be on track markers. When you choose the break point, you get a list 

of track markers to choose from. In some circumstances, you may need to place a 
marker on a track just for this purpose. 

Note:  In some special cases, you can set your dual-layer break point in the DVD-ROM 
area. See “Setting the Break Point With Large DVD-ROM Contents,” next, for 
more information.

• Break points need to be placed so that the first layer is mostly filled. A red laser dual-layer 
disc can hold 7.95 binary gigabytes and a blue laser dual-layer disc can hold 27.94 
binary gigabytes. (See “Making Sure Your Content Will Fit” on page 40 for information 
on disc sizes and DVDs.) Each red laser disc layer can hold approximately 3.9 binary 
gigabytes, and each blue laser disc layer can hold approximately 13.9 binary 
gigabytes. The closer your project comes to filling the disc, the more critical it is that 
you get as much content as possible on the first layer, and place the break point 
accordingly. Additionally, using the OTP direction setting requires the first layer to be 
larger than the second layer. See “Manually Determining the Break Point Position” on 
page 580 for information on determining at which track the first layer will be filled.

• Break points are best when they are not noticed. A layer switch that occurs during a 
tense action-packed scene can disrupt the viewer’s attention. When possible, it is 
best to place the break point in a scene with little action, or even better, at a scene 
transition, such as a fade to black.

Setting the Break Point With Large DVD-ROM Contents
Authoring a project that contains a small amount of DVD-Video data with a large 
amount of DVD-ROM data requires special handling for placing the break point. For 
example, you might author a project for a dual-layer red laser disc that contains 2 GB of 
DVD-Video data and 6 GB of DVD-ROM data. In this case, you will not be able to set a 
break point at a track’s marker since the DVD-ROM data will not fit on a single layer.

In these cases, setting the break point to Automatic places the break point in the 
DVD-ROM data.
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Setting the Dual-Layer Break Point
There are several methods you can use to set a dual-layer break point:
• The automatic method:  By default, once you configure the disc as dual-layer, 

Automatic is selected as the break point in the Disc/Volume tab in the Disc Inspector. 
With this setting, DVD Studio Pro chooses the last marker that fits in the first layer. In 
cases where there is a large amount of ROM data, the automatic method can also 
place the break point in the ROM data. See “Setting the Break Point With Large 
DVD-ROM Contents” on page 578 for more information.

If you are using the Build/Format command, the automatic method has the greatest 
chance of success, since it will be able to choose the break point marker once the build 
process is finished without having to pause for you to choose the marker to use.

It is possible that your project does not have a suitable marker for use as the dual-
layer break point. In that case, the format is cancelled and you must add a suitable 
marker to a track in your project. (Another option might be to rearrange the order of 
the tracks in the VTS Editor. See “Moving Elements From One VTS to Another” on 
page 591 for more information.) See “Manually Determining the Break Point Position” 
on page 580.

• Assign a break point marker in the Track Editor:  This method allows you to choose the 
marker to use as the break point while working with your tracks. The disadvantage of 
this method is that, until you build your project, it can be difficult to choose a 
suitable marker as the break point. This is especially true if your project has a lot of 
transitions or you are using assets that have not yet been MPEG-2 encoded. 

If you choose an inappropriate marker, the format process will automatically cancel, 
with a dialog advising you of the problem it encountered.

• Choose the break point marker when you start the format process:  After you have built 
your project, the Dual-Layer Break Point pop-up menu in the Disc/Volume tab in the 
format configuration window shows all suitable markers that you can choose from, 
with those that are inappropriate dimmed. This option has the advantage of letting 
you choose the marker to use from a list of known suitable markers. The 
disadvantage is that you have to build your project first.

As with the automatic method, it is possible that there are no suitable markers, with 
no markers appearing in the pop-up menu. This means that you will have to add a 
suitable marker to a track in your project, or try rearranging the tracks in the VTS 
Editor. See “Manually Determining the Break Point Position” on page 580.
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Manually Determining the Break Point Position
You can usually determine which track will be playing at the point where the break 
point is set by looking at the contents of the VIDEO_TS or HVDVD_TS folder. 
DVD Studio Pro writes the tracks to disc in their order in the Outline tab’s By VTS 
display. For SD projects, the first track listed becomes VTS_01_1.VOB, VTS_01_2.VOB, 
VTS_01_3.VOB, and so on (depending on the size of the track’s assets, with each VOB 
file being a maximum of 1 GB). The second track becomes VTS_02_1.VOB, and so on. 

For HD projects, the first track listed becomes HV001T01.EVO, HV001T02.EVO, and so on, 
with each EVO file being a maximum of 1 GB. The second track becomes 
HV002T01.EVO.

See “Standard SD DVD Video Zone Files” on page 566 and “Standard HD DVD Video 
Zone Files” on page 568 for more information on identifying the files and on 
determining which files contain the menus, which will allow you to take them into 
account.

For example, when authoring for a red laser disc, by adding the file sizes together, 
starting with VTS_01, you can determine at which track the first layer’s 3.9 GB limit will 
be reached, and even get a rough idea of where in that track this will happen. You may 
decide to reorder the tracks with the VTS Editor to ensure the break happens in a 
noncrucial track.

About Two-Sided Discs
A two-sided disc is a disc with separate projects on each side. Within DVD Studio Pro, 
you must create an independent project for each side. Some replication facilities allow 
you to have a single-layer project on one side and a dual-layer project on the other. 
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Formatting Your Project
Once you have built your project and set the preformat properties, you are ready to 
format it. The format process creates an output formatted for your output type: 
• A DVD burning drive
• A DLT drive
• A hard disk

Each output type has its own settings that need to be configured before the actual 
format process begins.

In addition to the VIDEO_TS or HVDVD_TS folder, there are other items that can be part 
of the format process:

• A folder specified by the DVD-ROM content setting
• DVD@CCESS Installers

You can change or set the folder to use for DVD-ROM content either when specifying 
the preformat settings or while configuring the format process. The DVD@CCESS 
Installers are included if the project used DVD@CCESS links and the Embed Text Data 
checkbox in the Disc Inspector is selected. See “DVD@CCESS” on page 594 for more 
information on DVD@CCESS.

You can also choose to read content from a DLT drive and format that content. See 
“Reading a DLT Drive” on page 585 for more information.

Starting a Format Process
You can set the format process to start automatically after a build or you can manually start 
the format. In either case, a window appears at the beginning of the format process; you 
can set the format properties here, if you have not already set them in the Disc Inspector. 

To format your project:
1 Do one of the following:

• Choose File > Advanced Burn > Format to perform a format only.
• Press Command-F to perform a format only.
• Click Format in the toolbar to perform a format only.
• Choose File > Advanced Burn > Build and Format to perform both a build and a 

format. See “About the Build/Format Command” on page 564 for more information.
• Click Build/Format in the toolbar to perform both a build and a format. 
• Press Option-Command-F to perform both a build and a format.
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2 The format configuration window appears.

By default, DVD Studio Pro assumes you want to format the project that was built last. 
The settings in the format configuration window are set to match the last build. It is a 
good idea to verify that the settings in the General, Disc/Volume, and Region/Copyright 
tabs are correct.

3 Configure the Destination section in the General tab in the format configuration 
window. This is where you select and configure the output type. See “Configuring the 
Output Type,” next, for more information.

4 Click Burn to start formatting the project if you are writing to DVD or DLT, Format if you 
are writing to a hard disk, or Build & Burn if you used the Build/Format command.

You can use the Choose button next to Current Source to select a folder that contains 
the VIDEO_TS and/or HVDVD_TS folder you want to format.
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Configuring the Output Type
Once you start the format process, you can configure the output type you want to 
format to. The Destination section in the General tab in the format configuration 
window contains the output type settings.

• Output Device:  Use this pop-up menu to choose the actual device to format to. It 
displays a list of your system’s suitable output devices, including DVD-R drives, DLT 
drives, and the system’s hard disk drive. The other Destination settings change 
depending on the device you select. See “Output Devices,” below, for details on the 
devices available.

• DVD-R Simulation Mode:  This is active only when writing to a DVD-R drive. When 
selected, the format goes through the motions of writing to the DVD-R drive, but 
does not actually write to the disc. 

This is useful when you want to ensure that your system is able to support writing to 
a disc without any buffer underrun issues. Buffer issues indicate that data is not 
flowing smoothly and continuously from the source disk to the DVD-R drive. This can 
be caused by a slow device (for example, a networked hard disk) or a system that is 
too busy doing additional tasks. (A buffer underrun error that occurs while data is 
actually being written to a disc results in an unusable disc.)

Once you finish the simulation with no problems, you can deselect the DVD-R 
Simulation Mode checkbox and feel comfortable that you can safely burn a DVD.

• Lossless Linking:  This checkbox is active only when writing to a DVD-R drive that 
supports this feature. When selected, it adds protection against buffer underrun 
conditions by allowing the drive to pause during the writing process, and then pick 
up where it left off once additional data becomes available. 

For normal DVD burning, especially on systems that may be prone to having buffer 
underrun conditions, it is suggested to select Lossless Linking. 

While Lossless Linking usually results in a flawless write process, there is a slight 
potential for an error to be introduced. If you are burning a disc for use by a 
replication facility, you may want to deselect Lossless Linking so that you can ensure 
that your disc is written without interruption. 

• Output Format:  Depending on the selected output device, there may be multiple 
formats available. Use this pop-up menu to select the specific format to use. See 
“Output Devices,” next, for details on the formats available for each device.
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Output Devices
There are three output device types that you can format your project for:  DVD-R drives, 
DLT drives, and your system’s hard disk.

DVD-R Drives
With respect to formatting, DVD-R drives can be one of two types:
• Authoring:  These drives use authoring media and are capable of writing Cutting 

Master Format (CMF) discs, which provide advanced features when working with a 
replicator. The most common authoring drive used is the Pioneer S201. With an 
authoring drive, you can set the Output Format to either Standard or CMF. See “The 
Cutting Master Format” on page 585 for more information on CMF discs.

• General:  These drives use general media and cannot write CMF discs. The Apple 
SuperDrive is the most common drive used for writing general media discs. Depending 
on your system, the SuperDrive is listed in the Output Device pop-up menu as a 
Pioneer DVR-103, a Pioneer DVR-104, a Pioneer DVR-105, or a Matshita UJ-815.

Note:  The list of drives used as SuperDrives will continue to change as newer drives 
become available. 

DLT Drives
You have three output format options when formatting to a DLT drive:
• DDP 2.0:  Writes to the tape using the Data Description Protocol using DDP version 2.0.
• DDP 2.1:  Writes to the tape using the Data Description Protocol using DDP version 2.1.
• CMF 1.0:  Writes to the tape using the CMF format version 1.0. 

If this is a dual-layer project, you will be required to write two tapes—one for each layer. 

Hard Disk
In most cases, when you use the format process you will be writing directly to a DVD-R 
or DLT drive. Writing to the hard disk can be useful if you do not have a DVD-R or DLT 
drive available.

You have four output format options when writing to your hard disk:

• DDP 2.0:  Use this (Data Description Protocol) option to create a file compatible with 
DLT drives using DDP version 2.0.

• DDP 2.1:  Use this (Data Description Protocol) option to create a file compatible with 
DLT drives using DDP version 2.1.

• CMF 1.0:  Use this option to create a file compatible with authoring DLT and DVD-R 
drives using CMF format version 1.0.

• .img:  Use this option to create a disk image. With a dual-layer project, a single “.img” 
file contains the entire project, without any break point information.

If you select your hard disk drive as your output device, you will be asked where you 
want the format to be written to.
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Important:  The format files will require the same amount of space as the build’s 
VIDEO_TS or HVDVD_TS folder plus any DVD-ROM content you have included. Be sure 
you have enough free hard disk space before clicking Format. 

If you are formatting a dual-layer project and use either DDP or CMF as the output format, 
two folders are created—one for each layer. Each folder contains all the information 
required by a replicator. If you use .img as the output format, one file is created.

The Cutting Master Format
There are several features of the DVD specification that you cannot include on red laser 
DVD-R discs that you burn with your system. These features, which must be added by a 
replication facility, include:
• Copyright management (including CSS and Macrovision)
• Double-sided disc information

Traditionally, the only way to include these features on your replicated disc was to use a 
DLT drive. The Cutting Master Format (CMF) has been adapted to the DVD-R format so 
that now you can burn a DVD-R disc on your system and a replication facility can use 
that disc and include these features on the discs they make. CMF for DVD-R is only 
supported by authoring drives and media.

Note:  Not all replication facilities support CMF discs; be sure to check with them ahead 
of time. Also, discs formatted as CMF may not play correctly on all DVD players. Only 
use CMF when supplying a disc to a replication facility.

Reading a DLT Drive
With DVD Studio Pro, you can copy the contents of a DLT drive to your hard disk as a 
disk image file. If the disk image is a single-layer project, you can then use the format 
feature to write the file to a second tape or to a DVD-R disc. By opening the disk image, 
you can access the VIDEO_TS or HVDVD_TS folder.

This technique can be useful if you want to verify the DLT tape’s contents, make a 
backup of a DLT tape, or burn a DVD of a previous project without having to load the 
project and all its assets onto your system.
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To read a DLT drive:
1 Make sure the DLT drive is connected and the tape is inserted.

2 Click Read DLT in the toolbar.

3 Select the location for the tape’s contents to be written to in the dialog that appears.

4 Click Open to start the process. 

If the tapes are from a dual-layer project, you are prompted to insert the second tape 
once the first has been read. The contents of the second tape are appended to the first 
tape’s contents.

Important:  When you read from a DLT drive, the “.layout” file that DVD Studio Pro uses 
to track the copy protection settings, position of the dual-layer break point, and other 
format related settings is not available. This means that, for single-layer projects, you 
have to verify the settings in the Format dialog before you burn a DVD or write a new 
DLT from the file. It also means that you cannot burn a DVD or write a new DLT of a 
dual-layer project.
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17 Using Advanced Features

DVD Studio Pro contains a number of advanced features 
that are used mostly in specialized projects:  VTS Editor, 
DVD@CCESS, user operations, display conditions, remote 
control settings, and Line 21 settings. 

In most cases, these features are available in several elements, such as menus and tracks.

• VTS Editor:  Used to verify and control the VTS (Video Title Set) structure of your project.
• DVD@CCESS:  Used to add interactivity intended for use when playing your DVD title 

on a computer. See “DVD@CCESS,” below, for more information.
• User operations:  Used to disable viewer operations in menus, tracks, stories, and 

markers. See “User Operations” on page 598 for more information.
• Display condition:  Used to control whether specific menus, tracks, and stories should 

appear or not. See “Display Condition” on page 603 for more information.
• Remote control settings:  Used to connect project elements to buttons on a DVD player’s 

remote control. See “Remote Control Settings” on page 608 for more information.
• Line 21 settings:  Used to provide closed caption capability to NTSC DVD titles. See 

“Line 21 Settings for Closed Captions” on page 611 for more information.
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VTS Editor
The VTS Editor allows you to verify and control the VTS (Video Title Set) structure of 
your project. Using the VTS Editor, you are able to manually assign elements to VTS 
blocks. This makes it possible for you to optimize the final DVD’s layout so that when 
it’s played there are minimum pauses due to the player having to move between 
elements in different parts of the disc.

For most projects, the VTS assignments automatically made by DVD Studio Pro while 
you build your project will work fine. However, complicated or specialized projects 
using many scripts and menus can have their playback performance improved by 
manually moving elements between the VTS blocks.

About VTS Blocks
The contents of a video DVD are contained in one or more VTS blocks. In 
DVD Studio Pro, each track and slideshow must reside in its own VTS. Additionally, each 
VTS has a structure to support one or more menus and one or more scripts. Also, all 
DVDs have a video manager that knows the VTS structure of the disc.

Menus and VTS Blocks
All menus in a VTS must use the same video and audio settings, including formats, 
aspect ratios, resolutions, and in the case of audio, sample size. For example, if you have 
some menus using AIFF audio and others using AC-3, they must be placed in different 
VTS blocks. DVD Studio Pro automatically places menus into VTS blocks as needed by 
their assets.

Each VTS is limited to a maximum of 1 GB worth of menus. If you have a lot of motion 
menus, you may exceed this limit and need to split the menus between multiple 
VTS blocks.

Video Title Set (VTS) blocks
(up to VTS_99)

VTS_01 VTS_02 VTS_03

Main content space
(8 GB maximum)

Menu space
(1 GB maximum)

Script space

VTS block detail

Video manager
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DVD Playback and VTS Blocks
When you play a DVD and a jump must occur, such as when a menu button is selected 
that jumps to a track’s chapter marker, there is a slight pause while the DVD player’s 
laser locates where to jump to on the disc. 
• If the track is in a different VTS block than the menu, the laser must first jump to the 

video manager files, and from there on to the track’s VTS. 
• If the track is in the same VTS block as the menu, the laser is able to go directly to 

the track. 

You can improve a disc’s playback performance by keeping related elements together 
whenever possible. For example, you should place the scripts used with a specific track 
in the same VTS as the track. 

Since menus often link to multiple tracks or slideshows, you will not be able to keep 
them together with everything they can jump to. However, you can minimize the time 
a DVD player spends jumping from the menu to the video manager files by keeping 
the menus in the first VTS, which is physically located close to the video manager files.

See “Standard SD DVD Video Zone Files” on page 566 for more information.

Using the VTS Editor
The VTS Editor is located in the Outline tab. By default, the VTS Editor is hidden in the 
Outline tab.

Indicates that the
project’s elements are

listed by their type, with
no VTS information.

Alternate View button 
swaps view between 
By Type and By VTS.

Adds a new empty VTS
(active only when the By VTS

display is visible).

Drag this edge to split the 
tab and show both 
By Type and By VTS.



590 Chapter 17    Using Advanced Features

 

To show the VTS Editor, do one of the following:
m Click the Alternate View button.

The Outline tab changes from the current display, either By Type or By VTS, to the 
alternate display. If the display is in a split-view mode (showing both By Type and By 
VTS), clicking the Alternate View button swaps sides between the two views.

m Drag the partition toward the tab’s center.

The partition edge can be on the left or right—it is the side that has the handle indication.

Comparing the By VTS and By Type Displays
The elements in the By VTS and By Type displays are very similar and can be used to do 
many of the same things. For example, double-clicking an element in either display 
opens it in its editor and inspector. (Selecting an element in one display also selects 
that same element in the other.)
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The primary difference is in how they are organized.

• By VTS lists the elements based on the VTS they belong to. A VTS can have only one 
track (which can also have stories) or one slideshow, but it can have multiple menus 
and scripts.

• By Type lists the elements based on their type (menus, tracks, slideshows, and scripts). See 
“Using the Outline Tab” on page 165 for more information on using the By Type display.

Note:  The Languages section in the By Type display does not represent actual 
elements—it represents languages that can be used for the menus. It does not appear 
in the By VTS display since it is not specific to a VTS.

Moving Elements From One VTS to Another
You can move elements from one VTS to another by dragging. This is most often done 
to place scripts and menus in the same VTS blocks as the tracks or slideshows they 
most closely relate to.

To move an element to a different VTS:
m Select the element and drag it to the destination VTS block’s name.

As you drag the element, a black box surrounds the VTS name that it will be moved to 
as you pass over it. Releasing the element places it in that VTS. The element has a “pin” 
added to its icon to indicate it has been manually placed in that VTS.

Once you start dragging the element, all incompatible VTS blocks (containing pinned 
incompatible menus) have their names struck through and yellow warning triangles 
placed in front of them. If you move a menu into an incompatible VTS, a warning 
appears, and the incompatible menus have a line through their names. See “About 
Pinning Elements in the By VTS Display,” next, for more information.

Important:  It is possible to manually move incompatible menus to the same VTS. The 
project will not build, however. 
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About Pinning Elements in the By VTS Display
As you create elements for your DVD project, DVD Studio Pro automatically places 
them in appropriate VTS blocks. For example, if you create a menu that uses a different 
audio format than the others, it is automatically placed in a separate VTS.

If you manually move an element from one VTS to another, the VTS Editor indicates it 
with a pin on the element’s icon.

You can also pin an element to a VTS to prevent DVD Studio Pro from moving it to 
another VTS.

To pin an element to a VTS:
m Control-click the element in the By VTS display, then choose Pin Element Type to Video 

Title Set from the shortcut menu, with Element Type being the type of element being 
pinned (menu, script, and so on).

To unpin an element from a VTS:
m Control-click the element in the By VTS display, then choose Pin Element Type to Video 

Title Set from the shortcut menu, with Element Type being the type of element being 
pinned (menu, script, and so on). (Since the element was pinned, it has a checkmark 
next to this entry in the shortcut menu.)

Once it is unpinned, the element is moved to the VTS where DVD Studio Pro would 
normally automatically place it.

The pin indicates that
the element was either

manually placed in
this VTS or has been

“pinned” to it.
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Adding Additional VTS Blocks
You can add additional VTS blocks to your project as needed.

To add a VTS to your project:
1 Ensure the By VTS display is visible by doing one of the following:

• Click the Alternate View button.
• Drag the partition toward the center of the Outline tab.

2 Do one of the following:

• Control-click in the By VTS display, then choose Add Video Title Set from the 
shortcut menu.

• Click the Add VTS button along the top of the Outline tab.

Note:  A project can have up to 99 VTS blocks.

If any VTS blocks are empty when you build the project, you are asked if you want 
them to be deleted. While it does not violate compatibility with the DVD specification 
to have empty VTS blocks in the build, they do use a small amount of disc space.

VTS Inspector
You can see the properties of a VTS block by clicking its name in the VTS Editor.

The VTS Inspector shows the name of the VTS block, and its audio and video properties. 
The properties are defined by the menus assigned to the VTS. If there are no menus in 
the VTS, these properties are left blank. It is these properties that determine whether or 
not any new menus that are added are compatible.
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DVD@CCESS
The DVD@CCESS feature allows you to add additional interactivity to your DVD title 
when it is played on a computer. For example, you can set a marker so that when it is 
reached, the computer’s web browser opens and is directed to the specified URL, which 
can be a website on the Internet or an HTML file on the DVD. 

DVD@CCESS is compatible with both Macintosh computers and most Windows-based 
computers. See “Configuring Computers for DVD@CCESS Playback” on page 597 for 
details on configuring both types of computers.

While the most common use of DVD@CCESS is to link to a website, you can also use it 
to open a program to view other types of files, such as PDF, PICT, or JPEG files. You can 
use DVD@CCESS links for:

• Internet access:  You can enter a URL that links to a specific page on the Internet. 
• Opening a file:  You can enter a filename. As long as the file type can be recognized 

by the computer’s operating system and a suitable application for that file type is 
available, the application opens and displays the file. Most often you will want to link 
to a file that you have included on the DVD. 

• Email:  You can enter an email address. The computer’s default email application 
opens, creates a new email, and enters the address you specify as the recipient. 

Creating DVD@CCESS Links in Your Project
There are three elements within DVD Studio Pro that can include DVD@CCESS links:
• Menus:  Each menu can have a DVD@CCESS link. The link is activated as soon as the 

menu is displayed. While you cannot assign a DVD@CCESS link directly to a button, 
you can assign the link to a menu that appears only when you click that button. 

• Markers:  Each marker within a track can have a DVD@CCESS link. The link is activated 
as soon as you reach the marker while playing the track. 

• Slideshow slides:  Each slideshow slide can have a DVD@CCESS link. The link is 
activated as soon as the slide starts playing.

The DVD@CCESS settings appear in the Inspector of each element. 
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To enter a DVD@CCESS link:
1 Select the item to add the link to. 

Its Inspector appears.

2 Select the DVD@CCESS checkbox to enable the link for the item.

3 In the Name field, enter text to help you remember what the DVD@CCESS link is for. 
This text is not seen by the viewer and is only for your use while authoring the title. It 
can be helpful since the link text is often difficult to interpret directly.

4 Enter the link text in the URL field. This is the text that gets processed during playback. 

See “Rules for Entering DVD@CCESS Links,” next, for guidelines on entering the links.

Note:  The Embed Text Data checkbox in the Advanced tab in the Disc Inspector is 
automatically selected when you add DVD@CCESS links to your project.

Configuring a DVD@CCESS link to a file included on the DVD requires some additional steps.

To enter a DVD@CCESS link to a file on the DVD:
1 Select the item to add the link to. 

Its Inspector appears.

2 Select the DVD@CCESS checkbox to enable the link for the item.

3 In the Name field, enter text to help you remember what the DVD@CCESS link is for. 

4 Enter the link text in the URL field. This is the text that gets processed during playback. 
To link to a file located on the DVD, you would enter:

file:///DVDName/FolderName/FileName

where DVDName is the name of the disc entered in the Disc Inspector, FolderName is 
the folder the file will be in on the DVD, and FileName is the file (the name must 
include an extension such as .pdf or .jpg).

5 Do one of the following to open the Disc Inspector:

• Click an empty area in the Graphical tab.
• Click the disc icon in the Outline tab.

6 Click the General tab in the Disc Inspector.

7 Select the Content checkbox.

8 Choose the folder that contains the folders and files you want to include on the DVD.

Note:  The actual folder you choose is not included on the DVD—only the folders and 
files contained within it are added to the root level of the DVD.

file:///DVDName/FolderName/FileName
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Rules for Entering DVD@CCESS Links
Enter your links in the following format:

Note:  The entry cannot contain any spaces.

• Internet links:  Enter the entire link. For example:

http://www.apple.com

• File links:  To view a file you have placed in a folder on the DVD, enter:

file:///DVDName/FolderName/FileName

where DVDName is the name of the disc entered in the Disc Inspector, FolderName is 
the folder the file will be in on the DVD, and FileName is the file (the name may 
include an extension such as .pdf or .jpg).

Note:  The file path information is case-sensitive. Be sure you enter it exactly right.

Important:  Filenames and paths using double-byte characters may not work 
correctly on systems configured for single-byte characters.

• Email links:  Enter the email link as:

mailto:yourname@yourplace.com

Testing DVD@CCESS Links
It is important to test the DVD@CCESS links you add to your project before committing 
the title to replication. The Simulator and the Apple DVD Player application can test 
most DVD@CCESS functionality. 

Using the Simulator
You can use the Simulator to test DVD@CCESS links that rely on Internet access or 
email; you can also see the text of each link when it is reached during playback in the 
Simulator’s information drawer. 

The Simulator pane in DVD Studio Pro Preferences contains a setting that allows the 
Simulator to process DVD@CCESS links. See “Simulator Preferences” on page 122 for 
more information.

Using the Apple DVD Player
You can use the Apple DVD Player application to test DVD@CCESS links that rely on 
Internet access or email. You must first build your project, creating the VIDEO_TS folder 
that DVD Player can open and play.

Note:  Be sure to select Enable DVD@CCESS Web Links in the Disc tab of 
DVD Player Preferences.
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Testing DVD@CCESS Links to Files With the Apple DVD Player
Since the files you intend to include on the DVD for access by DVD@CCESS links are not 
in their actual locations until you create the DVD, you cannot test these links as easily 
as the others with the Apple DVD Player.

To test DVD@CCESS links that rely on opening files located on the DVD, you can either:

• Build and format the title and burn it to a disc. You can then test the disc on a variety 
of computers to verify that the links work as expected.

• Build and format the title and write it as a disk image to your hard disk. The disk image 
contains the specified DVD-ROM content in addition to the VIDEO_TS and AUDIO_TS 
folders. Using the Apple DVD Player, you can play the disk image as if it were a burned 
DVD, and the DVD@CCESS links that rely on the DVD-ROM files can be tested.

Configuring Computers for DVD@CCESS Playback
Any DVD discs burned by DVD Studio Pro that include DVD@CCESS links also include 
an Installer for a small program that allows Windows computers to process the links. 
This program needs to be installed only once on a computer—it is not specific to that 
DVD title and will work with all DVD titles that use DVD@CCESS.

The Installer is located on the DVD in the DVD@CCESS folder, along with installation 
instructions.

Macintosh Computers
In the Apple DVD Player version 2.4 and later, DVD@CCESS playback functionality is 
built in.

When using version 2.4 or later of the Apple DVD Player, you need to configure it to 
process the links. Select Enable DVD@CCESS Web Links in the Disc tab in DVD 
Player Preferences.

Windows Computers
The DVD@CCESS Installer for Windows installs a program that works with most DVD 
player applications and Windows computers to process the DVD@CCESS links in the 
DVD title. See DVD Studio Pro Late-Breaking News, accessible through DVD Studio Pro 
Help, for specific information on known issues.

Including the DVD@CCESS Installer With a DVD
The DVD@CCESS Installer is automatically added to a DVD when you burn it directly 
from DVD Studio Pro. 

When you need to burn your DVD using another method, the Installer is not 
automatically added. You can manually add the Installer to the disc by copying it from 
the DVD Studio Pro application package.
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Important:  Be very careful when working within the DVD Studio Pro package. You can 
easily corrupt the data, lose custom settings, and be forced to reinstall DVD Studio Pro. 
This procedure should only be followed if you understand the concept of opening an 
application’s package and working within it.

To copy the DVD@CCESS Installer manually:
1 Locate the DVD Studio Pro application icon in your computer’s Applications folder. 

(This is the default location; the application may be located elsewhere depending on 
how it was installed.)

2 Control-click the icon, then choose Show Package Contents from the shortcut menu. 

The package opens in a Finder window.

3 Open the Contents folder, then the Resources folder. The DVDccess folder is in the 
Resources folder.

4 Copy the DVDccess folder to your desktop by holding down the Option key and 
dragging. This leaves the original in place and makes a copy you can add to your DVD.

5 Close the package’s Finder window.

User Operations
You can disable various viewer operations in menus, tracks, stories, and markers. For 
example, you may want to prevent the viewer from skipping through the FBI warning. 

By providing this ability for individual menus, tracks, stories, and markers, DVD Studio Pro 
allows you to be very specific about which elements have disabled operations. 

Setting User Operations
To disable specific viewer controls for a menu, track, story, or marker, use the user 
operations settings.

Note:  Selecting an item in the User Operations tab disables that item. Selecting an item 
does not enable it.

To set user operations:
1 Select the element you want to work with to display its properties in the Inspector.

2 Click the User Operations tab in the Track, Marker, or Story Inspector or the Advanced 
tab in the Menu Inspector.
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3 Select each item you want to disable. See “User Operations Properties,” next, for a 
description of all the items.

You can also click Disable All to disable all items. You can then deselect any items to 
enable them. The Enable All button enables all items.

When working with markers, you can also select Same as Track. This allows you to 
customize just those markers that require it. 

User Operations Properties
The user operations are broken into four groups:  Playback Control, Stream Selection, 
Menu Call, and Button. The following sections describe what happens when you select 
each item.

Select to disable
all items in a group.

Indicates some items in
the group are selected.

Click the triangles to show 
or hide each group’s items.
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Playback Control
• Title Play:  Available only in tracks, menus, and stories. Prevents jumping to a different 

title by entering a title number using a DVD player remote control.
• PPT Search/PTT Play:  Available only in tracks. Prevents jumping to or playing from a 

new chapter marker by using a remote control’s numeric keypad. PTT stands for part 
of title and corresponds to track sections defined by markers.

• Time Search/Time Play:  Available only in tracks. Prevents jumping to or playing from a 
new time by using a remote control’s numeric keypad.

• Stop:  Available in tracks, menus, stories, and markers. Prevents stopping movie 
playback before the end of the movie while a selected menu is displayed or until the 
next track, marker, or story is reached.

• Resume:  Available only in menus. Prevents resuming movie playback while a selected 
menu is displayed or until the next track, marker, or story is reached.

• Time/PTT Search:  Available only in tracks and markers. Prevents locating specific 
points in a video stream by entering an exact time. 

• Still Off:  Available in tracks, menus, stories, and markers. By default, disabled in 
menus. Disables the ability to prevent a still image from stopping in a slideshow. In 
other words, allows a still image to be paused.

• Pause On/Off:  Available in tracks, menus, stories, and markers. By default, disabled in 
menus. Disables the pause on/off function during track playback until the next track, 
marker, or story is reached.

• Forward Scan:  Available in tracks, menus, stories, and markers. By default, disabled in 
menus. Prevents scanning forward through the disc.

• Backward Scan:  Available in tracks, menus, stories, and markers. By default, disabled 
in menus. Prevents scanning backward through the disc.

• Next Program:  Available in tracks, menus, stories, and markers. By default, disabled in 
menus. Prevents skipping forward through chapters.

• Previous Program:  Available in tracks, menus, stories, and markers. By default, 
disabled in menus. Prevents skipping backward through chapters.

• Go Up:  Available only in menus. Prevents using the Return button on a remote control.
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Stream Selection
All items available in tracks, menus, stories, and markers. 

• Audio Stream Change:  Prevents changing to an alternate audio track during movie 
playback until the next track, marker, or story is reached.

• Subpicture Stream Change:  Prevents viewing an alternate subpicture stream (another 
name for the subtitle stream).

• Angle Change:  Prevents viewing different camera angles of the same material.
• Video Presentation Mode Change:  Prevents switching between 4:3 and 16:9 aspect 

ratios or switching between pan-scan and letterbox presentations.

Menu Call
All items available in tracks, menus, stories, and markers. 

• Root Menu (DVD Menu):  Prevents using the Menu button on a remote control to 
access a DVD menu that you have previously set up in the Connections tab.

• Title Menu:  Prevents using the Title button on a remote control to access a DVD 
menu that you have previously set up in the Connections tab.

• Subpicture Menu:  Prevents accessing the subtitle menu during movie playback.
• Audio Menu:  Prevents accessing the audio menu during movie playback.
• Angle Menu:  Prevents accessing the angle menu during movie playback.
• Chapter Menu:  Prevents accessing the chapter menu during movie playback.

Button

Selection/Activation:  Available only in tracks, menus, and stories. Prevents selecting and 
activating button highlight areas.
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Getting Consistent Previous and Next Button Behavior
The action that happens when a viewer uses the Previous or Next button to skip 
through chapter markers on a track and reaches the first or last marker can vary, 
depending on the DVD player. For example, if the viewer is at the last marker in a track 
and presses the Next button one more time, different DVD players will do different 
things. There are two common approaches that DVD players take:
• The viewer is constrained to that track, and the Previous or Next button (depending on 

whether you have reached the first or last marker, respectively) is disabled.
• The viewer is not constrained to that track, and the DVD player jumps to the previous 

or next track (which could also be a story or slideshow) and allows the viewer to 
continue skipping through that track’s markers. 

You can use user operations to force consistent behavior in these situations, ensuring 
that the viewer has the same experience regardless of which player they are using.

To ensure consistent Previous and Next button behavior:
1 Select a track in either the Outline or Graphical tab, or in the Track Editor.

2 Select the first marker in the Track Editor.

The Marker Inspector appears, displaying that marker’s properties.

3 Click the User Operations tab.

4 Select the Previous Program checkbox. 

This disables the remote control’s Previous button for this marker, which prevents the 
viewer from skipping to a marker on a different track.

5 Select the last marker in the track.

The Marker Inspector now displays that marker’s properties.

6 Click the User Operations tab.

7 Select the Next Program checkbox. 

This disables the remote control’s Next button for this marker, which prevents the 
viewer from skipping to a marker on a different track.

Note:  The same issue can occur with slideshows; however, you cannot correct it unless 
you convert the slideshow to a track.
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Display Condition 
The menus, tracks, and stories within DVD Studio Pro can have a display condition 
applied to them that determines whether they appear, and if not, what should appear 
instead. For example, based on the DVD player’s parental control setting, the condition 
can determine whether to play the current story or a story that is better suited to the 
parental setting. Or, you can choose to show or not show a menu based on the 
language setting.

By assigning a pre-script to the element or running a script before it is selected, you 
can include settings in the General Purpose Register Memories (GPRMs) as part of the 
condition. See “Scripting Overview” on page 469 for information on setting up scripts.

Comparing Display Conditions and Pre-Scripts
All three elements (menus, tracks, and stories) that can have display conditions can also 
have pre-scripts. Pre-scripts are scripts that are assigned to an element. They can do 
everything a display condition can do and more. There are some specific differences to 
be aware of:
• When an element has both a pre-script and a display condition, the pre-script 

executes first.
• Pre-scripts only execute if you have jumped to the root of the element they are 

assigned to, either by choosing the element’s name in the Connections tab or the 
name in square brackets in the shortcut menus. If you connect directly to a marker, 
slide, or menu button, the pre-script will not run. Display conditions, however, run 
any time the element it is assigned to is jumped to, whether you jump to its root or 
to a specific marker, slide, or button.

• On the DVD, pre-scripts are automatically placed with all other scripts in the VTS 1 file 
group. This can cause slight delays when executing them since the DVD player may 
have to jump significant distances to get to and from the script. Display conditions 
reside in the same file groups as the element they are assigned to, which makes 
them more efficient when playing.

Note:  You can use the VTS Editor to manually place pre-scripts in the same VTS block 
as the element it is assigned to. See “VTS Editor” on page 588 for more information.
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Display Condition Parameters
There are four parameters you need to configure when setting up a display condition:

• The conditional element:  You choose what is to be evaluated to determine whether 
the menu, track, or story should be displayed. Examples of what you can choose 
include the DVD player’s parental setting, region code, aspect ratio, or the contents 
of a GPRM.

Note:  Display conditions can only use full 16-bit GPRMs.

• The conditional relationship:  You choose the operation to use to determine the 
relationship between the conditional element and the conditional state. Example 
settings include smaller, greater, and equal.

• The conditional state selection:  You choose the state of the conditional element. The 
choices depend on the conditional element. For example, the states for the parental 
setting element are the eight possible rating settings (G, PG, and so on).

• The alternative target selection:  You choose the project element (menu, track, story, 
and so on) that should be displayed if the condition is not satisfied.

Important:  You must set all four parameters or else errors will occur during the 
build process.

Setting Up a Display Condition
You need to set four parameters to create a display condition.

To set up a display condition:
1 Choose the element (menu, track, or story) to set up a display condition for.

2 Do one of the following:

• If you are setting up a menu, click the Advanced tab in the Menu Inspector. 
• If you are setting up a track or story, click the General tab in the Track or Story Inspector.

3 Select the Display Condition checkbox.

4 Choose the conditional element (the first parameter—defines what the condition is to 
be based on). For a list of conditional elements you can use, see “Conditional Elements 
and States” on page 606.

Choose the conditional state.
Choose the alternative element.

Choose the conditional element.

Choose the conditional 
relationship.

Select to enable display
conditions for this

element.
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5 Choose the conditional relationship (the second parameter—determines how the 
conditional element is to be compared with the conditional state, set in the next step). 
For a list of conditional relationships, see “Conditional Relationships” on page 607.

6 Choose the conditional element’s state (the third parameter—defines the state that the 
conditional element is to be compared to). See “Conditional Elements and States” on 
page 606 for the states you can choose for each element.

7 Choose the Alternate Target element (the fourth parameter—defines what happens if 
the condition is not met).

To turn off the display condition, select the Display Condition checkbox to remove 
the checkmark.

Stories can have their own display conditions, or you can use the track’s settings by 
selecting Apply to Stories in the Track Inspector’s General tab.

Example:  Setting a Parental Management Display Condition
For this example, you have a movie with an R rating, and have created a story from it 
that removes enough objectionable material to make it suitable for a PG-13 rating.

When the viewer selects the button to play the movie’s track, you want to check the 
DVD player’s parental management setting to see if it can play an R-rated movie. If not, 
you want it to jump to the story and play the PG-13 version of the movie.

To configure a parental management display condition for a track:
1 Choose the track containing the R-rated movie.

2 Click the General tab in the Track Inspector.

3 Select the Display Condition checkbox.

4 Choose Parental Level from the conditional element pop-up menu.

5 Choose  > = (greater or equal) from the conditional relationship pop-up menu.

6 Choose 6 - R from the conditional state pop-up menu.

7 Choose the story that you want to use as the alternative to this track from the Alternate 
Target pop-up menu.

With this display condition, the parental level of the DVD player is checked to see if it is 
set at the R rating or higher. If it is, the track plays. If not, the player jumps to the story 
and it is played. The story could have a similar display condition to determine whether 
its PG-13 version of the movie can play.
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Conditional Elements and States
The conditional elements are based on settings read from the System Parameter 
Register Memories (SPRMs) or the General Purpose Register Memories (GPRMs). 

The conditional states are determined by the element. For example, the menu language 
element has all supported languages as the possible states. If the state is a numeric entry, 
you need to enter a decimal-based number (binary and hex numbers are not supported). 

• Menu Language:  Use to set up a condition based on the DVD player’s menu 
language setting (SPRM 0). The states include all supported languages.

• Audio Language:  Use to set up a condition based on the DVD player’s audio 
language setting (SPRM 16). The states include all supported languages.

• Subtitle Language:  Use to set up a condition based on the DVD player’s subtitle 
language setting (SPRM 18). The states include all supported languages.

• Audio Stream Number:  Use to set up a condition based on the currently selected 
audio stream (SPRM 1). The states include audio stream numbers 1 through 8. “Not 
set” appears next to any streams that currently have no assets assigned.

• Subtitle Stream Number:  Use to set up a condition based on the currently selected 
subtitle stream (SPRM 2). The states include subtitle stream numbers 1 through 32. 
“Not set” appears next to any streams that currently have no subtitles assigned.

• Player Aspect Ratio:  Use to set up a condition based on the DVD player’s aspect ratio 
setting (4:3 or 16:9—bits 8 and 9 of SPRM 14). The states include 4:3, 16:9 Pan-Scan, 
16:9 Letterbox, and 16:9 Pan-Scan and Letterbox.

• Last Track Played:  Use to set up a condition based on the most recently played track 
(SPRM 4). The states include all track numbers in the project. 

• Last Chapter Played:  Use to set up a condition based on the most recently played 
chapter (SPRM 7). The states include all chapter marker numbers in the track. 

• Last Button Selected:  Use to set up a condition based on the most recently selected 
button (SPRM 8). The states include numbers 1 through 36.

• Player Region Code:  Use to set up a condition based on the DVD player’s region 
setting (SPRM 20). The states include all eight regions.

• Parental Level:  Use to set up a condition based on the DVD player’s parental level 
setting (SPRM 13). The states include all eight parental levels plus a Not Rated setting.

• Video Player Config:  Use to set up a condition based on the DVD player’s aspect ratio 
setting (4:3 or 16:9) and display mode (letterbox or pan-scan) (SPRM 14). The state 
requires a decimal number entry.

• Audio Player Config:  Use to set up a condition based on the DVD player’s audio 
configuration—PCM, AC-3, and MPEG (SPRM 15). The state requires a decimal 
number entry.

• GPRM 0 - 7:  Use to set up a condition based on the values stored in one of the eight 
GPRM locations. The values must first be placed into the GPRM by a separate script 
that you have run. The state requires a decimal number entry.

Note:  Display conditions can only use full 16-bit GPRMs.
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See “Scripting Overview” on page 469 for details on scripts, GPRMs, and SPRMs.

Conditional Relationships
There are seven conditional relationships for you to choose from when setting up your 
display condition.

• = (equal):  The element and state are exactly equal. For example, if you choose the 
Player Region Code element, a state of 1-USA, and the “equal” relationship, you can 
only play the track if the DVD player is set for region 1-USA.

• != (not equal):  The element and state are not exactly equal. For example, if you 
choose the Audio Language element, a state of French, and the “not equal” 
relationship, you can play the track as long as the DVD player is not set for French. 

•  > = (greater or equal):  The element is either greater than the state, or they are equal. 
For example, if you choose the Parental Level element, a state of PG-13, and “greater 
or equal,” you can play the track as long as the DVD player is set to PG-13 or higher 
(R or NC-17).

•  >  (greater):  The element is greater than the state. For example, if you choose the 
Audio Stream Number element, a state of 2, and “greater,” you can play the track as 
long as one of the two first audio streams is not selected.

• <= (smaller or equal):  The element is either less than the state, or they are equal. For 
example, if you choose the Last Track Played element, set the state to 12, and “smaller 
or equal,” you can play this track as long as the previous track is from 1 to 12.

• < (smaller):  The element is less than the state. For example, if you choose the Subtitle 
Stream Number element, set the state to 4, and “smaller,” you can play this track as 
long as subtitle streams 1 through 3 are selected.

• & (and):  Provides a binary bit-wise “and” function. Several of the elements contain 
multiple settings. You can use the “and” relationship to extract one setting from the 
element. For example, if you choose the Audio Player Config element (which 
contains several settings related to the DVD player’s audio capabilities), a state of 
2048-DTS, and the “and” relationship, you can only play the track if bit 11 of the 16-bit 
byte is one, indicating that the DVD player supports DTS audio. See “Using Bit-Wise 
Operations” on page 503 for details on using a bit-wise “and” function.
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Issues With Display Conditions
There are several issues with using display conditions that you should be aware of:
• The Last Chapter Played setting is reliable only when assigned to menus. When using the 

Last Chapter Played setting for display conditions assigned to a track or story, you 
get unreliable playback on some DVD players. The Last Chapter Played setting can be 
used reliably with display conditions assigned to menus.

• Display Conditions using the subtitle stream number only work with the subtitle stream 
set to View. When you configure a display condition for a track or story that uses the 
subtitle stream number option, the display condition works correctly only if the 
subtitle stream is set to be viewed. For example, if you configure a menu’s button to 
use subtitle stream S1 and a track has a display condition configured for subtitle 
stream S1, the display condition only works correctly if you also select the subtitle 
stream’s View checkbox in the Button Inspector. 

• Some DVD players do not allow parental level in display conditions. Some DVD players 
do not process the parental level option correctly when used in a display condition, 
allowing content to play that should be disallowed. 

Remote Control Settings
An important part of authoring a DVD title is to assign functions to the DVD player’s 
remote control buttons. For most projects, you will set these functions for the entire 
disc. However, you can override several of the disc settings for individual tracks, stories, 
markers, slideshows, and menus. 

If an individual element has more than one remote control setting:

• Track, slideshow, story, and menu settings take precedence over disc settings while 
they play. 

• Marker settings override all other settings while that part of the track or story plays. 

Note:  All of these settings can also all be made in the Connections tab.
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Remote Control Buttons
The disc’s remote control settings support seven buttons. Remote control settings for 
tracks, stories, markers, slideshows, and menus support only certain ones:
• Title:  Supported by the disc settings only. This button is typically linked to the 

primary menu so that, no matter where the viewers are in the title, when they press 
the Title button they will always go to the same place.

• Menu:  Supported by all elements that can set remote control settings (disc, track, 
story, marker, and slideshow) except menus. You should generally link this button to 
the last menu viewed.

• Angle:  Supported by the disc, track, and slideshow elements. You can link this button 
to a menu that allows the viewer to select the angle to view. 

• Chapter:  Supported by the disc, track, and slideshow elements. Typically found only 
on specialized DVD players, you can link this button to a menu that allows the viewer 
to select the chapter to view. 

• Audio:  Supported by the disc, track, and slideshow elements. You can link the Audio 
button to a menu that allows the viewer to select the audio stream to listen to. 

• Subtitle:  Supported by the disc, track, and slideshow elements. You can link this 
button to a menu that allows the viewer to select whether subtitles appear and the 
subtitle stream to view. 

• Return:  Supported by the disc and menu settings only. The Return button is usually 
used to provide an easy way for the viewer to navigate back through nested menus. 

Beware of Similar-Sounding Buttons
The remote controls of most DVD players include stream select buttons labeled 
Angle, Audio, and Subtitle. These are not the same as the remote control buttons you 
can assign menus to. These three buttons allow the viewer to directly select the 
angle, audio, and subtitle stream without going to a menu first.

The Angle, Chapter, Audio, and Subtitle remote control buttons that you can assign 
menus to are in addition to these three stream select buttons, and are found only on 
a few remote controls, typically grouped in a “Menus” section of the remote control.

It is important to include alternative methods for viewers to get to these menus. You 
cannot count on all remote controls to have these buttons.
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Configuring the Remote Control Buttons
You can configure the remote control buttons either in the Inspector or in the 
Connections tab. 

To set the remote control buttons using the Inspector:
1 Select the element whose remote control buttons you want to set. You can select the 

element in the Outline tab, the Graphical tab, or use the pop-up menu in the 
appropriate editor.

2 In the Inspector, open the pop-up menu for the button to be set, then choose the 
function to link to. All elements currently set in the project are available to be linked to.

The remote control settings are in different Inspector locations for different elements:

• Disc Inspector:  The commonly used remote control settings (Title, Menu, and Return) 
are in the General tab. The Advanced tab contains the settings that are not often 
used (Angle, Chapter, Audio, and Subtitle).

• Track, Story, and Marker Inspectors:  All remote control settings are in their General tabs.
• Slideshow and Story Marker Inspectors:  All remote control settings are in its main area 

(there are no tabs).
• Menu Inspector:  Its only remote control setting (Return) is in its Menu tab.

To set the remote control buttons using the Connections tab:
1 Click the Connections tab. You can see all source elements in the project together, or 

see one element at a time:

• To see the remote control buttons for all project elements at once, select the disc in the 
Outline tab or click an empty area in the Graphical tab.

• To see the remote control buttons for a single element, select that element in the 
Outline tab, the Graphical tab, or use the pop-up menu in the appropriate editor.

2 Use the View pop-up menu in the Connections tab to control which of the remote 
buttons are visible:

• Basic:  Shows the disc’s title button, and the track’s, story’s, and slideshow’s menu buttons. 
• Standard:  Shows all basic buttons plus menu buttons for a track’s markers.
• Advanced:  Shows all possible remote buttons.

3 Set the link for the remote button by either dragging the target to the source element 
or Control-clicking the button’s setting in the Target column, and choosing the element 
to link to from the shortcut menu.
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Line 21 Settings for Closed Captions
To add text to a video on a DVD, most users use the subtitle feature. To meet 
accessibility requirements, however, you may also need to consider closed captions. 

Note:  The Line 21 settings apply only to NTSC SD DVD projects.

About Subtitles and Closed Captions
Subtitles have several advantages:  You can create them within DVD Studio Pro or using 
a third-party subtitle authoring application, you can set their font and color, and they 
can be displayed by any DVD player. Closed captions offer other advantages.

Subtitles generally provide a text version of the dialogue only—they do not describe 
any other sounds that may be in the title (such as a dog barking or a phone ringing). 
Closed captions typically include descriptive text along with the dialogue, which makes 
them better suited for viewers with impaired hearing. 

You can add descriptive text to subtitles and make them more similar to the content of 
closed captions, and there are third-party programs that will convert closed captions to 
a suitable subtitle format.

Closed captions require a decoder for playback. The decoder can be built in to the 
television or it can be a standalone box. Computers typically do not have closed 
caption decoders, so they cannot display captions. The font used by closed captions is 
determined by the decoder.

Adding Closed Captions to a DVD
With DVD Studio Pro, you can import closed caption files as part of a track. This is the 
most reliable way to include closed captions with your title. 

Do not assume that just because the closed-captioning information was present in the 
video during the MPEG encode that it will be available when the disc is played by the 
viewer. Be sure to perform a test before relying on this method of adding closed 
captions to your title.

Some MPEG encoders can create separate closed caption files that DVD Studio Pro can 
use to add the function to your disc.

DVD Studio Pro supports closed caption files in the “.cc” and “.scc” formats.
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About the Field 1 and Field 2 Settings
The closed caption standard provides for encoding up to four caption streams in Line 
21. The two most commonly used streams (C1 and C2) use field 1, and the other two 
streams (C3 and C4) use field 2. 

A closed caption file assigned to a track in DVD Studio Pro can have captions only in 
field 1 (C1 and C2) or in both fields (support for all four streams). It is important for you 
to configure the track’s Line 21 settings to match the file’s configuration. 

Note:  Since the C3 and C4 streams are rarely used, you may assume the closed caption 
file contains only the C1 and C2 streams, and only supports field 1. Be sure to verify this 
with a test disc and a DVD player connected to a television monitor before sending 
your disc to a replicator.

To assign a closed caption file to a track:
1 Select the track so that it appears in the Track Editor and its properties appear in 

the Inspector.

2 Click the Other tab in the Track Inspector.

3 To choose the closed caption file, do one of the following:

• In the Closed Caption (Line 21) area, click Choose. In the navigation dialog, locate and 
select the closed caption file to assign to this track. Click Choose.

• Control-click in the Track Editor’s video stream, then choose Import Line 21 File from the 
shortcut menu. Locate the closed caption file in the navigation dialog and click Import.

4 Select the Field 1 and Field 2 boxes to match the configuration of the caption file.

Note:  Most often you should select Field 1 and leave Field 2 unselected.

You can only assign one file to a track.
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AA Keyboard Shortcuts

Using keyboard shortcuts can make working with DVD Studio Pro even easier. The 
following tables group the keyboard shortcuts by function.

Note:  Some keyboard shortcuts are always active, whether or not you are working in 
the group that they are listed in. Other keyboard shortcuts are only active under 
special circumstances.

General Interface and Application Controls

Key command Function

Opens the first 15 interface configurations. (Note that F9, F10, and 
F11 may be used by Mac OS X for the Exposé feature, and F14 and 
F15 may be used to control the monitor’s brightness.)

Accesses the Viewer tab.1

Accesses the Assets tab.1

Accesses the Connections tab.1

Accesses the Log tab.1

Accesses the Menu tab.1

Accesses the Outline tab.1

Accesses the Graphical tab.1

Accesses the Script tab.1

Accesses the Slideshow tab.1

Accesses the Story tab.1

F1 F15

+ 0x

+ 1x

+ 2x

+ 3x

+ 4x

+ 5x

+ +xoption 5

+ 6x

+ 7x

+ 8x
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Accesses the Track tab.1

or

(left quote, on the same key as 
the tilde)

Toggles the currently selected tab between full window and 
normal. Additionally, holding the Shift and Space bar keys down 
toggles the tab only until you release them.

Shows or hides the Palette.

Shows or hides the Inspector.

Opens or closes the Font panel.

Opens or closes the Colors window.

Opens Preferences.

Opens DVD Studio Pro Help.

Quits DVD Studio Pro.

Minimizes DVD Studio Pro.

Hides DVD Studio Pro.

1These tabs are brought to the front of their quadrant or, if in their own window, they are brought to the front of the 
application. If the tab is closed, it is opened as a window at its last position.

Key command Function

+ 9x

+shift space

+ xoption +

+ xoption + P

+ xoption + I

+ Tx

+shift + Cx

+ ,x

+shift + ?x

+ Qx

+ Mx

+ Hx
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General Project Controls

Key command Function

Undoes the last change.

Redoes a change you just undid.

Creates a new project.

Opens an existing project.

Closes the project.

Saves the project.

Saves a project as a new project.

Copies the selected text, menu item, script command line, or 
subtitle button to the Clipboard.1

 
Copies the selected text, menu item, script command line, or 
subtitle button to the Clipboard and deletes it from selection.1

 
Pastes the Clipboard contents.1

Duplicates the selected item.

Simulates a project from the current element or, if none are 
selected, from the project’s First Play setting.

Burns the project.

Builds the project.

Formats the project.

Builds and formats the project.

1These shortcuts work with both text in your menus and subtitles and element names.

+ Zx

+shift + Zx

+ Nx

+ Ox

+ Wx

+ Sx

+shift + Sx

+ Cx

+ Xx

+ Vx

+ Dx

+ xoption + 0

+ xoption + B

+ xoption + C

+ Fx

+ xoption + F
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Adding Project Elements

Scrolling Through Lists

Key command Function

Adds a track.

Adds a story.

Adds a standard menu.

Adds a layered menu.

Adds a slideshow.

Adds a script.

Adds a menu language.

+ + Txcontrol

+shift + Tx

+ Yx

+shift + Yx

+ Kx

+ 'x

+ /x

Key command Function

Drag scroller Scrolls through the list.

drag scroller

Scrolls slowly through the list (useful for large lists).

Selects the previous line in the list.

Selects the next line in the list.

Selects the previous line in the list, leaving the current line 
selected.

Selects the next line in the list, leaving the current line selected.

Goes to the top of the list.

Goes to the bottom of the list.

option +

+shift

+shift

option +

option +
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Note:  Lists in DVD Studio Pro are found in the Assets, Log, Outline, Connections, 
Slideshow, Script, and Story tabs.

Assets Tab

or 

click scroller’s up arrow

Scrolls up one page in the list.

or 

click scroller’s down arrow

Scrolls down one page in the list.

Key command Function

page
up

option +

page
down

option +

Key command Function

Double-click empty area, or Imports an asset.

Double-click asset name, or Previews the selected asset.

Selects all assets and folders.

Deselects all assets and folders.

Removes the selected asset.

Creates a new folder.

Shows the encoder settings for the selected QuickTime movie.

drag

Does the opposite of the “Find matching audio when dragging” 
preference, used when you drag a video asset to a project element. 
You must start dragging the video asset before pressing the 
Command key.

+shift + Ix

space

+ Ax

+shift + Ax

delete

+shift + Nx

+ Ex

+x
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Connections Tab

Graphical Tab

Key command Function

or

Scrolls through items in the list not currently selected.

Double-click, or Connects or disconnects the currently selected items.

Disconnects the selected source’s connection.

Connects the selected source to the selected target and moves 
down to the next source or target (whichever was last selected).

Drag Copies a source’s target setting to another source.

 

click separator

Switches between horizontal and vertical views.

control +

control +

return

delete

enter

control +

Key command Function

Fits the tiles to the current window size.

Zooms one step in while maintaining the current center.

Zooms one step out while maintaining the current center.

click in window

Zooms one step into the area you click.

click in window

Zooms out one step from the area you click.

drag

Zooms into the selected area.

drag

Repositions the tile area in the window.

Toggles macro view on and off. Additionally, you can hold the key 
down to temporarily show the macro view.

shift + Z

+x

+x

Z +

option + +Z

Z +

space +

M
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Log Tab

Toggles a tile’s flag on and off.

Click tile Selects the tile. Deselects any currently selected tiles first.

click tile or

click tile

Selects the tile. Retains any currently selected tiles.

Selects all tiles.

Deselects all tiles.

, , ,
Moves the selected tiles.

Drag tile, then press Temporarily zooms out to show more of the tile area.

Toggles the tile position lock on and off.

Prints the Graphical tab.

Key command Function

F

+shift

+x

+ Ax

+shift + Ax

or

Z

L

+ Px

Key command Function

Copies the selected text.

Selects all text.

+ Cx

+ Ax
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Menu Tab (Menu Editor)

Key command Function

 

drag or 

Creates a duplicate of the selected item.

Click and drag Creates a button.

 

click and drag

Creates a drop zone.

 

click and drag

Selects multiple items. Deselects any currently selected items first.

 

click and drag

Selects multiple items. Retains any currently selected items.

Selects all menu items.

Deselects all menu items.

Double-click, or

 

click and drag

Creates a text object.

Applies a bold attribute to the selected text.

Applies an italic attribute to the selected text.

Adds an underline to the selected text.

Left aligns the selected text.

Center aligns the selected text.

Right aligns the selected text.

 

while typing text

Creates a new line. Applies to button text and text objects.

 

while typing text

While typing text into the Menu Editor, exits text entry mode. While 
typing text in the Button or Text Object Inspector, creates a new 
line.

option +

+ Dx

option +

+x

+ +shift x

+ Ax

+shift + Ax

+ +xoption

+ Bx

+ Ix

+ Ux

+shift + [x

+shift +x \

+shift + ]x

return

enter
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Deletes the selected item.

 

drag

Repositions an asset in a drop zone or button (if possible).

 

click and drag

Forces a button or drop zone to match its asset’s aspect ratio, and 
maintains that aspect ratio while being resized.

, , ,
Moves the selected item 1 pixel.

, ,

,

Moves the selected item 10 pixels.

, ,

,

Moves the selected item 20 pixels.

Creates a submenu.

Creates a slideshow.

Creates a track.

click and drag button’s edge

Sets button navigation when you drag from a button’s edge to 
another button.

Performs a one-time Auto Assign button navigation pass.

Sends the selected item to the back.

Sends the selected item backward one step in priority.

Brings the selected item forward one step in priority.

Brings the selected item to the front.

 

drag

Constrains the movement of an item to the vertical or horizontal 
direction only.

Key command Function

delete

+ +shift option

+shift

or

+shift

or

+ +shift option

or

+ xoption + Y

+ xoption + K

+ xoption + T

+ +xoption

+shift + Dx

+shift + Bx

+ [x

+ ]x

+shift + Fx

+shift
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Outline Tab

 

drag

Duplicates the selected item and constrains its movement to the 
vertical or horizontal direction only. You must wait to press Shift 
until you have started dragging the item.

 

drag item

Moves the selected item without snapping or showing the 
dynamic guides.

 

drag button’s edge to resize

Changes the item size based on its center. (You must wait to press 
the Option key until after you start dragging.)

Shows or hides rulers.

Shows or hides alignment guides.

Toggles the button state through normal, selected, and activated.

Toggles the background view through background only, overlay 
only, and composite.

Toggles the pixel display between square and rectangular.

Shows and hides the title safe area.

Shows the action safe area.

or

 

Toggles menu motion on and off.

Key command Function

+ +shift option

+x

option +

+ Rx

+ ;x

W

Q

P

+shift + Ex

+ xoption + E

space

+ Jx

Key command Function

 

click track disclosure triangle

Opens all disclosure triangles in the track area.

Selects all items.

Deselects all items.

Duplicates the selected item.

option +

+ Ax

+shift + Ax

+ Dx
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Palette

Script Tab (Script Editor)

Simulator

Key command Function

in a media tab

Removes the selected folder from the list.

in a Template, Style, or Shape tab

Deletes the selected item from your system’s hard disk.

Selects all items in the current view.

Deselects all items in the current view.

 

or double-click

Applies the selected item to the menu (templates, styles, and 
shapes, if applicable).

 

drag

Does the opposite of the “Find matching audio when dragging” 
preference, used when you drag a video asset to a project element. 
You must start dragging the video asset before pressing the 
Command key.

delete

delete

+ Ax

+shift + Ax

return

+x

Key command Function

Inserts a new command line.

Adds a new command line to the end of the script.

Deletes the current command line.

Selects all command lines.

+shift +x

+x

delete

+ Ax

Key command Function

, , ,
Provides the up, down, left, and right button navigation arrow 
function.

Activates the selected button.

Shows or hides the information drawer on the left/right edges.

or

return

+shift I
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Slideshow Tab (Slideshow Editor)

Story Tab (Story Editor)

Shows or hides the information drawer on the top/bottom edges.

Closes the Simulator.

Key command Function

+ +shift option I

+ Wx

Key command Function

Shows large thumbnails.

Shows small thumbnails.

Selects all slides.

 

or

Plays slideshow in Viewer tab or, if playing, stops and returns to the 
slide it started from.

Plays slideshow in Viewer tab, or if playing, pauses playback.

+x

+x

+ Ax

space

K

L

Key command Function

Selects all markers in the list.

 

or

Plays story in Viewer tab or, if playing, stops and returns to the 
story entry it started from.

Plays story in Viewer tab, or if playing, pauses playback.

+ Ax

space

K

L
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Subtitle Editor

Key command Function

 

while typing text

Creates a new line.

 

while typing text

While typing text into the Subtitle Editor, exits subtitle text entry 
mode. While typing text in the Subtitle Inspector, creates a new 
line.

Click and drag Creates a button.

 

click and drag or

Duplicates the selected button.

 

click and drag

Selects multiple buttons.

Selects the next subtitle.

Selects the previous subtitle.

 

click and drag button’s edge

Sets button navigation when you drag from a button’s edge to 
another button.

 

drag button’s edge to resize

Changes the button size based on its center. (You must wait to 
press the Option key until after you start dragging.)

 

while editing text

Selects all of the text.

Applies a bold attribute to the selected text.

Applies an italic attribute to the selected text.

Adds an underline to the selected text.

Left aligns the selected text.

Center aligns the selected text.

Right aligns the selected text.

return

enter

option +

+ Dx

+x

+x

+x

+ +xoption

option +

+ Ax

+ Bx

+ Ix

+ Ux

+shift + [x

+shift +x \

+shift + ]x
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Track Tab (Track Editor)

Key command Function

Plays track in Viewer tab or, if playing, stops or pauses playback 
(depending on the “Space bar toggles between play/pause” setting 
in DVD Studio Pro Preferences).
If you hold down the Space bar, playing automatically stops or 
pauses when you release it.

Plays track in Viewer tab or, if playing, pauses playback.

Stops playback and moves the playhead to where it started.

Moves the playhead to the beginning of the timeline.

or

Moves the playhead to the beginning of the selected clip.

Moves the playhead forward one frame.

Moves the playhead backward one frame.

Moves the playhead to the end of the timeline.

or

Moves the playhead to the end of the selected clip.

Moves the playhead one second earlier.

Moves the playhead one second later.

or

Moves the playhead to the previous marker.

or

Moves the playhead to the next marker.

space

L

K

home

+x

option + E

end

+x

shift + E

+shift

+shift

control +

option + M

control +

shift + M
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Moves the playhead to the previous GOP.

Moves the playhead to the next GOP.

Selects all clips in a stream.

Click and drag Moves the clip in the stream or to another stream.

 

click and drag

Creates a duplicate of the clip that can be placed in this or another 
stream.

 

click and drag

Creates a duplicate of the clip that can only be placed in another 
stream at exactly the same time or in any suitable place on the 
current stream.

Jumps playhead (forward or backward) to next timeline event 
(marker, clip edge, and so on).

Zooms the Track Editor timeline out to its maximum.

Fits current clip to the Track Editor.

Toggles through stream height settings.

Zooms the timeline in on the Track Editor, scrolling to show the 
playhead if necessary.

Zooms the timeline out on the Track Editor, scrolling to show the 
playhead if necessary. 

Zooms the timeline in on the Track Editor, ignoring the playhead 
position.

Zooms the timeline out on the Track Editor, ignoring the playhead 
position.

Locks or unlocks all streams.

or single-click above timeline

Creates a marker.

 

while playing

Creates a marker on the fly.

Removes the selected clip from the timeline.

Double-click in subtitle stream Adds a subtitle clip. 

Adds a subtitle at the playhead.

Key command Function

option +

option +

+ Ax

option +

+ +shift option

shift + Z

+ +shift option Z

shift + T

+x

+x

+shift +x

+shift +x

shift + F4

M

M

delete

shift +
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Viewer Tab
The Viewer tab keyboard shortcuts apply to those tabs in which an asset can play. 
These include the Assets, Track, Story, and Slideshow tabs.

Key command Function

Plays the video asset or, if playing, stops or pauses playback 
(depending on the “Space bar toggles between play/pause” setting 
in DVD Studio Pro Preferences).
If you hold down the Space bar, playing automatically stops or 
pauses when you release it.

Plays the video asset or, if playing, pauses playback.

Stop.

Frame step forward, or with slideshows, advance to the next slide.

Step one second forward (not applicable with slideshows).

Frame step backward, or with slideshows, go back to the previous 
slide.

Step one second backward (not applicable with slideshows). 

space

L

K

+shift

+shift
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BB Importing Other Projects

Using DVD Studio Pro 4, you can import projects created with iDVD and earlier versions 
of DVD Studio Pro. 

Importing iDVD Projects and Themes
DVD Studio Pro 4 can import projects from iDVD 3 and iDVD 4. You can import an iDVD 
theme by using the theme in a project within iDVD and importing the project into 
DVD Studio Pro. When creating the project within iDVD, you do not need to use the 
final assets or make a complete project. 

Note:  DVD Studio Pro will not import projects from iDVD 1, iDVD 2, and iDVD 5.

In general, iDVD needs to be installed on the same system as DVD Studio Pro. An 
exception is if you import an iDVD 4 archive project.

To import an iDVD project or archived project into DVD Studio Pro:
1 Do one of the following:

• Choose File > Open.
• Press Command-O.

2 Locate and select the iDVD project or iDVD 4 archive project in the Open dialog, then 
click Open.

DVD Studio Pro imports the iDVD project. 

About the iDVD Project Import
When DVD Studio Pro imports an iDVD 3 or iDVD 4 project or iDVD 4 archive project, it 
has standard locations it looks for to find the assets and themes used in the project. 
This is especially important if the project uses custom themes.



630 Appendix B    Importing Other Projects

 

The standard locations that DVD Studio Pro uses are (in this order):

• iDVD project bundle:  This is the file created when you save the project.
• [user]/Library/iDVD/Favorites:  This folder is located in your home folder.
• [root]/Library/iDVD/Favorites:  This folder is located at the root of your disk.
• /Network/Library/iDVD/Favorites:  This folder is on a network system specifically 

configured by your system administrator for this purpose. (This is not the same as 
having a server networked into your computer.)

• iDVD application bundle:  This is the iDVD application file that contains the default 
theme elements.

Note:  When you create an archive project in iDVD 4, you can choose to include the 
themes and encoded files. For the best portability, you should include both options. 
This results in a larger archive file, but ensures you can take the file to any 
DVD Studio Pro system and import it without missing assets. If you do not choose to 
include the themes and encoded files in the archive file, those assets must be available 
in one of the standard locations.

If your project will have automatically-created chapter index (scene selection) menus 
based on markers embedded in the video, it can be easier to create these within iDVD 
prior to importing the project into DVD Studio Pro. This ensures the chapter index 
menus use the selected theme’s background and include arrow buttons to navigate 
between the menus.

Important:  To ensure all iDVD menu elements import correctly into DVD Studio Pro, you 
must navigate to each chapter index menu within iDVD before saving the project. This is 
also true for any menus you add to your iDVD project by clicking the Folder button.

Issues With Importing iDVD Projects
There are some issues to be aware of when you import iDVD projects:
• If you import an iDVD project with DVD-ROM content, DVD Studio Pro does not update 

the settings in the Disc Inspector’s General tab to reflect the DVD-ROM content. You 
must manually select the DVD-ROM layout and choose the folder to include.

• When you create a slideshow in iDVD, you can add arrow buttons to each still to 
provide viewers with an additional method of jumping to the previous and next 
stills. These arrow buttons are not imported when you import an iDVD project into 
DVD Studio Pro. The viewer must use the Previous and Next buttons on the DVD 
player’s remote control to jump between stills. 

• The button highlights used in iDVD may look different when imported into 
DVD Studio Pro. In most cases, the text in the buttons is set to be included in the 
highlight. Additionally, buttons that use an underline in iDVD will not have an 
underline when imported into DVD Studio Pro.
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• When you import an iDVD project, you may find that the button that is highlighted by 
default on some menus changes. During the project import, DVD Studio Pro numbers 
the buttons on each menu and highlights button 1 by default. You can assign any 
button on a menu to be the default button in the Menu tab in the Menu Inspector.

• If you import an iDVD project that contains a drop zone configured as a slideshow 
and has multiple slides assigned to it, DVD Studio Pro only shows the slideshow’s first 
slide in the drop zone.

Importing DVD Studio Pro 1 Projects Into 
DVD Studio Pro 4
While DVD Studio Pro 4 contains many new features and user interface changes when 
compared to DVD Studio Pro 1, it can still import DVD Studio Pro projects. There are 
some things to be aware of, however:
• All assets must be linked in the project before it can be imported into 

DVD Studio Pro 4. A complication is that a project may open fine in the earlier 
version of DVD Studio Pro, with no indications of linking problems, and still have 
problems opening in DVD Studio Pro 4. This is most often caused when the project 
and its assets have been moved since the last time the project was saved—the 
earlier version of DVD Studio Pro is able to resolve the new asset locations but 
DVD Studio Pro 4 cannot. In this case, you need to open the project in the earlier 
version of DVD Studio Pro, then save it. This updates the asset location information in 
the project file so that DVD Studio Pro 4 can open the project.

• Slideshows created with more than one audio asset are imported as tracks.
• Slide durations are handled differently between earlier versions of DVD Studio Pro 

and DVD Studio Pro 4. In earlier versions of DVD Studio Pro, slide durations were 
based on the length of the audio file assigned to the slide (if present) and the pause 
duration. DVD Studio Pro 4 allows you to set a slide duration independent of the 
audio file length (on those slides without audio). Additionally, all pauses are set to 
infinity, making them manual pauses (the viewer must press a button to advance to 
the next slide). When imported into DVD Studio Pro 4, the slideshow durations from 
projects created in earlier versions of DVD Studio Pro will be equal to the audio 
duration plus the pause duration. If the pause duration was set to infinity, it is set as a 
manual pause in DVD Studio Pro 4.

• You cannot directly import an SPU file created with the Subtitle Editor used with 
earlier versions of DVD Studio Pro. If you import an existing DVD Studio Pro project 
with subtitles created with the Subtitle Editor, the subtitles are converted to TIFF files 
and positioned in the subtitle stream. 
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• In earlier versions of DVD Studio Pro, there was an issue when using the “Get Current 
Subtitle Stream” function in scripts—it was always off by 1. To work around this 
problem, many users would add a step into their scripts that would subtract 1 from 
the value returned with this function. If you import a project created with an earlier 
version of DVD Studio Pro that has been modified to avoid this problem, it will not 
work properly in DVD Studio Pro 4. You will need to edit the script to remove the 
modification you added to work around this issue.

• Earlier versions of DVD Studio Pro used Selection Conditions on each button to 
determine which button would be selected when you jumped to a menu. 
DVD Studio Pro 4 uses an easier method for controlling which button is selected 
when a menu is jumped to—you simply select the specific button from a list of 
targets when you assign the connection. When you import a project created with an 
earlier version of DVD Studio Pro into DVD Studio Pro 4, the original Selection 
Conditions are not retained. You will need to modify these connections in 
DVD Studio Pro 4.

• The DVD specification limits a project to 99 tracks, stories, and slideshows. 
DVD Studio Pro 1 allowed you to create more stories than allowed by the DVD-Video 
specification. When you import into DVD Studio Pro 4 a project with more than 99 
tracks, stories, and slideshows, an error dialog appears warning you that the entire 
project could not be imported.

Importing DVD Studio Pro 2 and DVD Studio Pro 3 
Projects Into DVD Studio Pro 4
There are several issues you should be aware of if you are importing projects created in 
DVD Studio Pro 2 and DVD Studio Pro 3 into DVD Studio Pro 4.

Opening Old Projects
When you open a project created in DVD Studio Pro 2 or DVD Studio Pro 3 in 
DVD Studio Pro 4, a warning appears saying that when you save the project, you will 
no longer be able to open it in DVD Studio Pro 2 or DVD Studio Pro 3.

DVD Studio Pro 4 has improved the way text items in menus are handled, which may 
cause some menus to look slightly different. 

Importing Item Descriptions
You cannot import item descriptions saved with any earlier version of DVD Studio Pro 
(1, 2, or 3) into DVD Studio Pro 4. Since an item description is a text file describing an 
element such as a menu or track, you can create a new item description by importing a 
project that contains the element into DVD Studio Pro 4, then saving an item 
description of it.
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CC Calculating Disc Space 
Requirements

A major concern when authoring your DVD project is knowing whether it will fit on the 
disc size you intend to use. The following describes in detail how to determine the 
amount of disc space your project requires, and provides a way to determine a safe bit 
rate to encode your video assets with. 

Note:  The following example is specific to an SD project on a red laser disc. The same 
process applies to HD projects on blue laser discs.

Also see “Making Sure Your Content Will Fit” on page 40 for additional information on 
fitting your content to the disc.

Calculating a Project’s Disc Space Requirements
While the video bit rate is the single biggest factor in controlling the size of your 
project, there are a number of other factors that determine how much disc space will 
be required to hold your project:
• The number of and types of audio assets
• The number of slideshows and their audio
• The number of subtitles
• Any DVD-ROM content to be included

The steps below guide you through the process of estimating your project’s disc space 
requirements. For this example, the project has:

• Video asset 1 with a duration of 01:26:13:12 and two audio streams:  an AC-3 5.1 
surround and an AC-3 stereo

• Video asset 2 with a duration of 00:45:34:07 and one PCM 16-bit 48 kHz audio stream
• Motion menu video with a duration of 00:00:16:20 and one AC-3 stereo audio stream



634 Appendix C    Calculating Disc Space Requirements

 

Step 1:  Calculate the total video play time
You first need to determine the total play time of all video assets and motion menus in 
your project. To make calculations easier, you need to convert the time from hours, 
minutes, and seconds to the total number of seconds. For frames, round up to the next 
second when there are frames left over.

In the example above, video asset 1 is 5174 seconds long, video asset 2 is 2735 seconds 
long, and the motion menu contains 17 seconds of assets, for a total of 7926 seconds. 

Note:  Slideshows do not count as video play time, and are discussed later.

Step 2:  Calculate disc capacities
To calculate the appropriate bit rate for your content, you need to know each disc 
type’s capacity in bits. The capacity of a DVD-5 disc is 4.7 GB (or 4.37 binary gigabytes). 
For the purposes of this calculation, you should use the 4.7 GB value since it does not 
have to be corrected to account for the difference that counting in binary adds. To 
make the calculation, you multiply the byte capacity by 8 (the number of bits in a byte).

DVD name Byte capacity Bit capacity

DVD-1 1.46 GB 11.68 gigabits (Gbit)

DVD-2 2.66 GB 21.28 Gbit

DVD-3 2.92 GB 23.36 Gbit

DVD-4 5.32 GB 42.56 Gbit

DVD-5 4.7 GB 37.6 Gbit

DVD-9 8.54 GB 68.32 Gbit

DVD-10 9.4 GB 75.2 Gbit

DVD-14 13.24 GB 105.92 Gbit

DVD-18 17.08 GB 136.64 Gbit
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Step 3:  Calculate the bit rates for each disc size
Once you know the play time in seconds and the bit capacity of the different disc sizes, 
you can calculate a basic bit rate for each disc size. To do this, divide the disc size by the 
play time (7926 seconds in this example).

These bit rate values should not be considered final at this point, because you still have to 
take into consideration the audio and DVD-ROM content. However, these values do 
provide an indication as to which DVD disc size you will need to use. If your project uses 
compressed audio, such as the Dolby Digital AC-3 format, and has little or no DVD-ROM 
content, you would need to decide whether encoding at 4.74 Mbps (or slightly less to 
ensure the video and audio all fit on the disc) would provide satisfactory results. If so, a 
DVD-5 disc should work for this project. If the project includes multiple soundtracks, a lot 
of slides or subtitles, and some DVD-ROM content, you may decide it is best to use a 
DVD-9 disc size so that everything you want to include will fit on the disc. 

Another point to keep in mind is that video assets are not required to use the same bit 
rate. For some assets, you may decide that quality is not as important as it is for others, 
and choose to use a lower bit rate for them, allowing more disc space for the other 
video assets.

Choosing a bit rate that provides satisfactory results depends on the video content and 
the encoder you use. In general, bit rates below 4.0 Mbps are marginally acceptable. 
For bit rates between 4 and 6 Mbps, you should get good results when using a good 
variable bit rate (VBR) encoder, such as the embedded MPEG encoder and Compressor. 
For rates between 6 and 8 Mbps, you should have no trouble getting good results even 
when using a constant bit rate (CBR) encoder. Eight Mbps is usually considered the 
highest usable bit rate—the DVD specification allows up to 9.8 Mbps, but this can 
cause playback problems on some DVD players and limit your audio options.

For more information on encoding, see “Encoding Video Materials for DVD” on page 54. 

DVD name Bit capacity Bit rate

DVD-1 11.68 gigabits (Gbit) 1.47 megabits per second 
(Mbps)

DVD-2 21.28 Gbit 2.68 Mbps

DVD-3 23.36 Gbit 2.95 Mbps

DVD-4 42.56 Gbit 5.37 Mbps

DVD-5 37.6 Gbit 4.74 Mbps

DVD-9 68.32 Gbit 8.62 Mbps

DVD-10 75.2 Gbit 9.49 Mbps

DVD-14 105.92 Gbit 13.36 Mbps

DVD-18 136.64 Gbit 17.24 Mbps
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Step 4:  Calculate the audio allowances
Depending on your project, the audio may have a relatively minor effect on disc space. 
It can also be challenging to determine the audio allowances since each video asset 
can have up to eight audio streams, and each stream can be a different type and 
length. The following table lists the typical bit rates for the common audio formats.

In the earlier example, video asset 1 has two audio streams, each 5174 seconds long. 
The first stream is AC-3 5.1 surround, and the second is AC-3 stereo. The video asset 2 
has one audio stream 2735 seconds long, using 16-bit 48 kHz PCM audio. The motion 
menu has an AC-3 stereo audio stream 17 seconds long. If your slideshow includes 
audio, you also need to include that in the formula.

To calculate the storage required, you determine each video asset’s total audio bit rate 
and multiply that by the duration.

As you can see, using PCM audio requires substantially more disc space than using a 
compressed format like AC-3. See “Preparing Audio Sources” on page 77 for more 
information on the different audio formats.

Audio format Bit rate

AC-3 stereo 192 kilobits per second (kbps) to 224 kbps

AC-3 5.1 surround 384 to 448 kbps

DTS 5.1 surround 754.5 kbps or 1509.75 kbps

PCM stereo 16 bits at 48 kHz 1536 kbps

PCM stereo 24 bits at 96 kHz 4608 kbps

Section Duration Bit rate Disc space

Video 1, 
AC-3 5.1

5174 seconds 448 kbps 2.32 gigabits (Gbit)

Video 1, 
AC-3 stereo

5174 seconds 224 kbps 1.16 Gbit

Video 2, 
16-bit 48 kHz PCM

2735 seconds 1536 kbps 4.20 Gbit

Menu, 
AC-3 stereo

17 seconds 224 kbps 0.004 Gbit

Total:  7.684 Gbit
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Step 5:  Calculate the effect of audio on the video bit rate
Now that you know how much disc space is required for the audio, you can more 
accurately determine the video bit rate you can use. Since the DVD-5 and DVD-9 discs 
were the only practical ones based on the previous calculations, you will continue 
experimenting with them in this example.

For the DVD-5 disc, you need to subtract the total audio amount from the total disc 
size:  37.6 gigabits – 7.684 gigabits = 29.916 gigabits for the video. Dividing the available 
space by the video duration provides a new bit rate:  29.916 gigabits ÷ 7926 = 3.77 
Mbps. You can see that the audio has considerably affected the original bit rate for the 
DVD-5 disc (4.74 Mbps). The use of PCM audio for the second video asset in this 
example has forced the video bit rate to drop below 4 Mbps, making the use of a 
DVD-5 disc questionable since a bit rate that low may not provide suitable quality.

For the DVD-9 disc, you end up with 60.636 gigabits available for the video 
(68.32 gigabits – 7.684 gigabits). The adjusted video bit rate is now 7.65 Mbps 
(60.636 gigabits ÷ 7926 seconds)—easily high enough to provide good quality.

Step 6:  Calculate DVD-ROM allowances
If you intend to include DVD-ROM content on the disc, you need to subtract it from the 
disc space before coming up with your video bit rate. 

Since the size of your DVD-ROM content is expressed in binary megabytes, you must 
convert it to the same standard as used for the DVD disc size. In this example, there is a 
total of 36 MB of data. Each computer MB is equal to 1,048,576 actual bytes. To convert 
the DVD-ROM content, you need to multiply its size (36 MB) by 1,048,576 to get the 
actual size of 37,748,736. 

The next step is to convert this number into bits by multiplying it by 8, providing a final 
size of approximately 0.3 gigabits. While this is not a large amount of space, you should 
take it into account if you are trying to maximize usage of the disc’s available space.
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Step 7:  Calculate other allowances
There are several other factors that should be taken into account when determining 
available disc space.
• Slideshows:  Each still in a slideshow requires approximately 200 kilobytes (KB) of disc 

space. A full slideshow with 99 stills requires about 20 MB of disc space. If the 
slideshow contains audio, you will find that the audio can require as much or more 
disc space than the stills. If your disc contains many stills, you will need to take them 
into account.

• Still menus:  Each standard still menu requires about 300 KB of space, depending on 
the number of buttons. 

Layered menus can require a lot more space than standard menus, since a new 
menu is created for each button in each of its separately specified states (normal, 
selected, and activated). This can mean as many as 12 menus are created to support 
4 buttons. See “Creating Menus Using the Layered Method” on page 323 for more 
information on layered menus.

Note:  Menus that use button shapes with motion assets assigned are considered to 
be motion menus, and need to count as a video asset. 

• Subtitles:  The amount of space required by subtitles can vary widely, depending on 
how many of the 32 streams you use, the type of content you use (simple text 
characters or full-screen graphics), and how often you change them (several times a 
second, or more typically, once every four or five seconds).

Simple subtitles average about 10 kbps—roughly 2 megabits of space per hour, 
which is negligible on most titles. If you intend to use subtitles more as an animation 
tool, with full-screen graphics that change often, you must make significant 
allowances for them. (The maximum bit rate allowed for a subtitle stream is 
3.36 Mbps—almost as much as the video stream.)

Unless you are using an exceptional number of stills, menus, or subtitles, you can 
usually account for the amount of space required by these items by allowing a five 
percent overhead. The easy way to apply this overhead amount is to multiply the bit 
rate you have figured out by 0.95. In the earlier example, the DVD-5 disc bit rate drops 
from 3.77 Mbps to 3.58 Mbps; the DVD-9 bit rate drops from 7.65 Mbps to 7.27 Mbps.

Important:  It is much better to be conservative and find yourself with some disc space 
left over than to get to the end of the project and find it will not fit on the disc.

Using the Calculated Bit Rate
The bit rates you calculate can be used as the bit rate entry of your encoder, regardless 
of the encoding method you intend to use (one pass, one-pass variable bit rate [VBR], 
or two-pass VBR). See “MPEG Encoding Methods” on page 56 for more information.
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DD Transition Parameters

Most of the parameters of the standard transitions supplied with DVD Studio Pro are 
self-explanatory. However, some parameters are not as obvious. This appendix explains 
the parameters for each of the transitions. For details on using transitions, see:

• “Using the Menu Transition Feature” on page 347 for information on using transitions 
with menus

• “Adding Transitions to Still Clips” on page 398 for information on using transitions 
with tracks

• “Using Slideshow Transitions” on page 421 for information on using transitions with 
slideshows

Transition Duration
All transitions have a duration setting. The duration can be set from a minimum defined 
for each transition (usually one second) to a maximum based on the source length or 
10 seconds maximum, whichever is smaller. For example, a slide with a duration of 5:00 
can have a maximum transition duration of 4:15 since the minimum duration for a slide is 
15 frames. (This is in an NTSC project—in a PAL project, the maximum transition duration 
would be 4:13 since the minimum duration for a slide is 12 frames.)

Video Transition
Menus and buttons have an additional transition to choose called Video Transition. With 
Video Transition, you choose a video asset to play as the transition when a button is pressed.

Alpha Transitions
DVD Studio Pro includes several Alpha Transitions. These transitions use short video 
clips to produce a transition from the current picture to the new picture. These 
transitions, indicated with an “ ” character in front of their name, have no settings 
other than a duration, and are not listed with the standard transitions. 

Additionally, you can even create and import your own Alpha Transitions. See 
“Preparing Alpha Transitions” on page 98 for details on the process. 
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Standard Transitions
The following transitions are available in menus, tracks, and slideshows. 

Blur
Blurs the current picture while it fades, revealing the new picture underneath.

Cube
Rotates the current picture off the screen while revealing the new picture as if on an 
adjacent side of a rotating cube.

Dissolve
Dissolves between the current and new pictures.

Drop
Slides in the new picture over the current one, with a bounce as it “hits” the side. Use 
Move In to have the slide without the bounce.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Blur Soft or Intense Defines the amount of blur 
shown before the transition 
finishes.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Direction Right, left, up, and down Defines the direction the cube 
rotates in.

Field of View 0-10 Defines the amount of 
perspective, with 0 being 
maximum and 10 being 
minimum.

Background Color Defines the color that appears in 
areas the pictures do not cover.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Direction Right, left, up, and down Defines the direction the new 
picture moves in.
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Droplet
The current picture ripples from its center and fades away, revealing the new picture.

Fade Through Color
Dissolves from the current picture to a color, then to the new picture. 

Flip
Rotates the current picture in 3D space, revealing the new picture on its back.

Melt
“Melts” the current picture while it fades, revealing the new picture.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Amplitude 0-10 Defines the severity of the ripple 
before the transition finishes; 0 is 
subtle while 10 is extreme.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Color Color Defines the color dissolved to.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Direction Right, left, up, and down Defines the direction the current 
image rotates toward.

Background Color Defines the color that appears in 
areas the pictures do not cover.

Field of View 0-10 Defines the amount of 
perspective, with 0 being 
maximum and 10 being 
minimum.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Viscosity 0-10 Defines how far the picture 
melts before the transition 
finishes.
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Mosaic
Divides the picture into panels that each flip independently to reveal the new picture 
on their back.

Motion Dissolve
Current picture zooms out while it dissolves to the next picture.

Move In
Slides in the new picture over the current picture. Use Drop to have the slide with a 
bounce as it “hits” the side.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Direction Right, left, up, and down Defines the direction the current 
image panels rotate toward.

Rows 1-16 Defines the number of rows the 
picture is broken into.

Columns 1-16 Defines the number of columns 
the picture is broken into.

Field of View 0-10 Defines the amount of 
perspective, with 0 being 
maximum and 10 being 
minimum.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Direction Right, left, up, and down Defines the direction the new 
picture moves in.
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Page Flip
Creates a page turn effect to remove the current picture, revealing the new 
picture underneath.

Push
Current picture slides off as the new picture slides in.

Radial Blur
Current picture blurs and zooms out while fading to reveal the new picture.

Reveal
Current picture slides off, revealing the new picture sitting underneath it.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Direction Right, left, up, and down Defines the direction the page is 
turned to.

Angle 0-359 degrees Defines the amount the page 
flip’s fold rotates during the 
transition.

Field of View 0-10 Defines the tightness of the fold, 
with 0 being minimum and 10 
being maximum.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Direction Right, left, up, and down Defines the direction the new 
picture moves in.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Depth 0-10 Defines the amount of blur and 
zoom before the transition 
finishes, with 0 being minimum 
and 10 being maximum.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Direction Right, left, up, and down Defines the direction the current 
picture moves in.
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Rotate
Spins the current picture about its Z-axis while zooming out and fading to reveal the 
new picture underneath.

Rotation Blur
Spins the current picture about its Z-axis while blurring, zooming out, and fading to 
reveal the new picture underneath.

Wipe
Current picture is wiped off and the new picture wiped on using a straight edge soft 
wipe.

Zoom
Current picture zooms out and fades to reveal the new picture.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Depth 0-10 Defines the amount of rotation 
and zoom before the transition 
finishes, with 0 being minimum 
and 10 being maximum.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Angle 0-359 degrees Controls how far the current 
picture rotates during the 
transition.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Direction Right, left, up, and down Defines the direction the wipe 
moves in.

Thickness 0-10 Defines the softness of the wipe 
edge, with 0 being minimum 
and 10 being maximum.

Parameter name Range Notes

Duration 1 to 10 seconds You can enter a duration or drag 
the slider to set the duration.

Depth 0-10 Defines the amount of zooming 
before the transition finishes, 
with 0 being minimum and 10 
being maximum.
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4:3  The most common video aspect ratio, used for NTSC and PAL video standards. Also 
known as the 1.33 aspect ratio. See also aspect ratio.

16:9  The widescreen aspect ratio supported by the DVD-Video specification. Also 
known as the 1.78 aspect ratio. See also anamorphic; aspect ratio.

AC-3 audio  A compressed audio format developed by Dolby Laboratories. Also known 
as Dolby Digital audio. Supports single-channel through 5.1 surround sound 
configurations. The AC-3 encoder in Compressor outputs AC-3 format audio.

active area  The rectangular area that defines the part of the overlay graphic used for a 
button. Also defines a button’s “hot spot” that can be clicked when viewing the title on 
a computer. See also button.

anamorphic  A type of widescreen video in which the video uses the same frame size 
as standard 4:3 video, but with a horizontally compressed image, giving it a distorted 
appearance. Widescreen SD-based DVDs require you to use anamorphic 16:9 video.

aspect ratio  A video frame’s width-to-height ratio on your viewing screen. The most 
common aspect ratio is 4:3 used for standard video. The DVD specification also 
supports the 16:9 aspect ratio. See also 4:3; 16:9; anamorphic.

assets  The audio, video, and still image files used by DVD Studio Pro in authoring DVD 
projects. See also Palette.

AUDIO_TS folder  One of two folders required on standard definition DVD-Video discs 
(the VIDEO_TS folder is the other). The AUDIO_TS folder is reserved for use on DVD-
Audio titles, and is always created but left empty when building projects with 
DVD Studio Pro. See also VIDEO_TS folder.

authoring  The process of creating a DVD. Authoring a DVD project requires you to use 
your sources to create elements, such as menus and tracks, connect the elements so 
that the viewer can get from one to the other, and then format the project into a 
DVD-compliant set of files, image, or DVD. See also elements.
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authoring media  The DVD-R format that supports the Cutting Master Format (CMF) for 
adding advanced features to master discs supplied to a replication facility. Requires using 
a special authoring DVD-R drive. See also Cutting Master Format (CMF); general media. 

AVC (Advanced Video Codec)  See H.264.

background image  All menus have a background image, over which the menu’s 
buttons are placed. The background can be a still image or a motion video (creating a 
motion menu). See also motion menu.

B-frame  Bi-directional frame. In an MPEG video stream, a B-frame contains the motion 
differences between I-frames and P-frames occurring before and after it. With respect to file 
sizes, these are the most efficient frame types, although they have the greatest difficulty in 
handling abrupt scene changes. See also Group of Pictures (GOP); I-frame; P-frame.

bit rate  The number of bits per second that makes up a digital video or audio asset. 
The higher the bit rate, the better the quality. However, higher bit rates require larger 
file sizes and can cause playback problems if the DVD player is unable to keep up. The 
DVD specification places bit rate limits on assets used in DVD titles.

blue laser  The name for the new disc format supported by HD-based DVDs. The name 
refers to the color of the laser that plays the discs. Since a blue laser has a shorter 
wavelength than the red laser used with traditional SD-based DVDs, it is able to handle 
data that is more tightly packed than on red laser discs. This results in a little more than 
three times higher disc capacity. See also red laser.

build  To compile the project into its DVD-compliant format, creating the AUDIO_TS 
and VIDEO_TS folders for SD projects, and the HVDVD_TS folder for HD projects. The 
streams that make up a track are multiplexed into a single video object file. Compare 
with format.

burn  To write data to a disc. Within DVD Studio Pro, burn refers to a process that builds 
the project and then formats and writes it to a DVD-R, simplifying the process. 
Compare with build; format.

button  Each DVD menu has at least one button that the viewer can activate to access 
areas within the DVD. You can also place buttons over a video track. DVD Studio Pro 
supports three button types:  overlay-based using an overlay graphic, shape-based 
using supplied or custom shape graphics, and layer-based using layers in an Adobe 
Photoshop (PSD) format file. You can connect buttons to a wide variety of project 
elements, including buttons on other menus, tracks, stories, slideshows, and scripts. See 
also button navigation; button states; motion button.
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button navigation  The actions that occur when a viewer presses a remote control’s 
arrow buttons. You can manually configure each button’s navigation settings or use the 
DVD Studio Pro Auto Assign feature to automatically set the navigation of all buttons 
on a menu at once. It is important to set the navigation so that viewers can logically 
get from the current button to the desired one.

buttons over video  Interactive buttons that appear over a video stream by way of a 
subtitle stream. Used to provide the viewer with viewing options while watching a 
title’s main program. Also known as interactive subtitles and interactive markers. 

button states  Each button on a menu can be in one of three states:  normal, selected, and 
activated. In the normal state, the button displays its inactive condition. All buttons on a 
menu except one are in the normal state. A button is selected when the viewer navigates to 
it. Only one button at a time can be in the selected state. The selected button becomes 
activated when the viewer presses the remote control’s Enter button. Depending on the 
button type, highlights or layers are used to indicate each button’s state.

chapter  Places in a track where you can connect to. Commonly used to identify scenes 
for a chapter index menu. You can assign up to 99 chapters in each track. 

clip  The term used to describe a video or audio asset, especially after it has been 
added to a track. See also assets.

color mapping  When working with overlay graphics, the process of assigning a color 
and opacity setting to colors used in the overlay graphic. You assign separate colors and 
opacities for all three button states (normal, selected, and advanced). See also overlay.

compile  See build.

constant bit rate (CBR) encoding  A video MPEG encoding method that uses the same 
bit rate for the entire video file. Its primary advantage is that you can reliably predict 
the resulting file size. Its disadvantage is that all video scenes, whether still or with a lot 
of motion, are treated the same. See also variable bit rate (VBR) encoding.

Content Scrambling System (CSS)  Provides digital-based copyright protection for a 
DVD’s contents. See also Copy Generation Management System (CGMS); Macrovision.

Copy Generation Management System (CGMS)  Used to set whether a disc can have 
unlimited copies made, a single copy made, or no copies made. Allowing no copies to 
be made activates the CSS and Macrovision settings. See also Content Scrambling 
System (CSS); Macrovision.

Cutting Master Format (CMF)  A format that provides the information needed by 
replication facilities to add advanced features to a DVD, such as support for copy 
protection and dual-layer discs. The cutting master format can be applied to DLTs and 
authoring DVD-Rs, but not general DVD-Rs.
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data description protocol (DDP)  The file type most often used when formatting a 
project onto a DLT drive. See also Digital Linear Tape (DLT) drive.

Digital Linear Tape (DLT) drive  The tape drive most often used to supply a project to a 
replication facility. A separate tape is written for each project layer during the format 
process. See also data description protocol (DDP); format.

Digital Theatre Systems (DTS) audio  A compressed audio format for single channel 
through 5.1 surround sound configurations. Requires an external DTS decoder for 
playing on your computer.

Dolby Digital  See AC-3 audio.

double-layer disc  A recordable disc format that you can burn a dual-layer project to. 
Since it has the same capacity as a dual-layer disc, it is able to use the dual-layer 
settings in your project to place the break point, making it possible to test the project 
before sending it to the replicator. See also dual-layer disc.

double-sided disc  A DVD with content on both sides of the disc. Most DVD players 
require you to turn the disc over to play the second side. Each side can be single- or 
dual-layer. See also dual-layer disc.

drop frame timecode  Timecode that represents the actual time duration of NTSC at 
29.97 frames per second (fps). To achieve this accuracy in numbering the frames, two 
frame numbers are dropped every minute on the minute, except for the tenth minute. 
See also non-drop frame timecode; timecode.

drop zone  An element you can add to a menu’s background. You can assign a still 
image or moving video asset to the drop zone. You can size, position, and rotate the 
drop zone. When you build the title, the drop zone is merged with the background. 
Drop zones cannot be linked to other elements in the project.

dual-layer disc  A DVD with two layers on a single disc side, almost doubling a single-
layer disc’s capacity. While you can burn a dual-layer project on a double-layer drive, 
they are most often created by a replication facility. See also double-layer disc; double-
sided disc; opposite track path (OTP); parallel track path (PTP).

duplication facility  When you need to create multiple copies of a DVD, and the disc 
fits on a standard DVD-R and requires no special high-end features such as copy 
protection, you can use a duplication facility. The duplication process creates DVD-R 
copies from a DVD-R that you burn on your system; they can automate the process and 
add professional labels. See also replication facility.
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DVD@CCESS  A feature in DVD Studio Pro that allows you to add additional 
interactivity to your title when it is played on a computer. With DVD@CCESS, you can 
add links to menus, tracks, and markers that can be used to open an application on the 
computer to display extra content. For example, you can open the system’s web 
browser and direct it to a specific URL.

DVD-R  The DVD format supported by the Apple SuperDrive, using write-once discs. 
See also authoring media; Cutting Master Format (CMF); general media.

DVD-ROM  A DVD with files in addition to those included on a standard DVD-Video 
disc. These files can be accessed when the title is played on a computer—they are 
ignored by standard set-top DVD players. The files can be almost anything you can 
write to a disc such as additional graphics or software.

elements  The parts of a DVD project, such as menus, tracks, stories, slideshows, and 
scripts. Authoring a project involves creating the elements and connecting them 
together. See also authoring.

encoding  The process of converting video or audio to a different format. For DVD 
projects, this means converting the video to an MPEG-2 file, and the audio to one of 
several DVD-compliant formats.

First Play  The element of a project that appears when the title begins playing. You can 
assign any of your project’s elements as the First Play. 

format  The process of writing the build files to an output device, which can be a 
DVD-R drive, an DLT drive, or your system’s hard disk. Compare with build.

general media  The DVD-R format most commonly used by DVD-R drives, including the 
Apple SuperDrive. It does not support the Cutting Master Format (CMF). See also 
authoring media; Cutting Master Format (CMF).

General Purpose Register Memories (GPRMs)  DVD players contain memory registers 
that are set aside for use by DVDs while they play. Scripts in a DVD use the GPRMs to 
store values used to provide special playback features, such as language customization 
or random playback. Compare with System Parameter Register Memories (SPRMs).

Group of Pictures (GOP)  A small section of an MPEG-2 encoded video clip, built from 
one I-frame and several B-frames and P-frames. Typical GOP sizes range from a few 
frames to a maximum of 18 frames (NTSC) or 15 frames (PAL). Marker placement and 
video trims can only occur at GOP boundaries. See also B-frame; I-frame; P-frame.
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H.264  Based on the MPEG-4 part 10 format, the H.264 format, the H.264 video format, 
also known as Advanced Video Codec (AVC), provides for encoding with about twice 
the efficiency as with the MPEG-2 format. This results in better quality at the same bit 
rate, or you can choose to use a lower bit rate to achieve the same quality (with a 
smaller file size). In DVD Studio Pro, the H.264 format can only be used with HD 
projects.

HDV  An HD video format, using high bit rate MPEG-2 encoding, designed to be 
recorded on standard mini-DV tapes. HDV video can be edited in Final Cut Pro 5 and 
used in your HD projects without ever needing to be transcoded.

HVDVD_TS  The folder required on HD DVD-Video discs. DVD Studio Pro creates the 
HVDVD_TS folder when you build your HD project. It contains all of the video, audio, 
subtitle, menu, and navigation files that make up your HD DVD-Video title. 

I-frame  Intra frame. In an MPEG video stream, I-frames, also known as reference or key 
frames, contain the complete image of the current frame. Unlike B-frames and P-
frames, I-frames do not rely on other frames to provide image information. Each GOP 
contains one I-frame. See also B-frame; Group of Pictures (GOP); P-frame.

interactive markers  See buttons over video.

interactive subtitles  See buttons over video.

jacket picture  An optional part of the DVD-Video specification that is intended to 
allow a DVD player to display a graphic representing a DVD, either on a separate 
display or when the DVD player is stopped.

layered menu creation method  A method of creating menus that takes advantage of 
a Photoshop PSD file having separate layers for each button in its three states (normal, 
selected, and activated). This allows you to use complex graphics for the button 
highlights; however, you cannot include a motion video background or audio. Compare 
with standard menu creation method. See also button states.

letterbox  A method of displaying 16:9 video on a 4:3 monitor. The entire frame 
appears, with black bars at the top and bottom. See also pan-scan.

Line 21 support  In NTSC systems, the video line that can contain special data. Most 
often used to contain closed caption information. 

Macrovision  Provides analog-based copyright protection for a DVD’s contents. See also 
Content Scrambling System (CSS); Copy Generation Management System (CGMS).



Glossary    651

 

marker  An element you can add to a track to identify specific parts of the track’s 
content. There are several marker types, including chapter markers used to link chapter 
buttons and button highlight markers used to control buttons over video. You can have 
up to 99 chapter markers in a track, and up to 255 total markers in a track. Markers can 
only be placed at GOP boundaries. See also Group of Pictures (GOP).

menu  An element in a project that provides buttons for the purpose of connecting to 
other elements in your project, such as tracks and slideshows. A menu can have a still 
or full motion background, and can include audio. See also background; drop zone; 
motion button; motion menu.

motion button  Button shapes that can display a thumbnail image of an assigned 
asset. The asset can be a still image or a video clip. 

motion menu  A menu that contains moving video content, either as the background, 
a motion button, or a drop zone. See also background; drop zone; motion button.

MPEG  Acronym for Moving Picture Encoding Group. A group of encoding standards that 
define the MPEG-1 and MPEG-2 encoding standards used by DVDs. 

multiplexing  The process of combining multiple streams, such as video streams, audio 
streams, and subtitle streams, into a single stream. This occurs when you build your 
title and create DVD-compatible streams. See also build.

muxing  See multiplexing.

non-drop frame timecode  Normal NTSC timecode, where frames are numbered 
sequentially and there are 30 frames per second, 60 seconds per minute, and 60 
minutes per hour. Because NTSC’s frame rate is actually 29.97 fps, non-drop frame 
timecode is off by 3 seconds and 18 frames per hour in comparison to actual elapsed 
time. See also drop frame timecode; timecode.

NTSC  Abbreviation for National Television Standards Committee. The organization that 
defines North American broadcast standards. The term NTSC video refers to the video 
standard defined by the committee, which has a specifically limited color gamut, is 
interlaced, and is approximately 720 x 480 pixels, 29.97 fps. Compare with PAL.

one-pass and two-pass VBR (variable bit rate) encoding  See variable bit rate 
(VBR) encoding.

opposite track path (OTP)  Used when creating dual-layer discs to control where the 
second layer starts. With OTP, the second layer starts at the outside edge of the disc, 
which is the opposite of the first layer, which starts at the disc’s inside edge. See also 
dual-layer disc; parallel track path (PTP).
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overlay  A still graphic that provides the highlight information for buttons when 
creating menus or buttons over video. Overlays can be simple, using a single color on a 
white background, or advanced, using up to four predefined colors. You use color 
mapping to assign highlight colors to those used in the overlay, setting different colors 
for each button state (normal, selected, and activated). See also color mapping.

PAL  Acronym for Phase Alternating Line. A 25 fps (720 x 576 pixels) interlaced video 
format used by many European countries. Compare with NTSC.

pan-scan  A method for displaying 16:9 video on a 4:3 monitor. Content is cropped at 
each end so that the 4:3 monitor is filled. An MPEG-2 video clip with pan and scan can 
include vectors that dynamically change the part of the picture that is cropped. See 
also letterbox.

parallel track path (PTP)  Used when creating dual-layer discs to control where the 
second layer starts. With PTP, the second layer starts at the inside edge of the disc, the 
same as the first layer. See also dual-layer disc; opposite track path (OTP).

patches  Specialized shapes that provide features not normally available with 
traditional shapes, such as shading and colorization. You cannot create your own 
patches. See also shapes.

P-frame  Predicted frame. In an MPEG video stream, P-frames are encoded based on 
the closest preceding I-frame or P-frame. They can be referenced by B-frames occurring 
before or after them. With respect to file size, they are not as efficient as B-frames, but 
handle abrupt scene changes better. See also B-frame; Group of Pictures (GOP); I-frame.

pixel aspect ratio  The distance between a pixel, the one next to it, and the one below 
it defines its aspect ratio. A square pixel aspect ratio, as used on computer systems and 
HD video monitors, has the same pixel distance in both directions. SD video monitors 
do not have the same distance in both directions, and have rectangular pixels. NTSC 
and PAL video each have different pixel aspect ratios. This difference must be 
accounted for when creating graphics on a computer for use in an SD project. 

project  When you author a DVD title with DVD Studio Pro, you create and work in a project.

red laser  Refers to the color of the laser used to play the discs used by SD projects. See 
also blue laser.

region codes  DVDs can be set to play only in certain parts of the world by selecting 
the supported regions when you author your title. The DVD specification divides the 
world into six regions plus an additional region for use by airlines and cruise ships. 
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replication facility  You can use a replication facility when you need to reproduce a 
significant number of copies of your DVD (generally more than 100). You must use a 
replication facility if you require dual-layer discs, or if you intend to include high-end 
features such as copy protection or region codes. Replication facilities use a glass 
mastering process to create DVDs that are compatible with all DVD players, as opposed 
to the DVD-R process used by duplication facilities. See also duplication facility.

scripts  Simple programs you create to access specialized information from the DVD 
player, such as its region code, and to perform advanced functions, such as randomly 
playing all tracks. You can connect most elements of a project to scripts. See also 
General Purpose Register Memories (GPRMs); System Parameter Register Memories (SPRMs).

shapes  Used with standard menus, shapes can be added to a menu as buttons or drop 
zones. In addition to their primary graphic, shapes can include the graphics required for 
highlights and video thumbnails. You can use those supplied with DVD Studio Pro or 
create your own. See also motion buttons; patches; standard menu creation method.

slideshow  An element in a project that can contain up to 99 still images and 
accompanying audio. DVD Studio Pro allows you to convert a slideshow into a track so 
that you can add additional features to it, such as a subtitle or additional languages for 
the audio.

S/PDIF audio  Sony/Philips Digital Interface. Digital audio output used by external AC-3 
or DTS decoders to listen to DVD Studio Pro audio. 

standard menu creation method  In DVD Studio Pro, refers to the process of creating 
menus that provides the most flexibility, including the ability to use motion video for 
the background, motion buttons, shapes, drop zones, and audio. Standard menus can 
also use templates and styles. Compare with layered menu creation method. 

story  An element in a project that is specific to a particular track, allowing you to 
create a customized version of that track. For example, you can use stories to create 
alternate versions of a track that skip violent content or play just the track’s highlights. 

styles  Used with standard menus, styles define how specific menu items, such as text 
objects, buttons, and drop zones, work in a menu. You can use those supplied by 
DVD Studio Pro or create your own. See also standard menu creation method; templates.

subpicture  See overlay.

subtitle  The DVD specification provides for up to 32 subtitle streams to be included in 
each track. These streams can contain plain text, similar to a closed caption function. 
They can also be used to provide buttons over video, allowing you to have buttons 
appear outside of menus. You can create the subtitles within DVD Studio Pro or import 
them from outside sources.



654 Glossary    

 

System Parameter Register Memories (SPRMs)  DVD players contain memory registers 
that contain configuration information, such as languages, video configuration, and 
region codes, for use by DVDs while they play. Scripts in the DVD can use the SPRMs to 
determine which version of a track to play or whether the DVD player has the proper 
region code. Compare with General Purpose Register Memories (GPRMs).

templates  Used with standard menus, templates can contain styles that define a 
menu’s background, button layout, text, and drop zones. You can use those supplied 
with DVD Studio Pro or create your own. See also standard menu creation method; styles.

timecode  A method of associating each frame of video in a clip with a unique, 
sequential unit of time. The format is hours: minutes: seconds: frames. See also drop 
frame timecode; non-drop frame timecode.

track  The element of a DVD Studio Pro project that contains the video, audio, and 
subtitle streams that provide the primary content of the DVD. Each project can have a 
combination of up to 99 tracks, stories, and slideshows.

transitions  A short video clip that plays in place of the normal direct jump from one 
button or still image to the next element. There are a variety of transition types 
supplied with DVD Studio Pro that you can use. Transitions can be configured between 
a menu button and its target, between slides in a slideshow, and between still image 
clips in a track. 

variable bit rate (VBR) encoding  A video MPEG encoding method that varies the bit 
rate based on the video content. Scenes with little motion use low bit rates to reduce 
the disc space needed, while scenes with a lot of motion use higher bit rates for greater 
quality. One-pass VBR encoding is faster than two-pass VBR encoding, but its quality is 
not quite as good and the final file size may be slightly different than you predicted. 
Two-pass VBR encoding makes a first pass through the video to determine its motion 
content, and then uses a second pass to perform the encode, with the advantage of 
better quality and providing a predictable file size.

VIDEO_TS folder  One of two folders required on DVD-Video discs (the AUDIO_TS 
folder is the other). DVD Studio Pro creates the VIDEO_TS folder when you build your 
SD project. It contains all of the video, audio, subtitle, menu, and navigation files that 
make up your DVD-Video title. 

video title set (VTS)  The contents of a DVD are contained in one or more VTS blocks. 
DVD Studio Pro creates a VTS block for each track and slideshow in your project, with a 
maximum of 99 total. In addition to a track or slideshow, each VTS can also contain 
menus and scripts. You can use the VTS Editor to view and manage the VTS structure of 
your DVD projects.

video zone  The area of the DVD that contains the VIDEO_TS or HVDVD_TS folders.
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QuickTime. See QuickTime assets
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SD DVD video streams  371
settings for  24
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slides  417, 428
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still  186, 200, 202, 371, 398
thumbnails  651
tracks  357, 370
used by elements  199
using in folders  160
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Assets tab  187–192
columns in  188–190
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described  147
importing assets  193–194
keyboard shortcuts  617

audio
AC-3. See AC-3 audio
adding to menus  229, 246, 272, 279–280
adding to slideshows  407, 411–414
adding to streams  372
adding to video  118
assets. See audio assets
bit rates supported  105, 108
DTS  79–80, 648
DTS ES  17
encoding  25–26
formats. See audio formats
for visually impaired  501
initial language code extension  501
mixing formats in project  80
not supported for DVDs  77
PCM  78, 636
preparing for DVDs  25
quality of  24
resolution  48
S/PDIF  653
sample rates  17, 25, 48, 105, 108
settings supported, HD video  107–108
settings supported, SD video  105
Simulator  122
in slideshows  98
surround  78, 105, 108
uncompressed  78
video bit rate and  637

AUDIO_TS folder  565, 573, 645
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audio assets

adding  372–373
adding to menus  280, 288
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adding to slideshows  413–414
assigning to slides  417
described  33
importing into slideshows  407
length changes  201
not DVD-compliant  183–184
resaving  202

Audio button  609
audio clips  98, 376, 378
audio files

AAC  372

assigning to menus  280
assigning to slideshows  413–414
deleting from slides  412
managing  280

audio formats
AAC  372
AC-3. See AC-3 format
AIFF  77
bit rates  636
compressed  78–79
Dolby. See Dolby Digital format
HD projects  81
listed  77–78
MPEG-1 Layer 2  77, 78, 105, 108
PCM  78, 105, 108, 636
SD projects  81
WAVE  77

Audio Interchange File Format (AIFF)  77
Audio menu button  529
audio monitors  16, 31–33, 79, 546
audio players  33
audio sources  77–79
audio streams

See also streams
AC-3  43
assets  372
assigning languages to  379
current number  492
default language for  117, 122
karaoke and  497–498
PCM  43
selecting  550, 554

authoring media  646
authoring media drives  30
authoring process  26–27, 645
Auto Assign feature  115, 215, 270–271
Automatic Gain Control (AGC) process  561
AVC (Advanced Video Codec)  646, 650

See also H.264 video

B
“Background encoding” option  65
background matte movies  99, 102
backgrounds

assigning to menus, layer method  324–325
assigning to menus, standard method  232–233
choosing, layer method  323–325
choosing, standard method  229, 231–233
color  116
images for  646
layered menus and  91
overlays and  88–89
settings  327
still images for  231
white  88–89
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basic configuration  110
B-frames

compression markers and  71
described  59, 646
GOPs and  61

bi-directional frames. See B-frames
bit rates

audio  105, 108, 636
calculating  634
considerations  43–45
constant  56, 64, 647
described  646
for disc sizes  635
disc space and  42
Dolby Digital AC-3  105, 108
DTS audio  105, 108
DVD-5 discs and  42
DVD players and  55
encoders and  635
H.264 video  76
HD projects  56, 70
higher rates  43–44
limits for  646
maximum  43–44, 56
mixed-angle tracks and  70
MPEG-1 Layer 2 audio  105, 108
MPEG video  55, 104, 106
multi-angle tracks and  70
multiple video angles  44
older computers and  38
SD projects  55, 70
setting  43–44, 64, 67
showing  375
stereo PCM  105, 108
subtitles  43
transitions  44
using calculated bit rate  638
VBR  45, 64
video  45
video assets  635, 636

bit-wise operations  503
blue laser discs

capacity  42, 578
common sizes  42
described  20, 38, 555, 646
filenaming issues  575–576
SD projects and  30
setting size  130
specifying as disc media  130
UDF 2.5 volume  575

Blur transition  640
break points

dual-layer  17, 579
dual-layer discs and  387, 556, 565, 576, 578
DVD-ROM data and  578
emulating  576

position  580
setting in DVD-ROM content  17
tracks  556, 580

buffer issues  583
Build/Format command  545, 564–565, 579
Build/Format toolbar item  162
build files

HD projects  568–569
SD projects  565–567

building projects  560–569
Build/Format command  545, 564–565, 579
described  544, 646
disc space required for  552
dual-layer  571
incremental builds  563–564
messages generated during  149
performance  564–565
procedure for  562–563
time required  564

Build toolbar item  162
burning discs  30, 41, 544, 646
burning projects  544
Burn toolbar item  162
button highlight markers  386, 387, 461
Button Inspector

assigning shapes  257
button connections  258
Colors tab  263
layered menus  333–335
standard menus  259–263
Transition tab  263

button outlines  217
buttons

16:9 aspect ratio and  208
active area  91, 217, 233, 253–254, 276, 645
adding text to  266
adding to menus, layered  331–335
adding to menus, standard  253–272
assets in  276
Auto Assign feature  270–271
chapter index usage  311
color  263
connections  258–259
copying  223, 258, 464–466
creating text-only  267
current highlighted number  496–497
custom  48
default  247, 312, 328
deleting  225, 254
described  48, 646
designing  40
drop shadows on  93, 94
DVD@CCESS links and  594
in HD projects  463
highlights  90, 247, 255, 256, 328
hot spots  645
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invisible  209–210
keeping elements together  90
layer-based  331–333, 646
layout styles and  311
motion menus and  92
moving  224–225
names  311, 314
navigation  115, 268–271, 647
number assignments  264–265
number of  208, 253, 463
offsetting number  248, 329, 440
overlapping  272
overlay-based  253–255, 272, 331, 646
over video streams  647
over video subtitles  431, 460–466
over video tracks  53, 387
positioning images in  276
properties  259–263
remote control. See remote control buttons
reordering  264–265
resizing  224–225, 254
Return  247, 328
in SD projects  463
shape-based  93–96, 646
slideshows  408, 419
states. See button states
step  402
styles  300, 307, 312
templates and  311
transitions  249, 263, 349, 352
types  646
user operations settings  601
as video sources  48

button states
activated  206, 241, 255
described  647
layered menus  91, 207
normal  83, 206, 240
overlays and  86
overview  206–207
selected  206, 241, 255
standard menus  206
viewing  217

Button tab, Subtitle Inspector  439–440
button transition clips  347, 349, 352

C
C1/C2 streams  612
C3/C4 streams  612
CBR (constant bit rate) encoding  56, 64, 647
cell markers  386, 387
CGMS (Copy Generation Management System)  647
channels, alpha  101
Chapter button  609
chapter index button usage  311

chapter index menus
button numbers and  264
Drop Palette options  286
first marker  227
general-purpose buttons and  311
markers and  384
overview  226
special-purpose buttons and  311
using button layouts  226

chapter markers
adding in iMovie  75
described  70, 386
DVD tracks and  72
importing into tracks  384
jumping to  386, 530
for loop points  92
placement of  71
stories  530
subtitles and  435

Chapter menu button  529
chapters  495, 530, 647
Choose Application Configuration window  110
chroma format  105, 107
chroma mapping type  234
Clip Inspector  358, 374–375
clips

See also assets
audio  98, 376, 378
bit rates  375
conflicts  377
copying to different streams  373
copying within streams  373
described  647
disc space required for  375
editing  376, 377
information about  375
looping  231
MPEG  379
properties  374–375
removing from streams  375
settings for  375
start time for  375
still  372
timecode start/end values for  368
tracks and  370–378
trimming  375, 376, 377
video. See video clips

closed captions
adding to DVDs  611–612
adding to tracks  612
capabilities of  433
decoders for  433
described  611
Line 21 settings for  611–612
viewing  433
vs. subtitles  433, 611
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CMF (Cutting Master Format)  31, 584, 585, 647
CMF discs  584, 585
color

background  116
buttons  263
markers  386
menu settings  251
methods for choosing  238
NTSC video  83
overlays  86–90, 234, 236–242
PAL video  83
preferences  121, 121
RGB values  16
slides  114
slideshows  98
STL format  457
subtitles  441–442, 450, 457
YUV values  16, 547

color commands, STL format  457
color mapping

described  236, 647
menus  90, 236–242
overlays  233, 236–242, 652
settings  121

color mapping sets  121, 238
Color Palette  237–238
Colors pane  121
Colors tab  250–251

Button Inspector  263, 336
Menu Inspector  251, 330
Subtitle Inspector  441–442

colorstripe process  561
Colors window  163, 238
command lines  471–473

See also scripting commands
commands

See also specific commands
jump  482, 484–485, 488, 490
scripting. See scripting commands
set  485–487
STL format  456–466

compare function  481–483
compare operations  483
compiling projects  560

See also building projects
compression  25
compression markers  69, 70, 71
Compressor

AC-3 audio files and  17
described  15, 26, 47
distributed encoding and  17
markers placed in  69, 71
using Final Cut Pro and  69

computers
DVD@CCESS playback and  597–598
DVD playback and  38

Macintosh  597
older  38
Windows  597

conditional elements  604, 606
conditional relationships  604, 605, 607
conditional states  604, 606–607
configurations

advanced  111
basic  110
custom  140, 141
extended  111
keyboard shortcuts  140, 141
managing  141
saving  140
selecting  140

Configurations toolbar item  162
connections  525–541

See also jumping
button  258–259
changing sources for  531
chapter-to-chapter  530
default  530–531
descriptions  534–541
making  531–533
Menu button  531
overview  526–531
project elements  527
remote control buttons and  529
source list  534–540
sources  527, 528–529
target list  541
targets  525, 527, 529
viewing  175

Connections tab
described  148
establishing connections in  532
jump settings  420
keyboard shortcuts  618
overview  526–527
setting remote control buttons  610
slideshows  420

constant bit rate (CBR) encoding  56, 64, 647
content

calculating bit rates for  634
DVD-ROM  637
estimating size of  42
fitting on DVD-5 discs  42
fitting on DVD discs  40–42
what to include  39

Content Scrambling System (CSS)  30, 558, 647
contrast commands, STL format  458
Control key  402
Copy Generation Management System (CGMS)  647
copying menu items  223–224
copyright protection

See also Macrovision APS
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Copy Generation Management System  647
copying discs and  558
CSS  30, 558, 647
settings for  557–558

country codes  498
.cpt extension  17
CSS (Content Scrambling System)  30, 558, 647
Cube transition  640
Customize Toolbar item  161, 162
Cutting Master Format. See CMF

D
D1 MPEG-2 assets  371
Data Description Protocol (DDP)  31, 584, 648
DDP (Data Description Protocol)  31, 584, 648
decoders

See also encoders
AC-3  653
closed caption  433, 611
DTS  653

Default button  247, 328
deleting items

assets  199
audio files from slides  412
buttons  225, 254
command lines  471–472
elements  177
markers  383, 391
in menu  225
shapes  321
slides from slideshows  411

destinations  123–124
Destinations pane  123
Digital Cinema Desktop Preview option  122
Digital Linear Tape. See DLT
Digital Theatre Systems. See DTS
director commentary  501
Disc/Volume tab  555–556
disc formatting properties  572–580
Disc Inspector  552–559

changing DVD standard in  128
creating ROM-only disc  575
naming discs in  129
setting DVD standard in  128
setting video standard in  127–130

Disc Meter Label toolbar item  163
discs

See also media
bit rates for  634–635
blue laser. See blue laser discs
burning  30, 41, 544, 646
calculating capacity of  634
choosing sides  556
CMF  584, 585
copying  558

creating  28
double-layer  648
double-sided  580, 648
dual-layer. See dual-layer discs
DVD. See DVDs
DVD-R. See DVD-R discs
DVD-ROM. See DVD-ROM discs
DVD-Video  573
fitting content on  40–42
formatting  572–580
information about  555
names  129, 552
number of sides  556
options for  41
play options  38, 553, 599–601
properties  552–559
red laser. See red laser discs
ROM-only  575–576
setting size  126, 129–130, 556
single-layer  130

disc sources  534, 537–538
disc space

bit rates and  42
required for builds  552
required for projects  555, 633–638
required for streams  375
required for tracks  360
required for transitions  44

disk images  584, 585
display commands, STL format  458
display conditions  603–607

compared to pre-scripts  479, 603
example  605
including in GPRMs  603
parameters for  604
setting up  604–605

display mode  499
Dissolve transition  640
distributed encoding  17
distribute objects feature  172
DLT drives

data description protocol  31, 648
described  31, 648
output format options  584
reading from  585
writing to  163, 584

DLT tapes
reading  163
replication facilities and  28, 30, 31

Dolby Digital format
See also AC-3 audio
advantages of  78
bit rates  105, 108
described  77

double-layer discs  648
See also dual-layer discs
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drives
authoring media  30
DLT. See DLT drives
general media  30
media compatibility and  30
SuperDrive  30, 42, 584

drop frame timecode  648
Droplet transition  641
Drop Palette

described  164
options in  285–302, 337–344
using  220–222

drop shadows
buttons  93, 94
drop zones  93, 94
menus  229, 248, 280–281
text  277

Drop transition  640
Drop Zone Inspector  274
drop zones

active area  276
adding to menus  229, 301
assets in  276
copying  223
creating  273
described  272, 273, 648
drop shadows on  93, 94
moving  224–225
overlapping  275
positioning images in  276
priority of  275
properties  274
resizing  224–225
shapes and  93, 94, 96, 275
styles  308
using  275

.dspScript extension  477
DTS (Digital Theatre Systems) audio  17, 79–80, 105, 
108, 648
DTS 5.1 surround format  636
DTS decoders  653
DTS ES audio  17
dual-layer break markers  386, 387
dual-layer break points  17, 579
dual-layer discs  576–580

See also double-layer discs
break points and  556, 565, 576, 578
described  648
seamless vs. non-seamless  577
setting direction  577
specifying  130

dual-layer projects  17, 565, 571
dual-standard DVD players  48
duplication facility  648
Duration setting  284
DVCPRO HD assets  23

DVCPRO HD video  23
DVCPRO SD video  23
DVD@CCESS feature  594–598

cell markers  387
described  594, 649
Embed Text Data option  559
markers  389
settings  429

DVD@CCESS Installers  581, 597
DVD@CCESS links

creating  594–596
to email addresses  594, 596
emulating with DVD Player  571
to files  594, 596, 597
formatting and  581
to the Internet  594, 596
menu settings  252, 331
rules for  596
Simulator and  122
testing  596
types of  571
uses for  594
verifying  571
to websites  594, 596

DVD@CCESS playback  597–598
DVD-5 discs  42, 637
DVD-9 discs  637
DVD burners  30
DVD creation

assembling source material  24–25
authoring with DVD Studio Pro  26–27
burning/replicating discs  28
encoding audio/video  25–26
limitations  45
overview of  23–28

DVD players
See also Apple DVD Player
16:9 video and  53
audio configuration  499–500
bit rates  55
dual-standard  48
DVD playback on  38
HD DVD  38
karaoke-capable  497–498, 500
NTSC  48
numeric keypad  248
PAL  48
parental management settings  498, 517–519
region codes  48, 502
remote control settings  608–610
SD DVD  38
set-top  30, 479
testing projects with  546, 570

DVD-R discs
described  30
features not supported  585
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replication facilities and  28
DVD-R drives

authoring media  30
buffer issues  583
described  30
formatting and  584
general media  30
lossless linking  583
output format options  584
simulation mode  583
types of  584
writing to  583

DVD-R format  649
DVD-ROM allowances  637
DVD-ROM content  637
DVD-ROM data  578
DVD-ROM discs

disc property settings  554
filenaming issues  573–574
overview  572–574, 649

DVDs
See also discs; projects
adding closed captions to  611–612
aspect ratio  48
burning  30, 41, 544, 646
common sizes  41
creating  28
dual-layer. See dual-layer discs
DVD-5 discs  42, 637
DVD-9 discs  637
encoding video materials for  54–61
First Play element  126, 131
fitting content on  40–45
frame rate  48
frame size  48
investigating  37
limitations  45
links in. See DVD@CCESS links
names  552
options for  41
play options  38, 553, 599–601
preparing audio for  25
preparing video for  25
replicating  28
standards. See DVD standards
storage space on  40–42
widescreen  645
writing to  30

DVD source settings  104–108
DVD standards

changing  128, 135
choosing  38
high definition. See HD DVD standard
overview  38
preferences  113

specifying for projects  112, 113, 126, 127–128, 
553
standard. See SD DVD standard

DVD Studio Pro
advanced features  345–352, 587–612
authoring with  26–27
described  15
Exposé feature and  141
function key issues  141
getting started with  15–35
hardware components  29–33
importing archived projects into  629–630
importing earlier-version projects into  631–632
importing iDVD projects into  629–631
importing themes into  629–630
new features  15–18
onscreen user manual  34
opening  109–112
preferences  112–125
quadrants  137, 141–153, 211
resources for  34
specifications for  35
status information for  149
system requirements  29
toolbar  160–162
user interface  137–180
uses for  15
vs. iDVD  18
website for  34
workspace configurations  139–141

DVD Studio Pro, earlier versions of
importing projects into latest version  631–632
importing subtitles from  432
item descriptions and  632
markers and  71

DVD tracks  72
DVD-Video discs  573
DVD-Video specification  48, 126, 469
dynamic guides  213

E
Easter Eggs  209–210
editing items

See also specific editors
assets  33
clips  376
imported subtitles  456
markers  382
scripts  470

elements
assets used by  199
connections  148, 175, 527
deleting  177
described  649
dragging assets to  194–198



664 Index    

duplicating  177
examples of  527
item descriptions  179
listing by type  165–166, 196, 590–591
listing by VTS  165–166, 196, 590–591
managing  177–180
moving  167, 591
pinning/unpinning  592
previewing  545
renaming  177
selecting  166
simulating  179
sources and  527
starting Simulator from  179
tile-based view of  148, 167–176

email addresses, links to  594, 596
embedded AIFF encoder  184
embedded MPEG encoder  62–68

bit rates  45
compression markers  71
configuring  62–65
converting unsupported audio  77
described  47
encoded file names  184
GOP settings  60, 62
imported assets and  183
improving MPEG encodes  71
messages generated by  149
MPEG-2 HD assets  135
MPEG export feature  62
multi-/mixed-angle video  69
previews and  203
QuickTime assets and  134, 135
reencoding assets  201
starting within DVD Studio Pro  66
using  66–68

emulating break points  576
emulating projects  479, 546, 570–571
encoded files  68
Encode Mode settings  64
“Encode on build” option  65
encoders

See also decoders; embedded MPEG encoder
AC-3  26
AIFF  26, 149, 184
bit rates and  635
H.264  22
MPEG  26

encoding items
audio  25–26
described  649
distributed encoding  17
DVD compliancy and  183–184, 185–186, 193
mode selection  183
MPEG encoding  25
parse files and  186

preferences for  125, 183–184
re-encoding assets  185
removing original QuickTime files  184
settings for  183–184
VBR encoding methods  45
video  25–26
video for multi-angle tracks  68–70
video materials for DVD  54–61

Encoding Mode settings  65
Encoding pane  62–65, 125, 183
End Jump setting

chapters  530
slideshows  425
tracks  360

End setting  284
enhanced video object (EVO) files  569
errors, building  563
EVO (enhanced video object) files  569
exit command in scripts  490
exit pre-script command  490
exporting items

Final Cut Pro movies with markers  74
GPRM configurations  507–508
iMovie movies with markers  75
item descriptions  179
MPEG clips  379
V1 streams as MPEG files  379

Exposé feature  141
extensions

file. See file extensions
folder  574

external audio decoder  80
external audio monitor  16, 31–33, 79, 546
external video monitor  16, 31–32, 546

F
Fade Through Color transition  641
fading subtitles with STL command  457
Field 1 settings  612
Field 2 settings  612
field order settings  64
file extensions

.aiff  68, 184

.cpt  17

.dspScript  477
DVD@ACCESS  596
.layout  567, 569
.m2v  184
.par  186
.SPU  432

file formats. See formats
files

AAC  77, 372
audio. See audio files
build  565–569



Index    665

DVD@CCESS links to  594, 596
EVO  569
graphics. See graphics files
HVDVD_TS  568–569
location of  123–124
missing  132, 182
MPEG. See MPEG files
names  68, 182, 573–576
opening with DVD@CCESS links  594, 597
overlay  87, 246
parse  132, 186
Photoshop  83
PSD. See PSD files
QuickTime  184, 188
renaming  182
RTF  456
style  314
subtitle. See subtitle files
template  314
TIFF  432
track content  566–567, 568–569
video manager group  566, 568
VOB  44, 567
zone  566–569

film aspect ratios  54
Final Cut Express  70
Final Cut Pro

asset editing and  33
chapter markers  70
exporting markers  72–74
importing markers  384

Final Rendering settings  115–116
Finder window  194
FireWire website  35
First Play

described  649
setting for projects  126, 131
setting for Simulator  547
setting in Graphical tab  178
setting in Outline tab  178
setting to track  131

Flexible Space toolbar item  163
Flip transition  641
.IFO file  567
folder list  158–159
folders

adding to folder list  158
assets  181, 191
AUDIO_TS  565, 573, 645
creating  191
destination settings  123–124
extensions  574
fallback  124
HVDVD_TS. See HVDVD_TS folder
importing and  193, 194
JACKET_P  562, 565, 568, 573

managing  159
naming  191
removing from folder list  159
reordering  159
saving encoded files to  124
specified  124
transition asset  99–100
using assets in  160
VIDEO_TS. See VIDEO_TS folder
viewing assets in  158, 159

font commands, STL format  457
Font panel  163, 267
fonts

See also text
button text  267
STL format  457
substitution of  132, 268
subtitles  449–450, 455, 457
text objects  277–278
unavailable  132, 268

formats
AC-3. See AC-3 format
AIFF  77
audio. See audio formats
chroma  105, 107
CMF  31, 584, 584–585, 647
Dolby. See Dolby Digital format
DTS  77, 105, 108
DVD-R  649
HDTV  50
MPEG. See MPEG video
NTSC. See NTSC
PAL. See PAL
PCM  77, 105, 108, 636
SCR  431
slideshows  97, 406–407
SON  431
STL  431, 456–460
TXT  431
UDF  574
WAVE  77

formatting projects  581–586
Build/Format command  545, 564–565
configuring output type  583–585
Cutting Master Format  585
described  544, 649
output devices  584–585
procedure for  581–582

Format toolbar item  163
frame rates

24 fps  49, 105, 107
Alpha Transitions  103
movies  48
MPEG video  58
NTSC  58, 105, 107
PAL  58, 105, 107
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supported by DVD Studio Pro  105, 107
frames

audio trimming  376
B-frames  59, 61, 71, 646
I-frames  59, 61, 71, 650
P-frames  59, 61, 71

Frame Sync setting  76
function keys  141

G
GarageBand  279
general media  649
general media drives  30
General pane  114
General Purpose Register Memories. See GPRMs
General tab

Disc Inspector  553–555
Menu Inspector  245–246, 327
Slide Inspector  429
Slideshow Inspector  426–427
Story Inspector  392
Subtitle Inspector  437–438
Track Inspector  361

gigabytes, actual size of  40
glossary  645–654
GOPs (Group of Pictures)

boundaries  357, 376, 380
closed  61, 69
described  649
lengths  60, 69
open  61, 69
patterns  60, 62, 69
settings  59–61
size  105, 107
Snap To settings  117

goto command  488
GPRM locations  484, 485–487
GPRM mode command  489, 508
GPRM registers

comparing  481–483
displaying values  478
increasing number of  17, 504–507
mode selection  489, 508
new features  17
partitioning  17, 479, 504–507
placing values in  485–487
showing/hiding  506
system streams  488

GPRMs (General Purpose Register Memories)
16-bit  504–505
button selection  484
described  469, 504, 649
display conditions in  603
displaying values  478
exporting  507–508

importing  507–508
names  474, 506, 559
overview  504–508
placing values in  489

Graphical tab  167–180
assigning First Play element  178
creating menus  218
deleting elements in  177
described  148, 168
dragging assets to  196–198
duplicating elements in  177–178
keyboard shortcuts  618–619
naming menus  219
opening menus  219
printing tile area  176
renaming elements in  177
viewing connections  175
viewing options  168–170
vs. Outline tab  164
working with tiles  171–174

graphics file command, STL format  458
graphics files

16:9 menus and  208
assigned to subtitles  438
importing for overlays  462
importing for subtitles  431, 452–453
jacket pictures  562, 650
in menus  24, 82–86
pixels in  85
referencing in STL subtitle files  460
subtitle animations  453
tips for creating for menus  83
using groups for subtitles  454

grayscale mapping type  234
Group of Pictures. See GOPs
guides

creating  212
dynamic  213
menu  212–213
removing  213
repositioning  212
settings  118–119

H
H.264 assets  22
H.264 encoder  22
H.264 format  76, 650
H.264 video  76
hard disks

copying DLT drive contents to  585
output format options  584
removing folders and  159
storage space on  29

hardware components  29–33
HD assets  22–23, 38, 181, 184, 371
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HD DVD (High Definition DVD)  38
HD DVD players  38
HD DVD standard

blue laser discs. See blue laser disks
media supported  20
overview  19–23, 650
preferences  113
specifying for projects  112, 113, 126, 127–128
unable to change to SD DVD  128, 135

HD DVD video zone  20, 28, 568–569
HD DVD video zone files  568–569
HD projects

See also projects
16:9 video and  51
4:3 aspect ratio and  209
aspect ratio  114
audio formats  81
bit rates for  56, 70
build files  568–569
closed captions and  433
compatibility issues  38
considerations  38
converting SD projects to  135, 184
disc space required for transitions  44
encoding settings in  67
GOP length  60
Macrovision APS and  560
maximum bit rate allowed  43
menu creation  208–209
MPEG-1 video and  55, 135
number of buttons in  208, 209, 253, 463
rendering and  230
resolution  58, 67, 86, 114, 208, 248, 328, 361
SD assets used in  86
unable to convert to SD  128, 135

HDTV (High Definition Television)  50
HDV assets  22
HDV format  22, 650
HD video

aspect ratio  50
audio settings  107–108
video settings  106–107

HD video streams  371
help, onscreen user manual  34
high definition

described  19
HD DVD. See HD DVD standard
SD DVD standard and  19
vs. widescreen video  19

High Definition DVD. See HD DVD
highlights, button  90, 247, 255, 256, 328
hot spots  645
HV001I01.BUP file  569
HV001I01.IFO file  569
HV001M01.EVO file  569
HV001T01.EVO file  569

HVDVD_TS files  183, 568–569
HVDVD_TS folder

accessing via disk image  585
build/format process  544, 545, 568
contents of  20, 28, 568
copying to disc  569
deleting contents of  563
described  650
emulating projects  546, 570–571
filenaming structure  573
non-standard video zone files  569
playing video from  570
verifying presence of  563

hybrid discs. See DVD-ROM discs

I
icons, adding to toolbar  161
iDVD projects  18, 629–631
.IFO file  566, 568, 569
I-frames

adding  60
compression markers and  71
described  59, 650
GOPs and  61

iMovie
assets  384
markers  70, 75, 384

Import Asset feature  192, 193
Import Asset toolbar item  163
importing items

archived projects into DVD Studio Pro  629–630
assets  49, 181, 192–198, 384
chapter markers into tracks  384
closed captions  612
GPRM configurations  507–508
graphics files for subtitles  431, 452–453, 462
iDVD projects into DVD Studio Pro  629–631
item descriptions  180, 632
LiveType projects into DVD Studio Pro  187
markers from Final Cut Pro assets  384
markers from iMovie assets  384
markers from text list  385
Motion projects into DVD Studio Pro  187
MPEG files  55
projects from earlier versions  631–632
QuickTime assets  49, 62, 66, 184, 371, 375
shapes  320
styles  315
subtitle files  431, 454–456
subtitles from earlier versions  432
templates  315
themes into DVD Studio Pro  629–630

information drawer, Simulator  551
Inspector

See also specific Inspectors
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described  138, 154
hiding  154
overview  154
setting remote control buttons  610
showing  154, 163

Inspector toolbar item  163
interactivity

DVD@CCESS  594–598, 649
markers  431, 460–466, 647
subtitles  431, 460–466, 647

Internet links  594, 596
intra frames. See I-frames
intro clips  345–346
invisible buttons  209–210
ISO 9660 volume  574
item descriptions  179–180, 632
iTunes Music Store  77, 372

J
JACKET_P folder  562, 565, 568, 573
jacket pictures  562, 650
Japanese characters  574
Joliet Extension Support setting  555, 574, 574
Joliet volume  574
jump commands  482, 484–485, 488, 490
jump indirect command  490
jumps

See also connections
advanced  528
basic  528
chapters  530
commonly used  528
GPRMs and  482
loop points  284, 346, 485, 509
markers  386, 388
menus  246, 346
next  529
previous  529
slideshows  420, 529
sources  528
standard  528
tracks  529

K
karaoke-capable DVD players  497–498, 500
keyboard shortcuts  613–628

See also shortcut menus
adding project elements  616
application  613
Assets tab  617
Connections tab  618
custom configurations  140, 141
Exposé feature and  141
general  613–614
Graphical tab  618–619

Log tab  619
Menu tab  620–622
Outline tab  622
Palette  623
problems with  141
project controls  615
Script tab  623
scrolling lists  616
Simulator  623
Slideshow tab  624
Story tab  624
Subtitle Editor  625
Track tab  626–627
Viewer tab  628
zoom controls  169

key frames. See I-frames
kilobytes, actual size of  40

L
language codes  501, 519–523
languages

adding to projects  162
assigning to audio/subtitle streams  379
assigning to menus  355
audio streams  117, 122
configuring menu languages  353–354
creating menu languages  353–354
default  112, 113, 117, 354
in menus  113, 122, 247, 328, 352–355, 492
multiple  353
not specified  117, 122
projects  112
removing  354
in Simulator  122
space taken on DVD for  354
subtitles  117, 122, 379, 438, 448, 453
text names and  559

language settings
Embed Text Data option  559
initial audio language  500
initial language code extension  501
menus. See languages
streams  375

laser disks  41
layered menus

backgrounds  91
considerations  91
creating  91
described  91
graphics for  83
layers  83
PSD files and  91

layers
creating menus with. See menu creation, layer 
method
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dual. See dual-layer discs
flattening  83
non-seamless  577
options for  556
overlay  246
Photoshop  83, 91
seamless  577
standard overlay menus  83

.layout extension  567, 569

.layout file  567, 569
layout styles  302, 308
letterboxing  51, 53, 650
Letterbox mode  114, 123, 208, 209
limitations, DVD  45
Line 21 settings  611–612, 650
links. See DVD@CCESS links
LiveType projects  187
loading scripts  477
Log tab  149, 551, 563, 619
looping menus  92
looping tracks  131
looping video clips  231
loop points

defining  92
improvements to  18
jumping to  284, 346, 485, 509
uses for  283

Loop Point setting  283, 346

M
.m2v extension  184
Macintosh computers  597
macro view  169–170
Macrovision APS

See also copyright protection
burning discs and  30
described  650
enabling  561
HD projects and  560
settings for  557–558, 560–561
types supported  561

Macrovision setting  362, 389, 557, 558
manual, onscreen  34
Marker Inspector  358, 387–389
markers

See also tracks
adding in external video editors  72
adding to clip end  382
adding to tracks  70–75, 381
adding without video clip  383
assigning  394
button highlight  386, 387, 461
cell markers  386, 387
changing entries in entry list  391
changing order of entry list  391

chapter. See chapter markers
color of  386
compression markers  69, 70, 71
deleting  383, 391
described  651
dual-layer break  386, 387
duration of  386
DVD@CCESS links  389, 594
DVD Studio Pro and  71
editing  382
Final Cut Pro  71, 72–74
fixing on build  118
GOP boundaries and  380
iMovie  71, 75, 384
importing from iMovie assets  384
importing from text list  385
interactive  431, 460, 647
invalid  118, 134
jumping to  386, 388
moving  382
names  116, 117, 388
placement of  71, 72, 380
prefixes  116
properties  387–389
remote control  389
setting playhead to marker position  382
skipping forward/backward  529
thumbnails  388
timecode  389
types of  386–387
user operations settings  601
uses for  380
with moved video clip  383
working with  380–389

Max Bit Rate settings  64
media

See also discs
authoring  30
general  30, 649

media tabs, in Palette  157–160
megabytes, actual size of  40
Melt transition  641
memory registers. See GPRMs; SPRMs
Menu button  259, 531, 609
Menu Call user operations  601
menu controls, Simulator  550
menu creation

basic steps for  82
overview  205–209
using templates/styles  303–321

menu creation, layered method  323–335
adding buttons  331–335
adding new menu to project  218
choosing background  323–325
choosing overlay  326
described  207
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properties  326–331
menu creation, standard method  229–284

adding audio  229, 279–280
adding buttons  253–272
adding drop shadows  229, 248
adding drop zones  229, 273–276
adding new menu to project  218
adding text objects  229, 276–279
choosing background  229, 231–233
choosing overlay  229, 233–235
color mapping  236–242
configuring drop shadows  280–281
configuring motion menu settings  282–284
configuring motion settings  229
described  206
options for  229
properties  244–252
templates/styles feature and  229
using shapes  229

Menu Editor
creating slideshows in  408
described  149, 211
displaying  163
dragging assets to  195, 220
dragging tiles to  172
Drop Palette  164, 220–222
dynamic guides  213
guide settings  119
importing assets with chapter markers  384
keyboard shortcuts  620–622
menu guides  212–213
opening menus  219
overview  211–217
rulers  119, 212
templates/styles and  309
tools in  215–217

Menu Editor toolbar item  163
menu guides  212–213
Menu Inspector

layered menus  326–331
setting loop points  92
standard menus  244–252

Menu Loop Point feature  18, 509
menu loop points. See loop points
Menu pane  115–116
menu rulers  212
menus  205–355

16:9. See 16:9 menus
24 fps video in  50
4:3. See 4:3 menus
adding assets to  220–222
adding audio to  229, 246, 272, 279–280
adding buttons to, layered  331–335
adding buttons to, standard  253–272
adding Easter Eggs to  209–210
adding intro clips  345–346

adding shapes to  256–258
adding text to  229, 276–279
adding transition clips  345, 347–352
advanced settings  252
applying styles to  303, 309–311
applying templates to  303, 309–311
aspect ratio  114
assigning backgrounds to, layered  324–325
assigning backgrounds to, standard  232–233
assigning languages to  355
assigning overlays to  234–235
backgrounds  81, 646
basic settings  244, 327
button offset  248, 329
buttons on. See buttons
chapter. See chapter index menus
color settings  251
copying menu items  223–224
creating. See menu creation
default styles  312
deleting menu items  225
described  651
designing  40
disabled operations  252
disabling viewer controls for  601
disc space required for  638
display settings  252, 331
dragging to buttons  298, 344
dragging to empty area  298, 344
Drop Palette  220–222, 285–302, 337–344
drop shadows  248, 280–281
drop zones  648
DVD@CCESS links  594
DVD@CCESS settings  252, 331
getting started with  218–227
graphics in  24, 82–86
HD projects  208–209
jump actions  246, 284, 346
languages in  113, 328, 352–355, 492
layered. See layered menus
layered creation method  650
limitations  45
looping  92
maximum number of buttons on  208, 209, 253, 
463
mixing audio formats in  80
motion. See motion menus
moving menu items  224–225
naming  219
opening  215, 219
overview  81, 205–209
preferences  115–116
properties, layered  326–331
properties, standard  244–252
rendering  115, 230
resizing menu items  224
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resolution  328
sources  81–96, 535, 536, 538
square pixels  216
standard creation method  653
supported file types  82
text settings  121
timeouts  246, 327
tips for creating graphics for  83
user operations settings  601
using 16:9 assets in  53
viewing layers  215

Menu tab
described  149
keyboard shortcuts  620–622
Menu Inspector, layered menus  328–329
Menu Inspector, standard menus  247–248

Method settings  66
Missing Files window  132
mixed-angle tracks

alternate streams  396
bit rates  70
considerations  68, 395
creating  397
overview  395
previewing  402
using stills in  396

mixed-angle video  69
monitors

4:3. See 4:3 monitors
audio  16, 31–33, 79, 546
NTSC  50
PAL  50
resolution  123
video  16, 31–32, 546

Mosaic transition  642
motion assets  183–186
motion button  217, 651
Motion Dissolve transition  642
Motion Estimation settings  65
motion menus

See also menus
buttons  92
calculating play time of  634
considerations  91
creating video for  91
described  651
loop points  485, 509
settings  115, 245–246, 282–284
video clips for  231

Motion projects  17, 187
motion settings  229
motion video assets

adding to layered menus  337–338
adding to menus  285–288

Move In transition  642

movies
See also video
asset  99, 100
asset matte  99, 102
background matte  99, 102
Final Cut Pro  74
frame rates  48
iMovie  70, 75, 384
video sources  48

Moving Picture Experts Group. See MPEG
MP-3 audio  77
MPEG-1 Layer 2 audio  77, 78, 105, 108
MPEG-1 video

bit rates  55, 104
HD projects and  55, 135
quality of  25
resolution  104
vs. MPEG-2 video  55

MPEG-2 assets  49–50, 371
MPEG-2 HD assets  135
MPEG-2 HD tab  63–65
MPEG-2 SD tab  63–65
MPEG-2 video

bit rates  104, 106
considerations  25
quality of  25
resolution  104, 107
vs. MPEG-1 video  55

MPEG-4 part 10 video. See H.264 video
MPEG audio settings  105, 107
MPEG clips  379
MPEG encoders  26
MPEG encoding

See also embedded MPEG encoder
16:9 video and  52
described  25
methods for  56

MPEG files
elementary  55
exporting  379
importing  55
multiplexed  55
segmented  186, 371
settings for  123

MPEG motion assets  200
MPEG standards  651
MPEG streams  26, 69
MPEG video  54–75

bit rates  55, 104, 106
described  54
encoding. See MPEG encoding
frame rates  58
GOP settings  59–61
multi-angle tracks  68–70
overview  54–75
quality issues  61
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resolution  57–58, 104
settings for  104, 106–107

multi-angle streams  494
multi-angle tracks  68–70

alternate streams  396
bit rates  44, 70
considerations  395
creating  396
overview  395
previewing  402

multi-angle video  69
multiplexing  651

N
National Television Standards Committee. See NTSC
navigation buttons  115, 268–271
navigation controls  38
Navigation Timer  497
network users  132
Next button  529, 602
noisy video  61
non-drop frame timecode  651
Nop command  483
Normal aspect ratio  54
NTSC assets  39, 49, 58, 103
NTSC DVD players  48
NTSC format  112, 113, 125–127
NTSC monitors  50
NTSC sources  48
NTSC video

about the term  48
AC-3 format and  78
aspect ratio  50, 84, 85
colors  83
described  651
frame rate  58, 105, 107
HD projects  58
interlaced scanning method  21
required audio formats  81
SD projects  57
specifying  553
square pixels and  84

numeric keypad  248

O
objects

distributing  172
text  229, 272, 276–279

one-pass VBR encoding  56
onscreen user manual  34
Opposite Track Path (OTP)  556, 577, 651
Option key  402
Other tab, Track Inspector  362
OTP (Opposite Track Path)  556, 577, 651
Outline tab  164–167

configuring menu languages  354
creating menus  218
described  150
dragging assets to  196–198
features  164
keyboard shortcuts  622
opening menus  219
project view  165–167
renaming elements in  177
using  165–167

output devices  583–585
overlay-based buttons  253–255, 272, 331
overlay files  246
overlay graphics  462
overlay layers  246
overlays

advanced  86, 88–90, 233, 236, 240–242
assigning to menus  234–235
backgrounds  88–89
choosing, layered method  326
choosing, standard method  229, 233–235
color mapping  234, 236–242, 652
colors  86, 87, 88–90
creating  86–90
described  233, 652
edges of  87
pseudo-soft edges  90
selections  246
settings  327
simple  86, 88, 233, 236, 239–240
subtitles and  432, 462
white values  88

P
Page Flip transition  643
PAL assets  39, 49, 58, 103
PAL DVD players  48
Palette  155–160

Audio tab  157
defaults  124
described  138
displaying  163
dragging shapes from  256–257
hiding  155
importing assets  194
keyboard shortcuts  623
settings  124
Shapes tab  156–157
showing  155
Stills tab  157
Styles tab  156
Templates tab  156
Video tab  157
working with assets  157–160
working with shapes  156
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Palette toolbar item  163
PAL format  112, 113, 125–127
PAL monitors  50
PAL-M video  126
PAL SD projects  433
PAL sources  48
PAL video

about the term  48
aspect ratio  50, 84, 85
colors  83
described  652
frame rate  58
HD projects  58
interlaced scanning method  21
required audio formats  81
SD projects  57
specifying  553
square pixels and  84

Panavision aspect ratio  54
pan-scan method  52, 53, 652
Pan-Scan mode  114, 123, 208, 209
pan-scan vectors  52
Parallel Track Path (PTP)  556, 577, 652
Parental Management level  498
parental management settings

country codes  498
display conditions  605
DVD players  517–519
level settings  498

.par extension  186
parse files  132, 186
partitioned GPRMs  17, 479, 504–507
pasting menu items  223–224
patches  317, 652
pause setting  118
PCM audio  77, 78, 105, 108, 636
PCM streams  43
P-frames

compression markers and  71
described  59, 652
GOPs and  61

PGCs (Program Group Chains)  495
Phase Alternating Line. See PAL
Photoshop  83, 91, 93
Photoshop files. See PSD files
Photoshop layers  91
pinning elements  592
pixel aspect ratio  16, 547, 652
pixels

graphics vs. video  84–86
HD video  86
rectangular  84
SD video  84
square  84, 85, 216
video  84, 86

video resolution and  57
placeholders, script  483
play/pause settings  118
playback

16:9 tracks  52, 53
AC-3 audio  79
all tracks  512–516
disabling viewer controls for  600
DTS audio  79
DVD@CCESS feature  597–598
Joliet Extension Support setting and  574
LiveType projects  187
Motion projects  187
options for  38, 553, 600
point  92
problems with Joliet support  574
random tracks  510–511
scripts  480, 490, 510–513
Simulator  122–123
with Space bar  401
stopping  401
user operations  600

playback controls, Simulator  548, 549
Playback Control user operations  600
players

audio  33
audio decoder support  80
dual-standard  48
DVD. See DVD players
video  33

playhead  368, 382
play time, calculating  634
point playback  92
position commands, STL format  458
prebuild disc properties  560
predicted frames. See P-frames
pre-encoded sources  26
preferences  112–125

See also properties
alignment  118–119
color  121
destinations  123–124
DVD standard  113
DVD Studio Pro  112–125
encoding  62–65, 125, 183–184
general  114–115
language  112, 113, 117
menu  115–116
projects  113
Simulator  122–123
subtitles  435
text  120–121
track  116–118

Preferences window  112–113
preformat disc properties  572
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pre-scripts
See also scripts
compared to display conditions  479, 603
described  467
ending  490
Nop command and  483, 490
resume command and  489
slideshows  427
uses for  467

presentations. See slideshows
previewing items

AC-3 audio  79–80
assets  203
DTS audio  79–80
mixed-angle tracks  402
multi-angle tracks  402
project elements  545
slideshows  429
streams  400
subtitles  443–444
tracks  400

Previous button  529, 602
printing tile areas  176
Program Group Chains (PGCs)  495
Project pane  113
projects

adding hidden items to  209–210
adding jacket pictures to  562
adding languages to  162
adding slideshows to  407
adding VTS blocks to  593
advanced disc settings  558–559
building. See building projects
burning  544
converting DVD standards  135
converting video standards  134
creating  125–130
default language for  112, 113
described  652
disc space required for  555, 633–638
dual-layer. See dual-layer projects
DVD@CCESS links in  594–596
Easter Eggs in  209–210
elements in. See elements
emulating  479, 546, 570–571
finishing  543–586
formatting. See formatting projects
hard disk space required for  29
HD. See HD projects
iDVD  18, 629–631
importing assets into  192–198
limitations  45
LiveType  187
loading scripts into  477
menu languages  352–355

missing assets in  132
Motion  17, 187
multiple users and  132
naming  126, 129
opening  131–132
opening old versions  632
planning for  37–46
preferences  113
reconnecting assets to  182
remote assignments  550
removing assets from  199
saving  125
SD. See SD projects
setting disc size  126, 129–130
setting DVD standard  127–128
setting first play  126, 131
setting video standard  126–127
simulating  546–551
starting  109–112
storyboarding  40
target audience for  38
testing with Simulator  545–551

properties
See also preferences
assets  204, 374–375
buttons  259–263
disc format  572–580
discs  552–559
drop zones  274
markers  387–389
menus, layered  326–331
menus, standard  244–252
prebuild disc properties  560
preformat disc properties  572
slides  428–429
slideshows  425–428
stories  392–394
streams  378–379
styles  305–309
templates  306–309
text objects  278–279
tracks  360–363
user operations  599–601

PSD files
choosing menu overlays from  235
creating layered menus with  91
flattening layers  83
layer settings  248
menu backgrounds, layered  323, 325
menu backgrounds, standard  233
overlays and  87
using for shapes  93

PTP (Parallel Track Path)  556, 577, 652
Push transition  643
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Q
quadrants, DVD Studio Pro  137, 141–153, 211
QuickTime assets

changing length of  201
importing  49, 62, 66, 184, 371, 375
mixing video standards  134, 135
names  184
re-encoding  185
refreshing  200–201

QuickTime files  184, 188
QuickTime MPEG Decoder  15
QuickTime MPEG Encoder. See embedded MPEG 
encoder
QuickTime website  35

R
Radial Blur transition  643
Read DLT toolbar item  163
red laser discs

capacity  41, 578
common sizes  41
described  38, 555, 652
filenaming issues  573–574
setting size  130
specifying as disc media  130
UDF 1.02 volume  574

reference frames. See I-frames
refreshing assets  200–201
Region/Copyright tab  557–558
region codes

default  122
described  39, 502, 652
dual-standard players and  48
listed  502
selecting  557
vs. video standards  39

registers, memory. See GPRMs; SPRMs
remote control buttons  608–610

assigning functions to DVD players  608–610
configuring  610
connections  529
markers  389
resume feature  259
stories  392

rendering menus  115, 230
rendering settings  115–116
replication facility  28, 653
resolution

audio  48
default  112
HD projects  58, 67, 86, 114, 208, 248, 328, 361
menus  328
monitors  123
MPEG video  57–58, 104
SD projects  57, 67, 248, 328, 361

slides  97
slideshows  97, 406, 426
supported by DVD Studio Pro  21, 104, 107
templates and  309
tracks  361
video  57–58

resources, DVD Studio Pro  34
resume command  489
resume feature  259
Return button  247, 328, 609
Reveal transition  643
RGB values  16
ROM-only DVD discs  575–576
Rotate transition  644
Rotation Blur transition  644
RTF files  456
rulers  118–119, 212

S
S/PDIF (Sony/Philips Digital Interface)  33, 653
sample rates  17, 25, 48, 105, 108
SCR format  431
Script Command Inspector  475
Script Editor

accessing  471, 476
adding command lines  471, 471–472
copying command lines  473
creating scripts  476
described  151
displaying  470
removing command lines  471–472
reordering command lines  472

scripting
display conditions and  479
examples  509–519
overview  469–470, 479–480
user interface for  470–475

scripting commands  480–490
See also command lines
adding comments to  475
configuring  475, 476
described  470
displaying information about  474
moving between  471
selecting  475

scripting language  467
Script Inspector  470, 474
scripts  467–523

See also pre-scripts
adding to buttons  344
adding to menus  299, 344
checking parental controls  517–519
comparing elements  481–483
creating  476
described  653
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disc playback and  480
duplicating  477
in DVD Studio Pro  467
editing  470
exit points  480
for playing tracks  510–513
GPRMs and  469, 504–508
jump commands in  484–485, 488
jumping to loop point  509
limitations  46
loading  477
naming  474, 476
placeholders in  483
planning  476
resuming  489
saving  477
saving as files  477
source values  487
SPRMs and  469, 482, 491–504
stopping playback  490
stories  393
stream values  488
terminating  480
testing  478–479
tracks  361
uses for  467

Script tab  151, 471–473, 623
SCSI devices  29
SD assets  38, 86, 181, 184, 371
SD DVD players  38
SD DVD-R drives  30
SD DVD specification  25, 50, 51
SD DVD standard

changing to HD DVD standard  128, 135
described  38
high definition and  19
overview  19
preferences  113
red laser discs. See red laser disks
specifying for projects  112, 113, 126, 127–128

SD DVD video zone files  566–567
SD projects

See also projects
16:9 graphics and  208
16:9 video and  51
aspect ratio  114
audio formats  81
bit rates for  43, 55, 70
blue laser media and  30
build files  565–567
compatibility issues  38
considerations  38
converting to HD projects  128, 135, 184
disc space required for transitions  44
general vs. authoring media  30
GOP length  60

number of buttons in  208, 209, 253, 463
rendering and  230
resolution  57, 67, 248, 328, 361
still images in  406

SD video
aspect ratio  50, 84
audio settings  105
pixels  84
video settings  104–105

SD video streams  371
seamless layers  577
Seamless setting  556, 577
SECAM video  126
segmented MPEG files  186, 371
Separator toolbar item  163
set commands  485–487
set GPRM command  485–487
set system stream command  488–489
set-top DVD players  30, 479
shapes

adding to menus  256–258, 299
applying  318–319
in Button Inspector  257
creating  93
creating for drop zones  93, 94, 96
creating with opacity settings  95
deleting  321
described  156, 653
in drop zones  275
general creation information  95
importing  320
managing  317–321
in Palette  256–257
types of  317, 318
using  229

Shapes tab  156, 317–321
Shift key  402
shortcut menus

See also keyboard shortcuts
adding quadrant tabs  145
button connections  259
customizing toolbar  161

Show Colors toolbar item  163
Show Fonts toolbar item  163
simulating elements  179
simulating projects  546–551
simulating stories  394
Simulator

aspect ratio  123
assets and  546
audio destination  122
described  546
display mode  123
entering SPRM and GPRM values  551
keyboard shortcuts  623
language settings  122
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log  551
messages generated by  149
monitor resolution  123
opening  163
playback controls  548
playback output options  122–123
preferences  122–123
refreshing assets and  200
region codes  122
simulating slideshows  430
simulating subtitles  444
starting/stopping  547
starting from the Outline tab  179
testing projects with  545–551
testing scripts in  478
toolbar item  163
verifying elements  179
video destination  122
window  548

Simulator pane  122–123
Simulator Window option  122
single-layer discs  130
skip buttons. See step buttons
Slide Inspector  412, 419, 423, 428–429
slide list  415, 417
slides

See also slideshows
adding to slideshows  409
aspect ratio  97
assets  417, 428
assigning audio files to  411–412, 417
background color  114
deleting audio files assigned to  412
duration of  114, 409, 412, 414, 417–419
DVD@CCESS settings  429
name of  428
order number  417
preferences  114
properties  428–429
rearranging order of  410–411, 417
removing from slideshows  411
resolution  97
selecting in a slideshow  410
settings for  417
thumbnails  415, 417
transitions  405, 417, 420, 421–424, 425

Slideshow Editor
adding slides to slideshow  409
assigning audio to slides  412
changing audio file assigned to  412
changing slide duration  418
changing thumbnail sizes  415
controls  416
described  151
displaying  163
dragging assets to  195

keyboard shortcuts  624
opening slideshows in  407
previewing slideshows  429
rearranging slides  410
removing slides from slideshow  411
selecting slides  410
settings  415
slide list  417
toolbar item  163
transitions  422, 423

Slideshow Inspector  407, 422, 425–428
slideshows  405–430

16:9 aspect ratio  97, 409
4:3 aspect ratio  97, 409
adding audio to  407, 411–414
adding slides to  409
adding to layered menus  343
adding to menus  297–298
adding to projects  407
aspect ratio  97, 114, 426
assigning overall audio file to  413–414
audio asset length  201
audio files imported to  407
audio in  98
buttons for  408, 419
color in  98
converting to tracks  381, 405, 424
converting tracks to  424–425
creating in Menu Editor  408
described  653
disc space required for  425, 638
duration of  413–414, 427
DVD@CCESS links  594
elapsed time  417
End Jump setting  425
file formats for  97, 406–407
in iDVD  630
jumps in  420, 529
limitations  46
mixing audio formats in  80
name of  425
pausing  417
preparing stills for  97–98
pre-scripts  427
previewing  429
properties  425–428
rearranging slides in  410–411, 417
remote control settings  427
removing slides from  411
resolution  97, 406, 426
selecting slides  410
simulating  430
slide duration  114, 409, 412, 414, 417–419, 427
sources  536, 540
still images in  406–407
transitions  421–424
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uses for  405
viewer-advanced  419–420
working with  415–430

Slideshow tab  151, 624
snap grid  171
Snap To options  117
SON format  431
Sony/Philips Digital Interface (S/PDIF)  653
sorting assets  192
sound. See audio
Soundtrack  279
source elements  485, 487
source material  24–25, 47
sources

advanced  537–540
basic  534–536
changing  531
connections  525, 527, 528–529, 531
described  525
disc  534, 537–538
examples of  527
jumps  528
listed  534–540
menus  535, 536, 538
project elements and  527
slideshows  536, 540
standard  536–537
story  535, 537
targets for  541
track  535, 536, 538–539
types of  528–529

source values in scripts  487
Space bar  118, 401
Space toolbar item  163
SPRMs (System Parameter Register Memories)

aspect ratio monitor  503
comparing  482
described  469, 654
listed  491–503
partitioned GPRMs and  504

SPRM values  478, 491–503
.SPU extension  432
square pixels  84, 85, 216
Standard Definition DVD. See SD DVD
standard overlay menus  83
standards

DVD. See DVD standards
video. See video standards

standard transitions  349
Start setting  283
status information  149
step buttons  402
Step Forward button  402
Step Reverse button  402
stereo PCM  105, 108
still assets  186, 200, 202, 371, 398

still clips  372, 398–400
still images

adding to layered menus  340–341
adding to menus  291–294
backgrounds  231
in HD projects  406–407
quality of  231
in SD projects  406
skipping forward/backward  529
in slideshows  97–98, 406–407
using in mixed-angle tracks  396
as video sources  48

still menus  638
STL commands  457–459
STL format  431, 456–466
STL format subtitle files  453, 456–460
stories

adding entries  391
adding to layered menus  343
adding to menus  296–297
changing entries in entry list  391
changing order of entry list  391
chapter markers  530
creating for tracks  390
deleting markers from entry list  391
described  390, 653
displaying  393
limitations  46
names  392
play options  392
properties  392–394
remote control settings  392
scripts  393
simulating  394
simulating entries  394
VTS numbers and  495
working with  390–394

storyboarding  40
Story Editor  152, 163, 391, 624
story entries  391, 393, 394
Story Entry Inspector  393
Story Inspector  392–393
story sources  535, 537
Story tab  152, 624
streams

AC-3  43
adding assets to  372
angle  550
audio. See audio streams
C1/C2  612
C3/C4  612
copying clips in  373
disabling viewer selection controls for  601
disc property settings  554
editing clips  376
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enabling  378
information about  375
inserting subtitles into  445–446
locking  379
MPEG  26, 69
multi-angle  494
options  601
preventing changes to  379
previewing  400
properties  378–379
removing clips from  375
subtitle. See subtitle streams
user operations settings  601
V1 video stream  372, 379
V2-V9  69
video. See video streams
viewing in Track Editor  364

stream selections, Simulator  550
Stream Selection user operations  601
stream values in scripts  488
style files  314
styles

applying  303, 309–311
buttons  312
creating  313–314
creating menus with  303–321
default  312
described  156, 653
dragging from Palette  195
drop zones  308
importing  315
layout  308
overview  303–309
properties  305–309
self-contained  314
text  307, 312

Style tab, Button Inspector  260–261
subpictures  501

See also overlays
Subtitle button  609
Subtitle Clip Inspector  452
Subtitle Editor  163, 434, 447, 625
subtitle files

creating for import into DVD Studio Pro  453–454
importing  431, 454–456
STL format  453, 456–460

Subtitle Inspector  436–442
Subtitle menu button  529
subtitles  431–466

animations  453
aspect ratios  442
bit rates  43
buttons over video  431, 460–466
capabilities of  433

color of  441–442, 450, 457
controls embedded in  432, 459
copying text between  448
creating  431, 445–446
creating outside of DVD Studio Pro  453–454
default language for  117, 122
described  611, 653
disc space required for  638
display options in STL file  458
duration of  115, 432, 446
editing imported subtitles  456
entering text for  436, 447–449
fading in/out  115
fading with STL command  457
fonts  449–450, 455, 457
formatting text  449–450, 459
graphics files assigned to  438
importing from earlier versions  432
importing graphics files for  431, 452–453, 462
interactive  431, 460–466, 647
language settings  379, 438, 448, 453, 501
line breaks  459
overlays and  432, 462
positioning in STL file  458
positioning text over video  451
positioning within streams  446, 455
preferences  115, 435
previewing  443–444
selecting streams  444
simulating  444
spell checking  453
STL format  431, 456–466
Text area in Subtitle Inspector  436
text settings  120
tracks and  358
trimming  446
uses for  358, 431
using groups of graphics  454
vs. closed captions  433, 611

subtitle streams
See also streams
assigning languages to  379
button highlight markers and  461
current subtitle stream number  493–494
described  358
disabling  392
properties  437–438
selecting  550, 554

SuperDrive  30, 42, 584
surround audio  78, 105, 108
S-Video  61
switch points  101
System Parameter Register Memories. See SPRMs
system requirements  29–33
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T
tabs

See also specific tabs
closing window  147
contained in quadrants  147–153
moving to different quadrants  145
rearranging within quadrants  144
reopening  147
restoring  146
tearing off  146
viewing contents of  144
viewing options  168–170

targets
connections  525, 527
described  525
examples of  527
listed  541
for sources  541
types of  529

template files  314
templates

adding to menus  300
applying  303, 309–311
creating  313–314
creating menus with  303–321
described  156, 654
dragging from Palette  195
importing  315
overview  303–309
properties  306–309
resolution and  309
self-contained  314

terms, glossary of  645–654
testing items

DVD@CCESS links  596
remote assignments  550
scripts  478–479

testing projects
with DVD Player  570
with the Simulator  545–551
on standalone DVD players  546, 570

text
See also closed captions; subtitles
adding to buttons  266
adding to menus  121, 229, 276–279
defaults  120, 312
drop shadows  277
Embed Text Data option  559
fonts. See fonts
importing markers from text list  385
justification  277
preferences  120–121
properties  278–279
styles  301, 307, 312

Text Display extensions  559

Text Object Inspector  278–279
text objects  229, 272, 276–279
Text pane  120
themes, importing into DVD Studio Pro  629–630
thumbnails

assets  651
markers  388
offset  117
preferences  115
slides  415, 417
transitions  350, 399

TIFF files  432
tiles  148, 167–176
timecode

in AC-3 assets  373
creating markers from  385
described  654
drop frame  648
non-drop frame  651
setting for timeline  367–368
start/end values for clips  368
story entries  394
subtitles and  455, 459
track offset  362

Timecode settings  63
time information, Track Editor  366–370
timeline

moving playhead along  368
setting timecode for  367–368
zoom controls for  365

timeline command, STL format  459
timeouts, menus  246, 327
timers  497
Timer Target  497
timestamps  362
Title button  609
titles, current playing number  495
title safe area  215
toolbar  160–162
toolbar palette  162
track content files  566–567, 568–569
track direction  556
Track Editor  364–379

configuring  364–365
described  152, 358
displaying  163
dragging assets to  195
opening tracks in  359
positioning playhead  369
stream view  365
time information in  366–370
toolbar item  163
viewing streams in  364
zoom controls in  365

Track Inspector  358, 360–363
Track pane  116
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tracks  357–403
24 fps video in  49
adding closed caption files to  612
adding markers to  70–75
adding to layered menus  342
adding to menus  294–296
aspect ratio  52, 114, 361
assets  357
break points in  556, 580
clips  370–378
converting slideshows to  381, 405, 424–425
creating  359
creating stories for  390
described  654
disc space required for  360
displaying  361
DVD  72
ending  513–516
importing chapter markers into  384
jumps  529
limitations  46
locking streams  379
looping  131
markers in. See markers
mixed-angle. See mixed-angle tracks
mixing audio formats in  80
multi-angle. See multi-angle tracks
names  360
number of  358
opening  359
playing all  512–516
playing at random  510–511
play options  361
preferences  116–118
previewing  400
properties  360–363
resolution  361
resuming  259
scripts  361
selecting  359
setting the End Jump  360
simulating  403
sources  535, 536, 538–539
subtitles and  358
transitions  398–400
user operations settings  601
using 16:9 assets in  52–53
viewing  400–403
working with  358

Track tab  152, 626–627
transcoders  54, 62
transcoding

artifacts  61
with embedded MPEG encoder  62

transition asset folder  99–100
transition clips  345, 347–352

transitions
alpha. See Alpha Transitions
bit rates  44
buttons  249, 263, 349, 352
described  654
disc space required  44
duration of  639
parameters  639–644
slides  405, 417, 420, 421–424, 425
slideshows  421–424
standard  640–644
still clips  398–400
tracks  398–400
video  349, 639

Transition tab
Button Inspector  263, 336, 350–351
Menu Inspector  249, 329, 350–351
Slideshow/Slide Inspectors  423–424
Track/Clip Inspectors  399

transition types  348–349
trimming items

clips  376, 377
frames of audio  376
GOP boundaries and  357, 376

troubleshooting  141, 377, 455, 563
TV system settings  553
two-pass VBR encoding  56
TXT format  431

U
UDF (Universal Disc Format)  573–574
UDF 1.02 volume  574
UDF 2.5 volume  575
UDF Bridge Format  573
UDF volume  574
Unicode  456, 574
Universal Disc Format. See UDF
URLs, links to  594
user manual, onscreen  34
user operations  598–601, 602
users

disabling viewer controls for  598–601
multiple  132
network  132

V
V1 stream  372, 377, 379
V2-V9 streams  69
variable bit rate. See VBR
VBR (variable bit rate)  45, 654
VBR encoding methods  45, 56, 64
video

See also MPEG video
16:9. See 16:9 video
24 fps. See 24 fps video
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4:3 video  53
anamorphic  51, 645
bit rates  45, 637
compression  25
encoding  25–26, 68–70
H.264  76
movie sources  48
multi-angle tracks and  68–70
noisy video  61
NTSC. See NTSC video
PAL. See PAL video
preparing for DVDs  25
quality of  24, 61
resolutions  57–58
SECAM  126
settings supported, HD video  106–107
settings supported, SD video  104–105
specifying type of  553
standards. See video standards
transitions  349, 639
widescreen  19, 645

video/audio pair assets
adding to layered menus  338–339
adding to menus  289–290

VIDEO_TS.BUP file  566
VIDEO_TS.VOB file  566
VIDEO_TS files  183

See also video zone files
VIDEO_TS folder

accessing via disk image  585
build/format process  544, 545
contents of  28, 566
copying to disc  567
deleting contents of  563
described  654
emulating projects  546, 570–571
filenaming structure  573
non-standard video zone files  567
playing video from  570
reusing  563–564
verifying presence of  563

video assets  183–184
See also motion video assets
alternate stream  396
bit rates  635, 636
calculating play time of  634
described  33
for HD video streams  371
length changes  201
for SD video streams  371

video capture cards  54
video clips

conflicts  377
exporting  379

intro clips  231, 345–346
looping  231
markers after moving  383
for motion menus  231
transitions  345, 347–352
trimming  377
V1 stream and exporting  379

video display  499
video editors  72
video manager group files  566, 568
video monitors  16, 31–32
video object (VOB) files  44, 567
Video Object Unit (VOBU)  389
video pixels  84, 86
video player, capturing from  33
video sources

encoding for DVD  54–61
PAL vs. NTSC  48
preparing  48–54
types of  48

video standards
changing in a project  134
choosing  39
DVD-Video specification  48, 126
listed by country  133
overview  39
selecting  126–133
setting for projects  553
transcoding  62
vs. region codes  39

video streams
See also streams
adding assets to  372
alternate  395–397
buttons over  647
HD  371
SD  371
selecting  554
still assets for  371
supported assets for  371
switching between  396

Video Title Set. See VTS
video tracks  53
Video Transition  349, 639
video zone  20, 28, 568–569, 654
video zone files

HD DVD  568–569
SD DVD  566–567

viewer operations  598–601
Viewer tab  153, 163, 401–402, 628
Viewer toolbar item  163
VOB (video object) files  44, 567
VOB_DATA.LAY file  567, 569
VOBU (Video Object Unit)  389
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VTS (video title set)
adding to projects  593
described  654
elements listed by  165–166, 196, 590–591
moving elements between  591
pinning/unpinning elements  592
stories and  495
title number  495

VTS_01_0.BUP file  567
VTS_01_0.IFO file  567
VTS_01_0.VOB file  567
VTS_01_1.VOB file  567
VTS blocks  16, 564, 568, 588–593, 654
VTS Editor  16, 588–593
VTS Inspector  593

W
WAVE format  77
websites

Apple Store  35
Apple Support  35
Apple websites  34–35

DVD@CCESS links to  594, 596
DVD Studio Pro  34
FireWire  35
QuickTime  35

widescreen aspect ratio  645
widescreen DVDs  645
widescreen video  19, 645
Windows computers  597
Wipe transition  644

Y
YUV values  16, 547

Z
zero-based timecode  367
zone files

HD DVD video  568–569
SD DVD video  566–567

zones  20, 28, 568–569, 654
zoom controls  169, 365
Zoom transition  644
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